## Contents

**Preface** ..................................................................................................................... 23
  - Conventions ........................................................................................................... 24
  - Related Publications ............................................................................................. 25
  - Customer Support .................................................................................................. 25
  - Information You Should Have .............................................................................. 26
  - User Feedback ........................................................................................................ 27
  - Information Builders Consulting and Training .................................................... 27

**1. Introducing WebFOCUS App Studio** ................................................................. 29
  - What Is App Studio? ................................................................................................. 29
  - App Studio Capabilities .......................................................................................... 30
  - WebFOCUS Architecture ....................................................................................... 32
    - WebFOCUS and Your Network ........................................................................... 32
    - WebFOCUS Components .................................................................................... 32
    - WebFOCUS Configuration .................................................................................. 33
  - App Studio Architecture .......................................................................................... 33
  - WebFOCUS and App Studio Processing .................................................................. 35
  - App Studio Development Modes .......................................................................... 35
    - Remote Development ............................................................................................ 36
  - Launching App Studio .............................................................................................. 37
  - Documentation Overview ........................................................................................ 38

**2. Navigating in App Studio** ................................................................................. 39
  - The App Studio Interface ....................................................................................... 39
  - Initiating App Studio ............................................................................................... 41
  - Opening the Application Menu of File-Related Commands .................................... 41
    - Setting User Preferences Using the Options Dialog Box .................................. 45
  - Accessing Frequently Used Commands .................................................................. 60
  - Developing Applications in the Canvas Area ........................................................ 64
    - Creating and Scheduling an Alert Using the Alert Assist Canvas .................... 66
      - Alert Assist Button ............................................................................................ 66
      - Alert Assist Quick Access Toolbar .................................................................. 67
      - Alert Assist Home Tab ...................................................................................... 67
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Creating Charts Using the Chart Canvas</td>
<td>68</td>
</tr>
<tr>
<td>Creating Cascading Style Sheets Using the Cascading Style Sheet Canvas</td>
<td>68</td>
</tr>
<tr>
<td>Accessing the ESRI Configuration Utility Canvas</td>
<td>68</td>
</tr>
<tr>
<td>Working With the JavaScript and CSS Canvas</td>
<td>68</td>
</tr>
<tr>
<td>Editing Component Code Using the Text Editor Canvas</td>
<td>68</td>
</tr>
<tr>
<td>Combining Layouts Within a Single Document Using the Document Canvas</td>
<td>69</td>
</tr>
<tr>
<td>Creating HTML Pages Using the HTML Canvas</td>
<td>69</td>
</tr>
<tr>
<td>Creating OLAP Hierarchies Using the Olap Dimensions Canvas</td>
<td>69</td>
</tr>
<tr>
<td>Creating and Styling Reports Using the Report Canvas</td>
<td>70</td>
</tr>
<tr>
<td>Creating Reporting Objects Using the Reporting Object Canvas</td>
<td>70</td>
</tr>
<tr>
<td>Reporting Object Button</td>
<td>70</td>
</tr>
<tr>
<td>Reporting Object Quick Access Toolbar</td>
<td>70</td>
</tr>
<tr>
<td>Reporting Object Home Tab</td>
<td>70</td>
</tr>
<tr>
<td>Working With Synonyms Using the Metadata Canvas</td>
<td>71</td>
</tr>
<tr>
<td>Joining Data Sources Using the Join Canvas</td>
<td>71</td>
</tr>
<tr>
<td>Changing Environment Settings Using the Set Canvas</td>
<td>71</td>
</tr>
<tr>
<td>Creating URL Files Using the Create URL Dialog Box</td>
<td>72</td>
</tr>
<tr>
<td>Specifying the Name and Location of a Data Source Using the Use Canvas</td>
<td>72</td>
</tr>
<tr>
<td>Customizing Canvases</td>
<td>72</td>
</tr>
<tr>
<td>Accessing Features With the Ribbon</td>
<td>73</td>
</tr>
<tr>
<td>Building an Application Using the Home Tab</td>
<td>75</td>
</tr>
<tr>
<td>Managing Data Using the Data &amp; Metadata Group</td>
<td>75</td>
</tr>
<tr>
<td>Sending Commands to the Server Using the Command Console</td>
<td>76</td>
</tr>
<tr>
<td>Listing the Available Paths Using the Execution Path Group</td>
<td>77</td>
</tr>
<tr>
<td>Loading Commands Using the Edit Group</td>
<td>77</td>
</tr>
<tr>
<td>Creating an Application Using the Content Group</td>
<td>78</td>
</tr>
<tr>
<td>Creating a New Environment and Configuring an Adapter Connection Using the Configure Group</td>
<td>80</td>
</tr>
<tr>
<td>Deploying an RStat Scoring Routine Using the Modeling Group</td>
<td>80</td>
</tr>
<tr>
<td>Controlling the Display of the Screen Using the View Group</td>
<td>82</td>
</tr>
<tr>
<td>Using the WebFOCUS Administration Menu</td>
<td>83</td>
</tr>
<tr>
<td>Customizing the Appearance of the Interface Using the Style Menu</td>
<td>85</td>
</tr>
<tr>
<td>Accessing App Studio Help Content</td>
<td>85</td>
</tr>
</tbody>
</table>
3. Creating Metadata ................................................................. 133
   Understanding Data Terminology .......................................... 134
   Accessing Data ................................................................ 135
      Working With Data Adapters .............................................. 135
   Generating a Synonym ......................................................... 136
      Enhancing a Synonym ...................................................... 137
   Building a Synonym Using the Metadata Tab ......................... 138
      Restoring Actions Using the Undo/Redo Group ...................... 139
   Deleting, Cutting, Copying, and Pasting Using the Clipboard Group... 139
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Searching and Revising Text Using the Editing Group</td>
<td>140</td>
</tr>
<tr>
<td>Switching Between Views and Aerial View Using the View Group</td>
<td>141</td>
</tr>
<tr>
<td>Inserting Nodes Using the Insert Group</td>
<td>142</td>
</tr>
<tr>
<td>Running a Sample Data, Data Profiling, or Impact Analysis Report Using the Reports Group</td>
<td>143</td>
</tr>
<tr>
<td>Showing Properties, Data Flow, and View Panels Using the Tools Group</td>
<td>144</td>
</tr>
<tr>
<td>Setting Preferences for the Metadata Canvas Using the Options Dialog Box</td>
<td>145</td>
</tr>
<tr>
<td>Changing Views in the Metadata Canvas</td>
<td>152</td>
</tr>
<tr>
<td>Displaying Fields in a Synonym Using the Field View Tab</td>
<td>152</td>
</tr>
<tr>
<td>Displaying Segments in a Synonym Using the Segment View Tab</td>
<td>153</td>
</tr>
<tr>
<td>Displaying Fields and Properties in a Synonym Using the List View Tab</td>
<td>159</td>
</tr>
<tr>
<td>Showing a Graphical Representation of a Synonym Using the Modeling View Tab</td>
<td>160</td>
</tr>
<tr>
<td>Displaying the Contents of a Master File Using the Text View Tab</td>
<td>161</td>
</tr>
<tr>
<td>Displaying the Contents of an Access File Using the Access File Text View Tab</td>
<td>162</td>
</tr>
<tr>
<td>Viewing and Editing Synonym Attributes</td>
<td>163</td>
</tr>
<tr>
<td>Setting Up Multilingual Titles and Descriptions</td>
<td>171</td>
</tr>
<tr>
<td>Viewing Data Profiling Characteristics</td>
<td>172</td>
</tr>
<tr>
<td>Viewing Data Profiling Columns</td>
<td>173</td>
</tr>
<tr>
<td>Enhancing a Master File with Expressions</td>
<td>180</td>
</tr>
<tr>
<td>Adding Virtual Columns (DEFINE) in a Synonym</td>
<td>180</td>
</tr>
<tr>
<td>Adding Computed Fields (COMPUTE) in a Synonym</td>
<td>183</td>
</tr>
<tr>
<td>Creating Filters in a Synonym</td>
<td>185</td>
</tr>
<tr>
<td>Defining Attributes and Creating Expressions for Custom Fields</td>
<td>187</td>
</tr>
<tr>
<td>Describing Group Fields and Repeating Fields in a Synonym</td>
<td>193</td>
</tr>
<tr>
<td>Storing the Number of Repetitions of a Repeating Field in a Virtual Field</td>
<td>196</td>
</tr>
<tr>
<td>Parameterizing a Synonym with Variables</td>
<td>200</td>
</tr>
<tr>
<td>Adding Indexes to a Synonym</td>
<td>202</td>
</tr>
<tr>
<td>Creating Cluster Joins</td>
<td>202</td>
</tr>
<tr>
<td>Creating a Synonym for Cube Data Sources</td>
<td>204</td>
</tr>
<tr>
<td>Defining a Business View of a Master File</td>
<td>208</td>
</tr>
<tr>
<td>Applying Database Administrator (DBA) Security</td>
<td>211</td>
</tr>
<tr>
<td>Applying Security Restrictions for Multiple Users</td>
<td>215</td>
</tr>
<tr>
<td>Deleting a DBA or User Password</td>
<td>215</td>
</tr>
</tbody>
</table>
Encrypting and Decrypting a Master File .......................................................... 216
Implementing DBA Security Using WebFOCUS Language ...................................... 217
Identifying the DBA: The DBA Attribute .......................................................... 218
Identifying Users With Access Rights: The USER Attribute ..................................... 218
Establishing User Identity .................................................................................. 219
Specifying an Access Type: The ACCESS Attribute .............................................. 219
Limiting Data Source Access: The RESTRICT Attribute ........................................ 220
Placing Security Information in a Central Master File ......................................... 222
Hiding Restriction Rules: The ENCRYPT Command .............................................. 223
Encrypting Data ................................................................................................. 223
Analyzing Procedures Using Impact Analysis .................................................... 224

4. Creating Reports .............................................................................................. 227

Building Reports Overview .................................................................................. 228
Report Types ....................................................................................................... 228
Launching the Report Wizard .............................................................................. 229
Accessing Reporting Components ...................................................................... 235
Building a Report Using the Report Tab .............................................................. 235
Defining a Filter Field Using the Filter Group ....................................................... 235
Creating Expressions Using the Expression Builder .............................................. 236
Using Filters in the Autoprompt Page .................................................................. 244
Chaining Input Controls in the Autoprompt Page ............................................... 245
Using a Calendar Control in the Autoprompt Page .............................................. 247
Customizing a Report Using the Report Group .................................................... 249
Adding a Header and Footer .............................................................................. 251
Adding Totals to a Report ................................................................................... 253
Setting Conditional Styling Using the Traffic Lights Group .................................. 257
Applying a Theme and Style to a Report Using the Style Group .......................... 258
Referencing or Embedding a Style Sheet Using the StyleSheet Selection Dialog Box.......................................................... 261
Assigning a Color Value Using the Color Dialog Box .......................................... 267
Adding Borders to a Report Using the Borders Dialog Box.................................. 267
Specifying a Width Limit for a Value Using the Width Options Dialog Box ........... 272
Specifying Styling for User Selected Output Formats Using the User Format Menu..................................................................................................................... 272
Creating Drill-Down Hyperlinks Using the Drill Down Command................................. 274
Creating a PDF Compound Report With Drill Through Links................................. 278
Managing Output Formats Using the Format Tab....................................................... 290
Selecting a Type of Report Using the Output Types Group........................................ 291
Setting Navigational Options for a Report Using the Navigation Group.................. 298
Navigating Large Reports with On-Demand Paging.................................................... 300
Working With Auto Drill & Analysis Functionality...................................................... 303
Working With the Features Group Commands........................................................... 304
Displaying Pop-up Field Descriptions for Column Titles............................................. 305
Controlling the Display of Sorted Data With Accordion Reports.................................. 306
Customizing Mailing Labels Using the Mailing Labels Options Dialog Box............... 311
Manipulating Mathematical Data Using the Data Tab.................................................. 312
Creating Computations Using the Calculation Group................................................. 313
Calculating Data Trends Using the Forecast Group.................................................... 316
Overview of Forecasting............................................................................................... 316
Creating a Parameterized Report Using the Guided Reports Group.......................... 319
Overview of Guided Reports......................................................................................... 320
Controlling the Page Properties of a Report Using the Layout Tab............................ 321
Changing the Page Properties Using the Page Setup Group....................................... 321
Applying Cell Padding Using the Report Group......................................................... 322
Applying Data or Field View Preferences Using the View Tab.................................... 323
Changing the Data or Field View Using the Object Inspector Group......................... 323
Displaying and Hiding View Components Using the General Group....................... 324
Limiting the Field Length of Data Using the Field Length Group............................... 325
Specifying the Number of Test Data Instances Using the Repetitions Group............. 325
Specifying the Size of the Report Canvas Using the Zoom Group.............................. 326
Viewing Report-Generated SQL Using the SQL Group............................................. 326
Determining Report Space in an HTML Page Using the Virtual Screen Size Group...... 326
Adding or Editing Images in a Report Using the Images Tab..................................... 327
Inserting a New Image in a Report Using the New Image Group............................... 327
Managing a Selected Image Using the Current Image Group.................................... 328
Changing the Position of an Image in a Report Using the Position Group.......... 329
Specifying Image Size Using the Size Group........................................... 329
Setting Options for a Selected Image Using the Options Group.................. 330
Setting Field Preferences Using the Field Tab........................................ 330
Specifying the Type of Field Using the Column Type Group........................ 331
Applying a Filter to a Field Using the Filter Group................................... 332
Sorting, Ranking, and Limiting Data Using the Sort Group........................ 332
Specifying Sort Field Break Options Using the Break Group....................... 333
Accessing Field Properties........................................................................ 335
Accessing Subtotal and Recompute Properties.......................................... 338
Formatting and Styling Report Fields Using the Appearance Tab.................. 340
Styling Data, Titles, and Text Using the Style Group................................... 340
Accessing the Styling Toolbar...................................................................... 342
Changing the Format of Numeric Fields Using the Format Group.................. 344
Accessing the Format Dialog Box............................................................... 344
Managing Data Visualizations Using the Display Group.............................. 346
Accessing the Data Visualization Dialog Box............................................. 348
Links Group............................................................................................... 350
Showing or Hiding Columns in an In-Document Analytic Report Using the Analytic
Documents Group......................................................................................... 350
Setting In-Document Analytic Report Options Using the Analytic Document Options Tab.. 350
Changing the Paging of an Analytic Document Using the Cache Group............. 351
Setting a Password and Expiration Date of an Analytic Document Using the
Viewing Restrictions Group......................................................................... 351
Setting Preferences for Calculations Using the Calculations Group............... 352
Setting Preferences for Legends Using the Legend Options Group............... 353
Setting Display Options for Multiple Reports Using the Window Display Group.. 354
Freezing Columns of a Report Using the Freeze Columns Group................... 354
Setting Display Options for the Status Bar and Navigation Bar Using the
Pagination Group......................................................................................... 355
Designating Colors for Positive and Negative Values in a Report Using the
Visualize Group......................................................................................... 356
Setting the Color of a Row in a Report Using the Row Selection Group.......... 356
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Working With Precision Report Tabs</td>
<td>400</td>
</tr>
<tr>
<td>Creating Precision Reports Using the Data Matrix Layer</td>
<td>406</td>
</tr>
<tr>
<td>Editing a Precision Report to Fit a Form</td>
<td>410</td>
</tr>
<tr>
<td>Joining Data</td>
<td>411</td>
</tr>
<tr>
<td>What Is a Join?</td>
<td>411</td>
</tr>
<tr>
<td>Creating Joins Using Join Functionality</td>
<td>412</td>
</tr>
<tr>
<td>Creating an Equijoin</td>
<td>412</td>
</tr>
<tr>
<td>Creating a Join Based on Conditional Criteria</td>
<td>412</td>
</tr>
<tr>
<td>Creating a Join Based on Virtual Fields</td>
<td>413</td>
</tr>
<tr>
<td>Creating a Left Outer Join</td>
<td>413</td>
</tr>
<tr>
<td>Creating a Full Outer Join</td>
<td>413</td>
</tr>
<tr>
<td>Specifying a Single (Unique) and Multiple (Non-Unique) Instance Join</td>
<td>414</td>
</tr>
<tr>
<td>Manipulating Data Sources in a Join Using the Join Tab</td>
<td>414</td>
</tr>
<tr>
<td>Joining Data Sources Using the Join Group</td>
<td>414</td>
</tr>
<tr>
<td>Displaying Data Sources in the Join Using the Windows Group</td>
<td>415</td>
</tr>
<tr>
<td>Creating a Join Using the Join Canvas</td>
<td>415</td>
</tr>
<tr>
<td>Creating Multi-Field Joins</td>
<td>416</td>
</tr>
<tr>
<td>Creating a Virtual Field as the Join Field</td>
<td>417</td>
</tr>
<tr>
<td>Creating Conditional Joins</td>
<td>417</td>
</tr>
<tr>
<td>Customizing a Join</td>
<td>418</td>
</tr>
<tr>
<td>Changing the Join Name</td>
<td>420</td>
</tr>
<tr>
<td>Adding a Tag Name</td>
<td>420</td>
</tr>
<tr>
<td>Detecting and Handling of Fan Traps and Chasm Traps</td>
<td>424</td>
</tr>
<tr>
<td>Blending Data</td>
<td>424</td>
</tr>
<tr>
<td>Styling Reports</td>
<td>427</td>
</tr>
<tr>
<td>Styling Characteristics</td>
<td>427</td>
</tr>
<tr>
<td>Introducing StyleSheet</td>
<td>428</td>
</tr>
<tr>
<td>Conditionally Styling Components in a StyleSheet</td>
<td>432</td>
</tr>
<tr>
<td>Linking Reports with Auto Linking and Auto Drill</td>
<td>437</td>
</tr>
<tr>
<td>Link to Predefined Reports, Charts, and Visualizations Using Auto Linking</td>
<td>437</td>
</tr>
<tr>
<td>Link to Ad Hoc Reports, Charts, and Visualizations Using Auto Drill</td>
<td>439</td>
</tr>
<tr>
<td>Reporting Syntax Summary</td>
<td>441</td>
</tr>
</tbody>
</table>
Navigating a Procedure .......................................................... 479
Branching Unconditionally .................................................. 479
Branching Conditionally ...................................................... 480
Looping in a Procedure ...................................................... 482
Using Variables in a Procedure ............................................. 485
Local Variables .................................................................... 487
Global Variables .................................................................. 488
Querying the Values of Variables and Parameters ...................... 488
Displaying Data Sources ........................................................ 489

7. Creating HTML Pages ......................................................... 491
Launching the HTML/Document Wizard ..................................... 491
Accessing HTML Page Components ......................................... 493
Inserting Components in an HTML Page Using the Components Tab .................................................. 494
Inserting a Report or Chart in an HTML Page Using the Reports Group .................................................. 494
Adding Basic Elements to an HTML Page Using the Generic Elements Group ........................................ 496
Adding Containers to an HTML Page Using the Containers Group .................................................. 502
Reordering Tabs, Accordions, and Windows ................................ 504
Adding Objects to an HTML Page Using the Objects Group ........ 506
Changing Load Order With HTML Object Manipulation .............. 507
Accessibility Support for Displaying Objects in the Order of the Document Object Model 508
Inserting Controls in an HTML Page Using the Controls Tab ........ 510
Adding Paging/Search Capabilities to a Control ......................... 513
Adding a Paging/Search Control to an HTML Page .................... 516
Defining the Load Order for Control Values ............................... 518
Using Multi-Select Lists ....................................................... 527
Working With a Slider Control .............................................. 527
Using Tree Controls .......................................................... 532
Saving Control Selections in a Browser Session ......................... 532
Positioning Objects in an HTML Page Using the Positioning Tab .... 538
Aligning Objects in an HTML Page Using the Positioning Group .... 538
Relating Objects in an HTML Page Using the Relationships Group .... 540
Aligning Text in an HTML Page Using the Text Alignment Group .... 541
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enabling Responsive Design for an HTML Page Using the Responsive Design Group</td>
<td>541</td>
</tr>
<tr>
<td>Changing HTML Page Properties Using the Utilities Tab.</td>
<td>542</td>
</tr>
<tr>
<td>Chaining Objects in an HTML Page Using the Chaining Group.</td>
<td>542</td>
</tr>
<tr>
<td>Synchronizing an Analytic Document in an HTML Page Using the Analytic Documents Group</td>
<td>542</td>
</tr>
<tr>
<td>Unlocking a Template for an HTML Page Using the Template Group.</td>
<td>543</td>
</tr>
<tr>
<td>Working With the Miscellaneous Group in the HTML Canvas.</td>
<td>543</td>
</tr>
<tr>
<td>Previewing HTML Output Using the Preview Group.</td>
<td>544</td>
</tr>
<tr>
<td>Displaying Panels in an HTML Page Using the View Group.</td>
<td>545</td>
</tr>
<tr>
<td>Creating a Widget to Autoplay Control Values</td>
<td>546</td>
</tr>
<tr>
<td>Using Parameters</td>
<td>557</td>
</tr>
<tr>
<td>Working With the Parameters Tab.</td>
<td>558</td>
</tr>
<tr>
<td>Adding a New Unbound Parameter</td>
<td>560</td>
</tr>
<tr>
<td>Creating a Static List of Values.</td>
<td>562</td>
</tr>
<tr>
<td>Creating a Dynamic List of Values.</td>
<td>571</td>
</tr>
<tr>
<td>Using Custom Procedures to Retrieve Dynamic Values.</td>
<td>579</td>
</tr>
<tr>
<td>Automatically Populating Fields With Dynamic Values.</td>
<td>583</td>
</tr>
<tr>
<td>Creating a Static or Dynamic Parameter Value List.</td>
<td>584</td>
</tr>
<tr>
<td>Parameterizing Properties in the Properties Panel.</td>
<td>592</td>
</tr>
<tr>
<td>Viewing Object Attributes</td>
<td>598</td>
</tr>
<tr>
<td>Customizing the Properties Panel for HTML Objects Using the Properties Toolbar</td>
<td>599</td>
</tr>
<tr>
<td>Resizing HTML Components Using the Autosize Children Option.</td>
<td>599</td>
</tr>
<tr>
<td>Working With Autosize Children</td>
<td>602</td>
</tr>
<tr>
<td>Adding Components to the HTML Canvas.</td>
<td>602</td>
</tr>
<tr>
<td>Working With Containers.</td>
<td>603</td>
</tr>
<tr>
<td>Modifying Object Population Settings</td>
<td>604</td>
</tr>
<tr>
<td>Working With the Selection To Area in the Settings Panel.</td>
<td>605</td>
</tr>
<tr>
<td>Using Tasks &amp; Animations</td>
<td>606</td>
</tr>
<tr>
<td>Executing a Task Using the Tasks Section.</td>
<td>607</td>
</tr>
<tr>
<td>Executing jQuery Animations Using the jQuery Animations Section.</td>
<td>612</td>
</tr>
<tr>
<td>Working with Requests &amp; Data Sources</td>
<td>621</td>
</tr>
<tr>
<td>Displaying Applications in Different Languages</td>
<td>623</td>
</tr>
</tbody>
</table>
Function: IbComposer_getAllAmpersValues........................................ 674
Function: IbComposer_showLayer................................................675
Function: IbComposer_toggleMapLayer........................................... 675
Function: IbComposer_toggleMapMarker..........................................676
Function: IbComposer_refreshMapLayer..........................................677
Function: IbComposer_panToAddress............................................. 677
Function: ibComposer_panToPoint............................................... 678
Function: IbComposer_preventModifyIFrameDocument.............................. 679
Function: IbComposer_showAllMapMarkers........................................ 679
Function: IbComposer_drawBullseye.............................................. 680
Function: IbComposer_setCalendarDatesRange....................................681
Function: IbComposer_goToPortalPage............................................682
Function: IbComposer_isSelectionRequired........................................ 683
Function: IbComposer_getNumberOfRecordsReturned............................... 684
Function: IbComposer_doSelectionByTableRow.................................... 685
Function: IbComposer_loadNextGroup............................................ 686
Function: IbComposer_loadPrevGroup............................................. 687
Function: IbComposer_isCompleteReloading....................................... 689
Function: IbComposer_setCalendarDate.......................................... 689
Function: IbComposer_saveSelectedFile.......................................... 690
Function: IbComposer_loadFromSelectedFile.................................... 691
Creating Responsive Web Pages ..................................................... 692
How Responsive Containers Fold................................................ 693
Selecting a Responsive Method.................................................. 695
Creating a Page With a Responsive Template...................................... 697
Understanding Responsive Templates ...................................... 697
Creating a Page With the HTML Canvas in Responsive Mode......................... 709
Designing Content for Smartphones ................................................... 718
Designing Output for Smartphones With the Mobile Layout Functionality .............. 719
  Enabling Mobile Layout in an HTML File.................................... 723
  Working With the Basic and Advanced Mobile Layouts.......................... 724
Viewing Mobile Output on a Smartphone.......................................... 730
Cascading Style Sheet Class Mapping List for Mobile Components................... 731
8. Creating Documents .......................................................... 739

Launching the HTML/Document Wizard .......................................................... 739
Accessing Document and In-Document Analytic Dashboard Components ............... 742

Inserting Components and Controls in a Document or In-Document Analytic Dashboard
Using the Insert Tab ..................................................................................... 742
Inserting Components in a Document or In-Document Analytic Dashboard Using
the Components Group ............................................................................. 742
Inserting Controls in an In-Document Analytic Dashboard Using the Controls
Group ........................................................................................................ 746
Adding Pages to a Document or In-Document Analytic Dashboard Using the
Pages Group .......................................................................................... 748

Positioning Multi-Selected Objects in a Document or In-Document Analytic Dashboard
Using the Positioning Tab ........................................................................... 756
Positioning Objects in a Document or In-Document Analytic Dashboard Using the
Positioning Group ...................................................................................... 757
Relating Objects on a Page in a Document Using the Relationships Group ........... 758
Aligning Text in a Document Using the Text Alignment Group ............................. 758
Changing Properties of a Document or In-Document Analytic Dashboard Using the
Utilities Tab ............................................................................................... 759
Adding or Chaining Objects in a Document or In-Document Analytic Dashboard
Using the Chaining Group .......................................................................... 759
Working With the Files Utility Group ................................................................ 760
Viewing Panels Associated With a Document or In-Document Analytic Dashboard
Using the View Group ................................................................................. 761
Previewing the Document Canvas .................................................................... 762
Editing Document Canvas Properties ............................................................. 762
Supporting Template Masters and Slide Layouts in App Studio-Generated Presentations ....... 763

9. Creating Maintain Data Applications ......................................................... 767

Using the Maintain Data App ......................................................................... 768
Freezing Grid Columns Using the FixedColumns Property. 847
Closing and Exiting a Form. 847
JavaScript onclick window.close Function. 848
Embedded or Linked JavaScript Files or CSS Files. 848
Displaying Forms and Databases. 848
Property Functions in JSGrid. 848
Migrating JavaScript Functions to App Studio Maintain Data. 848
  Function: SetCellFocus. 849
  Function: GetNumberRows and GetNumberColumns. 849
  Function: GetCurrentRow and GetCurrentColumn. 850
  Function: CellSetBackColor. 850
  Function: CellGetBackColor. 851
  Function: CellSetTextColor. 852
  Function: CellGetTextColor. 853
  Function: CellSetText. 853
  Function: CellGetText. 854
  Function: CellSetFontSize. 855
  Function: CellSetFontStyle. 856
  Function: CellSetFont. 857
  Function: CellSetReadOnly. 858
  Function: CellGetReadOnly. 859
  Function: ColumnSetContentType. 859
Check Box Property. 860

10. Creating Esri Maps 861
  Illustrating Trends 862
  Using the WebFOCUS Esri HTML5 Viewer 864
  Creating an Esri Component on an HTML Page 865
    Configuring the Esri Map Component. 866
  Using Unified Geographic Roles 869
  Configuring a Map Data Layer 894
  Adding a Demographic Layer to a Map 905
  Adding an RSS Feed to an Esri Map 910
Preface

This content describes WebFOCUS App Studio, a Windows®-based GUI development environment for creating WebFOCUS applications. App Studio provides innovative features and functions that simplify development, thereby allowing you to concentrate on interface design, business logic, and data manipulation. Features include data visualization, color exception reporting, intelligent drill downs, and the ability to generate HTML pages without writing code.

How This Manual Is Organized

This manual includes the following chapters:

<table>
<thead>
<tr>
<th>Chapter/Appendix</th>
<th>Contents</th>
</tr>
</thead>
<tbody>
<tr>
<td>2 Navigating in App Studio</td>
<td>Identifies the main components of the App Studio interface.</td>
</tr>
<tr>
<td>3 Creating Metadata</td>
<td>Describes how to create and edit metadata in App Studio.</td>
</tr>
<tr>
<td>4 Creating Reports</td>
<td>Describes how to launch the Report Wizard to create reports, the types of reports you can create with App Studio, and the tabs and panels that are available when you are developing reports in the Report canvas.</td>
</tr>
<tr>
<td>5 Creating Charts and Visualizations</td>
<td>Describes how to launch the Chart Wizard to create charts and the types of charts you can create with App Studio.</td>
</tr>
<tr>
<td>6 Creating Procedures</td>
<td>Describes the Join tab, creating and working with joins, creating procedures, and the Procedure View panel.</td>
</tr>
<tr>
<td>7 Creating HTML Pages</td>
<td>Describes how to launch the HTML/Document Wizard, and how to create and edit HTML pages.</td>
</tr>
<tr>
<td>8 Creating Documents</td>
<td>Describes how to launch the HTML/Document Wizard, and how to create and edit documents.</td>
</tr>
<tr>
<td>Chapter/Appendix</td>
<td>Contents</td>
</tr>
<tr>
<td>-----------------</td>
<td>----------</td>
</tr>
<tr>
<td>9 Creating Maintain Data Applications</td>
<td>Describes how to use the Maintain Data App and create Maintain Data applications using the HTML canvas.</td>
</tr>
<tr>
<td>10 Creating Esri Maps</td>
<td>Describes how to create Esri maps in App Studio.</td>
</tr>
<tr>
<td>11 Working With Source Control</td>
<td>Describes how to implement Source Control in App Studio.</td>
</tr>
<tr>
<td>A Creating, Viewing, and Editing Source Syntax</td>
<td>Describes the Text Editor that is available when you are developing the source syntax for procedures, procedure components, and other types of files.</td>
</tr>
<tr>
<td>B Selenium Browser Support</td>
<td>Describes Selenium browser support and tier setup.</td>
</tr>
<tr>
<td>C Troubleshooting</td>
<td>Provides troubleshooting tips and information on using verification and tracing tools.</td>
</tr>
</tbody>
</table>

## Conventions

The following table describes the conventions that are used in this manual.

<table>
<thead>
<tr>
<th>Convention</th>
<th>Description</th>
</tr>
</thead>
</table>
| **THIS TYPEFACE**
or
**this typeface** | Denotes syntax that you must enter exactly as shown. |
<p>| <strong>this typeface</strong> | Represents a placeholder (or variable) in syntax for a value that you or the system must supply. |
| <strong>underscore</strong> | Indicates a default setting. |
| <strong>this typeface</strong> | Represents a placeholder (or variable), a cross-reference, or an important term. It may also indicate a button, menu item, or dialog box option that you can click or select. |
| <strong>Key + Key</strong> | Indicates keys that you must press simultaneously. |</p>
<table>
<thead>
<tr>
<th>Convention</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>{ }</td>
<td>Indicates two or three choices. Type one of them, not the braces.</td>
</tr>
<tr>
<td>[ ]</td>
<td>Indicates a group of optional parameters. None are required, but you may select one of them. Type only the parameter in the brackets, not the brackets.</td>
</tr>
<tr>
<td></td>
<td>Separates mutually exclusive choices in syntax. Type one of them, not the symbol.</td>
</tr>
<tr>
<td>...</td>
<td>Indicates that you can enter a parameter multiple times. Type only the parameter, not the ellipsis (...).</td>
</tr>
<tr>
<td>. . . .</td>
<td>Indicates that there are (or could be) intervening or additional commands.</td>
</tr>
</tbody>
</table>

**Related Publications**

Visit our Technical Documentation Library at [http://documentation.informationbuilders.com](http://documentation.informationbuilders.com). You can also contact the Publications Order Department at (800) 969-4636.

**Customer Support**

Do you have questions about this product?

Join the Focal Point community. Focal Point is our online developer center and more than a message board. It is an interactive network of more than 3,000 developers from almost every profession and industry, collaborating on solutions and sharing tips and techniques. Access Focal Point at [http://forums.informationbuilders.com/eve/forums](http://forums.informationbuilders.com/eve/forums).

You can also access support services electronically, 24 hours a day, with InfoResponse Online. InfoResponse Online is accessible through our website, [http://www.informationbuilders.com](http://www.informationbuilders.com). It connects you to the tracking system and known-problem database at the Information Builders support center. Registered users can open, update, and view the status of cases in the tracking system and read descriptions of reported software issues. New users can register immediately for this service. The technical support section of [www.informationbuilders.com](http://www.informationbuilders.com) also provides usage techniques, diagnostic tips, and answers to frequently asked questions.
Call Information Builders Customer Support Services (CSS) at (800) 736-6130 or (212) 736-6130. Customer Support Consultants are available Monday through Friday between 8:00 a.m. and 8:00 p.m. EST to address all your questions. Information Builders consultants can also give you general guidance regarding product capabilities. Please be ready to provide your six-digit site code number (xxxx.xx) when you call.

To learn about the full range of available support services, ask your Information Builders representative about InfoResponse Online, or call (800) 969-INFO.

**Information You Should Have**

To help our consultants answer your questions effectively, be prepared to provide the following information when you call:

- Your six-digit site code (xxxx.xx).

- Your WebFOCUS configuration:
  - The front-end software you are using, including vendor and release.
  - The communications protocol (for example, TCP/IP or HLLAPI), including vendor and release.
  - The software release.
  - Your server version and release. You can find this information using the Version option in the Web Console.

- The stored procedure (preferably with line numbers) or SQL statements being used in server access.

- The Master File and Access File.

- The exact nature of the problem:
  - Are the results or the format incorrect? Are the text or calculations missing or misplaced?
  - Provide the error message and return code, if applicable.
  - Is this related to any other problem?

- Has the procedure or query ever worked in its present form? Has it been changed recently? How often does the problem occur?

- What release of the operating system are you using? Has it, your security system, communications protocol, or front-end software changed?
Is this problem reproducible? If so, how?

Have you tried to reproduce your problem in the simplest form possible? For example, if you are having problems joining two data sources, have you tried executing a query containing just the code to access the data source?

Do you have a trace file?

How is the problem affecting your business? Is it halting development or production? Do you just have questions about functionality or documentation?

User Feedback

In an effort to produce effective documentation, the Technical Content Management staff welcomes your opinions regarding this document. You can contact us through our website, http://documentation.informationbuilders.com/connections.asp.

Thank you, in advance, for your comments.

Information Builders Consulting and Training

Interested in training? Information Builders Education Department offers a wide variety of training courses for this and other Information Builders products.

For information on course descriptions, locations, and dates, or to register for classes, visit our website (http://education.informationbuilders.com) or call (800) 969-INFO to speak to an Education Representative.
Introducing WebFOCUS App Studio

WebFOCUS is a complete, web-ready data access and reporting system that connects users to data. It accesses and processes information located in any format, on any platform, and presents that information to end users through a web browser.

Business intelligence (BI) needs continue to evolve, as organizations seek to make more information from more sources available to more people inside and outside the enterprise. Developers need powerful, yet flexible tools in order to satisfy the increasingly sophisticated BI content demands posed by a growing number of employees, customers, suppliers, partners, and other stakeholders.

WebFOCUS App Studio is the Windows-based graphical user interface (GUI) environment for creating advanced ReportCaster applications. WebFOCUS App Studio is the most robust BI application development platform on the market today.

In this chapter:

- What Is App Studio?
- Launching App Studio
- Documentation Overview

What Is App Studio?

Building on the industry-familiar Microsoft Office Ribbon Interface, App Studio offers a simplified user experience and workflow, empowering developers to create application content immediately, without a costly and time-consuming learning curve. Additionally, it dramatically increases development efficiency by eliminating the need for developers to utilize multiple tools to piece together a BI application.

App Studio provides:

- **Rapid deployment.** Installation and setup are fast and simple.

- **Ease of use.** A familiar ribbon interface, which can be customized to individual preferences, allows users to get up to speed quickly.
Maximum flexibility. Build and deploy ad hoc or instant queries that go beyond the prescriptions of any particular application. Developers can also add dimensions to data structures at any time without affecting other queries, since the underlying data source is not changed.

Support for complex requests. Unlike other BI development environments, which require the use of complex code to handle anything more than the most simple of requests, App Studio allows users to create any request, no matter how sophisticated, using the same intuitive interface.

App Studio eliminates the complex multi-tool paradigm that exists with most other development solutions, providing a single, fully-integrated environment for rapidly designing and creating reports, dashboards, InfoApps, and other types of BI apps and content, including:

- Income statements, balance sheets, and other types of tabular or financial reports.
- Charts and visualizations. A library of more than 120 HTML5 chart types meet the needs of every information consumer.
- Dashboards that draw data from one source, or multiple disparate systems. Dashboards can be viewed online or offline in disconnected mode, with full interactivity and analytical capabilities.
- Documents for print, including Adobe PDF, interactive PDF, Microsoft PowerPoint, and more.
- InfoApps, business intelligence applications that are form-driven and extremely simple to use, providing the most effective way to make information accessible to all stakeholders, as well as for custom and SaaS implementations.
- Mobile BI applications that run on any device and on any platform.
- Responsive designs that conform to the device form factor, maximizing the user experience.
- Metadata creation and modeling, such as multifact star schemas, joins, and business views.

App Studio Capabilities

In App Studio, you can do the following:

Access data and descriptions. Using the Metadata canvas, you can create new synonyms, and view or modify existing synonyms, in a graphical user interface. Synonyms enable you to access and interpret data sources for use in reporting applications. Capabilities include metadata design and development, with full visual modeling of schemas.
Create reporting applications. Build reporting procedures in the Report Canvas, Chart Canvas, HTML Canvas, or Document Canvas, which can include the following components.

- **Reports.** Display your data in a tabular format. You can create stand-alone reporting procedures, or add the report to a document or an HTML page.

- **Charts.** Communicate your data in a more illustrative format. You can translate complex data into an easy-to-read and understandable visual format. This often provides a new perspective to the information that users view. You can create stand-alone charting procedures or add the chart to a document or an HTML page.

- **HTML pages.** Build webpages for users to launch, view, and analyze data. You can add multiple reports and charting procedures to an HTML page, in addition to the controls that enable you to manipulate the data. You can also apply styling through the use of cascading style sheets (CSS), JavaScript files, and jQuery animations.

- **Documents.** Combine multiple report and charting procedures in a single output that you can organize and format. You can also add pre-process and post-process codes to customize how your document is executed.

- **Visualizations.** Create charts, maps, and grids to visually represent your data. You can add multiple visuals to the canvas to create a complete visualization, and you can update, change, or revise the visualization at any time to account for shifts in data needs.

- **Alerts.** Create event-driven procedures that apply test conditions and then trigger customized reports if the test conditions are true. You can schedule an Alert using ReportCaster Distribution Methods.

- **Reporting Objects.** Transform complex views of data into simple objects that are labeled with common business terminology for users to understand and use as templates to create their own reports.

Customize reporting applications. In addition to customizing your reporting applications by applying styling and color, you can add the following components to a procedure.

- **Virtual fields (DEFINE or COMPUTE statements).** Create temporary fields that are treated as real fields stored in the data source.

- **Define functions.** Create user functions that you can use in components of a procedure. You can retrieve your stored functions from the Functions Arguments dialog box.

- **Joins.** Define relationships between two or more data sources so that a report can use the data from all sources at once. You can also merge data sources by creating logical expressions on the Match canvas.
Manage your environment. You can apply the following functions to your reporting applications to change the behavior of your environment.

- **Set.** Control the way that reports and charts appear on the screen or printer, the content of reports and charts, data retrieval characteristics that affect performance, and system responses to user requests. The Set component also helps you to set up your metadata and manipulate information, such as dates. Use the Set component to override default settings for your procedure.

- **Allocation.** Assign logical names and storage locations to the files that you create and use in WebFOCUS.

- **Use.** Identify a FOCUS data source to use in your procedure.

**WebFOCUS Architecture**

This topic briefly explains the main WebFOCUS components and implementations. For a complete description of WebFOCUS, see the WebFOCUS documentation.

**WebFOCUS and Your Network**

WebFOCUS integrates into your existing network by connecting your web server to your data. End users access WebFOCUS applications through a web browser, so they need only the following elements:

- **Web browser.** To access WebFOCUS applications, users need a browser and a TCP/IP connection to a web server.

- **Web server.** Web servers handle requests by returning files to a browser or by executing processes that provide additional functionality. You can provide WebFOCUS functionality by connecting to the web server using Java servlet calls.

- **Data.** WebFOCUS can access data from almost anywhere. Once you have configured data access and described that data, you can report on it.

**WebFOCUS Components**

There are two main WebFOCUS components.

- **WebFOCUS Client.** The WebFOCUS Client resides on the web server and connects WebFOCUS to the web through Java servlets. When a user makes a request from App Studio or a browser, the WebFOCUS Client receives and processes the request by passing it to the Reporting Server.
Note: When you perform a full App Studio installation for stand-alone development, you do not have to install the WebFOCUS Client separately because it is packaged with App Studio.

A stand-alone development environment is typically one in which all software components (the web server, WebFOCUS Client, and Reporting Server) are installed on the same local machine. This configuration gives you access to all your application files and data from a single machine. You do not need a physical network connection to access any other machine in order to accomplish your development tasks.

WebFOCUS Reporting Server. The Reporting Server resides on machines that can access your data. The Reporting Server provides data access, number crunching, and report generation functionality.

WebFOCUS Configuration

WebFOCUS employs a distributed architecture, so the WebFOCUS Client, Reporting Server, and your data can be located on any platform, anywhere in your network.

You can easily connect an Apache® web server running on UNIX to SQL Server data on Windows, or Db2 data on z/OS. Any number of WebFOCUS Reporting Servers can be connected to the WebFOCUS Client. WebFOCUS can report on all of them.

Configuring a distributed architecture requires the following:

- The WebFOCUS Client must reside on a machine with a web server.
- An instance of the Reporting Server must be installed on machines with your data, or machines that have access to your data.

App Studio Architecture

This topic briefly explains the main App Studio components and implementations.

WebFOCUS App Studio includes the following components:

- App Studio Graphical User Interface (GUI). Graphical development and code generation features for application development.

- WebFOCUS Reporting Server. A basic Reporting Server for local processing, stand-alone development, access to data, report generation, chart generation, and running requests.

- WebFOCUS Client. A scaled-down WebFOCUS Client with available functionality that is based on the App Studio edition you license.
Derby database. An embedded database that stores user accounts and policies required for the connection of App Studio to its local WebFOCUS Client. Derby is only installed in App Studio editions that are licensed for local/stand-alone development. It is used for authentication, and comes with preloaded user IDs that possess developer and administration permissions.

Note: If you install App Studio on the same machine as WebFOCUS 8, you can configure App Studio to utilize the WebFOCUS 8 Derby database.

Reference: App Studio Directory Structure

This topic references the App Studio directory structure created after installation. The default directory is drive:\ibi.

\apps
Contains directories and data. By default, this is the Application Root directory (APPROOT directory) in which WebFOCUS searches for application files. Sample files are provided in the \ibinccen and \ibisamp directories.

The Application Root directory is created during the installation of App Studio and the WebFOCUS Reporting Server.

It is defined by the APPROOT variable in the server configuration file, edaserve.cfg, and the IBI_Approot_Directory variable that is defined during the WebFOCUS installation. These variables point to the Application Root directory for applications that reside on the web server where WebFOCUS is installed.

\AppStudio82
Contains the graphical front-end components for creating App Studio content.

\AppStudio82\srv\home
Contains the local Reporting Server files.

\AppStudio82\derby
Contains the Derby database files.

For more information, see the App Studio Directory Structure topic in the WebFOCUS App Studio Installation and Configuration Guide.
WebFOCUS and App Studio Processing

The following figure illustrates how WebFOCUS and App Studio process requests. Each step is explained below the figure.

1. A user makes a request and passes parameters by calling a WebFOCUS Servlet through links and forms on a webpage, or through App Studio.

2. The request and parameters come to the WebFOCUS Client on the web or application server, which processes the parameters and creates a request for the Reporting Server.

3. The Reporting Server receives the request, processes it, and accesses any necessary data.

4. Data is retrieved from data sources to process the request.

5. The Reporting Server processes the user request using the retrieved data.

6. The response is returned to the WebFOCUS Client on the web or application server.

7. The response is returned to the user.

App Studio processes requests the same way that WebFOCUS does:

- To access WebFOCUS or a remote Reporting Server, App Studio calls a servlet on a remote web or application server.

- To process requests using the local WebFOCUS Client and Reporting Server installed with App Studio, App Studio calls the local Reporting Server through a local web or application server using a servlet. Therefore, to run reports locally, your machine requires a web server.

App Studio Development Modes

App Studio allows local (stand-alone) development and development against a remote environment. From the Environments Tree panel, you can develop applications locally on your machine, or against a remote WebFOCUS environment.

In App Studio, you build applications consisting of different kinds of files. You can create the application as a stand-alone application in a development environment or as a web-based self-service application.
With a full App Studio installation, you can do the following:

- Connect to one or more remote servers and modify existing self-service applications on those servers. For example, you can add a reporting procedure to an existing application.

- Configure access to one or more WebFOCUS environments so you can manage resources on the WebFOCUS Client and Reporting Server, and in the domain (if Managed Reporting is installed). For example, you can create and edit procedures, metadata, HTML files, and more.

**Note:** If you do not have a Reporting Server and WebFOCUS Client on your development machine (for example, the Managed Reporting Application edition of App Studio), your environment allows the last two capabilities.

**Remote Development**

App Studio provides the following scenarios for remote development:

- Use the Data Servers area to develop applications directly on the Reporting Server and edit resources in place against remote environments.

- Use the domain area to access the Managed Reporting domain. From here, you can develop and manage Managed Reporting applications against a configured WebFOCUS environment.

- Use the Web Applications area to manage resources on the web tier, and edit the resources in place against remote environments. HTML pages, cascading style sheets (CSS), and other web components can be stored in the Web Applications node. You can view and modify files with an editor.

**Reference:** *Summary of Steps for Remote Development*

To create a new application on a server platform:

1. **Install App Studio.** Use the installation program to install App Studio on your Windows machine.

2. **Add a WebFOCUS environment.** Add an environment from the WebFOCUS Environment Properties dialog box. For more information, see *How to Add a WebFOCUS Environment* on page 106.

3. **Create an application folder on the server.** Create the application folder in the Data Servers area, or develop directly against the domain.

4. **Create, develop, and test the application components.** Open the application, create its components (procedures, data source synonyms, HTML files, and related files), and develop and test them on the Reporting Server and WebFOCUS Client.
Launching App Studio

Once you have installed App Studio, you can launch the product and begin developing applications.

You can launch App Studio in one of the following ways:

- **Launch App Studio and the App Studio Reporting Server at the same time.** From the Start menu, expand the *Information Builders* program group, expand the *WebFOCUS App Studio* folder, and then click *WebFOCUS App Studio*. Both App Studio and the App Studio Reporting Server start at the same time.

  When App Studio starts, the Reporting Server installed with App Studio is started with Security OFF.

- **Start your Reporting Server and then launch App Studio.** If you have installed a stand-alone version of App Studio, or a stand-alone Reporting Server for use with WebFOCUS, you can start your Reporting Server before launching App Studio.

  - **Stand-alone App Studio.** From the Start menu, expand the *Information Builders* program group, expand the *WebFOCUS 82 App Studio* folder, and expand the *WebFOCUS 82 Server for App Studio* folder. Select *Start Security OFF* to start the Reporting Server without security, or *Start Security ON* to start the Reporting Server securely. The Reporting Server opens a command window. Once the process is complete, launch App Studio.

  - **Stand-alone Reporting Server.** From the Start menu, expand the *Information Builders* program group, and expand the *WebFOCUS 82 Server* folder. Select *Start Security OFF* to start the Reporting Server without security, or *Start Security ON* to start the Reporting Server securely. The Reporting Server opens a command window. Once the process is complete, launch App Studio.

  **Note:** Additional configuration steps are required if you choose to start the Reporting Server with Security ON. For more information, see the *WebFOCUS App Studio Installation and Configuration Guide*.

When App Studio first opens, you may be prompted to sign in to your local host environment. You can enter the ID, *wfdesktop*, with no password. For more information, see *Navigating in App Studio* on page 39.

**Note:** If you have previously configured WebFOCUS environments on your machine, those environments appear when you launch App Studio.
Documentation Overview

The following documentation components are available for App Studio users:

- WebFOCUS App Studio Installation and Configuration Guide
- Context-sensitive online Help system
  
  You can access the online Help system through the product. Press F1 on your keyboard or click Help throughout the interface to open the Help window. The online Help system is designed to provide you all of the information that you need to develop content in App Studio.

- Help Wizard
  
  You can access the Help Wizard by selecting the Help Wizard button in the View group on the Home tab of the App Studio ribbon. By default, the Help Wizard panel opens in the bottom-right corner of the interface. The Help Wizard content dynamically changes, depending on where you are in the interface.
Navigating in App Studio

App Studio provides an easy-to-use interface for creating applications, such as reports, charts, HTML pages, and documents.

The first time you launch App Studio, a default interface opens. You can modify the default interface by customizing the appearance of the application window and rearranging the placement of the main interface components.

These changes are automatically saved and made available the next time you launch the product.

In this chapter:

- The App Studio Interface
- Initiating App Studio
- Opening the Application Menu of File-Related Commands
- Accessing Frequently Used Commands
- Developing Applications in the Canvas Area
- Accessing Features With the Ribbon
- Working With the Environments Tree Panel
- Working With the Environments Detail Panel
- Viewing File and Folder Properties
- Editing Areas of Functionality Using the View Tabs
- Customizing the Panels

The App Studio Interface

The main components of the default App Studio interface are shown in the following image.
The App Studio interface components are identified as follows:

- **Welcome screen.** Provides access to resources that help you get started with the product as you develop content. For more information, see *Initiating App Studio* on page 41.

- **Application button.** Provides access to the Application menu of file-related commands. For more information, see *Opening the Application Menu of File-Related Commands* on page 41.

- **Quick Access Toolbar.** Displays frequently used commands, such as Open, Save, Quick Print, Undo, Redo, Cut, Copy, Paste, and Run. For more information, see *Accessing Frequently Used Commands* on page 60.

- **Ribbon.** Displays both static and contextual tabs of commands that you can use to build and customize applications. For more information, see *Accessing Features With the Ribbon* on page 73.

- **Environments Tree panel.** Provides access to the WebFOCUS environments you configure and files you create under each development area. For more information, see *Working With the Environments Tree Panel* on page 86.
Canvas. Provides an active preview of your application development. For more information, see Developing Applications in the Canvas Area on page 64.

Initiating App Studio

When you initiate App Studio for the first time, the Welcome screen opens.

From the Welcome screen, you can access the Getting Started video, and a suite of how-to videos that open within the software window. It also provides a direct link to the App Studio resources that are available on the WebFOCUS 8.2.x Information Center.

You can select the Don’t show this dialog again check box to prevent the Welcome screen from opening the next time you launch App Studio.

Note: You can also control the appearance of the Welcome screen through the Options dialog box. For more information, see Setting User Preferences Using the Options Dialog Box on page 45.

Opening the Application Menu of File-Related Commands

The Application button, represented by the App Studio icon , opens the Application menu of file-related commands. You can open an existing document, save an active document, and print an active document. The Options button opens the App Studio Options dialog box, where you can set user preferences. The Application menu also lists recently opened documents. The Application button is always available. It is located in the upper-left corner of the App Studio interface.

Tip: Double-click the Application button to exit App Studio. If you exit App Studio in this way, active (open) applications will not be saved.

From the Application menu, you can perform the following actions:

- **Open.** Open an existing document. You can open a file from the list of configured WebFOCUS environments.
- **Save.** Save the active document.
- **Save As.** Save the active document with a new name.
- **Save All.** Save all open documents with the current file names. There will be no prompting for file names.
- **Run.** Run the report, chart, HTML page, or document. When you click the Run menu, the Message Viewer Options submenu opens.
From the Message Viewer Options submenu, you can select from among four Message Viewer Options that affect the App Studio Viewer display when a report, chart, HTML page, or document is run. The options are:

- When you select Message Viewer OFF and run a report, the App Studio Viewer window displays the report without any messages.

- When you select Message Viewer ON and run a report, the App Studio Viewer window displays the report and a message.

- When you select Display command lines, the App Studio Viewer window displays the report and the command lines.

- When you select Display Dialogue Manager commands, the App Studio Viewer window displays the report and the Dialogue Manager commands, and the result of their evaluation.

- **Print.** Print the active document. When you click the **Print** menu, the Preview and print the document submenu opens.

  From the Preview and print the document submenu, you can print the active document using the current print options, preview the active document before printing, and configure your print options.

  **Note:** The Print and Quick Print options are only available when you edit content in the Text Editor, or when the Source view tab, in the Report canvas, is active.

- **Close.** Close the active document.

- **Close All.** Close all open documents. If changes were made to a file, you will be prompted to save the changes.

- **Options.** Open the Options dialog box, where you can set user preferences.

- **Exit.** Close the active document and exit App Studio.

**Note:**

- In the Application menu, the terms *document* and *active document* represent all files which you can create in App Studio.
Spaces are not allowed in file names. When naming a report, chart, HTML page, or document in their respective wizards or in the Save As dialog box, spaces are replaced with underscores (_). When naming a procedure, spaces and underscores are not permitted, and when you press the Space bar, nothing happens. If the domain is set to display by title, the wizards, Open dialog box, and Save As dialog box will still expect a proper name, with no spaces, to be entered.

Reference: Open File Dialog Box

The Open File dialog box opens when you click Open from the Application menu or the Quick Access toolbar.

The Open File dialog box displays files that you can open and edit in App Studio.

**Configured Environments list**

Contains a list of currently Configured Environments. You can navigate to different environments and development areas to display different files in the file list.

**File list**

Displays all files of a specific type in a selected folder and includes the name, size, type, last modified date, location, database type, title, and status of the file.

**Note:** Instead of the regular Master File icon, Master Files that have a DEFINE use the DEFINE icon and Master Files that have a Join use the JOIN icon.

**Preview**

Displays a preview of the contents in a selected file or a thumbnail preview of a selected image.

**File name text box**

Use this text box to type the name of a file you want to open.

**Note:** If you are in the Domains area and the Configured Environments tree is set to display by title, the Open File dialog box will only require a name to be entered.

**File Type drop-down list**

Filters to display all files of a specified file type. You can filter for .fex, .htm, .js, .css, .prtl, .page, .blog, .sch, .adr, .ad, .sty, .mnt, .txt, and .lib. You can also choose to display all files.

**Use Qualified Path**

When selected, the fully qualified path name of the file you select will be used.

**Note:** This check box appears only in the Report and Chart Wizard.
**Show Tree**

When selected, displays the Configured Environments tree. This option is only available when opening a file using commands and features in the Report canvas, HTML canvas, Document canvas, Join canvas, and the Procedure View panel.

**Details Toggle**

Toggles between displaying the files in the file list with details (date modified, size, and so on) or in a list. Displaying files with details is the default.

**Note:** App Studio remembers your choice and will keep the setting you chose the next time the Open File dialog box is open. For example, if you choose to display file details the first time you invoke the Open File dialog box, then the next time you invoke the Open File dialog box, file details are shown.

**Refresh Button**

When clicked, refreshes the list of available files.

**Reference:** **Save As Dialog Box**

The Save As dialog box opens when you click Save As from the Application menu. You can use this dialog box to save a file to another location or to provide a different file name.

**Configured Environments list**

Contains a list of currently Configured Environments. You can navigate to different environments and development areas to display different files in the file list.

**File list**

Displays all files of a specific type in a selected folder.

**File name text box**

Use this text box to type the name of a file you want to open.

**Note:** If you are in the Domains area and the Configured Environments tree is set to display by title, the Save As dialog box will only require a name to be entered.

**File Type drop-down list**

Displays the filter based on applicable file type.

**Details Toggle**

Toggles between displaying the files in the file list with details (date modified, size, and so on) or in a list. Displaying files with details is the default.
**Note:** If you choose to display details or not, App Studio remembers your choice and will keep the setting you chose the next time the Open File dialog box is open. For example, if you choose to display file details the first time you invoke the Open File dialog box, then the next time you invoke the Open File dialog box, file details are shown.

**Refresh Button**

When clicked, refreshes the list of available files.

### Setting User Preferences Using the Options Dialog Box

You can customize App Studio by setting specific user preferences, using the following tabs in the App Studio Options dialog box. To open the Options dialog box, click **Options** in the Application menu.

**Reference:** General Tab

The General tab contains options for starting App Studio, minimizing the main window, and other settings. The following options are available.

**Main Window Options**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximize main window</td>
<td>Maximizes the application window when you begin each session.</td>
</tr>
</tbody>
</table>

**Smart Context**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Set new column type based on metadata/surrounding fields</td>
<td>Sets new column types by using metadata and surrounding fields.</td>
</tr>
<tr>
<td>Activate Field ribbon tab when selecting a field on the report canvas</td>
<td>Activates the Field tab on the ribbon upon selection of a field within the report canvas.</td>
</tr>
<tr>
<td>Activate Layout ribbon tab when no selection is made on the report canvas</td>
<td>Activates the Layout tab on the ribbon when no selection is made on the report canvas and you click the white space.</td>
</tr>
</tbody>
</table>

**Other Settings**
<table>
<thead>
<tr>
<th><strong>Option</strong></th>
<th><strong>Description</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Show Welcome Screen</td>
<td>Controls the appearance of the Welcome screen when App Studio is launched.</td>
</tr>
<tr>
<td>Confirm close</td>
<td>Displays a prompt for users to confirm that they want to exit App Studio.</td>
</tr>
<tr>
<td>Start local WebFOCUS Server</td>
<td>Starts the local Reporting Server when App Studio is launched.</td>
</tr>
<tr>
<td>Stop local WebFOCUS Server on exit</td>
<td>Stops and closes the local Reporting Server when you exit App Studio.</td>
</tr>
<tr>
<td>Recent file list limit</td>
<td>Allows you to set the number of recently used files that appear in the Recent file lists. The default value is 25.</td>
</tr>
<tr>
<td>Ping Interval (minutes)</td>
<td>Sets the frequency at which requests are sent to the web or application server so your connection does not time out. The default is 5.</td>
</tr>
<tr>
<td>Reset All Message Boxes</td>
<td>Resets all message boxes to their default state. For example, if you selected the <em>Don’t show this message again</em> check box in any message box, clicking this button will reset all message boxes. Once you click this button, it becomes inactive until you choose not to display a message box in the product.</td>
</tr>
<tr>
<td>Reset All Options to Default</td>
<td>Restores all options in App Studio to the default settings.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Default file editor</td>
<td>Lists file editor options, such as:</td>
</tr>
<tr>
<td></td>
<td>- Edit in App Studio canvas</td>
</tr>
<tr>
<td></td>
<td>- Edit in Text Editor</td>
</tr>
<tr>
<td></td>
<td>- Edit in Windows registered tool</td>
</tr>
<tr>
<td><strong>Note:</strong> The Edit in Windows registered tool option is only visible if the file type you are accessing has been associated with a Windows application.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>The file editor used determines which shortcut menu options are available and controls the default behavior for double-clicking and right-clicking files.</td>
</tr>
<tr>
<td>Language</td>
<td>Provides a drop-down list that allows you to change the language of the App Studio screen text. After you change the language, restart App Studio to make the change effective. The languages listed are selected in the Dynamic Language Switch setting in the WebFOCUS Administration Console.</td>
</tr>
<tr>
<td></td>
<td>The Sync with WebFOCUS check box is selected, by default. When this check box is selected, the language used for App Studio and WebFOCUS are synced with the language selected in the Language drop-down list. If this check box is not selected, App Studio uses the language selected in the Language drop-down list and WebFOCUS uses the language selected in the Environments dialog box. If you make changes, restart App Studio to make the change effective.</td>
</tr>
</tbody>
</table>

**Reference:** Reporting Tab

The Reporting tab contains format options for output, field list displays, formatting a report for the web, and setting the record retrieval limits. The following options are available.

**Field List Options**
The following options affect the appearance of the Fields tab of the Object Inspector.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sort the list by field name</td>
<td>Sorts any list of field names alphabetically.</td>
</tr>
<tr>
<td>Show fully qualified field names</td>
<td>Displays any list of field names as qualified field names, which include data source and table names, alphabetically.</td>
</tr>
<tr>
<td>Display the field name</td>
<td>Displays the full field name in the Fields tab, as specified in the file description.</td>
</tr>
<tr>
<td>Display the field alias</td>
<td>Displays the alternate field name in the Fields tab, as specified in the file description.</td>
</tr>
<tr>
<td>Display field titles</td>
<td>Displays the titles for columns, filters, and computes in the Fields tab, as specified in the file description.</td>
</tr>
<tr>
<td>Display field descriptions</td>
<td>Displays descriptive information about the field in the Fields tab, as specified in the file description.</td>
</tr>
<tr>
<td>Display the data formats</td>
<td>Displays the field length and format type in the Fields tab, as specified in the file description.</td>
</tr>
<tr>
<td>Expand field tree</td>
<td>Displays fields in expanded mode when using a Field tree. If this option is not selected, segments appear collapsed wherever a Field tree appears. <strong>Note:</strong> This option can also be accessed from the Field tree shortcut menu.</td>
</tr>
<tr>
<td>Display Filters in Filters Folder</td>
<td>Displays Filters in a separate Filters folder of the Field tree. If this option is not selected, Filters appear with the rest of the fields in the segment. <strong>Note:</strong> This option can also be accessed from the Field tree shortcut menu.</td>
</tr>
</tbody>
</table>

**Authoring Mode**

The Authoring Mode options determine how field names in a procedure (.fex) are written in the App Studio source code. These options are not affected by the selected Field List options.
<table>
<thead>
<tr>
<th><strong>Option</strong></th>
<th><strong>Description</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Qualified fieldname</td>
<td>Writes the source code using qualified field names, for example: &lt;br/&gt;BY 'GGSALES.SALES01.CATEGORY'</td>
</tr>
<tr>
<td>Unqualified fieldname</td>
<td>Writes the source code using unqualified field names, for example: &lt;br/&gt;BY CATEGORY</td>
</tr>
<tr>
<td>Alias fieldname</td>
<td>Writes the source code using alias field names, as defined in the ALIAS field of the Master File. The ALIAS field assigns an alternative name for a column.  &lt;br/&gt;The following example shows source code in which the Category field name is assigned E02 in the ALIAS field of the ggsales.mas Master File: &lt;br/&gt;BY E02</td>
</tr>
</tbody>
</table>
### Other

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default Report Format</td>
<td>Sets a report format to use as the default format by the Reporting feature. Select the display format for your reports. You can select from the following options:</td>
</tr>
<tr>
<td></td>
<td>- HTML</td>
</tr>
<tr>
<td></td>
<td>- HTML Analytic Document</td>
</tr>
<tr>
<td></td>
<td>- PDF Analytic Document</td>
</tr>
<tr>
<td></td>
<td>- PDF</td>
</tr>
<tr>
<td></td>
<td>- Excel XLSX</td>
</tr>
<tr>
<td></td>
<td>- Excel XLS</td>
</tr>
<tr>
<td></td>
<td>- PowerPoint PPTX</td>
</tr>
<tr>
<td></td>
<td>- PowerPoint PPT</td>
</tr>
<tr>
<td></td>
<td>- Default (This option is the FOCUS default. It applies to whichever of the previous formats was set as an environment parameter.)</td>
</tr>
<tr>
<td></td>
<td>- User</td>
</tr>
<tr>
<td>Maximum number of records to retrieve</td>
<td>Specifies a limit on the number of records to retrieve from the data source. Setting a retrieval limit creates selection criteria for both Retrieval Limit and Read Limit dialog boxes. Specify a retrieval limit when you need only a few records to test the design of a new report, or you know how many records meet the test criteria and want to stop a search after those records are retrieved. This reduces total retrieval time.</td>
</tr>
<tr>
<td>Maximum number of readings to make</td>
<td>Specifies a limit on the number of readings that can be made against the data source.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Default Style Template</td>
<td>Specifies the default styling template when you open the Report feature.</td>
</tr>
<tr>
<td>Default Report Template</td>
<td>Specifies the default report settings when you open the Report canvas. Click <em>Browse</em> to select user-created templates.</td>
</tr>
<tr>
<td>Retrieve master file descriptions</td>
<td>Displays Master File suffix and description in the Environments Tree, and in the Chart Wizard and the Report Wizard. System performance may be affected if there are a large number of Master Files. This option is not selected, by default.</td>
</tr>
<tr>
<td></td>
<td>If you change this option, you must exit App Studio and reopen it for the change to take effect.</td>
</tr>
<tr>
<td>Enable OLAP</td>
<td>Activates the use of OLAP within App Studio.</td>
</tr>
<tr>
<td></td>
<td>This option is not selected, by default.</td>
</tr>
<tr>
<td>Binary FTM files</td>
<td>Allows the use of binary FOCUS Temporary Master (.ftm) files in App Studio. When this option is not selected, .ftm files are read as text, which is the default.</td>
</tr>
<tr>
<td>Display Styling Toolbar</td>
<td>Specifies the click option to trigger the mini styling toolbar, which enables you to style content. You can access the toolbar by selecting one of the following options:</td>
</tr>
<tr>
<td></td>
<td>- On left-click selections only.</td>
</tr>
<tr>
<td></td>
<td>- On right-click selections only. This is the default value.</td>
</tr>
<tr>
<td></td>
<td>- On both left-click and right-click selections.</td>
</tr>
</tbody>
</table>

**Reference:** **HTML Page Tab**

The HTML Page tab enables you to set grid settings for an HTML page, preview reports and charts, set single or multiple layers, and alter the frequency in which you refresh thumbnails.

**Note:** If you make changes to the HTML Page settings in the App Studio Options dialog box (Grid Settings, Preview Settings), you need to press F5 to refresh an HTML page that is currently open in order to see the changes.

The following options are available.
## Grid Settings

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show Grid</td>
<td>Enables you to view a grid while you create an HTML page. The Show Grid check box is selected, by default. Clear this check box if you do not want to develop with a grid.</td>
</tr>
<tr>
<td>Snap to Grid</td>
<td>Enables you to snap to grid on demand. The Snap to Grid check box is selected, by default. Clear this check box if you do not want to enable the snap to grid option.</td>
</tr>
<tr>
<td>Width</td>
<td>Customizes the width of your grid. The default is 10 pixels.</td>
</tr>
<tr>
<td>Height</td>
<td>Customizes the height of your grid. The default is 10 pixels.</td>
</tr>
</tbody>
</table>

## Form type

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>None</td>
<td>Specifies no form object in the HTML page.</td>
</tr>
<tr>
<td>Single layer</td>
<td>Specifies a single layer form in the HTML page. This is the default setting.</td>
</tr>
<tr>
<td>Multiple layer</td>
<td>Specifies a multiple layer form in the HTML page.</td>
</tr>
<tr>
<td>Form Settings</td>
<td>Opens the Form settings dialog box.</td>
</tr>
</tbody>
</table>

## Tab Characters

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Insert spaces</td>
<td>Indicates that, when the Tab key is pressed, the number of spaces specified in the Tab size option is inserted.</td>
</tr>
</tbody>
</table>
## Option

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Keep tabs</td>
<td>Indicates that, when the Tab key is pressed, a tab character is inserted.</td>
</tr>
<tr>
<td>Tab size</td>
<td>Specifies the number of spaces inserted when you press Tab.</td>
</tr>
</tbody>
</table>

## Check boxes

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show 'New Parameters' dialog</td>
<td>Sets the New Parameters dialog box to appear in the HTML page. This is the default setting.</td>
</tr>
<tr>
<td>Default caching option</td>
<td>Sets the Default caching option to run in the HTML page. By default, this option is not selected.</td>
</tr>
<tr>
<td>Auto Arrange Objects</td>
<td>Sets the objects in the HTML page to arrange automatically. This is the default setting.</td>
</tr>
</tbody>
</table>

## Preview settings

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reports and Charts Preview</td>
<td>Enables you to preview reports and charts before saving and deploying the HTML page. This is the default setting.</td>
</tr>
<tr>
<td>Simulated Data</td>
<td>Enables you to view the HTML page based on simulated data from WebFOCUS.</td>
</tr>
<tr>
<td>Live Data</td>
<td>Enables you to view reports and charts using live data in the HTML page. This is the default setting.</td>
</tr>
<tr>
<td>Record limit for reports</td>
<td>Sets the record limit for reports. Values range from -1 to 999. The default setting is 500.</td>
</tr>
<tr>
<td>Record limit for input controls</td>
<td>Sets the record limit for input controls. Values range from -1 to 999. The default setting is 10.</td>
</tr>
</tbody>
</table>
Option | Description
--- | ---
Use Prefix | Sets a prefix to run before each report or chart component on an HTML page.
Refresh thumbnails every seconds | Sets the time interval for refreshing thumbnails. Values range from 0 to 999 seconds. The default setting is 20.
Default Theme | Sets the default theme for an HTML page. The Information Builders theme is the default theme.

Reference: Form Settings Dialog Box

The following table describes the options available in the Form Settings dialog box.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>To the left of the input</td>
<td>Sets the prompt orientation to appear to the left of the input controls.</td>
</tr>
<tr>
<td>Above the input</td>
<td>Sets the prompt orientation to appear above the input controls. This is the default setting.</td>
</tr>
<tr>
<td>Distance between prompt and input</td>
<td>Sets the distance between prompt and input. The range is from 0 to 99 pixels. The default setting is 5 pixels.</td>
</tr>
<tr>
<td>Horizontal distance between controls</td>
<td>Sets the horizontal distance between controls. The range is from 0 to 99 pixels. The default setting is 10 pixels.</td>
</tr>
<tr>
<td>Vertical distance between controls</td>
<td>Sets the vertical distance between controls. The range is from 0 to 99 pixels. The default setting is 10 pixels.</td>
</tr>
<tr>
<td>Number of columns</td>
<td>Sets the number of columns in the form object. The default setting is 4.</td>
</tr>
<tr>
<td>Add schedule button</td>
<td>Adds a schedule button to the form object. This is the default setting. This button can also be inserted from the New Parameters dialog box.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Add defer button</td>
<td>Enables deferred running of a report. This is the default setting. This button can also be inserted from the New Parameters dialog box.</td>
</tr>
<tr>
<td>Start each chain on a new line</td>
<td>Starts chains on a new line. This is the default setting.</td>
</tr>
</tbody>
</table>

**Reference: Document Tab**

The Document tab enables you to set grid settings for a document, preview reports and charts, and alter the frequency in which you refresh thumbnails. The following options are available.

**Grid Settings**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show Grid</td>
<td>Enables you to view a grid while you create a document. The Show Grid check box is selected, by default. Clear this check box if you do not want to develop with a grid.</td>
</tr>
<tr>
<td>Snap to Grid</td>
<td>Enables you to snap to a grid on demand. The Snap to Grid check box is selected, by default. Clear this check box if you do not want to enable the snap to grid option.</td>
</tr>
<tr>
<td>Width</td>
<td>Customizes the width of your grid. The default is 10 pixels.</td>
</tr>
<tr>
<td>Height</td>
<td>Customizes the height of your grid. The default is 10 pixels.</td>
</tr>
</tbody>
</table>

**Tab Characters**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Insert spaces</td>
<td>Indicates that, when the Tab key is pressed, the number of spaces specified in the Tab size option is inserted.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Keep tabs</td>
<td>Indicates that, when the Tab key is pressed, a tab character is inserted.</td>
</tr>
<tr>
<td>Tab size</td>
<td>Specifies the number of spaces inserted when you press Tab.</td>
</tr>
</tbody>
</table>

**Preview Settings**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reports and Charts Preview</td>
<td>Enables you to preview reports and charts before saving and deploying the document. This is the default setting.</td>
</tr>
<tr>
<td>Simulated Data</td>
<td>View the document based on simulated data from WebFOCUS.</td>
</tr>
<tr>
<td>Live Data</td>
<td>View reports and graphs using live data in the document. This is the default setting.</td>
</tr>
<tr>
<td>Record limit for reports</td>
<td>Sets the Record limit for reports. Values range from -1 to 999. The default setting is 500.</td>
</tr>
<tr>
<td>Use Prefix</td>
<td>Sets a prefix to run before each report or chart component on a document.</td>
</tr>
<tr>
<td>Refresh thumbnails every seconds</td>
<td>Sets the time interval for refreshing thumbnails. Values range from 0 to 999 seconds. The default setting is 20.</td>
</tr>
</tbody>
</table>
**Reference: Environments Tab**

**Note:** The Environments options are used to control the development areas that are visible in the Configured Environments tree. At least one option must be selected and applied to all configured environments.

The Environments tab enables you to change the viewable contents of the Configured Environments tree. The following options are available.

**Environments settings**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show Data Servers area</td>
<td>Displays the Data Servers area in the Configured Environments tree.</td>
</tr>
<tr>
<td>Show domain area</td>
<td>Displays the domain area in the Configured Environments tree.</td>
</tr>
<tr>
<td>Show Web Applications area</td>
<td>Displays the Web Applications area in the Configured Environments tree.</td>
</tr>
<tr>
<td>Show master files for &quot;Show all content files&quot;</td>
<td>Displays Master Files when the All Files option is selected in the Environments Tree panel toolbar.</td>
</tr>
<tr>
<td>Automatically send usage statistics and crash reports to Information Builders</td>
<td>Activates a feature that records WebFOCUS events using Google Analytics. Information Builders uses statistics derived from these events to analyze usage of product features. By default, this option is not selected.</td>
</tr>
</tbody>
</table>

**Reference: Help Configuration Tab**

The Help Configuration tab enables you to configure the location of the web-based Help system for App Studio. It provides the fields in which you can modify the App Studio Help configuration information to access the online Help system from your environment. The following options are available.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Protocol</td>
<td>Specify the protocol, either HTTP or HTTPS.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Host</td>
<td>Type the name of the machine where the Help resides.</td>
</tr>
<tr>
<td>Port</td>
<td>Type the port number of the web and/or application server.</td>
</tr>
<tr>
<td>Help Context Root</td>
<td>Type the context root for the location where the Help is hosted.</td>
</tr>
</tbody>
</table>

**Reference: Output Viewer Settings Tab**

The Output Viewer Settings tab enables you to set a specific browser to use for output, and to set the navigation options for the output (run in new window, run in same window). The following options are available.

**Browser Setup**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Browser Setup</td>
<td>Select a browser to use for output.</td>
</tr>
</tbody>
</table>

**Note:**

- The Browser Setup section is populated with a list of browsers that are installed on the App Studio machine.
- App Studio works with Mozilla Firefox®, Google Chrome™, Microsoft Internet Explorer®, and Microsoft Edge® browsers. Microsoft Edge is the default browser for Windows 10 operating systems. Internet Explorer is the default browser for all Windows operating systems prior to Windows 10.
- The browser that is highlighted when you close the dialog box is the browser that will be used for execution.

<p>| Browser executable path        | Sets the location of the browser executable. This field box is populated based on the browser selection. |
| Web driver location            | Sets the location of the web driver for the browser. This field box is populated based on the browser selection. |</p>
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Test URL</td>
<td>Indicates the test URL for testing the browser setup. The default URL is <a href="http://www.ibi.com">http://www.ibi.com</a>.</td>
</tr>
<tr>
<td>Test browser setup</td>
<td>Tests the browser setup, using the test URL. If the test is successful, the webpage will display in the browser and you will receive a success message. If the test is unsuccessful, you will receive a failed message.</td>
</tr>
<tr>
<td>Save selected browser setup</td>
<td>Saves the setup information for the selected browser.</td>
</tr>
</tbody>
</table>

**Navigation Options**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Run in new window/tab*</td>
<td>Sets the output to run in a new window or tab.</td>
</tr>
<tr>
<td>Run in same window</td>
<td>Sets the output to run in the same window.</td>
</tr>
</tbody>
</table>

**Reference: File Extensions Tab**

The File Extensions tab lists the currently supported file extensions. They are all selected, by default, and you can clear the check box for any file types that you do not want retrieved from the server.

**Note:** You must exit and restart App Studio for your selections to take effect.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>File Type</td>
<td>The file extension for a specific type of file.</td>
</tr>
<tr>
<td>Display</td>
<td>If selected, displays this file type throughout App Studio.</td>
</tr>
</tbody>
</table>
Accessing Frequently Used Commands

The Quick Access Toolbar provides access to frequently used commands, and the option to customize the toolbar with the commands that you use most often. By default, the Open, Save, Save All, Quick Print, Undo, Redo, Cut, Copy, Paste, Run, and Customizing Quick Access Toolbar buttons appear on the Quick Access Toolbar, as shown in the following image.

![Quick Access Toolbar](image)

**Note:**

- When using the undo and redo commands, consider that these actions may not take effect on options or information that is changed in every panel. In addition, if you change multiple options in one panel, for example, the undo or redo command will reverse all of those indicated changes in one action.

- The Cut, Copy, and Paste commands can be used on text, objects on the HTML canvas and Document canvas, and fields on the Report canvas.

The Customize Quick Access Toolbar button (down pointing arrow) appears on the Quick Access Toolbar and opens the Customize Quick Access Toolbar menu. This menu contains a list of the default commands on the toolbar. You can clear these commands to hide them from the toolbar. There are also options to add more commands with the Customize dialog box, move the Quick Access Toolbar below the ribbon, and hide the ribbon.

You can also add commands using the Customize dialog box. To access the Customize dialog box, select *More Commands* from the Customize Quick Access Toolbar menu. From the Customize dialog box, you can choose which commands you want to add to or remove from the Quick Access Toolbar, as well as the order in which the commands appear.

The Quick Access Toolbar is always available. By default, it is located in the upper-left corner of the App Studio interface. To move the Quick Access Toolbar below the ribbon, click the arrow button, and then click *Show Below the Ribbon*.

**Reference:** Customize Dialog Box

Using the Customize dialog box, you can add or remove commands from the Quick Access Toolbar. By providing access to the Customize Keyboard dialog box, you can also customize the keyboard by setting keyboard shortcuts for commonly performed tasks.

**Choose commands from**

Opens a list of available areas in App Studio. The Commands section dynamically repopulates with the commands that are associated with your selection.
Commands

A list of commands from a specific area of App Studio. You can select commands and use the Add or Remove buttons to add or remove them from the Quick Access Toolbar.

Commands are represented by the icon that displays on the ribbon. Commands that have no icon and a vertical arrow are command groups. Commands that have an icon and a horizontal arrow are commands with submenus. You can add all commands, command groups, and commands with submenus to the Quick Access Toolbar.

Add

Adds a selected command from the Commands list to the Quick Access Toolbar.

Remove

Removes a selected command from the Quick Access Toolbar. If no command is selected, the last command on the Quick Access Toolbar is removed.

Up

Moves a command up in order on the Quick Access Toolbar.

Down

Moves a command down in order on the Quick Access Toolbar.

Reset

Reverts the Quick Access Toolbar to use the default commands (Open, Save, Quick Print, and Run).

Show Quick Access Toolbar below the Ribbon

Displays the Quick Access Toolbar below the ribbon when selected.

Customize

Opens the Customize Keyboard dialog box. For more information on the Customize Keyboard dialog box, see Customize Keyboard Dialog Box on page 62.

OK

Applies the changes you made to the Quick Access Toolbar.

Cancel

Exits the Customize dialog box without applying any changes you made to the Quick Access Toolbar.

Help

Opens the App Studio Help.
**Procedure:** How to Add Commands to the Quick Access Toolbar

You can quickly add commands to the Quick Access Toolbar by right-clicking the ribbon, groups, or the individual commands, and selecting Add to Quick Access Toolbar, or you can follow the procedure below.

1. On the Quick Access Toolbar, click the arrow, and then click **More Commands**.
   
   The Customize dialog box opens.

2. In the Choose commands from list, select a command group.

3. Select a command name, and then click **Add**.
   
   The command name appears in the Quick Access Toolbar list.

   If you select a command group or a command with a submenu, all associated commands are accessible from the Quick Access Toolbar.

   To remove a command name from the Quick Access Toolbar list, select the command, and then click **Remove**.

4. Click the arrow buttons to rearrange the order of command names in the list.
   
   This also rearranges how the command buttons appear in the Quick Access Toolbar.

5. Click **OK** to save your changes.

**Reference:** Customize Keyboard Dialog Box

The Customize Keyboard dialog box is used to create and edit keyboard shortcuts to commands. You can access the Customize Keyboard dialog box by clicking the **Customize** button in the Customize dialog box from the Quick Access Toolbar.

**Categories**

A list of the available areas in App Studio. The commands associated with that area are displayed in the Commands section.

**Commands**

A list of commands from a specific area of App Studio. You can select commands and then assign a keyboard shortcut to them.

**Current Keys**

Displays the current keyboard shortcuts associated with the selected command.
Press new shortcut key

Press the keyboard shortcut you want to assign to a specific command. Once the Assign button is clicked, this keyboard shortcut will then be displayed in the Current Keys list for the selected command.

Set Accelerator for

Enables you to set an accelerator for one of the following: Default, HtmlPage, or Document.

Description

Provides a description of the selected command.

Assign

Allows you to assign a keyboard mapping to a command.

Remove

Allows you to remove an assigned keyboard mapping.

Reset All

Resets all keyboard mapping assignments for every command. A warning displays to ensure that want to perform this action.

Close

Exits the Customize Keyboard dialog box and return to the Customize dialog box.

Procedure: How to Create Keyboard Shortcuts

1. To open the Customize dialog box, do one of the following:
   - Click the drop-down arrow on the Quick Access Toolbar and then click More Commands.
   - Use the shortcut menu on the ribbon or Quick Access Toolbar and then click Customize Quick Access Toolbar.
2. Click Customize.
   The Customize Keyboard dialog box opens.
3. From the Categories list, select an area that contains the command that you want to create a shortcut for.
4. From the Commands list, select a command.
5. In the Press new shortcut key area, enter the key combination that you want to use with the command you selected.
   You can make a shortcut up to three keystrokes long (For example, Ctrl+Shift+R).
6. Click Assign.

A shortcut is now assigned to the command you selected.

7. Click Close to exit the Customize Keyboard dialog box.

**Developing Applications in the Canvas Area**

You can use App Studio features and functions to develop applications in the canvas area. The canvas is designed to maximize your design-time options. At run time, elements appear in the browser based on the order in which they were added to the canvas, left to right, and top to bottom. Your canvas may have the same appearance as the browser at run time, but it is not required. You can drag elements to areas of the canvas as needed to make it easier to work with them.

The size of your canvas depends on the placement and location of panels around the interface window.

As you develop in App Studio, tabs open in the canvas area. Since you can develop an HTML page at the same time that you create a report, each canvas opens with a different colored tab. The colored tab at the top of each canvas displays the name of the file you are developing.

If you chose to name the file after you develop the content, a default file name, such as Report1, appears on the tab, as shown in the following image.
A second set of tabs opens when you create procedures with multiple components. For example, you can add Set, Define, and Join components to a procedure at any time. These canvases open as tabs below the report or chart procedure, as shown in the following image.
In addition to colored tabs, some canvases also contain View tabs. A View tab appears at the bottom of the canvas and changes the display of information on the canvas. View tabs, which display different views of the same component, are shown in the following image.

View tabs, such as those on the HTML canvas, also enable additional features and functions that you can use to customize an application. For example, in the HTML canvas, you can add JavaScript functionality to an HTML page through the Embedded JavaScript view tab.

You can develop App Studio content in the following canvases.

**Creating and Scheduling an Alert Using the Alert Assist Canvas**

The Alert Assist canvas enables you to distribute an entire report or selected sections of a report when certain test conditions are met.

To access the online Help for the Alert Assist canvas, click the Alert Assist Help icon, located within the Alert Assist canvas.

**Alert Assist Button**

The Alert Assist button opens a menu that contains the Save, Save As, Run, and Close buttons.
Alert Assist Quick Access Toolbar

You can access frequently used commands on the Alert Assist Quick Access Toolbar, such as Save, Undo, Redo, View code, and Run.

Alert Assist Home Tab

You can use the Alert Assist Home tab to access the features and functions necessary to create, open, edit or run an Alert Test or Alert Result. The Alert Assist Home tab contains the Navigation group.

Navigation Group

You can create a new Alert Test or Alert Result, open a previously created Alert Test or Alert Result, edit a previously created Alert Test or Alert Result, and run the report in a new browser window. The commands are:

New

You can create a new Alert Test or Alert Result by selecting Test or Result, and then clicking New. This opens a menu from which you can choose to create a new WebFOCUS Report or Test for File Existence. New provides the same functionality as if you right clicked the Test node and created a report from the menu.

Open

You can open a previously created Alert Test or Alert Result. This invokes the Chart canvas so that you can make changes to the chart. The Open option is activated only after a report test is created.

Edit

You can edit an Alert Test or Alert Result. This opens the Report on FILENAME data source dialog box. Here, you can edit the report in the Text Editor canvas.

Run

You can run the report in a new browser window.

Delete Group

You can remove the report from the Alert Test or Alert Result. The command is:

Delete

You can remove the report from the Alert Test or Alert Result.
Creating Charts Using the Chart Canvas

The Chart canvas enables you to create different types of charts. You can select from a variety of chart types and output formats, and add custom features to a chart. To access the Chart canvas, on the Home tab, in the Content group, click Chart. The Chart Wizard opens.

Creating Cascading Style Sheets Using the Cascading Style Sheet Canvas

The Cascading Style Sheet canvas allows you to create a cascading style sheet. To access the Cascading Style Sheet canvas, right-click any folder or file in the Environments Tree panel and in the shortcut menu point to New, point to Text Editor, and then click Cascading Style Sheet.

Accessing the ESRI Configuration Utility Canvas

The ESRI Configuration Utility canvas allows you to edit configuration options associated with ESRI, the ArcGIS Server, and the GIS Adapter. To access the ESRI Configuration Utility canvas, right-click an Application folder in the Data Servers area, point to New, and click XML Document with ESRI Configuration.

Working With the JavaScript and CSS Canvas

The Embedded JavaScript canvas and the Embedded CSS canvas have a built-in Auto Complete feature to assist in the creation of code segments, similar to functionality offered by Microsoft IntelliSense® and other code editors. When you begin typing a string, array, number, or user-defined object, a list of available JavaScript methods, related to those code segments, displays.

The Auto Complete feature is on by default. To turn it off, right-click in the Cascading Style Sheet canvas and clear Auto Complete from the shortcut menu.

**Note:** If there is a syntax error, the Auto Complete features will not display.

Editing Component Code Using the Text Editor Canvas

The Text Editor canvas allows you to edit component code. To access the Text Editor canvas, right-click a component in the Procedure View panel, point to Open With, and then click Text Editor.
Combining Layouts Within a Single Document Using the Document Canvas

The Document canvas enables you to design reports, and to coordinate and distribute layouts made up of multiple reports and charts in a document. You can position reports and charts anywhere on a single page or combine a series of layouts within a single document. To access the Document canvas, on the Home tab, in the Content group, click HTML/Document. When the HTML/Document Wizard opens, select Document from the available options. The Document canvas opens.

Creating HTML Pages Using the HTML Canvas

The HTML canvas enables you to create HTML pages for WebFOCUS. Designed for business users, you do not need to have experience in HTML, CSS, XML, or JavaScript. The HTML canvas is a graphical interface that is easy to use.

Note: HTML canvas files are intended to be created and edited with the HTML canvas only. You can either modify HTML pages created in the HTML canvas or create HTML pages using a text editor. When these pages are opened in the canvas, a message displays that allows you to decide whether to open the file in the canvas or the text editor.

If you are a web developer and want to write your own code instead of using the HTML canvas, you can use the authoring tool of your choice and also use RESTful Web Services. To do so, you must license the WebFOCUS Web Services Enablement Option. For more information on RESTful Web Services, see the WebFOCUS Embedded Business Intelligence User's Guide.

Note: When opening an HTML file that was not created in the HTML canvas, you will be prompted to open the file only in a Windows Associated tool.

To access the HTML canvas, on the Home tab, in the Content group, click HTML/Document. When the HTML/Document Document Wizard opens, select HTML Page from the available options. The HTML canvas opens.

The HTML canvas uses HTML 5 Document Type Definitions (DTD).

Creating OLAP Hierarchies Using the Olap Dimensions Canvas

The OLAP Dimensions canvas allows you to create temporary OLAP hierarchy and dimensions. To access the OLAP Dimensions canvas, right-click a procedure folder or component in the Procedure View panel, point to New, and then click Olap Dimensions.

Note: This option only appears if you select the Enable OLAP check box in the Reporting tab of the App Studio Options dialog box.
Creating and Styling Reports Using the Report Canvas

The Report canvas provides you with many features that enable you to create and style reports. To access the Report canvas, on the Home tab, in the Content group, click Report. The Report Wizard opens. Follow the prompts in the Report Wizard to create a report. The Report canvas opens.

Creating Reporting Objects Using the Reporting Object Canvas

The Reporting Object canvas enables you to present available data using different terms and formats. You can then use Reporting Objects as templates for the creation of a wide range of reports and charts.

To access the online Help for the Reporting Object canvas, click the Reporting Object Help icon, located within the Reporting Object canvas.

Reporting Object Button

The Reporting Object button opens a menu that contains the Save, Save As, Run, and Close buttons.

Reporting Object Quick Access Toolbar

You can access frequently used commands on the Reporting Object Quick Access Toolbar, such as Save, Undo, Redo, View code, and Run.

Reporting Object Home Tab

You can use the Reporting Object Home tab to access the features and functions necessary to create, open, edit or run an item. The Reporting Object Home tab contains the Navigation group.

Navigation Group

You can create a new item, open a previously created item in the respective canvas, edit a previously created item, rename an item, and run the item. The commands are:

New

You can create a new join, DEFINE statement, filter, or WHERE statement.

Open

You can open a previously created item in the appropriate canvas.

Edit

You can open the item source code in the Text Editor canvas.
Properties
You can rename the selected filter or filter group.

Run
You can run the selected item.

Delete Group
You can delete a selected item or all items of a specific type. The commands are:

Delete
You can delete the selected item.

Delete All
You can delete all items of the selected item type. For example, all WHERE statements, all filters in a particular group, or all filters in every group.

Working With Synonyms Using the Metadata Canvas
The Metadata canvas provides a graphical interface that enables you to work with synonyms and perform tasks, such as creating, viewing, and modifying synonyms. To access the Metadata canvas from the Environments Tree panel, right-click a Master File and select Metadata Canvas. To access the Metadata canvas from the ribbon, on the Home tab, in the Data & Metadata group, click Create or Open.

Joining Data Sources Using the Join Canvas
The Join canvas allows you to temporarily join two or more data sources and use data from them as if they were one data source. Joined files remain physically separate but are treated as one data source. To access the Join canvas, right-click a procedure folder or component in the Procedure View panel, point to New, and then click Join.

Changing Environment Settings Using the Set Canvas
The Set canvas provides you with a graphical option for issuing a SET command. You can use the SET command to change parameters that govern App Studio and your environment. To access the Set canvas, right-click a procedure folder or component in the Procedure View panel, point to New, and then click Set.
Creating URL Files Using the Create URL Dialog Box

The Create URL dialog box allows you to create a URL file. You can add URL files to other content, such as HTML pages or portal pages, to show the target of the URL. When you create a new URL file, you can set the title of the URL file, an optional summary, and the URL address that the file points to. To access the Create URL dialog box, right-click a domain or folder in the Environments Tree panel, point to New, point to Other, and click URL.

Specifying the Name and Location of a Data Source Using the Use Canvas

The Use canvas enables you to specify the name and location of a WebFOCUS data source. This is helpful if the default naming convention is not used, the data source cannot be found on the standard search path, or an explicit extra option is desired. To access the Use canvas, right-click a procedure folder or component in the Procedure View panel, point to New, and then click Use.

Customizing Canvases

You can switch between the canvases by clicking the colored tab at the top of the canvas. You can also develop in the canvases side by side.
Procedure: How to Move Canvases for Side-by-Side Development

To create side-by-side canvas development, follow these steps:

1. Drag one canvas tab away from its original position.

   A pointer with a document icon appears.

2. Drag the pointer with the document icon to the upper-right corner of the canvas.

   The canvases now appear side by side.

   **Tip:** Repeat the preceding steps to develop on additional canvases side by side.

Accessing Features With the Ribbon

The App Studio ribbon replaces traditional toolbars with a single command bar that organizes commands and controls into a series of static and contextual tabs. From the ribbon, you can also access the WebFOCUS Administration menu, the Style menu, and the Help menu.
The default ribbon is shown in the following image.

![Ribbon Example](image)

Each tab on the ribbon, whether static or contextual, contains commands and controls that are organized into groups, according to their function or relationship. All tabs are named and all groups are labeled. Icons are used to represent the commands or controls in each group. By default, all icons are labeled. There are a few styling icons in the Style group that are not labeled. Rest your pointer over an icon to view the tooltip that identifies it. An example of this is shown in the following image.

![Tooltip Example](image)

In addition to single-click commands, some commands on the ribbon contain a submenu of options that opens when you click the arrow associated with the command. These arrows can appear below or next to a label. An example of this is the Form command, which opens a submenu of options, as shown in the following image.

![Form Submenu Example](image)

**Note:** There is no default ribbon size. As your monitor or application window size changes, the commands and controls on the ribbon resize themselves to fit the available space. Large monitors or application windows will display larger icons and entire groups. Smaller monitors or application windows may display groups as a single, labeled icon that opens a submenu.
Building an Application Using the Home Tab

The Home tab enables you to access the features and functions necessary to build an application, create new components, open existing components, run existing components, and edit components. The Home tab contains the Data & Metadata, Content, Configure, and View groups. The Home tab is always available and is static. It is located in the upper-left corner of the App Studio interface, below the Quick Access Toolbar, as shown in the following image.

Note: The Home tab is the only static tab in App Studio.

Managing Data Using the Data & Metadata Group

The Data & Metadata group includes tools that you can use to connect to data, upload data, edit metadata, and manage data access. The Data & Metadata group is shown in the following image.

The commands in the Data & Metadata group are:

Create
If you click Create, the Select Server Node dialog box opens. Navigate to the application folder where you want to create your synonym and click Select. After the location of the synonym is determined, the Select Adapter dialog box opens. Double-click the adapter connection that you want to use. You will then be able to select tables and other objects to create synonyms for.

Design
Allows you to create a new synonym using the Metadata canvas. Navigate to the location where you want to create the new synonym and click Select.

Open
Allows you to edit an existing synonym using the Metadata canvas. Navigate to the synonym that you want to edit and click OK.
Upload Data
Allows you to upload data from a file on your machine, such as a delimited, Excel, JSON, or XML file. Select the type of file that you want to upload, then select a file and edit the metadata for the resulting synonym.

More
Contains the following options:

- **Passwords.** The Password dialog box opens. You can enter the password for the data source you have selected in your Environments Tree panel.

- **Rebuild a Connection.** The Rebuild dialog box opens. You can rebuild a disorganized file, index a specific field from a file, or check the integrity of a file.

- **Command Console.** Opens a command tab for editing and enables you to send commands directly to a server from App Studio. For more information on creating, viewing, and editing source syntax, see [Creating, Viewing, and Editing Source Syntax](page 1157).

Sending Commands to the Server Using the Command Console
The Command Console enables you to send commands directly to a server from App Studio. This benefits users who have worked with Information Builders products and are already familiar with the command syntax.

The Command Console sends output to your web browser or App Studio Viewer. Output can include error messages, responses to query commands, and report output. The Command Console can also serve as a troubleshooting and debugging tool.

The following are a set of rules that you should follow when entering commands in the command console:

- The Console is case sensitive. Therefore, you must enter text in the case required for processing. For example, keywords must be entered in uppercase characters.

- The Command Console is not interactive. Therefore, you must enter all required commands in sequence and execute them as an entire process. For example, you must enter all steps required to execute the WebFOCUS REBUILD command. The Console does not prompt you for information.

- You can copy or cut text from the Command Console or an outside window, and paste it in the Command Console.

- You can drag command syntax within the Command Console.
The following groups are available in the Command Console Ribbon tab.

**Listing the Available Paths Using the Execution Path Group**

The Execution Path group contains a list of paths that are available for you to use when you execute commands. The Execution Path group is shown in the following image.

![Execution Path](image)

The command is:

**Execution Path List**

Contains a list of available paths for you to execute commands.

The list of available execution paths is determined by the selected nodes in the Environments Tree panel. When you open App Studio for the first time, you must expand and select a node from the Environments Tree panel to populate the Execution Path List.

When you run the content of the console, it will be executed using the selected execution path and the Reporting Server associated with that selected path.

**Loading Commands Using the Edit Group**

The Edit group allows you to load commands, clear the console, and clear the input stack. The input stack is a series of commands that you enter using the Command console. The Edit group is shown in the following image.

![Edit](image)

The commands are:

**Back**

Loads the previous command from the input stack.

**Forward**

Loads the next command from the input stack.
Clear Console
Clears the current commands from the console.

Clear Input Stack
Clears the previously entered commands from saved memory. This option is unavailable if you do not have previously entered commands available for recall.

Auto Clear Console
When selected, automatically clears the console after your commands are executed.

Note: The Command Console tab shares the following groups with the Text Editor tab: Find, Bookmarks, Position, Case/Comment, and Options. For more information on these remaining groups, see Creating, Viewing, and Editing Source Syntax on page 1157.

Creating an Application Using the Content Group
The Content group contains the components or tools that you can use to create an application. These include: Report, Chart, and HTML/Document. The Content group is shown in the following image.

![Content Group Image]

The commands in the Content group are:

**Report**
Opens the Report canvas in report mode after you enter a procedure name and select a location for your report from the Report Wizard.

In report mode, you can create and style simple or complex reports, add data to the Report canvas, and style that data creating a graphical representation of the report page. This allows you to view how the report displays at run time.

Using report mode, you can:

- Display and sort data.
- Select records.
- Include totals, subtotals, column calculations, headings, footings, and images.
- Format columns.
- Style fonts, colors, and grids.
- Add drill downs to detailed reports and URLs.
- Save output in many types of formats for display and reuse.
- Create HTML Analytic Documents.
- Perform predictive analysis (an RStat license is required).

Chart

Opens the Chart canvas after you enter a procedure name and select a location for your chart from the Chart Wizard.

In chart mode, you can easily transform almost any type of data into effective custom charts. You can create a variety of charts, such as bar charts, line charts, scatter charts, or pie charts, to help users analyze data in a different way. You can include selection criteria by defining parameters for your data. Additionally, you can apply drill-down capabilities and conditional styling to highlight specific data on a chart.

The Chart canvas contains a ribbon of features and options that allow you to add and style the data in your chart. Contextual tabs open within the Chart canvas, rather than on the App Studio ribbon.

HTML/Document

Opens the HTML/Document Wizard. You can choose the type of page that you want to create from the following options: HTML Page, Guided Report Page, or Document. Depending on your selection, the corresponding canvas will open.

HTML mode provides the features you need to create HTML pages so that end users can interact with your data. You can build and customize an HTML page in the HTML canvas, using the contextual tabs on the ribbon to add objects to the page. HTML mode is fully integrated with JavaScript and cascading style sheets (CSS).

In the HTML canvas, you can:

- Build an HTML launch page.
- Add push buttons, hyperlinks, and other controls to launch WebFOCUS reports in your application.
- Create a launch page for one or more reports that contain parameters.
- Create a complete HTML page by adding multiple reports and charts.
- Create an advanced report layout by including images, frames, and other web objects.
Modify the location, size, and properties of all objects in your page layout.

Set background, font, and other page properties.

In the Document canvas, you can coordinate and distribute layouts made up of multiple reports and charts in a single document. You can position reports and charts anywhere on a single page or combine a series of layouts within a single document. When creating compound reports in the Document canvas, PDF, HTML, HTML and PDF Analytic Documents, PowerPoint, and Excel are available as output formats.

Creating a New Environment and Configuring an Adapter Connection Using the Configure Group

The Configure group enables you to create a new environment and to configure an adapter. The Configure group is shown in the following image.

The commands in the Configure group are:

Connect
The Select Server Node dialog box opens. Navigate to a valid server location to begin configuring a new adapter or edit the settings of an existing adapter.

Environments
Opens the Environments List dialog box. A WebFOCUS environment consists of a web server, a WebFOCUS Client, and a Reporting Server. Adding WebFOCUS environments allows you to create and manage multiple environments, such as development, test, and production instances. You can set a new development environment, add a new environment, edit an existing environment, or remove an environment.

Deploying an RStat Scoring Routine Using the Modeling Group
The Modeling Group is only available when RStat is installed. You can deploy an RStat scoring routine or estimate future values based on selected data.
WebFOCUS RStat is a statistical modeling workbench embedded in App Studio. It allows you to perform common statistical and data mining tasks, and develop models that can be deployed as scoring applications on every platform. RStat enables data miners and Business Intelligence developers to collaborate with the same tools used to access, manipulate, or transform data, develop predictive models, and create and deploy scoring applications along with associated reports to any worker within their organization. The Modeling group is shown in the following image.

![Modeling Group Image]

The commands in the Modeling Group are:

**Model Deployment**

Opens the Model Deployment dialog box. This functionality enables you to deploy existing, stored routines.

You can deploy an RStat scoring routine in any application directory within your app path on any WebFOCUS server. The process of deployment includes compiling the routine and placing the executable file in a location that can be accessed by a WebFOCUS scoring application.

**Predictive Modeling**

Opens RStat, a statistical modeling workbench that is embedded in App Studio. When you select the *Predictive Modeling* command, the RGui window is opened and the R Console and RStat are activated.

You use RStat to derive expected and predicted values from data observations. Decision trees, regression, and the other algorithms are used to generate estimates. For example, you can estimate whether a prospect is a good target for a particular marketing campaign, or you can estimate the expected sales revenues for different stores in order to determine whether store layout and product mix have an impact on sales.
Controlling the Display of the Screen Using the View Group

The View Group enables you to control what displays on your screen. For example, you can choose whether to display or hide the Environments Tree or Help Wizard. The View group is shown in the following image.

The commands in the View group are:

**Environments Tree**
Displays or hides the Environments Tree panel, which displays on the left side of the screen and displays environment information.

**Environments Detail**
Displays or hides the Environments Detail panel.

**File/Folder Properties**
Displays or hides the File/Folder Properties panel.

**Procedure View**
Displays or hides the Procedure View panel.

**Context Bar**
Displays or hides the Context Bar. The Context Bar displays under the ribbon.

**Status Bar**
Displays or hides the Status Bar. The Status Bar displays along the bottom of the screen.

**Help Wizard**
Displays or hides the Help Wizard. By default, the Help Wizard panel opens in the bottom-right corner of the interface. The Help Wizard content dynamically changes, depending on where you are in the interface.
Using the WebFOCUS Administration Menu

From the WebFOCUS Administration menu, you can access the WebFOCUS Administration Console, the Reporting Server Console, the Security Center, the WebFOCUS Home Page, the Deferred Status console, the ReportCaster Console, and the Session Viewer. You can also create deferred status reports from this menu. The WebFOCUS Administration menu is shown in the following image.

![WebFOCUS Administration Menu Image]

The WebFOCUS Administration menu is only available when you select an environment in the Environments Tree panel. The options available to you change, depending on the development area that you select in the Environments Tree panel. Deferred Status is only available when you select a Domains node in the Environments Tree panel. The Reporting Server Console is only available when you select a Web Applications node in the Environments Tree panel.

**Note:** App Studio always uses Microsoft Internet Explorer for all the tools available on the WebFOCUS Administration menu. This is the case even if you have selected another browser as the default viewer.

**WebFOCUS Administration Console**

Opens the WebFOCUS Administration Console. Here, you can add remote Reporting Servers, configure application settings and client settings, and use WebFOCUS diagnostic tools.

**Reporting Server Console**

Opens the Web Console. where a server user with the required metadata privileges can configure and manage adapters, add remote servers, and create synonyms, as an alternative to App Studio. In addition, many other configuration options are available through the Web Console.

For a full understanding of configuration options and server capabilities, see the Web Console Help system or the following manuals: *Server Administration* and *Adapter Administration*. 

WebFOCUS App Studio User’s Manual 83
Note:

- The Reporting Server Console is sometimes referred to as the Web Console.
- For App Studio installations that allow stand-alone development, the local, default Reporting Server normally runs with security OFF, and the user who installed App Studio is the default administrator.

Security Center

Opens the WebFOCUS Security canvas. Here, you can set user privileges and roles for users and groups.

WebFOCUS Home Page

Opens the WebFOCUS Home Page. Here, you can create dynamic websites using the content you create in App Studio.

Deferred Status

Opens the Deferred Report Status console. Here, you can defer running a report until a specified time. This option is only available in the Domains node.

ReportCaster Console

Opens the ReportCaster Console. Here, you can schedule and distribute WebFOCUS reports, the content of URLs, and files.

Session Viewer

Enables you to review system events that took place during recent work sessions and export them to system administrators or customer support staff. Traces of system events and error messages captured by the Session Viewer provide a clear picture of system operations, and enable you to investigate the causes of system disruptions or performance issues.
Customizing the Appearance of the Interface Using the Style Menu

You can customize the appearance of the App Studio interface from the Style menu. From this menu, you can select a theme with which to customize the App Studio interface. The themes available to you are determined by the themes that you have installed for Microsoft® Office. The Style menu is always available. It is located in the upper-right corner of the App Studio interface, as shown in the following image.

Note:

- When you close App Studio, the theme that you have selected is saved and used the next time you launch the product.
- When using a style other than Default, the drop-down arrow is removed from the panels. You can still access the menu by right-clicking the top frame of the panel.

Accessing App Studio Help Content

You can access the App Studio Help content, Focal Point Forums, App Studio licensing information, and other product options from the Help menu. The Help button is always available. It is located in the upper-right corner of the App Studio interface, as shown in the following image.

From the Help menu, you can do the following:

- Access the online Help system. Click Help Topics to open the App Studio Help window.
Access the Focal Point community. Click Focal Point Forums to access our online developer center and more than a message board. It is an interactive network of developers from almost every profession and industry, collaborating on solutions and sharing tips and techniques.

Reopen the Welcome screen after it has been closed. Click Display Welcome Screen to reopen the Welcome screen.

Reset the interface layout. Click Reset Layout to return the App Studio interface settings, such as the ribbon, Quick Access Toolbar, panels, and styling, to their default. This change will not occur until App Studio is restarted.

View license and product information. Click About to open the About WebFOCUS App Studio dialog box.

Working With the Environments Tree Panel

The Environments Tree panel is the primary navigational aide in App Studio. Using it, you can always stay oriented to the domain or web application that you are working in. You can use the panel to move or copy objects between folders, copy folders, share content with other App Studio users, or hide content.

Note:

Take care when copying and pasting Content folders from one environment to another. Content may be affected if the metadata in the source environment does not match the metadata in the target environment. The use of Change Management packages is recommended to move Content folders from one environment to another in App Studio.

You can right-click a folder and click Duplicate to copy and paste a folder within the same domain or parent folder.

When you copy and paste from the Domains area to the Data Servers area, the IBFS properties (metadata) are lost and InfoAssist cannot function. The same issue occurs if you copy and paste from the Domains area to your desktop, and then copy and paste from your desktop back to the Data Servers area.

From the Environments Tree panel, you can:

Customize the appearance of the panel.

Filter content listed under the WebFOCUS environments in the Configured Environments tree.
Access configured WebFOCUS environments to create new content or modify existing content.

- Refresh an application or folder in the Configured Environments tree, to view new files and updated file information, and omit deleted files.

The Environments Tree panel is shown in the following image.

The Environments Tree panel opens with App Studio.

**Reference:** Environments Tree Toolbar

The Environments Tree toolbar contains the buttons and menus that you need to navigate, filter, and sort the information that appears in the Configured Environments tree.

**View Options**

Presents options for viewing items (for example, alphabetical sorting or grouping), as described in the following table.

<table>
<thead>
<tr>
<th>Option</th>
<th>Name</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>![a-z]</td>
<td>View items sorted in alphabetical order</td>
<td>Sorts the files alphabetically from A to Z.</td>
</tr>
<tr>
<td>![A-Z]</td>
<td>View items sorted in reverse alphabetical order</td>
<td>Sorts the files alphabetically from Z to A.</td>
</tr>
<tr>
<td>Option</td>
<td>Name</td>
<td>Function</td>
</tr>
<tr>
<td>--------</td>
<td>------</td>
<td>----------</td>
</tr>
<tr>
<td><img src="image" alt="View items sorted in Chronological order" /></td>
<td>View items sorted in Chronological order</td>
<td>Sorts the files by the last saved time, in descending order.</td>
</tr>
<tr>
<td><img src="image" alt="View items sorted in reverse Chronological order" /></td>
<td>View items sorted in reverse Chronological order</td>
<td>Sorts the files by the saved time, in ascending order.</td>
</tr>
<tr>
<td><img src="image" alt="View items grouped by File Type" /></td>
<td>View Items grouped by File Type</td>
<td>Sorts the files by file type.</td>
</tr>
<tr>
<td><img src="image" alt="Respect Sort Order Property" /></td>
<td>Respect Sort Order Property</td>
<td>Respects the Sort Order property value specified in the File/Folder Properties panel. This is the default.</td>
</tr>
<tr>
<td><img src="image" alt="View items by Title" /></td>
<td>View items by Title</td>
<td>Displays the files by title and sorts the files by title. If an item does not have a title, its name is shown.</td>
</tr>
<tr>
<td><img src="image" alt="View items by Name" /></td>
<td>View items by Name</td>
<td>Displays the files by name and sorts the files by name. If an item does not have a title, its name is shown.</td>
</tr>
<tr>
<td><img src="image" alt="Refresh View" /></td>
<td>Refresh View</td>
<td>Refreshes all of the files and folders that you see in the Configured Environments tree. Refresh View also shows the dependencies of the file or folder that you have selected.</td>
</tr>
<tr>
<td><img src="image" alt="Show All Content files" /></td>
<td>Show All Content files</td>
<td>Filters the tree to show all content file types, except for Master Files. To view Master Files, click Show only Master files.</td>
</tr>
<tr>
<td><img src="image" alt="Show only Procedure files" /></td>
<td>Show only Procedure files</td>
<td>Filters the tree to show only this file type.</td>
</tr>
<tr>
<td><img src="image" alt="Show only Master files" /></td>
<td>Show only Master files</td>
<td>Filters the tree to show only this file type.</td>
</tr>
<tr>
<td><img src="image" alt="Show only HTML files" /></td>
<td>Show only HTML files</td>
<td>Filters the tree to show only this file type.</td>
</tr>
<tr>
<td><img src="image" alt="Show only Maintain files" /></td>
<td>Show only Maintain files</td>
<td>Filters the tree to show only this file type.</td>
</tr>
<tr>
<td>Option</td>
<td>Name</td>
<td>Function</td>
</tr>
<tr>
<td>--------</td>
<td>------</td>
<td>----------</td>
</tr>
<tr>
<td><img src="42x585" alt="Image" /></td>
<td>Show only Image files</td>
<td>Filters the tree to show only this file type.</td>
</tr>
<tr>
<td><img src="42x534" alt="ReportCaster" /></td>
<td>Show only ReportCaster files</td>
<td>Filters the tree to show only this file type.</td>
</tr>
<tr>
<td><img src="42x522" alt="Library Files" /></td>
<td>Show only Library files</td>
<td>Filters the tree to show only this file type.</td>
</tr>
<tr>
<td><img src="42x500" alt="Other Files" /></td>
<td>Other files</td>
<td>Filters the tree to show other file types.</td>
</tr>
</tbody>
</table>

**Viewing Nodes in the Configured Environments Tree**

The Configured Environments tree displays the WebFOCUS Environments, Data Servers, Domains, and Web Applications nodes. These are the development areas where you can create content. If you have the Managed Reporting version of App Studio and WebFOCUS installed on your machine, or configured a remote WebFOCUS 8 environment, a domain node also appears.

If a node under the Configured Environments Tree has been populated and contains content, a green dot is shown on the node icon. If a node has been populated and does not contain any content, a red dot is shown on the node icon. If a node has not been populated, App Studio does not know if there is any content in that node and no dot is shown on the node icon. If you create a new content in a node with a red dot on it, that node now has content in it and will change to a green dot. If you delete all content in a node with a green dot, that node now has no content in it and will change to a red dot.

**Note:** By default, the Configured Environments tree sorts files and folders by title. If you change the sorting options to *View Items by Name*, the names of your files and folders will display. Whether you display content by title or by name, the Domains, Data Servers, and Web Applications nodes do not display differently.

You can expand the nodes on the Configured Environments tree to view your configured environments, folders, and application files. Use the filtering commands on the toolbar to sort files alphabetically, display by name or title, or include the associated paths.

From the Configured Environments tree, you can manage content for each of your WebFOCUS environments. This includes creating new folders or files, opening existing files, and copying files. Right-click a node, folder, or file to view the shortcut menu of options. You can also open files by double-clicking them.
You can also use the Refresh Descendants option to refresh a specific application or folder. Right-click the application or folder that you want to refresh, and then click Refresh Descendants.

**Note:**

- You can use the shortcut menu on any file, select New, and click the type of content you want to create, to create new content in the same location.

- If a Master File is located in a nested folder (for example, folder xyz is within folder abc), you must first use the Reporting Server Console to map the nested application folder as a new application.

You can copy files from your desktop to the Configured Environments Tree.

From the Configured Environments node, you can access the following shortcut menu option:

- **Add.** Opens the WebFOCUS Environments Properties dialog box where you can add additional environments.

From your WebFOCUS environment, in the Environments Tree panel, you can access the following shortcut menu options:

- **Sign In.** Allows you to sign in to your WebFOCUS environment. This option is only available if you are not already signed in to your WebFOCUS environment.

- **Sign Out.** Allows you to sign out of your WebFOCUS environment. This option is only available if you are already signed in to your WebFOCUS environment.

**Note:** You can copy files that are not in App Studio and paste them in the Configured Environments tree to use those files when creating your application.

**Reference: Data Servers**

The Data Servers node lists each Reporting Server that the WebFOCUS Client can access. This node expands to display the files that you can use to develop WebFOCUS applications successfully.

The process of populating the application paths of the files in the Data Servers node is done on a background thread. While this background thread is running, you can navigate on the tree, open a folder, and create files. However, you will be unable to save a new file, or do anything that requires a path list, such as create a new style sheet, until the background thread completes. This section of the Configured Environments tree, which is visible, will populate.
From a data server, you can access the following shortcut menu options:

- **Manage Adapters.** Opens the Select Server Node dialog box from which you can configure a new adapter or edit the settings of an existing adapter.

- **Refresh Descendants.** refreshes the contents of the application or folder in the Configured Environments tree to omit deleted files, and show new files and file information, such as date, time, and size.

From the Applications folder, you can access the following shortcut menu options:

- **New Application.** Creates a new application folder.

- **Configure Application Path.** Opens the Application Path dialog box from which you can create applications, add applications to the search path, map and reorder applications, delete applications or mappings from the path.

- **Refresh Descendants.** Refreshes the contents of the application or folder in the Configured Environments tree to omit deleted files, and show new files and updated file information, such as date, time, and size.

From an application folder or a file, you can access the following shortcut menu options:

- **New.** Creates a new folder or file. The following shortcut menu options are available when pointing to New:
  - **Procedure.** Creates a new procedure folder in your current application folder.
  - **Reporting.** Expands a submenu containing the following options.
    - **Report.** Creates a new report.
    - **SQL Report.** Creates a new SQL report.
  - **HTML/Document.** Creates a new HTML page or document.
  - **InfoAssist.** Expands a submenu containing the following options.
    - **Chart.** Creates a new chart using the Chart canvas.
    - **SQL Chart.** Creates a new SQL chart.
  - **Data & Metadata.** Expands a submenu containing the following options.
    - **Synonym.** Creates a new Master File after you have selected a configured adapter, or configure a new adapter.
    - **Synonym via Metadata Canvas.** Creates a new Master File in the Metadata canvas.
Define Function Library. Creates a user-defined function library. Any user-defined functions created in this library are available for use in any content created within the same folder as the library. After the creation of the first function, you can create additional functions or edit existing ones. Once the initial function library is created, future additions or modifications are done through the Procedure View panel.

Upload Data. Connects to the Upload Desktop File utility in the Reporting Server Console. Using this utility, you can upload new data to an application. The data is converted using default master data options, and is displayed for your verification before the load is initiated. For details, refer to the Server Console Help system.

Text Editor. Expands a submenu containing the following options.

- Text Document. Creates a text document. You can use the Add Comment or Remove Comment commands to comment on the file.

Application Directory. Creates a new application folder in your current application folder.

Duplicate. Creates a copy of the selected file or folder in the Data Servers node. If you duplicate a folder, all contents, except for portals, are also duplicated.

Copy. Copies the selected file or folder to the clipboard where you can paste it to a different node. If you copy a folder, all contents, except for portals, are also copied.

Paste. Pastes the cut or copied file or folder.

Rename. Changes the name of the selected folder or file.

Delete. Deletes the selected folder or file. You will be prompted to confirm your deletion. Click No if you do not want to delete an item, or click Cancel to abort the delete operation. If you choose to abort the delete operation while deleting a list of items, Cancel will prevent all subsequent items from being deleted.

Properties. Displays the folder properties in the Data Servers node.

Refresh Descendants. Refreshes the contents of the application or folder in the Configured Environments tree to omit deleted files, and show new files and updated file information, such as date, time, and size.
**Reference: Domains**

The Domains node is storage space for data or information, and allows you to use App Studio to administer and develop against a Managed Reporting environment. The Domains node lets you manage resources and applications on remote servers, as well as on your local machine if you have performed a full installation of App Studio. You can create and edit application files on all remote servers from one easily accessible interface. You can also create and administer reports for Managed Reporting from a Windows application rather than a web browser.

From a Domains node, you can access the following shortcut menu options:

- **Impact Analysis.** Enables you to generate a list that identifies the procedures that access a specific Master File or field within a Master File.

- **New Folder.** Creates a new folder in the specified Domains node.
  
  **Note:** Using this option is not the same as creating a new domain.

  To create a new domain, use the BI Portal New - Enterprise Domain option. This option triggers the domain template, which creates domain-specific user groups and sub-folders such as My Content. For more information, see the WebFOCUS Business Intelligence Portal manual.

  Using the New Folder option in App Studio does not trigger the domain template.

- **Mode Manager.** Allows you to edit private files, if you have the proper authorization setting.

- **Physical View** or **Shared View.** Enables you to toggle between the two. Shared View displays all folders (including empty folders) in the hierarchy that includes shared content. Physical View suppresses empty folders in the hierarchy that includes shared content. Physical View displays all folders that contain shared content.

- **Security.** Enables you to control user permissions, which limit what development areas a user can access. The options are:
  
  - **Rules.** Opens the Security Rules dialog box, where you set up simple and advanced security rules for groups and users.

  - **Rules on this Resource.** Opens the Rules on this Resource dialog box, where you can view and run reports on the security rules defined for the domain.

  - **Effective Policy.** Opens the Effective Policy dialog box, where you can view the effective policy by privilege and user.
Working With the Environments Tree Panel

- **Owner.** Opens the Set Resource Owner dialog box, where you can set the portal user, set the group to which the user belongs, and publish the portal. Since ownership is set at the Domain level, this option is not available for the folders and files under a Domain.


- **Refresh Descendants.** Refreshes the contents of the application or folder in the Configured Environments tree to omit deleted files, and show new files and updated file information, such as date, time, and size.

From a folder or file, in the Domains node, you can access the following shortcut menu options:

- **Impact Analysis.** Enables you to generate a list that identifies the procedures that access a specific Master File or field within a Master File.

- **New.** Creates a new folder or file. The following shortcut menu options are available when pointing to New:
  - **Procedure.** Creates a new procedure folder or file in your current application folder.
  - **Reporting.** Expands a submenu containing the following options.
    - **Report.** Creates a new report.
    - **SQL Report.** Creates a new SQL report.
  - **HTML/Document.** Creates a new HTML page or document.
  - **Designer.** Opens a submenu containing the following options.
    - **Workbook.** Creates a new workbook using WebFOCUS Designer.
    - **Chart.** Creates a new chart using WebFOCUS Designer.
    - **Page.** Creates a new Designer page.
  - **InfoAssist.** Expands a submenu containing the following options.
    - **Chart.** Creates a new chart using the Chart canvas.
    - **SQL Chart.** Creates a new SQL chart.
    - **Visualization.** Creates a new visualization.
    - **Alert.** Creates a new alert.
[ ] **Schedule.** Expands a submenu containing the following options.

[ ] **Schedule.** Creates a new schedule.

[ ] **Distribution List.** Creates a new distribution list.

[ ] **Library Access List.** Creates a new library access list.

[ ] **Text Editor.** Expands a submenu containing the following options.

[ ] **JavaScript File.** Creates a new JavaScript file from which you can create original JavaScript.

[ ] **Cascading Style Sheet.** Creates a new cascading style sheet.

[ ] **WebFOCUS StyleSheet.** Creates a new WebFOCUS StyleSheet.

[ ] **Text Document.** Creates a new text document.

[ ] **Other.** Expands a submenu containing the following options.

[ ] **Reporting Object.** Creates a new reporting object.

[ ] **Portal Page.** Creates a new portal page, in a tab within App Studio, using the Page Designer. For more information on the Page Designer, see the Business Intelligence Portal technical content.

[ ] **Collaborative Portal.** Creates a new portal, in a tab within App Studio, using the Portal Designer. For more information on the Portal Designer, see the Business Intelligence Portal technical content.

[ ] **URL.** Creates a new URL.

[ ] **Blog.** Opens the Blog Viewer, in a tab within App Studio, where you can manage and read your blog posts. For more information on the Blog Viewer, see the Business Intelligence Portal technical content.

[ ] **Folder.** Creates a new folder.

[ ] **Upload Data.** Connects to the Upload Desktop File utility in the Reporting Server Console. Using this utility, you can upload new data to an application. The data is converted using default master data options and is displayed for your verification before the load is initiated. For details, refer to the Server Console Help system.

[ ] **Publish/Unpublish.** Allows or suppresses public access to every file within the selected folder. Multiple folders can be selected at one time by pressing the Ctrl key while selecting the desired folders.
Hide/Show. Hides or shows every file in the selected folder, to users who are permitted to access the folder. Multiple folders can be selected at one time by pressing the Ctrl key while selecting the desired folders. You can specify which users can see this content by changing the Do not show on user's list property in the File/Folder Properties panel.

Security. Enables you to control user permissions, which limit what development areas a user can access. The options are:

- **Rules.** Opens the Security Rules dialog box, where you set up simple and advanced security rules for groups and users.

- **Rules on this Resource.** Opens the Rules on this Resource dialog box, where you can view and run reports on the security rules defined for the domain.

- **Effective Policy.** Opens the Effective Policy dialog box, where you can view the effective policy by privilege and user.

- **Owner.** Opens the Set Resource Owner dialog box, where you can set the portal user, set the group to which the user belongs, and publish the portal. Since ownership is set at the Domain level, this option is not available for the folders and files under a Domain.

Duplicate. Creates a copy of the selected file or folder in the Domains node. If you duplicate a folder, all contents, except for portals, are also duplicated.

Copy/Paste. Copies or pastes a folder or file. If you copy a folder, all contents, except for portals, are also copied.

Rename. Changes the name of the selected folder or file. To ensure that all instances of the original name and references are updated, it is recommended that you use the Save As option to rename an HTML page.

Delete. Deletes the selected folder or file. You will be prompted to confirm your deletion. Click No if you do not want to delete an item, or click Cancel to abort the delete operation. If you choose to abort the delete operation while deleting a list of items, Cancel will prevent all subsequent items from being deleted.


Source Control. Enables Source Control for the folder or file.

Properties. Displays the folder properties in the Domains node.
- **Refresh Descendants.** Refreshes the contents of the application or folder in the Configured Environments tree to omit deleted files, and show new files and updated file information, such as date, time, and size.

*Note:* For more information on publishing and unpublishing folders and items within the Domains, see the *WebFOCUS Security and Administration* manual.

**Reference:** Scheduling

Scheduling allows you to indicate the method and time at which the procedure should run. You can schedule a procedure using one of the following options:

- Email
- FTP
- Printer
- Report Library
- domain

For more information, see the *ReportCaster Guide*.

**Reference:** Web Applications

The Web Applications node allows you to open files with the Text Editor, or the mode you used to create them.

*Note:* Based on the file type, different options may display.

From the Web Applications node, you can access the following shortcut menu options:

- **New Application.** Creates a new application folder.
- **Refresh Descendants.** Refreshes the contents of the application or folder in the Configured Environments tree to omit deleted files, and show new files and updated file information, such as date, time, and size.

From an application folder, you can access the following shortcut menu options:

- **Rename.** Changes the name of the selected folder or file.
- **Delete.** Deletes the selected application folder. You will be prompted to confirm your deletion. Click *No* if you do not want to delete an item, or click *Cancel* to abort the delete operation. If you choose to abort the delete operation while deleting a list of items, Cancel will prevent all subsequent items from being deleted.
Duplicate. Creates a copy of the selected folder in the Web Applications node.
If you duplicate a folder, all contents, except for portals, are also duplicated.

Copy/Paste. Copies the selected folder and its contents to the clipboard, allowing you to paste it.

New. Creates a new file. The following shortcut menu options are available when pointing to New:

- HTML File. Creates a page in html format. You can import existing HTML content, as well.

- JavaScript File. Creates a new JavaScript file from which you can create original JavaScript.

- Cascading Style Sheet. Creates a base template from which you can create a unique cascading style sheet (CSS).

- Folder. Creates a new folder.

Properties. Displays the folder properties in the File/Folder Properties panel.

Refresh Descendants. Refreshes the contents of the application or folder in the Configured Environments tree to omit deleted files, and show new files and updated file information, such as date, time, and size.

From a file, you can access the following shortcut menu options:

- Open. Opens the file.

- Open in Text Editor. Opens the file in a text editor.


- Print. Prints the file.

- New. Creates a new file. The following shortcut menu options are available when pointing to New:

  - HTML File. Creates a page in .html format. You can import existing HTML content, as well.

  - JavaScript File. Creates a new JavaScript file from which you can create original JavaScript.

  - Cascading Style Sheet. Creates a base template from which you can create a unique cascading style sheet (CSS).
- **Duplicate.** Creates a copy of the selected file in the Web Applications node.

- **Copy/Paste.** Copies the selected file to the clipboard where you can paste it to a different node.

- **Rename.** Changes the name of the selected file.

- **Delete.** Deletes the selected application folder. You will be prompted to confirm your deletion. Click No if you do not want to delete an item, or click Cancel to abort the delete operation. If you choose to abort the delete operation while deleting a list of items, Cancel will prevent all subsequent items from being deleted.

- **Properties.** Displays the folder properties in the File/Folder Properties panel.

**Reference:** **Node Population**

Population is a check to see what content, if any, is contained within a node in the Configured Environments tree. Node population occurs when you select a node in the Configured Environments tree. The node icon will be different depending on whether population has occurred. If a node contains files after population a green dot appears on the node icon. If a node does not contain files after population, a red dot appears on the node icon.

If a node has been populated and contains content, deleting that content will change the green dot to a red dot. Conversely, if a node has been populated and contains no content, creating content in that node will change the red dot to a green dot.

**Reference:** **Master File Shortcut Commands**

The following shortcut menu options are available for a Master File:

- **Open.** Opens the Master File in the Metadata canvas.

- **Create Report.** Opens the Report Wizard, where you can create a new report.

- **Create InfoAssist Chart.** Opens the Chart Wizard, where you can create a new chart.

- **Open in Text Editor.** Opens the Master File in the Text Editor canvas.

- **Edit in Windows Associated Tool.** Opens the Master File in your Windows associated tool. Note that this only appears if you have a Windows associated tool in which to open the file.

- **Refresh Synonym.** Regenerates the synonym. Use this option if the underlying object has been altered.

- **Sample Data.** Displays sample output for the Master File.
Impact Analysis. Enables you to generate a report that identifies the procedures that access a specific Master File or field within a Master File.

Print. Prints the Master File.

Check. Tests the validity of the Master File.

Edit Access File as Text. Enables you to view and manually edit the Access File synonym.

New. Creates a new folder or file. The following shortcut menu options are available when pointing to New:

Procedure. Creates a new procedure folder in your current application folder.

Reporting. Expands a submenu containing the following options.


InfoAssist. Expands a submenu containing the following options.

Chart. Creates a new chart using the Chart canvas.

SQL Chart. Creates a new SQL chart.

Data & Metadata. Expands a submenu containing the following options.

Synonym. Creates a new Master File after you have selected a configured adapter, or configure a new adapter.

Synonym via Metadata Canvas. Creates a new Master File in the Metadata canvas.

Define Function Library. Creates a user-defined function library. Any user-defined functions created in this library are available for use in any content created within the same folder as the library. After the creation of the first function, you can create additional functions or edit existing ones. Once the initial function library is created, future additions or modifications are done through the Procedure View panel.

Upload Data. Connects to the Upload Desktop File utility in the Reporting Server Console. Using this utility, you can upload new data to an application. The data is converted using default master data options and is displayed for your verification before the load is initiated. For details, refer to the Server Console Help system.
Text Editor. Expands a submenu containing the following options.


- Text Document. Creates a text document. You can use the add or remove comment to comment the file.

- Application Directory. Creates a new application folder in your current application folder.

Duplicate. Creates a copy of the selected file.

Copy/Paste. Copies the selected file to the clipboard where you can paste it to a different node.

Rename. Changes the name of the selected file.

Delete. Deletes the selected file. You will be prompted to confirm your deletion. Click No if you do not want to delete an item, or click Cancel to abort the delete operation. If you choose to abort the delete operation while deleting a list of items, Cancel will prevent all subsequent items from being deleted.

Properties. Displays the folder properties in the File/Folder Properties panel.

Note: When a Master File is opened in the Text Editor canvas or the Metadata canvas, all other open options from the shortcut menu are unavailable.

You can also create content from a Master File shortcut. Any changes made to a Master File shortcut do not affect the original Master File, but you can access the shortcut to use the original Master File as a data source. The following options are available when you right-click a Master File shortcut in the Domains node:

- Open. Opens the Master File in the Metadata canvas.

- Create Report. Opens the Report Wizard, where you can create a new report using the Master File as a data source.

- Create InfoAssist Chart. Opens the Chart Wizard, where you can create a new chart using the Master File as a data source.

- Create Designer Chart. Opens WebFOCUS Designer in a browser window to create a chart using the Master File as a data source.

- Create Designer Workbook. Opens WebFOCUS Designer in a browser window to create a workbook using the Master File as a data source.
Working With the Environments Tree Panel

- **Publish/Unpublish.** Allows or suppresses public access to the Master File shortcut. Multiple folders can be selected at one time by pressing the Ctrl key while selecting the desired folders.

- **Hide/Show.** Hides or shows the selected Master File shortcut to users who are permitted to access it.

- **Security.** Enables you to control user permissions, which limit what development areas a user can access. The options are:
  - **Rules.** Opens the Security Rules dialog box, where you set up simple and advanced security rules for groups and users.
  - **Rules on this Resource.** Opens the Rules on this Resource dialog box, where you can view and run reports on the security rules defined for the domain.
  - **Effective Policy.** Opens the Effective Policy dialog box, where you can view the effective policy by privilege and user.
  - **Owner.** Opens the Set Resource Owner dialog box, where you can set the portal user, set the group to which the user belongs, and publish the portal. Since ownership is set at the Domain level, this option is not available for the folders and files under a Domain.

- **New.** Creates a new folder or file. The following shortcut menu options are available when pointing to New:
  - **Procedure.** Creates a new procedure folder or file in your current application folder.
  - **Reporting.** Expands a submenu containing the following options.
    - **Report.** Creates a new report.
    - **SQL Report.** Creates a new SQL report.
  - **HTML/Document.** Creates a new HTML page or document.
  - **Designer.** Opens a submenu containing the following options.
    - **Workbook.** Creates a new workbook using WebFOCUS Designer.
    - **Chart.** Creates a new chart using WebFOCUS Designer.
    - **Page.** Creates a new Designer page.
- **InfoAssist.** Expands a submenu containing the following options.
  - **Chart.** Creates a new chart using the Chart canvas.
  - **SQL Chart.** Creates a new SQL chart.
  - **Visualization.** Creates a new visualization.
  - **Alert.** Creates a new alert.

- **Schedule.** Expands a submenu containing the following options.
  - **Schedule.** Creates a new schedule.
  - **Distribution List.** Creates a new distribution list.
  - **Library Access List.** Creates a new library access list.

- **Text Editor.** Expands a submenu containing the following options.
  - **JavaScript File.** Creates a new JavaScript file from which you can create original JavaScript.
  - **Cascading Style Sheet.** Creates a new cascading style sheet.
  - **StyleSheet.** Creates a new WebFOCUS StyleSheet.
  - **Text Document.** Creates a new text document.

- **Other.** Expands a submenu containing the following options.
  - **Reporting Object.** Creates a new reporting object.
  - **Portal Page.** Creates a new portal page, in a tab within App Studio, using the Page Designer. For more information on the Page Designer, see the Business Intelligence Portal technical content.

  - **Collaborative Portal.** Creates a new portal, in a tab within App Studio, using the Portal Designer. For more information on the Portal Designer, see the Business Intelligence Portal technical content.

  - **URL.** Creates a new URL.

  - **Blog.** Opens the Blog Viewer, in a tab within App Studio, where you can manage and read your blog posts. For more information on the Blog Viewer, see the Business Intelligence Portal technical content.

  - **Folder.** Creates a new folder.
Working With the Environments Tree Panel

- **Duplicate.** Creates a copy of the selected file in the folder containing the Master File shortcut.

- **Copy/Paste.** Copies or pastes the Master File shortcut.

- **Rename.** Changes the title of the Master File shortcut.

- **Delete.** Deletes the Master File shortcut. You will be prompted to confirm your deletion. Click No if you do not want to delete an item, or click Cancel to abort the delete operation. If you choose to abort the delete operation while deleting a list of items, Cancel will prevent all subsequent items from being deleted.

- **Properties.** Opens the File/Folder Properties panel for the Master File shortcut.

**Opening Files in the Configured Environments Tree**

In addition to opening files through the Application menu, or from the Quick Access Toolbar, you can also open files from the development areas in the Configured Environments tree.

- To open a file in its native canvas, double-click the file or right-click the file, and then click Open.

- To open a file in the Text Editor canvas, right-click the file and then click Open in Text Editor.

- To open a file in a Windows Associated Tool, right-click the file and then click Edit in Windows Associated Tool. This option appears only if a Windows associated tool is available. When you access this functionality, the file will open in a separate dialog box using the relevant Windows tool.

**Note:** Files can only be opened in one area of App Studio at a time to ensure that your changes are not overwritten by another opened version of the file. However, you are able to open a file in App Studio and in a Windows Associated Tool at the same time. To ensure that your changes are saved properly, you should only modify one opened version of the file at a time.

**Viewing Shared Files in the Configured Environments Tree**

There are two ways of sharing contents in App Studio.

- **Publish.** Allows you to share all the contents of a published folder with all users who have access to that folder. A bold folder icon in the Configured Environments tree indicates a published folder. A light folder icon in the Configured Environments tree indicates an unpublished folder.

  To publish a folder, right-click it and select Publish from the shortcut menu.
Share. Allows you to share a content file created in the BI Portal, with a single App Studio developer. When a file is shared, both the file icon and the folder icon appear with a shared icon overlay in the Configured Environments tree.

Procedure: How to Share a Content File Between Two Developers

Using the BI Portal, an Advanced user can designate a content file to share with an App Studio Developer user. This overview procedure gives the general steps needed to share a file.

1. In the BI Portal, an Advanced user creates a file in the My Contents folder of a domain created in the BI Portal.

2. The Advanced user right-clicks the file and selects Share With from the shortcut menu. The Advanced user designates an individual App Studio Developer to share with.

   For more information, see the WebFOCUS Business Intelligence Portal manual.

3. In App Studio, the designated Developer user views or opens the file from the Configured Environments tree.

Setting Up Access to WebFOCUS Environments

As you set up access to WebFOCUS environments, your settings are retained in a file named wfscom.xml. WebFOCUS environment settings are typically stored in the following locations.

Windows 7:

drive:\Users\user_id\AppData\Roaming\Information Builders\wfscom.xml

where:

user_id

Is your Windows user ID.

Note:

- This file and directory might not be visible, by default. To see this directory, open the Windows Control Panel, click Folder options, and then click the View tab. Select Show hidden files, folders, and drives, and click OK.

- User IDs and passwords stored in wfscom.xml are encrypted to keep them confidential.

- WebFOCUS environment properties apply to your current App Studio configuration.

- To ensure access to the WebFOCUS tools that create charting procedures, alert procedures, and Reporting Objects, you must develop against WebFOCUS environments that are Release 8.0 Version 0.5 or higher. When App Studio connects to a WebFOCUS environment, of a prior release, you will receive a WFSCom message.
You can choose to remove this environment from your configuration files or leave the environment, and continue to develop against other environments that you configure. If you choose to remove the environment from your configuration files, you must restart App Studio.

**Procedure: How to Add a WebFOCUS Environment**

A WebFOCUS environment consists of a web server, a WebFOCUS Client, and a Reporting Server. Adding WebFOCUS environments lets you create and manage multiple environments, such as development, test, and production instances.

To add a WebFOCUS environment, do the following:

- Specify a web server that includes a host name and port number.

- Configure the HTML alias/context root to access the WebFOCUS Client. If you develop applications in the Data Servers area and need to deploy the application to an environment that has a different alias, see *Working With the HTML Alias Property* on page 109.

- Provide the appropriate user credentials if web server authentication is required.

The following procedure provides the information you need to add a WebFOCUS Environment.

1. On the *Home* tab, in the *Configure* group, click *Environments*.

   The Environments List dialog box opens. This dialog box lists all WebFOCUS environments defined for App Studio.
2. Click **Add**.

The WebFOCUS Environment Properties dialog box opens, as shown in the following image.

At the top of the dialog box is the Description field, followed by the Environment Settings area. The Environment Settings area contains a series of buttons that represent components in a WebFOCUS environment, and the required parameter fields to configure that environment. When you configure an environment, the areas below the buttons can change according to the parameters that are required.

3. In the Description field, type a description for the WebFOCUS environment. This description appears in the Configured Environments tree.
4. In the Web Component area, specify the web server information.

For some environments, once you specify the web server, all other settings default. If the WebFOCUS environment you are accessing does not use default settings, or the components require authentication, click the appropriate button in the Environment Settings area to provide the parameters. The areas that follow explain the parameters available for each component.

Note: WebFOCUS environment properties must be supplied in a specific order. For example, if web server security is enabled, you cannot set the WebFOCUS Client script name until you have provided valid web server credentials. Similarly, you cannot retrieve a list of Reporting Servers until you have provided a valid WebFOCUS Client Path.

As you select a component button in the WebFOCUS Environment Properties dialog box, App Studio ensures that it has the necessary information before it displays the properties of that component in the lower part of the dialog box. If the required information is not available, you cannot proceed to the next component.

5. Click OK.

The WebFOCUS Logon - WebFOCUS dialog box opens and prompts you for a WebFOCUS ID and password.

The WebFOCUS Logon - WebFOCUS dialog box populates the ID wfdesktop, by default. This user ID is configured with WebFOCUS and allows self-service development: development from the Data Servers and Web Applications areas.

Access to the domain is restricted, and you cannot create new content with this user ID. You can only see and run published content.

There is a check box option on the logon dialog box for remembering the ID or password. By default, it is not selected. If you select this box, your credentials are stored and encrypted in the wfscom.xml file, the local configuration file that stores information processed by the App Studio communication layer.

To clear stored credentials, open the WebFOCUS Environment Properties dialog box and select the environment that users need to make changes. Click WebFOCUS Client. Under WebFOCUS Credentials, delete the User ID and Password information, and then clear the Supply Credentials check box.
**Note:** A logon dialog box can also open for connection to the web server, application server, or Reporting Server, depending on the security implemented in the WebFOCUS environment that is being accessed.

6. Type the appropriate user name and password, and then click **Logon**.

The WebFOCUS Environment Properties dialog box closes.

If you are connecting to an older version of WebFOCUS, an alert message may appear, warning you that certain App Studio features may not be compatible. Click **OK** to continue.

7. In the Environments List dialog box, click **OK**.

**Working With the HTML Alias Property**

If you develop applications in the Data Servers area and need to deploy the application to an environment that has a different alias, it is necessary to use a Generic alias. For existing pages, open the HTML pages and change the alias. The pages will not work if you do not change the alias to Generic.

**Note:** This option is only applicable to the Data Servers area.

To set an alias for a new page or change the alias for an existing page, you can:

- Set the HTML alias property in the Properties panel for the DOCUMENT object.
- Set the HTML Alias property value globally in the HTML Page section of the App Studio Options dialog box.

For the DOCUMENT object, the HTML alias property on the Properties panel contains the following values:

- **Custom.** In the HTML page, the alias (szHtmlAlias) will have the value of the HTML Alias from the settings in the WebFOCUS Environment Properties dialog box. Custom is the default value, since applications developed in the Data Servers area are meant for self-service applications.

- **Generic.** In the HTML page, the alias (szHtmlAlias) will have a generic value. This allows for files to be moved from one environment to the other.
The HTML alias property on the Properties panel is shown in the following image.

The HTML Alias property on the HTML Page section of the App Studio Options dialog box has the same values and functionality as the Properties panel. When the value is changed for this property, new pages will inherit the setting from the App Studio dialog box. This option is global and will be available for each HTML page.
Note: For existing non-self-service applications that need to be moved from development to production, you can set the value of HTML Alias as Generic in the App Studio Options dialog box. All existing pages will have to be opened and then saved with this setting before they are moved to Production.

The HTML Alias property on the HTML Page section of the App Studio Options dialog box is shown in the following image.

![HTML Alias property on the HTML Page section of the App Studio Options dialog box](image)

Note: To test the property, open the HTML page in the editor and verify the value of the HTML Alias, szHtmlAlias. For Custom, the value should be the same as in the HTML Alias property in the Environments dialog box, for example, szHtmlAlias=/ibi_apps/. For Generic, the value should be szHtmlAlias=/ibi_html/.

Setting Up Local Machine Properties

Local Machine properties are optional. Click the Local Machine button to access the WebFOCUS Environment Caching area. Select the options in this area to cache remote directory and file information, and enable file-content caching.

The file content caching location path is for a Windows 7 machine.
In caching, copies of files or information stored on a remote machine are temporarily stored on your local App Studio machine. App Studio then works with the locally stored files.

Caching speeds App Studio performance because remote machines are not accessed and queried every time you request information. This is especially useful when accessing mainframes or when a network connection is slow.

However, caching should not be used when multiple developers are working with the same files because they could overwrite changes made by other developers. By default, caching is not enabled.

Two properties are available:

- **Cache remote directory and file information.** This option caches information about files stored in the WebFOCUS environment. This does not actually cache files, only information about them. If you select this property, App Studio does not requery the Reporting Server every time it needs a list of files stored in the WebFOCUS environment.

- **Enable file content caching.** This option caches files typically stored on the server. App Studio only retrieves files once. When you want to read or edit your files, App Studio uses a cached copy. When you edit a cached file, the edited cached file is returned to the server and replaces the actual file on the server.

App Studio retrieves information and files the first time you request them and then caches them locally. App Studio then uses the cached copies until App Studio is restarted, or you click the *Clear* buttons for each level.

**Note:**

- If you create a new synonym, you have to perform a refresh to view the new files in the App Studio Environments Tree panel when caching is enabled.

- You cannot use the caching options for the local development environment if the Source Control feature is enabled.

**Specifying Web Component Properties**

The *Web Components* button is typically selected by default. Web Component properties specify how App Studio accesses the web server. The web server must be identified before any other components.

The following properties are available:

- **Host Name/IP Address.** Specifies the host name or IP address where your web server is running. This field is required and has no default value.
Allow Host Aliases. If checked, enables you to configure multiple WebFOCUS instances that have been installed on the same host machine.

Protocol. The protocol to use for accessing the web server (HTTP or HTTPS).

Port. The TCP/IP port for accessing the web server. Port 8080 is the default.

HTML Alias. Identifies the alias used to access content from the WebFOCUS environment directory, ibi_html. In App Studio, there is no need to configure an ibi_html alias. The ibi_html content is accessed through the ibi_apps alias. The configuration of this alias is:

/ibi_apps/ibi_html

where:

ibi_apps
   Is customizable.

ibi_html
   Is constant.

Client Path. Specifies how calls are made from App Studio to the web server. By default, when you add a new WebFOCUS environment, it is set to use the WebFOCUS Servlet with the default ibi_apps context path:

/ibi_apps/WFServlet

where:

ibi_apps
   Is customizable.

WFServlet
   Is constant.

If the WebFOCUS environment uses a non-default context path, clear the Use Default check box and provide the correct Client Path. For example:

/ibi_apps8/WFServlet

If the Client Path is incorrect for the environment, you receive an error when you click the WebFOCUS button at the top of the page, or when you click OK to exit and save your changes.
If you do not know your path, ask your WebFOCUS Administrator or check the WebFOCUS Administration Console of the environment to which you want to connect. The Client Path settings for the environment are located under Utilities and Client Selection.

- **Use Default.** Specifies that the default ibi_html alias is used. Keep this option selected unless you change the HTML Alias value.

**Note:**

- If the Client Path field is empty, and the Use Default check box is selected, there is a problem connecting to the WebFOCUS Client. Ensure your web server is started and that you typed the correct properties on the Web Components page. If you cannot connect, contact your WebFOCUS Administrator.

- If while providing a custom HTML Alias and Client Path, your connection fails because of incorrect information and the Client Path is deleted, you can clear **Use Default** to restore the values you entered. Click the **Use Default** check box to edit the HTML Alias and Client Path, and type the correct information. If a custom ibi_apps alias or context path is used, it needs to be entered in both the HTML Alias and Client Path fields. For example:

  HTML Alias:
  
  /ibi_apps8/ibi_html

  Client Path:
  
  /ibi_apps8/WFServlet

- **Connection Timeout.** The default time to connect to a WebFOCUS environment is 60 seconds. However, in some slow systems this needs to be increased to avoid connection failures when the timeout period is reached. If timeout issues are experienced, please increase this to 240 or higher. Also, increasing the timeout can address issues with slow environments or environments that have many resources (Applications/files) during development.

- **Login Timeout.** Specifies how long App Studio should wait for the login credentials to be validated. The default time is 15 seconds. You can set this to a higher value, if necessary. You can configure this setting for each environment.

- **Web Component Authentication.** Specifies whether authentication is required on the web server. To set security, select **Basic** in the drop-down list, and type a web server user ID and password. If this is set to **None**, the web server allows anonymous access.

  For more information, see the *WebFOCUS Security and Administration* manual.
WebFOCUS Properties

When you click the WebFOCUS button, App Studio makes a connection to your web server to retrieve information about the WebFOCUS environment. Therefore, you have to first specify Web Component properties, and your web server must be running.

You are prompted to sign in to WebFOCUS to verify your configuration. You will also be prompted to sign in to WebFOCUS if you click OK to exit the dialog box.

The following properties are available:

- **Client Path.** Is specified in the WebFOCUS Component properties area, and only appears in this pane for reference. This field is read-only and can only be changed in the WebFOCUS Component properties area.

- **Select Language.** Specifies the language of the WebFOCUS Client.

- **Supply Credentials.** Specifies whether to supply and store credentials when you connect to WebFOCUS and access the environment.

When the correct WebFOCUS Client Path is provided, you can specify properties for the remaining component.

Data Server Properties

You can set authentication and view available Reporting Servers by clicking the Data Servers button. When you select Data Servers, App Studio connects to the WebFOCUS Client and retrieves a list of servers from its communication configuration file (odin.cfg).

The following property is available:

- **Supply Credentials.** If selected, you can type a WebFOCUS Server ID and password for the server highlighted in the list. Clicking Set stores the credentials with the environment properties, and the ID entered is shown next to the server in the list. The credentials are checked the next time you use a feature on that server, not when you click Set.

Procedure: How to Edit an Existing WebFOCUS Environment

1. On the Home tab, in the Configure group, click Environments.
   
   The Environments List dialog box opens.

2. Select the environment that you want to edit.

3. Click Properties.
   
   The WebFOCUS Environment Properties dialog box opens.
4. Edit the WebFOCUS environment accordingly, and then click OK to accept your changes.

5. In the Environments List dialog box, click OK.

Mode Manager

If you have the manage private resources permission, you can use Mode Manager to view and edit private files. To enable Mode Manager, right-click on the domain node and click Mode Manager. Your view refreshes, displaying all private files in the domain. You can open and make changes to these private files as needed. When you are finished, right-click on the domain node and click Mode Normal. Your view refreshes, hiding the private files in the domain node.

Note: When a file in the domain is marked as shared, and you do not have permission to save the original file, you will only be allowed to use the Save As command to save the file. This will allow you to save the file under a different name, leaving the original file untouched.

Working With the Environments Detail Panel

The Environments Detail panel is an optional panel, which contains panel customization commands, the Environments Detail toolbar, the Configured Environments tree, and the Details pane. To display the Environments Detail panel, on the Home tab, in the View group, select the Environments Detail button.

The Environments Detail panel is similar to the Environments Tree panel except that content is displayed in the Details pane rather than under the Configured Environments tree.

From the Environments Detail panel, you can:

- Customize the appearance of the panel.
- Filter content listed under the WebFOCUS environments in the Configured Environments tree.
- Access configured WebFOCUS environments to create new content or modify existing content.
- Refresh an application or folder in the Configured Environments tree, to view new files and updated file information, and omit deleted files.

When you select a folder in the Configured Environments tree, the content within that folder is shown in the Details pane.
Reference: Environments Detail Toolbar

The Environments Detail toolbar contains the buttons and menus that you need to navigate and filter the information that appears in the Configured Environments tree.

View Options

Presents options for viewing items (for example, alphabetical sorting or grouping), as described in Environments Tree Toolbar on page 87. Note that the available icons for the Environments Detail toolbar and the Environments Tree toolbar are the same.

Note: To sort content in the Environments Detail panel, you do not use the View Options command. Instead, you would click the columns at the top of the Details pane to sort content by name, size, type, last modified, or location.

Viewing File and Folder Properties

The File/Folder Properties panel shows overview properties of a folder or file selected in the Environments Tree panel. For example, if you highlight a folder in the Environments Tree panel, the File/Folder Properties panel shows information like the name and title of the folder and the date it was last modified. If you highlight a report file in the Environments Tree panel, the File/Folder Properties panel shows things like whether the report is enabled for Auto Link or Auto Drill.
The File/Folder Properties panel is shown in the following image.

<table>
<thead>
<tr>
<th>General</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Quantity_Sold_By_Stores.fex</td>
</tr>
<tr>
<td>Title</td>
<td>Quantity Sold By Stores</td>
</tr>
<tr>
<td>Summary</td>
<td></td>
</tr>
<tr>
<td>Development Environment</td>
<td>bigscm64_head</td>
</tr>
<tr>
<td>Parent Folder</td>
<td>IBFS://WFC/Repository/Retail_...</td>
</tr>
<tr>
<td>Full Path</td>
<td>IBFS://WFC/Repository/Retail_...</td>
</tr>
<tr>
<td>Created On</td>
<td>4/11/2016 3:30:54 PM</td>
</tr>
<tr>
<td>Created By</td>
<td>manager</td>
</tr>
<tr>
<td>Last Modified On</td>
<td>4/11/2016 3:30:54 PM</td>
</tr>
<tr>
<td>Last Modified By</td>
<td>manager</td>
</tr>
<tr>
<td>Last Accessed On</td>
<td>4/11/2016 3:30:54 PM</td>
</tr>
<tr>
<td>Last Accessed By</td>
<td>manager</td>
</tr>
<tr>
<td>Properties</td>
<td>masters=&quot;retail_samples/wf_re...</td>
</tr>
<tr>
<td>Size</td>
<td>1.05 KB (1,072 bytes)</td>
</tr>
<tr>
<td>Sort Order</td>
<td></td>
</tr>
<tr>
<td>Status</td>
<td>Public</td>
</tr>
<tr>
<td>Shown to other users</td>
<td>Yes</td>
</tr>
<tr>
<td>Prompt for parameters</td>
<td>Yes</td>
</tr>
<tr>
<td>Run with OLAP</td>
<td>No</td>
</tr>
<tr>
<td>Only run as deferred report</td>
<td>No</td>
</tr>
<tr>
<td>Use Title for Deferred Report...</td>
<td>No</td>
</tr>
<tr>
<td>Schedule only</td>
<td>No</td>
</tr>
<tr>
<td>Enable Auto Linking</td>
<td>Yes</td>
</tr>
<tr>
<td>Auto Link Target</td>
<td>No</td>
</tr>
<tr>
<td>Enable Auto Drill</td>
<td>No</td>
</tr>
<tr>
<td>Source Control Status</td>
<td>_not_set</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Data Server</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Server</td>
<td>EDASERVE</td>
</tr>
<tr>
<td>Application Paths</td>
<td>retail_samples</td>
</tr>
</tbody>
</table>

The options within this panel change according to the type of file or folder you select. You can view the properties of a file or folder in the Data Servers and Domains areas of the Configured Environments tree.
Copying Property Values in the File/Folder Properties Panel

You can copy a property value from the File/Folder Properties panel. Right-click a property value and click Copy to copy it to the clipboard. This is particularly useful if you want to capture the full path of an open file.

Editing Properties in the File/Folder Properties Panel

The following table defines the properties that you can change for each node within the File/Folder Properties panel.

Note: The changes that you make in the File/Folder Properties panel are not reflected in the Configured Environments tree until you click outside of the panel.

Data Servers

<table>
<thead>
<tr>
<th>Element</th>
<th>Editable Panel Properties</th>
</tr>
</thead>
<tbody>
<tr>
<td>Node</td>
<td>- <strong>Title.</strong> Changes the title of the Data Server node in the Configured Environments tree.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Server Path.</strong> Indicates the fully-qualified path to the server.</td>
</tr>
<tr>
<td>Primary Folder</td>
<td>- <strong>Title.</strong> Changes the title of the primary folder in the Configured Environments tree.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Server Path.</strong> Indicates the fully-qualified path to the server.</td>
</tr>
<tr>
<td>Subfolder</td>
<td>- <strong>Name.</strong> Changes the name of the selected subfolder in the Configured Environments tree.</td>
</tr>
<tr>
<td>File</td>
<td>- <strong>Name.</strong> Changes the name of the selected file in the Configured Environments tree.</td>
</tr>
</tbody>
</table>

Domains/domain
## Element | Editable Panel Properties
---|---
### Node

- **Title**. Changes the title of the domain node in the Configured Environments tree.
- **Server Path**. Indicates the fully-qualified path to the server.

### Folder

- **Name**. Changes the name of the folder in the Configured Environments tree.
- **Title**. Changes the title of the folder in the Configured Environments tree.
- **Summary**. Adds summary information to the folder properties.
- **Sort Order**. Specifies the order in which to list the folder or item in the tree.
- **Shown to other users**. This value is set to Yes, by default. If Yes is selected, this folder will display on the user list. If No is selected, the folder is hidden from other users.
- **Auto Create My Content Folders**. This value is set to Yes, by default, to create a My Content folder for saving personal reports, charts, or documents. You can optionally set this to No to disable this functionality.
- **Automatically Open**. This value is set to No, by default. If Yes is selected, this folder will automatically be open in the next session of App Studio.
- **Source Control Status**. Displays whether or not Source Control is set.
- **Server**. This value defaults to the server that is currently in use. You can use the drop-down list to affiliate a different server with the folder.
- **Application Paths**. This value defaults to the application path indicated for the selected folder. You can modify this value as needed.
<table>
<thead>
<tr>
<th>Element</th>
<th>Editable Panel Properties</th>
</tr>
</thead>
<tbody>
<tr>
<td>File</td>
<td>- <strong>Name.</strong> Changes the name of the file in the Configured Environments tree.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Title.</strong> Changes the title of the file in the Configured Environments tree.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Summary.</strong> Adds summary information to the folder properties.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Sorted Order.</strong> Specifies the order in which to list the file in the tree.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Shown to other users.</strong> This value is set to Yes, by default. If Yes is selected, this file will display on the user list. If No is selected, the file is hidden from other users.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Prompt for parameters.</strong> This value is set to Yes, by default. If No is selected, you will not be prompted for parameters.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Run with OLAP.</strong> This value is set to No, by default. If Yes is selected, you can run the report or procedure with OLAP.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Only run as deferred report.</strong> This value is set to No, by default. If you select Yes, the report or procedure will run only as a deferred report.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Use Title for Deferred Report Description.</strong> This value is set to No, by default. If you select Yes, the title is used instead of the name, as the description for a deferred report.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Schedule only.</strong> This value is set to No, by default. If Yes is selected, you will only be able to schedule the report or procedure.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Enable Auto Linking.</strong> This value is set to No, by default. If Yes is selected, Auto Linking enables you to develop and maintain numerous referenceable reports and charts that can be linked together.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Auto Link Target.</strong> Indicates whether the file is set as a target for an Auto Link drill down. This value is set to No, by default.</td>
</tr>
</tbody>
</table>
### Procedure: How to Enter Titles and Summaries in Multiple Languages

In App Studio, you can dynamically switch to another language to display screen text in that language. Available languages are determined by your settings in the WebFOCUS Administration Console.

In addition, you can enter your file and folder titles and summaries in multiple languages using the Language Properties title and summary dialog boxes. So, when you dynamically switch languages, the titles and summaries automatically appear in the selected language. This can help streamline your collaborative, multi-language development work.

**Note:** In order to enable the Language Properties dialog box, you must select the *Enable Dynamic Language* check box in the Dynamic Language Switch area of the Configuration tab in the WebFOCUS Administration Console. For more information, see the *WebFOCUS Security and Administration* manual.

1. In the Configured Environments tree, right-click a file or folder and select *Properties* from the shortcut menu.
   - The File/Folder Properties panel opens. The Title property value is the same as the Name value, by default. The Summary property value is blank, by default.

2. Click in the Title property field to edit the title.
   - An ellipsis button appears on the right side in the Title property field.

3. Click the ellipsis button.
   - The Language Properties dialog box for titles opens.

### Element | Editable Panel Properties
--- | ---
**File** | - **Enable Auto Drill.** This value is set to No, by default. If Yes is selected, Auto Drill allows you to navigate through different levels within the dimension hierarchy of your data source.
- **Source Control Status.** Displays whether or not Source Control is set.
- **Server.** This value defaults to the server that is currently in use. You can use the drop-down list to affiliate a different server with the file.
- **Application Paths.** This value defaults to the application path indicated for the selected file. You can modify this value as needed.
The Default column is where you specify the title that displays unless it is explicitly overridden by another language title.

The Language column displays the languages that are enabled in your installation of App Studio.

4. Enter titles as needed in the Title column and click OK.

The Language Properties dialog box closes. The titles are saved.

5. Click in the Summary property field to edit the summary. Repeat the steps above to enter and save the summary language text.

Application Paths Dialog Box

You can add, remove, or reorder the associated application paths in the Application Paths dialog box.

Open the Application Paths dialog box by clicking the ellipsis button next to the Associated Paths information. The Application Paths dialog box displays a list of applications that you can associate with your domain and a list of applications that are currently associated with your domain.

Adding or Removing Applications

To add an application to the domain, click the name of the application in the Available list, and then click the right arrow to add the application to the Selected list. Click OK to view your changes in the File/Folder Properties panel.

To remove an application from the domain, click the name of the application in the Selected list, and then click the left arrow. Click OK to view your changes in the File/Folder Properties panel.

Reordering Applications

To reorder an application in the Available list, click the name of the Application and then click up or down. Click OK to view your changes in the File/Folder Properties panel.

Editing Areas of Functionality Using the View Tabs

You can use the view tabs to edit different areas of functionality for the same document. These tabs show information that would be inaccessible from any other view tab.
Designing the Layout of a Page Using the Design View Tab

The Design View tab is accessible when you are creating an HTML page or document. From here, you can design the layout of your page by adding controls and components to the canvas. This tab is selected by default when you are creating an HTML page or document.

Creating and Modifying Parameter Values Using the Parameters View Tab

The Parameters View tab is accessible when you are creating an HTML page or In-Document Analytic dashboard. From here, you can create and modify parameter values, input controls, and customize parameter conditions. You can also bind parameters to controls and chain controls to one another.

The Parameters tab consists of the following components:

- Input control objects.
  - You may select the input control object to view and edit the Properties and settings of the control.
  - Creating an input control from the Design view prompts you to create a bound parameter on the Parameters tab.
  - Editing an input control, which is inserted when setting input controls for new parameters.

- Add new parameters.
  - Right-click anywhere on the Parameters tab to add a new parameter.
  - Note: Manually adding a parameter creates an unbound parameter.

- Refresh unresolved parameters.
  - All parameters on the parameters tab are parsed every two minutes to check if any are unresolved. If there are any unresolved parameters, their surrounding polygon is colored red. If you want to check for unresolved parameters on demand, right-click and select Refresh unresolved.

- Binding controls and parameters.
  - Input controls and parameters can be bound and unbound from the Parameters tab.
  - You may bind a parameter to an input control, or bind an input control to a parameter.
  - Binding a parameter to a control makes it an incoming parameter that will populate the control. Drag a parameter object to a control object on the Parameters tab.
Binding a control to a parameter will populate the parameter. Drag a control object to a parameter object on the Parameters tab.

Chain one control to another. Chaining will populate controls based on the selected value from the prior control in the chain. You can chain static and dynamic controls, link or unlink parts of a chain, and create conditions on links in a chain. Chains are represented by lines connecting control objects on the Parameters tab. By clicking the arrow head in a link of a chain, the Properties and settings dialog box enables you to modify and set properties and conditions of the chain.

**Note:** Chaining is applicable only for controls, not parameters.

**Creating JavaScript and Cascading Style Sheets Using the JavaScript and CSS View Tabs**

The Embedded JavaScript and Embedded CSS View tabs are accessible when you are creating an HTML page. From here, you can create JavaScript code and cascading style sheets (CSS) for use in your HTML page. You can reference existing cascading style sheet files and JavaScript files by typing the URL in the URL/Find File area of the Settings panel. You can also search for these files by using the CSS or JavaScript commands.

Embedded code is used only in the host HTML file. External code is available to be used by multiple files.

**Procedure: How to Customize Titles Using jQuery Tooltips**

The following procedure describes how to customize titles, using jQuery and Internal CSS.

1. Create an HTML page.
2. Add a component or control to the page.
3. Navigate to the Properties panel.
4. Type a value for the Title property, under the Core attributes section.
5. Click the canvas to select the DOCUMENT object.
6. On the Properties panel, click the lightning bolt icon on the toolbar to show the events.
7. For the Load event, click the column on the right to display the ellipsis button, as shown in the following image.

8. Select the Embedded JavaScript view tab on the HTML canvas.

9. After the comment lines, add a new line, and type the following code, as shown in the following image.

```javascript
$(document).tooltip();
```

```javascript
//Begin function window_onload
function window_onload() {
    UpdateData();

    // TODO: Add your event handler code here
    //add onInitialUpdate() function to make changes before initial run of the reports
    $(document).tooltip();
}
//End function window_onload
```
10. Navigate to the Embedded CSS tab, as shown in the following image.

![Embedded CSS tab image]

11. Enter a new line after the first class definition and type the following as the new class name.

$.ui-tooltip

12. Add the following CSS Styles, as shown in the following image.

- Color: white;
- Font-size: small;
- Background: black;
Customizing the Panels

Similar to the ribbon tabs, App Studio features open panels that provide additional options to assist in the development of your application. Not all panels open at the same time, nor do they provide the same options. When you launch App Studio for the first time, only the Environments Tree panel appears docked to the edge of the canvas. The File/Folder Properties panel also appears, but is auto hidden.

All panels, except the Environments Tree panel, are auto hidden by default. You can control the visibility of the panels in the View groups on the Home tab and Utilities tab. You can also use the panel customization options, which are located in the upper-right corner of the panel, to change the appearance and location of the panels around the canvas.

Procedure: How to Rearrange Panels on the Canvas

To rearrange a panel on your canvas using the panel properties menu, follow these steps:

1. Click the Window Position button.

   The panel properties menu opens.

2. Select an option from the panel properties menu.
The options available are:

- **Floating.** Undocks the panel and allows you to move it freely around the canvas.
- **Docking.** Docks the panel onto the edge of your canvas where it last appeared.
- **Tabbed Document.** Opens the panel in the canvas area, as a tab. This option is unavailable in App Studio.
- **Auto Hide.** Hides the panel as a tab on the edge of your canvas. When you pause over the tab, the panel reopens.
- **Hide.** Closes the panel.

**Note:** You can also open the panel properties menu if you right-click the top of the panel.

**Procedure:** How to Pin and Unpin Panels to the Canvas

You can pin a panel to the canvas to keep it open while you develop your application. When you unpin the panel, it becomes auto hidden again, and appears as a tab on the edge of the canvas. When you hover the mouse over this tab, the panel reopens.

- To pin a panel to your canvas, click the *Auto Hide* horizontal pin button.
- To unpin a panel to your canvas, click the *Auto Hide* vertical pin button.

**Procedure:** How to Close and Reopen Panels

- To close a panel, click *Close* in the upper-right corner of the panel.
- To reopen the panel, go to the *Home* tab, and in the *View* group, and select the appropriate panel button.
- To reopen a panel in the HTML canvas, go the *Utilities* tab, and in the *View* group, select the appropriate check box.

**Using Handles**

You can dock floating panels within the canvas to ease accessibility. When you drag a panel across the App Studio canvas, a set of handles appears. These handles guide the placement of the panel, and automatically dock the panel to the edge of the canvas upon which you rest the mouse.
Customizing the Panels

The following image shows an example of the handles that appear when you drag the Environments Tree panel across the canvas.

**Procedure:** How to Dock Panels Around the Canvas Using Handles

1. From the panel customization toolbar, click the arrow, and then click *Floating*.
2. Drag the panel across the canvas and rest the mouse on a handle.
When you rest the mouse over a handle, a shaded area appears. This shaded area provides a preview of where the panel will dock if you release the mouse, as shown in the following image.

3. Release the mouse when you are satisfied with the previewed location of the panel. The panel automatically docks to the edge of the canvas.
Additional panels open as you develop applications throughout the product. To conserve space around the canvas, you can combine these panels. When you mouse over a docked panel, a tabbed handle option appears, as shown in the following image.

This handle option combines the panels into a single container with tabs. You can switch between the panels by clicking the appropriate tab at the bottom of the container. An example of the Environments Tree tab and File/Folder Properties tab, in a combined panel container, are shown in the following image.
Creating Metadata

Defined simply, metadata is data about data. Metadata describes the characteristics of your data sources to App Studio and gives it the information it needs to access those data sources. This insulates you from the need to know how to optimally access the data, so that you can concentrate on using the data for reporting, charting, visualizations, and applications. Examples of metadata components are data type, data location, and data content and information about how to connect to it. Metadata can be generated whenever data is created, acquired, added to, deleted from, or updated in any data source within an enterprise.

In this chapter:

- Understanding Data Terminology
- Accessing Data
- Generating a Synonym
- Changing Views in the Metadata Canvas
- Viewing and Editing Synonym Attributes
- Viewing Data Profiling Characteristics
- Enhancing a Master File with Expressions
- Describing Group Fields and Repeating Fields in a Synonym
- Parameterizing a Synonym with Variables
- Adding Indexes to a Synonym
- Creating Cluster Joins
- Creating a Synonym for Cube Data Sources
- Defining a Business View of a Master File
- Applying Database Administrator (DBA) Security
- Implementing DBA Security Using WebFOCUS Language
- Analyzing Procedures Using Impact Analysis
Understanding Data Terminology

The smallest meaningful element of data in a data source is referred to as a column (for relational data sources) or a field (for non-relational data sources). Column and field are used interchangeably throughout this content. Every column or field has several characteristics, such as the data type (character, date, integer, or some other type) and length or scale. Field characteristics can also include output display options, such as comma inclusion, currency symbol, date display, and so on. For consistency, all fields should be included in the metadata, so all users get the same view of the data. However, you can create a logical view of the data in which only a subset of the fields are available.

Certain fields in a data source may have a one-to-one relationship with each other and describe a group of related characteristics. For example, each unique ID number represents only one employee. These fields can be grouped together into a segment or, in relational terms, a table. You can relate segments to each other by creating a multi-segment data source or by joining segments together. Segments are the building blocks of larger data structures.

Fields can be categorized as measures (facts) or dimensions based on how they will be used in a request.

A measure or fact is a numeric value, such as Gross Profit or Cost of Goods Sold, that you may want to aggregate. All numeric values that can logically be summed are measures. Numeric fields that cannot be summed, such as product number and order ID, are not treated as measures. Instead, they may be used in the same way as dimension fields to analyze measures. It is up to you to understand your data and determine whether each numeric field should be summed. Related measures can be organized into measure groups. For example, Gross Profit and Cost of Goods Sold can be part of a Sales measure group.

A dimension is a way to categorize data. You can use a dimension to analyze and compare measures. Generally, any field that is not a measure, usually an alphanumeric field such as product, is a dimension. Dimensions can be organized into hierarchies to define the relationships between the fields in the hierarchies. For example, a Geography hierarchy can contain the Continent, Country, State, and City dimensions. You can also define dimension fields that are not part of a dimension hierarchy.

An attribute is a collection of related objects in a dimension. For example, in the Model dimension, there are attributes for Brand, Brand Type, and Product Name. Attributes are specific to a dimension and are typically more specific than general in nature.
Accessing Data

When your App Studio application accesses data, App Studio needs to know how to interpret the data that it finds. A Master File, which is the primary component of metadata, is a map of the segments in the data source and all of the fields in each segment. The Master File also identifies the name of the data source and the type of data source it is.

For some types of data sources, the Master File is supplemented by an Access File. An Access File includes additional information that completes the description of the data source. For example, it includes the full data source name and location. You require one Master File and, for some data sources, one Access File to describe a data source. These metadata files (Master File and Access File) are referred to as a synonym.

Synonyms are stored separately, apart from the associated data source. Your App Studio application uses a synonym to interpret a data source as follows:

1. It identifies the data sources available and their respective fields.
2. It examines the security rules, if Information Builders data source security (DBA) has been specified for the data source, and ensures that user access is allowed based on any DBA security specified.
3. It identifies the Access File for the data source, if that data source requires an Access File.

The data source content is interpreted based on the information in the Master File and, if applicable, the Access File.

Working With Data Adapters

With the appropriate WebFOCUS Data Adapters, you can access data from many different sources, including the following:

- Relational data sources, such as Db2 and Oracle.
- Hierarchical data sources, such as IMS and FOCUS.
- Indexed data sources, such as ISAM and VSAM.
- Network data sources, such as CA-IDMS.
- Sequential data sources, both fixed-format and delimited format.
- Multi-dimensional data sources, such as SAP BW and Essbase.
- XML data sources.
Generating a Synonym

Every adapter is specifically designed for the data source that it accesses, and, as a result, is able to translate between SQL or WebFOCUS and the data management language (DML) of the data source. The adapter manages the communication between the data interface and the data source and returns either answer sets or messages to the requestor. Adapters provide solutions to product variations, including product differences in syntax, functionality, schema, data types, catalogs, data representations, message processing, and answer set retrieval. It is the adapter that manages the synonym creation process.

The parameters required to configure supported adapters and to create synonyms for the corresponding data sources are described in detail in the Adapter Administration manual.

Generating a Synonym

A synonym defines a unique logical name (also known as an alias) for each web services operation. Synonyms are useful because they insulate client applications from changes to the location and identity of a request. You can move or rename a request without modifying the client applications that use it. You need to make only one change, redefining the request synonym on the server. Synonyms provide support for the extended metadata features of the server, such as virtual fields and security mechanisms. Creating a synonym generates a Master File and an Access File.

Often, a synonym already exists on the server, and reporting can begin at once. However, if the synonym you require does not exist on the server, an authorized server or application administrator can create it directly using the Metadata canvas in App Studio.

To begin creating a synonym, you use the Data Source Definition Wizard, which guides you through the steps that you need to follow to open a recently used synonym, create a new synonym, or edit an existing synonym. You use the Metadata canvas, and the available tab and panels, to develop your synonym. This enables you to explore DBMS catalogs and select the objects for which you wish to create synonyms. The Metadata canvas prompts for the information it needs to create a synonym for a particular data source and stores the generated synonym on the server.

In order to generate a synonym, you must be authorized to use the data against which you plan to report and you must have configured an adapter to access that type of data. When you begin to create a synonym, App Studio opens the Select adapter to configure or Select connection to create synonym window. The option to create the synonym becomes available only after the adapter is successfully configured.

Once you have generated a synonym, you can report against the synonym. In many instances, the configured adapter and the generated synonym are all you need to access your data and create reports and graphs.
However, you may wish to enhance the synonym in order to implement particular capabilities that are supported in the WebFOCUS data description language. To do this, you can use the Metadata canvas.

When you use the Metadata canvas, there is no need to know the data description language. All viewable and editable attributes of the synonym components display. If you make changes to the generated synonym, the Metadata canvas validates your entries and displays messages if they violate the underlying syntax of the data description language.

**Note:** If you are comfortable working directly with syntax, you can open the synonym components in a text editor. For detailed information about the underlying syntax, see the *Describing Data With WebFOCUS Language* manual.

### Enhancing a Synonym

The following are some of the attributes you might want to add to the synonym to enhance your data access and reporting capabilities. You can:

- Apply security rules for fields and values to ensure that user access is based on Information Builders data source security (DBA) specifications.
- Add virtual columns (DEFINE fields) and columns for aggregated values (COMPUTE fields).
- Add filters to specify data selection criteria.
- Add group definitions for data sources that support groups.
- Add meaningful titles and descriptions, including multilanguage variations.
- Change the format of fields (for example, the size of an alphanumeric field or the format of a date field).
- Create a cluster join view by linking available synonyms to create a multisegment (multitable) file for reporting.
- Create business views of the metadata in order to limit the fields available to any retrieval request that references the business view and to group fields together based on their roles in an application.
- Define parent and child hierarchies for cube data sources.

**Procedure:** How to Access the Metadata Canvas

In App Studio, you create new synonyms and edit existing synonyms using the Metadata canvas. You can access the Metadata canvas through the Design or Open command, in the *Data & Metadata* group, on the *Home* tab.
The Metadata canvas opens, as shown in the following image.

Note: The examples in this document use a multi-fact structure containing multiple Fact tables that have corresponding Dimensions described in the Master File.

Building a Synonym Using the Metadata Tab

The Metadata canvas displays the Metadata tab, which contains all the commands necessary to build your synonym.

The Metadata tab contains groups and commands that provide quick access to commonly performed functions while working in the Metadata canvas. You can use the Metadata tab to undo or redo actions, manipulate selections of data, find and edit text, switch to different view tabs, insert notes, run different reports, and switch between different view modes. The behavior of the command is determined by the selected object. Therefore, certain tab components may be inactive. The Metadata tab is shown in the following image.
Restoring Actions Using the Undo/Redo Group

You can undo and redo actions. The Undo/Redo group is shown in the following image.

The commands are:

**Undo**

Undoes the last action.

**Redo**

Restores a previously undone action.

Deleting, Cutting, Copying, and Pasting Using the Clipboard Group

You can delete, cut, copy, and paste sections from the canvas. The Clipboard group is shown in the following image.

The commands are:

**Delete**

Deletes your selection.

**Cut**

Cuts your selection.

**Copy**

Copies your selection.

**Paste**

Pastes from your clipboard to the designated area.
Searching and Revising Text Using the Editing Group

You can find specific text, select the entire canvas, replace specific text, move to a specific point in the canvas, apply case formatting to text, and add comments. The Editing group is shown in the following image.

![Editing group](image)

The commands are:

- **Find**
  Finds specified text.

- **Find Next**
  Finds the next instance of specified text.

- **Find Previous**
  Finds the previous instance of specified text.

- **Select All**
  Selects the entire canvas.

- **Replace**
  Replaces the specified text with different text.

- **Go To**
  Moves your view of the canvas to the specified area.

- **Invert Case**
  Inverts the case of the selected text.

- **Upper Case**
  Upper case the selected text.

- **Lower Case**
  Lower case the selected text.

- **Comment Selection**
  Comment the selected text.
Uncomment Selection

Uncomment the selected text.

Switching Between Views and Aerial View Using the View Group

You can switch between the different views and switch Aerial view on or off. The View group is shown in the following image.

The commands are:

Field

Switches to the Field View. The Field View shows a list of objects on the left, with the attributes and values of the selected item on the right.

Segment

Switches to the Segment View. The Segment View shows the segments that the synonym contains. The Segment View shows a list of objects on the left, with the attributes and values of the selected item on the right.

List

Switches to the List View. The List View shows a list of objects on the left, with the attributes and values of the selected item on the right.

When you right-click a column heading in the List View, a shortcut menu provides options to sort the display based on ascending or descending column values. The display can be sorted by any column.

Modeling

Switches to the Modeling View.

Text

Switches to the Text View tab.

You can print the Master File code by selecting Print from the Application menu, performing search operations, and making changes, if necessary.

Access File Text

Switches to the Access File Text View tab.
The Access File Text View shows the description of the Access File for a synonym, which is used to access the database.

**Note:** You can print the Access File code by selecting *Print* from the Application menu, performing search operations, and making changes, if necessary.

**Aerial View**

Switches between showing and hiding Aerial view. This view is only available when in the Modeling View tab.

**Inserting Nodes Using the Insert Group**

You can insert a node. The Insert group is shown in the following image.

The commands are:

**Insert**

Enables you to insert one of the following:

**Reference to Existing Synonym as Child**

The reference is a pointer to the source synonym using the synonym as a child. If you subsequently make changes to the source synonym, reopening the current synonym will reflect those changes.

**Reference to Existing Synonym as Root**

The reference is a pointer to the source synonym using the synonym as a root. If you subsequently make changes to the source synonym, reopening the current synonym will reflect those changes.

**Copy of Existing Synonym**

Adds a static copy of an existing synonym to the current synonym. If you subsequently make changes to the source synonym, the current synonym will not reflect those changes.
Segment via Metadata Import

Enables you to create and add a new synonym to the current synonym using the Create Synonym dialog box.

Segment Manually

Adds a synonym that must be coded manually.

DBA

Adds DBA security to the segment.

Field

Adds a general column to the segment.

Define

Adds a virtual or defined column to the segment.

Filter

Adds a filter to the segment.

Compute

Adds a calculated value to the file.

Sort Object

Adds a Sort Objects folder and a sort object. This option is available only if Support extended options is selected.

Variable

Adds a Variables folder and a variable to the segment.

Style

Adds a Styles folder and a style object. This option is available only if Support extended options is selected.

Subquery

Adds a subquery to the fields list.

Running a Sample Data, Data Profiling, or Impact Analysis Report Using the Reports Group

You can run a Sample Data report, Data Profiling report, or Impact Analysis report. The Reports group is shown in the following image.
The commands are:

**Sample Data**

Enables you to view and refresh sample data for the selected segment or synonym.

**Data Profiling**

Runs a Data Profiling report, which provides the data characteristics for synonym columns. The Statistics, Count, and Key Analysis options are available.

**Impact Analysis**

Runs an Impact Analysis report for the particular column in the workspace. An Impact Analysis report identifies the procedures that access a Master File or column within a Master File.

**Showing Properties, Data Flow, and View Panels Using the Tools Group**

You can switch between showing or hiding the Properties, DBA, and Business View panels. You can also recreate the default Business View structure and edit the user options. The Tools group is shown in the following image.

![Tools Group Image]

The commands are:

**Properties**

Switches between showing and hiding the Properties panel.

**Quick Copy**

Generates a simple Data Flow without using the Data Flow designer. For the selected tables, all rows and columns are copied to new tables.

Although no transformations or where conditions are generated, the Data Flow can still be opened as such and additional criteria can be added.

**DBA**

Switches between showing and hiding the DBA panel.
**Business View**

Switches between showing and hiding the Business View panel. Enables you to create a Business View and a custom Master File that can use selected columns from the original synonym. In addition, you can customize field names, titles, and descriptions.

**Options**

Allows you to edit the user options. When you click *Options* from the Tools Group, the Options dialog box appears. It enables you to set preferences and customize the look of the Metadata canvas.

**Setting Preferences for the Metadata Canvas Using the Options Dialog Box**

Click the *Options* button in the *Tools* group to open the Options dialog box.

**Reference: Synonym Editor Options Settings**

When you click *Options* from the Tools group, the options dialog box appears. It enables you to set preferences and customize the look of the Metadata Canvas.

The Synonym Editor settings page has the following fields and options:

- **Use application directory name with synonym**
  
  If this check box is selected, an application directory name is used when you select a synonym name for both referencing an existing synonym and a transformation with db_lookup.

- **Undo/Redo Limit**

  Specifies the maximum number of undo and redo operations allowed in the Synonym Editor.

- **Support extended options**

  If this check box is selected, both the Sort objects and Styles folders appear when you edit a synonym.

- **Enable insert copy of existing synonym**

  If this check box is selected, this option will be available in the shortcut menu when a synonym or segment name is selected.

- **Insert child segment with snowflakes**

  Inserts a reference to the selected table and any tables that the base synonym references through foreign keys.
Automatically arrange segments/folders in Modeling View

If you select or drag multiple or individual tables while in Modeling View, they will be automatically arranged for you.

Show parent segments in Join Editor

If this check box is selected, it controls whether or not columns in parent segments are displayed in the Join Editor for a cluster join or a synonym that references or includes, other synonyms.

Automatically detect entry segment

This information is not yet available.

Default Join Type

Sets the default Join type.

- **Unique.** This join indicates a single instance (one-to-one) type of join. At run time, each host record has, at most, one matching record in the cross-referenced file. This value is the default.

- **Multiple.** This join indicates a multiple instance (one-to-many) type of join. At run time, each host record can have many matching records in the cross-referenced file.

Auto Calculate Missing

Allows you to adjust the MISSING attribute.

- **Prompt.** Prompts before adjusting the MISSING attribute.

- **ON.** Adjusts the MISSING attribute without prompting.

- **OFF.** Does not adjust the MISSING attribute.

Modeling View Line Colors

Allows you to set colors for connector lines in the Modeling View.

- **Default.** Changes the color lines in the Modeling View.

- **Highlighted.** Changes the color of the highlighted lines in the Modeling View.

- **No keys.** Changes the color of lines with no keys in the modeling view.

Reset Colors

Restores the default colors.
**Reference:** Synonym Editor Format Options Settings

The Format pane is available from the Options dialog box. To open the Options dialog box, select *Options* from the Tools group. Expand the *General* node, and select *Format*.

The Fonts section has the following fields and options:

**Category**

Allows you to set the font for text in the process flow workspace, reports, text views, and log views.

**Font**

Launches a dialog box for specifying font settings.

**Reset Font to Defaults**

Restores the default fonts.

**Reference:** Synonym Editor Column Management Settings

The Column Management pane is available from the Options dialog box. To open the Options dialog box, select *Options* from the Tools group. Expand the *General* node, and select *Column Management*.

Column Management user preferences enable you to choose which columns to display on the grids for transformations, column selection, joins, and sorts. You can also set the column display order. The settings apply to all column-related dialog boxes.

The Column Management pane has the following fields and options:

**Customize column display**

Lists the column-related dialog boxes that can be customized. Expanding a folder will display check boxes that can be used to add columns to each dialog box.

**Reset to default**

Restores the default values.

**Column name display strategy**

Controls the information that appears in trees and grids. The available options are Name, Title, Description, and Alias. If no Title, Description, or Alias exists, the display will default to the Name.

**Note:** It is recommended that you use Title when working with Business Views.
**Function display strategy**
Controls how functions are identified on the functions tab in the calculators. By default, the function syntax is displayed. It can be changed to a short description, which displays a brief description of what the function does instead.

**Use segment to qualify field reference**
Indicates whether to qualify field names with the segment name in which they reside for duplicate field names only or always.

Expand any of the available Customize column display options to see default settings. Not all columns are on every grid. The following columns can be added:

**Alias**
Assigns an alternative name for a column or the real column name for a DBMS synonym.

**Application**
Indicates the application where the synonym resides.

**Belongs To Segment**
Shows the parent segment in the base synonym.

**Connection**
Indicates the adapter connection name used.

**Data Origin**
Indicates the date the synonym was created.

**Date Modified**
Indicates when the synonym was last modified.

**Description**
Is a description or comments about the column.

**Expression**
Is the expression for the column.

**Extension**
Indicates the suffix (data source type) of the synonym.

**Field Type**
Indicates that a column is an index (I) or is read-only.
Format
Is the type and length of a column data as stored.

Function
Indicates the name of the function.

Geographic Role
Describes the geographic role of the column.

Has Foreign Keys
Indicates that the synonym includes foreign keys.

Index
Indicates an index column.

Join Condition
Indicates the condition for the join.

Join Parent
Indicates the parent of the join.

Join Status
Out of the candidate list, indicates the strongest candidate or candidates for insertion.

Join Strategy
Indicates the strategy for the join.

Join To
Indicates whether you can join to the column.

Keys
Indicates the keys in the synonym.

Length
Is the column length.

Name
Indicates the column name.

Nulls
Indicates whether or not the column can contain null data.
**Number of Segments**
Indicates the number of segments in the synonym.

**Order**
Indicates the order of the column in the segment.

**Parent(s)**
Indicates the parent or parents on the active Metadata canvas.

**Prefix**
Indicates a prefix for the column.

**Primary Key Tables**
Indicates the primary key for the synonym.

**Property**
Indicates whether the column is an attribute or a measure.

**Real Table Name**
Indicates the actual name of the table or the physical file name.

**Reference**
Indicate a reference for the column to an index column.

**Scale**
Is the maximum number of digits to the right of the decimal.

**SCD Type**
Used for processing slowly changing dimensions.

**Segment**
Indicates the segment name.

**Sequence Number in Key**
Indicates the sequence number of the field within the key.

**Size**
Indicates the size of the synonym.

**Source**
Indicates the source of the synonym.
SQL Conversion Notes

Indicates how SQL is converted.

Table

Is the synonym that contains the column.

Title

Supplies a title to replace the column name normally used in reports.

Type

Is the type of object in an application directory.

Reference: Synonym Editor Run Options Settings

Run Options user preferences include determining the number of rows and columns to retrieve, as well as the default format when sampling data.

The Run Options settings pane has the following fields and options:

Maximum number of rows for test reports

Sets the number of rows retrieved to produce sample data when testing transformations or SQL. The default is 50.

Maximum number of columns for test reports

Sets the number of columns retrieved to produce sample data when testing transformations or SQL. The default is to retrieve all columns (with a highest value setting of 999999).

Test reports default format

Sets the format of reports for retrieving sample data when testing transformations or SQL. The default is Default. The following report formats are available:

- **Default.** Formats numeric and date columns based on edit options in the synonym.
- **HTML.** Produces the report in HTML format.
- **HTML - plain text.** Produces the report in plain text format.
- **active report.** Produces an HTML Analytic Document designed for offline analysis.
- **Excel.** Produces the report in Excel format.
- **PDF.** Produces the report in PDF format.
Stop after DBMS error

Sets the number of DBMS-related errors allowed before the server stops running the procedure.

Changing Views in the Metadata Canvas

The Metadata canvas displays Field View, Segment View, Modeling View, Text View, and Access File Text View tabs. You can switch to different views in the Metadata canvas to edit different aspects of your data source more efficiently.

Displaying Fields in a Synonym Using the Field View Tab

The Field View tab is accessible when you are creating or editing a synonym. From this tab, you can see a table with all available fields. As shown in the following image, the Field View tab shows a hierarchy of segments and columns on the left, with the attributes and values of the selected item in the Properties window, which displays, by default, on the right side of the canvas. This is the default view tab when you are creating or editing a synonym. The Properties panel can be resized, positioned in different areas, or hidden.

Note: The attributes available depend on the type of synonym.

The following image is an example of a multi-fact structure with a key column selected.
Displaying Segments in a Synonym Using the Segment View Tab

The Segment View tab is accessible when you are creating or editing a synonym. As shown in the following image, the Segment View tab shows a hierarchy of segments that the synonym contains on the left, with the attributes and values of the selected item in the Properties window, which displays, by default, on the right side of the canvas. The Properties panel can be resized, positioned in different areas, or hidden.

Note: Information about the attribute that has focus is displayed at the bottom of the attribute list. In this case, an explanation of the SEGMENT attribute appears.

Reference: Segment Shortcut Menu

When you right-click a segment in the Metadata canvas, the following options are available:

Properties

Opens a pane showing the properties of the selected segment.
**Insert**

Enables you to insert one of the following:

**Reference to Existing Synonym as Child**

The reference is a pointer to the source synonym using the synonym as a child. If you subsequently make changes to the source synonym, reopening the current synonym will reflect those changes.

**Reference to Existing Synonym as Root**

The reference is a pointer to the source synonym using the synonym as a root. If you subsequently make changes to the source synonym, reopening the current synonym will reflect those changes.

**Copy of Existing Synonym**

Adds a static copy of an existing synonym to the current synonym. If you subsequently make changes to the source synonym, the current synonym will not reflect those changes.

**Segment via Metadata Import**

Enables you to create and add a new synonym to the current synonym using the Create Synonym dialog box.

**Segment Manually**

Adds a synonym that must be coded manually.

**Field**

Adds a general column to the segment.

**Define**

Adds a virtual or defined column to the segment.

**Filter**

Adds a filter to the segment.

**Compute**

Adds a calculated value to the file.

**Sort Object**

Adds a Sort Objects folder and a sort object. This option is available only if Support extended options is selected.
Variable

Adds a Variables folder and a variable to the segment.

Style

Adds a Styles folder and a style object. This option is available only if Support extended options is selected.

Subquery

Adds a subquery to the fields list.

Add/Remove Parent Links

If applicable, enables you to add or remove segments in the current cluster synonym.

Data Profiling

Provides the characteristics of the data for a segment. The following options are available:

Statistics

Shows statistic values for the selected segment only.

Count

Shows a count of the number of rows in the selected source table. For a multi-segment synonym, it shows the count for each segment.

Statistics with parent segment

This option is available only when viewing a lower segment of a hierarchy (cluster join).

Key Analysis

Allows you to select the columns that you would like to analyze as potential keys to the source table.

Values

Shows unique values and their percentages.

Duplicate Values

Shows identical values and their percentages.

Sample Data

Displays sample data in the workspace for the selected segment or synonym.

Sample Data with parent key

Displays sample data for the selected segment joined to the parent segment. This option is only available when a child segment is selected in a multi segment synonym.
Delete

Deletes the segment.

Rename

Allows you to rename the segment.

Edit All Properties

Allows you to edit adapter specific properties, such as the delimiter value in a delimited flat file.

Open Base Synonym

Opens the base synonym for the current synonym.

Edit Parent Links

Indicates the parent segment or segments of the selected child that you can edit.

Reference: Column/Field Shortcut Menu

When you right-click a column in the Metadata canvas, the following options are available.

Note: If you multi-select columns and right-click them, an abridged version of the shortcut menu opens.

Properties

Opens a pane showing the properties of the selected column.

Insert

Enables you to insert one of the following:

Field

Adds a general column to the synonym.

Define

Adds a virtual or defined column to the synonym.

Filter

Adds a filter to the segment.

Filter (New)

Adds a filter to the segment using the Advanced Filter dialog box.

Compute

Adds a calculated value to the file.
**Group**

Indicates the name used to reference the element of data (group of columns) in a request.

**Sort Object**

Adds a Sort Objects folder and a sort object. This option is available only if Support extended options is selected and is not used with DataMigrator.

**Variable**

Adds a Variables Folder if needed.

**Style**

Adds a Styles folder and a style object. This option is available only if Support extended options is selected and is not used with DataMigrator.

**Subquery**

Adds a subquery to the fields list.
Impact Analysis
Displays an Impact Analysis report for the particular column in the workspace. An Impact Analysis report identifies the procedures that access a Master File or field within a Master File.

Data Profiling
Provides the characteristics of the data for a column.

Statistics
Shows statistic values for the selected segment only.

Patterns
Shows a patterns report for the selected column.

Hex View
Shows the Hexadecimal value of the selected field.

Values
Shows a values report for the selected column.

Values Graph
Displays a graph for both alpha and numeric field types.

Values Pie Graph
Displays a pie graph.

Duplicate Values
Shows identical values and their percentages.

Outliers
Shows outlier report for the selected column.

Sample Data
Displays sample data in the workspace.

Delete
Deletes the column.

Rename
Allows you to rename the column.
Displaying Fields and Properties in a Synonym Using the List View Tab

The List View tab is accessible when you are creating or editing a synonym. As shown in the following image, the List View tab shows the fields and properties displayed next to their name, with the attributes and values of the selected item in the Properties panel, which displays, by default, on the right side of the canvas. The Properties panel can be resized, positioned in different areas, or hidden. The List View tab is accessible when you are creating or editing a synonym.

![List View Tab Example](image)

**Note:** Information about the attribute that has focus is displayed at the bottom of the attribute list. In this case, an explanation of the FIELDNAME attribute appears.
Showing a Graphical Representation of a Synonym Using the Modeling View Tab

The Modeling View tab is accessible when you are creating or editing a synonym. As shown in the following image, the Modeling View tab shows a graphical representation of the synonym. You can use the Modeling View tab to view join properties, create cluster joins, and add or edit segments. The following image shows the Sales Dimension of a multi-fact data source.

Reference: Modeling View Shortcut Menu

When you right-click a synonym or segment in the Metadata canvas Modeling View tab, the following options are available:

Collapse/Expand

Changes the view from a file icon to a table view, which enables you to see columns, sample data, and sample data parent keys.

Tip: You may also double-click a file icon to open the table view. Double-click the table to close the table view, or click the X button from the toggle toolbar to close.

Properties

Opens a pane showing the properties of the selected segment.

Insert

- Reference to Existing Synonym as Child. Enables you to reference an existing synonym using the synonym as a child.
- **Reference to Existing Synonym as Root.** Enables you to reference an existing synonym using the synonym as a root.

- **Segment via Metadata Import.** Enables you to create a new synonym through the Create Synonym tool and add it to the current synonym.

- **Segment Manually.** Inserts a segment to the current synonym, that must by coded manually.

### Data Profiling

Provides the characteristics of the data for a segment.

### Sample Data

Displays sample data in the workspace.

### Sample Data with parent key

Displays sample data with parent key in the workspace.

### Delete

Deletes the segment.

### Rename

Enables you to rename the segment.

### Displaying the Contents of a Master File Using the Text View Tab

The Text View tab is accessible when you are creating or editing a synonym. The Text View tab shows the Master File of the underlying table in a text editor. You can print the Master File syntax by selecting *Print* from the Application Menu.
The following image is an example of a multi-fact structure in the Text View tab.

```
$Copyright (c) Information Builders, Inc. All rights reserved. @MFSM_NOPROLOG@$
FILENAME=WF_RETAIL, TRANS_FILE=_EDAHOME/INIS/dt,
REMARKS="Cluster Join of Fact Tables Sales, Shipments and Labor for Demo Database", $
SEGMENT=WF_RETAIL_SALES, CRFILE=wfrelai81/FACTS/WF_RETAIL_SALES, CRINCLUDE=ALL, $
DESCRIPTION=Sales Fact, $
FIELDNAME=ID_SALES, $
  WITHIN="Hierarchy1", $
FIELDNAME=COGS_LOCAL, $
PROPERTY=MEASURE, MEASURE_GROUP=MEASGRP1, $
FIELDNAME=COGS_US, $
PROPERTY=MEASURE, MEASURE_GROUP=MEASGRP1, $
FIELDNAME=DISCOUNT_LOCAL, $
PROPERTY=MEASURE, MEASURE_GROUP=MEASGRP1, $
FIELDNAME=DISCOUNT_US, $
PROPERTY=MEASURE, MEASURE_GROUP=MEASGRP1, $
FIELDNAME=GROSS_PROFIT_LOCAL, $
PROPERTY=MEASURE, MEASURE_GROUP=MEASGRP1, $
FIELDNAME=GROSS_PROFIT_US, $
PROPERTY=MEASURE, MEASURE_GROUP=MEASGRP1, $
FIELDNAME=MSRP_LOCAL, $
PROPERTY=MEASURE, MEASURE_GROUP=MEASGRP1, $
FIELDNAME=MSRP_US, $
PROPERTY=MEASURE, MEASURE_GROUP=MEASGRP1, $
FIELDNAME=QUANTITY_SOLD, $
PROPERTY=MEASURE, MEASURE_GROUP=MEASGRP1, $
FIELDNAME=REVENUE_LOCAL, $
PROPERTY=MEASURE, MEASURE_GROUP=MEASGRP1, $
FIELDNAME=REVENUE_US, $
PROPERTY=MEASURE, MEASURE_GROUP=MEASGRP1, $
DEFINE SALE UNITY/RDC WITH WF_RETAIL_SALES.ID_SALES=1; $
TITLE=Sale Unit(RDC) DESCRIPTION=Unity Value (1) for each Sales Fact, MEASURE_GROUP=MEASGRP1, $
PROPERTY=MEASURE, $
SEGMENT=WF_RETAIL_SHIPMENTS, PARENT=., CRFILE=wfrelai81/FACTS/WF_RETAIL_SHIPMENTS, CRINCLUDE=ALL, $
DESCRIPTION=Shipments Fact, $
FIELDNAME=ID_SHIPFACT, $
PROPERTY=MEASURE, MEASURE_GROUP=MEASGRP2, $
WITHIN="Hierarchy1", $
FIELDNAME=DAYSMATCHED, $
PROPERTY=MEASURE, MEASURE_GROUP=MEASGRP2, $
```

Displaying the Contents of an Access File Using the Access File Text View Tab

The Access File Text View tab is accessible when you are creating or editing a synonym. The Access File Text View tab shows the Access File for a synonym, which is used to access the data source. You can print the Access File syntax by selecting Print from the Application Menu.
The following image shows an example of an SQL data source in the Access File Text View tab.

```sql
1 SETNAME=WFRetailSales,
2 TABLENAME=wrd_wfretail_sales,
3 CONNECTION=msql2008,
4 KEY=ID_SALES, $
5 FOREIGN_KEY=fact_sales_id_currency_fk,
6 PRIMARY_KEY_TABLE=wrd_wfretail_currency,
7 FOREIGN_KEY_COLUMN=ID_CURRENCY,
8 PRIMARY_KEY_COLUMN=ID_CURRENCY, $
9 FOREIGN_KEY=fact_sales_id_customer_fk,
10 PRIMARY_KEY_TABLE=wrd_wfretail_customer,
11 FOREIGN_KEY_COLUMN=ID_CUSTOMER,
12 PRIMARY_KEY_COLUMN=ID_CUSTOMER, $
13 FOREIGN_KEY=fact_sales_id_discount_fk,
14 PRIMARY_KEY_TABLE=wrd_wfretail_discount,
15 FOREIGN_KEY_COLUMN=ID_DISCOUNT,
16 PRIMARY_KEY_COLUMN=ID_DISCOUNT, $
17 FOREIGN_KEY=fact_sales_id_product_fk,
18 PRIMARY_KEY_TABLE=wrd_wfretail_product,
19 FOREIGN_KEY_COLUMN=ID_PRODUCT,
20 PRIMARY_KEY_COLUMN=ID_PRODUCT, $
21 FOREIGN_KEY=fact_sales_id_store_fk,
22 PRIMARY_KEY_TABLE=wrd_wfretail_store,
23 FOREIGN_KEY_COLUMN=ID_STORE,
24 PRIMARY_KEY_COLUMN=ID_STORE, $
25 FOREIGN_KEY=fact_sales_id_time_fk,
26 PRIMARY_KEY_TABLE=wrd_wfretail_time,
27 FOREIGN_KEY_COLUMN=ID_TIME,
28 PRIMARY_KEY_COLUMN=ID_TIME, $
```

**Note:** The text views are read-only. You cannot edit the underlying description from these tabs. However, you can right-click a synonym from the navigation pane and click *Edit in Windows Associated Tool* (for relational synonyms).

### Viewing and Editing Synonym Attributes

The Metadata canvas enables you to view and edit the field attributes in a synonym. For example, a geographical field may have a role attribute that you want to change. You can do this using the Metadata canvas. Then, all subsequent reports derived from the synonym will include the edited geographical role.

### Procedure: How to View and Edit Synonym Attributes

To view and edit synonym attributes:

1. Double-click a synonym, or right-click it and select *Open*.

   The Metadata canvas opens to the Field View tab, which shows a hierarchy of segments and columns on the left, with the attributes and values of the selected item on the right.

   The attributes available depend on the type of synonym.

   The values for Display Name (Title), Format, Expression, Description, and Nulls are viewable in the hierarchy with the columns. To edit these values, use the corresponding attribute fields in the Properties panel on the right-hand side of the Metadata canvas.
2. You can change the attribute values by typing in new values or by using the drop-down menus and check boxes. The Properties panel does not let you make any changes that would render the synonym unusable. Therefore, you cannot edit any value field that is highlighted gray. In addition, if a change does not have proper syntax or format applied, the field may appear in red text. Messages and warnings appear if you try to save a file that contains an error.

3. Save changes by clicking Save from the Quick Access Toolbar.

   **Note:** You can multi-select fields to change attributes for multiple fields in a single operation. The display changes to show only those attributes that can be changed.

4. Close the Metadata canvas.

   **Note:** If you close the Metadata canvas without saving your changes, you are prompted to do so.

**Reference:** File Attributes Summary

Synonyms can have the following file attributes:

**General**

**SUFFIX**

Identifies the type of synonym or data source.

**MFD_PROFILE**

Identifies the name of the FOCEEXEC that will be executed before running a request based on the Master File.

**FDEFCENT**

Defines the default century value, specifying a century number for handling cross-century dates.

   **Note:** Use the default setting (0) unless you wish to retrieve data from an earlier century (for example, 19xx).

**FYRTHRESH**

Defines the base years, to represent the lowest year to which the century value applies (FDEFCENT).

   **Note:** Use the default setting (0) unless you wish to retrieve data from an earlier century (for example, 19xx).
REMARKS

Enables you to include descriptive information at the file level and specify multiple language descriptions for the synonym. Remarks are displayed along with the file name during reporting.

DATASET

Identifies the location of the data source to be used in the file name, including the extension and the location of the data file.

**Note:** The attributes available depend on the type of synonym.

**Codepage**

**CODEPAGE**

Defines the language to use for the synonym.

**Note:** Information about the attribute that has focus is displayed at the bottom of the attribute list. In this case, an explanation of the REMARKS attribute appears.

**Reference:** Segment Attributes Summary

If a synonym segment is selected, the attributes listed below are available.

**Note:** Information about the attribute that has focus is displayed at the bottom of the attribute list.

**General**

**SEGMENT**

Is the name of the segment.

**ENCRYPT**

Check this box to scramble field values in the current segment in order to protect it from unauthorized examination.

**SEGTYP**

Specifies the type of relationship that a segment has to its parent, and indicates which of the segment fields are key fields and in what order they are sorted.

**Type.** Identify the segment type and sorting options from the Type drop-down list.

**Keys.** Records are sorted in a data source by key fields. Enter the names of key fields that you want to use for sorting. For example, no two employees can have the same employee ID number, so you can use that field as the key. A segment instance can have more than one field that makes up the key. That is, two or more field values may be used to distinguish records.
Miscellaneous

SEGSUF

SEGSUF is used when part of the data source being described by the synonym is of a different data source type than that declared for the entire structure.

DESCRIPTION

Contains a description or comments about the segment.

SEG_TITLE_PREFIX

An optional attribute that enables you to provide the title prefix for the segment fields that appear in reports. You can split the text across up to five separate title lines by separating the lines with a comma.

CRFILENAME

Is the name of the cross-referenced data source.

CRSEGNNAME

Is the name of the cross-referenced segment.

CRKEY

Identifies the common join field for the cross-referenced segment.

Note: These cross-referenced values (CRFilename, CRSegname, CRKey) are available for WebFOCUS data sources.

OCCURS

Describes repeating fields or groups of fields in a data source. OCCURS can be based on an integer value showing the number of occurrences (from 1 to 4095), a field name, which names a field in the parent segment or a virtual field in an ancestor segment whose integer value contains the number of occurrences of the descendant segment, or a variable, which indicates that the number of occurrences varies from record to record.

POSITION

Specifies the name of the field in the parent segment that specifies the starting position and overall length of the multiply occurring fields.
Adapter Specific

Adapter Specific fields are shown if an Access File component has been generated with the synonym.

CARDINALITY

Defines how many members of a dimension can be retrieved for a report.

TABLENAME

Identifies the table or view. It may contain the owner ID, as well as the table name. For some synonyms, it must also contain the data source name. This value may be a variable.

CONNECTION

Indicates the host server or data source for synonyms. This value may be a variable.

KEY

Identifies the names of the columns that constitute the primary key.

KEYORDER

Identifies the logical sort sequence of data by the primary key.

WRITE

Specifies whether write operations are allowed against the table.

FOREIGN_KEY

Specifies the type of table persistence and related table properties. This is optional for database management systems that support volatile tables, and required otherwise.

DBSPACE

Identifies the storage area in which the table resides.

PERSISTENCE

Specifies the type of table persistence and related table properties. This is optional for database management systems that support volatile tables, and required otherwise.

Note: The attributes available depend on the type of synonym.
**Reference:** Column/Field Attribute Summary

If a column or field in a synonym is selected, the attributes listed below are available. The available attributes depend on the type of synonym. Information about the attribute that has focus is displayed at the bottom of the attribute list.

**General**

**FIELDNAME**

Is the name of the column.

**ALIAS**

Assigns an alternative name for a column, or the real column name for a DBMS synonym.

For file data sources, a special reserved ALIAS of INSTANCE means the associated FIELD will show the name of the file when it is read.

When a FIELDNAME of RECTYPE is used the ALIAS contains the value that identifies the record type.

**KEY COMPONENT**

Indicates whether the field is part of the primary key for the table.

**KEY SEQUENCE NUMBER**

Indicates the sequence number of the field in the primary key for the table.

**MISSING**

Controls how null data is handled, that is, if no transaction value is supplied.

**TITLE**

Supplies a title to replace the column name that is normally used in reports and enables you to specify multiple language titles for the column or field.

**ACTUAL**

Describes the type and length of data as it is actually stored in the data source.

**USAGE**

Describes the data type and format for the column for usage or display.
Note: Additional attributes, DEFCENT and YRTHRESH, are available if the Usage field is set to Date, Time, or DateTime (Timestamp) format. Use these attributes to enter the century and year threshold values for the column or field.

Miscellaneous

DESCRIPTION

Contains a description or comments about the column or field.

ACCEPT

Specifies criteria for validating data.

- **OR** enables you to specify an acceptable value.
- **SYNONYM** enables you to specify a synonym as the source of the accept list.
- **FOCEXEC** enables you to specify a FOCEXEC as the source of the accept list.
- **FROM-TO** enables you to specify a range of acceptable value fields.
- **FIND** enables you to supply file and field names to instruct where to search for a data source and for a list of acceptable values. You supply the field name of the data field for which the validation criteria are being assigned, the file name of the target WebFOCUS data source where the field can be found, and the field name of the target data field that contains the validation criteria.

FIND is only available for WebFOCUS data sources and does not apply to OLAP-enabled synonyms. Also note that, in the Maintain environment, FIND is not supported when developing a synonym.

WITHIN

Contains the name of a field to be included in a dimension.

PROPERTY

Describes which hierarchy property the column represents.

REFERENCE

Points to the field that is the unique identifier for the hierarchy.

FIELDTYPE

- **I - Index** identifies an indexed column in a WebFOCUS data source.
- **R - Readonly** indicates a read-only column. This setting is useful for columns that are automatically assigned a value by the RDBMS.
ACCESS_PROPERTY

Specifies access options for the column data.

- INTERNAL defines a column that does not appear in sample data or in the list of available columns. Restricts the field from showing in any of the field Lists in the reporting tools.

- NEED_VALUE defines a column that requires a value to access the data.

- Select By defines a column by value, range, or multi-values.

- AUTHRESP defines a column that describes the result of an authentication operation. Correct response values must be provided in the ACCEPT attribute (using the OR predicate if more than one value is acceptable).

- AUTHTOKEN defines a column that contains a response token to be passed as an input value to the operation to be executed.

HELPMESSAGE

Appends a help message to a column.

This attribute is not used by WebFOCUS.

GEOGRAPHIC_ROLE

Describes the geographic role of the column.

TEMPORAL_PROPERTY

Inserts virtual fields in the Master File to show how selected totals progressed through a time period for specified intervals.

USE_STYLE

Are the styles (for example, font and color) to apply to the field.

The attributes available depend on the type of synonym.

Adapter Specific

AUTOINCREMENT

Indicates that the field is automatically incremented by the relational database when rows are inserted. This option is only available for selected relational databases. When selected, the field must also be identified with a field type of read-only.

The following attributes are only used if AUTOINCREMENT is checked.

- START. Indicates the starting value for this AUTOINCREMENT field. If not specified, 1 is used.
_INCREMENT. Indicates the increment value for this field. If not specified, 1 is used.

SEQUENCE. Is the name of the corresponding database SEQUENCE object for this field. This option is only available for ORACLE tables.

Setting Up Multilingual Titles and Descriptions

You can open a synonym in the Metadata canvas and provide text for the title, caption, and description in multiple languages. These descriptions appear in the specified language in reports generated against the synonym.

The Multilingual Titles dialog box is available from the Remarks, Title, and Description attribute value fields in the Metadata canvas.

Note: The attributes available depend on the type of synonym.

Procedure: How to Set Up Multilingual Titles and Descriptions

1. From the Data Servers area, double-click the Master File.
   The Master File opens to the Field View tab in the Metadata canvas.

2. To add multilingual text:
   a. For Remarks, click the root level of the Master File (application/filename) on the left.
   b. For Title, click a column from the Master File hierarchy of columns on the left.
   c. For Descriptions, click a column, segment, or custom field from the Master File hierarchy of fields on the left.

   The corresponding attributes and values appear on the right.

3. Click the browse (...) button at the end of the value field for Remarks, Title, or Description.
   The Multilingual dialog box opens.

4. From the Specify for different languages drop-down list, choose the language in which you want the titles or remarks (descriptions) to be displayed.

5. Click Add.
   The selected language is added below the default language (which is determined by your code page selection).

6. Type a description or title in the Text field.
7. You may add, edit, or delete additional titles or descriptions.

   **To add an additional language:**
   a. Select another language from the drop-down list.
   b. Click Add.
   c. Type a title or description for the field.

   **To edit an existing specified title or description:**
   a. Select the title or description and click Edit.
      You may also double-click the title.
   b. Manually type a title or description name.

   **To delete a specified title:**
   a. Select the title or description and language to be deleted.
   b. Click Delete.

8. Click OK to close the Multilingual Remarks dialog box.

9. Click Save from the File menu to save the synonym.

### Viewing Data Profiling Characteristics

Data Profiling provides data characteristics for the columns in a synonym. You can display the characteristics for all the columns in a synonym or segment, or for an individual column.

For alphanumeric columns, Data Profiling provides the segment, format, count of distinct values, total count, patterns count, maximum, minimum, and average length, minimum and maximum values, and number of nulls. Patterns count shows the number of patterns found in each alphanumeric column.

For numeric columns, Data Profiling provides the segment, format, count of distinct values, total count, maximum, minimum, and average values, and number of nulls.

Data Profiling for an individual column provides access to Statistics, Patterns, Values, and Outliers reports.

**Procedure:** **How to View Data Profiling for a Synonym or Segment**

To view the Data Profiling information for a synonym or segment:

1. From the Data Servers area, open a synonym by double-clicking a Master File.
   By default, the Metadata canvas opens to the last view used.
2. Right-click the synonym or segment name, select *Data Profiling*, and then *Statistics*.
   The Data Profiling information displays in the workspace.
   You may use the Data Profiling Results toolbar to view server messages, print the report,
   copy data as text, and export the report.

3. Optionally, you can click a column name or patterns count (for alphanumeric columns) to
   drill down to the Values or Patterns reports, respectively.
   This is a partial Values report produced by clicking a column name.
   For pattern analysis, a 9 represents a digit, an A represents any uppercase letter, and an
   a represents any lowercase letter. All printable special characters are represented by
   themselves and unprintable characters are represented by an X.

### Viewing Data Profiling Columns

Data Profiling can be done for all the columns in a synonym or segment (press the Shift or Ctrl
key while selecting multiple columns), or for an individual column. Data Profiling for an
individual column provides access to the following reports:

- **Statistics.** Shows the same information as a Data Profile report for a synonym or segment.
  For alphanumeric columns, the Statistics report provides the segment, format, count of
distinct values, total count, patterns count, maximum, minimum, and average length,
minimum and maximum values, and number of nulls.
  For numeric columns, the Statistics report provides the segment, format, count of distinct
values, total count, maximum, minimum, and average values, and number of nulls.

- **Hex View.** Shows values in Hexadecimal format.

- **Patterns.** Only available for alphanumeric columns, shows patterns of letters, digits, and
  special characters, as well as counts and their percentages.

- **Values.** Shows unique values and their percentages.

- **Values Graph.** Displays a graph for alphanumeric field types.

- **Values Pie Graph.** Displays a pie graph for alphanumeric field types.

- **Duplicate Values.** Shows identical values and their percentages.

- **Outliers.** Shows the ten highest and lowest distinct values and their counts.

These reports are available by right-clicking a column in the Metadata canvas and selecting
*Data Profiling*. 
Procedure: How to View Data Profile Statistics

To view the Statistical Data Profiling information for a single column:

1. From the Data Servers area, open a synonym by double-clicking a Master File. By default, the Metadata canvas opens to the last view used.

2. Right-click a column, select **Data Profiling**, and then select **Statistics**.
   The Statistical Data Profiling information opens in the workspace, as shown in the following image.

3. Optionally, you can click a column name or patterns count (for alphanumeric columns) to drill down to the Values or Patterns reports, respectively.

Procedure: How to View Data Profile Hex View

Data Profile Hex View shows values in Hexadecimal format.

To view the Hex View Data Profiling information for a single column:

1. From the Data Servers area, open a synonym by double-clicking a Master File. By default, the Metadata canvas opens to the last view used.

2. Right-click a column, select **Data Profiling**, and then select **Hex View**.
Procedure: How to View Data Profile Patterns

Data Profile Patterns shows patterns of letters, digits, and special characters, as well as counts. This is only available for alphanumeric columns.

To view the Patterns Data Profiling information for a single column:

1. From the Data Servers area, open a synonym by double-clicking a Master File.

   By default, the Metadata canvas opens to the last view used.

2. Right-click a column, select Data Profiling, and then select Patterns.
The Patterns Data Profiling information displays, as shown in the following image.

<table>
<thead>
<tr>
<th>Pattern</th>
<th>Count</th>
<th>Percent</th>
</tr>
</thead>
<tbody>
<tr>
<td>Aaaaa</td>
<td>7</td>
<td>23.33</td>
</tr>
<tr>
<td>Aaaaaaa</td>
<td>4</td>
<td>13.33</td>
</tr>
<tr>
<td>Aaaaaaaa</td>
<td>4</td>
<td>13.33</td>
</tr>
<tr>
<td>AAA</td>
<td>2</td>
<td>6.67</td>
</tr>
<tr>
<td>Aaaa</td>
<td>2</td>
<td>6.67</td>
</tr>
<tr>
<td>AA</td>
<td>1</td>
<td>3.33</td>
</tr>
<tr>
<td>AAA</td>
<td>1</td>
<td>3.33</td>
</tr>
<tr>
<td>Aaaa Aaaa</td>
<td>1</td>
<td>3.33</td>
</tr>
<tr>
<td>Aaaa Aaaa Aaaa</td>
<td>1</td>
<td>3.33</td>
</tr>
</tbody>
</table>

For pattern analysis, a 9 represents a digit, an A represents any uppercase letter, and an a represents any lowercase letter. All printable special characters are represented by themselves and unprintable characters are represented by an X.

Procedure: How to View Data Profile Values

Data Profile Values shows unique values.

To view the Values Data Profiling information for a single column:

1. From the Data Servers area, open a synonym by double-clicking a Master File.
   - By default, the Metadata canvas opens to the last view used.
2. Right-click a column, select Data Profiling, and then select Values.
The Values Data Profiling information displays, as shown in the following image.

![Values Data Profiling](image.png)

**Procedure:** How to View the Data Profile Values Graph

The Data Profile Values Graph displays values as a bar graph.

To view the Values Graph Data Profiling information for a single column:

1. From the Data Servers area, open a synonym by double-clicking a Master File.
   By default, the Metadata canvas opens to the last view used.
2. Right-click a column, select *Data Profiling*, and then select *Values Graph*.
The Values Graph Data Profiling information displays, as shown in the following image.

Procedure: How to View the Data Profile Values Pie Graph

The Data Profile Values Pie Graph displays values as a pie graph.

To view the Values Pie Graph Data Profiling information for a single column:

1. From the Data Servers area, open a synonym by double-clicking a Master File.
   
   By default, the Metadata canvas opens to the last view used.

2. Right-click a column, select Data Profiling, and then select Values Pie Graph.
The Values Pie Graph Data Profiling information displays, as shown in the following image.

![Values Pie Graph](image1.png)

**Procedure:** How to View Data Profile Duplicate Values

Data Profile Duplicate Values shows identical values.

To view the Duplicate Values Data Profiling information for a single column:

1. From the Data Servers area, open a synonym by double-clicking a Master File.
   
   By default, the Metadata canvas opens to the last view used.

2. Right-click a column, select **Data Profiling**, and then select **Duplicate Values**.
   
   The Duplicate Values Data Profiling information displays, as shown in the following image.

![Duplicate Values Table](image2.png)
**Procedure:** How to View Data Profile Outliers

Data Profile Outliers shows the ten highest and ten lowest distinct values.

To view the Outliers Data Profiling information for a single column:

1. From the Data Servers area, open a synonym by double-clicking a Master File.
   By default, the Metadata canvas opens to the last view used.
2. Right-click a column, select *Data Profiling*, and then select *Outliers*.
   The Outliers Data Profiling information displays, as shown in the following image.

![Outliers Data Profiling Table](image)

**Note:** Outliers produce a maximum of the ten highest and ten lowest distinct values, if they exist.

**Enhancing a Master File with Expressions**

Using an expression, you can create virtual columns and store calculations and selection criteria in a synonym. For example, using the Revenue measure, you can create a calculation for Revenue per Square Foot. This is saved in the synonym as an object and is available for use in all subsequent reports derived from the synonym.

**Adding Virtual Columns (DEFINE) in a Synonym**

You may create a DEFINE field as a custom field in a synonym. A custom field can be used in a request as though it is a real data source field. Virtual columns (DEFINE fields) are available when the data source is used for reporting.

A virtual column can contain an expression, a constant, or a column name.
Procedure: How to Create a Virtual Column in a Synonym

To create a virtual column in a synonym:

1. From an application directory in the navigation pane, double-click a synonym, or right-click it and click Open.

   The Metadata canvas opens.

2. Right-click a segment (or column), point to Insert, and then click Define.

   The Define Calculator opens, as shown in the following image.

   ![Define Calculator Image]

3. From the Define Calculator, type a name for the column in the Name input field, or use the default define name.

4. Type a format for the column in the Format input field, or click the browse (...) button at the right of the Format input field to launch the Properties dialog box to enter the information.

5. You may enter a descriptive title for the virtual column (DEFINE) in the Title input field.

   Tip: From the Metadata canvas, click the browse (...) button at the right of the TITLE and DESCRIPTION value fields to specify multiple language titles.

6. Specify the Missing Data option for columns that allow null data. You can allow all missing data.
7. Use the Expression tab and the calculator buttons to build the expression for the virtual column (DEFINE).

or

Use the Relational Expression tab to build the expression.

a. From the Relational Expression tab, use the drop-down lists to select the filter Column, Relation, and Type.

   **Note:** Parameters are not supported.

b. Click the browse (...) button at the right of the Value input field.

   The Value Selection dialog box opens.

c. Select from the available values and use the arrows to add or remove values.

d. Click OK to close the Value Selection dialog box and return to the Relational Expression tab.

   The expression is added to the value field.

e. To add another filter, double-click a column or variable from the Columns/Variables tab on the right side of the Virtual Column Calculator.

   The filter is added to the Relational Expression tab, where you can add the expression value.

f. To delete an expression, click in the row number column of the expression that you are deleting, right-click, and select Delete Selected Row(s). The expression is removed from the Relational Expression tab.

8. You may select the Check Expression and Sample Data buttons, located on the top right of the Virtual Column Calculator, to verify that the expression is valid and to view sample data for the filter.

9. Click OK to close the Define Calculator and return to the Metadata canvas.

   **Note:** To edit the Define, Title, or Expression, you may do so directly from the Metadata canvas, or you may click the browse (...) button at the right of the EXPRESSION value field to relaunch the Define Calculator.

10. If no columns from the synonym are used in the expression or have been defined, you can use the WITH option to identify the logical home of the defined calculation. You can also use the WITH option to move the logical home for the virtual column to a lower segment than it would otherwise be assigned (for example, to count instances in a lower segment).

   **Tip:** You can click and drag the DEFINE field and move it to a different segment in the Tree View tab, which also changes the segment association.

11. Click Save from the Quick Access Toolbar to save the synonym.
Adding Computed Fields (COMPUTE) in a Synonym

You may create a Computed field as a custom field in the Metadata canvas. The procedure for adding a custom field is similar to the procedure used to add a Defined field. The Computed field is identified as the Master File Computed field and is differentiated from the Defined fields and the other Computed fields.

Procedure: How to Create a Computed Field in the Metadata Canvas

To create a computed column in a synonym

1. From the Data Servers area, open a synonym by double-clicking a Master File.
   The Metadata canvas opens.
2. Right-click a segment (or column), point to Insert, and click Compute.
   The Compute Calculator opens.
3. From the Compute Calculator, type a name for the column in the Column input field or use the default compute name.
4. Type a format for the column in the Format input field, or click the browse (...) button at the right of the Format input field to launch the Properties dialog box to enter the information.
5. You may enter a descriptive title for the computed field (COMPUTE) in the Title input field.

   Tip: From the Metadata canvas, click the browse (...) button at the right of the TITLE and DESCRIPTION value fields to specify multiple language titles.
6. Specify the Missing Data options for columns that allow null data. You can allow all missing data.

7. Use the Expression tab and the calculator buttons to build the expression for the computed field (COMPUTE).

or

Use the Relational Expression tab to build the expression.

a. From the Relational Expression tab, click the Add New Row button and use the drop-down lists to select the filter Column, Relation, and Type.

Note: Parameters are not supported.

b. Click the browse (...) button at the right of the Value input field.

c. Select from the available values and use the arrows to add or remove values.

d. Click OK to close the Value Selection dialog box and return to the Relational Expression tab.

The expression is added to the value field.

e. To add another filter, double-click a column or variable from the Columns/Variables tab on the right side of the Compute Calculator.

The filter is added to the Relational Expression tab, where you can add the expression value.

f. To delete an expression, select the number or field column of the expression and click the Delete button, or right-click it and select Delete Selected Row(s). The expression is removed from the Relational Expression tab.

8. You may click the Check expression and Sample Data buttons, located on the top right of the Compute Calculator, to verify that the expression is valid and to view sample data for the filter.

9. Click OK to close the Compute Calculator and return to the Metadata canvas.

Note: To edit the Compute, Title, or Expression, you may do so directly from the Properties section of the Metadata canvas or you may click the browse (...) button at the right of the EXPRESSION value field to relaunch the Compute Calculator.

10. Click Save from the File menu to save the synonym.

For more information about expressions and COMPUTE attributes, see Defining Attributes and Creating Expressions for Custom Fields on page 187.
Creating Filters in a Synonym

Filters are created in the Master File through the Metadata canvas and can be used in a Business View file or in reporting tools. You can also use filters to perform other data checking and validation, and sort data based on the conditions that you create.

Filters are created under a specific segment and, by default, they have association with the selected segment. Filters can also be created without segment association.

Procedure: How to Create Filters in a Synonym

1. From the Data Servers area, open a synonym by double-clicking a Master File.
   The Metadata canvas opens.
2. Right-click a segment or field, point to Insert, and click Filter.
   The Filter Calculator opens, as shown in the following image.

3. From the Filter Calculator, type a name for the filter in the Name input field or use the default filter name.
   Note: It is recommended that filters have a descriptive name to help identify the filter action during reporting.
4. The Format field shows a default value of I1.

   **Note:** The Format field cannot be changed. Values for filters return 0 for false and 1 for true.

5. You may enter a descriptive title for the filter in the Title input field.

   **Tip:** From the Properties panel in the Metadata canvas, click the browse (…) button at the right of the TITLE and DESCRIPTION value fields to specify multiple language titles.

6. Use the Expression tab and the calculator buttons to build the expression for the filter.

   or

   Use the Relational Expression tab to build the expression.

   a. From the Relational Expression tab, click the *Add New Row* button and use the drop-down lists to select the filter Column, Relation, and Type.

      **Note:** Parameters are not supported with Master File Filters.

   b. Click the browse (…) button at the right of the Value input field.

      The Value Selection dialog box opens.

   c. Select from the available values and use the arrows to add or remove values.

   d. Click *OK* to close the Value Selection dialog box and return to the Relational Expression tab.

      The expression is added to the value field.

   e. To add another filter, double-click a column or variable from the Fields/Variables section on the right side of the Filter Calculator.

      The filter is added to the Relational Expression tab where you can add the expression value.

   f. To delete an expression, select the number or field column of the expression and click the *Delete* button, or right-click it and select *Delete selected row(s).*

      The expression is removed from the Relational Expression tab.

7. You may click the Check Expression and Sample Data buttons, located on the top right of the Filter Calculator to verify that the expression is valid and to view sample data for the filter.

8. Click *OK* to close the Filter Calculator and return to the Metadata canvas.

   **Note:** To edit the Filter, Title, or Expression, you may do so directly from the Properties panel in the Metadata canvas or you may click the browse (…) button at the right of the EXPRESSION value field to relaunch the Filter Calculator.
9. To create a Filter without segment association, use the WITH drop-down list in the Properties panel to select a blank segment.

Filters are created under a specific segment and by default they have association with the selected segment. Filters can also be created without segment association.

**Note:** If you are using a field that appears in multiple segments, the WITH segment associated should be the lowest level segment or it should be left empty to prevent errors.

In addition, if no fields from the synonym are used in the expression or have not been computed, you can use the WITH option to identify the logical home of the filter calculation. You can also use the WITH option to move the logical home for the filter field to a lower segment than it would otherwise be assigned (for example, to count instances in a lower segment).

10. Click Save from the File menu to save the synonym.

   The filter is saved as part of the synonym.

---

**Defining Attributes and Creating Expressions for Custom Fields**

A custom field is a field whose value is not stored in the data source but can be calculated from the data that is there. You can create a custom field in your synonym by adding a virtual column (DEFINE), a Computed Field (COMPUTE), and a Master File filter (FILTER). The fields are available whenever you access the corresponding data source in a reporting tool.

You can define attribute values and create expressions for custom fields using the Metadata canvas.

**Reference:** Custom Field Attributes

The following attributes may be available for custom fields (DEFINE, COMPUTE, and FILTER) in the Metadata canvas.

**Note:** The attributes available depend on the type of synonym and the type of custom field selected.

Custom fields (DEFINE, COMPUTE, and FILTER) typically have the following attributes:

**General**

**DEFINE**

Is the name of the virtual column.

**Note:** This attribute only appears when a virtual column (DEFINE) is selected.

**COMPUTE**

Is the name of the computed field.
Enhancing a Master File with Expressions

**Note:** This attribute only appears when a virtual computed field is selected.

**FILTER**

Is the name of the Master File Filter field.

**Note:** This attribute only appears when a virtual filter field is selected.

**EXPRESSION**

Is the expression that creates the virtual column.

**TITLE**

Supplies a title to replace the column name that is normally used in reports and enables you to specify multiple language titles for the virtual column.

**FORMAT**

Describes the data type and format for the virtual column.

**Note:** This attribute only appears for DEFINE and COMPUTE custom fields.

**MISSING**

Allows missing data. If not, the transaction value is supplied.

**Note:** This attribute only appears for DEFINE and COMPUTE custom fields.

**Miscellaneous**

**REDEFINES**

A DEFINE expression may not contain qualified field names. REDEFINES enables you to redefine or recompute a column whose name exists in more than one segment.

**Note:** This attribute only appears for DEFINE custom fields and cannot be used by WebFOCUS.

**WITH**

If no columns from the synonym are used in the expression or have been defined, you can use the WITH option to identify the logical home of the defined calculation. You can also use the WITH option to move the logical home for the virtual column to a lower segment than it would otherwise be assigned (for example, to count instances in a lower segment).

**Note:** This attribute only appears for DEFINE and FILTER custom fields.

**DESCRIPTION**

Contains a description or comments about the virtual column.
**ACCESS_PROPERTY**

Specifies access options for the column data.

INTERNAL defines a column that does not appear in sample data or in the list of available columns. Restricts the field from showing in any of the Field Lists.

NEED_VALUE defines a column that requires a value to access the data. Indicates that a selection is needed in the report request (WHERE condition).

Select By defines a column by value, range, or multivalues:

- If Value is checked, only one value should be defined for selection in the report request.
- If Range is checked, a range selection should be defined in the report request.
- If Multivalues is checked, multiple values are allowed for selection in the report request.

**GEOGRAPHIC_ROLE**

Defines the geographic role of the column.

**WITHIN**

Contains the name of a field to be included in a dimension.

These WITHIN statements are added to the synonym through the Dimension Builder to OLAP-enable WebFOCUS files and relational tables.

**Note:** This attribute only appears for DEFINE and FILTER custom fields.

**TEMPORAL_PROPERTY**

Inserts virtual fields in the Master File to show how selected totals progressed through a time period for specified intervals.

**USE_STYLE**

Are the styles (for example, font and color) to apply to the field.

**Note:** The attributes available depend on the type of synonym.

**Reference:** Calculators for Custom Fields

The Define Calculator, Compute Calculator, and Filter Calculator have the following fields and options:

**Name**

Is the name of the object being created (virtual field (DEFINE), filter, computed field).
Enhancing a Master File with Expressions

**Format**

Is the field format.

**Title**

Is the title of a new target table created by a data flow. The title will be included in the synonym that is created.

**Missing**

Indicates if missing (null) values are allowed in this field. The following options are available:

- **OFF.** The result is never missing.
- **ON.** The result is missing only if all missable fields are missing.
- **ON ALL.** The result is missing if any missable fields are missing.

**Expression tab**

Location for typing an expression. You can add data source fields from the Columns/Variables tab, functions from the Functions tab, and numbers and operators from the calculator as you type.

**Relational Expression tab**

Displays the expression building window from which you can add and delete columns, choose the relation and type, and select values for your filter.

**Fields/Variables tab**

Displays a hierarchical list of available source columns and System Variable folders that you can use in creating an expression.

**Functions tab**

A function is a program that returns a value. This tab lists the built-in functions that you can use to derive the value of a temporary field.

**Function Assist button**

Enables you to specify parameters for the function through a dialog box when creating or editing a transformation.

**Calculator buttons**

Enables you to insert numbers and operators.
The following operators are available:

| (single concatenation bar)

Concatenates two values, retaining any trailing blanks after the first one. For example, if FIRST_NAME and LAST_NAME were both in A15 format, the expression

```plaintext
FULL_NAME = FIRST_NAME | LAST_NAME
```

would produce a column like the following:

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>MICHAEL</td>
<td>SMITHSON</td>
</tr>
<tr>
<td>ANE</td>
<td>JONES</td>
</tr>
</tbody>
</table>

|| (double concatenation bar)

Concatenates two values, suppressing any trailing blanks in the first. For example, to construct the full name and insert a comma (,), the syntax

```plaintext
FULL_NAME = LAST_NAME || (' ', ' | FIRST_NAME)
```

would produce a column like the following:

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>SMITHSON, MICHAEL</td>
<td></td>
</tr>
<tr>
<td>JONES, JANE</td>
<td></td>
</tr>
</tbody>
</table>

The concatenation in the parentheses is done first (preserving the blank space after the comma), and the result is then concatenated to LAST_NAME, suppressing the trailing blanks of LAST_NAME.

IF

Establishes a conditional test.

THEN

Specifies the action to perform if the result of a conditional test is TRUE.

ELSE

Specifies the action to perform if the result of a conditional test is FALSE.

LT

Returns the value TRUE if the value on the left is less than the value on the right.
**NOT**

Returns the value TRUE if the operand is false.

**LE**

Returns the value TRUE if the value on the left is less than or equal to the value on the right.

**EQ**

Returns the value TRUE if the value on the left is equal to the value on the right.

**AND**

Returns the value TRUE if both operands are true.

**GT**

Returns the value TRUE if the value on the left is greater than the value on the right.

**GE**

Returns the value TRUE if the value on the left is greater than or equal to the value on the right.

**NE**

Returns the value TRUE if the value on the left is not equal to the value on the right.

**OR**

Returns the value TRUE if either operand is true.

****

Raises a value to the specified power.

**()**

Adds parentheses.

""

Inserts two single quotation marks. Enter alphanumeric test values between the quotation marks.

**a->A**

Converts selected text to uppercase.

**A->a**

Converts selected text to lowercase.
**Date**

Opens the Date dialog box, where you can change the format for the Date field.

**Datetime**

Opens the Date Time dialog box, where you can change the format for the Datetime field.

**Check expression button**

Verifies the validity of the expression.

**Sample data button**

Produces sample data for the expression.

### Describing Group Fields and Repeating Fields in a Synonym

For data sources that support groups, you can assign a unique name to multiple fields to create a group field. A group field is created by two or more alphanumeric fields, physically next to each other. A group field provides an efficient means for grouping similar or logically connected fields that will be accessed as a single unit, but do not warrant a separate segment.

**Procedure: How to Add a Group Field to a Segment**

1. From the Data Servers area, open a synonym by double-clicking a Master File.
   
   The Metadata canvas opens.
2. Right-click a segment (or column), select **Insert**, and click **Group**.
   
   **Note:** The group option may not be available for some data sources.

   A group is added to the synonym and its attributes and values appear on the right.
3. Type a name for the group in the **GROUP** field.
4. Select the **USAGE Type** value for the group. Specify the length, the decimal places (if applicable) and any display options for the group.
5. Select the **I - Index** check box if you want the group to be indexed.
6. Select the **ACCESS_PROPERTY** values to specify access options for the group data.
   
   - INTERNAL defines a column that will not appear in sample data or in the list of available fields.
   - NEED_VALUE defines a column that requires a value to access the data.
   - Select By defines a column by value, range, or multivalues.
7. Optionally, you can specify the TITLE and DESCRIPTION display options.
8. Click Save from the File menu to save the synonym.

Note: When you add a group, a field is automatically added to the group.

Procedure: How to Add a New Field to a Group Field
1. Right-click the group field to which you want to add a new field, select Insert, and click Field.
   A field is added to the group and its attributes and values appear on the right.
2. Supply the required information for the group field. For more information about field attributes, see Viewing and Editing Synonym Attributes on page 163.

Procedure: How to Add an Existing Field to a Group Field
1. Click the field you want to add to the group field.
2. While holding the left mouse button down, drag the field and drop it on the group field name.
   The field is added to the group field.

Procedure: How to Delete a Group Field From a Segment
1. Right-click the group and select Delete.
   A confirmation appears stating that all columns (fields) within the group will be deleted.
2. Click Yes to delete the group and move the fields (within the group) under the root segment of the synonym.
   Click No to delete the group and all of the fields within the group.
   Click Cancel to close the Confirm dialog box and return to the Metadata canvas.

Procedure: How to Delete a Field From a Group Field
Right-click the field, then select Delete.

Reference: Group Field Attributes
Group fields in a synonym can have the following attributes:

General

GROUP

Is the name of the group.
ALIAS

Assigns an alternative name for a group.

If you create a report, the group name appears as a column heading unless you have specified an alternate title for the group. Aliases cannot be used as column titles.

TITLE

Supplies a title to replace the group name that is normally used in reports and enables you to specify multiple language titles for the group.

USAGE

Contains the format for the group field. Since the group field is made by concatenating together several other fields, the Metadata canvas determines what this format needs to be. For example, if the group field has two alphanumeric fields in it, each 20 characters long (A20), then the group field must be alphanumeric and 40 characters long (A40). The group field is always alphanumeric, regardless of the fields that make it up.

Miscellaneous

DESCRIPTION

Contains a description or comments about the group. The description displays in Field lists and on the status bar.

Field descriptions also appear as bubble help in OLAP-enabled reports. If you do not include a description, bubble help shows the field name (column title).

FIELDTYPE

Identifies an indexed group. You can index the values of a field to enhance data retrieval performance. To do so, select the Index check box when you add a field and before you add the data. An index is an internally stored and maintained table of data values and locations that enhance the performance of data retrieval. A Master File can have several associated indexes, but the combined total of indices and segments cannot exceed 64.

Note: FIELDTYPE=R indicates a read-only column. This setting is useful for columns that are automatically assigned a value by the RDBMS.

Tip: You can turn on the index after adding data to a field, however, you will have to use the Rebuild Index option to create the index.

ACCESS_PROPERTY

Specifies access options for the column data.

INTERNAL defines a column that does not appear in sample data or in the list of available columns. Restricts the field from showing in any of the Field Lists.
NEED_VALUE defines a column that requires a value to access the data. Indicates that a selection is needed in the report request (WHERE condition).

Select By defines a column by value, range, or multivalues:

- If Value is checked, only one value should be defined for selection in the report request.
- If Range is checked, a range selection should be defined in the report request.
- If Multivalues is checked, multiple values are allowed for selection in the report request.

**USE_STYLE**

Are the styles (for example, font and color) to apply to the field.

*Note:* The attributes available depend on the type of synonym.

**Storing the Number of Repetitions of a Repeating Field in a Virtual Field**

The OCCURS attribute in a Master File describes repeating fields or groups of fields in a data source. The repeating group of fields is described as a descendant segment in the Master File, and the OCCURS attribute for that segment specifies how to determine the number of repetitions.

The number of repetitions does not have to be the same for every record instance. Sometimes, the number of repetitions can be derived from a field in the data source. In that case, you can create a virtual field in the Master File that indicates the number of repetitions for each record and use that virtual field as the value of the OCCURS attribute.

**Syntax:**  **How to Specify an OCCURS Segment Using a Virtual Field**

```
SEGNAME = parent, SEGTYPE = segtype,$
  .
  .
  .
  DEFINE definefield/In = expression;
  SEGNAME = osegname, SEGTYPE=S0, PARENT = parent,
  OCCURS = definefield ,$
  FIELDNAME = rfield, ALIAS = ralias,
  USAGE = rufmt, ACTUAL = rafmt,$
  .
  .
  .
  [FIELDNAME = orderfield, ALIAS = ORDER,
    USAGE = In, ACTUAL = I4,$]
```
where:

**parent**

Is the name of the parent segment.

**segtype**

Is the SEGTYPE of the parent segment.

**definefield**

Is the virtual field that indicates the number of repetitions of the repeating field or group of fields. This field must be defined in a segment that is an ancestor of the segment containing the repeating fields.

**n**

Is the format of the virtual field that describes the number of repetitions. It must be an integer format.

**expression**

Is a valid expression that derives the number of repetitions for each record instance.

**osegname**

Is the name of the descendent OCCURS segment.

**rfield**

Is the name of a repeating field in the OCCURS segment.

**ralias**

Is the alias of a repeating field in the OCCURS segment.

**rufmt**

Is the display format for a repeating field in the OCCURS segment.

**rafmt**

Is the actual format for a repeating field in the OCCURS segment.

**orderfield**

Is the name of an internal counter field that you can specify as the last field in the OCCURS segment. The ORDER field associates a sequence number with each occurrence and is useful when the order of the repeating data is significant. For example, the values may represent monthly or quarterly data, but the record itself may not explicitly specify the month or quarter to which the data applies. The USAGE format must be integer and the ACTUAL format is I4.
Note: The virtual field used as the OCCURS value cannot be redefined inside or outside of the Master File.

Example:  Using a Virtual Field With an OCCURS Segment

The following request against the EMPLOYEE data source creates a fixed-format sequential file with a repeating field. The request:

- Counts the number of FICA deductions for each employee.
- Creates a calculated field that contains the length of all FICA deduction fields for each employee.
- Creates a HOLD file in which each record contains the calculated length of the deduction fields for the employee, the identifying information for the employee, and all FICA deductions for the employee.

Note that the number of deductions will vary for each employee. The part of the record that contains the deductions will constitute the OCCURS segment. The number of repetitions will have to be derived from the length field created in the TABLE request.

The procedure to create the file with the repeating deduction field follows:

```plaintext
DEFINE FILE EMPLOYEE
    CTR/I5 WITH DED_AMT = IF EMP_ID NE LAST EMP_ID THEN 1 ELSE LAST CTR + 1;
END
TABLE FILE EMPLOYEE
    SUM CNT.DED_AMT NOPRINT EMP_ID LAST_NAME FIRST_NAME CURR_SAL
    COMPUTE DEDLEN/I5 = 12 * CNT.DED_AMT;
    BY EMP_ID NOPRINT
    SUM DED_AMT
    BY EMP_ID NOPRINT
    ACROSS CTR NOPRINT
    WHERE DED_CODE EQ 'FICA'
    ON TABLE SET HOLDLIST PRINTONLY
    ON TABLE HOLD AS OCCURS1 FORMAT ALPHA
END
```
The OCCURS1 file has one record per employee with a variable number of DED_AMT fields. The total length of the number of actual instances of DED_AMT is stored in the field named DEDLEN. The Master File generated by the HOLD command lists 10 DED_AMT fields:

FILENAME=OCCURS1, SUFFIX=FIX, $
SEGMENT=OCCURS1, SEGTYPE=S0, $
FIELDNAME=EMP_ID, ALIAS=E01, USAGE=A9, ACTUAL=A09, $
FIELDNAME=LAST_NAME, ALIAS=E02, USAGE=A15, ACTUAL=A15, $
FIELDNAME=FIRST_NAME, ALIAS=E03, USAGE=A10, ACTUAL=A10, $
FIELDNAME=CURR_SAL, ALIAS=E04, USAGE=D12.2M, ACTUAL=A12, $
FIELDNAME=DEDLEN, ALIAS=E05, USAGE=I5, ACTUAL=A05, $
FIELDNAME=DED_AMT, ALIAS=E06, USAGE=D12.2M, ACTUAL=A12, $
FIELDNAME=DED_AMT, ALIAS=E07, USAGE=D12.2M, ACTUAL=A12, $
FIELDNAME=DED_AMT, ALIAS=E08, USAGE=D12.2M, ACTUAL=A12, $
FIELDNAME=DED_AMT, ALIAS=E09, USAGE=D12.2M, ACTUAL=A12, $
FIELDNAME=DED_AMT, ALIAS=E10, USAGE=D12.2M, ACTUAL=A12, $
FIELDNAME=DED_AMT, ALIAS=E11, USAGE=D12.2M, ACTUAL=A12, $
FIELDNAME=DED_AMT, ALIAS=E12, USAGE=D12.2M, ACTUAL=A12, $
FIELDNAME=DED_AMT, ALIAS=E13, USAGE=D12.2M, ACTUAL=A12, $
FIELDNAME=DED_AMT, ALIAS=E14, USAGE=D12.2M, ACTUAL=A12, $
FIELDNAME=DED_AMT, ALIAS=E15, USAGE=D12.2M, ACTUAL=A12, $

You can edit the Master File to describe these repeating DED_AMT fields with an OCCURS segment. The DEFINE field named NUMOCC derives the number of occurrences from the DEDLEN field. The ORDER field is not actually in the file. It is an internal counter populated by App Studio.

FILENAME=OCCURS1, SUFFIX=FIX, $
SEGMENT=OCCURS1, SEGTYPE=S0, $
FIELDNAME=EMP_ID, ALIAS=E01, USAGE=A9, ACTUAL=A09, $
FIELDNAME=LAST_NAME, ALIAS=E02, USAGE=A15, ACTUAL=A15, $
FIELDNAME=FIRST_NAME, ALIAS=E03, USAGE=A10, ACTUAL=A10, $
FIELDNAME=CURR_SAL, ALIAS=E04, USAGE=D12.2M, ACTUAL=A12, $
FIELDNAME=DEDLEN, ALIAS=E05, USAGE=I5, ACTUAL=A05, $
DEFINE NUMOCC/I2 = DEDLEN/12;,$
SEGNAME=DEDUCTION, SEGTYPE=S0, PARENT=OCCURS1, OCCURS=NUMOCC,$
FIELDNAME=DED_AMT, ALIAS=E06, USAGE=D12.2M, ACTUAL=A12, $
FIELDNAME=ORDER, ALIAS=ORDER, USAGE=I2, ACTUAL=I4,$

The following request uses the ORDER field to select and print the first occurrence of the repeating field for each employee. Since every employee has at least one deduction, every employee is represented on the report output:

TABLE FILE OCCURS1
PRINT NUMOCC LAST_NAME CURR_SAL DED_AMT
WHERE ORDER EQ 1
END
Parameterizing a Synonym with Variables

The output is:

<table>
<thead>
<tr>
<th>NUMOCC</th>
<th>LAST_NAME</th>
<th>CURR_SAL</th>
<th>DED_AMT</th>
</tr>
</thead>
<tbody>
<tr>
<td>10</td>
<td>STEVENS</td>
<td>$11,000.00</td>
<td>$64.17</td>
</tr>
<tr>
<td>8</td>
<td>SMITH</td>
<td>$13,200.00</td>
<td>$100.10</td>
</tr>
<tr>
<td>4</td>
<td>JONES</td>
<td>$18,480.00</td>
<td>$247.94</td>
</tr>
<tr>
<td>8</td>
<td>SMITH</td>
<td>$9,500.00</td>
<td>$60.96</td>
</tr>
<tr>
<td>1</td>
<td>BANNING</td>
<td>$29,700.00</td>
<td>$519.75</td>
</tr>
<tr>
<td>8</td>
<td>IRVING</td>
<td>$26,862.00</td>
<td>$626.78</td>
</tr>
<tr>
<td>4</td>
<td>ROMANS</td>
<td>$21,120.00</td>
<td>$317.62</td>
</tr>
<tr>
<td>1</td>
<td>MCCOY</td>
<td>$18,480.00</td>
<td>$161.70</td>
</tr>
<tr>
<td>5</td>
<td>BLACKWOOD</td>
<td>$21,780.00</td>
<td>$444.67</td>
</tr>
<tr>
<td>7</td>
<td>MCKNIGHT</td>
<td>$16,100.00</td>
<td>$187.88</td>
</tr>
<tr>
<td>4</td>
<td>GREENSPAN</td>
<td>$9,000.00</td>
<td>$52.50</td>
</tr>
<tr>
<td>10</td>
<td>CROSS</td>
<td>$27,062.00</td>
<td>$631.40</td>
</tr>
</tbody>
</table>

If you print the tenth occurrence of the repeating field, only two employees are displayed on the report output:

```sql
TABLE FILE OCCURS1
  PRINT NUMOCC LAST_NAME CURR_SAL DED_AMT
  WHERE ORDER EQ 10
END
```

The output is:

<table>
<thead>
<tr>
<th>NUMOCC</th>
<th>LAST_NAME</th>
<th>CURR_SAL</th>
<th>DED_AMT</th>
</tr>
</thead>
<tbody>
<tr>
<td>10</td>
<td>STEVENS</td>
<td>$11,000.00</td>
<td>$58.33</td>
</tr>
<tr>
<td>10</td>
<td>CROSS</td>
<td>$27,062.00</td>
<td>$526.20</td>
</tr>
</tbody>
</table>

Parameterizing a Synonym with Variables

You can define variables in a synonym in order to specify synonym attributes, such as the connection name or the table name. The variable is saved in the synonym as an object and is available for use in all subsequent reports derived from the synonym.

**Procedure:** How to Add a Variable to a Synonym

1. Right-click an object in the Metadata canvas, point to Insert, and then click Variable.

2. A new folder named Variables is added to the object tree, with &VARIABLE1 as an entry. The Properties panel shows the attributes of the variable.

3. If desired, change the name of the variable and enter a default value in the appropriate fields.
Variables Attribute Summary

Variables in a synonym can have the following attributes:

**VARIABLE**

The name of the variable. A double ampersand (&&) is automatically inserted in the name to indicate a global variable.

**DEFAULT**

The default value for the variable. If no value is set, the default value is used.

**QUOTED**

When selected, single quotation marks are added around the assigned string for the variable. A single quotation mark within the string is converted into two single quotation marks.

**FORMAT**

Optional description of the prompt value format for the variable. The format type can be Alpha fixed, Integer, or Decimal Packed.

**PROMPT**

The text that appears when prompting for a value for the variable.

**ACCEPT**

Allows you to select the method used to specify values that can be accepted for this variable. The following options are available:

- OR
- DECODE
- FIND (applies to Maintain only)
- SYNONYM
- FOCEXEC
- FROM-TO

**Select Type**

Allows you to specify whether you can select from a single or multiple list of values.

**Values**

Lists the values that are acceptable.
Procedure: How to Use a Variable in a Synonym

Variables in a synonym are commonly used to represent a table name or connection name.

1. In a synonym for a relational database where variables have been established, click a segment to open the Properties panel that shows the Adapter Specific attributes.

2. In the fields for TABLENAME and CONNECTION, enter the names of the variables to be used.

3. Click Save to save your changes.

Adding Indexes to a Synonym

Indexes are used to quickly locate data when a database table is queried, providing efficient access to ordered records. Indexes can be created using one or more columns of a database table.

When you use the Synonym shortcut menu option to create a synonym for a relational database table with more indexes than just the primary key, they will be included in the synonym.

For WebFOCUS files, additional indexes are useful when you anticipate using a column in a JOIN operation, a WHERE condition, or as an argument to DB_LOOKUP. You can add multiple indexes. Each index can be on one or more columns. You can specify if the index is sorted, and whether it is a unique index.

Example: Adding an Index to a Column

1. Right-click the field name and click Properties.

2. In the Properties panel, select the I - Index check box.

3. Select Rebuild a Connection from the More button on the Home tab to rebuild the data source.

Creating Cluster Joins

Cluster joins enable you to create a new file structure by linking existing synonyms of two or more relational tables using the same or mixed data sources. For example, you may join a Db2 table and an Oracle table, and so on. Use cluster joins to create new views in the metadata by linking together physical tables and easily report against the new view or structure. You can create cluster joins by using the Metadata canvas Modeling View.

The Master File that is created combines the fields of the joined tables within a single file. The Access File from the combined file contains information about the actual location of the data sources and the Join information. It also shows how the tables are linked.
The total number of tables that you can add to the tool is 512 (using 511 joins), which results in a new Master File that has a maximum of 512 segments.

The Cluster Join tool enables you to create a Star Schema which consists of a fact table referencing a number of dimension tables. Optionally, you can also create a view that has more than one fact table.

**Procedure: How to Create a Cluster Join by Enhancing Existing Synonyms**

Use the Modeling View to enhance an existing synonym by adding a segment.

1. From the Data Servers area, open a synonym by double-clicking a Master File.
   The Metadata canvas opens.
2. Click the *Modeling View* tab.
   The Modeling View tab opens in the workspace.
3. Right-click a segment in the workspace and select *Insert*.
4. Insert tables (segments) through one of the methods listed:

   **To insert a segment from an existing synonym as child or root:**
   a. Select *Insert*, then *Reference to Existing Synonym as Child* or *Reference to Existing Synonym as Root*.
   The Insert Reference to Existing Synonym dialog box opens.
   b. Select a synonym to be inserted and click *Select*.
   
   **Note:** Use this method if you are creating a cluster join with an existing table or synonym.
   
   **Tip:** Click *Save As* from the Modeling View File menu if you do not want to modify the original synonym.

   **To insert a segment via Metadata Import:**
   a. Select *Insert*, then *Segment via Metadata Import*. This enables you to add segments by using the Create Synonym tool. This tool creates a synonym and includes it as a segment in the synonym from which the tool was launched.
   
   **Note:** Use this method if you are creating a cluster join and need to use a synonym that does not exist. This option enables you to create the synonym and continue to create the cluster join.
   
   b. When this option is selected, you are first presented with the Adapter dialog box where you can select a configured adapter connection to continue or configure a new adapter, if necessary.
To insert a segment manually:

Select Insert, then Segment Manually. This enables you to assign values to segment attribute fields.

**Note:** Use this method if you are coding a new Master File, as you would for a WebFOCUS data source.

The segment is added in the Modeling View.

5. Right-click the join line between the segments.

**Note:** This option is only available when using relational tables.

6. Select a Join Type from the shortcut menu.

The Join Condition field automatically creates a Join if identical fields exist in both segments.

Creating a Synonym for Cube Data Sources

The Metadata canvas enables you to make further modifications to your Cube synonym definitions. The Cube synonym is displayed in the Cube View tab. If you select a component of the synonym, its properties appear in the Properties panel.

You can use the Metadata canvas to:

- Edit field names and titles for measures, properties, and variables. You may also edit the field prefix for the defined fields.

- Edit titles for multiple languages, delete titles, and add titles for additional languages if you are using code page UTF-8.

- Delete measures, dimensions, or parent/child hierarchies.

- View the USAGE and ACTUAL formats and change the USAGE display format for the field.

- Change an internal attribute value.

- Change the access property for variables.

- Change the field prefix used to create the field names, mandatory property names, and DEFINE field names generated for parent/child hierarchies by the Synonym Wizard.

- Create virtual measures (this is implemented with COMPUTE fields in the Master File).
Procedure: How to Edit Field Names and Titles

To edit field names and titles:

1. From the Data Servers area, open a synonym by double-clicking a Cube Master File.
   
   **Note:** You may also right-click the synonym and select *Edit in Synonym Editor.*
   
   By default, the Metadata canvas opens to the last view used.

2. Select an attribute from the Cube View tab.
   
   **Note:** The attributes available depend on the type of synonym.

3. Click *FIELD NAME*, *TITLE*, or *CAPTION* on the right-hand side of the workspace.
   
   **Note:** The Properties panel does not let you make any changes that would render the Master File unusable. Therefore, you cannot edit any value field that is highlighted gray.

4. Manually edit the Field Name, Title, or Caption by typing in the value field.
   
   The edits are updated instantaneously in the Cube View tab.

5. Click Save to save the synonym.
Procedure: How to Edit Titles for Multiple Languages

To edit the title for multiple languages:

1. From the Data Servers area, open a synonym by double-clicking a Cube Master File.
   By default, the Metadata canvas opens to the last view used.
2. Select an attribute from the Cube View tab.
3. Click the browse (...) button, located on the far right of the TITLE or CAPTION value field.
   The Multilingual Titles dialog box opens.
4. You may add, edit, or delete a title for this field.

   To add an additional language for the title:
   a. Select a language from the drop-down list.
   b. Click Add.
   c. Type a description for the title field.

   To edit an existing specified title:
   a. Select the title and click Edit.
      You may also double-click the title.
   b. Manually type a title name.

   To delete a specified title:
   a. Select the title and language to be deleted.
   b. Click Delete.
5. Click OK to close the Multilingual Titles dialog box.
6. Click Save from the File menu to save the synonym.

Procedure: How to Delete Measures, Dimensions, or Parent/Child Hierarchies

To delete measures, dimensions, or parent/child hierarchies:

1. From the Data Servers area, open a synonym by double-clicking a Cube Master File.
   By default, the Metadata canvas opens to the last view used.
2. Select the attribute name that you want to delete.
3. Right-click and select Delete from the shortcut menu.
   The attribute is deleted from the Cube View tab.
4. Click Save to save the synonym.

**Procedure: How to Create Virtual Measures With COMPUTE Fields**

To create virtual measures with COMPUTE fields:

1. From the Data Servers area, open a synonym by double-clicking a Cube Master File. By default, the Metadata canvas opens to the last view used.
2. Open the Measures folder from the Cube View tab.
3. Right-click the Virtual Measures folder, select Insert, and then select Virtual Measure. The Compute Calculator opens.
4. From the Compute Calculator, type a name for the column in the Name field.
5. You may type a descriptive title for the measure (COMPUTE) in the Title field.
6. Use the Expression tab and the calculator buttons to build the expression for the Measure (COMPUTE field).
   
       or

   Use the Relational Expression tab to build the expression.

   a. From the Relational Expression tab, click the Add New Row button.
   b. Use the drop-down lists to select the Field, Relation, and Type.

       **Note:** Parameters are not supported.
   c. Click the browse (...) button at the right of the Value input field.

       The Value Selection dialog box opens.
   d. Select from the available values and use the arrows to add or remove values.
   e. Click OK to close the Value Selection dialog box and return to the Relational Expression tab.

       The expression is added to the virtual measure.
   f. To add another expression, double-click a measure or dimension from the Fields/Variables tab on the right side of the Compute Calculator.
The expression is added to the Relational Expression tab, where you can add the expression value.

g. To delete an expression, select the number or field column of the expression and click the **Delete** button, or right-click it and select **Delete selected row(s)**. The expression is removed from the Relational Expression tab.

7. You may click the Check expression and Sample Data buttons, located on the top right of the Compute Calculator, to verify that the expression is valid and to view sample data for the filter.

8. Click **OK** to close the Compute Calculator and return to the Metadata canvas.

**Note:** To edit the Compute, Title, or Expression, you may do so directly from the Metadata canvas or you may click the browse (...) button at the right of the EXPRESSION value field to relaunch the Compute Calculator.

### Defining a Business View of a Master File

By defining a Business View of a Master File, you are creating an alternative view of the Master File and can limit the fields available or create a subset of fields from the original Master File. Fields can be grouped into meaningful folders. Field names, titles, and descriptions can be customized for each Business View.

Fields in a Business View are organized into folders. Each folder contains a group of fields. The fields in a folder can come from different segments in the original Master File. The Business View may contain existing fields and can include existing custom fields for DEFINE, COMPUTE, and Filters. Custom fields are associated with a specific segment in the original Master File and are subject to the same rules as real fields. A report can reference fields from multiple folders if they all lie along a single path in the original Master File.

When opening a Master File in the Synonym Editor and clicking the Business View button on the toolbar, a Business View pane opens inside the Synonym Editor where Business View attributes can be added. Adding Business View attributes at this point would update the Master File by inserting the Business View attributes at the end of the file, and once the file is saved, the Business View becomes the active view when the file is used for reporting.

If you do not wish to turn your Master File into a Business View, it is recommended that you save the Business View using a different name or preferably start by creating a new Master File by selecting **New**, then **Data & Metadata**, then **Synonym via Metadata Canvas**. Then, insert a reference to an existing synonym and continue to build the Business View. In this case, the Business View points to the cross-referenced Master File, and all of the actual fields and security information comes from the referenced file when the Business View is used in WebFOCUS tools (such as Joins and Defines) and in reports.
You may create a Business View for an existing Master File by using the Synonym Editor.

**Procedure:** How to Create a Business View Using the Metadata Canvas

1. From the *Data & Metadata* group, click *Open*. Select a Master File and click *OK*.
2. Right-click a segment, point to *Insert*, and then click *Reference to Existing Synonym*.
3. From the Insert Reference to Existing Synonym dialog box, select the synonym for which you want to create a Business View.
   The referenced file is added to the new synonym and its fields are visible in the left frame.
4. Select *Business View* from the Tools group to open the Business View panel.
   **Note:** A Business View Master File may contain only one root folder.
   **Tip:** Right-click a node in Business View and select *Properties* to open the Properties panel and view additional information for items selected in the Business View pane. Use the Properties pane to change titles, descriptions, or field names. Items that cannot be edited are grayed out.
5. In the Business View panel, right-click the file name and select *Create Default Business View* or *New Folder*.
   The *Create Default Business View* option duplicates the segments and fields that are available in the Master File. You can reorganize the view as necessary. The *New Folder* option creates a root folder to which you can add fields from the Master File on the left pane by selecting them and then dragging them inside the folder. You can create additional folders to create the structure you want.
6. To add additional folders for the Business View, right-click the Business View root folder that was created in the Business View pane and select *New Folder*.
   **Note:** Multiple subfolders can be created and folders may be empty for organizational purposes.
7. Select fields from the Master File on the left and drag them to the appropriate folder in the Business View pane. Press the Shift or Ctrl key while selecting multiple fields.
   **Note:** If needed, fields may be duplicated by placing them in multiple folders, but any given folder may contain a field only once.
   The selected fields appear in the Business View pane.
Reference: Usage Notes for Business Views

- When creating a Business View using a referenced Master File:
  - The detailed information about fields, such as USAGE and ACTUAL formats or indexes remain in the referenced Master File.
  - All information about Cluster Master Files remain in the referenced Master File.
  - DBA attributes specified in the referenced Master File are respected by the Business Views.
- When a Master File contains more than one field with the same name, as can occur when files are joined, the BELONGS_TO_SEGMENT attribute identifies which instance of the field name is being referenced in the Business View.
- Folders can be empty for organizational purposes. For example, Region can have empty folders called North, South, East, and West.
- You can issue an SQL SELECT command against a Business View. However, a Direct SQL Passthru request is not supported against a Business View.
- Business Views support alternate file views and fully qualified field names.
- The SEG. operator against a Business View folder displays all of the fields in that folder, not all of the fields in the real segment.
- Requests against a Business View cannot reference any fields or segments not in the Business View.
- All HOLD formats are supported against a Business View.
- All adapters for non-WebFOCUS data sources support retrieval requests against a Business View.
- Business Views are not supported with data source maintenance commands, such as Maintain or REBUILD.
- The referenced Master File or the Master File currently being used to create the Business View, may contain Defines, Computes, Filters, and other fields for use in the Business View.
- When creating a DEFINE field with a constant expression, in order to see the DEFINE field in a specific folder in the Object Inspector, you must use WITH syntax.

Note: For more information on Business Views, see the Server Administration Manual.
Reference: Using a Business View Master File

When you use the Business View Master File with WebFOCUS tools and reports, the field formats, descriptions, and titles will be retrieved from the original Master File, unless they are customized and a title and description is available through the Business View.

The Table List shows all available Master Files, including the Business Views, that are available. The Remarks column shows a description from the original Master File unless the Business View file contains its own remarks.

Applying Database Administrator (DBA) Security

You can secure Master Files on a file-by-file basis. For each data source, security can be maintained at two different levels.

- **Database Administrator Level.** You specify the Database Administrator (DBA) password for the data source. The DBA has unlimited access to the Master File and data source and can set up or change security restrictions for individual users. Only the Database Administrator can encrypt or decrypt a data source.

- **User Level.** You specify user passwords for the data source. A user password identifies a user who has access to that data source. When you specify a user password, you must also set at least the type of file access: read, write, read/write, or update. Security for each user can be further limited by restricting access to segments, fields, or field values. For more information, see Limiting Data Source Access: The RESTRICT Attribute on page 220. Once a user password has been established, you can apply the same restrictions to multiple users. For more information, see Applying Security Restrictions for Multiple Users on page 215.

**Note:** You cannot specify a Database Administrator (DBA) password during the Create Synonym process. You must use the Metadata canvas.

When security is specified, the Database Administrator or user must enter a password to get access to the data source. When the user no longer needs access to the data source, you can delete their security.

Before adding any type of security to a data source, the Database Administrator must be aware of certain DBA guidelines. See DBA Guidelines on page 213.
Procedure: How to Set Up Security for the Database Administrator

1. In the Metadata canvas, click DBA from the Tools menu or click the DBA button from the Synonym toolbar.

The DBA pane opens, as shown in the following image.

![DBA Pane Image]

**Note:** The DBA pane is available from the Field View, Segment View, List View, and Modeling View tabs.

2. Right-click the file name in the DBA window, point to Insert, then click DBA.

A default DBA password will be created for the Master File. You can change this value, delete it, add users to specify file restrictions, or add file names to specify data source-specific restrictions to the current data source. You can also specify a separate DBA file that contains DBA security restrictions.
Procedure: How to Set Up Security for a User

1. In the DBA pane, right-click the DBA icon to insert user restrictions or specify a DBA file.
2. Once you add a user, you can continue to insert file access restrictions by right-clicking the user field and selecting Insert.
3. Select the type of access: Read, Write, Read/Write, or Update.
4. Specify the type of restriction for each option: Restriction to Field, Value, Segment, Noprint, or Same Restriction.
   
   **Note:** The Same Restriction option is activated when there are multiple users.
5. Click OK to save the Master File with the user password and restrictions.

**Note:** To add WebFOCUS language security declarations to the Master File using the Text Editor, see *Implementing DBA Security Using WebFOCUS Language* on page 217.

Reference: DBA Guidelines

You can ensure that the security restrictions you place on Master Files are correct by adhering to the following guidelines:

- Every file with access limits must have a DBA password.
- No segment, field, or field value restrictions may be specified at the Database Administrator level. The Database Administrator must have unlimited access to the data source and all cross-referenced data sources.
- Once security restrictions have been applied, the Database Administrator should conduct thorough testing of every restriction before the data source is used. It is particularly important to check field values to make sure they do not contain errors. If they are in error, user access to the field data will be unnecessarily restricted.
- All groups of cross-referenced data sources should have the same security restrictions.
- You must have a DBA password to encrypt and decrypt or restrict existing data sources.
- The Database Administrator can change any type of security restriction.
- Access levels affect the fields users can access. The Database Administrator must consider what commands each user will need. If a user does not have access rights, that user will receive a message.
Reference: DBA Pane

The following options are available from the DBA pane when the DBA password is selected.

**DBA password**

By default, the DBA password is the same as the user ID used to connect to the Reporting Server. Using the Rename option from the DBA password shortcut menu, you may enter a different password of up to 64 characters. This is the password of the DBA who will be creating and maintaining the current data source. The DBA has full access to the data source and the corresponding Master File, controls the access rights of other users, and has encryption privileges. For more information, see *Encrypting and Decrypting a Master File* on page 216.

**DBAFILE**

Select the name of the Master File that contains your DBA security restrictions. Other Master Files can use the DBA security restrictions in this Master File.

**Insert Filename**

Enter the name of the Master File to which user security will be applied. This option is used to add data source-specific restrictions to the current data source. It includes a FILENAME attribute for the selected Master File. The FILENAME attribute in the referenced Master File must be the same as the FILENAME attribute in the DBA section of the current data source.

**Insert Users**

Enter the passwords (up to 64 characters) of users whose access rights will be granted for the current data source.

**File Access**

For user access, select one of the following options:

- Select *Read Access* for full viewing rights.
- Select *Write Access* to permit additions or changes to the data source.
- Select *Read/Write Access* for both of the above.
- Select *Update Access* to permit changes to field values.
**Restrictions: Segment, Field, Value, Noprint, Same**

When the file access is selected, continue to select the type of restriction you wish to apply.

- Select Segment to grant access to individual segments.
- Select Field to grant access to individual fields.
- Select Value to limit access to values that meet a test condition.
- Select Noprint to specify fields you do not want to display in a report.
- Select Same to apply the same restrictions as other users that are already set up.

**Applying Security Restrictions for Multiple Users**

You can specify restrictions for one user and apply the same restrictions to other users. This helps when you want to set the same restrictions for a group of users.

**Procedure: How to Apply Previously Defined Restrictions to Another User**

1. In the DBA pane, right-click the DBA password, point to Insert, and then click User.
2. Right-click the newly added user and select Insert to specify the desired type of access restriction you would like to apply.
   
   Available access types are Read Access, Write Access, Read/Write Access, and Update Access.
3. Right-click an access type and select Insert, then Same Restriction.

   **Note:** The Same Restriction option is only available when there are multiple users. A drop-down combo box is activated in the Properties panel with a NAME attribute.
4. Click the arrow on the drop-down combo box next to the NAME attribute in the Properties panel, and then select the user with the security restrictions that would apply to the new user.

   Security restrictions from the user selected in the drop-down combo box are applied to the new user. You can apply the security restrictions to other users by repeating steps 1 to 4.

   **Note:** You must have created at least one user security restriction to apply security restrictions to multiple users.

**Deleting a DBA or User Password**

The DBA can delete a DBA password or security for a user when it is no longer needed.
Procedure: How to Delete a User Password

1. On the DBA pane, select the user password you wish to delete.
2. Right-click and select Delete or press Delete on the keyboard.

If you delete the user based upon whom you have assigned security restrictions for other users, you must reset security restrictions for all users attached to the user you deleted.

Procedure: How to Delete a DBA Password

Deleting a DBA password will delete all user security for that data source.

On the DBA pane select the DBA password, then right-click and select Delete or press the Delete key.

All security information is removed.

Encrypting and Decrypting a Master File

The DBA may use the Encrypt and Decrypt attributes from the Metadata canvas to scramble and unscramble some or all of the contents of a data source. When you encrypt Master Files, they are secure from unauthorized examination.

Encryption at the data source level scrambles the entire contents of that Master File so it is unreadable. When you encrypt a Master File, you can decrypt it. Decrypting unscrambles the contents to its readable state.

Before you can encrypt or decrypt any Master File, you must specify the DBA password. If you do not specify a DBA password, you will not be able to encrypt or decrypt the file.

Procedure: How to Encrypt a Master File

1. In the Metadata canvas, click DBA from the Tools menu or click the DBA button from the Synonym toolbar.
   The DBA pane opens.
2. Create and save the Master File with the DBA password.
3. From the Metadata canvas Field View tab, select a segment from the Master File hierarchy (left pane).
   The values for the selected segment appear in the Properties panel on the right.
4. Select the ENCRYPT check box.
5. Click Save from the File menu to encrypt the Master File.
Procedure: How to Decrypt a Master File

1. At the encrypted segment level in the Master File hierarchy, clear the `ENCRYPT` attribute.
2. Click Save from the File menu to decrypt the Master File.

Implementing DBA Security Using WebFOCUS Language

The declarations (called security declarations) follow the END command in a Master File and tell WebFOCUS that security is needed for the data source and what type of security is needed. The word END on a line by itself in the Master File terminates the segment and field attributes and indicates that the access limits follow. If you place the word END in a Master File, it must be followed by at least a DBA attribute. Each security declaration consists of one or several of the following attributes:

- The DBA attribute gives the name or password of the Database Administrator for the data source. The Database Administrator has unlimited access to the data source and its Master File.

- The USER attribute identifies a user as a legitimate user of the data source. Only users whose name or password is specified in the Master File of a WebFOCUS data source with security placed on it have access to that data source.

- The ACCESS attribute defines the type of access a given user has. The four types of access available are:
  - RW, which allows a user to both read and write to a data source.
  - R, which allows a user only to read data in a data source.
  - W, which allows a user to only write new segment instances to a data source.
  - U, which allows a user only to update records in a data source.

- The RESTRICT attribute specifies certain segments or fields to which the user is not granted access. It can also be used to restrict the data values a user can see or perform transactions on.

- The NAME and VALUE attributes are part of the RESTRICT declaration.

Describe your data source security by specifying values for these attributes in a comma-delimited format, just as you specify any other attribute in the Master File.
Example: Implementing DBA Security in a Master File

The following is a Master File that uses security features:

```plaintext
FILENAME = PERS, SUFFIX = FOC,$
SEGMENT = IDSEG, SEGTYPE = S1,$
  FIELD = SSN          ,ALIAS = SSN    ,FORMAT = A9   ,$
  FIELD = FULLNAME     ,ALIAS = FNAME  ,FORMAT = A40  ,$
  FIELD = DIVISION     ,ALIAS = DIV    ,FORMAT = A8   ,$
SEGMENT=COMPSEG, PARENT=IDSEG, SEGTYPE=S1,$
  FIELD = SALARY       ,ALIAS = SAL    ,FORMAT = D8   ,$
  FIELD = DATE         ,ALIAS = DATE   ,FORMAT = YMD  ,$
  FIELD = INCREASE     ,ALIAS = INC    ,FORMAT = D6   ,$
END
DBA=JONES76,$
USER=TOM  ,ACCESS=RW,  $
USER=BILL  ,ACCESS=R  ,RESTRICT=SEGMENT  ,NAME=COMPSEG  ,$
USER=JOHN  ,ACCESS=R  ,RESTRICT=FIELD  ,NAME=SALARY   ,$
USER=LARRY  ,ACCESS=U  ,RESTRICT=FIELD  ,NAME=SALARY   ,$
USER=TONY  ,ACCESS=R  ,RESTRICT=VALUE  ,NAME=IDSEG,  
  VALUE=DIVISION EQ 'WEST',  $
USER=MARY  ,ACCESS=W  ,RESTRICT=VALUE  ,NAME=SALTEST,  
  VALUE=INCREASE+SALARY GE SALARY,$
  VALUE=DIV NE ' ' AND DATE GT 0,$
NAME=HISTTEST,
```

Identifying the DBA: The DBA Attribute

The first security attribute should be a password that identifies the Database Administrator. This password can be up to 64 characters long and, by default, is not case-sensitive. It can include special characters. If the DBA password contains blanks, it must be enclosed in single quotation marks ('). Since nothing else is needed, this line is terminated by the usual delimiter (,$).

Example: Identifying the DBA Using the DBA Attribute

```
DBA=JONES76,$
```

Identifying Users With Access Rights: The USER Attribute

The USER attribute is a password that identifies the users who have access to the data source. A USER attribute cannot be specified alone. It must be followed by at least one ACCESS restriction (discussed in Specifying an Access Type: The ACCESS Attribute on page 219) to specify what sort of ACCESS the user is granted.
Before using a secured data source, a user must enter the password using the SET PASS or SET USER command. If that password is not included in the Master File, the user is denied access to the data source. When the user does not have a password, or has one that is inadequate for the type of access requested, a message appears.

**Syntax:** How to Set the USER Attribute

Any user whose name or password is not declared in the Master File is denied access to that data source. The syntax of the USER attribute is

\[
\text{USER} = \text{name}
\]

where:

\[
\text{name}
\]

Is a password of up to 64 characters for the user. The password can include special characters and is not case-sensitive. If the password contains blanks, it must be enclosed in single quotation marks (').

You can specify a blank password (default value if not previously changed). Such a password does not require the user to issue a SET PASS= command. A blank password may still have access limits and is convenient when a number of users have the same access rights.

**Example:** Setting the USER Attribute

\[
\text{USER}=\text{TOM}, \ldots
\]

An example of setting a user password to blank, and access to read only follows:

\[
\text{USER}=\ , \text{ACCESS}=\text{R,}$
\]

**Establishing User Identity**

A user must enter his or her password before using any WebFOCUS data source that has security specified for it. A single user may have different passwords in different files. For example, in file ONE, the rights of password BILL apply, but in file TWO, the rights of password LARRY apply. Use the SET PASS command to establish the passwords.

**Specifying an Access Type: The ACCESS Attribute**

The ACCESS attribute specifies what sort of access a user is granted. Every security declaration, except the DBA declaration, must have a USER attribute and an ACCESS attribute.

The following is a complete security declaration, consisting of a USER attribute and an ACCESS attribute.
This declaration gives Tom read and write (for adding new segment instances) access to the data source.

Access levels affect what kind of commands a user can issue. Before you decide what access levels to assign to a user, consider what commands that user will need. If a user does not have sufficient access rights to use a given command, a message appears.

ACCESS levels determine what a user can do to the data source. Use the RESTRICT attribute (discussed in Limiting Data Source Access: The RESTRICT Attribute on page 220) to limit the fields, values, or segments to which a user has access. Every USER attribute must be assigned an ACCESS attribute. The RESTRICT attribute is optional. Without it, the user has unlimited access to fields and segments within the data source.

Limiting Data Source Access: The RESTRICT Attribute

The ACCESS attribute determines what a user can do with a data source.

The optional RESTRICT attribute further restricts a user access to certain fields, values, or segments.

The RESTRICT=VALUE attribute supports those criteria that are supported by the IF phrase. The RESTRICT=VALUE_WHERE attribute supports all criteria supported in a WHERE phrase, including comparison between fields and use of functions. The WHERE expression will be passed to a configured adapter when possible.

Syntax: How to Limit Data Source Access

```plaintext
...RESTRICT=level, NAME={name|SYSTEM} [,VALUE=test],$
```

or

```plaintext
...RESTRICT=VALUE_WHERE, NAME=name, VALUE=expression; ,$
```

where:

- `level`

  Can be one of the following:

  - **FIELD**, which specifies that the user cannot access the fields named with the NAME parameter.
  
  - **SEGMENT**, which specifies that the user cannot access the segments named with the NAME parameter.
- **SAME**, which specifies that the user has the same restrictions as the user named in the NAME parameter. No more than four nested SAME users are valid.

- **NOPRINT**, which specifies that the field named in the NAME or SEGMENT parameter can be mentioned in a request statement, but will not display. You can use a VALUE test to limit the restriction to values that satisfy an expression. For example, consider the following RESTRICT=NOPRINT declaration. User MARY can only display the IDs of those employees whose salaries are less than 10000.

  ```
  USER=MARY  ,ACCESS=R  ,RESTRICT=NOPRINT  ,NAME=EMP_ID  ,
  VALUE=CURR_SAL LT 10000;,$
  ```

  **name**
  Is the name of the field or segment to restrict. When used after NOPRINT, this can only be a field name. NAME=SYSTEM, which can only be used with value tests, restricts every segment in the data source, including descendant segments. Multiple fields or segments can be specified by issuing the RESTRICT attribute several times for one user.

  **Note:** With value restrictions, NAME=segment restricts the named segment and any segment lower in the hierarchy, whether or not an alternate file view changes the retrieval view. This means that if a parent segment has a value restriction, and a join or alternate file view makes a child segment the new root, the value restriction on the original parent will still apply to the new root.

  **VALUE**
  Specifies that the user can have access to only those values that meet the test described in the **test** parameter.

  **test**
  Is the value test that the data must meet before the user can have access to it. The test is an expression supported in an IF phrase.

  **VALUE_WHERE**
  Specifies that the user can have access to only those values that meet the test described in the **expression** parameter.

  **expression;**
  Is the value test that the data must meet before the user can have access to it. The test is an expression supported in a WHERE phrase.

  **Note:** The semicolon (;) is required.
Example: Limiting Data Source Access

USER=BILL, ACCESS=R, RESTRICT=SEGMENT, NAME=COMPSEG,$

Placing Security Information in a Central Master File

The DBAFILE attribute enables you to place all passwords and restrictions for multiple Master Files in one central file. Each individual Master File points to this central control file. Groups of Master Files with the same DBA password may share a common DBAFILE which itself has the same DBA password.

There are several benefits to this technique, including:

- Passwords only have to be stored once when they are applicable to a group of data sources, simplifying password administration.

- Data sources with different user passwords can be JOINed. In addition, individual DBA information remains in effect for each data source in a JOIN.

The central DBAFILE is a standard Master File. Other Master Files can use the password and security restrictions listed in the central file by specifying its file name with the DBAFILE attribute.

Syntax: How to Place Security Attributes in a Central Master File

END
DBA=dbaname, DBAFILE=filename,$

where:

- dbaname
  Is the same as the dbaname in the central file.

- filename
  Is the name of the central file.

You can specify passwords and restrictions in a DBAFILE that apply to every Master File that points to that DBAFILE. You can also include passwords and restrictions for specific Master Files by including FILENAME attributes in the DBAFILE.
Hiding Restriction Rules: The ENCRYPT Command

Since the restriction information for a WebFOCUS data source is stored in its Master File, encrypt the Master File in order to prevent users from examining the restriction rules. Only the Database Administrator can encrypt a description. You must set PASS=DBA_name before you issue the ENCRYPT command.

**Syntax:**

How to Hide Restriction Rules: ENCRYPT Command

```plaintext
ENCRYPT FILE filename
```

where:

- `filename`
  
  Is the name of the file to be encrypted.

**Example:** Encrypting and Decrypting a Master File

The following is an example of the complete procedure:

```plaintext
SET PASS=JONES76
ENCRYPT FILE PERS
```

The process can be reversed in order to change the restrictions. The command to restore the description to a readable form is DECRYPT.

The DBA password must be issued with the SET command before the file can be decrypted. For example:

```plaintext
SET PASS=JONES76
DECRYPT FILE PERS
```

**Encrypting Data**

You may also use the ENCRYPT parameter within the Master File to encrypt some or all of its segments.

Encryption takes place on the segment level. That is, the entire segment is encrypted. The request for encryption is made in the Master File by setting the attribute ENCRYPT to ON.

**Example:** Encrypting Data

```plaintext
SEGMENT=COMPSEG, PARENT=IDSEG, SEGTYPE=S1, ENCRYPT=ON, $
```
You must specify the ENCRYPT parameter before entering any data in the data source. The message NEW FILE... must appear when the encryption is first requested. Encryption cannot be requested later by a change to the Master File and cannot be removed after it has been requested or any data has been entered in the data source.

**Analyzing Procedures Using Impact Analysis**

You can use Impact Analysis to generate a report that identifies the procedures that access a specific Master File or field within a Master File. Impact Analysis helps you analyze the potential impact of modifying or deleting Master Files or fields and enables you to analyze data, control search criteria, save reports, and interactively open and edit procedures based on search results.

Impact Analysis searches Business Views in addition to WebFOCUS procedures. This enables you to see if changes in the original Master File will impact fields used in the Business View.

Impact Analysis is accessible from the Domains and Data Servers development areas of the Configured Environments tree.

**Note:** You can launch Impact Analysis from the Configured Environments tree or from the Metadata canvas. When Impact Analysis is launched from the Metadata canvas, it searches files based on the application path of the Reporting Server. From the Configured Environments tree, it enables you to select applications or folders to be searched.

**Procedure: How to Use Impact Analysis From the Configured Environments Tree**

1. You can use Impact Analysis from the Configured Environments tree in the following ways:

   - From the Domains area, right-click a folder and then click **Impact Analysis** to limit the search to the selected folder and its subfolders.

   - Right-click the **Domains** node and then click **Impact Analysis** to search all folders within that node.

   - From the Data Servers area, expand an application, right-click a Master File, and then click **Impact Analysis** from the shortcut menu.

   The Impact Analysis canvas opens with the New Report tab displaying the selected Master File Name and default Search Paths.

2. To search for all procedures that access a specific Master File or field, perform one of the following:

   - **Selected Master File.** The Master File you selected when opening the canvas will be searched, by default. Proceed to step 3.
Different Master File. Click the ellipsis button (…) to the right of the File Name search field and select a different Master File in the Select a Master File dialog box that opens.

Single Field Within a Master File. After you select the desired Master File, click the ellipsis button (…) to the right of the Field Name search field and double-click a field name in the Master File shortcut menu.

3. Optionally, to search for procedures in directory paths not listed by default in the Search Paths pane, add more search paths by clicking the folder icon above the Search Paths area and selecting one or more folders in the Select Folder dialog box that opens.

   Note: You can also delete search paths by highlighting a search path and clicking the Delete icon above the Search Paths area.

4. Optionally, you can change the Connection Settings to manage the resources used on Impact Analysis report execution.

   You can change the Request Timeout limit to a smaller or larger value depending on the expected size of the Impact Analysis report, and you can select the Deferred Response check box to run Impact Analysis asynchronously, allowing you to continue using App Studio while the Impact Analysis report is being generated, such as by accessing the Environments Tree and opening or creating files.

5. Click Analyze to display a report in the Impact Analysis Result pane.
The following image shows the New Report tab of the Impact Analysis canvas populated with File Name search criteria, multiple Search Paths, and a report displayed in the Impact Analysis Result pane.

You have options to edit procedures, delete a report item, export a report, and print the report.

Exported reports are XML-formatted, have an .IAR extension, and are saved in the following default directory (unless you specify a different location):

`drive:\ibi\AppStudio\releasenumber\bin`

6. Click the **Saved Reports** tab to access all previously created reports.

All Impact Analysis reports are automatically saved in the following XML-formatted file:

`drive:\ibi\AppStudio\releasenumber\bin\IARepository.xml`

Information is appended to this file as new analysis reports are performed. You have options to view reports, import previously exported reports, and delete reports.

**Note:** You can select an Impact Analysis report and click the Report Description icon to display details of the report.
Creating Reports

Reports are the foundation of business intelligence and business analytics, enabling you to gain valuable insights and make improved business decisions. In App Studio, you can create and edit reports using the Report canvas. When you create a new report, you use the Report Wizard. In report mode, you can create and style simple or complex reports, add data to the Report canvas, and style that data creating a graphical representation of the report page. This allows you to view how the report displays at run time.

This topic provides an overview of reporting, the types of reports you can create with App Studio, how to launch the Report Wizard to create reports, and a sample GUI procedure, with its associated WebFOCUS syntax, that you can use to create each type of report.

For information on the Report Wizard, see Launching the Report Wizard on page 229.

For information on the tabs and panels that are available when you are developing reports in the Report canvas, see Accessing Reporting Components on page 235.

In this chapter:

- Building Reports Overview
- Report Types
- Launching the Report Wizard
- Accessing Reporting Components
- Creating Reports Using the Report Canvas
- Creating Precision Reports
- Joining Data
- Blending Data
- Styling Reports
- Linking Reports with Auto Linking and Auto Drill
- Reporting Syntax Summary
Building Reports Overview

App Studio provides you with the toolset and resources you need to create, edit, and view reports online or offline. App Studio allows users from beginner to advanced skill levels to independently create their own reports or modify existing reports without writing complex code or requiring the assistance of IT staff. Once your reports are developed, you can add them to a reporting application that can be made available throughout your enterprise internally, externally to the field on mobile devices, or both. App Studio allows you to deploy, manage, and expand your reporting application as required.

Business intelligence reports are usually designed to answer such questions as:

- What happened in the first quarter of this year? How does it compare to the first quarter of last year?
- When is the best season to roll out our new inventory to our stores?
- How many products were sold in a given year, month, week, or day?
- Who was the best performing seller for these products?

Reports designed for business analytics can answer such questions as:

- Why did the southern region exceed third quarter revenue estimates?
- Will this event or result occur in the future?
- What will happen if we introduce a new product line in the Spring?
- What else does the data tell us that we never thought to ask?

Report Types

Using App Studio, you can create the following report types using graphical tools or the WebFOCUS syntax:

- **Tabular report.** Displays information in rows and columns. This is the basic report type, incorporating the fundamental reporting concepts. Most of the other report formats build on these concepts. You can drill down or roll up data hierarchies, pivot fields from columns to rows (or vice versa), and separate information by filtering or querying data sources based on specified criteria or thresholds. You can also create drill through reports that contain a summary report and detail reports, where the detail reports contains all the detail data for designated fields in the summary report. You can display these reports in many different formats, including HTML, Excel®, PowerPoint, and PDF. For more information, see *Creating a Tabular Report* on page 372.
In-Document Analytic report. Designed for offline analysis. When using an In-Document Analytic report, you can interact with data, using analysis options similar to those found in an Excel workbook. Since no connection to a server is required to view the data or use the analysis options, you can save and use the report anywhere. Analysis options include filtering, sorting, charting, and much more. For more information, see Creating an Analytic Document on page 374.

Excel Compound and Table of Contents reports. Provides a way to generate multiple worksheet reports using the XLSX output format. By default, each of the component reports from the compound report is placed in a new Excel worksheet. A Table of Contents report provides a way to generate a multiple worksheet report where a separate worksheet is generated for each value of the first sort field (BY) in the report. For more information, see Creating an Excel FORMULA Table of Contents Report on page 379.

Financial report. Specifically designed to handle the task of creating, calculating, and presenting financially oriented data, such as balance sheets, consolidations, and budgets. You design the content of the report on a row-by-row basis using a field (called a FOR field) that identifies each row, such as an account field. Once you have created the FOR field, you can build these reports from the Matrix tab. This organization provides a number of advantages, including easily defined inter-row and inter-column calculations. For more information, see Creating a Financial Report on page 380.

Precision report. Gives you an additional set of tools that make it easy to control the precise placement of objects and data in the report output. For example, with a precision report, you can quickly create a layout that is perfectly aligned for a preprinted form (such as a Bill of Sale or a tax form) and that automatically breaks out one record per report page. You can convert an existing report into a precision report or you can create a new precision report. For more information, see Creating a Precision Report on page 385.

SQL request. You can retrieve information using the SQL reporting language, and can directly incorporate WebFOCUS formatting commands. For more information, see Creating a Tabular Report Using an SQL Request on page 389.

Launching the Report Wizard

The Report Wizard allows you to create a new report procedure or SQL report procedure, and open an existing report.

To open the Report Wizard:

- On the Home tab, in the Content group, click Report.
- In the Environments Tree panel, right-click an application folder, point to New, then to Reporting, and click Report.
**Note:** If you choose to create a new report using the shortcut menu in the Environments Tree panel, you will skip the first screen of the Report Wizard. You will not have to specify whether you are creating a report or SQL report. You will instead be brought to the Select Data Source window, with the location for your report already selected.

The Report Wizard opens, as shown in the following image.

![Report Wizard Image](image)

From the Report Wizard, you can create a new report or SQL report procedure or open a recent procedure.

**Procedure:** How to Create a Report Using the Report Wizard

After you launch the Report Wizard, you can begin to create your report procedure.

**Note:** If you choose to create a new report using the shortcut menu in the Environments Tree panel, you will skip the first screen of the Report Wizard. You will not have to specify whether you are creating a report or SQL report. You will instead be brought to the Select Data Source window, with the location for your report already selected.

1. Click **Create Report**.

   The Report Wizard - Select Procedure Location window opens.

2. Navigate to where you want to create the new report and click **Next**.
The Select Data Source window opens.

3. Choose an application folder in the application folder tree, and select a Master File in the Master files list. You can select the Use Qualified Path check box if you only want to display the data sources in the application folder and generate a qualified file name reference.

4. Click Finish.

The Report canvas and the Procedure View panel open.

5. Double-click fields in the Object Inspector, or drag them on to the canvas to add them to the report.


   **Tip:** The Field and Appearance tabs appear when you select a data column on the Report canvas.

7. To save your report, click Save on the Quick Access Toolbar, or click Save or Save As from the Application menu.

8. To run your report, click Run on the Quick Access Toolbar, or click Run from the Application menu.

**Procedure: How to Create an SQL Report From an External .sql File**

After you launch the Report Wizard, you can begin to create your SQL report procedure. This enables you to browse and select external procedures that exist in the domain.

**Note:** If you choose to create a new SQL report using the shortcut menu in the Environments Tree panel, you will skip the first screen of the Report Wizard. You will not have to specify whether you are creating a report or SQL report. You will instead be brought to the SQL Report Wizard - Welcome window.

1. Click Create SQL Report.


2. Select a location for your SQL report and click Next.

   The SQL Report Wizard - Welcome window opens.

3. Click the Included from an external `.sql` file option.

4. Click Next.

   The SQL Report Wizard - Data access information window opens.

5. In the Select the SQL database engine area, select a database from the drop-down list. The drop-down list changes depending on your server configuration.
6. In the Select connection area, choose a connection from the drop-down list generated from the engine you selected.

7. Click Next.

   The SQL Report Wizard - Include external SQL file window opens.

8. Click Browse to select an external SQL file name or type the external SQL file name in the field.

   Optionally, you can run with limited records by clicking Run SQL. By default, the Run with limited records check box is selected so you can test your procedure with a read limit if the engine supports it. There is a field box next to the check box in which you can enter the number of records to be read. The default limit is 100.


10. Navigate to where you want to create the new procedure.

11. In the Enter a Procedure Name field, type a name for the SQL report.

   **Note:** Typing a procedure name is not required to create a new report. If you do not type a procedure name in the Enter a Procedure Name field, a default procedure name will be provided until you save the procedure.

12. Click Finish.

   The Report canvas and the Procedure View panel open. You can now add data to your report and format the data using the tabs on the ribbon.

**Procedure:** How to Pass SQL Commands to the RDBMS Using SQL Passthru

After you launch the Report Wizard, you can begin to create your SQL report procedure by typing SQL commands that will be passed on to the RDBMS with the SQL Passthru feature.

**Note:** If you choose to create a new SQL report using the shortcut menu in the Environments Tree panel, you will skip the first screen of the Report Wizard. You will not have to specify whether you are creating a report or SQL report. You will instead be brought to the Report Wizard - Choose location for the new SQL Report window, with the location for your report already selected.

1. Click Create SQL Report.


2. Select a location for your SQL report and click Next.

   The SQL Report Wizard - Welcome window opens.
3. Click **Type SQL statements in the report request**.

4. Click **Next**.

   The SQL Report Wizard - Data access information window opens.

5. In the Select the SQL database engine area, select a database from the drop-down list. The drop-down list changes depending on your server configuration.

6. In the Select the connection area, choose a connection from the drop-down list generated from the engine you selected.

7. Click **Next**.

   The SQL Report Wizard - Enter SQL statements window opens.

8. In the field box, type the SQL statements you want to pass to the RDBMS.

   Optionally, you can run with limited records by clicking **Run SQL**. By default, the **Run with limited records** check box is selected, so you can test your procedure with a read limit if the engine supports it. There is a field box next to the check box in which you can enter the number of records to be read. The default limit is 100.

9. Click **Next**.

   The SQL Report Wizard - Summary of SQL options window opens.

10. Review your options and click **Next**.

    The Report Wizard - SQL Data Source window opens.

11. Navigate to where you want to create the new procedure.

12. In the Enter a Procedure Name field, type a name for the SQL report.

    **Note:** Typing a procedure name is not required to create a new report. If you do not type a procedure name in the Enter a Procedure Name field, a default procedure name will be provided until you save the procedure.

13. Click **Finish**.

    The Report canvas and the Procedure View panel open. You can now add data to your report and format the data using the tabs on the ribbon.

**Procedure:** **How to Import SQL Commands From an Existing .sql File**

You can import commands from existing .sql files. This enables you to modify SQL code after importing it from an external file to the procedure being built. You can modify the request using bits of the code.
**Note:** If you choose to create a new SQL report using the shortcut menu in the Environments Tree panel, you will skip the first screen of the Report Wizard. You will not have to specify whether you are creating a report or SQL report. You will instead be brought to the *Report Wizard - Choose location for the new SQL Report* window, with the location for your report already selected.

1. Click *Create SQL Report*.
   

2. Select a location for your SQL report and click *Next*.
   
   The SQL Report Wizard - Welcome window opens.

3. Click *Import from an existing `.sql` file* and click *Next*.
   
   The SQL Report - Data access information window opens.

4. In the Select SQL database engine area, select a database from the drop-down list. The drop-down list changes depending on your server configuration.

5. In the Select the connection area, choose a connection from the drop-down list generated from the engine you selected.

6. Click *Next*.
   
   The SQL Report Wizard - Import external SQL file window opens.

7. Type the SQL file name that you want to import or click *Browse* to select it.
   
   Optionally, you can run with limited records by clicking *Run SQL*. By default, the *Run with limited records* check box is selected, so you can test your procedure with a read limit if the engine supports it. There is a field box next to the check box in which you can enter the number of records to be read. The default limit is 100. You can edit these options here or in the next step.

8. Click *Next*.
   
   The SQL Report Wizard - Enter SQL statements window opens.

9. In the field box, type the SQL statements you want to pass to the RDBMS.

10. Click *Next*.
   
    The SQL Report Wizard - Summary of SQL options window opens.

11. Review your options and click *Next*.

    The Report Wizard - SQL Data Source window opens.

12. Navigate to where you want to create the new procedure.

13. In the Enter a Procedure Name field, type a name for the SQL report.
Note: Typing a procedure name is not required to create a new report. If you do not type a procedure name in the Enter a Procedure Name field, a default procedure name will be provided until you save the procedure.

14. Click Finish.

The Report canvas and the Procedure View panel open. You can now add data to your report and format the data using the tabs on the ribbon.

Accessing Reporting Components

The following topics describe the tabs and panels that are available when you are developing reports in the Report canvas.

Building a Report Using the Report Tab

You use the Report tab to modify report properties, change the style of rows and columns on your report, or create filters. The Report tab contains the following groups: Filter, Report, Traffic Lights, Style, and Links. The Report tab is located at the top of the App Studio interface and is available only when you are creating or working with a report. The Report tab is shown in the following image.

Defining a Filter Field Using the Filter Group

You use the Filter group to define filter fields when creating a report. The Filter group is shown in the following image.

The commands are:

Filter

Filters fields using Where, If, Where Total, and Limits screening options. You can access the Expression Builder by selecting Where, If, or Where Total from the Filter drop-down menu.
Using the Expression Builder, you can create expressions quickly by selecting fields, relations, operators, and values from lists. You can base selection criteria on a specified value, a variable value, or a field value. For more information, see Creating Expressions Using the Expression Builder on page 236.

If you select Limits, the Retrieval Limits dialog box opens, where you can set the record limit and read limit values. This enables you to set how much data is displayed or previewed.

Creating Expressions Using the Expression Builder

The Expression Builder enables you to create expressions quickly by selecting fields, relations, operators, and values from lists. You can base selection criteria on a specified value, a variable value, or a field value.

You can access the Expression Builder by clicking Where, If, or Where Total from the Filter drop-down menu. The Expression Builder dialog box displays.

The Expression Builder is divided into four sections. The Data section is located in the upper-left of the Expression Builder. The Criteria section is located to the lower-left of the Expression Builder. The Expression Grid is located to the upper-right of the Expression Builder. The Advanced section is located in the lower-right of the Expression Builder.

The Data section displays a list of all fields in the data source. Double-click or drag the field into the Expression Grid to build an expression using the options provided. You can also drag fields to the Criteria section and the Advanced section, once it is enabled.

The Criteria section displays which expression you are working on, as well as which expressions, of the same type, you have already created. If you double-click a field and it is added to the Expression Grid, the field will be shown in the Criteria section. Alternatively, you can drag a field into the Criteria section to begin working on a new expression. Dragging more than one field into the Criteria section allows you to create multiple of whatever type of statement you selected (Where, If, or Where Total). For example, if you clicked Where to open the Expression Builder, dragging more than one field into the Criteria section will create multiple Where expressions. Selecting an expression in the Criteria section will show you the details of that expression in the Expression Grid and/or the Advanced section.

Note: The type of expression you are creating is shown next to the Criteria section.

The Advanced section is where, instead of creating an expression using the Expression Grid, you are creating the expression using syntax. The Advanced check box is only available to be selected once a field is in the Criteria or Expression Grid. Once the Advanced check box is selected, the Advanced section, the Function button, and the Variable button are available for use.
The Expression Grid is where you build an expression using the drop-down options available. You can add more fields to the Expression Grid to make a more complex expression by using OR and AND.

**Note:** if you close the Expression Builder dialog box using the close icon (X), you are prompted to save changes, if changes were made.

**Reference:** Expression Builder Dialog Box

The Expression Builder dialog box has the following sections:

**Data section**

Displays a list of all of the fields in the data source. Double-click or drag a field to add it to the Expression Grid.

If the selected field has a title attribute defined in the Master File, the title will be used in the prompt text for the variable. If the selected field does not have a title attribute, the name of the field will be used in the prompt text for the variable.

**Expression Grid**

Create an expression by using the drop-down menus in correlation with a field.

You can delete expressions from the Expression Grid using the Delete key or right-click Delete option when either the And/Or or Column to filter columns are selected. If you use the Delete key or right-click Delete option on any other column, it will only delete that column option. You can only delete entire expressions, using the Expression Grid, when there are multiple expressions present. If you want to delete a single expression, you must do it from the Criteria section.

**And/Or**

Displays the keyword used in the expression listed in the Expression list box. You must select more than one field for the expression to activate this option.

**Parentheses**

Allows you to add one, two, or three parentheses before and after an expression.

**Column to filter**

The field you clicked or dragged from the Data section. This field can be changed after being added by clicking the drop-down list and selecting a different field.

**Logical Relation**

Displays a list of possible relations between the selected data source field and the value, parameter, or other field that WebFOCUS will compare it to. Select a relation to activate the Compare Type column.
The following relations are available from the drop-down list:

- equals
- does not equal
- is greater than
- is greater than or equal to
- is less than
- is less than or equal to
- is
- is not
- contains
- does not contain
- matches the pattern
- does not match the pattern
- is like
- is not like
- is missing
- is not missing
- includes
- excludes
- is from
- is not from
- is in literal list
- is not in literal list
- is in external file of literals
- is not in external file of literals
Note: The is and is not relations are only available for an IF statement. The matches the pattern, does not match the pattern, is like, is not like, is in literal list, is not in literal list, is in external file of literals, and is not in external file of literals relations are only available for a WHERE statement.

Compare Type

 Indicates the nature of the comparison you wish to make to the field selected in the field section.

The following is a list of the available Compare Types and a brief description of what each is:

- Value is a set value the user creates, using the Multiple or Single Value Builder, in the Compare Value section.

- Field is a selected field the user specifies, using the Multiple or Single Value Builder, from the Compare Value section.

- Parameter (Editor) is a parameter created by the user, using the Variable Editor, in the Compare Value section.

- Parameter (Optional) is a parameter option that allows a user to create a parameter that does not require a value at run time.

- Parameter (Dynamic) is a parameter option that allows a user to multiselect values using a button. This option automatically generates the required syntax so that the Variable Editor does not need to be invoked.

- Parameter (Static) is a parameter option that presents a value list to select from. This option automatically generates the required syntax so that the Variable Editor does not need to be invoked.

- Parameter (Simple) is a parameter option that prompts the user to enter a value. This option automatically generates the required syntax so that the Variable Editor does not need to be invoked.

- Function is a function created by the user, from the Compare Value section, using the Function Arguments dialog box.

- Import Values is a list of values, created by the user, using the Multiple or Single Value Builder, in the Compare Value section.

Note: The external file should be a text file with new line delimiters.
Other allows you to enter your own expression.

**Note:** After choosing Other and double-clicking on Compare Value to enter a value, you will be prompted with the following warning message. You can choose to not show this message again by selecting the option at the bottom of the warning window.

*If using a literal value, it must be enclosed in single quotes. Please use "Compare Type" "Value" instead for quotes to be added automatically.*

**Compare Value**

Specifies the literal value, parameter, or other field to which the selected field is compared.

The choices available here are dependent on the selection you make in the Compare Type column.

**Criteria**

The Criteria section shows the different expressions you created. Selecting an expression in the Criteria section will show you details of the expression in the Expression Grid and/or the Advanced section.

**Advanced check box**

This option can only be checked if there is an expression in the Criteria or Expression Grid section. This option will enable you to use the Advanced section, the Function button, and the Variable button.

**Advanced section**

In this section, you can type an expression using syntax, instead of using the Expression Grid.

**Function**

Only available when Advanced is checked. Opens the Function Arguments dialog box to assist in the creation of an expression that is being made with the Advanced section.

**Variable**

Only available when Advanced is checked. Opens the Variable Editor dialog box to assist in the creation of an expression that is being made with the Advanced section.

**Delete**

Deletes an expression.

**Up**

Moves an expression up one.
Down

Moves an expression down one.

Procedure: **How to Display Records Based on Specified Values**

In the Expression Builder dialog box:

1. Select a field name from the Data section.
   The field is added to the Expression Grid.
2. Select a relation from the Logical Relation column.
3. In the Compare Type column, select *Value*.
4. Double-click the *Compare Value* column. The Multiple Value Builder dialog box opens.
5. Click the *Select a field* button and select a value from the list.
6. Double-click the value to add the value to the list.
   
   **Note:** Repeat this process to add other values to the list.
7. Click *OK*.
   The values are shown in the Compare Value column.

Procedure: **How to Display Records Based on a Variable Value**

In the Expression Builder dialog box:

1. Select a field name from the Data section.
   The field is added to the Expression Grid.
2. Select a relation from the Logical Relation column.
3. In the Compare Type column, select *Parameter (Dynamic)*.
   This creates a Single Select parameter. If you want to create a Multiselect parameter, double-click the Compare Value column to open the Variable Editor and change the Variable Type to *Multiselect*.

Procedure: **How to Display Records Based on Field Values**

In the Expression Builder dialog box:

1. Select a field name from the Data section.
2. Select a relation from the Logical Relation column.
3. In the Compare Type column, select *Field*. 
4. Double-click the Compare Value column to open the Single Value Builder dialog box.

5. Double-click a field from the Data Source section to move it to the Value List.

6. Click OK to close the Single Value Builder dialog box.
   
   The field is added to the Compare Value column.

**Procedure: How to Display Records Based on Imported Values From an External File**

In the Expression Builder dialog box:

1. Select a field name from the field list.
   
   The field is added to the Expression Grid.

2. Select a relation from the Logical Relation column.

3. Select Import Values from the Compare Type list options.

4. Double-click the Compare Value column.
   
   The Multiple Value Builder opens.

   **Note:** A Single or Multiple Value Builder dialog box opens, based on your Logical Relation selection. In the Multiple Value Builder dialog box, you may select more than one value. In the Single Value Builder dialog box, only one value may be selected.

5. Click the Select File button to import values from an external file.

6. Select a text file from your local machine and click **Open**.

   **Note:** The external file should be a text file with new line delimiters.

   The imported values are loaded into the Data Source area of the Multiple Value Builder dialog box.

7. Double-click an imported value to add it to the Values List.

8. Click OK to close the Multiple Value Builder dialog box and return to the Expression Builder.
   
   The imported values are added to the Compare Value area.

**Procedure: How to Select Multiple Values and Fields**

In the Expression Builder dialog box, you can select multiple values or fields to be used for record selection criteria by selecting options in the And/Or column. The And/Or column is only available if you have more than one Column to filter.

1. Select more than one field name from the Fields window and drag them to the Expression Grid.
Note: For every Column to filter after the topmost one, And is already selected for you.

2. Click the down arrow in the And/Or column. Select one of the following:

And

To start a new expression that will be combined with the previous expression by the keyword AND.

Or

To start a new expression that will be combined with the previous expression by the keyword OR.

3. Select remaining criteria from the other columns in the Expression Builder to complete the expression.

4. Click OK.

Note: When the keyword And is used, WebFOCUS only selects data that meet both conditions. When the keyword Or is used, WebFOCUS selects data that meet either condition.

Reference: Using the Variable Editor Dialog Box

You can use the Variable Editor dialog box to specify attributes for parameter filters, such as the name, prompt, type, and list of values.

To access the Variable Editor dialog box from the Expression Builder, point to Parameter in the Compare Type column and click Editor, right click the compare value for a parameter filter and click Edit, or select the Advanced check box and then click Variable.

The Variable Editor dialog box includes the following options:

- **Name.** The name of the parameter.
- **Prompt.** A description for the parameter that appears above it in an Autoprompt form.
- **Variable Type.** Determines the number of values that can be selected and how they will be handled. The parameter can accept a single value, multiple discrete values, or a range of values.
- **Validate Input.** When selected, uses .VALIDATE. syntax. The parameter will not pass any values that do not match its format.
- **Accept List.** Specifies whether the values available for selection are specified explicitly as a static list, retrieved from the data source as a dynamic list, or retrieved from an ACCEPT list in a data source.
If you select Static list, you can add new values by clicking the New button and clicking Add New Item to type them in, or you can double-click field names or values from the Data Context area.

If you select Dynamic list, you can select a data source and then select a field from that source containing the return and display values for the parameter.

If you select Accept list from file, you can select a data source and a field in that data source from which to accept values. Fields that include an ACCEPT list in the Master File are listed in red. Values in the ACCEPT list will be available for use in the parameter. If there is no ACCEPT list for the selected field, only All Values will be available for selection.

Using Filters in the Autoprompt Page

Filters that you define in the Report canvas appear at run time in the autoprompt page. The autoprompt page appears before the report is run and allows users to select the filter values that they want to see in the report.

In the example shown in the following image, there is one filter for Product Category, appearing in the Filter Values area. Using the drop-down arrow in the Product Category field, select the product category that you want to see. Accessories is the selected value in the following image.

If there were multiple filters, the user would see multiple fields in the Filter Values area.

Using the autoprompt page button bar, you can click:

- **Run with filter values.** (Rightmost button) To run the report with the values displayed in the filter fields.

- **Reset filter values.** (Center button) To remove the selected values and display the default values. The default value for a filter is the first valid value, listed alphabetically.

- **Close filter panel.** (Leftmost button) To hide the autoprompt filter panel.
Additionally, you can toggle the hamburger control on the top of the report to reveal or hide the filter panel.

**Chaining Input Controls in the Autoprompt Page**

Chaining lets you link two or more input controls when they call the same dimension hierarchy. For example, if you had chained input controls for State and City, the available list of cities would automatically be limited to those in the specified state. This saves users from scrolling through a list of invalid options when specifying a parameter value.

The Report canvas in App Studio allows for cascading or chaining input controls in the autoprompt page. Chaining is also available in the HTML canvas. For more information, see *Chaining in the HTML Canvas* on page 633.

**Procedure: How to Chain Input Controls in the Autoprompt Page**

When you create a report with a dynamic WHERE filter, an input control prompt displays at run time asking the user to select a value. When you have multiple WHERE filters that reference the same dimension hierarchy, the input controls can be chained together, as detailed in the following procedure.

1. Open the Report canvas and create a report that has two or more columns showing fields from the same dimension. Position the columns in the same order in which they appear in the dimension hierarchy.

   In the example below, we use the Category, Subcategory, and Model fields from the Product dimension of the WF_RETAIL database.

2. On the Report tab, click the down arrow under the Filter command and select *Where*.

   The Expression Builder dialog box is opened.

3. In the Data area, expand the dimension that you used in your columns. Select the first field (which appears in the first column) and drag it down to the Criteria (WHERE) window below.

   The Column to filter field in the main area of the Expression Builder is automatically populated with the field you selected. In the example below, we selected Category.

   Complete the main area as follows:
   a. In the Logical Relation field, select *equals*.
   b. In the Compare Type field, select *Parameter*. From the sub menu, select *Dynamic*.

   The first WHERE filter is complete.

4. Repeat Step 3 for the next field, in order, that you want to include in the chain.

   In the example below, a second filter for Subcategory and a third filter for Model are created.
Note: To support chaining, the WHERE filters must be created individually, as detailed above, in the correct order. A single WHERE filter that references multiple fields will not support chaining.

The following image shows three WHERE filters that will support chaining for the Product dimension.

5. Click OK to close the Expression Builder. Click the Run button on the Quick Access toolbar.

The Autoprompt Filter Values window is displayed.

6. Select values for all filters and click the autoprompt Run button.
A report like the following sample is displayed.

```
<table>
<thead>
<tr>
<th>Product Category</th>
<th>Product Subcategory</th>
<th>Model</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>Televisions</td>
<td>Flat Panel TV</td>
<td>LG 19LE5300 19</td>
<td>$9,381,491.62</td>
</tr>
</tbody>
</table>
```

Note the chain icon in the upper right corner of the Filter Values box. This indicates that the input controls are chained.

**Using a Calendar Control in the Autoprompt Page**

The Report canvas in App Studio allows for calendar input controls in the autoprompt page, when you filter on full date fields. The calendar control appears as shown in the following image.
The default date will display in the calendar control in the language that the user used at sign in. The following image shows the filter pane with the default value in French and the calendar control with the month expanded to show the month values are French.
Calendar input controls are also available in the HTML canvas. For more information, see How to Set Calendar Properties on page 524.

**Procedure: How to Use a Calendar Control in the Autoprompt Page**

1. Open the Report canvas and create a report that you want to filter by time.
2. On the Report tab, click the down arrow under the Filter command and select Where.
   The Expression Builder dialog box is opened.
3. In the Data area, expand a dimension that includes a full date field. For example, in the WF_RETAIL database, the Sales_Related dimension includes Transaction (Time). In this hierarchy, Sale,Day has an attribute Sale,Date that you can use to filter with a calendar control.
   Drag the selected field down to the Criteria (WHERE) window.
   The Column to filter field in the main area of the Expression Builder is automatically populated with the field you selected.
   a. In the Logical Relation field, select equals.
   b. In the Compare Type field, select Parameter. From the sub menu, select Simple.
   The WHERE filter is complete. The calendar is enabled by the (|FORMAT=YYMD) syntax which is automatically inserted in this, and all other expressions.
   **Note:** To support the calendar control, the WHERE filter must be created individually, as detailed above. A single WHERE filter that references multiple fields will not support the calendar control.
4. Click OK to close the Expression Builder. Click the Run button on the Quick Access toolbar.
   The Autoprompt Filter Values window is displayed with the calendar control.

**Customizing a Report Using the Report Group**

You use the options on the Report tab, in the Report group, to customize your reports. For example, you can add a header and footer to your report and include column and row totals. You can also sort the data on your report. The Report group is shown in the following image.
The commands are:

**Header & Footer**

Adds a header, footer, or both to your report. You can define a Report Header, Page Header, Page Footer, or Report Footer. For more information, see *Adding a Header and Footer* on page 251.

**Column Total**

Displays a menu of options for column totals:

- **No Totals.** To show no column totals or to remove existing column totals.
- **Column Totals.** To display totals below each numeric column.
- **Subtotal.** To create a subtotal on the table level. In effect, this creates column totals.
- **Summarize.** To create a summary on the table level. A summary performs calculations any again on total aggregated field values instead of simply summing calculated values, which is useful for reports that contain COMPUTE fields.

- **Recompute.** To create a recompute on the table level. A recompute performs calculations any again on total aggregated field values instead of simply summing calculated values, which is useful for reports that contain COMPUTE fields. When applied to the entire table, Recompute and Summarize behave the same.

For more information, see *Adding Totals to a Report* on page 253.

**Row Total**

Displays totals to the right of each numeric row.

**Row and Column Titles**

The default title for columns and rows appears in the reporting canvas as *(TOTAL)*. At run time, this is automatically translated into the language that you have selected for App Studio. For example, if you have selected Italian, the title appears as *TOTALE*. For more information on setting a language, see *General Tab* on page 45.

To specify a different title:

1. Right-click the total and select *Title* (for row) or *Column Title* (for columns) from the shortcut menu.
   
   The Title dialog opens.

2. Clear the Default Title check box and type the desired title in the Enter Title field.

3. Click OK.
At run time, the title appears as entered. Manual titles are not translated into the language that you have selected for App Studio.

For more information, see Adding Totals to a Report on page 253.

**Precision Report**

Converts your report to a precision report. For more information, see Creating Precision Reports on page 392.

**Compound Document**

Converts your report to a Compound document. The original report remains unchanged while a copy of that report is placed on the Document canvas.

**Universal Concatenation**

Retrieves data from unlike data sources in a single request. Opens the Universal Concatenation dialog box, where you can add the additional data sources to concatenate. For more information, see How to Concatenate Data Sources on page 256.

**Sorted Data**

Assumes that the data is already sorted in the database. If the data you are accessing is already in the correct sort order, you can prevent WebFOCUS from resorting it. This feature provides a fast method of retrieving data if it is already stored in the order required for display, and no further sorting is required.

**Custom Field Placement**

Allows sort fields to be moved from their default location.

**Adding a Header and Footer**

The Header & Footer option in the Report group enables you to add a header or footer to your report, as well as to the page. The following options are available from the Header & Footer drop-down list:

- Report Header
- Page Header
- Page Footer
- Report Footer

When you select one of the header or footer options, a text box displays in the appropriate location on the Report canvas. Type your text or right-click inside the Header or Footer text box to select one of the following options in the shortcut menu:
**Footing Bottom.** Available only in the Page Footer and Report Footer options, it adds a blank line to the bottom of the page or report, as specified.

**Page Break.** Available only in the Report Header and Report Footer options, it adds a page break either before or after the report, as specified.

**Insert Date.** Enables you to select the date format.

**Insert Spotmarker.** Enables you to refine the positioning of a header or footer.

**Alignment Grid.** Inserts grid lines so you can align text with one or more columns in the report.

**Procedure: How to Add Headers and Footers to a Report**

The following steps provide details on adding headers and footers to a report.

1. On the **Home** tab, in the **Content** group, click **Report**, or in the Environments Tree panel, right-click the desired folder, point to **New**, point to **Reporting**, and click **Report**. The Report Wizard opens.

2. Click **Create Report**.

3. On the Report tab, in the Report group, click **Header & Footer**. The following options are available from the Header & Footer drop-down list:
   - Report Header
   - Page Header
   - Page Footer
   - Report Footer

4. Select the type of header or footer you would like to add. A text box is added to the report where you can add the desired text.
   **Note:** You may add as many of the header and footer types as you like to your report or page.

5. Use the Style group on the Report tab to change the font or placement of each header or footer in relation to the report. For more information on the Style group, see *Applying a Theme and Style to a Report Using the Style Group* on page 258.
The following image shows the Report canvas with content added to all four header options.

Adding Totals to a Report

To help interpret detailed information in a report, you can summarize the information using column and row totals, grand totals, and subtotals. You can use these summary lines in a report to clarify or highlight information. You can produce totals for columns or rows of numbers in a report.

- **Column Total.** Inserts a grand total row at the bottom of the report to sum numeric data in each column.

  On the Report tab, in the Report group, click Column Total. Click the down arrow next to Column Total to launch a menu with the No Totals, Column Totals, and Summarize (for calculated values in your row or column totals) options.

  For more information, see How to Create a Report with a Column Total on page 254 and How to Create a Report With a Column Total on Selected Fields on page 254.

- **Row Total.** Inserts a new column containing the sum of all numbers in each row.


  For more information, see How to Create a Report with a Row Total on page 255.

You can use column totals and row totals in matrix reports (created by using a BY sort field and an ACROSS sort field in your report request), rename column and row total titles, and include calculated values in your column or row totals. You can also create row totals using ACROSS-TOTAL.
**Procedure:** How to Create a Report with a Column Total

1. On the **Home** tab, in the **Content** group, click **Report**, or in the Environments Tree panel, right-click the desired folder, point to **New**, point to **Reporting**, and click **Report**.

   The Report Wizard opens.

2. Click **Create Report**.

3. Navigate to where you want to create the new procedure and select a data source. For example, select **wf_retail.mas**.

   The Report canvas opens.

4. Add the following fields to your report in the order shown. You can double-click the fields in the Object Inspector, or drag them to the Report canvas.

   - Product Category
   - Product Subcategory
   - Revenue
   - Gross Profit.

5. On the **Home** tab, in the **Report** group, click **Column Total** and select **Column Totals** from the drop-down menu.

   A grand total row is added at the bottom of the report that sums numeric data in each column.

**Procedure:** How to Create a Report With a Column Total on Selected Fields

1. On the **Home** tab, in the **Content** group, click **Report**, or in the Environments Tree panel, right-click the desired folder, point to **New**, point to **Reporting**, and click **Report**.

   The Report Wizard opens.

2. Click **Create Report**.

3. Navigate to where you want to create the new procedure and select a data source. For example, select **wf_retail.mas**.

   The Report canvas opens.

4. Add the following fields to your report in the order shown. You can double-click the fields in the Object inspector, or drag them to the Report canvas.

   - Product Category
   - Product Subcategory
5. On the Report tab, in the Report group, click Column Total, and select Column Totals, Subtotal, Summarize, or Recompute from the drop-down menu.

A grand total row is added at the bottom of the report that sums numeric data in each column.

6. To add column totals to only specific columns in the report, right-click the Column Total row and select Options.

The General dialog box opens.

7. Select the columns for which you want a column total and click OK.

If you selected Subtotal, Summarize, or Recompute, you can also select a prefix operator to perform an aggregation function on each total value.

**Procedure: How to Create a Report with a Row Total**

1. On the Home tab, in the Content group, click Report, or in the Environments Tree panel, right-click the desired folder, point to New, point to Reporting, and click Report.

   The Report Wizard opens.

2. Click the Create Report button.

3. Navigate to where you want to create the new procedure and select a data source. For example, select wf_retail.mas.

   The Report canvas opens.

4. Add fields to your report. You can double-click the fields in the Object inspector, or drag them to the Report canvas. For example, add the fields listed below to your report in the following order.

   - Product Category
   - Product Subcategory
   - Cost of Goods
   - Discount

A grand total column that sums numeric data in each row is added at the far right of the report.

<table>
<thead>
<tr>
<th>Product Category</th>
<th>Product Subcategory</th>
<th>Cost of Goods</th>
<th>Discount</th>
<th>(TOTAL)</th>
</tr>
</thead>
<tbody>
<tr>
<td>A0000000000&gt;&gt;</td>
<td>A0000000000&gt;&gt;</td>
<td>$111,111,111,111&gt;&gt;</td>
<td>$111,111,111,111 &gt;&gt;</td>
<td>999,999,999.99</td>
</tr>
<tr>
<td>B0000000000&gt;&gt;</td>
<td>A0000000000&gt;&gt;</td>
<td>$111,111,111,111&gt;&gt;</td>
<td>$111,111,111,111 &gt;&gt;</td>
<td>999,999,999.99</td>
</tr>
<tr>
<td>B0000000000&gt;&gt;</td>
<td>B0000000000&gt;&gt;</td>
<td>$111,111,111,111&gt;&gt;</td>
<td>$111,111,111,111 &gt;&gt;</td>
<td>999,999,999.99</td>
</tr>
</tbody>
</table>

**Procedure: How to Concatenate Data Sources**

Universal concatenation specifies how to combine data from sources with dissimilar Master Files.

1. Create the main request.
   
   This contains all the formatting for the resulting report and names the first file to be concatenated. It also contains all printing and sorting information. The fields printed and the sort fields must exist as real or DEFINE fields in each file.

   
   The Universal Concatenation dialog box opens.

3. Click the Add Source button to add additional data sources.
   
   The Open File dialog box appears.

4. Select a Master File and click OK.
   
   If there are temporary HOLD files associated with the procedure, HOLD files are available from the Open dialog box.

   The selected data source is added, showing the Report Field Resolutions and Filters. Additionally, the Define Tool is activated.

   **Note:** If the field names for the selected data source are not the same names and formats as the fields being printed and sorted in the main request, the Universal Concatenation dialog box indicates that you need to define these fields with status icons.

5. Create or modify a field for the universal concatenation with the Define Tool.

   - Click the Define button from the Universal Concatenation toolbar.
   
   or

   - Double-click the field name from the Additional Data Sources list.
   
   The Define Tool opens.
**Note:** The Define Tool opens automatically if the *Create all needed fields for a data source when launching the Define tool* option is selected. This creates the missing defines for the data source. A message appears before the Define Tool opens, stating which DEFINEs will be created and require expressions, followed by a list of the created DEFINE fields. This option is off by default.

- Create the DEFINE expression using the selected universally concatenated Master File, generating the required DEFINEs for the data source to have the same field names and formats as the fields used in the main request.

- Click **OK** to close the Define Tool.

  The DEFINE expression is written in the procedure ahead of the TABLE request.

6. Create selection criteria for the universal concatenation with a filter.

   You may create a filter through a *WHERE* clause.

   - Select the *Where/If* button to open the Expression Builder.

   - To modify or view the filter, double-click the filter expression from the Additional Data Source list to open the Expression Builder.

7. Click **OK** to close the Universal Concatenation dialog box and add the **MORE** command to the procedure.

---

### Setting Conditional Styling Using the Traffic Lights Group

You use the Traffic Lights group to set styling conditions. The Traffic Lights group is shown in the following image.

![Traffic Lights](image)

**Traffic Lights**

Sets the current condition for styling and hyperlinks. Options include:

- **None.** Displays a preview of the report with no visible conditional styling. This is the default.

- **Forecast.** Lets you apply conditional styling to the predictive analytics shown in a forecast column. For more information, see *Overview of Forecasting* on page 316.
Add/Edit Conditions. Opens the Condition List dialog box. From this dialog box, you can define new conditions, and then apply styling to them.

The styling you add to a condition appears as a preview in the Report canvas when you select the condition in the Traffic Lights drop-down list box.

For a sample procedure, see How to Apply Conditional Styling with the Traffic Lights Feature on page 433.

Applying a Theme and Style to a Report Using the Style Group

You use the tools in the Style group to apply stylistic changes to a report, including data, title, and all other components of the report. The Style group is shown in the following image.

This section details the Style group of the Reports tab, which you can use to apply report-level styles. The Style group also appears on the Appearance tab (excluding the Theme commands) which you use to apply field-level styles. For more information, see Styling Data, Titles, and Text Using the Style Group on page 340.

The commands are:

- **Change Theme**
  Changes the theme of the report from a list of available style sheets.

- **Manage Theme**
  References or embeds an external StyleSheet or applies no styling to your report. The WebFOCUS StyleSheet is applied by default. When you click this button, the StyleSheet Selection dialog box opens.

- **Save Theme**
  Saves your current theme options.

- **Scope**
  Indicates the scope to which your changes will apply. For example, if you choose Report, your style changes will be applied to the whole report. If you choose Footing, your changes will be applied to the footer only. You can use the Scope function to apply styling to different areas of your report. The Scope options available from the Report tab are:

  - Report
Note: The (Selected Item) scope is only available when you select a text or field item. The type of item selected will come before (Selected Item). For example, if you have text selected in the Page Footer, the Scope would display Page Footer (Selected Item).

Bold

Applies bold font formatting to the highlighted text or text within a selected object.
**Italic**
Applies italic font formatting to the highlighted text or text within a selected object.

**Underline**
Underlines the highlighted text or text within a selected object.

**No Underline**
Does not display underlines, even for drilldowns.

**Left**
Aligns the highlighted text or text within a selected object to the left.

**Center**
Aligns the highlighted text or text within a selected object to the center.

**Right**
Aligns the highlighted text or text within a selected object to the right.

**Default**
Aligns the highlighted text or text within a selected object to the default alignment option. This aligns numbers to the right and text to the left.

**Report Width**
Sets report width options.

**Copy Style**
Copies the current style settings, enabling the Paste Style button.

**Paste Style**
Pastes the copied style settings.

**Font Name**
Changes the font of the highlighted text or text within a selected object. Fonts are listed in alphabetical order.

**Font Size**
Changes the font size of the highlighted text or text within a selected object. Font sizes range from 8 to 72 (whole numbers only).

**Color**
Changes the font color of the highlighted text or text within a selected object. Applies the color change to the selected Scope. Opens the Color dialog box, where you can select the font color.
**Background Color**
Changes the background color of the highlighted text or text within a selected object. Applies the color change to the selected Scope. Opens the Color dialog box, where you can select the background color.

**Defaults**
Resets the style settings of the highlighted text or text within a selected object to the default (original) style.

**Borders/Grid**
Turns on or disables borders and grid lines. You can apply borders and gridlines to HTML, Excel, and PDF reports. For all other report types, this option is disabled.

**User Style**
Enables you to set User Format Style Blocks, if available.

**Referencing or Embedding a Style Sheet Using the StyleSheet Selection Dialog Box**
The StyleSheet Selection dialog box enables you to reference or embed an external style sheet, use the default WebFOCUS StyleSheet, or apply no styling to your report. You may also save and include multiple style sheets. The StyleSheet Selection dialog box is accessible from the Style group on the Report canvas ribbon.

The StyleSheet Selection dialog box provides the following capabilities:

- Include a StyleSheet.
- Apply an external cascading style sheet (CSS).
- Embed a StyleSheet.
- Apply the default WebFOCUS StyleSheet.
- Save the modified style sheet as a new style sheet file (.sty).

To open the StyleSheet Selection dialog box, on the Report tab, in the Style Group, click Manage Theme.

**Note:** The StyleSheet Selection dialog box opens to the Include StyleSheet File section, since every procedure has existing embedded styling, by default. You may click Change Options and choose to embed or reference an external StyleSheet, use the WebFOCUS default StyleSheet, or turn off all report styling, as described in the following procedures.
**Procedure:** How to Include a StyleSheet in a Report

Since every procedure has existing styling, the Include StyleSheet File section opens, by default.

When a StyleSheet is included, part of the styling is embedded in the report. You may include StyleSheets up to an INCLUDE depth of three in your report, with the last selected StyleSheet having precedence.

1. On the Report tab, in the Style group, click Manage Theme.
   The StyleSheet Selection dialog box opens.

2. Click the Add new item button.
   The Open File dialog box opens.

3. Select a StyleSheet file and click OK.

4. Optionally, you may select to include additional StyleSheets, up to an INCLUDE depth of three in your report.

   **Note:** The last selected StyleSheet has precedence in the report. You may use the arrows to reorder the arrangement of StyleSheets.

   The following syntax will be added to the procedure for the included StyleSheets.

   ```
   ON TABLE SET STYLE *
     INCLUDE = citrus,
   $
     INCLUDE = teal,
   $
     INCLUDE = olive,
   
   ```

5. Click Finish to close the StyleSheet Selection dialog box.

6. Optionally, you may apply styling options from the Report canvas and save the StyleSheet code using the Save Theme command, in the Style group, on the Report tab.

**Procedure:** How to Apply an External Cascading Style Sheet (CSS)

In addition to applying StyleSheets to your report, you may apply an external cascading style sheet to your report. An external cascading style sheet (CSS) is an extension to HTML that enables you to specify formatting for an HTML document. To link the CSS to the report, use the External Cascading Style Sheet URL field in the StyleSheet Selection dialog box.
Note: An external cascading style sheet is only applicable when using the HTML report output format.

1. On the Report tab, in the Style group, click Manage Theme.
   The Stylesheet Selection dialog box opens.

2. Type a name of the customized StyleSheet (.css) in the External Cascading StyleSheet URL input field.
   
   Note: The external CSS (cascading style sheet) file should be saved in an alias on the web server.

3. Optionally, you may include StyleSheets to be added to the report.
   
   Note: A CSS file is separate from a StyleSheet file and can exist on its own.

4. Click Finish to close the StyleSheet Selection dialog box.

Procedure: How to Embed a StyleSheet in a Report

Embedding a StyleSheet stores your style information within the report, from which you can read an existing file as a starting point, start with an empty style, or leave the current StyleSheet contents without any modifications.

1. On the Report tab, in the Style group, click Manage Theme.
   The StyleSheet Selection dialog box opens.

2. Click Change Options to change the StyleSheet Selection dialog box options. The StyleSheet Selection dialog box displays.

3. Accept the default, Normal Embedded Styling, and click Next.

4. To read an existing file as a starting point:
   a. Select Initialize with the contents of a pre-existing file.
      
      Note: Preserve referenced StyleSheets so any “INCLUDE=name” will not be deleted is selected, by default. When a StyleSheet is included, a reference of the StyleSheet is added to the report syntax as INCLUDE=name. This reference is added to the existing style information already in the TABLE request.

   b. Click Next.
      The StyleSheet File Selection dialog box appears.

   c. Select a Predefined Template file to use as your starting point and click OK.
The selected StyleSheet file is shown as the origin embedded StyleSheet file. Optionally, you may include additional StyleSheets or add an External cascading style sheet (CSS).

d. Click Finish to close the StyleSheet Selection dialog box.

The selected StyleSheet code is imported into the procedure and overwrites any existing styling in the report.

5. To start with an empty style:
   a. Click Change Options to change the StyleSheet Selection dialog box options.
   b. Keep Normal Embedded Styling selected and click Next.
   c. Select Start fresh with an empty StyleSheet.

   **Note:** Preserve referenced StyleSheets so any “INCLUDE=name” will not be deleted is selected, by default. When a StyleSheet is included, a reference of the StyleSheet is added to the report syntax as INCLUDE=name. This reference is added to the existing style information already in the TABLE request.

d. Click Next.

The Include StyleSheet File section opens indicating that the origin of the embedded StyleSheet file is unknown.

   **Tip:** You may select StyleSheet files to embed to your currently empty style.

e. Click Finish to close the StyleSheet Selection dialog box.

f. Click OK to close the StyleSheet Selection dialog box.

Starting with an empty style clears any styling from the report and initializes a procedure with the WebFOCUS default style code (basic styling that is used when styling is not specified).
The Include StyleSheet File section opens indicating that the origin of the embedded StyleSheet file is unknown.

**Tip:** You may include StyleSheets to be added to the report.

1. Click **Finish** to close the StyleSheet Selection dialog box.

7. Optionally, you may apply styling options from the Report canvas and save the StyleSheet code.

**Procedure:** **How to Apply the Default WebFOCUS StyleSheet**

The WebFOCUS Default Styling section applies the default StyleSheet to your report, with no styling visible in the procedure.

**Note:** The default WebFOCUS StyleSheet disables any styling options in the report. No further styling options of any kind can be applied to the report.

1. On the **Report** tab, in the **Style** group, click **Manage Theme**.

   The StyleSheet Selection dialog box opens.

2. Click **Change Options** to change the StyleSheet Selection dialog box options.

3. Select **WebFOCUS Default Styling** and click **Finish**.

   **Tip:** To remove the default WebFOCUS StyleSheet and enable styling, click the **Style File Selection** button to open the StyleSheet Selection dialog box and select the **Normal Embedded Styling** option.

**Procedure:** **How to Reset the Default Report Canvas Styling**

To reset the default the Report canvas styling in the StyleSheet Selection dialog box:

1. On the **Report** tab, in the **Style** group, select **Manage Theme**.

   The StyleSheet Selection dialog box opens.

2. Highlight the added StyleSheet files (.sty) listed in the Include StyleSheet File section and click **Delete selected items (Del)**.

**Procedure:** **How to Save a StyleSheet**

After including StyleSheets and applying styling options from the Report canvas, you may save the StyleSheet as a new StyleSheet file (.sty).

1. On the **Report** tab, in the **Style** group, click **Save Theme**.
The Save As dialog box opens.

2. Type a name for the StyleSheet in the File name input field and click OK.

The .sty file is saved in the working directory. You may browse to select a different location.

**Tip:** The saved StyleSheet can be included in other reports from the StyleSheet File Selection dialog box.

**Reference:** Usage Notes for the StyleSheet Selection Dialog Box

The following apply when using the StyleSheet Selection dialog box in the Report canvas:

- Applying StyleSheets through the StyleSheet Selection dialog box follows the same rules of WebFOCUS StyleSheet inheritance. For details, see WebFOCUS StyleSheet Attribute Inheritance in the Creating Reports With WebFOCUS Language manual.
- When including or referencing a StyleSheet that is not in the current application, the StyleSheet gets copied to the working directory.
  
  If the StyleSheet already exists in the current application, it does not get overwritten.
  
  To refresh an existing StyleSheet, you must copy the new StyleSheet to the working directory or remove the StyleSheet from the procedure, delete it from the working directory, and then add it back to the procedure.

- The default location for StyleSheets that are Included or referenced in App Studio is `drive: \AppStudion\ibi_html\javaassist\int\locale\combine_templates`, which contains a set of sample StyleSheets. You can also search other WebFOCUS locations for available StyleSheets.

- When a StyleSheet is used in the procedure and the StyleSheet Selection dialog box is opened, it opens in the Include StyleSheet File section, enabling you to change the included StyleSheet. You may also change the StyleSheet options. This occurs even when the Defaults option (located in the Style group on the Report canvas ribbon in App Studio) is clicked.

  **Note:** If you go back and select to embed or reference a StyleSheet, or use the WebFOCUS default option, the StyleSheet that was in the report will get overwritten.

- If the report does not have any styling, the StyleSheet Selection dialog box opens to the Change Options section. The report code contains the command:

  ```on table set style off```
Assigning a Color Value Using the Color Dialog Box
The Color dialog box lets you choose a color by selecting it from the color palette or entering a hexadecimal value.

**Procedure: How to Access the Color Dialog Box**
1. On the Report tab, in the Style group, click Color or Background Color.
   The Color dialog box displays.
2. Click Default to restore the formatting back to its original state.
3. Click Custom to access custom coloring.
4. Click OK to close the Color dialog box.

Adding Borders to a Report Using the Borders Dialog Box
You use the Borders dialog box to add borders to your report.

**Procedure: How to Add Borders to an HTML, Excel, or PDF Report**
You can add borders to an entire report, a column, or another object area, such as a heading or footing.

**Note:** You must remove grids from the report, column, or object area before you can apply borders.

You can set borders to a report globally, so that they will apply to all objects you subsequently add to the report.

**Note:** Ensure that HTML, Excel, or PDF is selected as the report output format on the Format tab.

To set global borders:
1. On the Report tab, in the Style group, click Borders/Grid and then click Borders, or right-click the Report canvas area and click Borders.
   The Borders dialog box opens.
   **Note:** By default, the Make all borders the same option is selected.
2. To specify border settings for the top, bottom, left, and right borders, click the Make all borders the same check box to disable that option. Make your border selections:
   - Select the following options from the Width drop-down list:
     - OFF to turn borders off. (This is the default.)
LIGHT to apply thin border lines.

MEDIUM to apply medium border lines.

HEAVY to apply thick border lines.

From the Style drop-down list, select a line style.

From the Color drop-down list, select a color.

After you select your border width, style, and color selections, you can see them in the Border Preview window in the Borders dialog box.

Note: You can restore the original default borders by clicking the Default button.

3. Click OK.

To apply a border to a column:

1. Select the column to which you want to apply a border.

2. On the Appearance tab, in the Style group, select an option from the Scope drop-down command. The options are:

   Data and Title applies grids to the column title and data.

   Data Only applies grids to the column data.

   Title Only applies grids to the column title.

3. On the Appearance tab, in the Style group, click Borders.

   The Borders dialog box opens.

4. To specify border settings for the top, bottom, left, and right borders, select the Make all borders the same check box to turn off that option.

5. Make your border selections:

   Click the down arrow in the Width drop-down list box and select:

   OFF to turn borders off. (This is the default.)

   LIGHT to apply thin border lines.

   MEDIUM to apply medium border lines.

   HEAVY to apply thick border lines.

   From the Style drop-down list, select a line style.

   From the Color drop-down list, select a color.
After you select your border width, style, and color selections, you can see them in the Border Preview window in the Borders dialog box.

**Note:** If the OFF option is selected in the Width drop-down list, no borders will be shown.

6. Click OK.

**To apply a border to cells in a header, footer, subheader, or subfooter:**

You can divide a header or footer into cells, which you can align to columns in the report. In PDF, PowerPoint PPTX, and DHTML formats, you can add borders to all header, footer, subheader, or subfooter cells at once.

1. On the Format tab, in the Output Types group, click PDF to set the output format to PDF, click PowerPoint and then click PowerPoint PPTX to set the output format to PowerPoint PPTX, or click Output Format, point to Styled report formats, and click DHTML Web Document (DHTML) to set the output format to DHTML.

2. Optionally, set output format options in the Output Format Options dialog box.

3. Add fields to the report.

4. On the Report tab, in the Report group, click Header & Footer and click Report Header, Page Header, Page Footer, or Report Footer, or select a field and, in the Field tab, in the Break group, click Subheader or Subfooter.

5. Right-click the header, footer, subheader, or subfooter and click Alignment Grid.

The Insert Alignment Grid dialog box opens.

6. Select Align with Data to make the cells in the header, footer, subheader, or subfooter line up with the cells in the report.

7. Use the Number of lines option to set the number of rows in the header or footer grid.

8. Use the Default justification or Decimal alignment options to specify how text is aligned in each cell.

9. On the Report tab, in the Style group, select the header, footer, subheader, or subfooter object that you added a grid to from the Scope menu.

10. On the Report tab, in the Style group, click Borders/Grid and then click Borders.

The Borders dialog box opens.

11. Select the Border all cells in the grid check box to add the same borders to every cell in the header, footer, subheader, or subfooter grid.

12. Make your border selections:

   - Click the down arrow in the Width drop-down list box and select:
   - OFF to turn borders off. (This is the default.)
LIGHT to apply thin border lines.

MEDIUM to apply medium border lines.

HEAVY to apply thick border lines.

- From the Style drop-down list, select a line style.
- From the Color drop-down list, select a color.

After you select your border width, style, and color selections, you can see them in the Border Preview window in the Borders dialog box.

**Note:** If the OFF option is selected in the Width drop-down list, no borders will be shown.

13. Click OK.

14. When you run the report, all of the cells in the header, footer, subheader, or subfooter use the specified borders.

**To apply a border to another object area:**

1. On the Report tab, in the Style group, select an option from the Scope drop-down command.
   - The options are:
     - Report
     - Title
     - Data
     - Report Header
     - Report Footer
     - Page Header
     - Page Footer
     - Subhead
     - Subfoot
     - Subtotal
     - Subtotal Tag
     - Across Title
     - Across Data
2. On the Report tab, in the Style group, click Borders/Grid and then click Borders.

   The Borders dialog box opens.

3. To specify border settings for the top, bottom, left, and right borders, select the Make all borders the same check box to turn off that option.

4. Make your border selections:

   - Select the following options from the Width drop-down list:
     - OFF to turn borders off. (This is the default.)
     - LIGHT to apply thin border lines.
     - MEDIUM to apply medium border lines.
     - HEAVY to apply thick border lines.

   - From the Style drop-down list, select a line style.
   - From the Color drop-down list, select a color.

   After you select your border width, style, and color selections, you can see them in the Border Preview window in the Borders dialog box.

   **Note:** If the OFF option is selected in the Width drop-down list, no borders will be shown.

5. Click OK.
Specifying a Width Limit for a Value Using the Width Options Dialog Box

The Width Options dialog box allows you to set how values will be handled if they extend the report cell. You can also enter a value to specify a limit for how large or small a value can be before these options take effect.

Procedure: How to Set Width Options for a Report


   The Width Options dialog box displays.

2. From the <not set> drop-down dialog box, select one of the following options:
   - Minimum
   - Maximum
   - Truncate
   - Wrap
   - Wrap Off

3. Indicate a value (in inches) by which to limit the width of the report.
   
   Note: This only applies to Truncate and Wrap.

4. Click OK.

Specifying Styling for User Selected Output Formats Using the User Format Menu

If the output format for a report is set to user selection, the User Format menu becomes available. You can specify different styling for each available format by expanding the User Format menu, pointing to Create new empty styling block or Copy active styling to, and selecting an output format, as shown in the following image.
Once an output format is selected, styling changes that you make are applied only when that format is selected at run-time. Styling for the General output selection is applied to all output formats for which styling is not explicitly applied.

Selecting a format from the Create new empty style block submenu clears all styling for that for the selected format, including the StyleSheet. You can then style the report for the selected format.

If you point to Copy active styling to and then click an output format, you can copy the styling defined for another output format or for general output. Click the User Format menu, point to Activate style block, and select an output format to make additional changes specific to the selected format.

If you have multiple output format styles defined, you can point to Copy styling from and select an output format to apply the styling from that format to the active output format.

To reset the styling changes made for the active output format, open the User Format menu and click Clear current style block. To remove the specified styling for an output format entirely and instead use the styling specified for the General output type, click Delete current style block.

**Procedure:** How to Specify Styling for User Selected Output Formats

2. On the Format tab, in the Output Types group, click Output Format, point toStyled report formats, and click User.
   
   The User Format Selection dialog box opens.
3. Clear the check boxes for any output formats that you do not want to be available at run time. Optionally, click the double-arrows in the Options column to specify output format options for each available format, and change the text that displays in the user selection prompt at run time by changing the text in the Enter text for the WFFMT prompt text box.
4. Click OK.
   
   On the Report tab, in the Style group, the User Format menu becomes available. It is initially set to General, allowing you to style the report for any output formats that do not have their own styling explicitly specified.
5. Optionally, use the commands in the Style group to style the report for general output.
6. Configure separate styling for an available output type using one of the following methods.

   - In the User Format menu, point to Create new empty style block and click an output format. The selected output format now uses its own style settings, and currently has not styling characteristics defined. The StyleSheet has also been removed for the selected output format. The selected output format is now active for editing.
In the User Format menu, point to Copy active styling to and click an output format. The selected output format now uses its own style settings, copied from the styling for the active output format.

**Note:** Styling characteristics are copied to the selected output format, but that output format is not active for editing. To activate the selected output format, click the User Format menu, point to Activate style block, and select the output format that you want to edit.

7. Optionally, use the commands in the Style group to style the report for the active output format.

8. Repeat steps 6 and 7 for any other output formats that you want to have their own unique styling.

9. Run the report.

When you run the report with an output format for which you have defined unique styling, that styling is applied. When you run the report with an output format that you did not style separately, the styling characteristics defined for general output are used.

**Creating Drill-Down Hyperlinks Using the Drill Down Command**

You can use the Drill Down command in the Links group to create hyperlinks in your report. These hyperlinks allow you to see more detail in the ad-hoc reports that are automatically created when you click a link. The Drill Down command is shown in the following image.

![Drill Down](image)

The Drill Down command appears in both the Report and the Appearance tabs. The resulting hyperlinks differ, depending on the tab you invoke the command from.

- The **Report tab** Drill Down command creates hyperlinks in every field in the report.
- The **Appearance tab** Drill Down command creates hyperlinks only in the fields of the specified column.

**Procedure:** How to Create Drill-Down Hyperlinks

1. On the Report tab (for links in every field) or Appearance tab (for links in a column only), in the Links group, select Drill Down.

The Drill Down dialog box displays.
2. Click the *Add new item* button on the Drill Down dialog box toolbar.

   The Drill Down fields are enabled.

3. In the Drill Down dialog box:
   a. The Drill Menu Items field is automatically populated with a default drill-down name. You may rename it as needed, or delete the name if you are using only one drill down.
   b. Select one of the following Drill Down Types from the drop-down menu:
      - Execute Procedure
      - Execute Guided Procedure
      - URL
      - URL from field
      - JavaScript
      - Refresh BI Portal

   **Note:** The *Refresh BI Portal* drill-down type will be displayed only when you are working with a report that was created in the Content development area.
   c. Double-click in the Source field.
      - If you selected the *Execute Procedure* Drill Down Type, the Open File dialog box opens.
        Select the procedure to drill to and click *OK*.
      - If you selected the *Execute Guided Procedure* Drill Down Type, the Guided DrillDown dialog box opens. For more information, see *How to Create Guided Drill Down Hyperlinks* on page 276.
      - If you selected the *URL* Drill Down Type, type a fully qualified URL to drill to.
      - If you selected the *URL from field* Drill Down Type, select a source field from the drop-down menu which contains the URL to drill to.
      - If you selected the *JavaScript* Drill Down Type, enter the function to drill to. In the Parameters field (Step 4 below), type the arguments for the function.
      - If you selected the *Refresh BI Portal* Drill Down Type, select *Current page only* or *All pages in portal* to refresh when the drill down is triggered.
d. Select a Target Frame from the drop-down menu:

- _blank opens the target procedure in a new window.
- _self opens the target procedure in the same window as the source. This is the default. In addition, it is the only option available if you selected the Refresh BI Portal drill down type.
- _parent opens the target procedure in the same frame as the anchor.
- _top opens the target procedure in the current window.

e. Double-click in the Parameters field.

The Parameters dialog box opens.

4. Click the Add new item button on the Parameters dialog box toolbar.

The Parameter fields are enabled.

5. In the Parameters dialog box:

a. The Parameter Name field may appear, depending on the Drill Down Type you selected. Select a name from the drop-down menu or, if no drop-down menu appears, type a parameter name.

b. Select a parameter type from the drop-down list box:

- Field allows you to select a specific field from the Parameter Value drop-down menu.
- Constant Value allows you to specify a constant value for the parameter in the Parameter Value field.
- Variable allows you to specify a variable for the parameter in the Parameter Value field.

6. Click OK.

The Parameters dialog box closes and you return to the Drill Down dialog box.

7. Click OK.

The Drill Down dialog box closes.

Procedure: How to Create Guided Drill Down Hyperlinks

1. On the Report tab (for links in every field) or Appearance tab (for links in a column only), select Drill Down.

The Drill Down dialog box opens.
2. Click the *Add new item* button on the Drill Down dialog box toolbar.
   The Drill Down fields are enabled. The Drill Menu Items field is automatically populated with a default drill-down name. You may rename it as needed, or delete the name if you are using only one drill down.

3. In the Drill Down type list, click *Execute Guided Procedure*.

4. Double-click in the Source field.
   The Guided DrillDown dialog box opens.

5. Click *Browse*.
   The Open File dialog box opens.

6. Select the drill-down procedures that you want to use.
   To select multiple procedures, hold down the Ctrl key and click the procedures.

7. Click *OK*.
   You are returned to the Guided DrillDown dialog box, with the selected procedures displayed in the procedures list box.

8. Optionally, use the procedures list box toolbar to change the order of the procedures, undo or redo changes, or delete a procedure from the list.

9. To add parameters for a procedure, select it in the procedures list box, then click *Add* in the Parameters list box.
   The Drill Down Parameter dialog box opens.

10. In the Drill Down Parameter dialog box, do the following:
    a. Type a parameter name in the Parameter name field.
    b. To specify a field as a parameter value, select *Field* and use the drop-down list to select a field from the highlighted procedure.
    c. To specify a constant value as a parameter value, select *Constant value* and type the value in the available field.
    d. To change the wording of the prompt that displays when users select a drill down procedure, type the new wording in the Prompt field.

11. Click *OK*.
    You are returned to the Guided DrillDown dialog box.

12. Click *OK*.
    You are returned to the Drill Down dialog box.
13. In the Drill Down dialog box, select a Target Frame from the drop-down menu. The available options are:

- `_blank` opens the target procedure in a new window.
- `_self` opens the target procedure in the same window as the source.
- `_parent` opens the target procedure in the same frame as the anchor.
- `_top` opens the target procedure in the current window.

14. Click OK.

The Drill Down dialog box closes.

Creating a PDF Compound Report With Drill Through Links

A common technique in business reporting is to create two related reports:

- **Summary Report.** Contains condensed information for a category such as a business account, with summed data such as total balances and total sales.

- **Detail Report.** For specified fields in the associated summary report, a detail report contains all the component values that contributed to each summary field value.

Drill Through provides a way to easily relate the data in these two types of reports. For example, a user scanning a summary report account may see an unusual figure in one of the accounts, requiring examination of the specific data behind that figure.

Drill Through Compound Layout Reports use document syntax declarations to create the compound procedure and define which reports will be related through hyperlinks.

**Reference:** Drill Through and Drill Down Compared

Using Drill Down, you can construct a summary report in which clicking a hyperlink displays detail data. A Drill Down is implemented dynamically. Clicking a hyperlink causes a new report to run. The detail report typically displays only the detail data for a selected field on the summary report.

In contrast, Drill Through reports are static. Drill Through creates a PDF document that contains the summary report plus the detail report, with the detail report containing all the detail data for designated fields in the summary report. Clicking a Drill Through hyperlink navigates internally in the PDF file. No additional reports are run. You can save the PDF file to disk or distribute it using ReportCaster. When opened with Adobe Reader, it retains its full Drill Through functionality.
Drill Through provides flexibility in the appearance of reports and location of hyperlinks:

- Drill Through hyperlinks may appear in headings and subheadings, as well as, in rows of data.
- You can format the reports using a WebFOCUS StyleSheet.
- You can indicate a hyperlink by color, font, underlining, and so forth.
- You can mix conventional Drill Down hyperlinks freely in the same report with Drill Through hyperlinks.
- The PDF file created with Drill Through can consist of more than two reports.

**Reference:** Use With Other Features

You can use Drill Through with other WebFOCUS features:

- Compound reports that contain linked Drill Through reports may also contain unrelated reports, before or after the Drill Through reports. For example, you can add to the compound report package a PDF report that contains embedded graphs.
- You can add Drill Down and URL hyperlinks to a PDF report that contains Drill Through hyperlinks.
- Since Drill Through reports are standard PDF compound reports packaged into a single PDF file, you can distribute them using ReportCaster.
- Reports with DRILLTHROUGH syntax can be rendered in all other styled output formats: HTML, PostScript, XLSX, and so on. In these other formats, the DRILLTHROUGH syntax is ignored. It is useful, for example, to generate a PostScript version of a Drill Through report, which is formatted identically to the PDF version, but which you can send directly to a PostScript printer using ReportCaster or operating system commands.
- Drill Through automates the process of navigating quickly and easily from general to specific information in related reports packaged in a single PDF compound report. Drill Through syntax sets up hyperlinks that take you from an item in a summary report to a corresponding item in a detail report.

**Procedure:** How to Create a Drill Through in a PDF Compound Layout Report

To create a Drill Through in a PDF Compound Layout report:

1. Create the summary report with a DRILLTHROUGH hyperlink.
2. Create the detail report with sort values that match the hyperlink field values.
3. Create the Compound Layout report with page layouts for each component report, and define a DRILLMAP attribute within the calling report to specify the targets of the drill through hyperlinks.

**Procedure:** How to Create a Drill Through in a PDF Compound Report

To create a Drill Through in a PDF Compound Report:

1. Create the summary report.
2. Create the detail report.
3. Connect the reports with hyperlinks.
4. Merge the summary and detail reports into a PDF compound report.

**Reference:** Usage Notes for Drill Through

- Individual component reports containing Drill Through designations can be run standalone. You will see a warning message in the Message Viewer indicating that outside of the compound report, the Drill Through will not be active.

- Only one Drill Through behavior can be specified per report.

- The field specified to contain a Drill Through behavior must also be present in the target report.

- The originating report containing the Drill Through link must be rendered (by the Reporting Server) prior to the target report. The order of reports must be handled by the user.

- Live Drill Through links are only generated for PDF output. Reports with DRILLTHROUGH syntax can be rendered in all other styled output formats: HTML, PostScript, XLXS, and so on. In these other formats, the DRILLTHROUGH syntax is ignored. It is useful, for example, to generate a PostScript version of a Drill Through report, which is formatted identically to the PDF version, but which you can send directly to a PostScript printer using ReportCaster or operating system commands.

- Drill Through is only supported for reports (TABLE).

**Procedure:** How to Create the Summary Report (Step 1)

The following procedure generates a sample summary report.

2. Add the following fields to your report in the following order. You can double-click the fields in the Object Inspector, or drag them to the Report canvas.

- Category (By)
- Product (By)
- Units (Sum)
- Dollars (Sum)

3. On the Format tab, in the Output Types group, click PDF.

   The Output Format Options dialog box opens.

4. Optionally, change the output format options, or click OK.

5. Save and run the report.

   The output is:

   ![Detail Report Table]

   **Procedure:** How to Create the Detail Report (Step 2)

   The following procedure generates a sample detail report.

   2. From the Procedure View, right-click Comment, point to New, and then click Set.
   3. From the Available Settings pane, select SQUEEZE, click Add, and set Current Value to On.
4. Add the following fields to your report in the following order. You can double-click the fields in the Object Inspector, or drag them to the Report canvas.

- Category (By)
- Product (By)
- Units (Sum)
- Budunits (Sum)
- Dollars (Sum)

5. Right-click the Category field and set Invisible to On.

6. Right-click the Product field and set Invisible to On.

7. Select the Category field, and from the Field tab, in the Break group, set Page-Break to On.


9. Double-click the Page Heading field:
   a. Type Category:
   b. From the Object Inspector, double-click the Category field. This inserts the Category value in the heading of the report.
   c. Press Enter to add a blank line between the heading and the report.
   d. Right-click and from the Styling toolbar, select Center.

10. Select the Product field, and from the Field tab, in the Break group, select Subheader.

11. Double-click the Subheading field:
    a. Type **** Product:
    b. From the Object Inspector, double-click the Product field. This inserts the Product value in the subheading of the report.

12. Select the Product field, and from the Field tab, in the Break group, select Subfooter.

13. Double-click the Subfooting field:
    a. Press Enter to add a blank line between the report and the footer.
    b. Type <15 **** Return to Summary ****.

14. Select the Product field, and from the Field tab, in the Break group, set Page-Break to On.

15. Add the Region and City fields, as sort fields, to the report after the Product field.

16. On the Format tab, in the Output Types group, click PDF.
    The Output Format Options dialog box opens.
17. Optionally, change the output format options, or click OK.

18. Save and run the report.

The output is:

![Image of report output]

**Procedure:** How to Create the Summary Hyperlink Report (Step 3)

The following procedures describe how to use the Drill Through feature to create a compound report with a summary and detail report and navigate between them.

The example illustrates the following:

When you place a Drill Through hyperlink on a sort-break element, ensure the sort-break is at least at the level of the last sort field participating in the Drill Through. For example, in the second report, the Drill Through hyperlink is on the subfooting associated with PRODUCT rather than the heading (with a sort break) associated with CATEGORY.
Although the code can infer a value of PRODUCT for the CATEGORY heading (you can verify this by embedding the field <PRODUCT> in the heading), it is always the value of the first PRODUCT within that CATEGORY. Typically you want a Drill Through hyperlink for each value of PRODUCT within each CATEGORY.

You do not need to place the hyperlink on an embedded item. You can just as effectively place it on a text item. Any item in the subfooting is associated with the same values of CATEGORY and PRODUCT. Similarly, you can place a hyperlink on any field in a DATA line, and the values of the associated link fields will be identical. Conventional Drill Down hyperlinks also work this way.

The summary report:

- Places a hyperlink on the PRODUCT field on each DATA line.
- Specifies that the fields to link to the next report are CATEGORY and PRODUCT. Since the target fields in the detail report have identical names in the summary report, you can use the notation CATEGORY rather than CATEGORY=CATEGORY.
- Specifies the action DOWN, so that clicking a hyperlink brings you to the location in the next report that has the corresponding values of the two link fields.
- Uses the default appearance for the hyperlinks, which is blue, underlined text.

1. Open the report you created in Creating the Summary Report (Step 1).
2. Select the Product field, and on the Appearance tab, in the Style group, select Data Only from the Scope drop-down menu.
3. On the Appearance tab, in the Links group, select Drill Down.
   The Drill Down dialog box displays.
4. Click the Add new item button on the Drill Down dialog box toolbar.
   The Drill Down fields are enabled.
5. In the Drill Down dialog box:
   a. From the Drill Down Types drop-down menu, select Drill Through.
   b. From the Source drop-down menu, select Down.
   c. Double-click in the Parameters field.
   The Parameters dialog box opens.
6. Click the Add new item button on the Parameters dialog box toolbar.
   The Parameter fields are enabled.
7. In the Parameters dialog box:
   a. From the Parameter Value drop-down menu, select the Category field.
   b. Click the Add new item button on the Parameters dialog box toolbar.
   c. From the Parameter Value drop-down menu, select the Product field.
   d. Click OK.
      The Parameters dialog box closes and you return to the Drill Down dialog box.
8. Click OK.
      The Drill Down dialog box closes.
9. Save the report.

Procedure: How to Create the Detail Hyperlink Report

The detail report:

☐ Places a hyperlink in the subfooting associated with the link field PRODUCT. Since CATEGORY is a higher level BY field than PRODUCT, each PRODUCT subheading is also associated with a unique value of CATEGORY.

☐ Places a hyperlink on the first item of the second line of the subfooting, which is the text Return to Summary.

☐ Specifies action FIRST, so that clicking the hyperlink jumps to the line in the first (summary) report that contains the same values of the two link fields CATEGORY and PRODUCT.

1. Open the report you created in Creating the Detail Report (Step 2).
2. Select the **** Return to Summary **** line in the Subfoot field.
   The Drill Down dialog box displays.
4. Click the Add new item button on the Drill Down dialog box toolbar.
   The Drill Down fields are enabled.
5. In the Drill Down dialog box:
   a. From the Drill Down Types drop-down menu, select Drill Through.
   b. From the Source drop-down menu, select First.
   c. Double-click in the Parameters field.
      The Parameters dialog box opens.
6. Click the Add new item button on the Parameters dialog box toolbar.
   The Parameter fields are enabled.

7. In the Parameters dialog box:
   a. From the Parameter Value drop-down menu, select the Category field.
   b. Click the Add new item button on the Parameters dialog box toolbar.
   c. From the Parameter Value drop-down menu, select the Product field.
   d. Click OK.
   The Parameters dialog box closes and you return to the Drill Down dialog box.

8. Click OK
   The Drill Down dialog box closes.

9. Save the report.

**Procedure: How to Create the Compound Layout Report (Step 4)**

Perform this version of Step 4 if you are creating a Compound Layout report.

To create the Compound Layout report:

- Add a COMPOUND LAYOUT and SECTION declaration to the top of the procedure.

- Add PAGELAYOUT and COMPONENT declarations for the two reports. Add DRILLMAP attributes to the COMPONENT declarations.

- Add SET COMPONENT commands and the two reports.

- End the procedure with a COMPOUND END command.

1. On the Home tab, in the Content group, click HTML/Document, or in the Environments Tree panel, right-click the desired folder, point to New, and click HTML/Document.
   The HTML/Document Wizard opens.

2. In the File Type area, select Document.

3. Navigate to where you want to select a recent procedure.

   **Note:** If you used the shortcut menu in the Environments Tree panel to create your document, a location is already selected.

4. Click Next to set the Document Properties.
   The Document Properties dialog box opens.

5. From the Output Format list, choose PDF.
6. Click Finish.
   The Document canvas and Properties panel open.

7. Insert a report component.

8. Right-click the report and select Reference existing procedure.

9. Select the summary procedure and click OK.

10. Right-click the Document canvas and select Insert new page after.

11. Insert a report component.

12. Right-click the report and select Reference existing procedure.

13. Select the detail procedure and click OK.


15. Select the Detail report and in the Properties panel, select the Summary report for the Drill Through Destination parameter.

16. Save and run the report.

Procedure: How to Run the Drill Through Report (Step 5)

When you run the drill down report, the first page of output has the summary report with the hyperlinks to the individual products in blue and underlined, as shown in the following image.
Click the Croissant hyperlink for the Food category. You jump to the detail information. In the detail report, the hyperlink back to the summary report is underlined, as shown in the following image.

### Category: Food

<table>
<thead>
<tr>
<th>Region</th>
<th>City</th>
<th>Unit Sales</th>
<th>Budget Units</th>
<th>Dollar Sales</th>
</tr>
</thead>
<tbody>
<tr>
<td>Midwest</td>
<td>Chicago</td>
<td>43300</td>
<td>43271</td>
<td>549366</td>
</tr>
<tr>
<td></td>
<td>Houston</td>
<td>46941</td>
<td>47050</td>
<td>587887</td>
</tr>
<tr>
<td></td>
<td>St. Louis</td>
<td>48941</td>
<td>49327</td>
<td>613871</td>
</tr>
<tr>
<td>Northeast</td>
<td>Boston</td>
<td>41029</td>
<td>41351</td>
<td>497234</td>
</tr>
<tr>
<td></td>
<td>New Haven</td>
<td>45847</td>
<td>46335</td>
<td>551489</td>
</tr>
<tr>
<td></td>
<td>New York</td>
<td>50518</td>
<td>50178</td>
<td>622095</td>
</tr>
<tr>
<td>Southeast</td>
<td>Atlanta</td>
<td>53782</td>
<td>54126</td>
<td>661806</td>
</tr>
<tr>
<td></td>
<td>Memphis</td>
<td>52499</td>
<td>51585</td>
<td>638477</td>
</tr>
<tr>
<td></td>
<td>Orlando</td>
<td>50175</td>
<td>51437</td>
<td>602076</td>
</tr>
<tr>
<td>West</td>
<td>Los Angeles</td>
<td>66049</td>
<td>64432</td>
<td>800084</td>
</tr>
<tr>
<td></td>
<td>San Francisco</td>
<td>65214</td>
<td>66025</td>
<td>824457</td>
</tr>
<tr>
<td></td>
<td>Seattle</td>
<td>65759</td>
<td>64872</td>
<td>801060</td>
</tr>
</tbody>
</table>

**** Return to Summary ****

Click the Return to Summary hyperlink to return to the first page (summary report).
Reference: Guidelines on Links For FIRST

The following guidelines apply:

- The set of link fields used with FIRST must correspond to the set of link fields used with DOWN on the first report.

- The action of a FIRST hyperlink in the last report should return to the corresponding line in the first report. The chosen set of links must uniquely identify that line of the first report.

- The DOWN hyperlink on the line of the first report must uniquely identify that line of the first report to locate the matching line of the detail report. The set of links for the DOWN in the first report and the FIRST link in the last report are the same, since they both must uniquely identify a line in the first report.

Reference: Rules For Drill Through Hyperlinks

Reports linked with Drill Through must follow certain rules to ensure that the hyperlinks between them work correctly. The following are key concepts:

- **Source report.** The report from which you are linking. The source report contains hyperlinks to the target report.

- **Target report.** The report to which you are linking.

- **Link field.** One of a set of corresponding fields of the same data type that exist in both the source and target reports. Link fields locate the position in the target report to which a hyperlink in the source report jumps.

Source and target terminology refer to each pair of linked reports. For example, if there are three reports linked with Drill Through, the second report is generally the target report of the first report, and also the source report of the third report.

To process a report as a Drill Through, you must identify the link fields in the source report that relate to the target report:

- Choose meaningful link fields whose values match in the source and target reports. For example, if a field in the source report contains a part number and a field in the target report contains a Social Security number, the field values will not match and you cannot construct hyperlinks.

- Specify as many link fields as necessary to uniquely locate the position in the target report that corresponds to the link fields in the source report. For example, if the source report is sorted by STATE and CITY, specifying CITY alone as the link field will be problematic if different states contain a city with the same name.
The link fields in the source and target reports must have the same internal (actual) format: the stopped data type and internal length must be identical. Formatting options, such as number of displayed digits and comma suppression, may differ. For example, an A20 field must link to another A20 field. However, an I6C field may link to an I8 field, since internally both are four-byte fields.

The link fields must be sort fields or verb objects in both the source and target reports. You can include a NOPRINT (non-display) field, which is useful when constructing a report in which a field is in embedded in heading text.

Designing Drill Through reports is very similar to designing Drill Down reports. Choosing the link fields for a Drill Through report is similar to choosing the parameter fields in a Drill Down report. Likewise, the syntax of a Drill Through closely parallels the syntax of a Drill Down.

Since Drill Through reports are linked by corresponding values of link fields, the hyperlinks must appear on report elements associated with a particular value of a link field. However, hyperlinks do not have to appear on any link itself.

Not all line types are appropriate for placement of a Drill Through hyperlink. For example, if a page break occurs on a BY field that is also a Drill Through link, each page heading is clearly associated with a value in that field. However, if a page break occurs because of page overflow, avoid placing a Drill Through link in a heading. Similarly, subheadings, subfootings, subtotals, and recaps are associated only with the values of particular BY fields.

Managing Output Formats Using the Format Tab

You use the Format tab to change the output type of the report, control the navigational settings of a report, and access the special features of a report. Accordingly, this tab contains the Output Types, Navigation, and Features groups. The Format tab is located at the top of the App Studio interface and is available only when you are creating a report. The Format tab is shown in the following image.
Selecting a Type of Report Using the Output Types Group

The Output Types group enables you to choose the type of report (for example, PDF, Excel, or Analytic Document) that you would like to produce. You can also set the output format and the destination of the report using the elements in this group. The Output types group is shown in the following image.

The report type options are:

**HTML**

Changes the report output type to HTML. This is the default value. For more information, see *Output Format Options Dialog Box for an HTML Report* on page 295.

**HTML Analytic Document**

Changes the report output type to HTML Analytic Document (AHTML).

**PDF**

Changes the report output type to PDF. For more information, see *Output Format Options Dialog Box for a PDF Report* on page 296.

**PDF Analytic Document**

Changes the report output type to PDF Analytic Document, which creates a PDF report for Adobe Flash Player.

**Excel**

Changes the report output type to Excel. You can select the following types of Excel Reports: Excel XLSX, Excel XLS, Excel XLSX Formula, Excel XLS Formula, or the Excel XLS PivotTable. For more information, see *Output Format Options for Excel Reports* on page 296.

**PowerPoint**

Changes the report output type to PowerPoint. You can select PowerPoint PPTX or PowerPoint PPT. For more information, see *Output Format Options for PowerPoint Reports* on page 297.
Output Format

Changes the output format of a report. The options that are available to you change depending on which output format you select. Formats are grouped into the following categories: Styled report formats, Unstyled formats, and Database formats.

The following output formats are available:

- **Styled report formats**
  - HTML Web Document (HTML)
  - HTML Table (HTMTABLE)
  - HTML Analytic Document (AHTML)
  - PDF Analytic Document (APDF)
  - DHTML Web Document
  - Portable Document Format (PDF)
  - PostScript (PS)
  - Excel XLSX (XLSX)
  - Excel XLS (EXL2K)
  - Excel XLSX Formula (XLSX FORMULA)
  - Excel XLS Formula (EXL2K FORMULA)
  - Excel XLS PivotTable (EXL2K PIVOT)
  - Excel 97 (EXL97)
  - PowerPoint PPTX (PPTX)
  - PowerPoint PPT (PPT)
  - Default
  - User (&WFFMT)

- **Unstyled formats**
  - Binary numbers with file description (BINARY)
  - Binary numbers with file description, no internal padding (INTERNAL)
- Sequential file with a Master File (DATREC)
- Comma delimited text file with blanks (COMMA)
- Comma delimited text file with field names (COMT)
- Data Interchange Format (DIF)
- Excel 95 (EXCEL)
- Fixed format text file with file description (ALPHA)
- Standard XML (XML)
- JSON (JSON)
- Tab delimited text file (TAB)
- Tab delimited text file for Visual Discovery (VISDIS)
- Tab delimited text file for Visual Discovery AE (VISDISAE)
- Tab delimited text file with field names (TABT)
- Text file with layout and line breaks (DOC)
- Text file with layout and without line breaks (WP)
- Format Magnify (MAGNIFY)
- Delimited Sequential File (DFIX)
- Generate SQL Select (SQL_SCRIPT)

- Database formats
  - FOCUS database (FOCUS)
  - XFOCUS database (XFOCUS)
  - Native database table (SAME_DB)
  - Hyperstage database table (SQLHYPG)
  - Other
    - Db2 Database table (DB2)
    - Dbase extract file (DBASE)
Output Format Options

Opens the Output Format Options dialog box where you can set a report title, turn on cascading style sheets, set how to expand report rows and turn on line suppression.

Destination

Opens the Output Destination dialog box, where you can set the destination of your output to Web Browser, Temporary File, or Save File. If you select Temporary File or Save File, you can set the name and location of that file using the Name text box and directory selection icon. For more information, see How to Set the Output Destination on page 294.

Procedure: How to Set the Output Destination

1. On the Format tab, in the Output Types group, click Destination (PCHOLD).
   The Output Destination dialog box displays.

2. For Destination, select one of the following options:
   - Web Browser
   - Temporary File
   - Save File
   - Default
   
   Note: If you select Temporary File or Save File, the Name field is activated.

3. Enter a file name and click the ellipsis button (...)
   The File name and location dialog box displays.
4. Select where you want to save the file.

   **Note:** The file name that you specified on the Output Destination dialog box is carried over to the Filename field in the File name and Location dialog box.

5. Click **OK**.

6. Click **OK** on the Output Destination dialog box.

**Reference:** Output Format Options Dialog Box for an HTML Report

The following options are available for an HTML report:

**Report Title**

You can type a report title into the text box.

**Cascading Style Sheets**

You can select whether or not to include cascading style sheets in your report. You can select **On** or **Off**. **On** is selected by default.

**Expand By Row**

You can select how you would like rows to be expanded. Only show top level is the default.

- **Only show top level.** Creates a report which initially displays only the highest sort field level. To see rows on lower levels, click the plus sign (+) next to one of the displayed sort field values.

- **Off.** Does not create a report where you can expand rows.

- **Expand everything.** Creates a report in which all sort field levels are initially expanded. To roll up a sort field level, click the minus sign (-) next to one of the sort field values on that level.

   **Note:** If you want to set your report rows to expand to a specific number, you must type an integer into the text box rather than selecting one of the options.

**Suppress blank lines**

You can select whether to suppress blank lines or not.

- **Off.** The suppression of blank lines will not occur.

- **Only within report body.** The suppression of blank lines will only occur within the body of the report.
**Reference:** Output Format Options Dialog Box for a PDF Report

The following options are available for a PDF report:

**Repeat sort fields per panel**

Enables the display of By fields in the left portion of each panel of a multi-panel report.

**Repeat headings/footings per panel**

Repeats headings/footings on each panel page when the columns presented on PDF reports cannot be displayed on a single page.

**Use settings for Postscript printing**

Sends the page settings to a PostScript printer when printing in PS format.

**Display grid for object placement evaluation**

Displays a grid in the report output, which enables you to evaluate the correct placement of data and objects during your report design.

**Align borders in subheading/subfooting with data**

Aligns the borders in a subheading or subfooting with the data in the report output.

**Reference:** Output Format Options for Excel Reports

The following options are available for an Excel report:

**Create separate worksheets for each primary sort value**

Adds the highest-level sort field and its values as a TOC in the report. This option deactivates all other options on the Format tab.

**Report Title**

You can type a report title into the text box.

**Generate overflow sheets**

This indicates where the overflow rows of data break in the Excel worksheet. The default is 65,000 rows of data before an overflow sheet is generated.

**Note:** When you change formats from XLSX to EXL2K and ROWLIMIT exceeds 65,000, you will receive a message asking you if you want to proceed. If you decide to continue, ROWLIMIT will be set to 65,000. If you decide not to continue, the format will revert to XSLX, with no change to ROWLIMIT.

**Rows per sheet**

 Specifies the number of rows per sheet. This option is set to max and unable to be edited when Generate overflow sheets is turned off.
Define a range name for the data

Assigns a named range to a group of cells in Excel. There is a 256 character limit for named ranges.

Template

You can set which template to use in your Excel report.

Item to populate

Sets the number of items to populate.

Reference: Output Format Options for PowerPoint Reports

The following options are available for a PowerPoint report:

Group tables and components

You can group table elements together in a PowerPoint PPTX report, allowing you to move, resize, and format all of the report output on a slide at once. If grouping is not enabled, which is the default, each grid line, header row, and cell value in a report is a separate element when output as a PowerPoint presentation. This option is only available for PowerPoint PPTX reports.

Template

You can set which template to use in your PowerPoint report. Type the name of the template including the file extension. The template must be accessible in your environment. For example, it can be saved in an application folder.

Item to populate

Only available if you have selected a template. Allows you to select which slide of the template the report should start on.

Slide master

Allows you to select a slide master from the selected PowerPoint template. This option is only available for PowerPoint PPTX reports.

Slide layout

Allows you to select a slide layout from the selected slide master to display the report on. This option is only available for PowerPoint PPTX reports.

Reference: User Format Selection Dialog Box

You can use the User Format Selection dialog box to choose which formats and options are available, at run time, when you select the User output format from the Styled report formats, from the Output Formats command. You can select which formats a user can choose from, and customize the options specific to each format.
The options are:

**Selection**

Provides a list of check boxes that indicate whether or not an output format is available to the user. All formats are selected by default. You can click the check box for a format to clear it.

**Format**

Displays a list of available output formats.

**Description**

Provides a brief description of the output format which is displayed to the user, at runtime. You can edit the description by double-clicking the description text box.

**Options**

Indicates which output formats have options you can customize. You can click the double-arrow to open the Output Format Options dialog box, which displays the options available for that format. For example, if you click the double-arrow for the HTML output format, the Output Format Options dialog box opens, displaying the options for the HTML output format.

**Enter text for the WFFMT prompt:**

You can type what the user sees when prompted to select an output format, at run time.

**OK**

Accepts the changes and closes the dialog box.

**Cancel**

Discards the changes and closes the dialog box.

**Setting Navigational Options for a Report Using the Navigation Group**

The navigation group contains the functionality for setting navigational options for your report (for example, adding a Table of Contents or freezing an area of the report). You can also create drilldowns with the Auto Drill command. The Navigation group is shown in the following image.
The commands are:

**Table of Contents**

Displays every value of the highest-level sort field as a hyperlink, and then toggles between a display of the entire report and a designated section. It also applies a dynamic table of contents to the first By field in an HTML report. You can select *Report*, *Heading*, or *None*.

**Note:** You create a Table of Contents on a BY field.

For more information, see *How to Add a TOC or Disable the TOC Feature* on page 299.

**Freeze**

Freezes the scrolling area of a report so that Headings or Footings display with the full report in a narrow browser window. You can select *Off*, *On*, *Top*, *Bottom*, or *Custom*. For more information, see *How to Freeze the Scrolling Area for Report Output* on page 300.

**Note:** The Top, Bottom, and Custom freeze options are not available for HTML Analytic Documents.

**On-Demand Paging**

Displays one page of an HTML report at a time. You use controls on your browser to display the next or previous page, all pages, or to navigate to a specific page. You can select *On* or *Off* (default). For more information, see *Navigating Large Reports with On-Demand Paging* on page 300.

**Auto Drill**

Creates an automatic drill down. This changes the Enable Auto Drill property value to *Yes*. You can use the Auto Drill with the HTML or HTML Analytic Document output types only. For more information, see *Link to Ad Hoc Reports, Charts, and Visualizations Using Auto Drill* on page 439.

**OLAP Options**

Opens the Auto Drill & Analysis dialog box. You can select options related to OLAP and automatic drill downs. For more information, see *Working With Auto Drill & Analysis Functionality* on page 303.

**Note:** This option only appears if you select the *Enable OLAP* check box in the Reporting tab of the App Studio Options dialog box.

**Procedure:** *How to Add a TOC or Disable the TOC Feature*

1. Select a BY column in your report.
2. On the *Format* tab, in the *Navigation* group, click *Table of Contents*. 
3. Choose one of the following options:

- **Report** to embed the TOC in the executed report as an expandable tree control.
- **Heading** to add the By columns as the last objects in the page heading. The TOC appears in a drop-down list in the heading when the report is executed.
- **None** to turn the TOC feature off.

**Tip:** Click the Properties tab in the Object Inspector to verify that the Table of Contents is turned on.

or

a. Right-click the first By column in the Report canvas and click **Table of Contents**.

b. Select one of the following options: **Report**, **Header**, or **None**.

**Procedure: How to Freeze the Scrolling Area for Report Output**

You can freeze page headings/footings, report headings/footings, column titles, and totals for your report output. The freeze option is available from the Navigation group of the Format tab.

1. On the **Format** tab, in the **Navigation** group, select **Freeze**.

2. Select the freeze type from the drop-down list.

   The options are:

   - **Off.** This is the default.
   - **On.** Freezes the headings/footings, column titles, and totals.
   - **Top.** Freezes the headings and column titles.
   - **Bottom.** Freezes the totals and footings.
   - **Custom.** Enables you to set the scroll height for the freeze type.

**Note:** The Top, Bottom, and Custom freeze options are not available for HTML Analytic Documents.

3. Save and run your report.

**Navigating Large Reports with On-Demand Paging**

On-Demand Paging is a feature that minimizes load time by opening requested pages only when you run a report. This is particularly useful when running large reports that can otherwise take a long time to load.
When On-Demand Paging is enabled, your browser consists of the following two sections:

- **Report frame.** The Report frame is the main section of the browser and contains one page of report output. When you first run a report, the Report frame contains the first page of report output.

- **On-Demand Paging Toolbar.** Located at the bottom of the screen, this toolbar contains the navigational controls you use to display the next or previous page, the first or last page, or to display a specific page.

The following image provides an example of a report with On-Demand Paging.

![Example of a report with On-Demand Paging](image)

**Procedure:** How to Enable On-Demand Paging in a Report Canvas

1. Create a report with HTML as the output type. (This is the default.)

2. On the *Format* tab, in the *Navigation* group, click *On-Demand Paging*.

3. Run the report.

On-demand paging delivers the first page of the report output to the browser and holds the remaining pages on the server disk. A page of report output is determined by the Margins, Report Page, and Page Type selections on the Page Setup group of the Layout tab.
Procedure: How to Use the On-Demand Paging Toolbar

The On-Demand Paging Toolbar offers you several ways to view pages in your report or search for a string of text.

☐ To display a specific page:
   1. Enter a page number in the Page field.
   2. Click the Go to Page button.

☐ To display the previous or next page in the sequence, click the Previous or Next arrow button.

☐ To display the first or last page of the report, click the First Page or the Last Page button.

☐ To download the entire report to your browser as a single document, click the All Pages button.

Your browser displays the entire report without the On-Demand Paging toolbar. You can return to viewing a single page of your report by clicking the Back button on your browser toolbar.

☐ To search for string of text or numbers:
   1. Enter or paste the string into the Search field.
   2. Click the Find button.

☐ To match the case of your search text, click the Match Case button. The default setting is unmatched.

☐ To change the direction of your search, click the Search Direction button. The default setting is forward.
Working With Auto Drill & Analysis Functionality

This section describes the functionality for Auto Drill & Analysis.

Auto Drill and Analysis

OLAP Options

- **Disable.** OLAP options are disabled and not shown in the OLAP report. By default, the Enable OLAP option is set to Disabled.

- **Off.** Turns off the OLAP Control Panel and the OLAP Selections pane, but allows OLAP functionality from the report itself. You can access options on right-click menus, drag columns within the report, and use up and down arrows to sort columns from high-to-low or vice versa.

- **On.** Provides access to the OLAP Selections pane from a square button to the left of the column titles. You can open the Control Panel by clicking the OLAP button in the OLAP report.

- **Top Panel.** Opens the OLAP Selections pane above the report. The Measures, Graph, and Dimension controls, the band containing the OLAP, Run, and Reset buttons appear above the report output. You can open the Control Panel by clicking the OLAP button on the Selection pane.

- **Bottom Panel.** Opens the OLAP Selections pane below the report. The Measures, Graph, and Dimension controls, the band containing the OLAP, Run, and Reset buttons appear below the report output. You can open the Control Panel by clicking the OLAP button on the Selection pane.

- **Hidden Panel.** Opens the OLAP report with the OLAP Selections pane hidden. You can perform a variety of analytic tasks from the report itself. Selection Criteria is shown next to the OLAP button.

- **Show Tabbed.** For OLAP reports that have multiple dimensions, this option groups the dimension elements under a tab labeled with the dimension name.

Auto Drill Options

Automatic Drill Down controls access to automatic drill downs in a report:

- **None.** Disables automatic drill downs. By default, the Automatic Drill Down option is to None.

- **Dimensions.** Enables automatic drilldowns on dimensions in a report.
Dimensions and Measures. Enables automatic drilldowns on dimensions and measures in a report.

Working With the Features Group Commands

Options in the Features group enable you to control the appearance of pop-up descriptions, whether a report is an Accordion Report, whether to repeat a sorted value, whether to use special In-Document Analytic options, and if accessibility options are on. The Features group is shown in the following image.

The commands are:

**Popup Description**

Enables the display of pop-up field descriptions for columns in your report. You can select On or Off. The default is <not set>. For more information, see Displaying Pop-up Field Descriptions for Column Titles on page 305.

**Accordion Report**

Changes a report to an Accordion Report. Use the Accordion dialog box to customize the accordion report. Accordion reports provide a way to control the amount of sorted data that appears on an HTML report page. You can produce reports with expandable views of data for each vertical sort field. When an Accordion Report first appears, only data values of the first (highest-level) vertical sort field are shown, unless an Expand option is selected. All other data is hidden. You can manually expand your view to expose data values of lower-level sort fields. For more information, see Controlling the Display of Sorted Data With Accordion Reports on page 306.

**Repeat Sort Value**

Displays all repeated sort values instead of blanks in the output after the first instance of a new sort value, which is the default behavior. You can select On or Off. The default is <not set>. For more information, see How to Use the Repeat Sort Value Option on page 311.
Lines per Page

Determines how many lines are displayed on each report page. Options are 10, 20, 30, 40, 50, and Show All. The default is 20. For more information, see How to Use the Lines per Page Option on page 311.

Accessibility

Offers options that help users with disabilities to interact with the report.

Mailing Labels

Opens the Mailing Label Options dialog box, which allows you customize the layout, dimensions, spacing, and print order of your mailing label. This option is only available for PDF and PostScript reports.

For more information, see Customizing Mailing Labels Using the Mailing Labels Options Dialog Box on page 311.

Displaying Pop-up Field Descriptions for Column Titles

You can have pop-up field descriptions display in an HTML report when the mouse pointer is positioned over column titles. Field description text displays in a pop-up box near the column title using the default font for the report.

Note: Pop-up Field Descriptions are available for HTML Web Document (HTML), HTML Table (HTM_TABLE), Default, and User styled report formats.

The pop-up text displayed for a column title is defined by the Description attribute in the Master File for the corresponding field. If a column title has no Description entry in the Master File, then no pop-up box is generated when your mouse is positioned over the title.

The following procedure provides information on displaying pop-up descriptions in an HTML report.

Procedure: How to Display Pop-up Field Descriptions in an HTML Report

1. Open a report in App Studio.
2. On the Format tab, in the Features group, click Popup Desc.
   The selection menu displays.
3. Select one of the following options:
   - On. Turns Pop-up Field Descriptions on.
   - Off. Turns Pop-up Field Descriptions off.
Controlling the Display of Sorted Data With Accordion Reports

Accordion Reports provide a way to control the amount of sorted data that appears on an HTML report page. You can produce reports with expandable views of data for each vertical sort field. When an Accordion Report first appears, only data values of the first (highest-level) vertical sort field are shown. All other data is hidden. You can manually expand your view to expose data values of lower-level sort fields.

When you create an Accordion Report, a plus sign or arrow icon appears to the left of each data value in the column under the highest-level sort heading. For data associated with lower-level sort fields, a plus sign or arrow is placed to the left of each data value, but the data does not appear unless manually expanded. Data values of the lowest-level sort field are not expandable.

To expand your view of data for any expandable sort field, click a plus sign or arrow. All data associated with the next lower-level sort field appears. When you expand a data value under the next to lowest sort heading, all of the remaining associated data values in the report appear.

**Note:** Two vertical (BY) sort fields are required. If your report does not contain two vertical sort fields, then the Accordion Reports option is ignored and a standard HTML report is created.

The use of horizontal (ACROSS) sort fields is supported with Accordion Reports. The horizontal sort headings that appear above vertical sort headings in a standard HTML report are not displayed in an Accordion Report until at least one sorted data value has been manually expanded in each expandable sort column.

PDF and Excel formats are not supported with Accordion Reports.

To create an accordion report, create a report that has multiple sort or BY fields and, on the Format tab, in the Features group, click Accordion Report.

In the Accordion dialog box, you can specify the type of accordion functionality, and control additional settings depending on the type.
You can select one of the following options from the Type section:

- **By Row Tree.** Uses the enhanced Accordion By Row interface, which includes the same behavior of Accordion By Row reports, as well as additional functionality such as responsive column width and the ability to change the button to expand a row from a plus sign to an arrow. The following image shows an example of an enhanced Accordion By Row report.

<table>
<thead>
<tr>
<th>Quantity Sold</th>
<th>Revenue</th>
<th>Cost of Goods</th>
<th>Gross Profit</th>
</tr>
</thead>
<tbody>
<tr>
<td>173,417</td>
<td>$48,965,069.21</td>
<td>$34,631,123.00</td>
<td>$14,333,946.21</td>
</tr>
<tr>
<td>204,615</td>
<td>$61,140,962.97</td>
<td>$43,840,341.00</td>
<td>$17,300,621.97</td>
</tr>
<tr>
<td>48,009</td>
<td>$14,376,427.31</td>
<td>$10,314,288.00</td>
<td>$4,062,139.31</td>
</tr>
<tr>
<td>46,714</td>
<td>$13,855,714.79</td>
<td>$9,930,523.00</td>
<td>$3,926,191.79</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Accessory</th>
<th>Quantity Sold</th>
<th>Revenue</th>
<th>Cost of Goods</th>
<th>Gross Profit</th>
</tr>
</thead>
<tbody>
<tr>
<td>7,323</td>
<td>$1,827,354.16</td>
<td>$1,204,225.00</td>
<td>$503,129.16</td>
<td></td>
</tr>
<tr>
<td>Camcorder</td>
<td>6,475</td>
<td>$2,073,189.24</td>
<td>$1,391,888.00</td>
<td>$681,301.24</td>
</tr>
<tr>
<td>Computers</td>
<td>2,726</td>
<td>$555,012.38</td>
<td>$338,626.00</td>
<td>$216,386.38</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Smartphone</th>
<th>Quantity Sold</th>
<th>Revenue</th>
<th>Cost of Goods</th>
<th>Gross Profit</th>
</tr>
</thead>
<tbody>
<tr>
<td>2,726</td>
<td>$555,012.38</td>
<td>$338,626.00</td>
<td>$216,386.38</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Media Player</th>
<th>Quantity Sold</th>
<th>Revenue</th>
<th>Cost of Goods</th>
<th>Gross Profit</th>
</tr>
</thead>
<tbody>
<tr>
<td>10,264</td>
<td>$3,313,925.34</td>
<td>$2,560,704.00</td>
<td>$753,221.34</td>
<td></td>
</tr>
<tr>
<td>Stereo Systems</td>
<td>15,855</td>
<td>$4,221,474.37</td>
<td>$2,979,703.00</td>
<td>$1,241,771.37</td>
</tr>
<tr>
<td>Televisions</td>
<td>1,331</td>
<td>$1,074,107.17</td>
<td>$847,804.00</td>
<td>$226,303.17</td>
</tr>
<tr>
<td>Video Production</td>
<td>2,740</td>
<td>$800,652.13</td>
<td>$556,573.00</td>
<td>$244,079.13</td>
</tr>
</tbody>
</table>

| 3             | 50,632        | $15,240,046.81 | $10,941,101.00 | $4,298,945.81 |
| 4             | 59,257        | $17,058,774.06  | $12,645,429.00 | $5,013,345.06 |
| 2015          | 300,678       | $89,561,595.40  | $64,159,146.00 | $25,402,449.40 |
| 2016          | 423,103       | $126,675,560.19 | $90,376,786.00 | $35,298,781.19 |
| 2017          | 935,496       | $282,541,804.48 | $202,610,814.00 | $79,930,990.48 |
| 2018          | 1,472,582     | $452,307,832.95 | $325,821,316.00 | $125,486,516.95 |
By Row. Creates an Accordion By Row report, which allows you to expand sort values to navigate into the report. Totals for measure fields in the report are shown for each visible sort value down to the lowest-level sort value. The following image shows an example of an Accordion By Row report.

<table>
<thead>
<tr>
<th></th>
<th>Quantity Sold</th>
<th>Revenue</th>
<th>Cost of Goods</th>
<th>Gross Profit</th>
</tr>
</thead>
<tbody>
<tr>
<td>2013</td>
<td>173,417</td>
<td>$48,965,069.21</td>
<td>$34,631,123.00</td>
<td>$14,333,946.21</td>
</tr>
<tr>
<td>2014</td>
<td>204,615</td>
<td>$61,140,962.97</td>
<td>$43,840,341.00</td>
<td>$17,300,621.97</td>
</tr>
<tr>
<td>1</td>
<td>48,009</td>
<td>$14,376,427.31</td>
<td>$10,314,288.00</td>
<td>$4,062,139.31</td>
</tr>
<tr>
<td>2</td>
<td>46,714</td>
<td>$13,865,714.79</td>
<td>$9,939,523.00</td>
<td>$3,926,191.79</td>
</tr>
<tr>
<td>Δ Accessories</td>
<td>7,323</td>
<td>$1,827,354.16</td>
<td>$1,264,225.00</td>
<td>$563,129.16</td>
</tr>
<tr>
<td>Δ Camcorder</td>
<td>6,475</td>
<td>$2,073,189.24</td>
<td>$1,391,888.00</td>
<td>$681,301.24</td>
</tr>
<tr>
<td>Δ Computers</td>
<td>2,726</td>
<td>$555,012.38</td>
<td>$338,626.00</td>
<td>$216,386.38</td>
</tr>
<tr>
<td>Smartphone</td>
<td>2,726</td>
<td>$555,012.38</td>
<td>$338,626.00</td>
<td>$216,386.38</td>
</tr>
<tr>
<td>Δ Media Player</td>
<td>10,264</td>
<td>$3,313,925.34</td>
<td>$2,560,704.00</td>
<td>$753,221.34</td>
</tr>
<tr>
<td>Δ Stereo Systems</td>
<td>15,855</td>
<td>$4,221,474.37</td>
<td>$2,979,703.00</td>
<td>$1,241,771.37</td>
</tr>
<tr>
<td>Δ Televisions</td>
<td>1,331</td>
<td>$1,074,107.17</td>
<td>$847,804.00</td>
<td>$226,303.17</td>
</tr>
<tr>
<td>Δ Video Production</td>
<td>2,740</td>
<td>$800,652.13</td>
<td>$558,573.00</td>
<td>$242,079.13</td>
</tr>
<tr>
<td>3</td>
<td>50,635</td>
<td>$15,240,046.81</td>
<td>$10,941,101.00</td>
<td>$4,298,945.81</td>
</tr>
<tr>
<td>4</td>
<td>59,257</td>
<td>$17,658,774.06</td>
<td>$12,645,429.00</td>
<td>$5,013,345.06</td>
</tr>
<tr>
<td>2015</td>
<td>300,678</td>
<td>$89,561,595.40</td>
<td>$64,159,146.00</td>
<td>$25,402,449.40</td>
</tr>
<tr>
<td>2016</td>
<td>423,103</td>
<td>$126,675,660.19</td>
<td>$90,376,789.00</td>
<td>$36,298,871.19</td>
</tr>
<tr>
<td>2017</td>
<td>935,496</td>
<td>$282,541,804.48</td>
<td>$202,810,814.00</td>
<td>$79,930,990.48</td>
</tr>
<tr>
<td>2018</td>
<td>1,472,582</td>
<td>$452,307,832.85</td>
<td>$325,821,316.00</td>
<td>$126,486,516.95</td>
</tr>
</tbody>
</table>
By Column. Creates an Accordion By Column report, which reveals additional sort field values as higher-level sort field values are expanded. Measure values are not revealed until the lowest-level sort value is expanded for display. The following image shows an Accordion By Column report.

<table>
<thead>
<tr>
<th>Sale Year</th>
<th>Sale Quarter</th>
<th>Product Category</th>
<th>Product Subcategory</th>
<th>Quantity Sold</th>
<th>Revenue</th>
<th>Cost of Goods</th>
<th>Gross Profit</th>
</tr>
</thead>
<tbody>
<tr>
<td>2013</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2014</td>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>2</td>
<td>Accessories</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Camcorder</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>3</td>
<td>Computers</td>
<td>Smartphone</td>
<td>2,726</td>
<td>$555,012.30</td>
<td>$330,826.00</td>
<td>$216,186.30</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Media Player</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Stereo Systems</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Televisions</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Video Production</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2015</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2016</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2017</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2018</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Off. Accordion functionality is not enabled in the report.

Not Set. Accordion functionality is not set in the report. By default, this means it is off.

When By Row or By Row Tree are selected, additional settings are available in the Options section.

Expand. Available for Accordion By Row and enhanced Accordion By Row (By Row Tree) reports. Specifies how many sort field columns are expanded initially at run time. You can select one of the following options:

Not Set. The report is fully collapsed at run time.

All. The entire report is initially expanded at run time.

n Levels. Creates an Accordion report in which n sort field levels are initially expanded. To roll up an expanded sort field level, click the minus sign (-) next to one of the sort field values on that level. You can change the initial number of expanded levels by using the arrow control or typing a number value.
**Expansion Icons.** Available for enhanced Accordion By Row (By Row Tree) reports. Allows you to select the icon used to expand rows of the report.

**Not Set.** Expansion icons are not set. The default plus and minus signs are used, unless otherwise specified in the StyleSheet.

**Plus/Minus Signs.** Uses plus signs to expand sort values and minus signs to collapse them.

**Right/Down Arrows.** Uses right-pointing arrows to expand sort values and downward-pointing arrows to collapse them.

**Reference:** Requirements for Accordion Reports

The following requirements must be taken into consideration when creating Accordion Reports:

- Adding a drill-down link to an Accordion Report requires that the TARGET parameter must be set to a value that specifies a new HTML frame.

- Once an Accordion Report is created and delivered to the user, there are no subsequent calls to the WebFOCUS Reporting Server required when the user is interacting with the report. However, the collapsible folder controls on the sort fields require JavaScript and images that reside on the WebFOCUS Client. The user must be connected to the WebFOCUS web tier components in order to use this feature. For online connected users of WebFOCUS, no change is required to the report.

**Procedure:** How to Create an Accordion Report

2. In the Report canvas main window, add the following fields:
   
   **UNITS, ST, DOLLARS, CITY, REGION, CATEGORY**

3. Highlight the **UNITS** and **DOLLARS** fields and Sum these fields.
4. Highlight the **ST, CITY, and CATEGORY** fields and make them By fields.
5. On the **Format** tab, in the **Features** group, select **Accordion Report**.

   **Note:** Accordion Reports are available for HTML Web Document (HTML), HTML Table (HTMTABLE), Default, and User styled report formats.

6. In the Accordion dialog box, specify the properties of the accordion report.
   
   a. Select a Type for the accordion report. Available options are By Row Tree, By Row, By Column, Off, and Not Set.
b. If the Type is By Row Tree or By Row, select the number of levels to expand when the accordion report is initially run. Options are Not Set, All, or a specified number of levels.

c. If the Type is By Row Tree, select an expansion icon. Options are Not Set, Plus/Minus Signs, and Right/Down Arrows.

**Procedure: How to Use the Repeat Sort Value Option**

The Repeat Sort Value option enables you to choose to display all repeated sort values in the output after the first instance of a new sort value.

1. Open an existing report or create a new one that has at least one sort parameter specified in a Where clause.
2. In the Features group of the Format tab, select Repeat Sort Value.
3. Select one of the following options:
   - **On** to turn on the Repeat Sort Value option and display all the repeated sort values after the first instance.
   - **Off** to turn off the Repeat Sort Value option and display blanks instead of repeated sort values.
   - **<not set>** to indicate no choice.

**Note:** The default value is <not set> and is the same as selecting No.

**Procedure: How to Use the Lines per Page Option**

The Lines per Page option allows you to adjust the number of lines displayed on a single page.

1. Open an existing report or create a new one using the Report Wizard.
2. In the Features group of the Format tab, select the Lines per Page drop-down list.
3. Select the number of lines you want displayed. The options are 10, 20, 30, 40, 50 or Show All.

**Note:** The default value is 57.

**Customizing Mailing Labels Using the Mailing Labels Options Dialog Box**

You can use the Mailing Labels Options dialog box to customize the settings for your mailing label. You can customize the layout, dimensions, spacing, and print order of your label.

**Label type**

- **None.** Removes all label settings in the cascading style sheet.
Custom label. Enables you to specify custom label settings.

All other preset label types automatically load the appropriate settings into the cascading style sheet.

Label layout
Sets the number of rows and columns for the labels.

Label dimensions
Determines the height and width of each label.

Label spacing
Determines the amount of horizontal and vertical spacing between each label (in the current units of measure).

Print order
Determines whether the data output flows down a column or across a row.

- **Down.** Labels are printed top-to-bottom and moves left-to-right until each column is filled.

- **Across.** Labels are printed left-to-right and then moves down until all rows are complete.

Manipulating Mathematical Data Using the Data Tab
You use the options on the Data tab to manipulate mathematical data in a report.

This tab contains the Calculation, Forecast, and Guided Reports groups. The Data tab is located at the top of the App Studio interface. It is only available when you are creating a report. The Data tab is shown in the following image.

![Data Tab Image]
Creating Computations Using the Calculation Group

You can use the options in the Calculation group to include temporary calculated values or computations in your report. A temporary calculation field is a computed field whose value is not stored in the data source, but is calculated from the data that is there, or assigned an absolute value. A temporary field takes up no storage space in the data source, and is created only when needed.

When you create a temporary field, you determine its value by writing an expression. You can combine fields, constants, and operators in an expression to produce a single value. For example, if your data contains salary and deduction amounts, you can calculate the ratio of deductions to salaries using the following expression: deduction/salary.

You can specify the expression yourself, or you can use one of the many supplied functions that perform specific calculations or manipulations. In addition, you can use expressions and functions as building blocks for more complex expressions, as well as use one temporary field to evaluate another.

Choose a calculated value when you want to:

- Evaluate the temporary field using total values or prefix operators (which operate on total values). You cannot use a virtual field, since it is evaluated before any totaling takes place.

- Evaluate the temporary field using fields from different paths in the data structure. You cannot use a virtual field, since it is evaluated before the relationship between data in the different paths is established.

The Calculation group is shown in the following image.

The commands are:

**Summary (Compute)**

A calculated value (COMPUTE) is evaluated after all of the data that meets the selection criteria is retrieved, sorted, and summed. Therefore, the calculation is performed using the aggregated values of the fields. Calculated values are available only for the specified report request. You specify the COMPUTE command in the body of the report request, following the display command and optionally, introduced by AND. You can compute more than one field with a single COMPUTE command.
The Computed Field Creator (COMPUTE) dialog box allows you to create a computed field, type a name for the field, and enter a format. The Field List provides similar functionality, including options to display data source fields in a Logical, List, or Structured view. You can also view a complete set of functions, instead of data source fields, by clicking the Functions button. Using the Options button allows you to specify how missing values are handled. For details, see How to Create Computed Fields on page 314.

Across Compute

Opens the Across Compute dialog box, where you can create a calculated value to be used in a report. You can open the Field List which provides similar functionality, including options to display data source fields in a Logical, List, or Structured view. You can also view a complete set of functions, instead of data source fields, by clicking the Functions button. For details, see How to Use the Across Compute Option on page 315.

Note: An Across Compute can only be applied to an Across field. For example, if Sort Across is indicated on the Field tab, you can then apply an Across Compute to that field.

Procedure: How to Create Computed Fields

1. Open an existing report or create a new report.
2. Click the Summary (Compute) option on the Data tab in the Calculations group.
   The Computed Field Creator dialog box opens.
3. Enter a name in the Computed Field Name field.
4. Click Format.
   The Format dialog box opens.
5. Select the formatting options you want to apply to this calculation and click OK.
   The entry in the Format field reflects any changes you made.
6. Click Options to enable or disable the display of missing values for a COMPUTE field.
   The Override Missing Values Handling check box allows you to determine how missing values are displayed.
7. Build an expression in the expression box.
   - Double-click fields from the Fields List to add them to the expression.
   - Use the calculator buttons under the expressions window to provide numbers and operators in the expression.
8. Use the *Functions* button to open the Function Arguments dialog box which enables you to view a complete set of functions that can be selected for this computation.

- The *Select a category* drop-down list provides the category for the new function.
- The *Select a function* list box lets you choose the type of function you want to create.
  
  Field descriptions and the appropriate fields are displayed for each function.

- Click *OK* when all selections are made.

9. Click *OK* to close the Computed Field Creator dialog box.

**Procedure:** How to Use the Across Compute Option

1. Open an existing report or create a new one.
2. Click the *Across Compute* option on the Data tab in the Calculations group.

   The Across Compute dialog box opens.

3. Select a *Field* using the drop-down arrow or click the *Fields* button to display the available fields in the Insert Field dialog box.

4. Build an expression in the expression box.

   - Double-click fields from the Fields List to add them to the expression.
   - Use the calculator buttons under the expressions window to provide numbers and operators in the expression.

5. Click *Format*.

   The Format dialog box opens.

6. Select the formatting options you want to apply to this calculation and click *OK*.

   The entry in the Format field reflects any changes you made.

7. Use the *Functions* button to open the Function Arguments dialog box which enables you to view a complete set of functions that can be selected for this computation.

   - The *Select a category* drop-down list provides the category for the new function.
   - The *Select a function* list box lets you choose the type of function you want to create.

   Field descriptions and the appropriate fields are displayed for each function.

   - Click *OK* when all selections are made.

8. Click *OK* to close the Across Compute dialog box.
Calculating Data Trends Using the Forecast Group

You can calculate trends in numeric data and predict values beyond the range of those stored in the data source by using the Forecast feature. The Forecast group is shown in the following image.

For more information on Forecasting, see *Overview of Forecasting* on page 316.

The command is:

**Forecast**

Opens the Forecast dialog box, where you can calculate trends in numeric data and predict values beyond the range of values stored in the data source. You can also add a Forecast column to the report. For more information, see *How to Calculate a Simple Moving Average* on page 317.

**Overview of Forecasting**

You can calculate trends in numeric data and predict values beyond the range of those stored in the data source by using the Forecast feature.

The calculations you can make to identify trends and forecast values are:

- **Simple Moving Average.** Calculates a series of arithmetic means using a specified number of values from a field.

- **Exponential moving average.** Calculates a weighted average between the previously calculated value of the average and the next data point. There are three methods for using an exponential moving average:
  - **Single Exponential Smoothing.** Calculates an average that allows you to choose weights to apply to newer and older values.
  - **Double Exponential Smoothing.** Accounts for the tendency of data to either increase or decrease over time without repeating.
  - **Triple Exponential Smoothing.** Accounts for the tendency of data to repeat itself in intervals over time.
Linear Regression Analysis. Derives the coefficients of a straight line that best fits the data points and uses this linear equation to estimate values.

When predicting values in addition to calculating trends, Forecast continues the same calculations beyond the data points by using the generated trend values as new data points. For the linear regression technique, the calculated regression equation is used to derive trend and predicted values.

Forecast performs the calculations based on the data provided, but decisions about their use and reliability are the responsibility of the user. Therefore, Forecast predictions are not always reliable, and many factors determine how accurate a prediction will be.

Conditional Formatting

You can create conditional formatting and data visualizations for forecast data. This makes it easy to distinguish between actual and forecast values in a column. For more information, see How to Set Conditional Styling for Forecast Data on page 318 or How to Set Data Visualizations for Forecast Data on page 318.

Procedure: How to Calculate a Simple Moving Average

1. Select the By and Across fields that you want to use for your calculations.
2. On the Data tab, in the Forecast group, click Forecast.
   The Forecast dialog box opens.
3. If you want to change the name of the output field that displays the Forecasted values, edit the default name that exists in the Field Name field.
4. Select Moving Average from the Step 1: Choose a Method drop-down list.
5. Select an input measure field from the Step 2: Choose a Measure drop-down list.
   If you select the same field as the By or Across field, this field will not appear in the output even if it is included in a display command.
6. Select the increment number to count each instance of the By or Across field from the Step 3: Choose The Interval field.
7. Select the number of predictions to be calculated for the Forecast field from the Step 4: Choose Number of Predictions field.
8. Select the number of values to average from the Step 5: Choose Number Of Values to Average field.
9. Optionally, change the default field format by clicking the Change Format button and selecting a different format from the Format dialog box.
10. Click OK.
**Procedure: How to Set Conditional Styling for Forecast Data**

This procedure shows how you can use the Traffic Lights feature to set styling in your report for forecast data.

1. Open a report that contains one or more columns of forecast data.

2. Click in the data area of a forecast column.
   
   The *Field* and *Appearance* tabs open.

3. On the *Appearance* tab, in the *Display* group, click *Forecast* from the Traffic Lights drop-down menu.

4. In the *Style* group, click *Data Only* from the Scope drop-down.

5. In the *Style* group, click the Color button.
   
   The Color dialog box opens.

6. Click a color, for example, red.

   This means that forecast data will appear in red and actual data will appear in the default black.

   Apply other style attributes from the Style group as needed to visually distinguish your forecast data.

   **Note:** In cases where you have multiple forecasts in a report, all forecasts will appear with the same styling that you specify in this procedure.

7. Save and run the report.

**Procedure: How to Set Data Visualizations for Forecast Data**

This procedure shows how you can use the Traffic Lights and Data Bars features to set data visualizations in your report for forecast data.

1. Open a report that contains one or more columns of forecast data.

2. Click in the data area of a forecast column.

   The *Appearance* tab opens.

3. In the *Display* group, click *Forecast* from the Traffic Lights drop-down menu.

4. In the *Display* group, click *Data Bars*.

   The Data Visualization dialog box opens.

5. Click Visualize.

   The *Conditional Styling* button becomes active.
6. Click **Conditional Styling**.
   The Data Visualization Conditional Styling dialog box opens.

7. Click **Forecast**.

8. In the Forecast area, specify the desired visualization and click **OK**.
   You are returned to the Data Visualization dialog box.

9. Click **OK**.

10. Save and run the report.

    **Note:** The Data Visualization Conditional Styling dialog box allows you to remove a Forecast data visualization after it has been saved. However, if you click **Remove**, it will also remove any conditional styling that you applied to the forecast. In this case, you would need to reset the conditional styling after the data visualization has been removed.

Creating a Parameterized Report Using the Guided Reports Group

A Guided Report is a highly parameterized report that allows you to select fields and options that participate in a report at run time. Fields and options that have been added to the Guided Report are displayed in controls and are available for selection. Selecting fields from controls and running the report will display the data that correlates to the field values. For more information, see *Overview of Guided Reports* on page 320.

You use the options in the Guided Reports group to generate and delete parameter groups. The Guided Reports group is shown in the following image.

![Guided Reports Group](image)

The commands are:

**Generate Parameter Group**

Generates a parameter group from the selected column or columns. It opens a drop-down menu that has the One variable for each selected column and One variable for all selected columns options. One variable for each selected column creates one control for every selected column with all the selected field names as values. One variable for all selected columns creates one control for all selected columns with all the selected field names as values. For more information, see *How to Generate a Parameter Group for One or More Columns* on page 320.
Remove from Parameter Group

Removes a column or columns from the parameter group. This command is available only when the selected columns are part of a parameter group. For more information, see How to Remove One or More Columns from a Parameter Group on page 320.

Overview of Guided Reports

A Guided Report is a highly parameterized report that allows you to select fields and options that participate in a report at run time.

Fields and options that have been added to the Guided Report are displayed in controls and are available for selection. Selecting fields from controls and running the report will display the data that correlates to the field values.

The advantage of using a Guided Report is that you can create one streamlined, highly parameterized report, and from that one report, you can generate thousands of different report outputs at run time. It requires no knowledge of code to customize the final report with the data you want displayed.

Procedure: How to Generate a Parameter Group for One or More Columns

You use this procedure to assign one or more columns to a Parameter Group with either a unique or common variable.

1. Create a report with multiple columns.
2. Select the column or columns to include in the Parameter Group.
3. On the Data tab in the Guided Reports group, click Generate Parameter Group.
4. Select one of the following options:
   - One variable for each selected column. Assigns a unique variable to each column.
   - One variable for all selected columns. Generates one unique variable for all selected columns.

   Note: To reverse a parameter group assignment, you can press Ctrl-Z, provided that this is immediately following the assignment and no other action has taken place on the canvas.

Procedure: How to Remove One or More Columns from a Parameter Group

You use this procedure to remove one or more columns from a Parameter Group assignment.

1. Open or create a report with multiple columns.
2. Review the Parameter Group assignment.
Note: Parameter Group assignments are indicated by an ampersand (&) in the top-left to signify that it is a member of a parameter group. If multiple variables were indicated, each column icon will have a different color scheme. For example, COLUMN1 may have a blue background with a yellow ampersand (&) and COLUMN2 may have a blue background with a white ampersand (&). The color scheme varies depending on how the Parameter Groups were assigned (one variable for each selected column or one variable for all selected columns).

3. Select the column or columns for which you want to remove the Parameter group assignment.

4. On the Data tab in the Guided Reports group, click Remove from Parameter Group.

Controlling the Page Properties of a Report Using the Layout Tab

You can control the page properties of a report using the functionality available on the Layout tab. You can change the margin size, page layout, type of material the report will be printed on, the unit of measurement the report uses, page numbering, cell padding, and whether to autofit columns. The Layout tab is located at the top of the App Studio interface. It is available only when you are creating a report. The Layout tab is shown in the following image.

Changing the Page Properties Using the Page Setup Group

You can change the margins, orientation, paper type, unit of measurement, and page numbering of a report. The Page Setup group is shown in the following image.
The commands are:

**Margins**

Changes the margin dimensions. You can change the margin dimensions using the Custom option or use one of the other four preset margin types, Normal, Narrow, Moderate, or Wide. Selecting Custom opens the Margins dialog box, where you can set each margin value.

**Report Page**

Changes the orientation of the report page. You can select Landscape or accept the default, Portrait.

**Paper Type**

Displays a list of paper types and media outlets for the report output.

**Units**

Displays the unit of measurement in inches, centimeters, or points.

**Page Numbering**

Adds page numbering or removes lead space. You can select On, Off, or OFF without lead space. Select On to turn page numbering on. Select Off to turn page numbering off. Select OFF without lead space to turn off page numbering and the two leading blank lines on each page.

**Applying Cell Padding Using the Report Group**

You can change the way that columns are shown. The Report group is shown in the following image.

![Cell Padding Report](image)

The commands are:

**Cell Padding**

Edits the space between the gap values in the cascading style sheet. The cell padding displays values that indicate the top, left, bottom, and right margins. The values increment by 1/100 of an inch. For more information, see *How to Access the Cell Padding Dialog Box* on page 323.
**Procedure:** How to Access the Cell Padding Dialog Box

1. On the **Layout** tab, in the **Report** group, click **Cell Padding**.
   The Cell Padding dialog box displays.
2. Enter values for Top, Bottom, Left, and Right.
   **Note:** Values increment by 1/100 of an inch.
3. Click **OK**.

**Applying Data or Field View Preferences Using the View Tab**

You use the View tab to change the way that you view your data or fields. The View tab is shown in the following image.

**Changing the Data or Field View Using the Object Inspector Group**

You can change the way that you view your data or fields. When a command is used on the Object Inspector group, that same option is respected on the Object Inspector shortcut menu. The Object Inspector group is shown in the following image.

The command types are:

**Dimension View**

Enables you to view the hierarchical structure of the data if there is a dimension view defined in the Master File. Options include No Extended Information, Alias, Title, and Description. The default is No Extended Information.

**List View**

Enables you to view fields in a list. You can select one or more field categories to view, including Sort Field List, Name, Alias, Title, Description, Format, and Type. Name and Description are selected by default.
Tree View

Enables you to view fields by type in a tree showing the relationship between the segments. Options include No Extended Information, Alias, Title, and Description. The default selection is No Extended Information.

Show Qualified Fields

Enables you to display any list of field names as qualified field names, which includes data sources and table names.

Field Details Section

Enables you to display the field details section in the Object Inspector.

For more information, see Creating Metadata on page 133.

Displaying and Hiding View Components Using the General Group

Allows you to display boundaries, test data, tooltips, invisible fields, and the ruler. The General group is shown in the following image.

![Image of General group settings]

Boundaries

Enables you to show or hide the boundaries for report objects, such as headings and footings.

Test Data

Enables you to display test data in design mode.

Show Field Tooltips

Enables you to display tooltips.

Show Invisible Fields

Enables you to display hidden fields.

Show Ruler

Enables you to display the standard ruler at the top of the Report canvas.
Limiting the Field Length of Data Using the Field Length Group

Allows you to edit the amount of data displayed by a field. The Field Length group is shown in the following image.

![Field Length](image)

**Limit Field Lengths**

Enables you to limit the length of data displayed by a field at design time.

**Field Limit Length**

Enables you to set the maximum length of a field in your report. This option is only available when Limit Field Lengths is selected.

Specifying the Number of Test Data Instances Using the Repetitions Group

Allows you to edit the amount of data displayed by a field. The Repetitions group is shown in the following image.

![Repetitions](image)

**Repetitions**

Enables you to specify the number of test data instances that appear for a field. The default value is 2. You can select 1, 2, or 3.
Specifying the Size of the Report Canvas Using the Zoom Group

Allows you to edit the amount of data displayed by a field. The Zoom group is shown in the following image.

![Zoom](image)

**Zoom**

Enables you to specify the size (magnification/scale) of the Report canvas. For example, 100%, 75%, 50%, or 25%. The default value is 100%.

Viewing Report-Generated SQL Using the SQL Group

Allows you to view the SQL code your report generates. The SQL group is shown in the following image.

![View Generated SQL](image)

**View Generated SQL**

Allows you to view the SQL code generated by your report in a separate viewer. This command is only available if you are creating a report using an RDBMS data source.

Determining Report Space in an HTML Page Using the Virtual Screen Size Group

The Virtual Screen size group lets you set how much space the report will occupy when displayed in an HTML page. The Virtual Screen Size group is shown in the following image.

![Virtual Screen Size](image)

**Width**

Sets the width your report will occupy when displayed in an HTML page.
**Height**

Sets the height your report will occupy when displayed in an HTML page.

**Adding or Editing Images in a Report Using the Images Tab**

You use the Images tab to add images to your report or edit images that are already inserted into your report. The Images tab is shown in the following image.

![Images Tab](image)

**Inserting a New Image in a Report Using the New Image Group**

Allows you to insert a new image into your report. The New Image group is shown in the following image.

![New Image Group](image)

**File**

Enables you to select an image file to insert into your report.

When you add an image to your report from the Data Servers area, the image is saved to the domains folder where the report was created. If the same image is already present in that folder, you are prompted to save a new copy of the image, use the existing image, or overwrite the existing image file.

**Field**

Inserts a new image into your report by using a field that specifies the image file name. This option is enabled if the image is placed in an alpha-numeric field in a header or footer. The app path must contain an image that has the same name as a value in the field. That image will be available to be selected when the Field button is clicked.
Managing a Selected Image Using the Current Image Group

Allows you to select a specific image, delete an image, make an image a drill down, change the location of the selected image, and add a pop-up description to the selected image. This group is unavailable if there is no image in your report. The Current Image group is shown in the following image.

![Current Image Group](image)

**Image**
Displays the name of the selected image. You can change the selected image by clicking the arrow and selecting the image name.

**Delete**
Deletes the selected image.

**Drill Down**
Opens the Drill Down dialog box, where you can make your image a drill-down procedure or a hyperlink to a URL.

**Image Location**
Displays where the image is located. You can click the arrow to change the image location to either the page or the background.

**Popup Desc.**
Displays the pop-up description for an image.
Changing the Position of an Image in a Report Using the Position Group

Allows you to change the horizontal and vertical position of the selected image. The Position group is shown in the following image.

\[
\begin{array}{c}
\text{X} \\
\text{Y} \\
\text{Position}
\end{array}
\]

\[X\]
Displays the horizontal position of the selected image.

\[Y\]
Displays the vertical position of the selected image.

Specifying Image Size Using the Size Group

Allows you specify whether the selected image will have a set size or custom size. The Size group is shown in the following image.

\[
\begin{array}{c}
\text{Custom Size} \\
\text{Width} \\
\text{Height} \\
\text{Size}
\end{array}
\]

Custom Size

Allows you to select whether the image will have a set size or a custom size. When selected, you can enter values into the Width and Height fields.

Width

Specifies the width of the selected image. This field is unavailable when Custom Size is not selected.

Height

Specifies the height of the selected image. This field is unavailable when Custom Size is not selected.
Setting Options for a Selected Image Using the Options Group

Allows you to set various options pertaining to the selected image. The Options group is shown in the following image.

![Options Group](image)

### Line Break

Adds a line break after the selected image, when selected.

### Include As Reference

Includes the current image as a reference, when selected.

The Include As Reference check box is available on the **Images** tab, in the **Options** group, and becomes active when you specify a local file as the image location. To specify a local file, type the location into the source syntax.

### Preserve Ratio

Keeps the aspect ratio of the selected image.

### Show Images in Design View

Shows images when in Design view. This option is selected, by default.

Setting Field Preferences Using the Field Tab

You use the Field tab to change the field type, filter specific fields, sort data in fields, and style the titles and data of a field. The Field tab is located at the top of the App Studio interface. It is accessible only when a field is selected on the Report canvas. The Field tab is shown in the following image.

![Field Tab](image)
Specifying the Type of Field Using the Column Type Group

You can change the field type of a selected field. The Column Type group is shown in the following image.

The command types are:

**Detail**

Changes the field type of the selected field to Detail.

**Aggregate**

Changes the field type of the selected field to Aggregate.

**Sort Down**

Changes the field type of the selected field to Sort Down.

**Sort Across**

Changes the field type of the selected field to Sort Across.

**For Row**

Changes the field type of the selected field to For Row.

**Delete**

Deletes the selected field or column.

The Report canvas uses smart context functionality to determine what column type a field should be, given the metadata of the field and/or the position of the field on the canvas.

If smart context is on, and the metadata indicates that a field should be a measure or dimension, when you add that field to the canvas, it will automatically be added as an aggregate or sort down field type, respectively.

If smart context is on, but the metadata does not indicate whether a field is a measure or dimension, then alphanumeric fields and date fields are added as BY fields, while numeric fields are added as SUM fields.

If smart context is off, all fields are added as DETAIL fields.
If smart context is on, and you try to add a numeric field between two alphanumeric fields, a message will appear, prompting you to either add the field as a sort or an aggregate. If you try to add an alphanumeric field between two numeric fields, a message will also appear, prompting you to either add the field as a COUNT or as an aggregate.

**Applying a Filter to a Field Using the Filter Group**

You can filter fields when creating a report. The Filter group is shown in the following image.

The commands are:

**Filter**

Filters fields using Where, If, Where Total, and Limits screening options. You can access the Expression Builder by selecting Where, If, or Where Total from the Filter drop-down list.

Using the Expression Builder, you can create expressions quickly by selecting fields, relations, operators, and values from lists. You can base selection criteria on a specified value, a variable value, or a field value. For more information, see *Creating Expressions Using the Expression Builder* on page 236.

If you select Limits, the Retrieval Limits dialog box opens where you can set the Record Limit and Read Limit values. This enables you to set how much data is shown or previewed.

**Sorting, Ranking, and Limiting Data Using the Sort Group**

You can sort data, rank data, or limit the amount of data shown. These options are enabled only when Sort Down is selected in the Column Type group. If Sort Across is selected, the options for Up and Down are available. The Sort group is shown in the following image.
The commands are:

Up
Sorts column data from lowest to highest value. If the values were alphabetical, this option would place the columns in alphabetical order.

Down
Sorts column data from highest to lowest value. If the values were alphabetical, this option would place the columns in reverse alphabetical order.

Variable
Enables the user to select the sort order at run time.

Rank
Allows you to enable or disable numeric ranking for the selected column. This is particularly useful when sorting a report vertically.

Hierarchy
Sorts and formats a hierarchy, showing the parent and child relationships.

Note: This option is only available when using a multidimensional data source.

Limit
Limits the number of sort values shown. The options are 5, 10, 15, None, and Variable. When you use Limit with Up, the chosen number of lowest values is shown. When you use Limit with Down, the chosen number of highest values is shown. Limit is available only when the selected field is a By field.

Specifying Sort Field Break Options Using the Break Group
You can add a page break, line break, subheading or subfooting, and subtotal columns. You can also recompute calculated values and recap calculated values. The Break group is shown in the following image.

![Break Group Image](image-url)
The commands are:

**Page Break**

Starts a new report page when the value of a selected sort field changes. Options include On, Off, Variable, or Restart Page Numbering. The default value is Off.

**No Split**

Breaks sort fields logically and regenerates the field heading on the next page or screen. Options include On, Off, or Variable. The default value is Off.

**Line Break**

Inserts a line break at a specified point in the report. The options are On, Off, or Variable. The default value is Off.

**Fold Line**

Causes columns to be placed on a separate line when the value of the sort field changes. This feature is not supported for HTML styled report formats. Click Variable to make the option a parameter whose value is prompted for at run time. Click the ampersand (&) to change the parameter name suffix, display text, order of values, and display or return values.

**Skip Line**

Skips a line on a report when the value of the selected sort field changes. To apply this action in HTML styled report formats, ensure that a cascading style sheet is selected. Click Variable to make the option a parameter whose value is prompted for at run time. Click the ampersand (&) to change the parameter name suffix, display text, order of values, and display or return values.

**Subtotal**

Adds a subtotal for the selected column or on all outer sort fields. The options are Apply to selected column or Apply to all outer sort fields. The Layout tab appears, where you can modify the Page Setup.

**Subheader**

Inserts a subheader for the selected column into the report. The Layout tab appears, where you can modify the Page Setup.

**Subfooter**

Adds a subfooter for the selected column into the report. The Layout tab appears, where you can modify the Page Setup.
Recompute

Recalculates totals for the selected column or on all outer sort fields. Recalculates only at the specified sort break, similar to Subtotal.

Recap

Creates subtotal values in a calculation for the selected column.

Accessing Field Properties

The General and Field Properties dialog boxes contain options that pertain to the selected field. You can access the General and Field Properties dialog boxes by using the shortcut menu of a field, on the Report canvas, and clicking Options. You can also access the General and Field Properties dialog boxes by double-clicking a field on the Report canvas.

Reference: General Dialog Box

Select a Detail or Aggregate field on the Report canvas and click Options from the shortcut menu to open the General dialog box. The General dialog box allows you to control how fields are aggregated and organized.

First Within (BY)

Select a first WITHIN phrase, which requires a BY phrase and/or an ACROSS phrase. A WITHIN phrase allows you to aggregate values for a specific sort field rather than for all sort fields in a report. A maximum of two WITHIN phrases can be used per display command.

Second Within (ACROSS)

Select a second WITHIN phrase, if necessary.

New Line (OVER)

Stacks field names over one another. This is one way to decrease the width of a report, particularly when you are sorting horizontally (Across).

Reference: Field Properties Sorting Tab

Select a Sort By field on the Report canvas and click Options from the shortcut menu to open the Field Properties dialog box at the Sorting tab. The Sorting tab contains options to sort the values in the selected field.

Current Sort Statement

Reflects the sort conditions that are in effect.

Sort Limit

Limits the number of sort values to display.
**Subtotal others**

If a sort limit is applied, subtotals the extra values.

**Title**

The title of the subtotal.

**Total**

These options allow you to simultaneously sort by and aggregate numeric columns.

- **On.** Aggregates a numeric sort field. Total values for the numeric field are used to sort the report.

- **Off.** Does not aggregate the sort field. Unique values are used to sort the report. This is the default option.

- **Variable.** Makes the option a parameter whose value is prompted for at run time. Clicking the ampersand (&) button opens the Guided Variable Definition dialog box, which enables you to change the parameter name suffix, display text, order of values, and display or return values.

**Sort Sequence**

The Sort Sequence button opens the Sort Sequence Builder, which allows you to pull in data from a field and customize sorting priorities.
Reference: Field Properties Grouping Tab

The Grouping tab is only available when you sort a report using a numeric sort field.

Current Sort Statement

Reflects the sort conditions that are in effect.

Grouping

None

No grouping option will be in effect. This is the default option.

IN-GROUPS-OF

Groups sort field values in specified increments.

IN-RANGES-OF

Defines the range by which sort field values are grouped.

Variable

Variable makes the option a parameter whose value is prompted for at run time. Click the ampersand (&) button to open the Guided Variable Definition dialog box, which enables you to change the parameter name suffix, display text, order of values, and display or return values.

Range or Number of Tiles

Allows for a range of number tiles to be present with the grouping.

☐ None is the default option.

☐ Variable makes the option a parameter whose value is prompted for at run time. Click the ampersand (&) button to open the Guided Variable Definition dialog box, which enables you to change the parameter name suffix, display text, order of values, and display or return values.

Limit

If specified, this value limits the number of groups of the specified interval to be retrieved.

☐ On. Allows for a limit to be in place.

☐ Off. Does not allow for a limit to be in place. This is the default option.
Variable. Makes the option a parameter whose value is prompted for at run time. Click the ampersand (&) button to open the Guided Variable Definition dialog box, which enables you to change the parameter name suffix, display text, order of values, and display or return values.

Highest Value

In order to use the Highest Value option, Limit must be set to On or Variable. This option enables you set the highest value for the limit.

None is the default option.

Variable makes the option a parameter whose value is prompted for at run time. Click the ampersand (&) button to open the Guided Variable Definition dialog box, which enables you to change the parameter name suffix, display text, order of values, and display or return values.

Tiles

Select this option to group numeric data into any number of tiles (percentiles, deciles, quartiles, and so on). A new column, labeled TILE by default, is added to the report output and displays the tile number assigned to each instance of the tile field.

Title

You may type in a unique title name.

You can combine these selections with the list of defined Actions.

Accessing Subtotal and Recompute Properties

The General dialog box contains options that pertain to the selected field-level subtotal or recompute. You can access the General dialog box by right-clicking a subtotal or recompute for a field on the Report canvas, and clicking Options.
Reference: **General Dialog Box**

Right-click a subtotal or recompute row for a field on the Report canvas and click Options from the shortcut menu to open the General dialog box. The General dialog box allows you to control how subtotals and recomputes are aggregated and labeled.

**Column list**

Shows a list of aggregate columns in the report. You can specify which to subtotal or recompute and whether to apply a prefix operator aggregation.

**Columns**

By default, field level subtotals and recomputes are applied to all aggregate columns. Select the check box next to each column name to subtotal or recompute only selected columns.

**Prefix**

Applies a prefix operator to the column subtotal or recompute. By default, values are summed, but you can alternatively select average sum of squares, average, count, first, last, maximum, minimum, or specify sum.

**Note:** When all prefix values are set to None, the values are summed, by default. However, if the prefix for a column is set to None and a column above it is set to a different prefix operator, then that prefix is inherited.

**Subtotal/Recompute Text**

Provides options to set the label for subtotal or recompute rows.

**Current Subtotal/Recompute Text**

The label to be displayed in each subtotal or recompute row. You can type a value in the text box.

**Reset to default text**

Click to restore the default label, which is *TOTAL*.

**Suppress for single lines**

When selected, subtotals and recomputes that would be performed on single sort values are not displayed.
Formatting and Styling Report Fields Using the Appearance Tab

You use the Appearance tab while creating or editing a report to filter specific fields, sort data in a field, and style the titles and data of a field. The Appearance tab is located at the top of the App Studio interface. It is only accessible when a field is selected on the Report canvas. The Appearance tab is shown in the following image.

Styling Data, Titles, and Text Using the Style Group

You can style data, titles, and text of a selected field. The Style group is shown in the following image.

This section details the Style group of the Appearance tab, which you can use to apply field-level styles. The Style group also appears on the Reports tab, which you can use to apply report-level styles. For more information, see Applying a Theme and Style to a Report Using the Style Group on page 258.

The commands are:

Scope

Indicates whether style options apply to the data, title, or both.

Bold

Applies bold font formatting to the text or selected object.

Italic

Applies italic font formatting to the text or selected object.

Underline

Underlines the text or selected object.

No Underline

Does not display underlines, even for drilldowns.
Left

Aligns the text or selected object to the left.

Center

Aligns the text or selected object to the center.

Right

Aligns the text or selected object to the right.

Default

Applies the default alignment options. In this case, numerals are aligned to the left and text is aligned to the right.

Column Width

Sets column width options.

Copy Style

Copies the style of the selected object, enabling the Paste Style command.

Paste Style

Pastes your copied style settings to the selected field.

Match Style

Copies the specific style settings from one column to another.

Font Name

Changes typed or highlighted text to the selected font.

Font Size

Changes typed text or a selected object to the selected size.

Color

Changes typed text or a selected object to the selected color.

Background Color

Changes the background color. Opens the Color dialog box, where you can select the background color.

Defaults

Resets the typed text or a selected object to the default style settings.
Borders

Turns borders and gridlines on or off.

Accessing the Styling Toolbar

By default, the Styling toolbar appears above the shortcut menu when you right-click in the Report canvas. If you right-click the canvas area or when the cursor appears as an insert pointer, the Styling toolbar allows you to style the entire report. If you right-click a section of the report, the Styling toolbar can be used to style that section, as shown in the following image.

You can use the Styling toolbar to quickly apply styling changes to the selected element. For reports and the Data Matrix layer of precision reports, you can select the data and/or title areas for one or more columns in the report. For a financial report, you can use the Styling toolbar to style a selected row and its children.
The Styling toolbar contains the following options:

**Bold**
Applies bold font formatting to the text or selected object.

**Italic**
Applies italic font formatting to the text or selected object.

**Underline**
Underlines the text or selected object.

**No Underline**
Do not display underlines, even for drilldowns.

**Left**
Aligns the text or selected object to the left.

**Center**
Aligns the text or selected object to the center.

**Right**
Aligns the text or selected object to the right.

**Default**
Applies the default alignment options. In this case, numerals are aligned to the left and text is aligned to the right.

**Font Name**
Changes typed or highlighted text to the selected font.

**Font Size**
Changes typed text or a selected object to the selected size.

**Color**
Changes typed text or a selected object to the selected color.

**Background Color**
Changes the background color. Opens the Color dialog box, where you can select the background color.

**Defaults**
Resets the typed text or a selected object to the default style settings.
Changing the Format of Numeric Fields Using the Format Group

Use the tools in the Format group to change the formatting of numeric fields. For example, you can add percentage signs to data and indicate currency (with or without symbols). This group is unavailable when the format option or edit option for the selected field are eight characters in length or attempt to go over eight characters in length.

**Note:** If you select For Row, the options in the Format group will be unavailable.

The Format group is shown in the following image.

![Format Group](image)

The commands are:

- **Currency**
  Adds a currency symbol in front of the field data. Enables the selection of a currency, for example Floating Dollar or Fixed Euro. The symbol used is that of the currency selected. If a Fixed currency is selected, no symbol appears. If a Floating currency is selected, the currency symbol appears.

- **Percent**
  Adds a percentage symbol after the field data.

- **Comma**
  Enables the display of commas in the field data.

- **More Decimals**
  Increases the number of decimal positions shown.

- **Less Decimals**
  Decreases the number of decimal positions shown.

**Accessing the Format Dialog Box**

Use the Format dialog box to modify the format of fields in your report.

To access the Format dialog box, right-click a field in the report and click *Format.*
The following format types and formatting options are available:

- **Alphanumeric.** You can use alphanumeric format for any value to be interpreted as a sequence of characters and composed of any combination of digits, letters, and other characters.
  - **Length.** Is the number of characters to display.

- Numeric formats, such as **Decimal, Floating Point, Packed,** and **Integer,** use the following format options:
  - **Length.** Is the number of characters to display for the field.
  - **Decimal.** Is the number of digits that follow the decimal point. This number must be less than the total length.
  - **Comma Options.** Choose whether to include thousands separators, suppress thousands separators, or accept the default.
  - **Percent Options.** Choose whether to not show a percent sign, append a percent sign to the values in the selected field, or multiply by 100 and add a percent sign to compute the percentage.
  - **Negative Number Options.** Choose how to indicate negative values. Selecting **None** places a minus sign (-) before negative values. You can also place the minus sign after negative values, put negative values in parentheses, mark negative values as credits, or suppress the minus sign.
  - **Zero Options.** Allows you to use the default options, display values equal to zero as blanks, or display leading zeroes.
  - **Currency Options.** Allows you to modify how currency values display. You can choose to display no currency symbol, the default currency symbol for your environment, dollar signs, pound sterling symbols, euro signs, yen signs, or currency symbols for other locales. You can also choose whether the currency symbol is fixed, floating, or spaced, and whether it appears to the right or left of the value.

- **Date/Time.** Allows you to modify the order and display of components in date and date-time fields.
  - **Field.** Allows you to use a date, date-time, or numeric format.
  - **Date.** For date or date-time fields, allows you to select the order of date components, which date components to display, and how date components are represented.
Time. For date-time fields, allows you to select how precisely to show time components, whether to use 12-hour or 24-hour time, and the suffix.

Length. For numeric date and date-time fields, allows you to specify the number of digits to display.

VarChar. Can be used similarly to alphanumeric fields, but the length of the field is stored with the data, which can be useful when converting between different databases.

Length. Is the number of characters to display.

Dynamic. Uses values from a selected field as field formats. These values should be valid field formats. You can use this to use different formats for values in the same field.

Dynamic from field. Provides a list of fields from which you can select one to use as a list of field formats.

Managing Data Visualizations Using the Display Group

You can add a data visualization column to a report, display numeric data differently, and add conditional styling. The Display group is shown in the following image.

![Data Visualization Group](image)

The commands are:

Data Bars

Enable the Data Visualization dialog box, through which you can add a data visualization column to the right of a selected numeric field. The column displays values in each row using horizontal bars that extend from left to right in varying lengths, depending on the corresponding data values. For more information, see Accessing the Data Visualization Dialog Box on page 348.

Aggregation

Displays numeric data using a variety of aggregation types. Different aggregation types are available depending on the field and the column type for that field. These aggregation types are:

- None
- Sum
- Average
- Count
- Count Distinct
- Percent of Count
- Distinct Values
- First Value
- Last Value
- Minimum
- Maximum
- Total
- Percent
- Row Percent
- Median
- Mode
- Average Square
- All

**Note:** You can also access these options from the Report canvas shortcut menu by right-clicking a field in your report and pointing to *Aggregation*.

**Traffic Lights**

You use the Traffic Lights functionality to set styling and hyperlinks conditions. Adds conditional styling or modifies existing conditional styling by applying colors to a field in the output when the field meets specified criteria. Options include None, Forecast, or Add/Edit Conditions. If you select *Add/Edit Conditions*, the selection option changes to *Sorted Data*.

To style a specific condition, select a condition and then use the Style group. This will only style the condition you selected.

The styling you add to a condition appears as a preview in the Report canvas when you select the condition in the Traffic Lights drop-down list box.
**Hide Field**

You can hide or show a selected field in the output. Fields added to a report or chart are visible in the output by default. Options include On, Off, or Variable. The default value is Off. When a data field is invisible, it appears on the Report canvas (dimmed) and is not visible in the report output.

*Note:* An invisible column or field may be used in the report as part of a calculation, even though it is set to invisible and will not display in the output.

**Accessing the Data Visualization Dialog Box**

You use the Data Visualization dialog box to define the data visualization bar graphs that appear in your report. You can access the Data Visualization dialog box by selecting a numeric field, and, on the Appearance tab, in the Display group, clicking Data Bars, or by right-clicking the canvas area and clicking Visualization Defaults.

If you are setting conditions to control the display of bar graphs, you use the Data Visualization Conditional Styling dialog box instead of this one.

The Data Visualization dialog box contains the following fields or options:

**Visualize**

Initiates the Data Visualization feature.

**Color**

Specifies the color of the bar graphs. Select a color from the drop-down list. Black is used as the default color.

The color option is the default for HTML, PDF, and PS formats.

**Pattern**

Specifies the shading patterns for bar graphs. Select a shading pattern from the drop-down list.

This option is only available for PDF and PS formats to make graphs in black and white reports more readable. If the report format is HTML, the Pattern option button is inactive because the shading option is only available for PDF and PS formats.

**Graphlook**

Specifies how the graph looks. Select a look from the drop-down list.

*Note:* Graphlook Gauge or Quality do not support negative values. Use Bar Graphs instead.
Scale

Specifies the relative bar graph scaling for multiple report columns under a common Across sort field to which you have applied data visualization.

**Note:** This option only appears when applied to the entire report.

Choose one of the following options from the Scale drop-down list:

**Uniform**

Specifies that each vertical bar graph be scaled based on the minimum and maximum values of the entire set of values compiled from each Across column to which you have applied data visualization bar graphs.

**Distinct**

Specifies that each vertical bar graph be scaled based on the distinct minimum and maximum values for each Across column to which you have applied data visualization bar graphs.

**Maximum Length**

Specifies the length of the longest bar graph.

**Default.** The default length of 60 pixels is used for a vertical bar graph and 80 pixels for a horizontal bar graph.

**Custom.** Sets the value for displaying the vertical or horizontal bar graph for the maximum data value in the associated report column. This value must be a positive number.

This value is initially expressed in the current windows measurement units (inches, centimeters), then converted into the corresponding number of pixels.

**Width**

Specifies the width of the bar graphs in a report.

**Default.** This value is preset based on the current font size.

**Custom.** Sets the value for displaying the width of the bar graphs in a report. This value must be a positive number.

This value is initially expressed in the current windows measurement units (inches, centimeters), then converted into the corresponding number of pixels.

**Default Values button**

Resets all defaults.
Conditional Styling button

Opens the Data Visualization Conditional Styling dialog box where you can define conditions and colors for bar graphs.

Links Group

You can add a hyperlink or drill-down procedure to a selected field in a report.

**Note:** The Links group also appears in the Report tab. For more information, see *Creating Drill-Down Hyperlinks Using the Drill Down Command* on page 274.

Showing or Hiding Columns in an In-Document Analytic Report Using the Analytic Documents Group

You can choose to show or hide columns in an In-Document Analytic report, as shown in the following image.

![Analytic Documents](image)

Present Hidden

You can select which columns are hidden from view, in the report output, when using the HTML Analytic Document output format.

Setting In-Document Analytic Report Options Using the Analytic Document Options Tab

You can change the options that apply to an Analytic Document. The Analytic Document Options tab is located at the top of the App Studio interface and is accessible only when you have selected an Analytic Document output. The Analytic Document Options tab is shown in the following image.

![Analytic Document Options Tab](image)
Changing the Paging of an Analytic Document Using the Cache Group

You can change the paging of a report and the number of rows retrieved. The Cache group is shown in the following image.

The commands are:

**On-Demand Paging**

When on-demand paging is enabled, the viewer displays one page of report output and navigational controls. You use the navigational controls to change the report page that appears in the viewer.

Your browser consists of two frames, the Report Frame and the Viewer Control Panel frame. The Report Frame is the larger frame and contains one page of report output. When you first run a report, the Report Frame contains the first page of report output.

The Viewer Control Panel frame contains the controls you use to navigate through the report and to search for a string. The navigational controls allow you to display the next or previous page, the first or last page, or to display a specific page. You use the searching function to locate a page of the report that contains the search string you specify.

**Rows Retrieved**

Sets the number of rows displayed in the output. The default value is 100.

Setting a Password and Expiration Date of an Analytic Document Using the Viewing Restrictions Group

You can set a password to access an Analytic Document, and set an expiration date so that an Analytic Document is no longer viewable past that date. The Viewing Restrictions group is shown in the following image.
The commands are:

**Password**

Sets a password that must be entered to view the Analytic Document output.

It is a character string up to 32 characters in length. Only standard alphanumeric English characters are allowed in the password for an Analytic Document in AHTML format. National Language Support (NLS) characters are not allowed in the password. Any NLS character in the password for an AHTML report makes the password invalid.

**Expire**

The date when an Analytic Document expires and the report output can no longer be viewed (displayed).

Enter the expiration date in year, month, day (ymmd) format or in day format (1-999 DAYS) where the value indicates the number of days from the current date that the report expires. Valid values are 1 to 999 days. Note that you must enter the number and the word DAYS as part of the value.

**Setting Preferences for Calculations Using the Calculations Group**

You can set the color, position, and options available for calculations. The Calculations group is shown in the following image.

![Calculations Group](image)

The commands are:

**Calculation Options**

Enables you to turn on calculations for fields in the report. All visible fields in the report appear in the Column list in the order they appear in the report. Hidden fields do not appear in the Column list.

You can select a calculation for each field in the Column list from the Calculations dialog box. Calculation options are determined by the field type. If the field is in an alphanumeric format, the drop-down list contains Count and Count Distinct. If the field is a numeric format, the drop-down list contains Sum, Average, Count, Count Distinct, Minimum, Maximum, and Percent.
Values
Opens the Color dialog box, where you can set the color of calculation values.

Background
Opens the Color dialog box, where you can set the background color of calculations.

Top
Displays calculations at the top of the report.

Bottom
Displays calculations at the bottom of the report.

Setting Preferences for Legends Using the Legend Options Group
You can change the visibility, collapsibility, and position of the legend. The Legend Options group is shown in the following image.

The commands are:

Fixed
Sets the legend to always be visible.

Collapsible
Sets the legend to be collapsible.

Bottom Left
Minimizes the legend and moves it to the bottom left.

Bottom Center
Minimizes the legend and moves it to the bottom center.

Bottom Right
Minimizes the legend and moves it to the bottom right.
**Setting Display Options for Multiple Reports Using the Window Display Group**

You can display multiple reports differently. The Window Display group is shown in the following image.

The commands are:

- **Default**
  
  View multiple reports with default windows.

- **Cascade**
  
  View multiple reports with cascading windows.

- **Tabs**
  
  View multiple reports in one window with a tab for each report.

**Freezing Columns of a Report Using the Freeze Columns Group**

You can freeze the selected column and all columns to the left of that column. The Freeze Columns group is shown in the following image.

The command is:

- **Freeze columns**
  
  Freezes the report at a particular point so that columns to the left of the freeze point remain in view while you scroll through the other report columns. You can select any of the fields present on the Report canvas to freeze the report at that point, or you can select *None* to turn off the Freeze option.

  If the report can be fully viewed in the browser window, then freeze is not applied.

  The Freeze columns option is not available for expandable report (Accordion) views.
Setting Display Options for the Status Bar and Navigation Bar Using the Pagination Group

You can set the location and color of the status bar and page navigation bar. You can also specify whether or not to display these bars. The Pagination group is shown in the following image.

![Pagination Group](image)

The commands are:

**Top Left**
Sets the record status bar and page navigation bar to display on the top left.

**Top Center**
Sets the record status bar and page navigation bar to display on the top center.

**Top Right**
Sets the record status bar and page navigation bar to display on the top right.

**Bottom Left**
Sets the record status bar and page navigation bar to display on the bottom left.

**Bottom Center**
Sets the record status bar and page navigation bar to display on the bottom center.

**Bottom Right**
Sets the record status bar and page navigation bar to display on the bottom right.

**Off**
Sets the record status bar and page navigation bar to not display.

**Text**
Sets the text color for the record status bar and page navigation bar. Opens the Color dialog box.

**Background**
Sets the background color for the record status bar and page navigation bar. Opens the Color dialog box.
Designating Colors for Positive and Negative Values in a Report Using the Visualize Group

You can apply data visualization to numeric fields in an Analytic Document. You can designate the colors of the bars and set different colors for positive and negative values. The default color for positive and negative values is black. The Visualize group is shown in the following image.

The commands are:

**Positive**

Sets the color for positive numeric values. Opens the Color dialog box.

**Negative**

Sets the color for negative numeric values. Opens the Color dialog box.

**Icons**

Sets which icon set to use for your Analytic Document.

Setting the Color of a Row in a Report Using the Row Selection Group

You can set the color of a row of data when you pause the mouse pointer on the row or when you select the row. The Row Selection group is shown in the following image.

The commands are:

**Hover**

Sets the color of a row of data when you pause the mouse pointer on the row. Opens the Color dialog box.
Selected
Sets the color of a row of data when you select that row. Opens the Color dialog box.

Setting the Color of Menu Items in a Report Using the Menu Options Group
You can make specific options available in the Analytic Document and set the color of menu items. Click the Launch button on the bottom of the Menu Options group to display the Customize User Interactivity box.

The options are:

Show Records
Adds pagination options when selected.

Filter
Adds filter options when selected.

Freeze
Adds freeze options when selected.

Calculations
Adds calculation options when selected.

Hide/Unhide
Adds hide options when selected.

Chart
Adds chart options when selected.

Export
Adds exportation options when selected.

Visualize
Adds visualization options when selected.

Sorting
Adds sorting options when selected.

Rollup
Adds rollup options when selected.

Pivot (Cross Tab)
Adds pivot options when selected.
Comments
  Adds comment options when selected.

Window Type
  Adds window options when selected.

Restore Original
  Adds restoration options when selected.

Send as Email
  Adds email options when selected.

Save Changes
  Adds save options when selected.

Print
  Adds print options when selected.

Accordion
  Adds accordion options when selected.

Advanced Tools
  Adds tool options when selected.

Grid Tool
  Adds grid options when selected.

Font Text
  Sets the color of menu text. Opens the Color dialog box.

Font Hover
  Sets the color of menu text when you pause the mouse pointer on menu text. Opens the Color dialog box.

Menu Background
  Sets the background color of menu text. Opens the Color dialog box.

Menu Hover
  Sets the background color of menu items when you pause the mouse pointer on the menu items. Opens the Color dialog box.

Menu Border
  Sets the color of the border for menu text. Opens the Color dialog box.
User Level

Sets predefined options for the following user levels:

- **Default.** Enables all options listed above except Advanced Tools and Grid Tool.

- **Power.** Enables all options listed above.

- **Analytical.** Enables the following options: Show Records, Filter, Freeze, Calculations, Hide/Unhide, Chart, Export, Visualize, Sorting, Window Type, Restore Original, Send as Email, Save Changes, Accordion.

- **Business.** Enables the following options: Show Records, Freeze, Calculations, Hide/Unhide, Visualize, Sorting, Restore Original, Send as Email, Save Changes, Print.

- **Custom.** If you select a combination of options that does not match one of the predefined user levels (Default, Power, Analytical, Business), the name Custom appears in the User Level field. This is not a default user type or a selectable user type. It is used to show that options for this user do not match any of the predefined user levels.

Setting the Width and Height for an Analytic Document Using the Application Container Group

Sets the width and height of FLEX or APDF formatted Analytic Documents. The Application Container group is shown in the following image.

![Application Container](image)

**Width**

Sets the width of the In-Document Analytic report container for FLEX or APDF formatted reports.

**Height**

Sets the height of the In-Document Analytic report container for FLEX or APDF formatted reports.
Creating Financial Reports Using the Matrix Tab

You can create, calculate, and present financially oriented data such as balance sheets, consolidations, profit and loss statements, budgets, and certain government mandated reports. These reports are distinguished from other WebFOCUS reports because calculations are inter-row as well as inter-column. Each row or line represents a unique entry or series of entries that can be aggregated directly from the input data, or calculated as some function of the data. The Matrix tab is located at the top of the App Studio interface and is only accessible when a FOR field is selected on the Report canvas and the Matrix tab is selected from the bottom of the Report canvas. The Matrix tab is shown in the following image.

Changing the Report Mode Using the View Group

You use the View group to change the type of a field. The View group is shown in the following image.

The commands are:

- **Design Mode**
  
  Toggles the report between Design mode and Preview mode. Design mode is used to assist you in the creation of your report, and Preview mode allows you to preview what a user will see at run time.

  In Preview mode, the Report canvas displays the following:

  - In the first column, a label assigned to each row in the report, such as R1 and R2 (or an explicit row label if you have supplied one).
  - In the second column, default titles, or titles you assigned to rows in the report, representing TAG values of the FOR field and other row types.
  - In subsequent columns, any other fields you specified for the report.
Display Properties

Shows the properties of the selected row in a dialog box named after the row type. For example, if your row was the DATA type, the DATA dialog box opens. You can edit the properties for that row from this dialog box.

Inserting a Specific Row Type Using the Insert Group

You can use the Insert group to insert or change a row in a report. The type depends on which button you click. You can choose between Tag, Recap, Text, Bar, Data, and Pickup. You can also change a row to a different type using the shortcut menu on the Report canvas. The Insert group is shown in the following image.

The commands are:

Tag

Inserts a tag row or changes a row to a tag row. Tags identify the data values of the FOR field in your report. A report row can be associated with a tag that represents:

- A single data value of the FOR field.
- The aggregate of two or more data values of the FOR field.
- The aggregate of a range of data values of the FOR field.
- The aggregate of a related group of data values of the FOR field.

You can also identify tag values that are organized in a parent/child hierarchy up to 99 levels deep and extending over many rows in the matrix.

The Tag command opens the TAG dialog box, from which you can define all of these variations. You can also access the TAG dialog box by right-clicking a TAG row and clicking Row Properties or by clicking Display Properties on the Matrix tab, in the View group.

The TAG dialog box includes the following options on the Options tab:

- **Value.** Identifies one or more data values for the TAG row. If you are identifying a range of values, this field identifies the first data value in the range. If you are using masking characters to specify a group of tag values with common identifying characters, enter the common and masking characters ($$) in the Values box.
To (optional). If you are identifying a range of values, identifies the last value.

Tags. Displays the values that you have selected for the current TAG row. Click Add to add the values identified in the Value and To fields, allowing you to add multiple separate values or ranges to the TAG row. Select a value or range of values and click Delete to remove it.

Children. These options are available when a parent/child relationship has been defined in the Master File being used for the financial report. You can also specify a descriptive caption in the Master File to display in place of the hierarchy field values in the report.

Show selected item. Retrieves the value for the specified tag in the hierarchy.

Show selected item consolidated. Displays a single summary row for the numeric data values of all children.

Show only children. Displays the hierarchy starting with the first child of the specified parent, up to 99 levels deep. Each child instance appears over the next child instance. The parent level is not included in the output.

Successive levels of the hierarchy field are indented two spaces from the previous level. You can change the spacing of these indents by using the Indent settings in the TAG dialog box.

Show only children to level. Displays children up to the level that you indicate. The default value is 1, which shows direct children. Level 2 retrieves direct children and grandchildren. The parent level is not included in the output.

Show with all children. Displays the hierarchy starting with the specified parent and all children. The parent level is included in the output.

Show with children to level. Displays the values for the specified parent tag and its children, up to 99 levels deep. The default value is 1, which displays direct children. The parent level is included in the output.

Consolidate. Displays a summary row for children up to the level indicated, displayed below the detail rows for the children being summed. Consolidate is supported with the Show only children and Show with children options.

Display children’s caption. If available, displays descriptive text from the Master File as a caption in place of FOR field values.
Indent. Allows you to determine the size indent spaces for children in the report. Children are indented 2 spaces, so the indent size is double the selected value. The default indent size depends on the default unit for the report. For inches, the default value is 0.125, which means children are indented 0.25 inches. The default for centimeters is 0.3175, for an indentation of 0.635 centimeters, and the default for points is 9, for an indentation of 18 points.

You can use the default value, turn indentation off, or specify the indent value.

The TAG dialog box includes the following options on the General tab:

- **Title.** Changes the title of the TAG row. If a title is not specified, the cell will be blank when the report is run. For hierarchical data, the caption defined in the Master File is used for the title.
  - If you add a parent to the matrix and specify Show selected item, the caption is applied. This value appears in the Title input line, where you can edit it.
  - If you add a parent and specify an option that retrieves its children, captions are used as titles and cannot be changed.
  - If no caption is specified in the Master File and you drag a tag value into the matrix, the tag value appears as the title, but can be edited.
    - If you do not want the caption to appear, clear the Display children’s caption check box.

- **Label.** Lists the identification label for the TAG row. You can replace the default row label with one that you specify, although the default label (R1, R2, and so on) is retained internally.

- **Invisible.** Makes the TAG row available for use in calculations, but does not display the row in the report.

- **When Exists.** Displays a row only when data exists for the tag value. By default, a TAG row appears even if no data is found for the tag values.

- **Post To.** Posts the output of a TAG row to a work file. This row can then be used as if it were provided in a DATA row.

**Recap**

Opens the RECAP dialog box, where you can create an expression that derives the value of the RECAP row and assign row properties. Recaps enable you to perform calculations on data in the rows of a report to produce new rows.
To initiate a recap operation, you must supply the format of the value that will receive the result of the calculation, and an expression that defines the calculation you wish to perform. Initially, the default row label (R1, and so on) serves as the identifying label for the calculated value. However, it is good practice to provide a more descriptive label for reference in other calculations.

The RECAP dialog box includes the following options on the Options tab:

- **Column.** Identifies a single column that will contain the recap formula. This is also the column in which the recap output will appear on the report. You can select the column from the drop-down list.

- **Apply to row.** Indicates that the same Recap formula is to be used for all columns in the row. The Column drop-down menu is disabled when you select Apply to row.

- **From Column/To Column.** Defines a range of columns to which the Recap formula is to be applied.

- **Increment.** Indicates an interval of columns in the range that should have the Recap formula applied. For example, a value of 2 will apply the formula to every other column.

  **Note:** Although not directly supported by options in the RECAP dialog box, there are a number of other ways in which you can identify the columns to which you want to apply the recap calculation: column address, column value, and cell notation. To use these features, you must type the required syntax directly into the expression box in the RECAP dialog box.

- **Format.** Identifies the field type, field length, and display options that will be used for the recap output. You can type a format in the text box, or use the Format dialog box by clicking Format.

- **Calculator buttons.** You can use the calculator buttons to enter values and operators for the recap formula instead of typing.

- **Labels.** Allows you to add a row to the formula by selecting its label.

- **By Fields.** Allows you to add a field to the formula.

- **Functions.** Allows you to use a WebFOCUS function in the recap formula.

The RECAP dialog box includes the following options on the General tab:

- **Title.** Changes the title of the RECAP row. If a title is not specified, the cell will be blank when the report is run. For hierarchical data, the caption defined in the Master File is used for the title.
- **Label.** Lists the identification label for the RECAP row. You can replace the default row label with one that you specify, although the default label (R1, R2, and so on) is retained internally.

- **Invisible.** Makes the RECAP row available for use in calculations, but does not display the row in the report.

- **Post To.** Posts the output of a RECAP row to a work file. This row can then be used as if it were provided in a DATA row.

**Text**

Opens the TEXT dialog box, where you can enter a row of text, or a blank row. Type up to 256 characters in the text field or leave it blank to insert a blank row to the report.

The TEXT dialog box includes the Free Text option on the Options tab, which allows you to type text to display in the text row.

The options in the General tab are unavailable for a text row.

**Bar**

Opens the BAR dialog box, where you can add an underline character below columns of numbers. The options include a single (_ ) or double underscore (___ ) character.

The options in the General tab are unavailable for a bar row.

**Data**

Opens the DATA dialog box, where you can assign properties, such as title and label, to a row whose data you supply directly in the request, rather than retrieving it from a data source.

The DATA dialog box includes the following options on the General tab:

- **Title.** Changes the title of the DATA row. If a title is not specified, the cell will be blank when the report is run. For hierarchical data, the caption defined in the Master File is used for the title.

- **Label.** Lists the identification label for the DATA row. You can replace the default row label with one that you specify, although the default label (R1, R2, and so on) is retained internally.

- **Invisible.** Makes the DATA row available for use in calculations, but does not display the row in the report.

- **Post To.** Posts the output of a DATA row to a work file to retrieve later using a PICKUP row.
**Pickup**

Opens the PICKUP dialog box, where you can assign row properties, such as title and label, and indicate the name of a file from which to pick up a row of previously posted data.

The PICKUP dialog box includes the following options on the General tab:

- **Title.** Changes the title of the PICKUP row. If a title is not specified, the cell will be blank when the report is run. For hierarchical data, the caption defined in the Master File is used for the title.

- **Label.** Lists the identification label for the PICKUP row. You can replace the default row label with one that you specify, although the default label (R1, R2, and so on) is retained internally.

- **Invisible.** Makes the PICKUP row available for use in calculations, but does not display the row in the report.

- **Post To.** Retrieves the posted output from a specified work file.

**Creating and Editing Rows and Cells Using the Row/Cell Group**

You use the Row/Cell group to create and edit rows and cells. The Row/Cell group is shown in the following image.

![Row/Cell group](image)

The commands are:

**Add Row**

Adds a blank row at the bottom of the matrix.

**Insert Row**

Inserts a blank row between two existing rows.

**Delete Row**

Deletes the selected row.

**Make Recap (Rows)**

Creates a RECAP row based on the sum of other values in the matrix.
Make Recap (Cells)

Creates a RECAP cell based on the sum of other values in the matrix.

Controlling Report Properties Using the Report Properties Group

You use the Report Properties group to control report properties. The Report Properties group is shown in the following image.

The commands are:

**Use Multiple Values**

Allows you to add the same data value to multiple rows.

**First Instance**

When enabled, adds the .FST to all summed numeric columns, ensuring that the shared value is only counted once.

Controlling Row Properties Using the Row Properties Group

You use the Row Properties group to control row properties. The Row Properties group is shown in the following image.

The commands are:

**Invisible**

When enabled, hides the selected row.

**When Exists**

When enabled, you can hide a row, if no data exists in that row.
Accessing Reporting Components

**Post To**

You can enter the name of a file you want to add to a row of output.

**Accessing WebFOCUS RStat Using the Modeling Tab**

You can use the Modeling tab to access WebFOCUS RStat, a statistical modeling workbench that is embedded in App Studio. You can perform common statistical and data mining tasks, and develop models that can be deployed as scoring applications on every platform. RStat enables data miners and Business Intelligence developers to collaborate with the same tools used to access, manipulate, or transform data, develop predictive models, and create and deploy scoring applications along with associated reports to any worker within their organization.

You can pass any data generated from the Report canvas directly into RStat. After you pass the data to RStat, you can develop your data, join various data sources, build virtual fields, and create data sets to pass to RStat for modeling. The Launch button extracts the data defined within your report and loads it directly into RStat. Within each report, you can customize the name of the hold file that you create, and the location at which it is stored. If you do not customize the name and location of the hold file, a default name and location are assigned.

**Note:** The Modeling tab is only accessible when RStat is installed.

**Launching RStat Using the Modeling Group**

You can run RStat and edit the RStat configuration model options. You can also conduct sampling activities. The commands are:

**Launch**

Extracts the data defined in your report and loads it directly into RStat. RStat opens in a new window.

**Note:** The file name that loads in RStat is that which you define on the RStat Model Configuration dialog box. The default file name is HOLD (HOLD.CSV).

**Parameters**

When you click the Parameters button, the RStat Model Configuration dialog box displays. In this dialog box, you can name the hold file that will be used to pass the model data from the Report canvas into RStat (the default file name is HOLD). You can also define the directory in which the hold file should be placed. You can customize the default hold path for your procedures (.fex files). Your model configuration parameters are saved when you exit the RStat Model Configuration dialog box.
Sampling

Opens the Sampling dialog box. You can generate statistically representative data extracts for data examination and modeling purposes. You can select Random, Numeric Stratified, or Categorical Stratified sampling.

You can also disable sampling. Each option contains a set of criteria that you can edit for the sampling.

**Note:** In order for sampling to work, you must select a data field prior to clicking Sampling. If you do not select a data field, the message *No field is available for sampling* will be the only item that appears in the dialog box.

**Procedure:** How to Launch RStat

2. Add fields to the report.
3. On the **Modeling** tab, in the **Modeling** group, click the RStat icon.
   
   RStat launches in a separate window.
4. Optionally, customize the variables that are imported into RStat.

   **Note:** The fields that you define on your Report canvas are imported into RStat in the order specified in your report.

   For more information on using RStat, see the *Using WebFOCUS RStat for Predictive Analytics* manual.

**Procedure:** How to Set Parameters Using the RStat Model Configuration

You use the Parameters option to specify a name for the data file, as well as an output directory.

1. On the **Modeling** tab, in the **Modeling** group, click **Parameters**.

   The RStat Model Configuration dialog box displays.
2. In the **Hold File Name** field, enter a name for the file or optionally browse to select an existing file.

   **Note:** The default Hold file name is HOLD and displays in the file name field on the Data tab in RStat. If you change the name of the file on the RStat Model Configuration dialog box, this revised file name is reflected in RStat.
3. In the **Hold File Path** field, enter or select a path in which to save the file.

   **Note:** You can restore the original drive and directory by clicking **Default**.
4. Click OK.

When you launch RStat, this file name is the default Hold file used upon entry into the application.

**Working With Sampling Functionality**

The sampling functionality is accessible through the Modeling tab in App Studio. Sampling offers three sampling techniques: Random, Numeric Stratified, and Categorical Stratified.

- **Random Sampling** is a basic sampling technique where you select a group of subjects (a sample) from a larger group (a population). Each individual is chosen entirely by chance and each member of the population has an equal chance of being included in the sample.

- **Stratified Sampling** is obtained by taking separate samples from each sub-group of a population (commonly referred to as a stratum).

  When you sample a population, stratified sampling allows us to ensure that the proportion of each stratum in the sample is the same as in the population. Numeric stratified sampling is used when the field identifying the strata is a number and can be defined in terms of a range. Categorical stratified sampling is used for all other data.

Accessing sampling criteria within the Modeling tab requires that at least one field is defined within the report extract. If no fields have been defined, you will receive a warning message informing you that no fields are available for sampling and the Sampling tab will be present, but no actions will be available. For Random Sampling, which is not tied to a specific field value, any field will open the option. For Stratified sampling, the stratum field (the field on which the strata will be defined) must be included in the report.

**Basic Sampling Concepts and Terminology**

To produce a valid output sample, each sampling definition requires information about the file to be sampled. In each sampling routine, you can use the sample calculator to calculate the values for each of the following or enter your own values:

- **Population Size.** The number of records in the overall data set to be sampled. Before performing a sampling routine, the population size must be determined. Within the sampling function, the population size can be retrieved at design time, generated live at run time, or defined as a fixed value. Although the population size is usually the total number of records in the file, there will be times when you want to sample a subset of the file. To ensure a statistically valid sample, the specified population size must be the same as the number of records sampled.
Confidence Level. Is the probability, expressed in percent, that the selected sample will represent the total population. Most guidelines establish a minimum acceptable confidence level of 90%, 95%, or 98%.

Margin of Error. Represents the amount of error, expressed in percent, that you can tolerate. Lower margins of error require larger sample sizes.

Response Distribution. Allows you to correct for skewness in the sample (if the sample deviates from the normal standard deviation). Use the Response Distribution percentage to account for the skewness in population.

Seed. The statistical sampling routines use a seed value for the pseudo random number generator. This generator produces a series of random numbers from the entered seed. These random numbers are then used to determine each record to include in the sample. The seed has no effect on the number of records included in the sample, it only affects which records are selected. A single seed will produce the same set of random numbers, so if you want to replicate a sample, use the same seed, population size, and record order. To generate a unique sample, enter a new seed value each time.

Sample Size. The number of records that you want to store in the output file. The number should be a positive integer, greater than zero and less than the population size.

Creating Reports Using the Report Canvas

In App Studio a report is a WebFOCUS procedure (with a .fex extension) that returns data from a selected data source, and displays it in a column/row format. You create an App Studio report using the Report Wizard. The wizard lets you specify the location where the report is saved and the data source. It then opens the Report canvas. The Report canvas includes the Object Inspector pane that contains the measures and dimensions of the selected data source. You can drag and drop objects from the Object Inspector to populate the columns and rows of your report.

When you make selections in the Report Wizard, WebFOCUS syntax is automatically generated to produce the report output. You can create reports easily, with no knowledge of the syntax. However, for a summary of WebFOCUS reporting syntax, see Reporting Syntax Summary on page 441.
Creating a Tabular Report

The following image shows a tabular report, which displays cost of goods and revenue sorted across brand types and by product category, creating a matrix report. When you include both BY and ACROSS sort phrases in a report request, information is sorted vertically and horizontally, turning the report into a matrix of information that you read like a grid. A matrix report can have multiple BY and ACROSS sort fields.

Note: The default StyleSheet is used to format the report. You can create your own StyleSheet or choose from other StyleSheets that are available in the product.

Procedure: How to Create a Tabular Report Using the Report Canvas

1. On the Home tab, in the Content group, click Report or in the Environments Tree panel, right-click the desired folder, point to New, point to Reporting, and click Report.

   The Report Wizard opens.

2. Click Create Report.

3. Navigate to where you want to create the new procedure and select a data source. For this example, click wf_retail.mas.

   The Report canvas opens.

4. Add the following fields to your report in the following order. You can double-click the fields in the Object Inspector, or drag them to the Report canvas.

   - PRODUCTCATEGORY
   - BRANDTYPE
   - COGS_US
5. Select the `BRANDTYPE` field and from the Column Type group, select `Sort Across` to sort the report across brand type values.

6. To add a heading to the report, on the Report tab, click `Header & Footer` and select `Report Header`.

7. Type `Cost and Revenue` in the Heading text box.

8. In the Procedure View panel, right-click the `Comment` component, point to `New`, and click `Set`.

   The Set canvas opens.

9. In the Available Settings area, use the scrollbar to locate the `NODATA` setting.

10. Double-click `NODATA` or select `NODATA` and click `Add`.

    The NODATA setting now appears in the Used Settings area.

11. Type `N/A` in the Current Value area to change the default missing data character from a period (.) to N/A to indicate the missing data in the report.

12. Run the report.

Procedure: How to Create a Tabular Report Using WebFOCUS Syntax

You can create the tabular report using the following WebFOCUS syntax, which you can type into a procedure using the Text Editor.

```foocus
TABLE FILE WF_RETAIL
HEADING
"Cost and Revenue"
SUM COGS_US REVENUE_US
BY PRODUCT_CATEGORY
ACROSS BRANDTYPE
ON TABLE SET NODATA N/A
END
```
Creating an Analytic Document

The following image shows an Analytic Document designed for offline analysis. The request uses the ON TABLE PCHOLD FORMAT AHTML command to create the HTML Analytic Document. Analysis options include filtering, sorting, charting, and much more. You click an arrow next to a column heading to gain access to the analytic options. For more information on In-Document Analytics, see the Active Technologies User’s Guide.

Procedure: How to Create an Analytic Document Using the Report Canvas

1. Create the tabular report outlined in How to Create a Tabular Report Using the Report Canvas on page 372.


3. Run the report.

Procedure: How to Create an Analytic Document Using WebFOCUS Syntax

You can create the HTML Analytic Document using the following WebFOCUS syntax, which you can type into a procedure using the Text Editor.
**Procedure:** How to Select the Sort Order for a Control for In-Document Analytic Formats

You can select the sort order of display for a control for In-Document Analytic formats in the HTML and Document canvas. You can select Ascending or Descending from the Sort order option in the Settings panel. Ascending is the default value selected. At run time, the values will be sorted based on the sort order selected.

1. Create an Analytic Document that includes a filter control (for example, a date filter).

   When you run the report, as shown in the following image, notice that date values are sorted in ascending order. Ascending is the default value.
2. Open the report and select the control, as shown in the following image.

![Select a Date control](image-url)
3. From the Settings panel, select *Descending* for the sort order, as shown in the following image.
Creating Reports Using the Report Canvas

When you run the report, as shown in the following image, notice that the date values for the control are now sorted in the descending order.

Select a Date:

<table>
<thead>
<tr>
<th>Date Of Order</th>
<th>Order Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>2002/12/31</td>
<td>68461</td>
</tr>
<tr>
<td>2002/12/20</td>
<td>93820</td>
</tr>
<tr>
<td>2002/12/21</td>
<td>93900</td>
</tr>
<tr>
<td>2002/12/13</td>
<td>94200</td>
</tr>
<tr>
<td>2002/12/10</td>
<td>94490</td>
</tr>
<tr>
<td>2002/12/09</td>
<td>2001/01/01</td>
</tr>
<tr>
<td>2002/12/05</td>
<td>68651</td>
</tr>
<tr>
<td>2002/12/29</td>
<td>74310</td>
</tr>
<tr>
<td>2002/11/28</td>
<td>2001/01/02</td>
</tr>
<tr>
<td>2002/11/27</td>
<td>93940</td>
</tr>
<tr>
<td>2002/11/24</td>
<td>94000</td>
</tr>
<tr>
<td>2002/11/22</td>
<td>94030</td>
</tr>
<tr>
<td>2002/11/21</td>
<td>94270</td>
</tr>
<tr>
<td>2002/11/17</td>
<td>94300</td>
</tr>
<tr>
<td>2002/11/15</td>
<td>94340</td>
</tr>
<tr>
<td>2002/11/13</td>
<td>94380</td>
</tr>
<tr>
<td>2002/11/10</td>
<td>94410</td>
</tr>
<tr>
<td>2002/11/09</td>
<td>94430</td>
</tr>
<tr>
<td>2002/11/08</td>
<td>94450</td>
</tr>
<tr>
<td>2002/11/04</td>
<td>94520</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Product Name</th>
<th>Product Number1</th>
<th>Product Number2</th>
<th>Quantity</th>
</tr>
</thead>
<tbody>
<tr>
<td>b Sales</td>
<td>1030</td>
<td>1030</td>
<td>5</td>
</tr>
<tr>
<td>Bio Expert</td>
<td>1036</td>
<td>1036</td>
<td>2,019</td>
</tr>
<tr>
<td>art</td>
<td>1034</td>
<td>1034</td>
<td>1,122</td>
</tr>
<tr>
<td>City</td>
<td>1036</td>
<td>1036</td>
<td>1,984</td>
</tr>
<tr>
<td>art</td>
<td>1036</td>
<td>1036</td>
<td>1,918</td>
</tr>
<tr>
<td>b Sales</td>
<td>1034</td>
<td>1034</td>
<td>5</td>
</tr>
<tr>
<td>VideoTown</td>
<td>1034</td>
<td>1034</td>
<td>582</td>
</tr>
<tr>
<td>City</td>
<td>1034</td>
<td>1034</td>
<td>1,123</td>
</tr>
<tr>
<td>City</td>
<td>1030</td>
<td>1030</td>
<td>905</td>
</tr>
<tr>
<td>b Sales</td>
<td>1036</td>
<td>1036</td>
<td>14</td>
</tr>
<tr>
<td>Consumer</td>
<td>Merchandise</td>
<td>1034</td>
<td>1,869</td>
</tr>
<tr>
<td>City</td>
<td>1034</td>
<td>1034</td>
<td>417</td>
</tr>
<tr>
<td>b Sales</td>
<td>1034</td>
<td>1034</td>
<td>10</td>
</tr>
<tr>
<td>City</td>
<td>1034</td>
<td>1034</td>
<td>1,297</td>
</tr>
<tr>
<td>Bio Expert</td>
<td>1034</td>
<td>1034</td>
<td>1,165</td>
</tr>
<tr>
<td>JAN, 2001 Web Sales</td>
<td>1034</td>
<td>1034</td>
<td>8</td>
</tr>
<tr>
<td>JAN, 2001 Web Sales</td>
<td>1036</td>
<td>1036</td>
<td>10</td>
</tr>
<tr>
<td>JAN, 2001 Web Sales</td>
<td>1034</td>
<td>1034</td>
<td>11</td>
</tr>
<tr>
<td>JAN, 2001 TV City</td>
<td>1034</td>
<td>1034</td>
<td>945</td>
</tr>
</tbody>
</table>
Creating an Excel FORMULA Table of Contents Report

The following image shows an Excel Workbook with multiple worksheets (tabs) for each value of the major sort field (BY) and with formulas for the column totals. The request uses the ON TABLE PCHOLD FORMAT XLSX FORMULA BYTOC command to create the multiple worksheets.

![Excel FORMULA Table of Contents Report](image)

Procedure: How to Create an Excel Formula Table of Contents Report Using the Report Canvas

2. Select the *Brand Type* field and from the Column Type group, select *Sort Down* to change the field from an Across field to a By field.
3. Drag the *Brand Type* field before the Product Category field so that Brand Type is the first By sort field.
4. From the Report group, click *Column Total* and select *Column Totals* to create totals for each of the numeric columns (Cost of Goods, Revenue) and to show the formula capability.
5. On the Format tab, in the Output Types group, click *Excel* and select *Excel XLSX Formula.* The Output Format Options dialog box opens.
6. Select *On* for the Create separate worksheets for each primary sort value option.
7. Run the report.
**Procedure:** How to Create an Excel Formula Table of Contents Report Using WebFOCUS Syntax

You can create the Excel Formula Table of Contents report using the following WebFOCUS syntax, which you can type into a procedure using the Text Editor.

```
TABLE FILE WF_RETAIL
HEADING
"Cost and Revenue"
SUM COGS_US REVENUE_US
BY BRANDTYPE
BY PRODUCT_CATEGORY
ON TABLE SUBTOTAL
ON TABLE PCHOLD FORMAT XLSX FORMULA BYTOC
END
```

Creating a Financial Report

In a financial report, specific rows can be placed anywhere in the report.

- Rows can be displayed for selected values in the data source (TAG rows).
- Rows can be displayed for values calculated from that data (RECAP).
- Values can be inserted directly or picked up from another file (POST and PICKUP).
- Text rows, blank rows, and rows of bars (BAR) can be inserted at any point in the report for clarity.
- Inter-row and inter-column calculations can be performed at any point in the report.

The following image shows a financial report with cost and revenue for specific products.

![Cost and Revenue](image)

<table>
<thead>
<tr>
<th>Cost of Goods</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>Stereo Systems</td>
<td>$205,113,863.00 $291,294,933.52</td>
</tr>
<tr>
<td>Televisions</td>
<td>$59,077,345.00  $74,962,843.71</td>
</tr>
<tr>
<td>Total Entertainment</td>
<td>$264,191,208.00 $366,257,777.23</td>
</tr>
<tr>
<td>Headphones</td>
<td>$44,281,114.00  $65,769,422.39</td>
</tr>
<tr>
<td>Remote Controls</td>
<td>$17,801,299.00  $23,720,981.20</td>
</tr>
<tr>
<td>Total Accessories</td>
<td>$62,082,413.00 $89,490,403.59</td>
</tr>
<tr>
<td>Total</td>
<td>$326,273,621.00 $455,748,180.82</td>
</tr>
</tbody>
</table>
Procedure: How to Create a Financial Report Using the Report Canvas and Matrix Tab

1. On the Home tab, in the Content group, click Report or in the Environments Tree panel, right-click the desired folder, point to New, point to Reporting, and click Report.

   The Report Wizard opens.

2. Click Create Report.

3. Navigate to where you want to create the new procedure and select a data source. For this example, click wf_retail_sales.mas.

   The Report canvas opens.

4. Add the following fields to your report in the following order. You can double-click the fields in the Object Inspector, or drag them to the Report canvas.

   - ID_PRODUCT
   - COGS_US
   - REVENUE_US

5. To add a heading to the report, on the Report tab, click Header & Footer and select Report Header.

6. Type Cost and Revenue in the Heading text box.

7. Change the StyleSheet of the report. Reports that use cell borders or gridlines will not show bars in the financial report when run.

   On the Report tab, in the Style group, click Change Theme. In the Open File dialog box, navigate to the Legacy Style Templates folder, select ENblack_theme.sty, and click OK.

8. Select the ID_PRODUCT field, and from the Column Type group, select For Row.

9. Click the Matrix tab, to open the Matrix canvas.

   Note: The Matrix view tab is only visible when a FOR field exists.

10. Create a text row to introduce the Entertainment group:

    a. Click Text from the Insert group to make the row a text row, or right-click row R1 (except on the label) and select Change Type to, and then select Text.

       The TEXT dialog box opens.

    b. Type the following in the text box:

       Entertainment:

    c. Click OK.

       Entertainment appears in the Title column on the matrix.
11. Create a row for the Stereo Systems product codes:
   a. In the For field values panel, multi-select 2001 to 2167 and drag the values to row R2 in the ID_PRODUCT column.
      
      Notice that the TAG row type is entered in the Row Type column. You can also select Tag from the Insert group and type the tag values into the dialog box.
      
      By default, for a tag row, the tag values will display in the left on the report. However, you can change the row title on the report. In addition, if you want to use this row in calculations in the report, you can assign it a label to use as a name in the calculations.
      
      b. Right-click 2001 TO 2167 in the ID_PRODUCT column and select Row Properties.
      
      The TAG dialog box opens.
      
      c. On the General tab, type an optional title and label for the 2001 TO 2167 ID_PRODUCT values, for example Stereo Systems and SS, respectively.
      
      d. Click OK to return to the matrix.

12. Create a row for the Televisions product codes:
   a. In the For field values panel, multi-select 4012 to 4018 and drag the values to row R3 in the ID_PRODUCT column.
      
      Notice that the TAG row type is entered in the Row Type column. You can also select Tag from the Insert group and type the tag values into the dialog box.
      
      b. Right-click 4012 TO 4018 in the ID_PRODUCT column and select Row Properties.
      
      The TAG dialog box opens.
      
      c. On the General tab, type an optional title and label for the 4012 TO 4018 ID_PRODUCT values, for example Televisions and TV, respectively.
      
      d. Click OK to return to the matrix.

13. Place an underscore under the Entertainment rows:
   a. Click Bar from the Insert group to make the row a bar row, or right-click row R4 (except on the label) and select Change row type to, and then select Bar.
      
      The BAR dialog box opens.
      
   b. Click OK to accept the default underline character.

14. Add a row that totals the Entertainment products:
   a. Click Recap from the Insert group to make the row a recap row, or right-click row R5 (except on the label) and select Change Type to, and then select Recap.
      
      The RECAP dialog box opens at the Options tab.
b. Type SS + TV in the Recap text box. You can also select SS('Stereo Systems') and TV('Televisions') from the Labels drop-down menu to add them to the Recap text box.

c. Click the General tab and type the title and label for the Recap calculation, for example, Total Entertainment and TOTENT, respectively.

15. Create a text row to introduce the Accessories group:

a. Click Text from the Insert group to make the row a text row, or right-click row R6 (except on the label) and select Change Row Type to, and then select Text.

   The TEXT dialog box opens.

b. Type the following in the text box:

   Accessories:

c. Click OK.

   Accessories: appears in the Title column on the matrix.

16. Create a row for the Headphones product codes:

a. In the For field values panel, multi-select 5001 to 5007 and drag the values to row R7 in the ID_PRODUCT column.

   Notice that the TAG row type is entered in the Row Type column. You can also select Tag from the Insert group and type the tag values into the dialog box.

b. Right-click 5001 TO 5007 and select Row Properties.

   The TAG dialog box opens.

c. On the General tab, type an optional title and label for the 5001 TO 5007 ID_PRODUCT values, for example Headphones and HP, respectively.

d. Click OK to return to the matrix.

17. Create a row for the Remote Controls product codes:

a. In the For field values panel, multi-select 5008 to 5009 and drag the values to row R8 in the ID_PRODUCT column.

   Notice that the TAG row type is entered in the Row Type column. You can also select Tag from the Insert group and type the tag values into the dialog box.

b. Right-click 5008 TO 5009 and select Row Properties.

   The TAG dialog box opens.

c. On the General tab, type an optional title and label for the 5008 TO 5009 ID_PRODUCT values, for example Remote Controls and RC, respectively.

d. Click OK to return to the matrix.
18. Place an underscore under the Accessories rows:
   a. Click Bar from the Insert group to make the row a bar row, or right-click row R9 (except on the label) and select Change Type to, and then select Bar.
      The BAR dialog box opens.
   b. Click OK to accept the default underline character.

19. Add a row that totals the Accessories products:
   a. Click Recap from the Insert group to make the row a recap row, or right-click row R10 (except on the label) and select Change Type to, and then select Recap.
      The RECAP dialog box opens at the Options tab.
   b. Type HP + RC in the Recap text box. You can also select HP('Headphones') and RC('Remote Controls') to add them to the Recap text box.
   c. Click the General tab and type the title and label for the Recap calculation, for example, Total Accessories and TOTACC, respectively.

20. Place an underscore under the Total Accessories row:
   a. Click Bar from the Insert group to make the row a bar row, or right-click row R11 (except on the label) and select Change row type to, and then select Bar.
      The BAR dialog box opens.
   b. Click OK to accept the default underline character.

21. Add a row that totals both the Entertainment and Accessories products:
   a. Click Recap from the Insert group to make the row a recap row, or right-click row R12 (except on the label) and select Change Type to, and then select Recap.
      The RECAP dialog box opens at the Options tab.
   b. Type TOTENT + TOTACC in the Recap box.
   c. Click the General tab and type the title and label for the Recap calculation, for example, Total and TOTAL.

22. Run the report.

The syntax of the resulting financial report is shown in the following example.

**Note:** The page width of this document may cause the syntax to wrap onto multiple lines in the example below. In order to run the example, you must remove any line breaks in the name of the StyleSheet referenced by the INCLUDE statement.
Creating a Precision Report

The precision report is a report type that gives you an additional set of tools that make it easy to control the precise placement of objects and data in the report output. For example, with a precision report, you can quickly create a layout that is perfectly aligned for a preprinted form (like a Bill of Sale or a tax form) and that automatically breaks out one record per report page. Other benefits of precision reports include:

- Select multiple objects to size identically, or space evenly.
- Enhance headers and footers by including fields as display variables.
- Create Composition Templates to run the same precision report with different attribute values.

You can convert an existing report into a precision report or you can create a new precision report.
The following image shows an example of a precision report. Precision reports are built in the Precision Report canvas. You can output them in PDF, DHTML, and PostScript formats.

**Revenue by EMEA**

<table>
<thead>
<tr>
<th>Customer Business Region</th>
<th>Product Category</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>EMEA</td>
<td>Accessories</td>
<td>$211,477.99</td>
</tr>
<tr>
<td></td>
<td>Camcorder</td>
<td>$280,235.28</td>
</tr>
<tr>
<td></td>
<td>Computers</td>
<td>$78,240.81</td>
</tr>
<tr>
<td></td>
<td>Media Player</td>
<td>$424,907.47</td>
</tr>
<tr>
<td></td>
<td>Stereo Systems</td>
<td>$514,689.93</td>
</tr>
<tr>
<td></td>
<td>Televisions</td>
<td>$123,921.37</td>
</tr>
<tr>
<td></td>
<td>Video Production</td>
<td>$112,141.72</td>
</tr>
<tr>
<td>North America</td>
<td>Accessories</td>
<td>$249,935.10</td>
</tr>
<tr>
<td></td>
<td>Camcorder</td>
<td>$349,755.15</td>
</tr>
<tr>
<td></td>
<td>Computers</td>
<td>$87,843.34</td>
</tr>
</tbody>
</table>

For more information on creating a precision report using the Precision Report canvas, see *Creating Precision Reports* on page 392.

**Procedure: How to Create a Precision Report Using the Precision Report Canvas**

The following example shows how to create a precision report showing Revenue by Vendor and Product Category.

1. On the Home tab, in the Content group, click Report or in the Environments Tree panel, right-click the desired folder, point to New, point to Reporting, and click Report.

   The Report Wizard opens.

2. Click Create Report.

3. Navigate to where you want to create the new procedure and select a data source. For this example, click *wf_retail.mas*.

   The Report canvas opens.


   A styling warning message appears indicating that the report will be converted to a precision report. Click Yes to close the message and open the Precision Report canvas.
5. Create a report in the Data Matrix layer:
   a. In the Layers tab, under the Data Matrix layer, click REGION. The region object is displayed as a highlighted square in the Precision Reports canvas.
   b. Click the Fields tab. In the Dimensions folder, expand the Product cube. Expand the Product hierarchy and click Product,Category. Drag it into the region object.
   c. In the Dimensions folder, Product cube, expand the Vendor hierarchy and click Vendor,Business,Region. Drag it into the region object.
   d. In the Measures folder, expand the Sales hierarchy and click Revenue. Drag it into the region object.
   e. Drag the region placeholder to resize the region.

6. Add a Where clause filter in the report to show only non-zero revenue amounts:
   b. From the drop-down menu, click Where. The Expression Builder opens.
   c. In the Measures folder, expand the Sales hierarchy and double-click Revenue. It now displays in the Column to filter field.
   d. In the Logical Relation drop-down list, click is greater than.
   e. In the Compare Type drop-down list, click Value.
   f. In the Compare Value field, type 0. The filter criteria appears as follows.
   g. Click OK to save the filter and close the Expression Builder. The report will now suppress all rows with zero revenue.

7. Add a Report Heading layer to the report with text and an embedded field:
   a. Select the Report Heading layer from the Layers tab.
   b. On the Tools tab, in the Objects group, click Add Text. The pointer becomes an arrow over a letter T.
   c. Click the canvas to add a text box. You can also drag the pointer on the canvas to create a text box in the size that you want.
   
   Note: Use the options in the Default Style group of the Tools tab to select the desired font, size, and style of the text.
   d. Type Revenue by and place the pointer after by.
   e. In the Fields tab, in the Dimensions folder, Product cube, expand the Vendor hierarchy and double-click Vendor,Business,Region. The field is added to the text object as <Vendor,Business,Region>.
8. Add a Page Header layer to the report:
   a. Click the Page Header layer from the Layers tab.
   b. On the Tools tab, in the Objects group, click Add Line. The pointer changes to an arrow over a line segment.
   c. Drag the pointer on the canvas to create a line below the text added in step 7.

9. Click Save.

The Precision Report canvas will appear similar to the following image.

---

**Procedure:** How to Create a Precision Report Using the WebFOCUS Language

You can create the precision report using the following WebFOCUS syntax, which you can type into a procedure using the Text Editor.
Creating a Tabular Report Using an SQL Request

You can retrieve information using the SQL reporting language, and can directly incorporate WebFOCUS formatting commands into the procedure. The following request uses the SQL SELECT statement to create a simple tabular report.

```
SQL
SELECT BRANDTYPE, PRODUCT_CATEGORY, SUM(COGS_US), SUM(REVENUE_US)
FROM WF_RETAIL
GROUP BY BRANDTYPE, PRODUCT_CATEGORY;
END
```
Generating an SQL Script as a Subquery to Another Request

The following request uses the ON TABLE HOLD FORMAT SQL_SCRIPT command to automatically generate a file containing an SQL SELECT statement that can be used as a subquery in another request. The request includes a WHERE phrase to exclude the Accessories product category.

```
TABLE FILE WF_RETAIL
SUM MSRP_US
BY PRODUCT_CATEGORY
WHERE PRODUCT_CATEGORY NE 'Accessories'
ON TABLE HOLD AS app1/sql1 FORMAT SQL_SCRIPT
END
```

The following is the Master File that is generated by the ON TABLE HOLD FORMAT SQL_SCRIPT command:
The following is the Access File that is generated by the ON TABLE HOLD FORMAT SQL_SCRIPT command:

```
FILENAME=SQL1, SUFFIX=SQLMSS, $
SEGMENT=SQL1, SEGTYPE=S0, $
    FIELDNAME=PRODUCT_CATEGORY, ALIAS=E01, USAGE=A40V, ACTUAL=A40V, $
        TITLE='Product,Category', $
    FIELDNAME=MSRP_US, ALIAS=E02, USAGE=D20.2, ACTUAL=D8, $
        TITLE='MSRP', $

The following is the SQL SELECT statement that is generated by the ON TABLE HOLD FORMAT SQL_SCRIPT command and that you can use as a subquery:

```
SELECT T18."PRODUCT_CATEGORY" AS "E01", SUM(T1."REVENUE_US") AS "E02", $
    SUM(T1."COGS_US") AS "E03" FROM (wrd_wf_retail_sales T1 LEFT OUTER JOIN $
    wrd_wf_retail_product T18 ON T18."ID_PRODUCT" = T1."ID_PRODUCT") $
GROUP BY T18."PRODUCT_CATEGORY"
```

The following is a TABLE request that uses the sql1 file:

```
TABLE FILE wf_retail
SUM REVENUE_US
BY PRODUCT_CATEGORY WHERE DB_INFILE(sql1, PRODUCT_CATEGORY, $
PRODUCT_CATEGORY)
END
```

The following is the generated SQL request in which the sql1 file is used as a subquery:
The output is shown in the following image. Note that the Accessories product category is omitted from the report because of the subquery.

<table>
<thead>
<tr>
<th>Product Category</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>Camcorder</td>
<td>$667,254.48</td>
</tr>
<tr>
<td>Computers</td>
<td>$179,761.46</td>
</tr>
<tr>
<td>Media Player</td>
<td>$1,009,790.56</td>
</tr>
<tr>
<td>Stereo Systems</td>
<td>$1,216,393.89</td>
</tr>
<tr>
<td>Televisions</td>
<td>$286,160.68</td>
</tr>
<tr>
<td>Video Production</td>
<td>$259,179.84</td>
</tr>
</tbody>
</table>

Creating Precision Reports

The Precision Report feature gives you an additional set of tools that make it easy to control the precise placement of objects and data in the report output. For example, with a precision report, you can quickly create a layout that is perfectly aligned for a preprinted form (such as a Bill of Sale or a tax form) and that automatically breaks out one record per report page.
You can access the Precision Report canvas by converting an existing report or by creating a new precision report.

**Note:** All of the tabs and panels that you use to develop regular reports are also used in precision reports. The additional tools found in the Precision Report canvas are available only for precision reports.

**Procedure:** How to Access the Precision Report Canvas By Converting an Existing Report

1. Open the procedure (.fex file) for a selected report. To do this, you may use one of the following methods:
   - In the Environments Tree panel, navigate to the desired folder and double-click the report.

2. If the selected procedure was created with the Report canvas, it will automatically open in the Report canvas.
   - If the selected procedure was not created with the Report canvas, it will automatically open in the Procedure Viewer. In this case, double-click a report component to open it in the Report canvas.

   - A style warning message appears, indicating that the report will be converted to a precision report.

4. Click Yes to convert the report and open it in the Precision Report canvas. The next time the report is opened, the Precision Report canvas will automatically be active.

   Similar to the Object Inspector in the Report canvas, the Precision Report canvas includes a window containing tabs used for creating and building Precision Reports. This window has the Fields, Sort Groups, Properties, and Columns tabs found in the Object Inspector, but also includes the Layers tab and Navigate tab, which are unique to the Precision Report canvas.

   By default, the report output is PDF. To change the output format, on the Format tab, in the Output Types group, click Output Format. In the drop-down menu that appears, point to Styled report formats, and click the desired output.

   You may edit the report by changing the alignment and position of the objects in the report.
Reference: Usage Notes for Converting Existing Reports to Precision Reports

The following conditions apply when converting existing reports to precision reports:

- If you are converting a report component that was created using the Document canvas and the output format is not supported by the precision reports feature, the following message displays:

  *Your report is using a locked format that is not supported by Precision Reports.*

  In this case, you may want to create a new precision report to replicate the original, using a supported output format.

- The existing report heading and report footing will not convert to the precision report. You can create them in the Precision Report canvas.

- The subheading and subfooting will convert to the precision report, including the alignment grid options set in the Report canvas. You can edit them in the Data Matrix layer of the Precision Report canvas.

- Reports with images, parameters, and drill downs will convert to the precision report, but you cannot edit them in the Precision Report canvas.

Procedure: How to Access the Precision Report Canvas for a New Report

1. To access the Precision Report canvas for a new report, do one of the following:

   - On the *Home* tab, in the *Content* group, click *Report*.
   - In the Environments Tree panel, right-click the desired folder, point to *New*, point to *Reporting*, and click *Report*.

   The Report Wizard opens.


   The Report canvas opens.

3. On the *Report* tab, in the *Report* group, click *Precision Report*.

   A style warning message appears, indicating that the report will be converted to a precision report. Click Yes to close the message and open the Precision Report canvas.
Accessing Precision Report Components With the Precision Report Canvas Tools Tab

The Precision Report canvas Tools tab contains commands that provide quick access to commonly performed functions. This tab is only available when creating Precision Reports. The availability of the commands is context-sensitive to the object that is highlighted in the canvas.

The Tools tab contains the Objects and Default Style groups, as shown in the following image.

Selecting and Adding Objects in a Precision Report Using the Objects Group

The Objects group contains commands to select and add objects to precision reports, as shown in the following image.

The commands are:

**Select Object**

Allows you to select (single-click) or edit (double-click) an object.

**Tip:** Click *Select Object* after inserting a box, line, image, or text to return to select mode.

**Add Box**

Allows you to add a box to the Precision Report canvas. When this command is active, the pointer becomes an arrow with a box. Click the canvas to add a box. You can also drag the pointer on the canvas to create a box in the size that you want.

When you add a box, the Default Style group on the Tools tab becomes active with options to set the pen size, line style, fill color, and line color.
Add Line

Allows you to add a line to the Precision Report canvas. When this command is active, the pointer becomes an arrow over a line segment. Drag the pointer on the canvas to create a line and adjust it to the size that you want.

When you add a line, the Default Style group on the Tools tab becomes active with options to set the pen size, line style, fill color, and line color.

Add Image

Allows you to add an image to the Precision Report canvas. When this command is active, the pointer becomes an arrow over a flower. Click the canvas or drag the pointer on the canvas to create a box in the size that you want.

The Open File dialog box opens. Select the desired image and click OK.

Add Text

Allows you to add text to the Precision Report canvas. When this command is active, the pointer becomes an arrow over a letter T. Click the canvas to add a text box. You can also drag the pointer on the canvas to create a text box in the size that you want.

When you add text, the Default Style group on the Tools tab becomes active with options to set the font, size, color, and formatting.

Customizing Objects in a Precision Report Using the Default Style Group

The Default Style group contains commands and options to customize the box, line, and text objects added to a precision report. The Default Style group is shown in the following image.

### Pen Size

Sets the default pen size for box and line objects.

### Line Style

Sets the default line style for box and line objects. The options are Solid, Dotted, and Dashed.
Color

Sets the default color for box, line, and text box objects.

Fill Color

Sets the default fill color for box and text box objects.

Font Name

Sets the default font type for text boxes. This option is only available for a text box.

Font Size

Sets the default font size for text boxes. This option is only available for a text box.

Bold

Sets bold font formatting as the default for text boxes. This option is only available for a text box.

Italic

Sets italic font formatting as the default for text boxes. This option is only available for a text box.

Underline

Sets underline font formatting as the default for text boxes. This option is only available for a text box.

Defaults

Resets the style settings of the selected object to the default, original style.

Positioning Objects in a Precision Report With the Precision Report Canvas Positioning Tab

The alignment commands on the Positioning tab enable you to select multiple objects in the same layer and easily position them relative to one another.

The availability of the commands is context-sensitive to the objects that are selected in the canvas. You cannot select multiple objects in different layers.

The Positioning tab contains the Positioning, Distribution, Options and Composition groups, as shown in the following image.
Aligning Objects in a Precision Report Using the Positioning Group

The Positioning group contains commands to align the objects on the Precision Report canvas, as shown in the following image.

Align Left

Aligns the selected object to the left of the last object selected.

Align Right

Aligns the selected object to the right of the last object selected.

Align Top

Aligns the selected object to the top edge of the last object selected.

Align Bottom

Aligns the selected object to the bottom edge of the last object selected.

Make Same Width

Makes two or more objects the same width.

Make Same Height

Makes two or more objects the same height.

Make Same Size

Makes two or more objects the same size.
Controlling Spacing Between Objects in a Precision Report Using the Distribution Group

The Distribution group contains commands to control the spacing on the Precision Report canvas, as shown in the following image.

Space Evenly Across

Sets the horizontal spacing between three or more selected objects to be the same.

Tip: To select multiple objects, use the Shift key.

Space Evenly Down

Sets the vertical spacing between three or more selected objects to be the same.

Setting Grid and Ruler Options for a Precision Report Using the Options Group

The Options group contains commands to set grid visibility and ruler options on the Precision Report canvas, as shown in the following image.

Grid Options

Sets grid visibility and snap option.

Guide Options

Sets guide visibility and snap option.

Note: These options are applicable when the page ruler is on.
Adding or Removing Compositions in a Precision Report Using the Composition Group

The Composition group contains commands to name, add, or remove compositions on the Precision Report canvas, as shown in the following image.

![Composition Name](image)

**Composition Name**

Displays a drop-down list of available compositions. You can rename composition names.

**Add Composition**

Adds a composition. The name of the composition is derived by the system (COMP00).

**Remove Composition**

Deletes a composition.

Working With Precision Report Tabs

The Precision Report canvas is characterized by a window containing multiple tabs. Each tab contains tools that enable you to design and create positioned elements for your precision report. The default tabs are:

- **Layers.** Consists of the Page, Report Heading, Page Header, Data Matrix, Page Footer, and Report Footing layers. For details, see Precision Report Canvas Layers Tab on page 401.

- **Sort Groups.** Displays the sorting method being applied to each column in the Data Matrix layer. For details, see Precision Report Canvas Sort Groups Tab on page 402.

- **Columns.** View and modify the columns in the Data Matrix layer. For details, see Precision Report Canvas Columns Tab on page 403.

- **Fields.** View the fields used in the Data Matrix layer. For details, see Precision Report Canvas Fields Tab on page 404.

- **Properties.** Displays attributes and their editable values, grouped by category. For details, see Precision Report Canvas Properties Tab on page 405.

- **Navigate.** View the entire layout of the Precision Report. For details, see Precision Report Canvas Navigate Tab on page 405.
These tabs are described in the following sections.

**Reference:** Precision Report Canvas Layers Tab

By default, the Layers tab consists of the Page, Report Heading, Page Header, Data Matrix, Page Footer, and Report Footing layers, as shown in the following image. You can add additional layers as needed.

The Data Matrix layer inserts a placeholder for the reporting data. You can snap objects (boxes, lines, images, text) to the layout.

The following commands are available on the Layers tab:

<table>
<thead>
<tr>
<th>Command</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Shows or hides the selected layer in the Precision Report canvas.</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Enables or disables styling changes.</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Enables or disables data changes.</td>
</tr>
<tr>
<td>Command</td>
<td>Definition</td>
</tr>
<tr>
<td>---------</td>
<td>------------</td>
</tr>
<tr>
<td></td>
<td>Enables or disables all changes.</td>
</tr>
<tr>
<td></td>
<td>Creates a new layer for the precision report.</td>
</tr>
<tr>
<td></td>
<td>Deletes the selected object or layer. If a layer is deleted, all objects within it are deleted as well.</td>
</tr>
<tr>
<td></td>
<td>Moves the selected object up or down in the selected layer.</td>
</tr>
</tbody>
</table>

**Reference:** Precision Report Canvas Sort Groups Tab

You can view and modify the sorting properties of fields in the Data Matrix from the Sort Groups tab in the Precision Report canvas, as shown in the following image.

The Sort Groups tab displays the sorting method being applied to each column in the Data Matrix layer. You can change the sorting method (for example, from By to Across or from Detail to Sum) by using the right-click context tab. The changes are reflected in the Columns and Sort Groups tabs and in the Data Matrix layer.

You can also use the Sort Groups tab to create multi-verb requests.
Reference: Sort Type Icons

The icons in the first column to the left of the field name display the type of sort field. The icons and their meanings are defined in the following table:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>🔄</td>
<td>Across field.</td>
</tr>
<tr>
<td>🔽</td>
<td>By field.</td>
</tr>
<tr>
<td>🔼</td>
<td>Sum field.</td>
</tr>
<tr>
<td>📃</td>
<td>Detail field.</td>
</tr>
<tr>
<td>📚</td>
<td>For field.</td>
</tr>
</tbody>
</table>

Reference: Precision Report Canvas Columns Tab

You can view and modify the columns in the Data Matrix layer from the Columns tab in the Precision Report canvas, as shown in the following image.

Right-click a column and select Options from the context tab to open the Field Properties dialog box, where you can format and style the column, as well as apply drill down capabilities. Any changes made to the column properties are reflected in the Data Matrix layer.
Reference: Precision Report Canvas Fields Tab

You can view the fields used in the Data Matrix layer as a:

- Tree separated by segments (the Field Tree).
- List of fields (the Field List).
- Tree separated by Dimensions (the Dimension Tree).

To change the view, right-click in the Fields tab and choose the view from the shortcut menu.

You can double-click or drag segments or fields from this tab to the Precision Report canvas, where they become report columns.

You can customize how you view the fields list and save your settings. Right-click in the Fields tab and select Save Settings options from the shortcut menu.

You can also search for fields in the fields list. Right-click in the Fields tab and select Find Item from the shortcut menu.
Reference:  Precision Report Canvas Properties Tab

The Properties tab displays attributes and their editable values, grouped by category, as shown in the following image.

Reference:  Precision Report Canvas Navigate Tab

You may view the entire layout of the Precision Report in the Navigate tab.

- The slider bar enables you to increase or decrease the zoom percentage of the layout.
Drag the red box in the Navigate tab to view different elements of the precision report in the layout, as shown in the following image.

Creating Precision Reports Using the Data Matrix Layer

Precision reports are created in the Precision Report canvas by using the Data Matrix layer as the reporting object, and by inserting objects in the other layers as fields.

Procedure: How to Build a Report in the Data Matrix Layer

1. To access the Precision Report canvas for a new report, do one of the following:
   - On the Home tab, in the Content group, click Report.
   - In the Environments Tree panel, right-click the desired folder, point to New, point to Reporting, and click Report.
   
The Report Wizard opens.

2. Navigate to the desired folder, choose a data source, and click Finish. For more information on the Report Wizard, see How to Create a Report Using the Report Wizard on page 230.
   
The Report canvas opens.
   A style warning message appears, indicating that the report will be converted to a precision report. Click Yes to close the message and open the Precision Report canvas.

4. If it is not already highlighted, click REGION under the Data Matrix layer in the Layers tab. The REGION object is displayed as a highlighted placeholder in the Precision Report canvas.

5. Double-click the REGION object in the Precision Report canvas. A hand icon displays, indicating that the region is in selection mode.

6. Click the Fields tab. Select a field for the report, and drag it into the region. Repeat this for all of the desired fields. You may resize the region placeholder as needed.

7. Click Save.

Procedure: How to Design the Page Layout for Precision Reports

Once the precision report has been built in the Data Matrix layer, you may design the page layout using the Page layer. Objects you add to the page layer appear on each page of the report at run time. You may add a box, line, or image to the page layer.

You can begin this procedure by opening the report you saved from the previous procedure How to Build a Report in the Data Matrix Layer on page 406.

1. From the Layers tab, click the Page layer to toggle to edit mode.

2. On the Tools tab, in the Objects group, click Add Line.

   The pointer changes to an arrow over a line segment.

3. Drag the pointer to create a line.

   Change the line color and style on the Tools tab, in the Default Style group.

   Tip: After the line object has been added to the page layer, you may use the Properties tab to change the appearance of the line.

4. On the Tools tab, in the Objects group, click Add Image.

   The pointer changes to an arrow over a flower.

5. Click the canvas or drag the pointer to create a box.

   The Open File dialog appears.

6. Select the desired image file, such as a company logo, and click OK.

   The image appears on the page. Resize it as needed.

   Note: You can click Select Object to toggle off the Add Image.
As objects are added to the page layout, they appear under the Page layers.

7. Click Save.

When you run the report, the items added to the page layer appear on every page of the report output.

**Procedure:** How to Add Heading or Footing Layers in the Precision Report Layout

Once the precision report has been built in the Data Matrix layer, you may add Heading and Footing objects as placeholders for fields on your form.

You can begin this procedure by opening the report you saved from the previous procedure How to Design the Page Layout for Precision Reports on page 407.

1. From the Layers tab, click the Report Footing layer to toggle to edit mode to add an object to the report footing. Similarly, you could select the Report Heading, Page Header, or Page Footer layer.

2. On the Tools tab, in the Objects group, click Add Box.

   ![Add Box](image)

   The pointer changes to an arrow over a box.

3. Click the canvas or drag the pointer to create a box.

   **Note:** Objects snap to the grid for perfect alignment.

   Change the color and style of the box on the Tools tab, in the Default Style group.

   **Tip:** After the box object has been added to the page layer, you may use the Properties tab to change the appearance of the box.

   As items are added, they appear under the Heading/Footing layers.

4. Click Save.

   Optionally, you can use the Layers tab to move or delete layer objects.

**Procedure:** How to Add Embedded Fields in the Heading/Footing Text Objects

You may embed fields and variables in your Heading/Footing layers as text objects. The precision report retrieves the value for the field when the report is run.

**Note:** Values for embedded fields are calculated differently in Heading and Footings. Headings use the first value on the page of the report, and Footings use the last value on the page of the report.
You can begin this procedure by opening the report you saved from the previous procedure *How to Add Heading or Footing Layers in the Precision Report Layout* on page 408.

1. From the Layers tab, click the *Report Heading* layer to toggle to edit mode to add a text object to the report heading. Similarly, you could select the *Page Header, Page Footer*, or *Report Footing* layer.

2. On the Tools tab, in the Objects group, click *Add Text*.

   The pointer changes to as an arrow over a letter T.

3. Click the canvas or drag your pointer to create a box, indicating where you want the text to appear in the canvas. Type the desired text. Place the cursor at the position in the text where you want to embed the value.

4. Double-click a field from the Fields tab in the Precision Report canvas.

   This includes Report Variables, Computed, and Defined fields.

   The field is added to the text object as `<FIELDNAME>`.

5. Optionally, you may also perform a calculation on a field value in the text object:
   a. Highlight `<FIELDNAME>` in the text object.
   b. Right-click and choose *Prefix Operators* and the desired operator from the context tab.

   **Tip:** The list of available operators adjusts to show those that are appropriate for the type of field you select.

**Procedure:** How to Control Spacing Between Wrapped Lines

You can use the Wrap Gap option in a style sheet to control spacing between wrapped lines in PDF and PostScript report output. The Wrap Gap option is available only for an active object of type *Data*.

You can begin this procedure by opening the report you saved from the previous procedure *How to Add Embedded Fields in the Heading/Footing Text Objects* on page 408.

1. On the Report tab, in the Style group, click the *Report Width* button.

2. The Width Options dialog box opens.

3. From the drop-down menu, click *Wrap*.

4. Click the *ON* radio button to enable the Wrap Gap option.

   Type the number of inches to leave between wrapped lines and click *OK*.

5. Click *Save*.
**Procedure:** How to Run Different Compositions for the Precision Report

You may run the precision report with different composition templates. Composition templates enable you to run the same precision report with different attribute values.

This can be beneficial if you need to run a precision report with modifications for internal and external use. For example, you have an internal report that shows your trademark image in the Report Heading Layer. You can create a composition template that hides your trademark image for an external customer.

You can begin this procedure by opening the report you saved from the previous procedure *How to Control Spacing Between Wrapped Lines* on page 409.

1. On the Positioning tab, in the Composition group, note that *DEFAULT* is displayed as the Composition Name.

2. To create an additional composition template, click *Add Composition*. Note the new composition name derived by the system is *COMP00*. You can rename the composition by typing over the old one in the Composition Name field.

3. Select the *Properties* tab and expand the *IMAGE* section. For the Visible attribute, change the value to *No*.

4. Click *Save*.

The composition template is added to the selection list. The template in this example hides the image in the precision report. When the report is run under the DEFAULT template, the image will appear. When it is run under the COMP00 template, the image will not appear.

To delete a composition template, select it from the Composition Name drop-down list and click the *Remove Composition* command.

**Editing a Precision Report to Fit a Form**

After you create a precision report, you may need to edit the formatting of it to fit perfectly on a preprinted form. The Properties tab of the Precision Report canvas makes it easy to fine-tune the output to match your form.

**Example:** Matching Output to a Preprinted Form

The following example shows how to edit a precision report to match a preprinted form.

1. Open the desired precision report. On the Format tab, Output Types group, click *Output Format*. Click *DHTML*, *PDF*, or *PS* (PostScript).

2. On the Format tab, Output Types group, click *Output Format Options*. The Output Format Options dialog box appears.
3. Select the option values that will best assist in matching your form and click OK.

   **Note:** Matching output to your preprinted form is an iterative process that will progress through trial and error.

   Click Save.

4. Put your preprinted form in your printer and print a single page of output from the precision report. View the results.

5. Open the precision report. If you need to adjust the alignment of data columns, Open the Properties tab and expand the REGION area. The Position attribute shows four values.

   - The first number (192 in the example above) controls the left side of the region box.
   - The second number (132 in the example above) controls the top of the region box.
   - The third number (588 in the example above) controls the right side of the region box.
   - The fourth number (276 in the example above) controls the bottom of the region box.

   You can edit the numbers to move the region with great accuracy in matching your form.

   In addition to the REGION attribute, you can also fine tune the TEXT attribute as described above.

6. Edit the precision report, save it, and print it on your form again until the alignment is correct.

### Joining Data

You can join two or more related data sources to create a larger integrated data structure from which you can report in a single request. The joined structure is virtual. It is a way of accessing multiple data sources as if they were a single data source. Up to 511 joins can be in effect at one time, for a total of 512 segments, depending on the number of active segments and the number and length of the fields (there is a 256K limit on the length of all fields). Joined files remain physically separate, but are treated as one data source structure throughout the session or until you clear the join.

You can also create a new file structure for reporting by joining existing synonyms of relational tables using the Cluster Joins editor.

### What Is a Join?

A join is a temporary connection between two or more data sources, based on a shared field or on a condition you specify in the JOIN command. For example, since the wf_retail_sales data source includes an ID_STORE field and the wf_retail_store data source also includes an ID_STORE field, you can join the two data sources.
The field type must be the same for the common fields, but the field name and field format do not need to be the same.

After you join two files, each time a record is retrieved from the first file (host data source), it also retrieves the matching records from the second file (cross-referenced data source).

Creating Joins Using Join Functionality

The following section describes the types of joins you can create using the Join functionality.

- **Equijoin.** Used to join two or more data sources that share at least one field and create a virtual structure for reporting. For more information, see Creating an Equijoin on page 412 and How to Create an Equijoin on page 415.

- **Conditional join (WHERE-based).** Uses expressions to specify joins based on conditional criteria, not just on equality between fields. For more information, see Creating a Join Based on Conditional Criteria on page 412 and How to Create a Conditional Join on page 418.

- **Join based on virtual fields (DEFINE-based).** Uses virtual host fields that you can join to real cross-referenced fields. For more information, see Creating a Join Based on Virtual Fields on page 413 and How to Use a Virtual Field as the Join Field on page 417.

- **Left outer join.** Returns all matching rows, in addition to all rows from the host data source that lack corresponding cross-referenced rows. For more information, see Creating a Left Outer Join on page 413.

- **Full outer join.** Returns all rows from the host data source and all rows from the cross-referenced data source. Full outer joins are supported for use with relational data sources that support this type of join. For more information, see Creating a Full Outer Join on page 413.

Creating an Equijoin

You can use an equijoin structure if you need to join two or more data sources that have two fields, one in each data source, with formats (character, numeric, or date) and values in common.

Joining a store ID field in a sales data source (host data source) to the store ID field in a store data source (cross-referenced data source) is an example of an equijoin.

Creating a Join Based on Conditional Criteria

Conditional joins use WHERE-based syntax to specify joins based on conditional criteria, not just on equality between fields. Additionally, the host and cross-referenced join fields do not have to contain matching formats.
Suppose you have a data source that lists stores by their ID number (the host data source) and another data source that lists sales for each store ID by date (the cross-referenced data source). Using a conditional join, you can join the store ID in the host data source to the store ID in the cross-referenced data source to determine which stores had sales in a given date range (the WHERE condition).

**Creating a Join Based on Virtual Fields**

Joins that are based on virtual fields use DEFINE-based syntax to create a virtual field in the host data source that you can then join to a real cross-referenced field. The DEFINE expression that creates the virtual host field may contain only fields in the host data source and constants. It may not contain fields in the cross-referenced data source.

You can join a virtual field to more than one real field in more than one cross-referenced data source using separate Join commands, each referring to the same host data source.

**Creating a Left Outer Join**

When a report omits host rows that lack corresponding cross-referenced rows, the join is called an *inner join*. When a report displays all matching rows, in addition to all rows from the host data source that lack corresponding cross-referenced rows, the join is called a *left outer join*.

For details on left outer join syntax, see the *Creating Reports With WebFOCUS Language* manual.

**Creating a Full Outer Join**

The WebFOCUS Join command and conditional join command have a Full Outer Join option.

A full outer join returns all rows from the host data source and all rows from the cross-referenced data source. Where values do not exist for the rows in either data source, null values are returned. WebFOCUS substitutes default values on the report output (blanks for alphanumeric columns, the NODATA symbol for numeric columns).

The full outer join is only supported for use with those relational data sources that support this type of join, in which case the WebFOCUS Join syntax is optimized (translated to the full outer join SQL syntax supported by the RDBMS). Use of this syntax for any data source that does not support a full outer join, or the failure of the request to be optimized to the engine, produces an error message.

For details on full outer join syntax, see the *Creating Reports With WebFOCUS Language* manual.
Specifying a Single (Unique) and Multiple (Non-Unique) Instance Join

When you create a join using the Join functionality, you can specify whether the join is a single instance or a multiple instance.

A single instance, or one-to-one join structure matches one value in the host data source to one value in the cross-referenced data source.

Joining a store ID field in a sales data source (host data source) to the store ID field in a store data source (cross-referenced data source) is an example of a one-to-one join structure.

A multiple instance or one-to-many join structure matches one value in the host data source to multiple values in the cross-referenced data source.

Suppose you have a data source that lists stores by their ID number (the host data source) and another data source that lists products sold for each store ID (the cross-referenced data source). Joining one instance of each store ID in the host data source to the multiple store IDs in the cross-referenced data source is an example of a one-to-many join structure and would result in a listing of all products sold for each store ID.

Manipulating Data Sources in a Join Using the Join Tab

You can use the Join tab to manipulate data sources when using a join. The Join tab is available only when you are creating a join.

After you join two files, each time a record is retrieved from the first file (host data source), the matching records from the second file (cross-referenced data source) are also retrieved.

Joining Data Sources Using the Join Group

Using the Join group, you can create a new join, add a new data source to the join, clear a join, insert a Define field into a join, create a conditional join, show or hide the procedure (fex) window, perform an automatic join within tables, or blend data sources. The Join group is shown in the following image.
Displaying Data Sources in the Join Using the Windows Group

You can choose how to display the data sources currently in the join as cascading overlapping tiles (default), horizontal tiles that do not overlap, or vertical tiles that do not overlap. The Windows group is shown in the following image.

Creating a Join Using the Join Canvas

You can use the Join canvas to join two or more data sources. The Join component provides a graphical method for creating and manipulating all types of joins. To create a join, you must specify a host data source, and then a cross-referenced data source.

You are responsible for placing the Join object in the correct position within your procedure (that is, before a Define, Report, or Chart), and running it. The join remains active for the entire session, unless you explicitly clear it.

After a join exists, you can retrieve it, report from it, view its syntax, and clear it.

Procedure: How to Create an Equijoin

1. Open an existing procedure, or create a new procedure.
2. In the Procedure View panel, right-click the procedure folder or the component that you want to create the Join after, point to New and click Join.
3. Select a Master File (host data source), for example, wf_retail_sales, and click OK.
   The Join canvas opens and displays the fields in the Master File.
4. On the Join tab, in the Join group, click Add.
   You can also right-click the Join canvas and select Add File.
5. Select a Master File (cross-referenced data source), for example, wf_retail_store, and click OK.
The new Master File is added to the canvas. Common fields in both files are joined by a Join connector line, as shown in the following image.

6. Click **Save**.
7. Click **Run**.

A dialog box opens, displaying the component code, and either an error message or text stating that no error exists.

8. Click **OK** and close the Join canvas.

You can add another component to the procedure by right-clicking the Join component, pointing to **New**, and clicking the component. When you are prompted to select a Master File, select the same host file you used to create the Join component. This allows you to use the joined data sources.

The following is the WebFOCUS Join syntax that is created:

```
JOIN WF_RETAIL_SALES.WF_RETAIL_SALES.ID_STORE IN wf_retail_sales
TO WF_RETAIL_STORE.WF_RETAIL_STORE.ID_STORE IN wf_retail_store AS J0
END
```

**Creating Multi-Field Joins**

In some cases, you might want to join more than one host field to one or more cross-referenced fields.

There are two types of multi-field joins:

- Multi-field joins in which you join multiple host fields to multiple cross-referenced fields.
- Concatenated joins in which the field resulting from the concatenation of two host fields is joined to a single cross-referenced field.
Creating a Virtual Field as the Join Field

You can create a virtual host field that you can join to a real cross-referenced field.

Procedure: How to Use a Virtual Field as the Join Field

1. Open an existing procedure or create a new procedure.
2. In the Procedure View panel, right-click the procedure folder or the component that you want to create the Join after, point to New, and click Join.
3. Select a Master File (host data source) and click OK.
   The Join canvas opens and displays the fields in the Master File.
4. On the Join tab, in the Join group, click Define.
   The Join Define in File dialog box opens.
5. You must associate the virtual field with a segment of the data source.
   a. Type the name of the virtual field you are going to define in the Define Field box.
   b. In the With Field drop-down list box, choose the name of any real field from the segment in which you want to put the virtual field and click OK.
      The virtual field appears in the Fields window of the host data source.
6. On the Join tab, in the Join group, click Add.
   You can also right-click the Join canvas and select Add File.
7. Select a Master File (cross-referenced data source) and click OK.
   The new Master File is added to the canvas. Delete any existing Join connector lines.
8. To complete the Join, drag the mouse pointer from the virtual field to a matching field in the cross-referenced data source.
   You cannot join multiple fields with this option. The virtual field must be the only Join field.

Creating Conditional Joins

Using conditional joins, you can establish joins based on conditions other than equality between fields. In addition, the host and cross-referenced join fields do not have to contain matching formats and the cross-referenced field does not have to be indexed.

Because each data source differs in its ability to handle complex conditional criteria, the optimization of the WHERE syntax differs depending on the specific data sources involved in the join and the complexity of the conditional criteria.
To display a list of joined data sources, select the following query subject in the Query tool, or issue the command from the Command Console:

```
JOIN
```

This query displays every join currently in effect and indicates any that are based on conditional criteria.

**Procedure:** How to Create a Conditional Join

1. Open an existing procedure, or create a new procedure.
2. In the Procedure View panel, right-click the procedure folder or the component that you want to create the join after, point to New, and click Join.
3. Select a Master File (host data source) and click OK.
   
   The Join canvas opens and displays the fields in the Master File.
4. On the Join tab, in the Join group, click Add.
   
   You can also right-click the Join canvas and select Add File.
   
   If you are developing in the Data Servers area or in the domain, a WebFOCUS Table List dialog box opens.
5. Select a Master File (cross-referenced data source) and click OK.
   
   The new Master File is added to the canvas. Common fields in both files are joined by a Join connector line.
6. Select the Join (the connector line), and on the Join tab, click Where/If.
   
   The Where Expression Builder dialog box opens.
7. After you have specified your WHERE criteria, click OK to return to the Join tool.
   
   If you need to change the join type or join name, double-click the conditional join to launch the Join Properties window.

**Customizing a Join**

You can customize an existing join by changing the files or fields involved. If no default join was created, you can use the same technique to specify a connection explicitly.

You can also change the join name, make the join a single instance, use a virtual field as the join field, and add tag names to the join files.

**Procedure:** How to Remove a Data Source From the Join

1. Click the data source you want to remove.
2. Press the Delete key. A confirmation dialog box appears.
   If you delete the host data source, all cross-referenced data sources are automatically deleted.

Procedure: How to Delete a Join

1. Right-click the Join connector line.
2. From the shortcut menu, click Delete.
   You can also select the Join connector line, and on the Join tab, in the Join group, click Clear, or press the Delete key.
   The data sources remain on the canvas with no connector line between them.

Procedure: How to Specify Join Fields

To create your own join (after deleting the existing join, if necessary):

1. Select a field in the host data source panel.
2. Click and hold the selected field.
3. Drag the selected field from the host data source panel onto the matching field located in the cross-referenced data source panel. The pointer changes and displays the appropriate icon when a join is possible.
4. Release the mouse button.
   A Join connector line appears.

Procedure: How to Create Additional Joins

You can leave the Join window open and create another Join by:

- Clicking New on the ribbon.
- Clicking New Join from the shortcut menu on the Join canvas.

You can define up to 511 concurrent Joins that will have a maximum of 512 segments in the new Join structure.

Procedure: How to Make a Join a Single Instance

By default, each join is a multiple instance.
To make the join a single instance:

1. Right-click the Join connector line.
2. From the shortcut menu, click *Single Instance*.

**Changing the Join Name**

A default name is automatically assigned to each join.

You can use the Join name to later clear the join and to prevent another join from overwriting it. If you remove the Join name completely, any subsequent unnamed join will overwrite this join.

**Procedure: How to Change or Remove the Default Join Name**

1. Right-click the Join connector line and from the shortcut menu, click *Join Name*.
   
   The Join Name dialog box displays the default Join name.

2. Edit or delete the name in the Join Name box and click *OK*.

   You can also provide a description. This is not used in the Join command, but for reference purposes. A comment (-*) is added to the procedure. For example, -*JOINDESC J0.*

   **Note:** The following reserved words cannot be used as a Join name: ALL, AND, AS, IN, JOIN, TAG, TO, WITH.

**Procedure: How to Display Current Join Structures**

To display a list of joined data sources, issue the following command from the Command Console:

```
? JOIN
```

This command displays every join currently in effect.

**Adding a Tag Name**

Tag names provide a way of distinguishing between identical field names in the host and cross-referenced data sources. They function as aliases for the file names in the join. Tag names are useful when you join a file to itself because in such a join all field names, segment names, and file names are the same in the host and cross-referenced data sources. Tag names are also useful if a file is used as a target more than once in the join structure.

A procedure can use the tag name of a data source as a qualifier for field names and aliases.
If you create a report using a recursive join without tag names, the field names in the cross-referenced data source are prefixed with the first four characters of the Join name.

**Procedure: How to Add a Tag Name**

1. Double-click the connector line between the tables. The Join Properties dialog box opens. The Join Properties dialog box also opens if you right-click a selected link, and click *Properties* on the shortcut menu. A thick line appears when a join is selected.

2. Enter names in the Host Tag and Cross Tag name fields and click *OK*.

**Note:**

- The following reserved words cannot be used as a tag name: ALL, AND, AS, IN, JOIN, TAG, TO, WITH.

- Tag names can be up to eight characters in length.
Reference: Join Properties Dialog Box

To view or modify the properties of a Join, right-click the Join link and select Properties, or double-click the Join link. The Join Properties window appears, as shown in the following image.

The Join Properties window has the following fields and options:

**Host Tag**

Enter a tag name for the data source.

**Cross Tag**

Enter a tag name for the cross-referenced file.
Selected Fields

Displays the field that has been joined from the host file to the cross-referenced file. A single arrow indicates a unique Join, and a double-arrow indicates a non-unique Join.

Join Name

Displays the name of the Join. To change the default Join name, type a new name in this field and click OK.

Note: The Join name must be unique and cannot exceed eight characters.

Description

Enter a description. This is not used in the Join command. It is used for reference purposes. A comment (-*) is added to the procedure.

Join Type

Indicates the type of Join. Choose from the following:

Multiple Instance (Non-Unique). A one-to-many Join structure that matches one value in the host data source to multiple values in the cross-referenced field. Joining employee ID in an employee data source to employee ID in a data source that lists all the training classes offered by that company would result in a listing of all courses taken by each employee, or a joining of the one instance of each ID in the host file to the multiple instances of that ID in the cross-referenced file. This is the default selection.

Single Instance (Unique). A one-to-one Join structure that matches one value in the host data source to one value in the cross-referenced data source. Joining an employee ID in an employee data source to an employee ID in a salary data source is an example of a unique Join.

Unspecified. This option is selected in the Join properties when a Join that was created in an earlier release is opened in the Join tool. In earlier versions, the defaults for Join type and other operators were assumed and not specified in the generated code. Since the Join tool cannot determine the type of Join that was created and if there were other commands set to control the Join, select the appropriate options (Inner Join, Left Outer Join, Multiple Instances, Single Instances) from the Join tool to upgrade the generated code.

Inner Join. A Join that results when a report omits host rows that lack corresponding cross-referenced rows.
**Left Outer Join.** Extends the results of an Inner Join and retrieves records from both host and cross-referenced tables, including all records from the left table (host) and any records from the right table (cross-referenced) where the condition values match. If there are no matching values in the cross-referenced table, the Join still retrieves records from the host table.

**Detecting and Handling of Fan Traps and Chasm Traps**

WebFOCUS supports complex joins between a large number of data sources. Sometimes requests against a complex join (or star schema) can cause individual columns to be aggregated multiple times, generating inflated results. These constructions are referred to as fan traps or chasm traps.

The relational adapters have a new context analysis process that detects the multiplicative effect and generates SQL script commands that retrieve the correct values for each segment context. These scripts are then passed to the RDBMS as subqueries in an optimized SQL statement.

**Blending Data**

Blending data is the process of gathering data from various sources and combining the useful data into a customized, functioning data set. For example, you may have some of the basic fields available in the current data source. You can use the Blend option to add relevant data fields from a different data source to the current data source in order to create a unique data set.

The Blend functionality allows you to explicitly select the data fields that you want to include. More specifically, you can join multi-fact data structures and combine pertinent external data into your current data source, creating a blended data resource. This can be from local or other system resources.

You may want to blend data if you are reporting from two different fact tables that share a common dimension, such as a product dimension. The Blend option allows a new external fact table, for example an uploaded Excel worksheet, to be added to a multi-segment master as a parent of an existing child segment.

For an example of this, you can view the sample retail database, "wf_retail." The "wf_retail" Master File contains a fact table, "wf_retail_sales," and a dimension table, "wf_retail_store_sales." The "wf_retail_sales" segment is defined as the parent of the "wf_retail_store_sales" segment. You may want to add a second fact table to the report. The second fact table in this example can be an Excel spreadsheet that you upload to App Studio for use with a report or chart. The data in the spreadsheet file that you upload will be joined to the "wf_retail" database using a common dimension field.
The following are some general rules that apply to the Blend option:

- The result of blending is that a single dimension is shared between two fact tables. The table must be based on a cluster with at least two segments. One segment is for Fact table 1, the second segment is for the dimension.

- Do not use the fields from the blended table as a sort field, since these fields will not have a common field when used with fields from other fact tables.

**Procedure: How to Blend Data Using the Join Tab**

This procedure describes how to blend data from two existing data sources. It uses the \textit{wf_retail} Master File and the \textit{product_category_sales} spreadsheet.

1. Create a new procedure or open an existing procedure.

2. In the Procedure View panel, right-click the procedure folder or the component that you want to create the Join after, point to \textit{New}, and click \textit{Join}.

3. Select the \textit{wf_retail} data source from the Select a Data Source dialog box and click \textit{OK}.
   The Join canvas opens and displays the fields in the Master File.

4. Select the \textit{Join} tab on the ribbon and in the Join group, click \textit{Add}.
   You can also right-click in the Join canvas and select \textit{Add File} to add the second part of the join.

5. Select the \textit{product_category_sales} spreadsheet from the Select a Data Source dialog box and click \textit{OK}.  
The new file is added to the canvas. Common fields in both files are linked by a Join connector line, as shown in the following image.

6. To blend the data in the join, select the linked field in each file list, and click the Join connector line.

7. In the Join tab on the ribbon, click the Blend option.

8. Select Inner (default) or Full Outer as the Blend type.

9. Click Run.

A dialog box opens, displaying the component code, and either an error message or text stating that no error exists.

**Example: Blending Data Using WebFOCUS Syntax**

You can blend data using the following JOIN AS_ROOT command, which you can type into a procedure using the Text Editor. In this example, the Projected Excel worksheet is added as a parent of the wf_retail Product dimension. The report output contains field values from the wf_retail_sales fact table and the Projected Excel worksheet for each product category.

```
JOIN AS_ROOT PRODUCTCATEGORY IN WF_RETAIL TO UNIQUE PRODUCTCATEGORY IN PROJECTED
END
TABLE FILE wf_retail
SUM REVENUE_US
PROJECTED_COG
PROJECTED_SALE_UNITS
BY PRODUCTCATEGORY
END
```
Note: The AS_ROOT command is only supported with JOIN syntax as shown above and is not supported for conditional JOIN syntax.

The output of the above syntax is shown below:

<table>
<thead>
<tr>
<th>Product Category</th>
<th>Revenue</th>
<th>Projected COG</th>
<th>Projected Sale Units</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accessories</td>
<td>$499,551.40</td>
<td>90,427,076.00</td>
<td>365717</td>
</tr>
<tr>
<td>Camcorder</td>
<td>$667,254.48</td>
<td>105,615,828.00</td>
<td>325288</td>
</tr>
<tr>
<td>Computers</td>
<td>$179,761.46</td>
<td>70,468,086.00</td>
<td>251911</td>
</tr>
<tr>
<td>Media Player</td>
<td>$1,009,790.56</td>
<td>191,631,034.00</td>
<td>551088</td>
</tr>
<tr>
<td>Stereo Systems</td>
<td>$1,216,393.89</td>
<td>206,563,759.00</td>
<td>795024</td>
</tr>
<tr>
<td>Televisions</td>
<td>$286,160.66</td>
<td>62,014,388.00</td>
<td>75083</td>
</tr>
<tr>
<td>Video Production</td>
<td>$259,179.84</td>
<td>40,380,803.00</td>
<td>142594</td>
</tr>
</tbody>
</table>

Styling Reports

A report consists of several components, each of which can you can format or style. App Studio is installed with a set of StyleSheet files, each of which has a distinctive theme. You can select one of these themes for your output and you can customize selected report components individually. You can create your own styles or use the themes included with App Studio.

Using a styling theme is an excellent way to easily style many different aspects of a report, for example, headings, footings, column titles, backgrounds, fonts, grids, borders, images, and so on. Many companies apply standard style themes to their reports so all of their reports look consistent and professional.

A style theme, once it is applied to a report, is used every time the report is run. If you want to display some of the data differently, you can customize individual styles either for all data or for data that satisfies specific criteria (called conditional styling).

Styling Characteristics

The physical characteristics of a style for a report component consist of the following basic attributes:

- **Text font.** You can use different fonts and font sizes, and selectively apply text styles, such as bold or italic.
- **Color.** You can select a color for the text or background.
- **Conditional styling.** You can apply different styles to the same component based on report values.
- **Column widths.** You can have column widths based on the column content, the field format specified in the Master File, or specify a width.
- **Column placement.** You can specify the starting position of individual columns and arrange columns in any order regardless of the sequence established in the report request. In addition, you can indicate how much space to leave before and after individual columns.
- **Page size.** You can select from a wide range of page sizes for PostScript and PDF reports.
- **Page orientation.** You can select either portrait or landscape for PostScript, PDF, and EXL2K reports.
- **Page margins.** You can specify the top, bottom, left, and right margins, measured in inches, centimeters, or points for PostScript and PDF reports.
- **Justification.** You can justify individual report components.
- **Grids, borders, and images.** You can emphasize headings, footings, and column titles in a report by adding borders and grid lines around them. You can add and position images in a report. An imaged, such as a logo gives corporate identity to a report, or provides visual appeal.

## Introducing StyleSheets

A StyleSheet describes how you want your report to look. You can create a StyleSheet within a report request (useful when you are applying a set of styles to only one report) or as a separate file (useful when you want to create a StyleSheet theme that you can apply to any report). In addition, you can create a StyleSheet on one platform and then port it to, and run it on, other platforms.

You use the Style group, on the Report tab, to apply stylistic changes to a report, including data, title, and all other components of the report. The commands are:

- **Change Theme.** Changes the theme of the report from a list of available StyleSheets.
- **Manage Theme.** References or embeds an external StyleSheet or applies no styling to your report. When you click this button, the StyleSheet Selection dialog box opens. If you do not select a StyleSheet, a default StyleSheet is applied.
- **Save Theme.** Saves your current style options as a stylesheet file (.sty) for future use.
A StyleSheet consists of a set of declarations, which:

- Identify a report component or subcomponent.
- Describe the formatting to apply to that component.
- Optionally, if the component is a heading, footing, or column, specify a position and justification for the component.
- Optionally, specify the distance between columns, column sequence, and column width.
- Optionally, specify a condition that must be true in order to apply the style. This technique is called conditional styling.

In your StyleSheet, you only need to include declarations for those components whose format you want to change. Within each declaration, you only need to include those attributes you want to change.

Each declaration in a StyleSheet consists of attribute=value pairs separated by commas, and terminated with a comma and dollar sign (, $). The syntax is:

```
TYPE=component, attribute=value, ... ,$  
```

For example:

```
TYPE=Report, FONT=Times, SIZE=10, $  
TYPE=Data, COLUMN=REVENUE_US, BACKCOLOR=Aqua, COLOR=Navy, STYLE=Bold,  
WHEN=REVENUE_US GT 500, $  
TYPE=Title, FONT='Helvetica', $  
TYPE=Heading, FONT='Helvetica', STYLE=Bold, SIZE=14, JUSTIFY=Center,  
BACKCOLOR=Dark Turquoise, COLOR=White, $  
TYPE=Heading, LINE=6, BACKCOLOR=White, COLOR=Dark Turquoise,$
```

**Procedure:**  **How to Select a Styling Theme**

The following procedure shows you how to change the default style to a predefined theme.

1. On the Home tab, in the Content group, click Report.
   
   The Report Wizard opens.

2. Click Create Report.
   
   The Select Data Source window opens.

3. Select the *wf_retail.mas* data source and click Finish.
   
   The Report canvas opens.
4. Select the *Full Name*, *Product Name*, and *Revenue* fields and click *Run* on the Quick Access toolbar to view the report with no conditional styling.

<table>
<thead>
<tr>
<th>Full Name</th>
<th>Product Name</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>Aaliyah Akhtar</td>
<td>Pioneer BDP-330 Region Free Blu Ray DVD Player</td>
<td>$699.99</td>
</tr>
<tr>
<td>Aaliyah Little</td>
<td>Polk Audio RM705 5.1-Channel Home Theater Speaker System - Black</td>
<td>$249.99</td>
</tr>
<tr>
<td>Aaliyah Stone</td>
<td>Sony BDP-S370 Region Free Blu Ray DVD Player</td>
<td>$399.99</td>
</tr>
<tr>
<td>Aaron Gregory</td>
<td>Yamaha RX-V3900 7.1-Channel Network Home Theater Receiver</td>
<td>$1,189.00</td>
</tr>
<tr>
<td>Aaron Markley</td>
<td>Panasonic DMP-BD60 Region Free Blu Ray DVD Player</td>
<td>$559.98</td>
</tr>
<tr>
<td>Aaron Shaffer</td>
<td>Panasonic HM-TA1 High Definition Mobile Camera - Red - HM-TA1PP-R</td>
<td>$288.91</td>
</tr>
<tr>
<td>Abbey Sparkes</td>
<td>Canon FS300 Ultra Sleek camcorder-rd</td>
<td>$999.98</td>
</tr>
<tr>
<td>Abby Dickinson</td>
<td>Sony MDR-V900HD Pro Style Headphones</td>
<td>$336.00</td>
</tr>
<tr>
<td>Abdelhadi van Grinsven</td>
<td>Sanyo VPC-CG208K Full HD 1080 Video &amp; 10MP Digital Photos Camcorder</td>
<td>$359.98</td>
</tr>
<tr>
<td>Abdul-Azim Wasem</td>
<td>Sony BDP-S370 Region Free Blu Ray DVD Player</td>
<td>$899.98</td>
</tr>
</tbody>
</table>

5. On the *Report* tab, in the *Style* group, click *Change Theme*.

6. In the Open File dialog box, click the *Legacy Style Templates* folder, as shown in the following image.
**Note:** As of Release 8.2.01M, the following folders were added to the Open File dialog box used by the Change Theme option.

- **Legacy Style Templates folder,** which contains the legacy style files. Prior to Release 8.2.01M, this folder was named Predefined Template Files.

- **Reporting Server Style Templates folder,** which contains style files from the Reporting Server. Prior to Release 8.2.01M, this folder was named Reporting Server Stylesheet Files.

- **Style Templates folder,** which contains the new Warm, Flat, and Dark style files.

7. From the list of style files in the right pane, locate and select a template file, for example, *ENBlue_Light1.sty.* The report styling in the canvas automatically changes, as shown in the following image.

<table>
<thead>
<tr>
<th>Full Name</th>
<th>Product Name</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>Aaliyah Akhtar</td>
<td>Pioneer BDP-330 Region Free Blu Ray DVD Player</td>
<td>$699.99</td>
</tr>
<tr>
<td>Aaliyah Little</td>
<td>Polk Audio RM705 5.1-Channel Home Theater Speaker System - Black</td>
<td>$249.99</td>
</tr>
<tr>
<td>Aaliyah Stone</td>
<td>Sony BDP-S370 Region Free Blu Ray DVD Player</td>
<td>$359.99</td>
</tr>
<tr>
<td>Aaron Gregory</td>
<td>Yamaha RX-V3900 7.1-Channel Network Home Theater Receiver</td>
<td>$1,189.00</td>
</tr>
<tr>
<td>Aaron Markloy</td>
<td>Panasonic DMP-BD60 Region Free Blu Ray DVD Player</td>
<td>$559.98</td>
</tr>
<tr>
<td>Aaron Shaffer</td>
<td>Panasonic HA-TA1 High Definition Mobile Camera - Red - HA-TA1PP-R</td>
<td>$288.91</td>
</tr>
<tr>
<td>Abbey Sparkes</td>
<td>Canon FS300 Ultra Sleek camcorder-rd</td>
<td>$599.98</td>
</tr>
<tr>
<td>Abby Dickinson</td>
<td>Sony MDR-V900HD Pro Style Headphones</td>
<td>$336.00</td>
</tr>
<tr>
<td>Abdelhadi van Grinsven</td>
<td>Sanyo VPC-CG200K Full HD 1080 Video &amp; 10MP Digital Photos Camcorder</td>
<td>$359.98</td>
</tr>
</tbody>
</table>

**Procedure:** How to Apply a Style Theme Using WebFOCUS Syntax

The following request applies the enblue_light1 theme to the report output. The ON TABLE SET STYLE * and ENDSTYLE commands indicate the beginning and the end of an inline StyleSheet.

```
TABLE FILE WF_RETAIL
SUM REVENUE_US
BY FULLNAME
BY PRODUCT_NAME
ON TABLE SET HTMLCSS ON
ON TABLE SET STYLE *
INCLUDE = enblue_light1,
$
ENDSTYLE
END
```
**Procedure:** How to Create a StyleSheet in a Report Request

You can use the following commands in a report request to create a StyleSheet to indicate the beginning and the end of an inline StyleSheet:

```
ON TABLE SET STYLE *
.
.
.
ENDSTYLE
```

For example, in the following report request, the StyleSheet syntax appears in bold.

```
TABLE FILE WF_RETAIL
SUM REVENUE_US BY FULLNAME BY PRODUCT_NAME
ON TABLE SET STYLE *
  TYPE=REPORT, FONT=ARIAL, SIZE=10, $
  TYPE=REPORT, COLUMN=REVENUE_US, COLOR=RED, $
  TYPE=REPORT, COLUMN=FULLNAME, COLOR=BLUE, $
  TYPE=REPORT, COLUMN=PRODUCT_NAME, COLOR=GREEN, $
ENDSTYLE
END
```

The request produces the following report, in which the font for the entire report is Arial 10, the Full Name column is blue, the Product Name column is green, and the Revenue column is red.

<table>
<thead>
<tr>
<th>Full Name</th>
<th>Product Name</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>Aaliyah Akhtar</td>
<td>Pioneer BDP-330 Region Free Blu Ray DVD Player</td>
<td>$699.99</td>
</tr>
<tr>
<td>Aaliyah Little</td>
<td>Polk Audio RM705 5.1-Channel Home Theater Speaker System - Black</td>
<td>$249.99</td>
</tr>
<tr>
<td>Aaliyah Stone</td>
<td>Sony BDP-S370 Region Free Blu Ray DVD Player</td>
<td>$359.99</td>
</tr>
<tr>
<td>Aaron Gregory</td>
<td>Yamaha RX-V3900 7.1-Channel Network Home Theater Receiver</td>
<td>$1,189.00</td>
</tr>
<tr>
<td>Aaron Markley</td>
<td>Panasonic DMP-BD60 Region Free Blu Ray DVD Player</td>
<td>$559.98</td>
</tr>
<tr>
<td>Aaron Shaffer</td>
<td>Panasonic HM-TA1 High Definition Mobile Camera - Red - HM-TA1PP-R</td>
<td>$288.91</td>
</tr>
<tr>
<td>Abbey Sparkes</td>
<td>Canon FS300 Ultra Sleek camcorder-rd</td>
<td>$599.98</td>
</tr>
<tr>
<td>Abby Dickinson</td>
<td>Sony MDR-V900HD Pro Style Headphones</td>
<td>$336.00</td>
</tr>
<tr>
<td>Abdelhadi van Grinsven</td>
<td>Sanyo VPC-CG20BK Full HD 1080 Video &amp; 10MP Digital Photos Camcorder</td>
<td>$359.98</td>
</tr>
<tr>
<td>Abdul-Azim Wasem</td>
<td>Sony BDP-S370 Region Free Blu Ray DVD Player</td>
<td>$899.98</td>
</tr>
<tr>
<td>Abdul-Qawi Moghadam</td>
<td>Bluetooth Audio Streaming, MEGA BASS, Speaker Dock</td>
<td>$127.95</td>
</tr>
</tbody>
</table>

**Conditionally Styling Components in a StyleSheet**

You can conditionally format report components or display a graphic in your report based on the values in your report. Using conditional styling, you can:

- Draw attention to particular items in the report.
- Emphasize differences between significant values.
Procedure: How to Apply Conditional Styling with the Traffic Lights Feature

This procedure shows how you can use the Traffic Lights feature to apply styling in your report based on conditions that you define. You can apply the styling either to an entire row, or to column data only. This example will use a red background to highlight revenue column data amounts that are less than 500.

1. On the Home tab, in the Content group, click Report.
   The Report Wizard opens.
2. Click Create Report.
   The Report Wizard - Select Procedure Location window opens.
3. Select a location for your report and click Next.
   The Select Data Source window opens.
4. Select the wf_retail.mas data source and click Finish.
   The Report canvas opens.
5. Select the Customer Full Name, Product Name, and Revenue fields, and then click Run on the Quick Access toolbar to view the report with no conditional styling.
6. Return to the Report canvas to create a condition for the Revenue field, for which you will later specify styling. Click the Revenue field to highlight it.
7. On the Appearance tab, in the Traffic Lights group, click the drop-down list box and select Add/Edit Conditions.
   **Note:** The Traffic Lights group in the Appearance tab is used to highlight column data only. To highlight an entire row, use the Traffic Lights group in the Reports tab instead.
   The Condition List dialog box opens.
8. Click New.
   The Edit Condition dialog box opens. In the Condition field, a default name CONDO0001 is specified for your new condition, which you can change as required.
9. Complete the Edit Condition dialog box as shown in the following image.
   - Select Revenue for the field.
   - Select is less than for the Relation.
   - Select Value for the Compare Type.
10. Click OK to save your new condition and close the Edit Condition dialog box. You are returned to the Condition List dialog box. Notice that the new condition COND0001 is now listed.

11. Click OK.

12. Select COND0001 from the Traffic Lights drop-down list box to specify styling for the new condition.

13. On the Appearance tab, in the Style group, set the background color to red.

   Note that the red background displays as a preview in the Report canvas when COND0001 is selected.

14. Click Run on the Quick Access toolbar to view the report with conditional styling.
Note that only the Revenue amounts below 500 appear with the red background, as shown in the following image.

![Image showing a table with conditional styling applied to revenue amounts below 500]

The example above shows conditional styling applied to the column data only, because the Traffic Lights group in the Appearance tab was used. To highlight the entire row, use the Traffic Lights group in the Reports tab instead.

**Procedure:** How to Set Conditional Styling Using the WebFOCUS Syntax

This request sets conditional styling to use a red background to highlight revenue amounts that are less than 500.

```webfocus
TABLE FILE WF_RETAIL
SUM REVENUE_US
BY FULLNAME
BY PRODUCT_NAME
ON TABLE SET HTMLCSS ON
ON TABLE SET STYLE *
   INCLUDE = endeflt,$
   TYPE=DATA, COLUMN=REVENUE_US, WHEN=REVENUE_US LT 500, BACKCOLOR='RED' ,$
ENDSTYLE
END
```

**Reference:** Styling Report Components

The following chart lists all report components that you can style.

<table>
<thead>
<tr>
<th>TYPE</th>
<th>Report Component</th>
</tr>
</thead>
<tbody>
<tr>
<td>REPORT</td>
<td>The entire report.</td>
</tr>
<tr>
<td><strong>TYPE</strong></td>
<td><strong>Report Component</strong></td>
</tr>
<tr>
<td>---------------------</td>
<td>----------------------------------------------------------</td>
</tr>
<tr>
<td>PAGENUM</td>
<td>Default page numbers.</td>
</tr>
<tr>
<td>TABHEADING</td>
<td>A heading on the first page of a report.</td>
</tr>
<tr>
<td>TABFOOTING</td>
<td>A footing on or after the last page of a report.</td>
</tr>
<tr>
<td>HEADING</td>
<td>Headings at the top of each report page.</td>
</tr>
<tr>
<td>FOOTING</td>
<td>Footings at the bottom of each report page.</td>
</tr>
<tr>
<td>SUBHEAD</td>
<td>Headings before a particular sort field.</td>
</tr>
<tr>
<td>SUBFOOT</td>
<td>Footings after a particular sort field.</td>
</tr>
<tr>
<td>DATA</td>
<td>Report data.</td>
</tr>
<tr>
<td>TITLE</td>
<td>Column titles.</td>
</tr>
<tr>
<td>ACROSSTITLE</td>
<td>ACROSS field names (that is, field names used in ACROSS phrases).</td>
</tr>
<tr>
<td>ACROSSVALUE</td>
<td>ACROSS field values (that is, values of the ACROSS field).</td>
</tr>
<tr>
<td>SUBTOTAL</td>
<td>Totals generated by SUBTOTAL, SUB-TOTAL, RECOMPUTE, and SUMMARIZE.</td>
</tr>
<tr>
<td>GRANDTOTAL</td>
<td>The last total on a report, which can either be a column total generated by COLUMN-TOTAL or a grand total generated by SUBTOTAL, SUB-TOTAL, RECOMPUTE, or SUMMARIZE.</td>
</tr>
<tr>
<td>RECAP</td>
<td>Lines generated by ON field name RECAP or ON field name COMPUTE.</td>
</tr>
<tr>
<td>UNDERLINE</td>
<td>Underlines generated by ON field name UNDER-LINE.</td>
</tr>
<tr>
<td>SKIPLINE</td>
<td>Skipped lines generated by ON field name SKIP-LINE.</td>
</tr>
<tr>
<td>FREETEXT</td>
<td>FML free text.</td>
</tr>
</tbody>
</table>
Linking Reports with Auto Linking and Auto Drill

When you view a report, you can enhance your analytical insight by drilling down from a summary to a detailed report. Similarly, you may want to drill up from a detailed report, to a summary report, or drill across to see similar information in different contexts.

App Studio provides two features that automate the creation of links that enable these drilldowns:

- **Auto Linking** lets you connect predefined reports, charts, and visualizations together through common filters.

- **Auto Drill** lets you create ad hoc reports, within a dimension hierarchy, that connect to a source report.

These features magnify your analytical capabilities while saving you the significant development and maintenance time required by numerous manual links.

However, you can also create individual drill-down procedures, in cases where that may be advantageous. For more information, see *Creating Drill-Down Hyperlinks Using the Drill Down Command* on page 274.

Link to Predefined Reports, Charts, and Visualizations Using Auto Linking

Use the Auto Linking feature to connect a source procedure to one or more predefined target reports, charts, or visualizations. The links that enable these connections are created automatically by the Auto Linking feature.

The Auto Linking source/target relationship is structured as follows:

- **Auto Linking Source Report.** The source report has the Enable Auto Linking property set to Yes. Also, the source report contains one or more columns that correspond with parameters that can be passed to the target reports. For example, if the source report has a Product Category column, it can Auto Linking to target reports that have Product Category as a parameter.

- **Auto Linking Target Reports.** The target reports have both the Enable Auto Linking property, and the Auto Link Target property set to Yes. Also, they must have one or more parameters that correspond with columns in the source report.

Because Auto Linking reports, charts, and visualizations are manually tagged with the Auto Linking property values, you control the allowable drilldowns. This can prevent report users from drilling down too far and losing focus.
In the following image, the source report on the left shows all Product Categories. Since Auto Linking is enabled in the source, the Product Categories all appear as hyperlinks. The Auto Linking Target property has been set for 3 reports that all have filters for Product Category.

In the following example, the user clicked Camcorder and selected a drill-down report, shown on the right. The source passed the camcorder parameter to the predefined target report, which includes a WHERE filter for Product Category. The resulting drill-down report shows camcorder information only, down to the model level.

Once the target reports are tagged with the Auto Linking property values, they are eligible to be used as targets for other source reports in the domain that use the same parameter. They will automatically appear in the Auto Linking lists for those reports.

**Procedure:** How to Connect Reports, Charts, and Visualizations with Auto Linking

1. Select a report, chart, or visualization that you wish to designate as a source. The source report must contain one or more columns that correspond with parameters that can be passed to the target reports. In the File/Folder Properties panel, change the Enable Auto Linking property to **Yes**.

   Close the source.

2. Select a report, chart, or visualization that you wish to designate as a target. The target report must have one or more parameters that correspond with columns in the source report. In the File/Folder Properties panel, change the Enable Auto Linking property to **Yes** and change the Auto Link Target property to **Yes**.

   Close the target. Repeat this step for additional targets, as needed.
3. Run the source report.

Hyperlinks automatically appear for columns that support Auto Linking. Click a hyperlink and select a target report from the context menu. Note that the resulting report opens in a new tab on your browser.

**Link to Ad Hoc Reports, Charts, and Visualizations Using Auto Drill**

Use the Auto Drill feature to connect a source procedure to one or more ad hoc target reports, charts, or visualizations, within a dimension hierarchy. The links that enable these connections are created automatically by the Auto Drill feature, and the resulting target reports are created automatically, on the fly, when invoked.

The Auto Drill source/target relationship is structured as follows:

- **Auto Drill Source Report.** A report, chart, or visualization may be a source for Auto Drill when the following conditions are met:
  - The Enable Auto Drill property is set to Yes.
  - The report contains one or more sort columns that exist within a dimension hierarchy in the master data. Either BY or ACROSS sorting will generate hyperlinks automatically in the source report.
  - The report output type must be HTML or HTML Analytic Document.

- **Auto Drill Target Reports.** An ad hoc target report is generated automatically when you click a hyperlink in a source report. The parameter that you clicked in the dimension hierarchy is automatically passed to the target report. A target report can also contain links to drill down further in the hierarchy.

Because Auto Drill target reports, charts, and visualizations are generated automatically on the fly, you can drill down anywhere within a dimension hierarchy. This gives you an open-ended, high-capacity analytical capability.

In the following image, the Auto Drill source report on the left shows all Product Category and Product Subcategory fields as hyperlinks, since these two columns are in the same dimension hierarchy.
In the following example, the user clicked the Standard subcategory under the Camcorder category. From the resulting menu, the user selected Drill down to Model. An ad hoc report was generated, shown on the right. The source passed the camcorder and standard parameters to the target, which shows those parameters only, down to the model level.

Since Model, in the above example, is the bottom of the dimension hierarchy, we cannot drill down further. Clicking a hyperlink in the Model column results in two options: Restore Original or Drill up to Product Subcategory. You can also return to the original source by clicking the Home breadcrumb trail, at the top of the target report.

Ineligible Conditions

Auto Drill functionality is not supported under the following conditions:

- You may run your source report, chart, or visualization in deferred mode, or you may distribute it through ReportCaster. However, under these conditions, Auto Drill functionality is not supported.

- Auto Drill functionality is not supported for all HTML output format charts. It is not supported for HTML5 output format charts that do not support the new chart attribute syntax.

- Auto Drill functionality is not supported on Across fields in Analytic Documents.

- Auto Drill functionality is not supported when Accessibility options are on.

- Imported Auto Drill reports are not supported in the HTML canvas. Only Referenced Auto Drill reports are supported.
Procedure: How to Connect Reports, Charts, and Visualizations with Auto Drill

1. Select a report, chart, or visualization that you wish to designate as a source. The source must contain one or more sort columns that exist within a dimension hierarchy in the master data.

2. On the Format tab, click the Auto Drill button. In the File/Folder Properties panel, the Enable Auto Drill property value is changed to Yes.

3. Run the source report.

Hyperlinks automatically appear for columns that support Auto Drill. Click a hyperlink to drill down. Note that the resulting ad hoc report overwrites the source report on your browser, but you can navigate back using the breadcrumb trail, at the top of the report.

Note: If you have created a chart that has multiple dimension sort fields in the request, some of which belong to the same dimension hierarchy, multiple links to the same target may result.

Reporting Syntax Summary

This topic summarizes the WebFOCUS reporting commands and options that you can type directly into the Text Editor. For detailed information about these commands and options, see the Creating Reports With WebFOCUS Language manual.

```plaintext
TABLE FILE filename
HEADING [CENTER] "text"
{display_command} [SEG.] field [/R|/L|/C] [/format]
{display_command} [prefixop.] [field] [/R|/L|/C] [/format]
[NOPRINT|AS 'title1,...,title5'] [AND|OVER] [obj2...obj1024]
[WITHIN field] [IN n]
COMPUTE field [/format] = expression; [AS 'title,...,title5'] [IN n]
[AND] ROW-TOTAL [/R|/L|/C] [/format] [AS 'name']
[AND] COLUMN-TOTAL [/R|/L|/C] [AS 'name']
ACROSS [HIGHEST] sortfieldn [IN-GROUPS-OF qty]
[NOPRINT|AS 'title1,...,title5']
BY [HIGHEST] sortfieldn [IN-GROUPS-OF qty]
[NOPRINT|AS 'title1,...,title5']
BY [HIGHEST|LOWEST] TOTAL [prefix_operator] {field|code_value}
RANKED [AS 'name'] BY (TOP|HIGHEST|LOWEST) [n] field
[PLUS OTHERS AS 'othertext']
[IN-GROUPS-OF qty [TILES [TOP m]] [AS 'heading']]
[NOPRINT|AS 'title1,...,title5']
{BY|ACROSS} sortfield IN-RANGES-OF value [TOP limit]
ON sfield option1 [AND] option2 [WHEN expression;...]
ON sfield Recap fld1 [/fmt] = FORECAST (fld2, intvl, npredct,
'(MOVAVE|EXPAVE)', npnt);
```
ON `sfld RECAP` `fld1` `/fmt` = FORECAST(`fld2`, `interval`, `npredict`, 'DOUBLEXP', `npoint1`, `npoint2`);

ON `sfld RECAP` `fld1` `/fmt` = FORECAST(`fld2`, `interval`, `npredict`, 'SEASONAL', `nperiod`, `npoint1`, `npoint2`, `npoint3`);

ON `sfld RECAP` `fld1` `/fmt` = FORECAST(`fld2`, `intvl`, `npredict`, 'REGRESS');

ON `{sortfield|TABLE} RECAP` `y` `/fmt` = REGRESS(`n`, `x1`, `[x2, [x3]]`) `z`;
ON `sfld RECAP` `fld1` `/fmt` = FORECAST(`infield`, `interval`, `npredict`, 'DOUBLEXP', `npoint`, `npoint2`);
ON `sfld RECAP` `fld1` `/fmt` = FORECAST(`infield`, `interval`, `npredict`, 'SEASONAL', `nperiod`, `npoint`, `npoint2`, `npoint3`);{BY|ON} `fieldname` SUBHEAD

{NEWPAGE}
"text"

{BY|ON} `fieldname` SUBFOOT [WITHIN] [MULTILINES][NEWPAGE]
"text" [<prefop.fieldname ... ]" [WHEN expression;]
Creating Charts and Visualizations

A chart often conveys meaning more clearly and effectively than data displayed in tabular form. A chart enables you to visually communicate quantitative information. On a chart, you can give data a shape and form, and reveal patterns and relationships among many data values. A chart can highlight anomalies that require further investigation.

It is important that you choose a chart that is appropriate for your data. App Studio provides a complete chart library of both basic and advanced charts. You can choose from a wide variety of charts to best represent the data that you want to display.

In App Studio, you can create and edit InfoAssist charts using the Chart canvas, or create a Designer chart by using the default browser for App Studio. When you create a new chart, you use the Chart Wizard.

This topic provides an overview of the types of charts you can create with WebFOCUS App Studio and how to launch the Chart Wizard to create charts.

For more information on creating visualizations, see the InfoAssist User's Manual, or click the Help icon , located in the upper-right corner of the canvas.

In this chapter:

- Chart Types
- Launching the Chart Wizard
- Creating Visualizations

Chart Types

Once you connect to the data that you want to analyze, you can build simple or complex charts. These chart types including the following:

- **Bar chart.** Plots numeric data by displaying rectangular blocks against a scale. The length of a bar corresponds to a value or amount. Viewers can develop a clear mental image of comparisons among data series by distinguishing the relative heights of the bars. Use a bar chart to display numeric data when you want to present distributions of data. You can create horizontal, as well as vertical bar charts.
- **Line chart.** Emphasizes the movement or trend of numeric data over time, since they allow a viewer to trace the evolution of a particular point by working backwards or interpolating. Highs and lows, rapid or slow movement, or a tendency toward stability are all types of trends that are well suited to a line chart.

- **Area chart.** Similar to a line chart, except that the area between the data line and the zero line (or axis) is usually colored or textured. An area chart allows you to stack data on top of each other. Stacking allows you to highlight the relationship between data series, showing how some data series approach or shadow a second series.

- **Pie chart.** Emphasizes where your data fits in relation to a larger whole. Keep in mind that a pie chart works best when your data consists of several large sets. Too many variables divide the pie into small segments that are difficult to see. Use color or texture on individual segments to create visual contrast.

- **Scatter chart.** Shows the relationship between two different numeric measures. A scatter chart gives you a sense of trends, concentrations, and outliers that pinpoint where to focus further investigation efforts.

- **Bubble chart.** Plots data similar to a scatter chart, where the size of each marker is proportional to the value of a third measure.

- **Treemap chart.** Displays large amounts of hierarchically structured data. Using a set of nested rectangles to illustrate data relationships, sections of a treemap represent branches of a tree.

- **Gauge chart.** Indicates the current position of a single data value within a given spectrum. This chart has a circular shape. A gauge thermometer chart indicates the current position of a single data value within a given scale. This chart has the shape of a thermometer.

- **Pareto chart.** Uses the X axis to show group members, and the Y axis to show the percent of the total of all groups that each group represents. This chart highlights the differences between groups of data. Pareto charts are only available for InfoAssist charts.

- **Box Plot chart.** Shows the distribution of data, vertically or horizontally, through five-number summaries: Upper limit, Upper Quartile, Median, Lower Quartile, and Lower Limit. This chart can be represented with or without outliers, also known as whiskers. Box plots are only available for InfoAssist charts.

- **Funnel chart.** Displays only one group of data at a time, from the first series to the last series at the bottom of the funnel. Funnel charts are similar to pie charts.
Pyramid chart. Displays only one group of data at a time, from the first series to the last series at the top of the pyramid. A pyramid chart is similar to a pie chart. To create a pyramid chart as a Designer chart, select the funnel chart type and use the display options to change it to a pyramid.

Heatmap chart. Displays data in a table where the color of each cell is dependent on the value in the cell. A heatmap chart is similar to a spectral map. To create a heatmap as a Designer chart, select the matrix marker chart type and then select the Fill marker display option.

Tagcloud chart. Displays text data, typically used to depict keywords on websites or to visualize free form text. This format is useful for quickly perceiving the most prominent terms.

In addition to the charts that you can create, you can also create interactive, informative maps. Using the lightweight mapping feature, you can view important information for a region and drill down to view and analyze trends, population changes, or sales data. These chart types include the following:

Choropleth map. Uses color to differentiate between value groups on a map. It is useful for visualizing location-based data, trends, and distributions across a geographic area.

Proportional Symbol map. Uses marker size and color to differentiate between the data on a map.

Launching the Chart Wizard

To open the Chart Wizard:

On the Home tab, in the Content group, click Chart. Use this option to create a chart using the Chart canvas.

In the Environments Tree panel, right-click an application folder, point to New, point to InfoAssist, and click Chart or SQL Chart to create a chart using the chart canvas, or point to Designer and click Chart to create a chart using WebFOCUS Designer.

Note: If you choose to create a new chart using the shortcut menu in the Environments Tree panel, you will skip the first screen of the Chart Wizard. You will not have to specify whether you are creating a Designer chart, InfoAssist chart, or SQL chart, since you already clicked one of these options. You will instead be brought to the Select Data Source window, with the location for your chart already selected.
The Chart Wizard opens, as shown in the following image.

From the Chart Wizard, you can create a new InfoAssist chart or SQL chart procedure or open a recent procedure.

**Procedure: How to Create a Chart Using WebFOCUS Designer**

Designer charts can only be created from the Environments tree. Designer charts are built using the simple and intuitive Designer interface.

1. Right-click the domain or folder where you want to create the Designer chart, point to New, point to Chart, and click Designer Chart.

   The Select Data Source window opens.

2. Choose an application folder in the application folder tree, and select a Master File to use as a data source. You can select the Use Qualified Path check box if you want to only display the data sources in the application folder.

3. Click OK.

   WebFOCUS Designer opens in the web browser set as the default for App Studio.

4. Double-click fields in the Data pane to add them to the chart, or drag each field into the appropriate bucket.

   Features and functions to style and format the chart are available in the display options, the Format tab, the Chart Picker, and the WebFOCUS Designer toolbar.
5. To save your chart, click the Save button on the WebFOCUS Designer toolbar or Application menu.

6. To run the chart, click the Preview button on the WebFOCUS Designer toolbar.

Procedure: How to Create a Chart Using the Chart Canvas

After you launch the Chart Wizard, you can begin to create your chart procedure.

**Note:** If you choose to create a new chart using the shortcut menu in the Environments Tree panel, you will skip the first screen of the Chart Wizard. You will not have to specify whether you are creating a Designer chart, InfoAssist chart, or SQL chart. You will instead be brought to the Select Data Source window, with the location for your chart already selected.

1. Click Create Chart to create a chart using the Chart canvas.
   The Chart Wizard - Choose location for the new chart window opens.

2. Navigate to where you want to create the new chart and click Next.
   The Select Data Source window opens.

3. Choose an application folder in the application folder tree, and select a Master File. You can select the Use Qualified Path check box if you want to only display the data sources in the application folder.

4. Click Finish.
   The Chart canvas opens.

5. Double-click fields in the Data Panel to add them to the chart.
   You can use the features and functions on the ribbon that is located in the Chart canvas to format the chart.

6. To save your chart, click the Save button on the App Studio Quick Access Toolbar, or select Save from the Application menu.

7. To run your chart, click the Run button on the App Studio Quick Access Toolbar.

Procedure: How to Create an SQL Chart From an External .sql File

After you launch the Chart Wizard, you can begin to create your SQL chart procedure.
**Note:** If you choose to create a new SQL chart using the shortcut menu in the Environments Tree panel, you will skip the first screen of the Chart Wizard. You will not have to specify whether you are creating a chart or SQL chart. You will instead be brought to the SQL Chart Wizard - Welcome window, with the location for your chart already selected.

1. Select *Create SQL Chart*.

   The Chart Wizard - Choose location for the new chart window opens.

2. Navigate to where you want to create the new chart and click *Next*.

   The SQL Chart Wizard - Welcome window opens.

3. Click the *Included from an external '.sql' file* option. This enables you to browse and select external procedures that exist in any folder in the Data Servers or Domains areas.

4. Click *Next*.

   The SQL Chart Wizard - Data access information window opens.

5. In the Select the SQL database engine area, select a database from the drop-down list. The drop-down list changes depending on your Reporting Server configuration.

6. In the Select the connection area, choose a connection from the drop-down list generated from the engine you selected.

7. Click *Next*.

   The SQL Chart Wizard - Include external SQL file window opens.

8. Click *Browse* to select an external SQL file name or type the external SQL file name in the field.

   Optionally, you can run with limited records by clicking *Run SQL*. By default, the *Run with limited records* check box is selected so you can test your procedure with a read limit if the engine supports it. There is a field box next to the check box in which you can enter the number of records to be read. 100 is the default limit.

9. Click *Next*.

   The SQL Chart Wizard - Summary of SQL options window opens.

10. Review your options and click *Finish*.

    The Chart Wizard - SQL Data Source window opens.

11. Navigate to where you want to create the new procedure.

12. In the *Enter a Procedure Name* field, type a name for the SQL chart.

    **Note:** Typing a procedure name is not required to create a new chart. If you do not type a procedure name in the Enter a Procedure Name field, a default procedure name will be provided until you save the procedure.
13. Click Finish.

The Chart canvas and the Procedure View panel open. You can now add data to your chart and format the data using the tabs in the ribbon.

**Procedure:** How to Pass SQL Commands to the RDBMS Using SQL Passthru

After you launch the Chart Wizard, you can begin to create your SQL chart procedure.

**Note:** If you choose to create a new SQL chart using the shortcut menu in the Environments Tree panel, you will skip the first screen of the Chart Wizard. You will not have to specify whether you are creating a chart or SQL chart. You will instead be brought to the Chart Wizard - Choose location for the new SQL Chart window, with the location for your chart already selected.

1. Click Create SQL Chart.

   The Chart Wizard - Choose location for the new SQL Chart window opens.

2. Navigate to where you want to create the SQL chart and click Next.

   The SQL Chart Wizard - Welcome window opens.

3. Click Type SQL statements in the chart request. This enables you to type SQL commands that will be passed on to the RDBMS with the SQL Passthru feature.

4. Click Next.

   The SQL Chart Wizard - Data access information window opens.

5. In the Select the SQL database engine area, select a database from the drop-down list. The drop-down list changes depending on your Reporting Server configuration.

6. In the Select the connection area, choose a connection from the drop-down list generated from the engine you selected.

7. Click Next.

   The SQL Chart Wizard - Enter the SQL statements window opens.

8. In the field box, type the SQL statements you want to pass to the RDBMS.

   Optionally, you can run with limited records by clicking Run SQL. By default, the Run with limited records check box is selected so you can test your procedure with a read limit if the engine supports it. There is a field box next to the check box in which you can enter the number of records to be read. The default limit is 100.

9. Click Next.

   The SQL Chart Wizard - Summary of SQL options window opens.

10. Review your options and click Finish.

   The Chart Wizard - SQL Data Source window opens.
11. Navigate to where you want to create the new procedure.

12. In the Enter a Procedure Name field, type a name for the SQL chart.
   
   **Note:** Typing a procedure name is not required to create a new chart. If you do not type a procedure name in the Enter a Procedure Name field, a default procedure name will be provided until you save the procedure.

13. Click Finish.

   The Chart canvas and the Procedure View panel open. You can now add data to your chart and format the data using the tabs in the ribbon.

**Procedure:** How to Import SQL Commands From an Existing .sql File

You can import commands from existing .sql files.

**Note:** If you choose to create a new SQL chart using the shortcut menu in the Environments Tree panel, you will skip the first screen of the Chart Wizard. You will not have to specify whether you are creating a chart or SQL chart. You will instead be brought to the Chart Wizard - Choose location for the new chart window, with the location for your chart already selected.

1. Open the Chart Wizard and click Create SQL Chart.
   
   The Chart Wizard - Choose location for the new chart window opens.

2. Navigate to where you want to create the new chart and click Next.
   
   The SQL Chart - Welcome window opens.

3. Click Import from an existing ‘.sql’ file and click Next. This enables you to modify SQL code after importing it from an external file to the procedure being built. You can modify the request using bits of the code.
   
   The SQL Chart - Data access information window opens.

4. In the Select the SQL database engine area, select a database from the drop-down list. The drop-down list changes depending on your Reporting Server configuration.

5. In the Select the connection area, choose a connection from the drop-down list generated from the engine you selected.

6. Click Next.
   
   The SQL Chart Wizard - Import external SQL file window opens.

7. Type the SQL file name that you want to import or click Browse to select it.
Optionally, you can run with limited records by clicking Run SQL. By default, the Run with limited records check box is selected so you can test your procedure with a read limit if the engine supports it. There is a field box next to the check box in which you can enter the number of records to be read. The default limit is 100. You can edit these options here or in the next step.

8. Click Next.

The SQL Chart Wizard - Enter SQL statements window opens.

9. In the field box, type the SQL statements you want to pass to the RDBMS.

10. Click Next.

The SQL Chart Wizard - Summary of SQL options window opens.

11. Review your options and click Next.

The Chart Wizard - SQL Data Source window opens.

12. Navigate to where you want to create the new procedure.

13. In the Enter a Procedure Name field, type a name for the SQL chart.

**Note:** Typing a procedure name is not required to create a new chart. If you do not type a procedure name in the Enter a Procedure Name field, a default procedure name will be provided until you save the procedure.

14. Click Finish.

The Chart canvas and the Procedure View panel open. You can now add data to your chart and format the data using the tabs in the ribbon.

**Creating Visualizations**

In App Studio, you can create and build visualizations. Visualizations centralize information by providing different views of data that are pertinent to a particular objective (for example, reviewing trends or fluctuations in data over a period of time or within a region).

A visualization provides you with a quick glance of information on a single screen. Visualizations support the use of different types of charts, maps, and grids. For example, you may want to use a bar, pie, and line chart to show different views of the same data. Alternatively, you may want to offset a particular visual by showing other types of related data that employ a different type of visual. You can also add a text cell to your visualization to provide explanatory text or information that other users can reference. Visualizations allow you to monitor changes in data. They also serve to provide information in real-time, based on changes in underlying data or other components. A visualization can be updated, changed, or revised at any time to account for shifts in data needs.
Procedure: How to Create a New Visualization

You can create visualizations from the Domains node in the Environments Tree panel or Environments Detail panel.

1. From the Domains node in the Environments Tree panel or Environments Detail panel, right-click a folder, point to New, point to InfoAssist, and click Visualization.

2. Select a Master File from the list and click Open.

The WebFOCUS InfoAssist interface opens, as shown in the following image, where you can create charts, maps, and grids to visually represent your data.
The following image shows a visualization that contains multiple visuals, including a bubble, gauge, ring pie, and treemap.

Note: For more information on creating visualizations, see the *InfoAssist User’s Manual*, or click the Help icon 📚, located in the upper-right corner of the canvas.
Creating Procedures

A procedure is a .fex file that defines how data is retrieved and displayed. Procedures request data from the data source using a Master File to understand how the data is organized. When you run a procedure, it executes a series of commands that process your data and transform it into a readable output.

In App Studio, you can develop multi-component procedures using the Procedure View panel.

This topic explains the components that can make up a procedure and identifies the Procedure View panel.

In this chapter:

- Using the Procedure View Panel
- Using Dialogue Manager
- Displaying Data Sources

Using the Procedure View Panel

The Procedure View panel contains the panel customization commands and the Procedure View tree. This panel displays all components in a procedure. You can add new components to a procedure, such as a Report, Define, Define Function, Chart, Set, Join, Use, and others.

If a component in the procedure is open, a green arrow appears next to the component icon.

When a new procedure is created, the Comment component opens automatically. In a previously created procedure that is reopened, the last report component or chart component opens automatically.
The Procedure View panel is available when you create or open a procedure or report. The Procedure View panel is shown in the following image.

For more information on customizing the Procedure View panel, see Customizing the Panels on page 128.

Displaying Components of a Procedure Using the Procedure View Tree

The Procedure View tree displays the components and folders associated with a procedure.

Open Folder Node

Displays different options depending on the selected component or components in the procedure.

Procedure Contents Tree

Shows the components in a procedure.

Defining the Components of a Procedure

A procedure is a .fex file that defines how data is retrieved and displayed. Procedures request data from the data source using a Master File to understand how the data is organized. When you run a procedure, it executes a series of commands that process your data and transform it into a readable output.

Procedures can consist of the following components:

- Report
- MAGNIFY Engine
- Engine
- SQL Report
- Define
You can add these components to new or existing procedures, and are responsible for the order in which you add them. For more information, see Order of Components in the Procedure View Panel on page 463. The following topics describe how these components modify a procedure.

**Report**

You can add a report to a procedure. In report mode, you can create and style simple or complex reports, add data to the Report canvas, and style that data creating a graphical representation of the report page. This allows you to view how the report displays at run time.

**MAGNIFY Engine**

The MAGNIFY Engine canvas contains the following ENGINE SET statements which are available for selection.

- **ACTION.** Possible values are *add* or *delete*. The add option is the default and inserts or updates a record. A record is updated if its WF_INDEX_UNIQE_KEY value already exists in the index. The delete option finds the WF_INDEX_UNIQE_KEY of the record value and deletes it from the index.
- **BASEURL.** The WebFOCUS Report base URL.
- **BATCHSIZE.** The number of records to burst at one time. It is recommended that the BATCHSIZE property is always used.
- **CONNECTION ATTRIBUTES.** The Magnify Indexing Servlet.
- **DATASOURCE.** The Magnify index library directory.
- **DELMITER.** The separator for multiple categorizations. This is used in conjunction with aggregation-based alias names.
- **FEEDTYPE.** Possible values are *incremental* or *full*. The incremental option is the default and updates an existing record in the index or adds the data as a new record. This mode prevents duplicate records from being added to the index library. The full option adds all data to the index from the data source. If a record is repeated in the feed, it is duplicated in the Magnify index library.
- **MIME.** The document mime type, required for file indexing. Possible values are *text/plain* or *application/openurl*. The text/plain option is the default.

**Engine**

The Engine component exposes the WebFOCUS ENGINE SET statement and enables you to enter ENGINE commands or connection attributes, and override parameters.

**Note:** The Engine component is only used to create ENGINE statements. You are responsible for having the knowledge of the ENGINE SET command or the Connection Attribute needed.

**SQL Report**

The SQL Report component launches the SQL Report Wizard, where you can create a new SQL report, create an SQL report from an external .sql file, pass SQL commands to an RDBMS using SQL passthru, or import SQL commands from an existing .sql file.

**Define**

You can use the Define feature to create a virtual field as a component in a procedure.

**Note:** To enable the objects when creating a Define, click the New button.

A virtual field is evaluated on each retrieved record that passes any selection criteria on real fields. Define the virtual field by assigning a format and typing an expression, or composing it using the calculator fields and functions. The result of the expression is treated as though it were a real field stored in the data source.
Define Function

You are able to create your own functions by using the Define Function Wizard. The Define Function Wizard assists in the creation of a user function. The created functions can later be retrieved through the Function Arguments dialog box, using the Retrieve User Functions button. By clicking *Retrieve User Functions*, your created functions will be available for use.

Chart

You can add a chart to a procedure. In Chart mode, you can transform almost any type of data into effective, custom charts. You can create a variety of charts, such as bar charts, line charts, scatter charts, or pie charts to help users analyze data in a different way. You can include selection criteria by defining parameters for your data. Additionally, you can apply drill-down capabilities and conditional styling to highlight specific data on a chart.

The Chart canvas contains a ribbon of features and options that allow you to add and style the data in your chart. Contextual tabs open within the Chart canvas, rather than on the App Studio ribbon.

SQL Chart

The SQL Chart component launches the SQL Chart Wizard, where you can create a new SQL chart, create an SQL chart from an external .sql file, pass SQL commands to an RDBMS using SQL passthru, or import SQL commands from an existing .sql file.

Set

You can add the Set component to a procedure to select Environment Parameters and customize the procedures. The Set component controls the way that reports and charts appear on the screen or printer, the content of reports and charts, data retrieval characteristics that affect performance, and system responses to user requests. It also helps you set up your metadata and manipulate information, such as dates. For more information about SET parameters, see the *Developing Reporting Applications* technical content.

Join

If a report requires data from two or more related data sources, you can temporarily join the files and report from them as if they were one. Joined files remain physically separate, but are treated as one data source structure.

The Join component provides a graphical method for creating and manipulating all types of Joins. To create a Join, you must specify a host data source, and then a cross-referenced data source. Both host and cross-referenced files are Master Files.
You create the Join as an component that is separate from any other component or procedure. You are responsible for placing the Join object in the correct position within your procedure, (that is, before a Define, Report, or Chart), and running it. The Join remains active for the entire session, unless you explicitly clear it.

**Use**

When you access a WebFOCUS data file, WebFOCUS searches for a Master File with the specified file name, and then searches for a data source with the same name. With the Use component, you can specify the name and location of a WebFOCUS data source.

You can apply the Use component to a procedure in App Studio when the default naming convention is not used, the data source cannot be found in the standard search path, or an explicit extra option is desired.

When you identify a WebFOCUS data source with the Use component, a Use directory is created, which is a list of data source definitions. When a Use directory is in effect, WebFOCUS locates a data source using the information in the directory instead of searching for it using the default name and search path. A Use directory enables you to access up to 1022 data sources and applies only to WebFOCUS data sources.

**Allocation**

For a file managed by the operating system, such as a comma-delimited data file, the physical file name is the actual name of a file as it appears to the operating system. A logical name is the shorthand name that points to a physical file name. Logical names simplify code by allowing short names to be used in place of the longer physical file name.

With the Allocation Wizard, you can create a FILEDEF command and generate platform independent file paths for all portable platforms by creating FILEDEF syntax with application names.

**Execute**

The Execute component allows one procedure to execute or call another procedure. The called procedure behaves as a completely separate procedure, with its own context. The Execute component allows you to view and select available procedures, supply values for parameters in the called procedure, and test the called procedure.
Once this procedure is specified, Execute displays these parameters and prompts you to provide values for them. You can provide values for all parameters in the procedure, or you can choose to provide values for only some of the parameters. If you provide values for only some of the parameters, you must provide values for the other parameters using another method. For example, values are passed from another part of the application. After providing parameter values, you can test the called procedure.

Execute is available from all development areas of the product.

**HtmlForm**

The HtmlForm component enables you to add HTML code to the active procedure. HTML forms are used to display HTML content. You can choose to reference or embed HTML forms in your procedure.

**Note:** HTML pages created in the HTML canvas are not meant to be used with an -HTMLFORM that uses run-time references. The HTML canvas cannot evaluate -HTMLFORM when run-time references to file names and objects are used.

**Include**

The Include component allows you to include a whole or partial procedure in another procedure. A partial procedure might contain heading text or syntax that should be included at run time based on a test in the calling procedure. It enables the reuse of code, making applications easier to write and maintain. After an included procedure runs, control returns to the calling procedure.

An Include component can be placed anywhere in a procedure.

**Olap Dimensions**

The Olap Dimensions component allows you to create a temporary OLAP hierarchy and dimensions to build reports from, without modifying the Master File. Instead, you create a local hierarchy, where the information is stored in the active procedure. After you create the local hierarchy, you can build a report.

**Match**

The Match component launches the Match Wizard, where you can merge two or more data sources and specify which records to merge and which to sort out. The wizard creates a new data source (a HOLD file) which merges fields from the selected records. You can report from the new data source and use it as you would any other HOLD file. The merge process does not change the original data sources.
You select the records to be merged into the new data source by specifying sort fields in the Match Wizard. You specify one set of sort fields (using the BY phrase) for the first data source, and a second set of sort fields for the second data source. The Match Wizard compares all sort fields that have been specified in common for both data sources, and then merges all records from the first data source whose sort values match those in the second data source into the new HOLD file. You can specify up to 32 sort sets, which includes the number of common sort fields.

In addition to merging data source records that share values, you can merge records based on other relationships. For example, you can merge all records in each data source whose sort values are not matched in the other data source. Yet another type of merge combines all records from the first data source with any matching records from the second data source.

You can merge up to 16 sets of data in one Match request. For example, you can merge different data sources, or data from the same data source.

**Note:** The limit of 16 applies to the most complex request. Simpler requests may be able to merge more data sources.

**Other**

The Other component enables you to enter commands that connect other components. This feature is useful for writing code that does not have a graphical tool (such as Dialogue Manager). However, you can also use Other for any kind of manual coding, for example, to code a virtual field or a report. When used this way, the Other component automatically converts to the corresponding component type.

An Other component can be placed anywhere in a procedure.

**Dialogue Manager**

Dialogue Manager is the part of the WebFOCUS language that controls the execution of your application components. You can add flexibility to your application design by dynamically managing the flow of control in procedures using Dialogue Manager commands and variables whose values are supplied at run time.

You can select five different types of Dialogue Manager components to add to your procedure.

- **DM If.** Creates a Dialogue Manager IF statement by having you type an expression and choosing a label. You can choose to create an IF template if you want.

- **DM Goto.** Creates a Dialogue Manager GOTO statement by having you type a label.

- **DM Label.** Creates a Dialogue Manager label by having you type a label name.
DM Repeat. Creates a Dialogue Manager REPEAT statement by having you choose labels, amper values, steps, times, and expressions. You can choose to create a REPEAT template if you want.

Dialogue Mngr. Opens the Dialogue Manager canvas where you can manually create your Dialogue Manager code. For more information, see Using Dialogue Manager on page 477.

Order of Components in the Procedure View Panel

Components can be added to the Procedure View panel in any order. After adding a component you may need to change the order.

The order of components in the Procedure View panel can be significant. For example, suppose you have a report component and a define component, where the define component is a field used in the report. In this case, the define component must appear before (above) the report component in the Procedure View panel. Otherwise, the system will display a message when you try to run the report.

To move a component, click and drag it over another component until the target component is highlighted. As the component is moved, the pointer displays a box image. Release the mouse button and the moved component will appear after the highlighted component.

To copy a component, hold down the Ctrl key, click the component and drag it up or down. As the component is copied, the pointer displays a plus (+) sign. Release the mouse button and Ctrl key and the copied component will appear after the highlighted component.

Note: You can move or copy a component in the Procedure View panel even if the component is open in its respective canvas.

Creating Procedures and Procedure Components

This section describes how to create procedures and procedure components.

Procedure: How to Create a New Procedure

1. In the Environments Tree panel, right-click a folder, point to New, and then click Procedure. The Procedure View panel opens.
2. To add components to your procedure, right-click the procedure folder or component that you want to add a new component after, select New, and click the component name.
3. To run a procedure at any time, in the Procedure View panel, right-click any component and select Run complete procedure from the shortcut menu. The current state of the procedure is used even if it has not been saved.
Note: If you select Run complete procedure when the procedure is in an invalid state you will get an error message asking if you would like to run the procedure with the last good content.

**Procedure: How to Create a Report as a Component of a Procedure**

1. Create a new procedure, or open an existing procedure.
2. In the Procedure View panel, right-click the procedure folder or the component that you want to create the report after, point to New, and click Report.
   The Select Data Source dialog box opens.
3. Select a Master File from the list and click OK.
   The Report canvas and the Procedure View Panel open.
4. Double-click fields in the Object Inspector to add them to the report.
5. Format your report by using the options on the Report tab, Format tab, Data tab, and Layout tab.
   **Tip:** The Field tab appears when you select a data column on the Report canvas.
6. To save your report, click the Save button on the Quick Access Toolbar, or select Save or Save As from the Application menu.
7. To run your report, click the Run button on the Quick Access Toolbar, or select Run from the Application menu.

**Procedure: How to Create an Engine Statement**

1. From the Procedure View panel, right-click the procedure folder or the component that you want to create the Engine statement after, point to New, then click Engine.
   The Engine canvas opens.
2. Select an Engine from the Engine list, or manually type in an Engine name.
3. Select an existing connection from the Connection list, or type a parameter statement in the SET parameters field.
4. Click the Test button to test the Engine statement.

**Procedure: How to Create an SQL Report**

1. From the Procedure View panel, right-click the procedure folder or the component that you want to create the SQL report after, point to New, then click SQL Report.
   The Welcome to the WebFOCUS SQL Report Wizard window opens.
2. Depending on the type of SQL report you wish to create, follow the respective instructions in *Launching the Report Wizard* on page 229.

**Procedure: How to Define a Virtual Field**

1. Open an existing procedure, or create a new procedure.

2. In the Procedure View panel, right-click the procedure folder or the component that you want to create the virtual field after, point to New, and click Define.

   The Open File dialog box opens.

3. Select a Master File from the list and click OK.

   The Define canvas opens.

4. Type a name for the virtual field in the Define Field Name input box.

5. Click the Format button.

   The Format dialog box opens.

6. Select the formatting options you want to apply to the virtual field and click OK.

7. Build an expression in the expression box. You can double-click fields from the Fields List to add them to the expression. Use the calculator buttons under the expressions window to provide numbers and operators in the expression. Use the Functions button to add a WebFOCUS function to the virtual field using the Function Arguments dialog box.

8. Optionally, click the Title tab to provide a title for the virtual field.

   The title is used as the column title when the virtual field is added to a chart or report.

9. Optionally, click the Description tab to type a description for the virtual field.

10. Click Options to specify additional behaviors for the virtual field in the Options dialog box.

    Select the Override missing values handling check box to specify how null or missing values should be handled. Select the Associate the temporary field with the real field that is selected check box to place the virtual field into the same segment as the selected real field.

11. Click the Check button to validate the generated code.

    The Check dialog box opens displaying the component code and either an error message, or text stating that no error exists.

12. Click OK to close the Check dialog box. Click New to create a new virtual field, or close the Define canvas.
You can define multiple virtual fields for a procedure. You can view all virtual fields within a Define component in the Defined Fields list. You can reorder them using the Up and Down buttons, which is useful if one virtual field references another virtual field. The virtual field being referenced must be higher in the Defined Fields list. You can also click Delete to delete a virtual field.

If you have multiple Define components in a procedure, select the Add to previous Define check box to ensure that the virtual fields from each Define component display. Otherwise, only the virtual fields from the last Define component in the procedure will be available.

After you define a virtual field, you can create a report that uses the virtual field. Right-click the Define component, point to New, and click Report.

**Procedure:** How to Create a User Define Function

To create a user define function:

1. Right-click a procedure component in the Procedure View panel, point to New, and click Define Function.

   The Welcome to the Define Function Wizard window opens.

2. Click Next.

   The Name dialog box opens.

3. Type a name and description for the function and click Next.

   The Parameters dialog box opens.

4. Click the Add new item button to add new parameters to the function.

   You can rename the parameters by double-clicking on the name column. For each parameter, clicking the ellipsis button in the Format column will open the Format dialog box, allowing you to edit the format of that parameter. Double-clicking in the Description column for each parameter will allow you to edit the description for parameter.

5. Click Next.

   The Defined Fields dialog box opens. One defined field (with the same name as your function) is already entered.

   **Note:** A function is comprised of expressions that returns a value to the caller of the function.

6. Click the Add new item button if you want to add more defined fields.
You can rename the fields by double-clicking on the name column. For each field, clicking the ellipsis button in the Format column will open the Format dialog box, allowing you to edit the format of that field. Clicking the ellipsis button in the Expression column will open a dialog box where you can edit what the function will do.

**Note:** The last defined field must have the same name as the function. This is why one defined field is already entered with the same name as the function. If multiple expressions are present, then the defined field with the same name as the function must be in the last position. If no defined field has the same name as the function, or if the defined field is not in the last position, you will be unable to progress to the next window.

7. Click Next.

The Define Function Wizard Complete window displays. The function, as well as its parameters and logic, are displayed before completion.

8. If you want to create more functions, click New to bring up the Define Function Wizard again, allowing you to create another function.

This can be done as many times as needed, allowing you to create multiple functions in the procedure, without having to exit and repeat certain steps.

Selecting a Define Function component and clicking Open will open the Define Function Wizard. Here, you can change any part of the already created function by going through each window.

Selecting a Define Function component and clicking Delete will delete the function.

**Procedure:** How to Create a Define Function Library

To create a define function library:

1. Right-click a Data Servers folder in the Environments tree panel, point to New, point to Data & Metadata, and click Define Function Library.

   The Welcome to the Define Function Wizard window opens.

2. Click Next.

   The Name dialog box opens.

3. Type a name and description for the function and click Next.

   The Parameters dialog box opens.

4. Click the Add new item button to add new parameters to the function.
You can rename the parameters by double-clicking on the name column. For each parameter, clicking the ellipsis button in the Format column will open the Format dialog box, allowing you to edit the format of that parameter. Double-clicking in the Description column for each parameter will allow you to edit the description for parameter.

5. Click Next.

The Defined Fields dialog box opens. One defined field (with the same name as your function) is already entered.

**Note:** A function is comprised of expressions that returns a value to the caller of the function.

6. Click the *Add new item* button if you want to add more defined fields.

You can rename the fields by double-clicking on the name column. For each field, clicking the ellipsis button in the Format column will open the Format dialog box, allowing you to edit the format of that field. Clicking the ellipsis button in the Expression column will open a dialog box where you can edit what the function will do.

**Note:** The last defined field must have the same name as the function. This is why one defined field is already entered with the same name as the function. If multiple expressions are present, then the defined field with the same name as the function must be in the last position. If no defined field has the same name as the function, or if the defined field is not in the last position, you will be unable to progress to the next window.

7. Click Next.

The Define Function Wizard Complete window displays. The function, as well as its parameters and logic, are displayed before completion.

8. If you want to create more functions within the Define Function Library, click *New* and select *Define Function*, allowing you to create another function.

This can be done as many times as needed, allowing you to create multiple functions in the procedure, without having to exit and repeat certain steps.

Selecting a Define Function component and clicking *Delete* will delete the function within the Define Function Library.

**Procedure:** *How to Create a Chart as a Component of a Procedure*

1. Create a new procedure, or open an existing procedure.

2. In the Procedure View panel, right-click the procedure folder or the component that you want to create the chart after, point to *New*, and click *Chart*.

The Select Data Source dialog box opens.
3. Select a Master File from the list, and click OK.
   The Chart canvas opens.
4. Double-click fields in the Data Panel to add them to the chart.
   You can use the features and functions on the ribbon that is located in the Chart canvas to format the chart.
5. To save your report, click the Save button on the App Studio Quick Access Toolbar, or select Save or Save As from the Application menu.
6. To run your report, click the Run button on the App Studio Quick Access Toolbar, or select Run from the Application menu.

**Procedure: How to Create an SQL Chart**
1. From the Procedure View panel, right-click the procedure folder or the component that you want to create the SQL chart after, point to New, then click SQL Chart.
   The Welcome to the WebFOCUS SQL Chart Wizard window opens.
2. Depending on the type of SQL chart you wish to create, follow the respective instructions in *Launching the Chart Wizard* on page 445.

**Procedure: How to Set Parameters for a Procedure**
1. Open an existing procedure, or create a new procedure.
2. In the Procedure View panel, right-click the procedure folder or the component that you want to create the Set after, point to New, and click Set.
   The Set canvas opens.
3. From the Available Settings list, double-click a parameter.
   The selected parameter is added to the Used Settings list. The available values for that parameter display in the Current Value list.
   
   **Note:** You can also select a parameter and click the Add button to add it to the Used Settings list.
4. Select a value from the Current Value list.
5. Click the Check button to validate the generated code.
   The Check dialog box opens displaying the component code and either an error message, or text stating that no error exists.
6. Click OK, and close the Set canvas.
   This setting is now on, and will affect the way the procedure works.
**Procedure: How to Join Data Sources**

1. Open an existing procedure, or create a new procedure.

2. In the Procedure View panel, right-click the procedure folder or the component that you want to create the Join after, point to New and click Join.

   The Open File dialog box opens.

3. Select a Master File (host file) and click OK.

   The Join canvas opens and displays the fields in the Master File.

4. On the Join tab, in the Join group, click Add.

   You can also right-click the Join canvas and select Add File.

5. Select a Master File (cross-referenced file) and click OK.

   The new Master File is added to the canvas. Common fields in both files are joined by a Join connector line.

6. Click Save.

7. Click Run.

   A dialog box opens, displaying the component code, and either an error message or text stating that no error exists.

8. Click OK and close the Join canvas.

   You can add another component to the procedure by right-clicking the Join component, pointing to New, and clicking the component. When you are prompted to select a Master File, select the same host file you used to create the Join component. This allows you to use the joined data sources.

**Note:** For more information on how to create each type of Join, see *Creating Joins Using Join Functionality* on page 412.

**Procedure: How to Identify a Data Source With the Use Feature**

1. Open an existing procedure, or create a new procedure.

2. In the Procedure View panel, right-click the procedure folder or the component that you want to create the Use after, point to New, and click Use.

   The Use canvas opens.

3. Select a USE action:

   - **Clear/Replace current list of USE databases** clears all entries or replaces the current list of USE data source with those in the list box.
Append to the present database list adds data sources to the current USE directory.

Replace only specified files in list changes one or more data source assignments in the current USE directory.

4. In the Use canvas, do one of the following:

- Type the name of a WebFOCUS data source in the Database Filename field.
- Click Browse to search the network drives and directories for the file you want to add.
- Type the Universal Naming Convention (UNC) name of the file in the Database Filename field. For example:

  `\\Server1\Disk1\filename.ext`

  The Universal Naming Convention (UNC) allows you to type the server name without entering the explicit path to the server. However, in order to take advantage of the UNC you must first attach to the server. For information on attaching to a server or mapping network drives, consult your Network Administrator.

  Enter the Master File name to be associated with the data source in the MASTER File field.

5. If the data source is not located locally, type the name of the server on which the file resides, in the Database Server field.

6. Click Add.

7. Repeat steps 3 through 6 for any additional data sources you want to identify.

8. Click the Check button to validate the generated code.

   The Check dialog box opens displaying the component code and either an error message, or text stating that no error exists.

9. Click OK and close the Use canvas.

Procedure: How to Define a Logical Name With the Allocation Wizard

1. Open an existing procedure, or create a new procedure.

2. In the Procedure View panel, right-click the procedure folder or the component that you want to create the Allocation after, point to New, and click Allocation.

   The Welcome to the Allocation Wizard window opens.

3. Click Next and specify the logical name for the allocation.

   The name can be from one to eight characters. If you are identifying a data source, the name must be the same as the name of the Master File.
4. Click Next and select the device for the logical name.

- **Disk** associates the logical name with a file. This is the default option.

- **Printer** associates the logical name with a printer.

- **Http** associates the logical name with a URL, by allocating the Master File to the result of running the URL.

- **Terminal** indicates that the keyboard and monitor are the input source and output destination for the file.

- **Clear** clears the allocation assigned to a file name.

5. Click Next to select additional options.

   **Note:** The options vary depending on which device is selected. The steps below detail how the Allocation Wizard continues with the selected device.

   **Tip:** At any time, you may click Back to go back and change the device, or any of the device settings.

6. When selecting Disk as the device:

   a. Select the application folder that contains the physical file.

      **Note:** The application folders from the Reporting Server are shown by default and depend on the area from which the Allocation Wizard is invoked. Some examples of the Reporting Server application folders are Data Servers and domains.

   b. Click Next and type the new file name.

      or

      Click the **Browse** button to display the Open dialog box and select from the list of existing files.

      **Note:** The default file type is Data Files (*.dat). You may also select Temporary Files (*.ftm), and All Files (*.*), as the type of file.

   c. Click Next to specify additional options for the Disk device.

      These additional options are:

      - **Appends** records to the end of the file (without this option, the file is overwritten).

      - **Fixed length records** indicates that you are assigning a logical name to a file with a fixed record length.

      - **Record Size** specifies the record length of the file, when using the Fixed length records option.
d. Click Next to view the summary of the allocation settings you selected for the Disk device.

7. When selecting Printer as the device:
   a. Select the application folder that contains the physical file.

   **Note:** The application folders from the Reporting Server are shown by default and depend on the area from which the Allocation Wizard is invoked. Some examples of the Reporting Server application folders are Data Servers and domains. You may specify a file in a directory that is not in the Reporting Server Application Path by using the Advanced option from the completed Allocation.

   b. Click Next and enter the new file name.

   or

   Click the Browse button to display the Open dialog box and select from the list of existing files.

   **Note:** The default file type is Data Files (*.dat). You may also select Temporary Files (*.ftm), and All Files (*.*), as the type of file.

   c. Click Next to type the name of the printer.

   d. Click Next to view the summary of the allocation settings you selected for the Printer device.

   The following syntax is applied to the FILEDEF statement when using a Printer device:

   ```
   FILEDEF OFFLINE PRINTER BASEAPP/TEMPOFFLINE.FTM (PRINTER \ibiprint \28C1
   ```

8. When selecting Http as the device:
   a. Type the full URL path.

   b. Click Next to view the summary of the allocation settings you selected for the Http device.

9. When selecting Terminal as the device:
   a. Click Next to specify additional options for the Terminal device.

   - You may choose to send the keyboard input to WebFOCUS as entered (lowercase or mixed-case). The default is mixed-case. Select this option to specify lowercase.

   b. Click Next to view the summary of the allocation settings you selected for the Terminal device.

10. When selecting Clear as the device:
    a. Click Next to view the summary of the allocation settings that you cleared.
Procedure: How to Call a Procedure From Another Procedure

In the following example, you will create two procedures: a report procedure and an Execute procedure. The first procedure, named salesrep, will contain a sales report with parameter prompts. The second procedure, called svalues, will contain the values for the parameters in salesrep, and will execute the called procedure, salesrep. The result will be a sales report with parameter values filled in.

1. Create a report called salesrep, with two multiselect parameter fields, for example, State and Region and two sum fields, for example, Quantity Sold and Revenue.

2. Create a procedure, called svalues. From the Procedure View, right-click Comment, point to New, and then click Execute.

3. From the Open File dialog box that displays, select the procedure to call (for example, salesrep).

   The Resolve procedure parameters dialog box opens, as shown in the following image.

4. Select values for the Statename and Region parameters. For example, Connecticut and Florida for Statename and NorthEast and SouthEast for Region.

5. Click OK.
The code in the Execute canvas shows the Execute code, with the selected parameter values, as shown in the following image.

![Execute canvas](image)

6. Run the `svalues` procedure.

The Sales Report displays, as show in the following image.

![Sales Report](image)

**Procedure:** How to Merge Data Sources Using the Match Wizard

1. Open an existing procedure, or create a new procedure.

2. In the Procedure View panel, right-click the procedure folder or the component that you want to create the Match after, point to New, and click Match.

   The Open File dialog box opens.

3. Select a Master File to use first in the MATCH logical expression.

4. Click OK.

   The Match Wizard opens in a new canvas. It uses typical wizard behavior in which you click a series of Next buttons to navigate from one window to the next. You can also use the Match Preview area to navigate the Match Wizard.

5. From the Available fields list, select the fields you want to use to build the Match request.

   You can add a Match Alias (how the field appears in the HOLD file field list) and a Prefix Operator for each field.

   **Note:** You can remove fields from this list by clicking the Delete button. If you add more than one field, you can also use the Move Up and Move Down buttons to rearrange the orders of the fields.

6. Select either PRINT, SUM, or LIST from the drop-down list.

7. To add a field as BY field, click a field in the Available Fields list and click the Add field button in the BY fields list box.

   **Note:** You must have at least one BY field.
8. Click the Where/If tab if you want to create a WHERE expression or IF condition. This limits the records that are merged together.

9. Click the Add WHERE expression or Add IF condition button to open the Expression Builder. Use the Expression Builder to create the Where/If condition.

10. Click Next.

   Step 3 of the Match Wizard opens.

11. Click the Browse button to select the data source you want to merge with the original data source.

   The Open File dialog box opens.

12. Select a Master File and click OK.

13. Click Next.

   Step 4 of the Match Wizard opens.

14. Add the fields for the second data source, including a Where/If field criteria if you want, as in step 5.

15. Click Next.

   Step 5 of the Match Wizard opens.

16. Type a name for the HOLD file and select the type of MATCH phrase.

17. Click Finish.

   The Match Wizard - Summary window opens, where you can review the final MATCH request.

**Syntax:**

**How to Use -HTMLFORM Syntax**

-HTMLFORM sends report output to the HTML file you create for a webpage, and displays that page in the browser. The output can be saved as an HTML file that can be displayed later.

The syntax is:

```
-HTMLFORM filename [SAVE AS htmlpage]
```

or

```
-HTMLFORM BEGIN
  ...
  ...
-HTMLFORM END
```
where:

filename

Is the HTML file that contains placeholders for the report or reports that WebFOCUS creates with the command:

```
ON TABLE HOLD HTMTABLE AS report
```

SAVE

Indicates that the HTML page, created when the HTML file filename and the report or reports generated by WebFOCUS are combined, is to be saved.

AS htmlpage

Is the file name for the HTML page that is created when the HTML file filename and the report or reports generated by WebFOCUS are combined. This file is saved so that it can be displayed later.

-HTMLFORM BEGIN

Indicates the beginning of an inline HTML form in a procedure.

-HTMLFORM END

Indicates the end of an inline HTML form in a procedure.

Using Dialogue Manager

Dialogue Manager is the part of the WebFOCUS language that controls the execution of your application components and allows you to control the flow of your application with the use of commands and variables. You can dynamically control the execution of procedures, giving you flexibility in application design. Dialogue Manager also enables you to use variables in your procedures and supply values for them at run time.

The following are some of the ways you can use Dialogue Manager:

- **Customizing a procedure with variables.** You can dynamically change the execution of a procedure by including variables, or retrieve information from the system.

- **Navigating a procedure.** You can conditionally execute requests, repeat execution with program loops, or call another procedure.

- **Enhancing an HTML webpage.** You can increase the functionality of your webpage by including HTML commands in your procedure.

- **Issuing operating system commands.** You can issue an operating system command to set up an environment in which a request must run.
Controlling passwords. You can directly assign and change passwords.

Sending a message to the application. You can send a message to an application while a procedure is processing to explain the purpose of the procedure, display results, or present useful information.

You can create Dialogue Manager IFs, GOTOs, Labels, and REPEATs. You can also open the Dialogue Manager canvas and create any of the other items manually.

Dialog Manager Variables Overview

You can write procedures containing variables with values that are unknown until run time, allowing a user to customize the procedure by supplying different values each time it executes. Variables fall into two categories:

- **Local and global variables.** Local and global variable values must be supplied at run time. Local variables retain the values only for one procedure. Global variables retain the values across procedures unless you explicitly clear them. You create a local variable by choosing a name that starts with a single ampersand (&) and you can create a global variable by choosing a name that starts with a double ampersand (&&).

- **System and statistical variables.** System and statistical variable values are automatically supplied by the system when a procedure references them. System and statistical variables have names that begin with a single ampersand (&). For example, the variable &LINES indicates how many lines of output were produced, and the variable &DATE indicates the current date.

Dialog Manager Processing

You can modify your application at run time with user input and environment conditions by using Dialogue Manager stored procedures, which include commands and variables.

In App Studio, stored procedures are referred to as procedures.

1. Processing begins from the command processor when a procedure is invoked for execution.
2. The FOCEXEC Processor reads each line of the procedure. Any variables on the line are assigned the current values.
3. All Dialogue Manager commands execute as soon as Dialogue Manager reads them.
4. When a command line containing no Dialogue Manager commands is fully expanded with any variables resolved (through either a -SET command or prompting), it is placed onto the command execution stack.
5. Dialogue Manager execution commands and statistical variables route all currently stacked commands to the WebFOCUS Command Processor.
By the time your procedure is ready for execution, the following has happened:

- All variables have received values and these values have been integrated into the command lines containing variables.

- Dialogue Manager commands have been used to place WebFOCUS commands into proper sequential order for execution.

- At this point the WebFOCUS Command Processor no longer sees any Dialogue Manager commands. It only sees WebFOCUS command lines in the stack.

You can use the -TYPE command to send a message to the display while a procedure is processing. Typically, the message serves the following purposes:

- Explains the purpose of the procedure.

- Displays the results of a procedure or calculation during testing of a procedure.

- Presents other useful information.

- Indicates what type of information to supply in response to a prompt.

Navigating a Procedure

You can navigate a procedure in the following ways:

- **Unconditional branching.** Transfers control to a label.

- **Conditional branching.** Transfers control to a label depending on the outcome of a test.

- **Looping.** Performs a function repeatedly in your procedure.

- **Calling another procedure.** Incorporates a whole or partial procedure into your procedure.

Branching Unconditionally

You can perform unconditional branching, which transfers control to a label with the -GOTO command.

The first time through a procedure, Dialogue Manager notes the addresses of all the labels so they can be found immediately, if needed again. If Dialogue Manager has not stored the address of the label in the -GOTO command, it searches forward through the procedure for the target label. If no label is found, it begins searching at the top of the procedure.

Dialogue Manager takes no action on labels that do not have a corresponding -GOTO. If a -GOTO does not have a corresponding label, execution halts and a message is displayed.
Syntax: How to Branch Unconditionally

-GOTO label

where:

-label

Is a user-defined name of up to 64 characters. Do not use embedded blanks or the name of any other Dialogue Manager command. Do not use arithmetic or logical operations, words that can be confused with functions, or reserved words, such as CONTINUE.

The label text may precede or follow the -GOTO command in the procedure.

Note: When the label is specified in the -GOTO command, a dash does not precede it.

TYPE text

Sends a message to the display.

Example: Branching Unconditionally

The following example comments out all the WebFOCUS code using an unconditional branch, instead of the user typing -* in front of every line:

-GOTO DONE
TABLE FILE SALES
PRINT UNIT_SOLD RETURNS
BY PROD_CODE,CITY
END
-RUN
-DONE

Branching Conditionally

Conditional branching performs a test of the values of variables and, based on the test, transfers control to a label in the procedure with the -IF... GOTO command. This helps control the execution of requests and builds a dynamic procedure by choosing to execute or not execute parts of a procedure.

For example, you can check whether an extract file was created from a production data source. If the extract file exists, the program runs a set of reports against the extract. If it does not exist, the program branches around the reports and writes a message to a log file.
Note: Generally, a -IF test does not require that each test specify a target label. However, in a compound IF test, where a series of tests are nested within each other, a specified target label is required for each test.

Syntax: How to Branch Conditionally

-IF expression [THEN] {GOTO label1|CONTINUE} [ELSE IF...] [ELSE {GOTO label2|CONTINUE}] ;

where:

expression

Is a valid expression. Literals do not need to be enclosed in single quotation marks unless they contain embedded blanks or commas.

THEN

Is an optional word that increases readability of the command.

label1

Is a user-defined name of up to 64 characters to which to pass control if the -IF test is true. Do not use embedded blanks or the name of any other Dialogue Manager command. Do not use arithmetic or logical operations, words that can be confused with functions, or reserved words, such as CONTINUE.

The label text may precede or follow the -IF criteria in the procedure.

CONTINUE

Continues to the command that follows the semicolon (;) of the -IF command.

Note: CONTINUE cannot be used as a label in a -IF statement.

ELSE IF

Specifies a compound -IF test. The command -IF must end with a semicolon (;) to signal that all logic has been specified.

ELSE GOTO label2

Passes control to label2 when the -IF test fails.

If a command spans more than one line, continuation lines must begin with a hyphen (-) and one or more spaces.
Example: Conditional Branching Based on User Input

In the following example, the first report request or the second report request, but not both, executes. Suppose that for the procedure to run a user must supply a value for a variable named &PROC. The user may enter SALES or EMPLOYEE.

1. -IF &PROC EQ 'EMPLOYEE' GOTO EMPLOYEE;
2. -SALES
   TABLE FILE SALES
   SUM UNIT_SOLD
   BY PROD_CODE
   END
3. -EXIT
   -EMPLOYEE
   TABLE FILE EMPLOYEE
   PRINT PLANT_NAME
   BY DEPARTMENT
   END

The procedure processes as follows:

1. The user enters the value SALES for &PROC. A -IF test is done, and since the value for &PROC is not EMPLOYEE, the test fails and control is passed to the next line, -SALES.

   If the value for &PROC had been EMPLOYEE, control would pass to -EMPLOYEE.

2. The WebFOCUS code is processed, and stacked to be executed later.

3. -EXIT executes the stacked commands. The output is sent to the display and the procedure is terminated.

   The request under the label -EMPLOYEE is not executed.

Looping in a Procedure

You can perform an action repeatedly by looping in your procedure with the -REPEAT command. Looping can be used for many tasks. For example, you can populate an indexed variable using a loop or use the output of a request in a second request.

A process loop can be executed a designated number of times or until a condition is met. A loop ends when any of the following occurs:

- It is executed in its entirety.
- A -EXIT command is issued.
- A -GOTO is issued to a label outside of the loop.

**Note:** If you issue another -GOTO later in the procedure to return to the loop, the loop proceeds from the point at which it left off.
Note that the -SET command provides another method for implementing loops.

**Tip:** During loop processing, the search for labels that indicate the target of a -REPEAT or a -GOTO command takes longer in a procedure with variable, rather than fixed (80 character), record lengths. To speed execution in this situation, consider replacing loops with EX or -INCLUDE commands.

**Syntax:** How to Specify a Loop

- **REPEAT** *label* *n* **TIMES**

or

- **REPEAT** *label* **WHILE** *condition*;

or

- **REPEAT** *label* **FOR** &*variable* [**FROM** *fromval*] [**TO** *toval*] [**STEP** *s*]

where:

*label*

Identifies the code to be repeated (the loop). A label can include another loop if the label for the second loop has a different name than the first.

*n TIMES*

Specifies the number of times to execute the loop. The value of *n* can be a local variable, a global variable, or a constant. If it is a variable, it is evaluated only once, so you cannot change the number of times to execute the loop. The loop can only be ended early using -EXIT.

**WHILE** *condition*;

Specifies the condition under which to execute the loop. The condition is any logical expression that can be true or false. The loop executes if the condition is true.

**Note:** The condition must be followed by a semicolon (;).

&*variable*

Is a variable that is tested at the start of each execution of the loop and incremented by *s* with each execution. It is compared with the value of *fromval* and *toval*, if supplied. The loop is executed only if &*variable* is greater than or equal to *fromval* or less than or equal to *toval*.
fromval

Is a constant that is compared with &variable at the start of the execution of the loop. The default value is 1.

toval

Is a value that is compared with &variable at the start of the execution of the loop. The default value is 1,000,000.

STEP s

Is a constant used to increment &variable at the end of the execution of the loop. It may be positive or negative. The default increment is 1.

Note: The parameters FROM, TO, and STEP can appear in any order.

**Example:** Repeating a Loop

These examples illustrate each syntactical element of -REPEAT.

-REPEAT label n TIMES

For example:

-REPEAT LAB1 2 TIMES
-TYPE INSIDE
-LAB1 TYPE OUTSIDE

The output is:

INSIDE
INSIDE
OUTSIDE

-REPEAT label WHILE condition;

For example:

-SET &A = 1;
-REPEAT LABEL WHILE &A LE 2;
-TYPE &A
-SET &A = &A + 1;
-LABEL TYPE END: &A

The output is:

1
2
END: 3

-REPEAT label FOR &variable FROM fromval TO toval STEP s
For example:

-REPEAT LABEL FOR &A STEP 2 TO 4
-TYPE INSIDE &A
-LABEL TYPE OUTSIDE &A

The output is:

INSIDE 1
INSIDE 3
OUTSIDE 5

Using Variables in a Procedure

Using interactive variable substitution, you can create procedures that include variables (also called amper variables) and supply values for them at run time. These variables store a string of text or numbers and can be placed anywhere in a procedure. For example, a variable can refer to a field, a command, descriptive text, or a file name.

Note: A Dialogue Manager variable contains only alphanumeric data. If a function or expression returns a numeric value to a Dialogue Manager variable, the value is truncated to an integer and converted to alphanumeric format before being stored in the variable, unless you specify the precision to use.

Variables fall into two categories:

- Local and global variables have values supplied at run time. Local variable values remain in effect for the respective procedure, while global variable values remain in effect for all procedures executed during an entire session.

  Leading double ampersands (&&) denote global variables. All other Dialogue Manager variables begin with a single ampersand (&). For this reason, they are known as amper variables.

- System, statistical, and special variables have values that the system automatically resolves whenever you request them.

The maximum number of local, global, system, statistical, special, and index variables available in a procedure is 1024. Approximately 40 are reserved for use by WebFOCUS.

Variables can be used only in procedures. They are ignored if you use them while creating reports live at the display.

You can query the values of each type of variable you use.

The values for variables may be supplied in a variety of ways.
Reference: Naming Conventions for Local and Global Variables

Local and global variable names are user-defined, while system and statistical variables have predefined names. The following rules apply to the naming of local and global variables:

- A local variable name is always preceded by an ampersand (&). The variable can be named or positional.
  - A positional variable consists of a single ampersand (&) followed by a numeric string (for example, &1). The value of a positional variable is passed to a procedure when it is executed.

- A global variable name is always preceded by a double ampersand (&&).

- A variable name can consist of up to 100 characters.

- Embedded blanks are not permitted in a variable name.

- If a value for a variable might contain an embedded blank, comma, or equal sign, enclose the variable in single quotation marks when referred to.

- A variable name may be any combination of the characters A through Z, 0 through 9, and the underscore (_). The first character of the name should be a letter.

- You can assign a number instead of a name to a variable to create a positional variable.

- The underscore may be included in a variable name, but the following special characters are not permitted: plus sign (+), minus sign (-), asterisk (*), slash (/), period (.), ampersand (&), and semicolon (;).

Syntax: How to Specify a Variable Name

\&[\&]name

where:

\&

Denotes a local variable. A single ampersand (&) followed by a numeric string denotes a positional variable.

&&

Denotes a global variable.
name

Is the variable name. The name you assign must follow the rules outlined for Dialogue Manager.

Local Variables

Local variables are identified by a single ampersand (&) preceding the name of the variable. They remain in effect throughout a single procedure.

Example: Using Local Variables

Consider the following procedure, SALESREPORT, in which &CITY, &CODE1, and &CODE2 are local variables:

TABLE FILE SALES
HEADING CENTER
"MONTHLY REPORT FOR &CITY"
"PRODUCT CODES FROM &CODE1 TO &CODE2"
""
SUM UNIT_SOLD AND RETURNS AND COMPUTE
RATIO/D5.2 = 100 * (RETURNS/UNIT_SOLD);
BY CITY
IF CITY EQ &CITY
BY PROD_CODE
IF PROD_CODE IS-FROM &CODE1 TO &CODE2
END

Assume you supply the following values when you call the procedure:

EX SLRPT CITY = STAMFORD, CODE1=B10, CODE2=B20

Dialogue Manager substitutes the values for the variables as follows:

TABLE FILE SALES
HEADING CENTER
"MONTHLY REPORT FOR STAMFORD"
"PRODUCT CODES FROM B10 TO B20"
""
SUM UNIT_SOLD AND RETURNS AND COMPUTE
RATIO/D5.2 = 100 * (RETURNS/UNIT_SOLD);
BY CITY
IF CITY EQ STAMFORD
BY PROD_CODE
IF PROD_CODE IS-FROM B10 TO B20
END

After the procedure executes and terminates, the values STAMFORD, B10, and B20 are lost.
Global Variables

Global variables differ from local variables in that once a value is supplied, it remains current throughout the WebFOCUS session unless set to another value with -SET or cleared by the LET CLEAR command. Global variables are useful for gathering values at the start of a work session for use by several subsequent procedures. All procedures that use a particular global variable receive the current value until you exit from WebFOCUS.

Global variables are specified through the use of a double ampersand (&&) preceding the variable name. It is possible to have a local and global variable with the same name. They are distinct and may have different values.

Example: Using Global Variables

The following example illustrates the use of three global variables: &&CITY, &&CODE1, &&CODE2. The values are substituted in the first procedure, PROC1, and the values are retained and passed to the second procedure, PROC2.

```
TABLE FILE SALES
HEADING CENTER
"MONTHLY REPORT FOR &&CITY"
SUM UNIT_SOLD AND RETURNS AND COMPUTE
RATIO/D5.2 = 100 * (RETURNS/UNIT_SOLD);
BY CITY
IF CITY EQ &&CITY
BY PROD_CODE
IF PROD_CODE IS-FROM &&CODE1 TO &&CODE2
END
EX PROC2

TABLE FILE SALES
HEADING CENTER
"MONTHLY REPORT FOR &&CITY AND PRODUCT &&CODE1"
PRINT UNIT_SOLD AND RETURNS AND COMPUTE
RATIO/D5.2 = 100 * (RETURNS/UNIT_SOLD);
BY CITY
IF CITY EQ &&CITY
IF PROD_CODE EQ &&CODE1
END
```

Querying the Values of Variables and Parameters

Two Dialogue Manager commands enable you to:

- Display the values of all types of local, global, and system variables.
- Store the value of a parameter in a variable. The stored value can then be queried with the ? SET command.
In addition, you can issue two QUERY (?) commands to display the values of:

- **Global variables.** Since global variable values remain current throughout the WebFOCUS session, it is helpful to be able to display the values on demand. The syntax is:
  
  ? &

- **Statistics stored in variables.** You can query the current value of all statistical variables (except &FOCDISORG and &FOCERRNUM). The syntax is:
  
  ? STAT

**Syntax:**

**How to Display the Value of a Variable**

You can query all Dialogue Manager variables (local, global, system, and statistical) from a stored procedure. The syntax is:

```-? &[&variablename]```

where:

- **&**
  
  Issued alone, displays variables of all types.

- **variablename**
  
  Is the variable name, including the ampersand (&). Only amper variables starting with the specified string are displayed.

The command displays the following message, followed by a list of currently defined amper variables and the values:

**CURRENTLY DEFINED & VARIABLES:**

Since local variables do not exist outside a procedure, no similar query is available from the WebFOCUS command line.

**Displaying Data Sources**

The Use Qualified Path Command is available when creating content. A qualified path is one that includes all names in the hierarchic sequence above the object and the name of the object itself.

You can select the *Use Qualified Path* check box to only display data sources in the selected application folder. When the *Use Qualified Path* check box is unselected, all data sources in the application path are displayed.
When creating content or adding components to a procedure, selecting the *Use Qualified Path* check box will display an application folder selection area and a data source selection area. When the *Use Qualified Path* check box is unselected, only a data source selection area is displayed.

Procedure components that use a mix of qualified and non-qualified paths for the same data source will not work together. For example, the components that use the qualified path of a data source will work together and the components that use the non-qualified path of the same data source will work together.

If you want all components to work together, then all components need to either use the qualified path of a data source, or all components need to use the non-qualified path of a data source.
Creating HTML Pages

In App Studio, you can create and edit HTML pages using the HTML canvas. When you create a new HTML page, you use the HTML/Document Wizard.

This topic describes how to launch the HTML/Document Wizard to create HTML pages. It also identifies and explains the tabs and panels that are available when you are developing HTML pages in the HTML canvas.

In this chapter:

- Launching the HTML/Document Wizard
- Accessing HTML Page Components
- Creating a Widget to Autoplay Control Values
- Using Parameters
- Viewing Object Attributes
- Modifying Object Population Settings
- Using Tasks & Animations
- Working with Requests & Data Sources
- Displaying Applications in Different Languages
- Specifying Browser Defaults
- Chaining in the HTML Canvas
- Using JavaScript Code with HTML Canvas Pages
- Creating Responsive Web Pages
- Designing Content for Smartphones
- Cascading Style Sheet Support Matrix for Internet Explorer
- Cascading Style Sheet Class Mapping List

Launching the HTML/Document Wizard

The HTML/Document Wizard allows you to create a new HTML Page, Guided Report Page, or Document, and open a recent procedure.

To open the HTML/Document Wizard:

- On the Home tab, in the Content group, click HTML/Document.
- In the Environments Tree panel, right-click an application folder, point to New, and click HTML/Document.
**Note:** If you choose to create a new HTML page using the shortcut menu in the Environments Tree panel, your screen will not include a Navigator panel since the location for your HTML page is already selected.

The HTML/Document Wizard opens, as shown in the following image.

From the HTML/Document Wizard, you can open a recent HTML Page/Document or create a new one.

**Procedure:** How to Create an HTML Page Using the HTML/Document Wizard

After you have launched the HTML/Document Wizard, you can begin to create your HTML Page.

1. In the File Type area, select *HTML Page*.
2. Navigate to where you want to create the new procedure or select a recent procedure and click *Next*.
   
   **Note:**
   
   - The Next button is available after you select a valid path.
   - If you used the shortcut menu in the Environments Tree panel to create your HTML page, a location is already selected.
3. Optionally, you can add themes and settings to your HTML page.
4. Click Finish.

   The HTML canvas, File/Folder Properties panel, Properties panel, Settings panel, Requests & Data sources panel, and Tasks & Animations panel open. You can now add data to your HTML page and format the data using the tabs in the ribbon.

5. To save your HTML page, click the Save button on the Quick Access Toolbar or select Save from the Application menu.

6. To run your HTML page, click Run on the Quick Access Toolbar or click Run from the Application menu.

Procedure: How to Create a Guided Report Page Using the HTML/Document Wizard

After you have launched the HTML/Document Wizard, you can begin to create your own Guided Report page.

1. In the File Type area, select Guided Report Page.

2. Navigate to where you want to create the new procedure or select a recent procedure.

   **Note:** If you used the shortcut menu in the Environments Tree panel to create your Guided Report page, a location is already selected.

3. Optionally, click Next if you want to add themes and settings to your Guided Report page.

4. Click Finish.

   **Note:** The Finish button is unavailable until you select a valid path.

   The HTML canvas, File/Folder Properties panel, Properties panel, Settings panel, Requests & Data sources panel, and Tasks & Animations panel open. You can now add data to your HTML page and format the data using the tabs in the ribbon.

5. To save your Guided Report page, click the Save button on the Quick Access Toolbar or select Save from the Application menu.

6. To run your Guided Report page, click Run on the Quick Access Toolbar or click Run from the Application menu.

Accessing HTML Page Components

The following topics describe the tabs and panels that are available when you are developing HTML pages in the HTML canvas.
Inserting Components in an HTML Page Using the Components Tab

You can add a variety of components to an HTML page found in the command groups in the Components tab. For example, suppose you want to add a button to your page that a user can click to refresh the data. The button is a component. You select it from the Generic Elements command group in the Components tab, then add it to your page as desired.

The Components tab contains the Reports, Generic Elements, Containers, and Objects groups, as shown in the following image.

![Components Tab Image]

When you click a command from a ribbon, your mouse pointer turns into a cross-hair to let you draw the object in the HTML canvas. If you click a command in error, press the Escape key to return your mouse to a pointer.

Inserting a Report or Chart in an HTML Page Using the Reports Group

From the Reports group, you can add a report or chart to your HTML page. The Reports group is shown in the following image.

![Reports Group Image]

The commands in the Reports group are:

**Report**

Inserts a report object. You can add reports to the HTML canvas that will display when you run the layout. You can either embed or reference reports. Double-clicking a blank report object opens the Report canvas where you can create and style a report to be used in the HTML page.

You can also include parameters in a report whose values can be assigned with controls that are added with the HTML canvas.
Chart

Inserts a chart object. You can add charts to the HTML canvas that will display when you run the layout. You can either embed or reference charts. Double-clicking on a blank chart object will open the Chart canvas where you can create and style a chart to be used in the HTML canvas.

Procedure: How to Add a New Report or Chart to an HTML Page

1. Insert a report or chart object by doing one of the following:
   - On the Components tab, in the Reports group, click the Report or Chart.
   - Right-click in the layout and select New Report or New Chart from the shortcut menu.
   The pointer changes into a crosshair.

2. Drag the crosshair to create a report or chart object and adjust it to the size that you want.

   A report or chart object is created in the layout and assigned the name report(n) or chart(n), where n is a number. The object will appear in gray and white to indicate that the placeholder does not have a report or chart associated with it. Once a report or chart is associated with the object, the object displays the contents of the report or chart if live or simulated data is active (live data is the default) or a colored placeholder if preview is off in the HTML Page tab, located in the App Studio Options dialog box.

3. Create a report or chart by doing one of the following:
   - Double-click the placeholder.
   - or
   - Right-click the placeholder and select New Report for a report, or New Chart for a chart.
   The Open File dialog box appears.

4. Select the Master File you want to use and click OK.
   The Report canvas opens for reports and the Chart canvas opens for charts.

5. Optionally, after creating the report or chart, you can change its properties by adjusting the properties displayed in the Properties panel.

Procedure: How to Add an Existing Report or Chart to a Layout

1. Insert a report or chart object by doing one of the following:
   - On the Components tab, in the Reports group, click Report or Chart.
   - Right-click in the layout and select New Report or New Chart from the shortcut menu.
The pointer changes into a crosshair. Drag the crosshair to create a report or chart object and adjust it to the size you want.

A report or chart object is created in the layout and assigned the name report\( (n) \) or chart\( (n) \), where \( n \) is a number. The object will appear in gray and white to indicate that the placeholder does not have a report or chart associated with it. Once a report or chart is associated with the object, the object displays the contents of the report or chart if live or simulated data is active (live data is the default) or a colored placeholder if preview is off in the HTML Page tab, located in the App Studio Options dialog box.

2. Right-click the report or chart.
   - Select Reference existing procedure.
   - For a report, right-click the report object and select Import existing report.
   - For a chart, right-click the chart object and select Import existing chart.

   The Open File dialog box appears.

3. Enter the name of the procedure you want to add to the layout.

4. Click OK.

   The report or chart object appears in the Design view of the HTML canvas.

**Adding Basic Elements to an HTML Page Using the Generic Elements Group**

You can add a variety of basic elements. The Generic Elements group is shown in the following image.

![Generic Elements Group](image)

The commands in the Generic Elements group are:

**Image**

Inserts an image. You can add an image to the layout. This is useful for including graphics, such as a company logo.

You can insert an image into your report layout and add a hyperlink. After you run your report and click the image, you can launch a URL or run a report the same way by clicking a hyperlink or push button.
**Note:** When inserting images, images must be referenced from a specific directory location.

**Hyperlink**

Inserts a hyperlink.

**Button**

Inserts a button. A push button enables you to execute a report or link to a URL or HTML file. This behavior is similar to a hyperlink.

**Note:** You can either double click to change the text or can use the Text property in the Properties panel.

**Reset**

Inserts a reset button. A reset button enables you to revert the entire page back to its initial settings.

**Save Selection**

Inserts a Save Selection button. At run time, the user can select given parameters and save them in a snapshot by clicking the Save Selection button. This creates a static HTML file that is saved in the same folder as the source file, by default.

To make the default save location for the parameterized HTML page your nearest My Content folder instead, select the Save Selection button on the canvas and, in the Properties panel, select My Content for the File default folder property. You can still navigate to another folder in your environment to save it there. The new save location becomes the default for saved parameter pages for the remainder of the session.

The static Save Selection files are not editable in the HTML canvas or in the text editor. To verify that a file is a Save Selection file:

1. Right-click the file in the Configured Environments tree and select Properties from the shortcut menu.
   
   The File/Folder Properties panel opens.

2. The value for the Properties attribute is tool=saveparam. This indicates that the file is not editable in the HTML canvas or in the text editor.

**Hamburger**

Inserts a hamburger control, which can be used to hide or display a form or control panel. A control panel is a panel component that has the Control panel property enabled.
To use a hamburger control, add it to the page, select it, and open the Properties panel. In the Hamburger specific section, select a form or control panel on the page from the Navigation and controls panel drop-down menu. You can also use the Properties panel to set the animation used when the hamburger control is clicked, and automatically hide the form or control panel when a request is executed on the page.

When you run the HTML page, the selected form or control panel does not appear until you click the hamburger control. You can hide it by clicking the hamburger control again.

**Label**

Inserts a label. The label component lets you create and name a label, and link it to a control. To link a label to a control, you can select a value from the HtmlFor property drop-down list in the Properties panel, or you can select the *Bind label to* option from the shortcut menu, when the label and control are both selected.

**Text**

Inserts a text box. You can add text to the layout. This is useful for including headings for your webpage, or adding directions or explanations for your report or chart.

**Line**

Inserts a line. You can add a horizontal or vertical line to the layout. This is useful for distinguishing between sections of your launch or display page.

**Menu**

Inserts a menu. You can add a horizontal or vertical menu to the layout. This component can be used with Maintain code.

**Table**

Inserts a table. This component can be used with Maintain code.

**Grid**

Inserts a grid.

**Procedure:** How to Toggle the Display of a Form Using a Hamburger Control

A hamburger control allows you to show and hide a form, saving space on an HTML page.

1. Create an HTML page.
2. Add a chart or report component to the page, and reference a procedure that includes at least one parameter.

   The New Parameters dialog box opens.
3. Click OK to create a form on the page using the default options.
4. On the Components tab, in the Generic Elements group, click Hamburger and draw a hamburger control onto the page.

**Note:** Forms appear below and to the right of the hamburger control when it is clicked. Make sure to leave enough space between the hamburger control and the right side of the page to display the entire form.

5. Select the hamburger control and open the Properties panel.

6. Link the hamburger control to a form. In the Hamburger specific section of the Properties panel, click the drop-down menu for the Navigation and controls panel property, and select the form that you want to access using the hamburger control.

You can also link a hamburger control to a control panel. To create a control panel, on the Components tab, in the Containers group, click Panel, and draw a panel onto the page. Select it and, in the Properties panel, set the Control panel property to Yes.

7. Optionally, set the Animation and Auto-hide panel properties.

   The Animation property allows you to set the animation that occurs when the form appears.

   When the Auto-hide panel property is enabled, clicking the submit button in the form hides the panel. If Auto-hide panel is not enabled, you can hide the form again by clicking the hamburger control.

8. Run the HTML page. The form is hidden, by default, and it appears when you click the hamburger control.

**Procedure:** How to Format Text in an HTML Page

You may apply various formatting and style options to words and individual text characters within the text object.

**Note:** Any formatting and styling that you have applied to individual text strings within the text object will remain unchanged. Changes made to the entire text object are only applied to part of the text string that has not been formatted.

1. On the Components tab, in the Generic Elements group, click Text.

   The pointer changes to a crosshair.

2. Drag your pointer across the canvas to create a text object.

   A text object with the default text, *Enter text*, is created.
3. Select the text that you wish to format:

- To format the entire text object, single-click the text object in the layout.
- To format an individual word or text character, highlight part of the text within the text object.

4. Right-click the text, point to Style, and then click Font.

The Style Composer dialog box opens with Font selected automatically.

**Note:** You can also access font formatting options in the Properties panel.

5. Select from the formatting options available. You can change the type, style, color, size, and effect of the font.

**Note:** When you enter a Specific font size, the unit defaults to px (pixels).

6. Click OK to close the Style Composer dialog box.

The formatting options that you selected are applied to the text.

**Procedure:** How to Insert a Bulleted List or Numbered List Into a Text Element

To insert a bulleted list or numbered list into a text object:

1. On the Components tab, in the Generic Elements group, click Text.

The pointer changes to a crosshair.

2. Drag your pointer across the canvas to create a text object.

A text object with the default text, Enter text, is created.

3. Add multiple lines of text to the text object.

4. Highlight and right-click the text that you want to include in the list.

5. In the shortcut menu, select one of the following list options:

- **Bullets**
  - Disc
  - Circle
  - Square
  - None

- **Numbering**
  - Numbers
Lowercase Letters
Uppercase Letters
Small Roman numerals
Large Roman numerals
None

Note:

- Alternatively, you can select a bullet type before typing text to begin the list. Pressing enter will begin the next item in the list on a separate line.

- To change the bullet or number list type of an existing list, place your pointer on the list level you want to change and reselect a bullet or number list type. Selecting None will remove the bullets or numbers for that level and move any nested lists up one level. In order to switch between bullets and numbers, you must first remove the current list option by selecting None and then applying the list option you want.

Procedure: How to Insert Nested Lists Into a Text Element

To insert a nested list into the text object:

1. On the Components tab, in the Generic Elements group, click Text.
   The pointer changes to a crosshair.

2. Drag your pointer across the canvas to create a text object.
   A text object with the default text, Enter text, is created.

3. Add a list to the text object. For more information, see How to Insert a Bulleted List or Numbered List Into a Text Element on page 500.

4. Place your pointer after a list item.

5. Right-click, point to Nested List and then select a bulleted or numbered list option.
   A list is started within the current list, allowing you to enter text on that list level.

   Note: Pressing Tab while your pointer is on the same line as a list item will move that item one level down, resulting in a nested list. The bullet or number type selected is the next list type in the right-click shortcut menu. For example, if you have a bulleted list that uses the disc bullet type, pressing Tab to move an item down one level will cause that nested list to have the circle bullet type.

   You can continue to nest lists within other lists by using the same steps shown above.
Adding Containers to an HTML Page Using the Containers Group

You can add specific containers that group objects together on an HTML page. The Containers group is shown in the following image.

The commands in the Containers group are:

**Form**

Inserts either a multi-layer form or single-layer form.

**Tab**

Inserts a tab control. Tab controls enable you to create multiple pages in one HTML form and present a better display for viewing secondary information. You can select Top, Bottom, Left, or Right. This means you can choose to add a tab control that displays tabs at the top, bottom, left, or right on the control.

You can drag and resize this object, at run time, if the Enable dragging and Enable resizing properties, in the Properties panel, are set to Yes.

To change the header text, you can either double click and change the header text or enter a value in the Selected Page: Title property.

When a tab control object is added to the layout, each tab control consists of:

- A tab item.
  
  A tab item is the tab label. You may edit the name of the tab item, style the tab item, and add multiple tab items. Each tab item is associated with a tab body.

- A tab body.
  
  A tab body is the tab page where you associate your components, such as report and graph objects, images, and lines.

The Tab control can be displayed as a full screen or part of an HTML page.
**Accordion**

Inserts an Accordion styled box. You can drag and resize this object, at run time, if the Enable dragging and Enable resizing properties, in the Properties panel, are set to Yes.

To change the header text, you can either double click and change the header text or enter a value in the Selected Page: Title property.

**Window**

Inserts a window. You can drag and resize this object, at run time, if the Enable dragging and Enable resizing properties, in the Properties panel, are set to Yes.

To change the header text, you can either double click and change the header text or enter a value in the Selected Page: Title property.

**Output Widget**

Inserts an output widget. The output widget container includes buttons in the widget title bar that let you display or hide filter controls and that let you maximize to display full-screen, and minimize to return it to its original size.

**Mobile Container**

Inserts a mobile container containing an output widget. You can right-click the mobile container to add multiple pages, and then create tasks using the Go to page action to navigate between them. If you right-click a page in a mobile container and click *Selected page as prototype*, any subsequently added pages are created as clones of the prototype page.

The output widgets on mobile container pages include hamburger controls, allowing you to access collapsible forms and control panels to interact with the page at run time.

You can enable responsive design on an HTML page that includes a mobile container so that the mobile container and the output widgets in it can resize to comfortably fit on mobile devices.

**Maintain Data App**

Inserts a Maintain Data app window. You can drag and resize this object, at run time, if the Enable dragging and Enable resizing properties, in the Properties panel, are set to Yes.

**Group Box**

Inserts a group box. A group box can be used to create a border around a group of objects, for example, forms or reports and charts.

**Panel**

Inserts a panel to group objects together. The panel is invisible at run time.
Procedure: How to Use a Form Object to Create a Pop-Up Dialog Box

You can use a form object to create a pop-up dialog box.

1. Create a form object.
2. Create a button.
3. Select the form.
4. In the Properties panel, change the Display container as property to As popup dialog.
5. Create a new task in the Tasks section of the Tasks & Animations panel.
6. Use the button you create as the trigger.
7. Make the button object toggle the visibility of the form you created.
8. Run the page and click the button to display the form as a dialog box.

Procedure: How to Create a Pop-Up Dialog Box or Pop-Up Window From a Form Control

1. Add a button object to your HTML page.
2. Add a form control to your HTML page.
3. Delete the run and back buttons created with the form control.
4. While the form control is selected, in the Properties panel, change the Display container as property to either As popup dialog or As popup window.

   As popup dialog causes the form to display as a pop-up dialog box. When the dialog box is displayed, you must click Close to return to your HTML page.

   As popup window causes the form to display as a pop-up window. When the window is displayed, you can resize and move the window around your screen.

5. Create a new task in the Tasks section of the Tasks and Animations panel that uses the button object to toggle the visibility of the form you created.
6. Run your HTML page.
   When you click the button you added to the HTML page, the form will be displayed as either a pop-up dialog box or a pop-up window, depending on what option you selected.

Reordering Tabs, Accordions, and Windows

You can reorder tabs, accordions, and windows by dragging the page that you want to appear first onto the page that you want it to display before. For example, if you have 3 tabs, Tab1, Tab2, and Tab3, and you drag Tab3 onto Tab1, Tab3 will now display ahead of Tab1. The order of the tabs will then be Tab3, Tab1, Tab2. You can reorder windows when they are in tile view.
**Procedure:** How to Navigate Between Pages in a Mobile Container

You can add multiple pages to a mobile container on an HTML page to provide different sets of content with expandable forms and control panels. You can add a task using the Go to page action to allow users to move between pages.

1. Create a new HTML page.
2. Open the Properties panel and, with the `DOCUMENT` object selected, set the Enable responsive property, in the Responsive design section, to Yes.
   
   Using responsive design will make the content on the page easier to use on mobile devices.
3. On the Components tab, in the Containers group, click Mobile Container and draw a mobile container on the page.
   
   The mobile container contains one page by default.
4. Click on the output widget in the first page of the mobile container, and open the Properties panel. Enter a new title for the page using the Widget Title property.
   
   Since the Go to page action differentiates between pages by the widget title, using different titles for each one helps to ensure you select the correct page to navigate to.
5. Add content to the first page inside the output widget.
6. Create a control panel that will include a button to navigate to the second page. The control panel can also include filter controls to interact with the content on the page.
   
   a. On the Components tab, in the Containers group, click Panel, and create a panel on the page.
   
   b. On the Components tab, in the Generic Elements group, click Button and draw a button inside the panel.
      
      Optionally, double-click the button to change the text in it.
   
   c. Select the panel containing the button and open the Properties panel. Set the Control panel property to Yes.
      
      This turns the panel into a control panel that can be accessed using the hamburger control in the mobile container output widget.
7. Select the mobile container output widget and open the Properties panel. Select the control panel that you created previously from the menu next to the Navigation and controls property.
8. Right-click the mobile container, outside of the output widget, and click Add Page.
   
   A second page with an output widget is created in the mobile container.
9. Repeat steps 4 through 7 to create the second page. Follow these steps again for any additional pages that you want to add.
10. Create two new tasks using the Go to page action to navigate between the first and second page.
   a. Open the Tasks & Animations panel.
   b. Click the New button to create a new task.
   c. Leave the Trigger Type as Click.
   d. For the Trigger Identifier, select the first button that you created, which is in the collapsible panel on the first page of the mobile container.
   e. Click the arrow next to the Requests selections button, point to Go to page, point to the name of the mobile container, and select the name of the second page in the mobile container.

   This will allow you to access the second page from a button accessible from the first page.
   f. Click New to create a second task.
   g. Leave the Trigger Type as Click.
   h. For the Trigger Identifier in the second task, select the button that will be accessible from the second page of the mobile container.
   i. Click the arrow next to the Requests selections button, point to Go to page, point to the name of the mobile container, and select the name of the first page in the mobile container.

   This will allow you to return to the first page using a button accessible on the second page.

11. Save the HTML page and access it from a mobile device.

   When you tap the hamburger control, a panel with a button opens. Tap the button to access the other page created using the mobile container.

**Adding Objects to an HTML Page Using the Objects Group**

You can add objects other than reports, charts, elements, or containers to customize your HTML page. The Objects group is shown in the following image.
The commands in the Objects group are:

**Frame**

Inserts a frame object. You can use a frame to embed additional web sources or run reports. You can also use a frame as the output location or target for a drill-down report. You can also use a frame to run a table of contents report, an OLAP report, a PDF report, or an Excel® report.

**Flash**

Inserts a Flash component. You can add SWF files that are Adobe® Flash Player compatible to accompany reports or graphs on an HTML page.

**Note:** When inserting Flash animations, only files that are 1 MB or smaller can be run using the HTML canvas.

**Map**

Inserts a map object. You can add a Google™ or ESRI map to your HTML page. Maps are services offering powerful, user-friendly mapping technology that can be customized to show points on a map with drill-down capabilities. You can customize the map properties and bind them to a report or chart.

**HTML**

Inserts an HTML object. Developers can use the Settings panel to type a valid snippet of HTML code for the HTML object, such as HTML code to browse for a file.

**ESRI Map**

Inserts an ESRI map object. You can use the Settings panel to configure the properties and components.

### Changing Load Order With HTML Object Manipulation

In an HTML page, objects load in the order in which they were added to the canvas. A developer using raw HTML has the option of editing the source code to change the load order. Such edits leverage the Document Object Model (DOM) for HTML and XML documents.

In App Studio, however, the source code cannot be edited. Therefore, the HTML object manipulation menu is provided to allow you to change the load order, if necessary.

To change the load order, select multiple objects or components in the HTML canvas, then right-click and select HTML object manipulation. The following menu options are available:

- **Add selected to new container.** To put a container around two or more multiselected objects. Objects in a container load at the same time.
- **Append selected.** Available when the last multi-selected object is a container. Use this option to move one or more multi-selected objects into the container.

- **Insert selected before.** To load the last multiselected object before the other selected objects.

- **Insert selected after.** To load the last multiselected object after the other selected objects.

- **Swap selected.** To swap positions for two multiselected objects.

### Accessibility Support for Displaying Objects in the Order of the Document Object Model

You can add elements/objects independently of screen reading order and then change the order later on during the development process.

Using the Accessible property, available on the Properties panel for a document, you can indicate that the Document Object Model (DOM) should be rewritten in the order of objects on the page, left to right, top to bottom. In addition, all tab index values should be set to the value -1.

**Procedure:**  **How to Display Objects in the Order of the DOM**

1. Create a new HTML page with multiple controls on the page.
2. On the Properties panel for the document, select Yes from the Accessible drop-down menu, as shown in the following image.

The following tab order warning message appears, as shown in the following image.

**Note:** The Warning message displays only once, when the Accessibility property is set to Yes.

Selecting Yes will write the tab order of objects on the page, left to right, top to bottom. Selecting No will keep the tab order in the page.
Inserting Controls in an HTML Page Using the Controls Tab

You can use the Controls tab and group to insert controls in an HTML page or a Guided Report page. Controls enable you to prompt users for a parameter value. When you create a parameter as part of a report or graph, the HTML canvas automatically adds a control, Submit button, and Reset button for the parameter to your layout, and the parameter appears on the Parameters tab. You can also add an input control and bind it to a parameter.

Controls, with the exception of a text box which does not supply a list of possible values, can supply values with a dynamic or static list of values:

- A dynamic list retrieves values from a specified data source when the request is run.
- A static list consists of a list of values you supply. These values do not change unless you change them.

An Analytic Document control lists Analytic Document values that mimic In-Document Analytic menu items. The Analytic Document controls cannot be associated to any parameters in the layout. This type of control can only be associated with an Analytic Document in the layout.

The properties of a control, as well as the parameters associated with each control, can be controlled with the Properties tab of the Properties window, and with the Parameters tab. The Controls tab is shown in the following image.

The controls are:

**Edit Box**

Inserts a text box. A text box enables you to enter a value in an entry field. You can specify a list of static or dynamic accepted values in Settings panel and, at run time, when you type the first letter of a value into the text box, that value will be listed as an autocomplete suggestion.

Change the Type property for the edit box control to *File* to use the edit box to browse for files from your system, to *Password* to automatically mask the text for password entry, or to *Hidden* to make the control invisible.
Hidden

Inserts a hidden control. A hidden input control allows parameter values to be used in a control without the user seeing them. When a hidden control is used, the current input control assigned to the parameter will not be visible. The value of the parameter can be entered in the Properties panel of the Parameters tab, or supplied through chaining.

Drop Down

Inserts a drop-down list. A drop-down list enables you to select single or multiple values from a list of supplied values. In order to provide multiple values, the procedure must be set up to accept multiple values.

- A single-select drop-down list enables you to select only one value for each time a request is run.
- A multiselect drop-down list enables you to select multiple values using the check boxes adjacent to the values.

You can use a dynamic or static list of values for the drop-down list.

Note: The height of a drop down control is based on the font size of the text within it, and not the height property of the control object.

List Box

Inserts a list. This enables you to select single or multiple values at one time:

- A single-select list enables you to select only one value for each time a request is run.
- A multiselect list enables you to select multiple values by using the Ctrl key while selecting values.

In order to provide multiple values, the procedure must be set up to accept multiple values.

List box values can be dynamic or static.

Double list

Inserts a double list. Displays multiselect values. This enables you to view a list of the available values and add or remove them from one list to another. At run time, a report is generated based on the values that are added.

Radio Button

Inserts a radio button. Radio buttons enable you to select a single value from a list of supplied values. Radio button values can be static or dynamic.
Use the Type property to control the appearance of the radio buttons. From the drop-down list box in the Type field, select "Standard" to display standard radio buttons.

From the drop-down list box in the Type field, select "Push button" to display push buttons.

**Check Box**

Inserts a check box. Check boxes enable you to select a single value from a list of supplied values. Note that if there are multiple check box input controls that are grouped together, you may select the Multiple properties for each control. Multiple ensures that you can select a single value from each check box control. Check box list values can be dynamic or static.

Use the Type property to control the appearance of the check boxes. From the drop-down list box in the Type field, select "Standard" to display standard check boxes.

From the drop-down list box in the Type field, select "Push button" to display push buttons.

**Text area**

Inserts a text area. A text area is a single-select control that enables you to enter multiple lines of text that can be assigned to a single variable. The behavior is similar to a text box, but you are not restricted to entering just one line of text. For example, if you want to assign a paragraph (multiple lines of text) to a variable that can be referenced by a procedure, you can add the paragraph to a text area from the Properties panel on the Parameters tab.

If you want to display text in the control:

- When hard wrap is enabled, at run time, a line break is shown at the point where it was specified.

- For soft wrap, the line should wrap automatically depending on the size of the text area control.

If you want to submit values in the control:

- For single-select text area controls, only the first value up to the end of the line will be submitted.

- For multiselect text area controls:

  - All of the values separated by OR or AND will be submitted. For example, "ENGLAND" OR "FRANCE".

  - To indicate one value with a comma, type ENGLAND,FRANCE.

  - To indicate two values with a comma, type "ENGLAND","FRANCE".
To indicate two values, type the values on separate lines. For example:

ENGLAND
FRANCE

Tree

Inserts either a single-source tree control or multi-source tree control. By using a tree structure in an HTML report, you can show hierarchical data from a multi-dimensional data source (for example, SAP BW), that uses the parent/child model. You may also use a tree control for non-hierarchical data sources. Level hierarchies are not supported. The behavior of the tree control is integrated with the parameter definition. If a parameter is defined as a single value and that parameter is bound to a tree control, the tree control uses option buttons for each node in the hierarchy. If the parameter is defined as Multiselect OR or Multiselect AND, and that parameter is bound to a tree control, then the tree control uses check boxes for each node in the hierarchy, enabling you to select multiple nodes.

Calendar

Inserts a calendar. Date parameters can utilize a built-in calendar control that enables you to select the desired date or range of dates in a pop-up dynamic calendar. A procedure or parameter that is added to or referenced in the HTML canvas, and contains date parameters, will have a Calendar control type available in the New Parameters dialog box. When you select the Calendar control type, a text box with a calendar icon displays in the Design view of the layout. The text box is the only control available for the calendar, and the icon always displays to the right of the text box. The icon cannot be positioned independently from the text box. Note that when programmatically returning a date to the calendar, the date must be in a WebFOCUS date format that specifies the complete date from the list of supported data types in the Popup Calendar Settings section of the Settings panel.

Slider

Inserts a horizontal or vertical slider control that has a numeric range of values to be used with a report or chart. This enables you to use a slider bar to select from a range of values.

Adding Paging/Search Capabilities to a Control

With a List Box, Drop Down List, or the first control of a Double List, you can add additional paging and search capabilities. Designed for controls that have a large number of valid values, this functionality enables you to:

- Page through a large list of values before making a selection.
Search for a value within a control.

These options give you a quick way of narrowing your search when you know the value, or partial value, that you want to use to filter your page.

The *Add 'Paging/Search' control* function is available on the HTML canvas through the right-click context menu for the List Box, Drop Down List, and the first control of a Double List.

Use this function to enhance the capabilities of an individual control. If you want to create a single Paging/Search option that applies to multiple controls on a page, see *Adding a Paging/Search Control to an HTML Page* on page 516.

You can also create a search control, which includes only the search functionality of the paging/search control.

**Procedure:** How to Add Paging/Search Capability to a Control

To add paging and search capabilities to a control that has a large number of valid values:

1. On the HTML canvas, select a List Box, Drop Down List, or the first control of a Double List, then right-click the control and select *Add 'Paging/Search' control* from the shortcut menu.

   The paging/search control is added to the canvas below the input control. The following image shows the paging/search control added below a Drop Down List for Product Subcategory.

   ![Image of paging/search control](image)

   Note that the blue left and right arrow buttons are for paging. The gray magnifying glass and arrow buttons are for searching.

   At run time, the paging/search control shows a number or page range of values. The default range is 1-50, meaning the input control starts at the first value and displays a range of 50 values per page.

2. Optionally, in the Search/paging control section of the Properties panel, with the navigator object selected, select the following default search options for the paging/search control:

   - **Match Prefix.** The search string matches the beginning of each value. When not enabled, the search string can appear at any point in the control value.

   - **Match Case.** Searches are case-sensitive.
- **Match Whole Word Only.** Search values are returned only for entire words that match the search string.

- **Instant Search.** The value is automatically searched as you type in the input control.

- **Keep selected values.** When selected, the values that you select on each page or search for are retained when you leave the page, and are shown again when you return to it. If you run the request, all previous selections are used.

- **Show settings.** Search options display in the paging/search control by default. You can show or hide search options in the control by clicking the search arrow button.

- **Number or Range.** Specifies the initial number of values or range of values to show in the control.

3. Run the HTML page.

   The paging/search control shows the specified range. For example, 1-50.

4. Use the arrow buttons to page through the values to be displayed for the input control. You may select First, Previous, Next, or Last.

   For searching, enter a search term in the paging/search control and press the Enter key or click the Search (magnifying glass) button.

   To display search criteria, click the search arrow button on the far right. The search criteria list is displayed. You can select any of the following options:

   - **Match Prefix.** Search value prefix must match the prefix of the value in the input control.

   - **Match Case.** Search value must match the value in the input control exactly.

   - **Match Whole Word Only.** Search value word must exist in the string.

   - **Instant Search.** The value is automatically searched as you type in the input control.

   - **Keep selected values.** When selected, the values that you select on each page or search for are retained when you leave the page, and are shown again when you return to it. If you run the request, all previous selections are used.

   Toggle the search arrow button to hide the search criteria list.

5. Click the Run button to refresh the report, showing the value selected in the input control.
Adding a Paging/Search Control to an HTML Page

A global paging/search control lets you add additional capabilities to an HTML page that contains multiple instances of the following controls: List Box, Drop Down List, and the first control of a Double List. Designed for controls that have a large number of valid values, this functionality enables you to:

- Page through a large list of values before making a selection.
- Search for a value within multiple controls.

The global paging/search is added as a DOCUMENT level property in the Search/paging section of the Properties panel.

Use this option to enhance the functionality of an HTML page. If you want to enhance the functionality of an individual control, see Adding Paging/Search Capabilities to a Control on page 513.

Procedure: How to Add a Paging/Search Control to an HTML Page

Use this procedure to add global paging and search capabilities to an HTML page with multiple controls.

The search options for the global paging/search control override the options for individual controls. For example, if Keep selected values is selected for the global paging/search control, that setting is applied to all controls on the page, regardless of whether they have Keep selected values enabled.

1. In the Properties panel for the DOCUMENT object, in the Search/paging section, click the Enable property and select Yes from the drop-down menu.
2. Optionally, in the Search/paging control section of the Properties panel, select the following default search options for the paging/search control:

   - **Match Prefix.** The search string matches the beginning of each value. When not enabled, the search string can appear at any point in the control value.

   - **Match Case.** Searches are case-sensitive.

   - **Match Whole Word Only.** Search values are returned only for entire words that match the search string.

   - **Instant Search.** The value is automatically searched as you type in the input control.

   - **Auto-link.** When enabled, selecting an input control on the page automatically connects the global paging/search control to it. When not enabled, connect the global paging/search control by selecting an input control and then clicking the global paging/search control.
Keep selected values. When selected, the values that you select on each page or search for are retained when you leave the page, and are shown again when you return to it. If you run the request, all previous selections are used.

Show settings. Search options display in the global paging/search control by default. You can show or hide search options in the control by clicking the search arrow button.

Number or Range. Specifies the initial number of values or range of values to show in the control.

1. Run the HTML page.
   The global paging/search control appears in the upper right corner of the window (Home position).

2. Click an input control.
   The global paging/search control appears below the selected input control.
   The label for the input control is displayed showing that it is linked to that input control. If no label is associated with the input control, the window will show the unique identifier for the input control, for example, combobox1.

   If you want multiple pages, type a range in the Search/Paging field in the format 1-2 of 4 and press the Enter key.

3. Click the Show settings button on the Global Search and Paging window to expand the window and show the search and paging options.

   The Search/Paging options are:

   Match Prefix. Search value prefix must match the prefix of the value in the input control.

   Match Case. Search value must match the value in the input control exactly.

   Match Whole Word Only. Search value word must exist in the string.

   Instant Search. The value is automatically searched as you type in the input control.

   Auto-link to selected control. Link the Search/Paging control to the selected control (default).

   Keep selected values. When selected, the values that you select on each page or search for are retained when you leave the page, and are shown again when you return to it. If you run the request, all previous selections are used.
Toggle the Up arrow button to display and collapse the Search/Paging options. Click the Home icon on the Search/Paging window to move the window back to the Home position.

**Defining the Load Order for Control Values**

You can specify when controls are populated with values. If a control is configured to display a large number of values, you can set the values to populate after the content on the page is loaded, allowing the page to load more quickly.

To specify load order for a control, select it, and, in the Properties panel, select a value for the Loading procedure property. You can select one of the following values:

- **Initial loading.** The control is populated with values when the page initially loads. This is the default value.

- **Post initial loading.** Control values populate once the Load task is executed, after the rest of the page has loaded.

- **On demand.** The control is not populated automatically. To populate the control, create a task in the Tasks & Animations panel, select *Refresh* from the Requests selections menu, and set the control as the target, or use the *IbComposer_populateDynamicCtrl* function.

- **On demand and hide initially.** The control is not populated automatically and does not display until it is populated. To populate and display the control, create a task in the Tasks & Animations panel, select *Refresh* from the Requests selections menu, and set the control as the target, or use the *IbComposer_populateDynamicCtrl* function.

**Note:** You can set the Loading procedure property for any object that is treated as an input control, including tables, grids, and maps.

**Procedure: How to Use a Button to Populate a Control**

You can use the Loading procedure property to specify when controls are populated with values at run time. This example shows how to create a control object that initially appears blank but populates with values when a button is clicked.

1. In the HTML canvas, add a control to the page. On the Controls tab, in the Controls group, select a type of control and draw it onto the page.

2. Add values to the control. Select the control and open the Settings panel. Select a data type for the list of values in the control and populate the control.

   Optionally, bind the control to a parameter from a request referenced in the HTML page.
3. Set the control so that values do not load automatically, and instead must be prompted at run time.
   a. Select the control and open the Properties panel.
   b. Set the Loading procedure property. Select On demand or On demand and hide initially so that the control does not populate with values automatically. If you select On demand and hide initially, the control will not be visible until you prompt it to load values.

4. Add a button or other item to the page to trigger the loading of values in the control.

5. Open the Tasks & Animations panel and create a new task to execute control object population. Specify the following properties for the task:
   a. Set the Trigger Type for the task, for example, Click, which executes the task when the Trigger Identifier is clicked.
   b. Set the Trigger Identifier to the button or other object that you want to use to trigger loading of control values.
   c. Under Requests/Actions, in the Requests selections menu, click Refresh.
   d. Change the Target type to Input Control.
   e. From the Target/Template Name menu, select the control object.

6. Save and run the HTML page.

If the Loading procedure property is set to On demand, the control object is empty when the page initially loads. When you execute the task to refresh the control (for example, by clicking a button), the control populates with values.

If the Loading procedure property is set to On demand and hide initially, then when the page initially loads, the control is not visible. When you execute the task to refresh the control, the control appears and is populated with values.

**Procedure: How to Enter Masked Text in a Text Box**

When entering a value in a text box at run time, you may set the Mask text property so that the text is not displayed as text, but masked by default characters. This is recommended when using passwords or other sensitive information.

1. Select the Edit Box object to view the associated properties in the Properties panel.
2. From the Mask text property field, select Yes.
3. Run the report and enter a value in the text box.

The value being entered appears as masked text.
Procedure: How to Upload a File to an Application Folder Using an Edit Box

When you change the Type property of an edit box to File, you can use it to browse files on your system. You can then use the IbComposer_saveSelectedFile function to upload the file to a selected location in the Data Servers area.

1. Create an HTML page.
2. On the Controls tab, click Edit Box, and draw an edit box on the page.
3. In the Properties panel, change the Type property for the edit box to File.
   A Browse button is added to the edit box.
4. Optionally, in the Properties panel for the edit box, use the Accept property to specify the types of files that will be available for selection using a comma-separated list of file type specifiers.
   These file type specifiers can be extensions, including the period, such as .jpg or .fex, or MIME type strings, such as image/* or text/html.
5. In the Properties panel, click the ellipses button for the Copy file to property, select the location in the Data Servers area in which to save the uploaded files, and click Select.
6. On the Components tab, in the Generic Elements group, click Button, and draw a button onto the page.
7. Select the button and open the Properties panel.
8. At the top of the Properties panel, click the Events button.
9. Click the ellipses button next to Click to add an on-click event.
10. In the Embedded JavaScript tab, in the new on-click event, add the following JavaScript function:

\[ \text{IbComposer\_saveSelectedFile("uniqueID")} \]

Where uniqueID is the unique identifier for the edit box.
11. Run the page and click the Browse button on the edit box.
    Select a file that you want to upload.
12. Click the button on the page to execute the IbComposer\_saveSelectedFile function. The file is uploaded to the folder specified in the Copy file to property of the edit box.
Procedure: How to Create a Double List Box

A double list box displays values in two lists. The list on the left shows available values that are not being used, while the list on the right shows values that have been selected for use in the parameter. You can move values within lists or between lists by using the arrow buttons between them. You can select multiple values at once by holding the Ctrl key while selecting values, and then clicking the single right arrow button, or add each value one at a time.

In order to use a double list box with a parameter, the parameter must be set up to accept multiple values. Ensure that the Variable Type for the parameter value is Multiselect OR or Multiselect AND in the procedure.

1. From the HTML canvas, insert a report with parameters that accept multiple values.

   For example, create a report with Multiselect OR as the variable type for the parameter, accepting a dynamic list of values from a Master File.

2. When the New Parameters dialog box is displayed, right-click the value in the Control Type column and click Double list control, and then click OK.

   A list box is created in the layout and assigned the Unique Identifier listbox(n), where (n) is a number.

3. Save and run the HTML page.

4. Select any values selected in the available list by using the single right arrow, or select all values from the available list by using the double right arrow. Deselect values selected in the selected list by clicking the single left arrow, or deselect all values by clicking the double left arrow. When you deselect a value, it returns to the available list in the order it was originally sorted in.

   You can reorder values in the selected list by using the up and down arrows. Move the selected value up or down one spot by using the single up or single down arrow. Move the selected item to the top or bottom of the list by clicking the double up or double down arrow.

5. Click the Run button to run the report with the selected value parameters.

Procedure: How to Format Selected and Unselected Push Buttons for Radio Button and Check Box Controls

This procedure shows how you create a push button form from a radio button or check box control. It also shows how you can apply background color to push buttons to distinguish between selected and unselected values.

1. In the HTML canvas, create a radio button or check box control by clicking Radio Button or Check Box on the Controls tab of the ribbon. Populate the control with multiple values.
2. Select the control and open the Properties panel.

3. In the Properties panel, from the Type drop-down menu, select Push button.
   Two additional properties appear: Selected pushbutton background color and Unselected pushbutton background color.

4. From the Selected pushbutton background color drop-down menu, select a background color.

5. From the Unselected pushbutton background color drop-down menu, select a different background color.

6. Save and run the HTML file.
   The specified background colors appear for the selected and unselected values.

Procedure: How to Add Images to Radio Buttons With Static Content

This procedure shows you how to add images to radio buttons with Static content.

1. In an HTML canvas, create a radio button control by clicking Radio Button on the Controls tab and drawing a control box.

2. In the Settings panel, select the Add display image check box.
   a. Click the New button to populate the control box with multiple values.
      Note: The first value defaults to Selected, but you can clear this check box.
   b. Right-click in the Display column for a value to select an image to include for that value. The Open File dialog box displays.
c. Navigate to and select an image. The path to the image is added to the Display column, as shown in the following image.

![Image Settings](image.jpg)

**Note:** The text in the Display column outside the angle brackets (<> ) is displayed when the page is run. If no text is included, only the image is displayed. If the display text is moved to before the brackets, the image appears to the right of the text in the radio button control.

d. To change or remove the text in the Display column, double-click it and carefully make the desired changes.
Run the HTML page. Since the Selected check box for the Camera radio button is selected in the Settings panel, it is populated as the default when the page is run, as shown in the following image.

**Procedure:** How to Set Calendar Properties

1. Add a calendar to the HTML page by clicking the Calendar command on the Controls tab.
   Position the cursor over the HTML canvas. The pointer changes to a crosshair.

2. Drag the crosshair to create a calendar and adjust it to the size you want.
   A calendar placeholder is created in the layout and assigned the name calendar(n), where (n) is a number.

3. Optionally, change the calendar properties by adjusting the properties displayed in the Properties panel.
   The Properties panel includes the following properties for calendar controls:
   
   - **Number of months.** Allows you to determine the number of months to show simultaneously in the calendar control. Type a single integer value to display that number of months in a single row in the control, or type two integers, separated by a comma, to show months in the specified number of rows and columns. One month appears, by default.
- **Step months.** Determines how many months to skip when clicking the forward or back arrows in the calendar control. This can be useful if you are showing multiple months at once and want to save clicks when navigating the control. The default is to move one month at a time.

- **Show On.** Determines how to expand the calendar control. The default is Button clicked, which displays the calendar when you click the calendar icon. Focus hides the calendar icon and displays the calendar control when you click the calendar text box. Both allows you to display the calendar control by clicking either the text box or the icon.

- **Show week.** When you select Yes, numbers the weeks of each year in the calendar control. No is the default value.

- **Show button pane.** When you select Yes, adds a button pane to the bottom of the calendar control. The button pane contains the Today button, to select the current date in the control, and Done button, to close the control. No is the default value.

- **First day of the week.** Determines which day of the week appears first in the calendar control.

- **Calendar image.** Allows you to change the default calendar icon to an image available in your environment. The image is cropped to the size of the calendar icon.

- **Animation.** Determines the animation that is used to display the calendar control. Show is the default value.

4. **Bind an existing parameter to the calendar.**

   Binding a parameter to a calendar control creates an incoming parameter. The incoming parameter value must be in a WebFOCUS date format that specifies the complete date from the list of supported data types in Calendar Properties. The incoming parameter value will populate the calendar with date values.

   - Click the **Parameters** view tab.

   - Select the center of the parameter name object, drag the parameter to the center of the calendar object, and release the mouse to complete the binding.

   - To unbind the parameter from the calendar, select the arrow head on the line, so that the line is bold. Right-click and click **Break binding.**

5. **Bind the calendar to a parameter.**
Binding the calendar to a parameter will populate the parameter with a date value.

- Click the Parameters view tab.

The Settings panel opens, showing the calendar setup options in the Popup Calendar Settings section. The calendar setup options enable you to set the range of dates available to the user at run time. Available dates are represented as an active hyperlink (blue and underlined). Unavailable dates are static (black without underlines).

**Note:** The Settings panel for a calendar contains different options depending on the selected data type.

- Create the values for the calendar. You can create Static or Dynamic values.

When the Current/Start date option is checked, the current date will be used in the calendar control at run time.

The Date Range options for setting up the calendar include:

- **Static.** This option will set a static date range in which the developer will select a start date and an end date using a pop-up calendar icon, or by clicking the month, day, or year from the controls.

  The pop-up calendar icon appears in the From and To sections when the Static Date Range is selected. If you click the pop-up calendar icon, a pop-up calendar appears and shows the current date selected and circled in red by default. As you scroll through the calendar with the left/right arrows, the currently selected day will remain highlighted for each month. Clicking a date will add that date to the control. Dates can be selected by scrolling left to right, entering the month, day, and year as text, or by selecting the month, day, and year from the drop-down list and spin boxes.

- **Relative.** This option allows you to set a specific number of days, months, and years relative to the current date. The current date (at run time) will always be the reference or starting point and the calendar will show a number of days, months, and years relative to the current date. The range could be all in the past (for example, five years prior to the current date) or all in the future (for example, five years in the future). This is selected as the default Date Range.

- **Dynamic.** This option allows you to point to a request that returns a range of dates. Clicking the Select custom request drop-down list box allows you to choose a preexisting request. The request must return two date values on the same data line in XML format. The date values must be returned in a format that returns two digits for the month and day, and four digits for the year, for example, MM/DD/YYYY.
Limit by data. This option limits the available dates to those that appear in the data source for the control. For example, if you set the Data Type in the Settings panel to Dynamic and select a data source and date field for the control, then only the dates listed in that field will be available for selection.

Select the center of the calendar, drag the calendar to the center of the parameter object, and release the mouse to complete the binding.

Working With a Slider Control

You can use a slider control to select numeric values. A slider allows you to select a single number value from a range of available values. You can click a point in the slider to select it, or use the arrow buttons at either end of the slider to move the slider one increment at a time. If you create a slider for a static parameter, you can use the Settings panel to specify the minimum and maximum value and the increment between values on the slider. If you create a slider for a dynamic parameter, all values from the selected data source and field are available on the slider.

You can also create a double-head slider. A double-head slider control is a type of slider control in which you can select a range of values for displaying data in a report or chart. Rather than having one slider head, you have two. In order to use a double-head slider control, you must have two variables in the report or chart that will be controlled by the double-head slider control. One variable will be controlled by one head of the double-head slider control and the other variable will be controlled by the other head of the double-head slider control. The variables need to be specified in the procedure as FROM and TO.

Note: You can use the Report canvas to create a parameter that accepts a range of values using the Expression Builder dialog box. The Chart canvas requires you to manually create a parameter that accepts a range of values.

Procedure: How to Create an HTML Page That Uses a Slider Control

1. Create a new HTML page.
2. Add a report object to the HTML canvas.
3. Create, import, or reference a report that contains a variable that accepts a numeric value. The New Parameters dialog box opens.
4. In the Control Type column of the New Parameters dialog box, right-click the first parameter, point to Slider, and then select either Horizontal or Vertical.
5. Click OK to close the New Parameters dialog box and add the slider control to the HTML page.
If you click the Parameters view tab at the bottom of the HTML canvas, you will see that the slider control is chained to the parameter in the report, and if you select the slider control and open the Settings panel, you will see that it uses a dynamic list of values to supply a selected value to the parameter in the report.

6. Optionally, select the slider control and open the Properties panel. The following properties are specific to slider controls:

   - **Show Input.** Select Yes, which is the default, to include an edit box with the slider, displaying the selected value and allowing you to change the slider selection by typing a value into it. Select No to hide the edit box and not display the value selected on the slider. Select Read only to hide the edit box and display the selected value above the slider.

   - **Show/Hide Arrows.** Select Yes, which is the default, to include arrow buttons that allow you to move the slider one increment at a time, or select No to hide the arrow buttons. You can click a point along the slider to move the slider head there.

   - **Range.** Select No for a single-head slider control, or select Yes to create a double-head slider control. For more information about creating an HTML page with a double-head slider, see How to Create an HTML Page That Uses a Double-head Slider Control on page 530.

7. Save and run your HTML page.

   The slider control controls what you see in your report or chart by allowing you to select a value.

**Procedure:** How to Create a Report That Can Be Used With a Double-head Slider Control

1. Create a new report.

2. Add the fields you want displayed in your report.

3. On the Report tab, in the Filter group, select Filter, and then click Where to create a Where filter.

   The Expression Builder dialog box opens.

4. Double-click the field you want to use in conjunction with the Double-head slider control.

5. From the Logical Relation drop-down list, select Is From.

   This indicates that the parameter that you are creating is a range of values.

6. Double-click the Compare Value cell to open the Range Builder dialog box.

   In the Range Builder dialog box, you can name the parameters you will use for the Double-head slider control or select a field whose values you want to create a range from.
7. Type an amper variable name in the From text box. For example, &Value1.
   This is the FROM value.

8. Type an amper variable name in the To text box. For example, &Value2.
   This is the TO value.

   These are the names of the two parameters that will be controlled by the double-head slider control.

9. Save and close the report.
   This report can now be used with a double-head slider control once you set up your HTML page.

**Procedure:** How to Create a Double-head Slider Control From the Ribbon

1. While in the HTML canvas, click either Horizontal or Vertical, from the Slider command, in the Controls group, on the Controls tab.
   The pointer changes to a crosshair.

2. Drag the crosshair to create a single-head slider control.

3. While the single-head slider control is selected, in the Properties panel, change the Range property from No to Yes.
   Changing the Range property to Yes changes the single-head slider control to a double-head slider control. You can now use this control to select a range of values to display.

**Procedure:** How to Create a Double-head Slider Control Using the New Parameters Dialog Box

1. Create a report object or chart object on the HTML canvas.
   The pointer changes to a crosshair.

2. Drag the crosshair to create a report or chart

3. Create, import, or reference a report or chart with two variables used in a FROM... TO... relationship.
   The New Parameters dialog box opens.

4. In the Control Type column of the New Parameters dialog box, right-click the first parameter and then click Slider, and select either Double-head Horizontal or Double-head Vertical.

   Note that the Control Type for the second parameter changes to Append to Above. This means that the second parameter has been recognized as being part of a range and will be controlled by the double-head slider control specified in the first parameter.
Procedure: How to Create an HTML Page That Uses a Double-head Slider Control

1. Create a new HTML page.
2. Add a report object to the HTML canvas.
3. Create, import, or reference a report that contains a variable that accepts a range of values.
   The New Parameters dialog box opens.
4. In the Control Type column of the New Parameters dialog box, right-click the first parameter, point to Slider, and then select either Double-head Horizontal or Double-head Vertical.
   Note that the Control Type for the second parameter changes to Append to Above. This means that the second parameter has been recognized as being part of a range and will be controlled by the double-head slider control specified in the first parameter.
5. Click OK to close the New Parameters dialog box and add the double-head slider control to the HTML page.
6. Click the Parameters view tab at the bottom of the HTML canvas.
7. Drag the unbound parameter out of the Unbound Parameters box.
8. Drag the second half of the slider control to the unbound parameter.
9. Click the slider control and click the Settings panel.
10. In the Input Control Population section, change the Data type to Dynamic.
11. Select the data source you used in the Data Source drop-down list.
12. In the Value Field, click the ellipsis (...) and select the field being controlled by the double-head slider control.
13. Save and run your HTML page.

   The double-head slider control controls what you see in your report or chart by allowing you to select a range of values rather than one specific value or all values. The first head updates the FROM value and the second head updates the TO value.

Using Multi-Select Lists

Two types of multi-select lists can be used in a report: a regular list box or a drop-down list. When using either type of multi-select input control to supply parameter values, the Multiple property value indicates whether multiple values can be selected from a list of supplied values at run time.
**Procedure:** How to Create a List Box with Multiple Values

A multi-select list box enables you to select multiple values by using the Ctrl key while selecting values. In order to select multiple values in the list box, the procedure must be set up to accept multiple values. Ensure that the Variable Type for the parameter value is Multiselect OR or Multiselect AND in the procedure.

1. From the HTML canvas, insert a report with parameters that accept multiple values.
   
   For example, create a report with *Multiselect OR* as the variable type for the parameter, accepting a dynamic list of values from a Master File.

2. When the New Parameters dialog box is displayed, accept the default control type of *List box* and click *OK*.
   
   A list box is created in the layout and assigned the name listbox\(n\), where \(n\) is a number.

3. Select *Multiple* from the Multiple drop-down list in the Properties panel.
   
   This indicates that multiple items can be selected from the list box.

4. Save and run the HTML page.

5. Select multiple values by using the Ctrl key while selecting values from the list box.

6. Click the *Run* button to run the report with the selected value parameters.

**Procedure:** How to Create a Drop-Down Check Box List with Multiple Values

A multiselect drop-down list enables you to select multiple values using the check boxes adjacent to the values. In order to select multiple values in the drop-down list, the procedure must be set up to accept multiple values. Ensure that the Variable Type for the parameter value is Multiselect OR or Multiselect AND in the procedure.

1. From the HTML canvas, insert a report with parameters that accept multiple values.
   
   For example, create a report with *Multiselect OR* as the variable type for the parameter, accepting a dynamic list of values from a Master File.

2. When the New Parameters dialog box appears, accept the default control type of *List box* and click *OK*.
   
   A list box is created in the layout and assigned the name listbox\(n\), where \(n\) is a number.

3. Right-click the control, select *Set Control Type*, and select *Drop down list* to change the control type.
   
   **Note:** In the Properties panel, the Multiple property for the control is automatically set to *Multiple*.

4. Save and run the HTML page.
5. Select multiple values using the check boxes displayed when you click the down arrow.
6. Click outside of the control to close the drop-down list.
7. Click the Run button to run the report with the selected value parameters.

**Saving Control Selections in a Browser Session**

You can link the controls on HTML pages so that they automatically default to the same selected value when you switch between multiple pages in the same browser session. To do this, you need to assign a common value to the *Global name* property for each control that you want to link.

For example, you may have two HTML pages that contain controls with information that relates to regional sales. You can assign a value to the *Global name* property, such as *Region*, to each of the controls that you want to link. When you run those pages in the same browser session, and choose a value from one of the linked controls, such as *Southeast*, the controls on the other pages will refresh and display the information for the Southeast, by default.

**Note:** A selected value is retained as the default only during a single browser session. The value is not retained after you close the browser.

**Procedure: How to Save Control Selections in a Browser Session**

This procedure describes how to assign a value to the *Global name* property, which enables you to save control selections within a browser session.

**Note:** A selected value is retained as the default only during a single browser session. The value is not retained after you close the browser.

1. Create or open an HTML page that contains a control.
2. Click the control to highlight it.
3. In the Properties panel, under Miscellaneous, type a value in the *Global name* field. This value can be any alphanumeric string, such as *GlobalRegion1*.
4. Save the HTML page.
5. Repeat steps 1-4 for any controls that you want to link. You must assign the same *Global name* property value for each control that you want to link.

**Using Tree Controls**

You can insert a single-source tree control or a multi-source tree control in an HTML page.
**Procedure**: How to Add a Tree Control to an HTML Page Using a Default Procedure

This procedure describes how to add a tree control for a multi-dimensional data source, using a default procedure.

**Note**: In prior releases, a default procedure was known as an “Embedded Procedure.”

1. In the HTML canvas, insert a tree control from the Controls tab.
   
   **Tip**: You may select Single source Tree control or Multi source Tree control. If no type is selected, Single source Tree control is the default. Single source Tree controls must be populated from a multi-dimensional data source such as SAP BW, SSAS, or Essbase.
   
   The pointer changes to a crosshair.

2. Drag the crosshair to create a tree control, and adjust it to the size you want.
   
   A tree control is created in the layout and assigned the name treecontrol(n), where (n) is a number.

3. Optionally, you may enable the Expanded property from the Properties panel to show the tree control expanded at run time.

4. Optionally, you may enable the Hyperlink property from the Properties panel to show the tree nodes as hyperlinks, instead of radio buttons at run time.

5. Optionally, you may enable the Select all children property from the Properties panel so that selecting a parent node automatically also selects all of its children, and if you select all of the children of a parent, the parent node is automatically selected.

6. From the Settings panel, click Dynamic as the Data type.

7. Keep Default selected and click the browse (...) button adjacent to the Data Source field.
   
   The Open File dialog box appears.

8. Select a multi-dimensional data source and click OK.
   
   The multi-dimensional data source is added as the default procedure.

9. Click the browse (...) button adjacent to Value from field to select a field from the hierarchy.
   
   The Value from field is the data source field from which the values will be retrieved.

10. Click the browse (...) button adjacent to Display from field to select a field from the hierarchy.

    The Display field is the text that represents the parameter value in the tree control.

11. Save and run the page to view the multi-dimensional data source in the tree control.
Procedure: How to Add a Tree Control to an HTML Page Using an Existing Procedure

You can select an existing procedure to add to the tree control in an HTML page. When you select a procedure, it should use fields from the parent/child hierarchy and be set up as follows:

```plaintext
TABLE FILE file
SUM FST.dispfield
BY ParentUniqueField
BY UniqueField
BY datafield
ON TABLE PCHOLD FORMAT XML
END
```

where:

- `file` is the name of the data source.
- `dispfield` is the field whose values display in the tree control.
- `ParentUniqueField` is the field that represents the parent for the parent/child hierarchy (PROPERTY = PARENT_OF).
- `UniqueField` is the field that represents the unique IDs for the hierarchy members (PROPERTY=UID).
- `datafield` is the field whose values are passed as the parameter value.

After the procedure is set up, follow these steps:

1. From the Controls tab, insert a tree control.

   **Tip:** You may select Single source Tree control or Multi source Tree control. If no type is selected, Single source Tree control is the default. Single source Tree controls must be populated from a multi-dimensional data source such as SAP BW, SSAS, or Essbase.

   The pointer changes to a crosshair.

2. Drag the crosshair to create a tree control, and adjust it to the size you want.

   A tree control is created in the layout and assigned the name treecontrol\((n)\), where \(n\) is a number.

3. Optionally, you may click the Expanded property from the Properties panel to show the tree control expanded at run time.
4. Optionally, you may click the *Hyperlink* property from the Properties panel to show the tree nodes as hyperlinks, instead of radio buttons at run time.

5. From the Settings panel, click *Dynamic* as the Data type.

6. Select *Explicit (Requests panel)*, select a procedure from the Request drop-down list, and then click *OK*.

   The procedure name is added as the explicit procedure.

   **Note:** In prior releases, an explicit procedure was known as an “external” procedure.

7. Click the browse (...) button adjacent to *Value from field* to select a field from the hierarchy or type the field manually.

   The Value from field is the data source field from which the values will be retrieved.

8. Click the browse (...) button adjacent to *Display from field* to select a field from the hierarchy or type the field manually.

   The Display field is the text that represents the parameter value in the tree control.

9. Save and run the page to view the multi-dimensional data source in the tree control.

**Procedure:** *How to Populate a Multi Source Tree Control*

You can show a tree structure for a non-hierarchical data source by using a tree control. By identifying the number of levels for the tree control, you are able to populate each level of the tree control with its own procedure. Setting the number of levels creates a tree structure by which each level is its own subcontrol, chained together with no conditions.

This procedure describes how to add parameters for a tree control, where the number of levels property is set.

1. In the HTML canvas, insert a Multi source tree control.

   - Click *Multi source Tree control* from the Tree control drop-down list, located on the Controls tab.

   The pointer changes to a crosshair.

2. Drag the crosshair to create a tree control, and adjust it to the size you want.

   A tree control is created in the layout and assigned the name treecontrol\((n)\), where \((n)\) is a number.

3. From the Properties panel, type in the Number of levels for the tree control, and press the Enter key.

   This enables you to specify the number of levels to populate.
4. Optionally, you may click the Expanded property from the Properties panel to show the tree control expanded at run time.

5. With the tree control selected, click the Parameters tab.
   The tree control object shows the set number of levels.

6. Select each level of the tree control and create the settings for its data population.
   When creating a Multi source Tree control, the static data type is not available. If creating static values for the tree control, you must create a single source tree control.

7. Optionally, to add an additional level for the tree control, right-click the tree control object on the Parameters tab and select Add level.
   **Note:** Add level only appears for a Multi source tree control object.

8. Click the added level to view the Settings panel for that level.

9. Switch to the Design tab of the HTML canvas to preview the populated tree control.
   Note that the Properties window drop-down list for the tree control shows each level of input values.

10. Save and run the page.
    **Note:** If a user selects a lower level node in one level and a higher level node in another level, when the procedure is executed, only the lowest level selections will take effect. For example, you have 3 levels: COUNTRY, CAR, and MODEL. Under ENGLAND, TRIUMPH you select TR7. Under FRANCE, you select PEUGEOT. At run time you will only receive the records for TR7 because you did not select a MODEL under the FRANCE node.

The tree control populates each level with values.

**Note:** A value must be selected for each level before you can click the Save Selection button.

If a selected value is specified for a field that is not in level1, then corresponding selected values must also be specified for the preceding levels.

Only the first and second levels load at run time. If a selected value is specified for a field in level1, only values from the first two levels will be selected.

**Procedure:** How to Add a Tree Control to an HTML Page Using Static Values

This procedure describes how to add static data type parameters for a tree control, where the Number of levels property for the tree control is not set. This enables you to add a static list of values.

1. In the HTML canvas, insert a tree control.
2. From the Settings panel, select Static as the Data type. Static is selected, by default. You may select an item, delete it, or add a subitem.

3. Create the parameter values for the control:

- Click the New button to add a list of values. The values are added in a sequential hierarchical structure. The last value added appears in the Value and Display Value fields.
- To edit the value, manually type the desired value in the Value and Display Value fields.
- Click Append child item from the Static values drop-down list to append a value at the level currently selected, and create a new value as the child of the selected value.
- Click Insert before from the Static values drop-down list to insert a value before the selected value. Note the number of the value.
- Click Insert after from the Static values drop-down list to insert a value after the selected value. Note the number of the value.

Repeat these steps until the list contains all of the values you want to include.

- Optionally, click the Delete button to eliminate any values.

4. Click the Selected check box to show the entry in the Value field as the default value.

5. Select the Send display value check box to send the display value, rather than the actual data, to the parameter.

6. Save and run the page to populate the tree control with static values.

**Procedure:** How to Create a New Tree Control From the New Parameters Dialog Box

When a report contains one or more new amper variable parameters, the New Parameters dialog box opens when you save the report and return to the HTML canvas. You can assign a new Single source or Multi source Tree control from the HTML page to the parameter from the New Parameters dialog box.

For each parameter, you will find Name and Control Type fields, a Create control check box, and options to set the Control Type to a Single source or Multi source Tree control.

1. Import or create a report that contains parameters.

   When importing a report with parameters, the New Parameters dialog box opens, prompting you to create the control type.

2. Right-click the value in the Control Type column and select the tree control from the New Parameters dialog box.
The Control Type column refreshes, showing the selected control.

3. Click OK to close the New Parameters dialog box.

The report is added and the associated parameters are bound to the tree control.

**Reference:** Usage Notes for Chaining Tree Controls

The following usage notes apply when chaining tree controls. You may chain controls from the New Parameters dialog box and from the Parameters tab.

- When the Multi source Tree control is a link in the chain, the New Parameters dialog box enables you to share parameters with the same multi source control.
- You can chain a Multi source Tree control to a Single source Tree control.
- You can chain a Single source Tree control to another Single source Tree control.
- You can chain a Multi source Tree control to another Multi source Tree control.
- You can chain a tree control to another non-tree control, such as Drop down list or List box.
- Chaining cannot be done with only field names.
- Dynamic population of controls with field names need to use SYSCOLUMN calls.

**Positioning Objects in an HTML Page Using the Positioning Tab**

Positioning options enable you to multi-select objects and position them relative to one another. The Positioning tab contains the Positioning, Relationships, Text Alignment, and Responsive Design groups, as shown in the following image.

![Positioning Tab Image](image-url)

**Aligning Objects in an HTML Page Using the Positioning Group**

The Positioning group contains the Left, Right, Top, Bottom, Center, Middle, Same Width, Same Height, Same Size, Toggles Grid, and Drag and Drop commands.

**Left**

- Aligns the objects to the left. This works in relationship positioning.
- Relates an object to the left of another object.
Right

Aligns the objects to the right. This works in relationship positioning.

Relates an object to the right of another object.

Top

Aligns the objects to the top of the highest selected object. This works in relationship positioning.

Bottom

Aligns the objects by the bottom of the lowest selected object. This works in relationship positioning.

Center

Aligns the objects to the center of the page. This works in relationship positioning.

Aligns objects at the horizontal center point of the object.

Middle

Aligns the objects to the middle of the page. This works in relationship positioning.

Aligns objects at the vertical center point of the object.

Same Width

Makes two or more objects the same width.

Same Height

Makes two or more objects the same height.

Same Size

Makes two or more objects the same size.

Toggles Grid

Turns the grid on and off.

Drag and Drop

Turns parent/child Drag and Drop on and off.

When this command is off (default), drag and drop is used only to reposition objects on the HTML canvas.

When this command is on, drag and drop is used to designate a parent/child relationship between two objects.
Procedure: How to Designate a Parent/Child Relationship using Drag and Drop

There are instances where you want an object in your HTML canvas to be a child to another object. For example, you may have a report (child) that you want to place within a tab container (parent).

1. Open an HTML file in which the two objects have been created.
2. Click the Positioning tab.
3. Click the Drag and Drop command to toggle it on.
   Alternatively, you can select Toggle Drag and Drop from the HTML canvas shortcut menu.
   The Drag and Drop command on the Positioning tab is now highlighted.
4. Click the designated child object and drag it toward the designated parent object.
   A small rectangle appears below your cursor, but the child object itself does not move.
5. Move your cursor to the designated parent object and drop.
   The parent/child relationship is now created.
6. To restore the default drag and drop, click the Drag and Drop command to toggle it off.
   **Note:** When the Drag and Drop command is on, you are unable to reorder tabs or page containers, when using the Tab, Accordion, or Window components.

Relating Objects in an HTML Page Using the Relationships Group

The Relationships group contains the Top Left, Top Right, Bottom Right, Bottom Left, Break, and Show commands. The Top Left, Top Right, and Bottom Right commands are only available for HTML pages and Guided Report pages.

**Top Left**
Relates two or more objects on a page. Two objects must be selected. Relates an object to the top left of another object.

**Top Right**
Relates two or more objects on a page. Two objects must be selected. Relates an object to the top right of another object.

**Bottom Right**
Relates two or more objects on a page. Two objects must be selected. Relates an object to the bottom right of another object.
**Bottom Left**

Relates two or more objects on a page. Two objects must be selected. Relates an object to the bottom left of another object.

**Note:** The above four commands have been deprecated and will be removed from a future release of App Studio.

**Break**

Breaks the relationship between the objects selected.

**Show**

Shows or hides the relationship between objects.

**Aligning Text in an HTML Page Using the Text Alignment Group**

The Text Alignment group contains the Left, Center, Right, and Full Justification commands. These commands align text within the HTML page.

**Left**

Aligns selected text to the left.

**Center**

Aligns selected text to the center.

**Right**

Aligns selected text to the right.

**Full Justification**

Fully justifies the selected text, meaning that the text fills the width of the text box.

**Enabling Responsive Design for an HTML Page Using the Responsive Design Group**

The Responsive Design group contains the Toggle Editing, Toggle Selection, and Update Layout commands. These commands are enabled when the Responsive design property is set to Yes.

**Toggle Selection**

Toggle on to allow containers that include content to be dragged to a new position. Toggle off to prevent those containers from being repositioned.

**Update Layout**

Click to refresh the HTML canvas after you reposition containers, to show how the containers will stack when folded. This command is activated when the Autosize Enable property is set to Yes for both the document and the object.
Changing HTML Page Properties Using the Utilities Tab

You can change HTML page properties using the Utilities tab. For example, suppose you want to test your HTML page in a specific browser. The default browser specification is considered a property of your HTML page. To run your page in a different browser, open the Utilities tab and select the desired browser from the Preview command group.

The Utilities tab is shown in the following image.

[Image of the Utilities tab]

Chaining Objects in an HTML Page Using the Chaining Group

You can add or remove chaining options using the Chaining group. The Chaining group is shown in the following image.

[Image of the Chaining group]

The commands are:

**Add**

Chains two or more objects that are selected in the Parameters tab.

**Remove**

Unchains two or more selected, chained objects in the Parameters tab.

Synchronizing an Analytic Document in an HTML Page Using the Analytic Documents Group

You can synchronize an Analytic Document using the Analytic Documents group. This group is available only for an HTML page and a Guided Report page. The Analytic Documents group is shown in the following image.

[Image of the Analytic Documents group]
The commands are:

**Sync**

Syncs an Analytic Document.

**Show**

Shows the synchronization of the canvas.

**Unlocking a Template for an HTML Page Using the Template Group**

You can unlock a template to add controls, text, and buttons. This group is available only for an HTML page and a Guided Report page. The Template group is shown in the following image.

![Template group image](image)

The commands are:

**Unlock**

Unlocks the template that you are using and allows for full control of the page.

**Report Set**

In template mode, this adds a title bar and a form with controls, text, and buttons as a set.

**Working With the Miscellaneous Group in the HTML Canvas**

The Miscellaneous group contains the Visibility, Tab order, Delete Container, and Refresh All commands. This group is available only for an HTML page and a Guided Report page. The Miscellaneous group is shown in the following image.

![Miscellaneous group image](image)
The commands are:

**Visibility**
Toggles the visibility of hidden objects. Hidden objects are objects that have the Visibility property, in the Properties panel, set to hidden.

For more information on using the Visibility command, see *How to Toggle the Visibility of a Hidden Object* on page 544.

**Tab order**
Shows the order of the tabs.

**Delete Container**
Deletes the selected container, without deleting the container content.

**Refresh All**
Refreshes the HTML page.

**Procedure:** *How to Toggle the Visibility of a Hidden Object*

1. Insert an object into the HTML canvas.
2. Select the object you created, if it is not already selected.
3. In the Properties panel, change the Visibility property to hidden.
   The object on the canvas is hidden from view.
4. On the Utilities tab, in the Miscellaneous group, click the Visibility command.
   The hidden object is now displayed on the canvas. You can click the Visibility command again to hide the object again. At run time, this object will be hidden.

**Previewing HTML Output Using the Preview Group**

The Preview group, as shown in the following image, allows you to preview HTML output in Internet Explorer, Chrome, Firefox, and Edge browsers to be sure that your content displays correctly.

The Preview Runtime option is available for Responsive HTML pages only. It uses your default browser to preview your HTML run time layout with simulated data. This may be faster than running the page if it contains large amounts of data.
**Note:** Alternatively, you can right-click in the HTML canvas, select *Preview*, and select a browser or *Preview Runtime*.

The browser preview options are:

**Internet Explorer**
- Preview your HTML output in Internet Explorer.

**Chrome**
- Preview your HTML output in Chrome.

**Firefox**
- Preview your HTML output in Firefox.

**Edge**
- Preview your HTML output in Edge.

**Preview Runtime**
- Available for Responsive HTML pages only. It uses your default browser to preview your HTML run time layout with simulated data.

### Displaying Panels in an HTML Page Using the View Group

The View group allows you to display or hide the panels associated with an HTML Page or Guided Report page. This group is accessible in the Utilities tab of the HTML canvas and in the Text Editor tab when accessing the Embedded JavaScript and Embedded CSS view tabs. The View group is shown in the following image.

![View Group](image)

The commands are:

**Properties**
- Toggles the visibility of the Properties panel.

**Settings**
- Toggles the visibility of the Settings panel.

** Thumbnails**
- Toggles the visibility of the Thumbnails panel.
Creating a Widget to Autoplay Control Values

You can insert a widget on an HTML page to automatically submit values in a control at specific intervals. The control can be linked to a report, chart, or map.

You can enable the autoplay setting for the widget in the Tasks & Animations panel. The widget selected may require the following configurations:

- Setting the timing for the autoplay action to indicate the amount/length of time it should take for a value to change.
- Setting the play interval for a date slider to specify the interval in terms of days, weeks, months, or years.

When the autoplay widget displays, select a control on your page from the drop-down menu in the widget. You can hide the drop-down menu by making a selection or pressing the Esc key. When you press the play button in the autoplay widget, the value in the selected control changes based on the specified time interval.

You can also create an autoplay control that is the sole input control for a parameter, unassociated with any control on the page. This is called a virtual control. You can do this in one of two ways:

- When creating a control using the New Parameters dialog box, in the Create control column drop-down menu, click Virtual.
- In the Parameters view tab, right-click a control object, point to Set Control Type, and click Virtual Control.

You must create a task to display a virtual control autoplay widget using the Tasks & Animations panel.

Procedure: How to Create a Widget to Autoplay Control Values

1. Create an XML parameter report to use for the map. For example:
2. Create a new HTML page.

3. In the Objects group, click ESRI Map to draw an Esri map component on the canvas.

4. From the Requests & Data Sources panel, select the New drop-down arrow, point to External Request, and then click WebFOCUS Procedure.

5. Right-click the report in the Requests & Data Sources panel and click Create Controls for Parameters, as shown in the following image.
6. In the New Parameters dialog box:
   a. In the Control Type column, right-click Calendar.
   b. Select New control.
   c. Select Slider.
   d. Select Horizontal.

The populated New Parameters dialog box is shown in the following image.

![New Parameters dialog box](image)

**Note:** To create a control as only an autoplay widget, without an associated control on the page, open the drop-down menu in the Create control column and click Virtual.

7. Click OK.
The horizontal slider is added to the HTML page, as shown in the following image.

8. Select the Parameters tab and drag the slider over emfobject1 (the map object) to draw a line to symbolize the chaining of objects. The arrow indicates the direction of the chaining, as shown in the following image.

9. Return to the Design tab, select the map object, and open the Settings panel.
10. On the Settings panel:

   - Select Layer1.
For the Request value, select the name of the XML report.

For the Geographic Role, select Country (Name).

For the Column(s) that match the role, select COUNTRY_NAME.

For the Layer Attributes, select REVENUE_US and GROSS_PROFIT_US.

For the Enable Popups attribute, select On.

For the Default Extent attribute, select On.

For the Use attribute, select Color.

For the Using Field attribute, select GROSS_PROFIT_US.

For the Color Scheme attribute, select red to green.
The populated Settings panel is shown in the following image.
11. Multi-select the Submit, Reset, and Schedule buttons in the form and delete them, as shown in the following image.

12. On the Tasks & Animations panel:

- Delete task 2 and task 3.
- Create a new task.
- For the Trigger Type attribute, select *Click*.
- Select the form of the control to add the Trigger Identifier.
- Select *form1*.
- For the Requests/Actions attribute, select *Show Autoplay widget*.

The populated Tasks & Animations panel is shown in the following image.
13. On the Tasks & Animations panel:

- Create a new task.
- For the Trigger Type attribute, select Selection Changed.
- Select the form of the control to add the Trigger Identifier.
- Select slider1.
- For the Requests/Actions attribute, select Execute Task and then select load.

The populated Tasks & Animations panel is shown in the following image.

14. Select the slider control in the HTML canvas.
15. On the Settings panel, select *Limit values returned* and change the value to 6, as shown in the following image.

![Settings panel](image)

16. Select the map component in the HTML canvas.
17. From the Properties panel, change Map: Basemap to *Dark Gray Canvas Map*, as shown in the following image.
18. Run the HTML page, as shown in the following image.

19. Click within the slider form.
20. Select Sale,Year: from the Autoplay Widget drop-down list, as shown in the following image.

21. Drag to reposition the widget, so that it does not cover the map or the control.

22. Click the play button.

Note: As the slider moves automatically, from year to year, the map is refreshed with the data for the corresponding year.

Using Parameters

Parameters, or "variables," are a good way to make a single HTML page valuable to a wide range of end users. For example, if you have a parameter for region, the end users can select their own region at run time. This improves performance, saves users from scrolling through data that is not pertinent, and saves you from having to build multiple pages.

Parameter values and input controls can be created with a dynamic or static list of values:

- A dynamic list retrieves values from a specified data source when the request is run. These values are always current to your data source.

- A static list consists of a list of values you supply. These values do not change unless you change them.
An Analytic Document control lists Analytic Document values that mimic In-Document Analytic menu items.

**Note:** The Analytic Document controls cannot be associated to any parameters in the layout. This type of control can only be associated with an Analytic Document in the layout.

The TOC control list gives you the ability to integrate a report with a Table of Contents and OnDemand Paging in the HTML canvas.

**Note:** TOC controls cannot be associated to any parameters in the layout. This type of control can only be associated with certain input controls in the layout.

### Working With the Parameters Tab

The Parameters tab enables you to create and modify parameter values, input controls, and customize parameter conditions. You can also bind parameters to controls and chain controls to one another. The Parameters tab consists of the following components:

- **Input control objects.**
  You may select the input control object to view and edit the settings of the control.

- **Creating an input control from the Design view prompts you to create a bound parameter on the Parameters tab.**

- **Editing an input control, which is inserted when setting input controls for new parameters.**

- **Autoplay controls without associated input controls on the page, also known as virtual controls, can only be accessed at design time from the Parameters tab. They are represented by a dashed hexagon.**

- **Add new parameters.**
  Right-click anywhere on the Parameters tab to add a new parameter.

**Note:** Manually adding a parameter creates an unbound parameter.

- **Rearrange the order of objects.**
  When you move a parameter on the Parameters tab, a property value is automatically set. On the Properties panel, under Document properties, the *Parameters tab: auto arrange* property is automatically set to *No* when you move a parameter. This means the parameter will remain where you moved it after you navigate away, then navigate back to the Parameters tab.
You can rearrange the order of parameters and controls on the Parameters tab, which will automatically set the Parameters tab: auto arrange property value to No. This means that if you navigate away from the Parameters tab, and then return to it, the objects remain in the position you placed them. Additionally this means that the Auto Arrange Objects option, which is selected in the HTML tab of the App Studio Options dialog box by default, will be overridden.

You can change the Parameters tab: auto arrange property value to Yes, to undo any moves that you made previously, and to ensure that the objects on this tab use the auto arrange functionality.

To inherit the Auto Arrange Objects option value, you can set the Parameters tab: auto arrange property value to <Not Set>.

The Parameters tab: auto arrange property is available in the Properties panel. To access this property, you must select DOCUMENT, from the list at the top of the panel.

When you select an object on the Parameters tab, the properties for that object will automatically display on the Properties panel. When you select a parameters object from the Properties panel drop-down, the object is automatically selected in the Parameters tab.

- Refresh unresolved parameters.

All parameters on the Parameters tab are parsed every two minutes to check if any are unresolved. If there are, their surrounding polygon is colored red. If you want to check for unresolved parameters on demand, right-click and select Refresh unresolved.

- Binding controls and parameters.

Input controls and parameters can be bound and unbound from the Parameters tab. You may bind a parameter to an input control, or bind an input control to a parameter.

- Binding a parameter to a control makes it an incoming parameter that will populate the control. Drag a parameter object to a control object on the Parameters tab.

- Binding a control to a parameter will populate the parameter. Drag a control object to a parameter object on the Parameters tab.

- Chain one control to another.

Chaining will populate controls based on the selected value from the prior control in the chain. You can chain static and dynamic controls, link or unlink parts of a chain, and create conditions on links in a chain. Chains are represented by lines connecting control objects on the Parameters tab. By clicking the arrow head in a link of a chain, the Settings panel enables you to modify and set properties and conditions of the chain.
Note: Chaining is applicable only for controls, not parameters.

Adding a New Unbound Parameter

An unbound parameter is useful when passing a parameter value used on another page. You may also bind the new parameter to a control to create an incoming parameter, or bind a control to the parameter.

Procedure: How to Add a New Unbound Parameter

The following steps describe how to add a new parameter:

1. Right-click anywhere on the Parameters tab and select *Add parameter*.
   - Enter the parameter value information. Options are *Single select*, *Multiselect OR*, and *Multiselect AND*.

2. If using single value, select *Single select*.
   - Note: Single select is the default option when adding a new parameter.
   - a. Enter the Selected Value to be assigned to a single variable.
   - b. Enter the name for the parameter in the Name field, or keep the default name.
   - c. Optionally, you may use the Format field to define the format of the parameter, such as A20, or D12.2.
      - If this field is left blank, it automatically applies the Alphanumeric format to the value field.

3. If using a multiselect value, select *Multiselect OR* or *Multiselect AND*.
   - The Value, Display, and Selected columns appear.
   - a. Click the *New* button to enter a list of static values.
   - b. In the Value column, enter the value to be passed to the selected parameter.
   - c. In the Display column, enter the text that represents the parameter value in the control the user views.
   - d. In the Selected column, check the box for the value you want to be selected by default. More than one value can be selected.
      - Repeat these steps until the list contains all of the values you want to include.

4. Optionally, you may select values and click the *Delete* button to eliminate any values, and use the up and down arrows to rearrange the order of the values.

5. To modify the parameter value, right-click the parameter on the Parameters tab and select *Settings* to make your edits.
**Tip:** You may also use the Undo and Redo buttons located on the Standard toolbar. Note that undo/redo treats the entire Settings panel as one action.

6. Optionally, bind a control to a parameter to populate the parameter. Select the center of the parameter name object and drag the parameter to the center of the control object.

7. Optionally, bind the new parameter to a control to create an incoming parameter. Select the center of the control object and drag the control to the center of the parameter object.

---

**Procedure:** How to Link an Unbound Parameter to a Procedure

The following steps describe how to link an unbound parameter to a procedure. As an example, a heading is added to a report in the steps below.

1. Create a new HTML page.

2. From the Requests & Data Sources panel, click the New drop-down arrow and select *External Request - WebFOCUS Procedure*.

3. Select any simple or parameterized procedure.

   **Note:** In this example, we are using a report.

4. Insert a frame in the canvas.

5. In the Tasks & Animations panel, select the load task.

6. Click the arrow in the Requests/Animations section, select *Run Request* and select your procedure.

7. Select the Target type as *Frame*.

8. Select the frame from the Target/Template Name drop-down list.

9. In the Requests & Data Sources panel, right-click *Parameters Created in Current Page* and select *New Parameter*.

   **Note:** You can also create a new unbound parameter as described in *How to Add a New Unbound Parameter*.

10. Navigate to the Parameters tab and drag *Parameter1* outside the Unbound Parameters box.

11. Select *Parameter1* and in the Settings panel, enter A20 in the Format field.
12. Select the check box in the Apply To field next to the procedure you want to link, as shown in the following image.

13. Enter an alphanumeric value in the Selected Value field.

14. Open the procedure.

15. From the Report group on the Report tab, use the Header & Footer option to add a Report Header.

16. Enter &Parameter1 in the Report Heading text box.

17. Run the HTML page.

   Notice that the value entered in the Settings panel for Parameter1 is displayed in the report heading.

**Creating a Static List of Values**

When creating a list of static values, you can select from the following options:

- Add ignore value
- Add everything value
- Add ‘No Selection’ value
- Use values from procedure
- Use values from external file
- Use values from Library
- Use values from Library (include versions)

When the options are added to the Value list, the display text can be customized, but the value cannot be changed.

You may create an unbound static parameter, an incoming static parameter (a parameter that is bound to a control), or a control that is bound to a static parameter.

**Reference:** Settings Panel (Incoming Static Parameter and Unbound Control)

The Settings panel appears when creating or editing a static value on the Parameters tab.

The options available depend on the type of static value.

The Settings panel contains the following fields and options when Static is selected as the Data type.

**Data type**

- Determines whether values are obtained from a static or dynamic list, an Analytic Document, or table of contents.

  **Static.** Uses a static list of values you supply. A list of static values can also be created in the Report canvas.

**Static values**

- Is a list of supplied values for a static list.

  **Value.** The value to be passed to the selected parameter.

  **Display.** The text that represents the value in the control the user views. Press the Ctrl + Shift keys to add a value to the Display field.

  **Selected.** The value to act as the default value. If the control is multiselect, more than one value can be selected.

  **New.** Creates a new value.

  **Delete.** Deletes a supplied value from the list.
Move Up. Moves the selected value up in the list.

Move Down. Moves the selected value down in the list.

Send display value

Select this option to send the display value, rather than the actual data, to the parameter.

Values are procedures names

Select this option to have a control populated with procedure names, so that when a value is selected, that procedure executes. The Value column is the procedure name itself and cannot be edited. The Display column is editable.

Reference: Settings Panel (Unbound Parameter)

The Settings panel appears when creating or editing a static value on the Parameters tab.

The options available depend on the type of static value.

The Settings panel contains the following fields and options when adding an unbound parameter with Single select. Single select is the default option when adding a new parameter.

Name

The default name assigned to the parameter. Optionally, you may enter a new name for the parameter.

Format

The Format field defines the format of the parameter, such as A20, or D12.2.

This field is optional. If this field is left blank, it automatically applies the Alphanumeric format to the value field.

Selected Value

Enter the selected value to be assigned to the parameter.

Static values

Is a list of supplied values for a static list.

Value. The value to be passed to the selected parameter.

Display. The text that represents the value in the control the user views. Press the Ctrl + Shift keys to add a value to the Display field.

Selected. The value to act as the default value. If the control is multiselect, more than one value can be selected.

New. Creates a new value.
Delete. Deletes a supplied value from the list.

Move Up. Moves the selected value up in the list.

Move Down. Moves the selected value down in the list.

**Reference:** Settings Panel (Bound Parameter)

The Settings panel appears when selecting a bound parameter on the Parameters tab. The Settings panel for a parameter is read-only, and displays the values for the bound control.

The Settings panel contains the following read-only values:

**Value**

Shows the selected value for the static parameter data.

**Display**

Shows the static parameter display value.

**Procedure:** How to Add a New Static Value

The steps below describe how to manually add a new static value:

You may create an unbound static parameter, an incoming static parameter (a parameter that is bound to a control), or a control that is bound to a static parameter.

1. Create a new parameter.
   a. Right-click anywhere on the Parameters tab and select Add parameter.
   b. Enter the parameter value information in the Settings panel. Options are Single select, Multiselect OR, and Multiselect AND.
   c. If using single value, select Single select.
      Single select is the default option when adding a new parameter.
      - Enter the Selected Value to be assigned to a single variable.
      - Enter the name for the parameter in the Name field, or keep the default name.
      - Optionally, you may use the Format field to define the format of the parameter, such as A20, or D12.2.
      If this field is left blank, it automatically applies the Alphanumeric format to the value field.
   d. If using a multiselect value, select Multiselect OR or Multiselect AND.
The Value, Display, and Selected columns appear.

- Click the New button to enter a list of static values.
- In the Value column, enter the value to be passed to the selected parameter.
- In the Display column, enter the text that represents the parameter value in the control the user views.
- In the Selected column, check the box for the value you want to be selected by default. More than one value can be selected.

Repeat these steps until the list contains all of the values you want to include.

- Optionally, you may select values and click the Delete button to eliminate any values, and use the up and down arrows to rearrange the order of the values.

An unbound static parameter is useful when passing a parameter value used on another page. You may also bind the new parameter to a control to create an incoming parameter, or bind a control to the parameter.

2. Bind the new parameter to a control.

Binding a new parameter to a control creates an incoming parameter. An incoming parameter is a static parameter that is bound to a control. The parameter value will populate the control.

- Select the Design tab and create an input control. For example, insert a list box or a drop-down list.
- Click the Parameters tab.
  
The Settings panel appears for the control.
- Select the center of the parameter name object and drag the parameter to the center of the control object.
- To unbind the parameter, select the arrow head on the line, so that the line is bold, right-click, and select Break binding.

3. Create a control that is bound to a parameter.

Create a control with static values and bind the control to a parameter to populate the parameter with the control values.

- From the Design view of the HTML canvas, select a control.
  
The pointer changes into a crosshair.
- Drag the crosshair to create the control and adjust it to the size you want.
c. Click the Parameters tab.
   The Settings panel appears for the control.

d. Select Static as the Data type.
   Static is selected, by default.

e. Create the parameter values for the control:
   - In the Value column, enter the value to be passed to the control.
   - In the Display column, enter the text that represents the static parameter value in the control the user views.
   - In the Selected column, check the box for the value you want to be selected by default. More than one value can be selected.

   Repeat these steps until the list contains all of the values you want to include.

   Optionally, you may select values and click the Delete button to eliminate any values, and use the up and down arrows to rearrange the order of the values.

f. Bind the new control to a parameter: Select the center of the control object and drag the control to the center of the parameter object.

g. To unbind the control, select the arrow head on the line, so that the line is bold, right-click and select Break binding.

h. To change the default type of control, right-click the control object on the Parameters tab or the Design tab and select Set Control Type.
   The options are Calendar, Check box, Drop down list, Hidden, List box, Radio button, Text Area, Edit box, Single source Tree control, and Multi source Tree control.

4. To modify the static value, right-click the control, or parameter, on the Parameters tab and select Settings to make your edits.

Reference: Adding Static Field Values From the Report Canvas

Instead of adding new static values, you may also import static value parameters that you created from the Variable Editor dialog box. Parameter values can be data values to limit your data or field names to select the fields in your report. Both types of static lists can be created in the Report canvas. This example details how to supply field values to a report through the HTML canvas and the Report canvas.

For the purposes of this example, use the CAR Master File (car.mas) that is supplied with App Studio.

1. From the HTML canvas, insert a new report.
The pointer changes into a crosshair.

2. Drag the crosshair to create a report object and adjust it to the size you want.

3. Double-click the report object.

   The Open File dialog box appears.

4. Select the `car.mas` Master File and click OK.

   The Report canvas opens.


   The Variable Editor dialog box opens.

   - Enter `SORTVAR` in the Name and Prompt input fields, and keep the Variable Type as Single Select.

   - Click Static list from the Accept List section.

   - Double-click `COUNTRY` and `BODYTYPE` from the Fields from database Data Context area.

   - The fields are added to the Static Accept List.

   - Click OK to save the variable.

6. Create a second variable.


   - The Variable Editor dialog box.

   - Enter `MEASURES` in the Name and Prompt input fields.

   - Click Multiselect AND from the Variable Type drop-down list.

   - Click Static list from the Accept List section.

   - Double-click `CAR, DEALER_COST, RETAIL_COST, and SALES` from the Fields from database Data Context area.

   - The fields are added to the Static Accept List.

   - Click OK to save the variable.


   The variables are added to the report.

8. Click `&SORTVAR` and select Sort Down from the Column Type group on the ribbon.
Note: If the parameter is to be used as a By field in a report, it must be the single-select variable type.

9. Save and close the report.

You are returned to the HTML canvas and since you are adding a report with parameters, the New Parameters dialog box appears.

10. From the New Parameters dialog box:

   - Select *Double list control* from the Control Type list for MEASURES.
   - Select *Do not create a form* from the Parameter grouping options drop-down list.
   - Click *OK* to close the New Parameters dialog box.

   The report and associated parameters are added as static field values. You may rearrange or lengthen the controls in the layout.

11. Save and run the layout.

   Select the static field values (By field and the associated measures) and run the report.

Procedure: How to Add an Ignore Value

The add ignore value option sends _FOC_NULL to the server at run time and is intended for use with complex applications. The add ignore value option is available for Multiselect OR and Multiselect AND static parameters.

1. From the HTML canvas, use controls to supply parameter values for a report.

   A report with parameters requires that you to select values (at run time) in order to generate the output.

2. Click the *Parameters* tab.

   The parameters associated with each control can be controlled with the Parameters tab. The properties of a control can be controlled with the Properties tab.

3. Select a multiselect control object from the Parameters tab.

   The Settings panel opens.

4. Select *Add ignore value* from the Static values drop-down list.

5. Optionally, select *Send display value* to send the display value, rather than the actual data, for the parameter values in the report.

6. Close the Settings panel.

7. Run the HTML page and select the *Ignore All* value to ignore the parameter values.
**Note:** Sending _FOC_NULL to a procedure will result in any clause of that procedure that uses that variable to be ignored.

**Procedure:** How to Add an Everything Value

The add everything value option uses JavaScript to send every value present in the parameter list to the server at run time. The add everything value option is available for Multiselect OR and Multiselect AND static parameters.

The add everything value option is not available for a Double List Control.

1. From the HTML canvas, use controls to supply parameter values for a report.
2. Click the Parameters tab.
3. Select a multiselect control object from the Parameters tab.
   The Settings panel opens.
4. Select *Add everything value* from the Static values drop-down list.
5. Optionally, select *Send display value* to send the display value, rather than the actual data, for the parameter values in the report.
6. Run the HTML page and click the *Select All* parameter value to view all the parameter values.

**Procedure:** How to Use Values From a Procedure

This is the default option which populates the static list with field names predefined in the procedure. The use values from procedure option is available for Multiselect OR and Multiselect AND static parameters, and when adding static field values from the Report canvas.

1. From the HTML canvas, use controls to supply parameter values for a report.
2. Click the Parameters tab.
3. Select a multiselect control object from the Parameters tab.
   The Settings panel opens.
4. Select *Use values from procedure* from the Static values drop-down list.
   The field names from the procedure appear in the Settings panel.
5. Optionally, select *Send display value* to send the display value, rather than the actual data, for the parameter values in the report.
6. Run the HTML page and select the parameter values from the procedure.
Procedure: How to Import Values From an External File

This option enables you to use a local external file to provide values for the parameter. The import values from an external file option is available for Multiselect OR and Multiselect AND static parameters.

1. From the HTML canvas, use controls to supply parameter values for a report.
2. Click the Parameters tab.
3. Select a multiselect control object from the Parameters tab.
   The Settings panel opens.
4. Select Use values from external file from the Static values drop-down list.
   The Open File dialog box appears.
5. Select a text file from your local machine and click Open.
   The external file can be a file with single values on each line, or two values per line, comma-delimited.
   For example, in the following text file, BOS is the data value and Boston is the display value.
   The imported values are loaded into the Static values area of the Parameters tab.
   If there is only one value on the line in the text file, the value will populate both the data value and the display values.
6. Run the HTML page to see the imported values for the selected parameter.

Creating a Dynamic List of Values

Dynamic values are available by default if a parameter used in the procedure is associated with the selected control. A dynamic list retrieves values from a specified data source when the request is run.

Reference: Settings Panel (Dynamic Values)

The Settings panel appears when creating or editing a dynamic parameter on the Parameters tab.

The Settings panel contains the following fields and options when Dynamic is selected as the Data type:

Data type

Determines whether values are obtained from a static or dynamic list, an Analytic Document, or table of contents.
Dynamic uses a list of values retrieved from a selected data source when the request is executed. This is the default if you use an Accept clause in a Master File to create an amper variable parameter within a procedure.

**Default**

Is the data source from which the values will be retrieved. This is the default value when Dynamic is selected as the Data Type.

**Explicit (Requests panel)**

Is the existing procedure that will be called.

You may modify the explicit procedure directly from the Settings panel on the Parameters tab. If you modify the request, you can save the explicit procedure and overwrite the original request.

**Data Source**

Is the data source from which the values will be retrieved.

**Value from field**

Is the data source field from which the values will be retrieved.

**Display from field**

Is the text that represents the parameter value in the control the user views.

There should be a relationship between the Value from field and the Display from field. The Display from field is user-friendly text corresponding to the Value from field.

**Source Code for the procedure**

- When the Value from field is selected for the default procedure, the corresponding source code appears.

  **Tip:** You may manually edit the source code if you are familiar with WebFOCUS syntax. For example, you may right-click and choose Select a field from the data source to add to the request. You can also right-click and choose Use the default request.

  The source code for a default procedure includes the line // TODO: Add your filters here to replace defaults, as a placeholder for you to enter filters, or WHERE clauses, for the request to resolve at run time. If entering filters, only dynamic filters can be specified.

  The //TODO line must remain in the source code in order to resolve filters at run time. One such example of this is when filters are based on chains that have conditions. If you want your own filters specified, then delete this line.

- When an explicit procedure is selected, the corresponding source code appears.
**Tip:** You may manually edit the source code if you are familiar with WebFOCUS syntax. For example, you may right-click and choose Select a field from the data source to add to the request. After editing the procedure that is associated with a control, right-click and choose Reload explicit procedure to reload and display the new syntax in the Settings panel. You can also right-click and choose Save explicit procedure. Saving the explicit procedure overwrites the original requests.

**Sort**

Clicking Sort enables you to set the sort order for displaying values in dynamic list controls. This option is useful when you want to sort each control independently of the others.

By default, the request retrieves dynamic display values from the BY sort field in the request. The results display values based on the value field.

**Sort by**

When Sort is enabled, you may sort the display value by the Value field or the Display field selected from the Settings panel. The default is Value field.

**Sort order**

When Sort is enabled, you may select the sort order as Ascending or Descending. The default sort order is Ascending.

**Values are procedures/html files**

Indicates that the values in the control are procedures or HTML pages. You can create a task using the Run Procedures/HTML From Control request option in the Tasks & Animations panel to run the file selected in the control.

**Check for duplicate values**

When creating a dynamic list of values for a report, you may remove duplicate values from input controls.

**Add "All" Option**

Adds the option to select all data source values to the control. Alternate text can be substituted for All using the text field to the right.

**Note:** If the dynamic list contains only one value, the All option does not display in the control.

**Add ‘No selection’ option**

Optimizes performance by populating a chain one control at a time, instead of all the controls when the page initially loads. Selecting the Add ‘No selection’ option enables you to populate controls when necessary.
**Cache run time data**

When adding dynamic parameters to the HTML page, input controls retrieve data through procedures. Select this option to cache the run-time data for the selected input control. This setting is off by default.

This setting overrides the Default caching option from the HTML Page tab, which is located in the App Studio Options dialog box.

**Limit values returned**

Indicates that a specific number of field values will be retrieved from the data source. The specific number of fields is selected with the menu to the right.

**Use last modified filter only**

**Send display value**

Select this option to send the display value, rather than the actual data, to the parameter.

**Selected Value**

Enter the value to be selected as the default value whenever the procedure is run.

**Reference:** Settings Panel (Bound Parameter)

The Settings panel appears when selecting a bound parameter on the Parameters tab. The Settings panel for a parameter is read-only and displays the values for the bound control.

The Settings panel contains the following read-only values:

**Data Source**

Shows the selected Master File for the parameter data source.

**Value from**

Shows the value field for the dynamic parameter data.

**Display from**

Shows the dynamic parameter display field.

**Multiselect**

Shows OR or AND, if there is a Multiselect OR or Multiselect AND dynamic parameter.

**Selected Value**

Shows the selected value, if there is one assigned to the variable.

**Procedure:** How to Create a Dynamic Value

The steps below describe how to create a dynamic list of values.
You may need to create a dynamic control that is bound to a parameter. Creating a control with dynamic values and binding the control to a parameter will populate the parameter with the control values.

1. From the Design view of the HTML canvas, select a control from the Controls submenu of the Insert menu. For example, insert a list box or drop-down list.
   The pointer changes into a crosshair.

2. Drag the crosshair to create the control and adjust it to the size you want.

3. Click the Parameters tab.
   The Settings panel opens.

4. Select Dynamic as the Data type.
   The dynamic value options appear.

5. Create the dynamic values for the control.
   a. If you are using a default procedure to supply dynamic values, follow the steps below.
      
      - Click the browse (...) button adjacent to the Data Source drop-down list.
        The Open File dialog box appears.
      
      - Select the Master File name and click OK.
      
      - Click the browse (...) button adjacent to the Value from field.
        The Object Inspector opens with the field names from the selected Master File.
      
      - Double-click a field name to add it to the Value from field.

      **Tip:** You may also use the Object Inspector icons to select a field and close the Object Inspector. The green icon is OK, the red icon is Cancel, double-clicking a value will select the value and close the dialog box without using any button, and pressing the Esc key will cancel the dialog box without using any button.

      The selected field is automatically added to the Display field and the source code for the procedure appears.

      - Optionally, you may click the browse (...) button adjacent to the Display from field to select a different field name for the Display field. (You may also use the Object Inspector icons to select a field and close the Object Inspector).

      - You may manually edit the source code if you are familiar with WebFOCUS syntax. Right-click and choose Select a field from the data source to add to the request. For example, add an additional BY sort field to the request.
To remove any syntax that you added, right-click and select *Use the default request*.

The source code for a default procedure includes the line `// TODO: Add your filters here to replace defaults`, as a placeholder for you to enter filters, or WHERE clauses, for the request to resolve at run time. If you are entering filters, only dynamic filters can be specified. For example, enter a filter for the CITY in the request.

The `//TODO` line must remain in the source code in order to resolve filters at run time. One example of this is when filters are based on chains that have conditions. If you want your own filters specified, then delete this line.

b. If you are using an explicit procedure to supply dynamic values, follow the steps below.

- Select *Explicit (Requests Panel)*.
- Select a procedure from the *Requests* drop-down list.
  
The parameter names from the procedure are automatically added to the *Value from* field and *Display from* field, and the source code for the explicit procedure appears.

- Optionally, you may click the *browse (…)* button adjacent to the *Value from* field and *Display from* field to select different field names.

  **Tip:** You may also use the Object Inspector icons to select a field and close the Object Inspector. The green icon is OK, the red icon is Cancel, double-clicking a value will select the value and close the dialog box without using any button, and pressing the Esc key will cancel the dialog box without using any button.

  Only the parameter names from the explicit procedure will be available for selection.

- You may manually edit the source code if you are familiar with WebFOCUS syntax. Additionally, you may right-click and choose *Select a field* from the data source to add to the request.

- If you modify the request that is associated with a control, you can right-click and choose *Reload explicit procedure* to reload and display the new syntax in the Settings panel. Or right-click and choose to *Save explicit procedure*. Saving the explicit procedure overwrites the original requests.
6. Optionally, select Add "All" option to add the ability to select all data source values to the control.

7. Optionally, select Add 'No selection' option to optimize performance by populating a chain one control at a time instead of all the controls when the page initially loads.

8. Optionally, select Cache run time data to cache the run time data for the selected input control.

9. Optionally, select Limit values returned, and select or type the number of field values you want to retrieve from the data source in the box to the right of this option.

10. Optionally, click the Sort option to enable and select the sort order options for displaying values in dynamic list control.

11. Optionally, select Check for duplicate values to remove any duplicate value entries from the input control at run time.

12. Bind the new control to a parameter. Select the center of the control object and drag the control to the center of the parameter object.

13. To unbind the control, select the arrow head on the line, so that the line is bold, right-click and select Break binding.

14. To change the default type of control, right-click the control object on the Parameters tab or the Design tab and select Set Control Type.

   The options are Calendar, Check box, Drop down list, Hidden, List box, Radio button, Text Area, Edit box, Single source Tree control, and Multi source Tree control.

15. To modify the dynamic value, right-click the control and select Settings to make your edits.

Procedure: How to Create Dynamic Parameters by Adding a Filter

You may create new dynamic parameters by adding a filter to a report or graph component in the layout.

1. To create dynamic parameters for your report or graph in the Design view, right-click the report or graph object and select Add a filter from the shortcut menu.

   The Filter options dialog box opens.

2. Select the field to be used for the parameter, the Multiselect option, and click OK.

   The New Parameters dialog box appears.

   You may select a control type for the parameter from this dialog box, or adjust them later using the Settings panel on the Parameters tab.
If the New Parameters dialog box does not appear, ensure that Show New Parameters dialog is selected from the HTML Page tab. To access the HTML Page tab, select Options from the Window menu to open the App Studio Options dialog box. From the App Studio Options dialog box, select the HTML Page tab.

3. Click OK to close the New Parameters dialog box.

4. The filter appears above the report or graph object.

   Repeat this procedure for each additional parameter for the report or graph.

**Procedure: How to Sort the Dynamic List of Values**

This option is useful when you want to sort each control independently of the others.

**Note:** If sort options are not selected, the request retrieves dynamic display values from the BY sort field in the request, and the results display values based on the value field. Sort options are not selected by default.

1. Select a dynamic control from the Parameters tab.

   The Settings panel opens.

2. Select Sort to enable the sort options.

   You may select the Sort by and Sort order options for the control.

3. Select the Sort by options:

   - Sort by Value sorts the value by the field name from the Value field. This is the default Sort by selection.
   - Sort by Display sorts the value by the field name from the Display field.

4. Select the Sort order options:

   - Sort order Ascending sorts the value from lowest to highest. This is the default Sort order selection.
   - Sort order Descending sorts the value from highest to lowest.

5. Run the HTML page to see the sort results.

**Procedure: How to Check for Duplicate Values**

When creating a dynamic list of values for a report, you may remove duplicate values from input controls. This is useful if you are using your own procedure that does not use a structured data source.
The Check for duplicate values option is turned off by default.

1. From the HTML canvas, create an input control with a dynamic list of values.

2. Select the input control and click the Parameters tab.
   The Settings panel opens for the input control.

3. Select the Check for duplicate values check box.
   The Check for duplicate values option is only available when creating a dynamic list of values for an input control.

4. Save and run the HTML page.
   The input control removes duplicate value entries.

   The following example shows a list box with a list of city values. The first list box shows the list of values with duplicate entries. The second list box shows the list with duplicate values removed.

**Using Custom Procedures to Retrieve Dynamic Values**

You have the option to allow customized retrieval of dynamic parameter values. By using a custom procedure, you can use the WebFOCUS language to utilize temporary HOLD files, filtering, and so on. This allows the HTML canvas to better integrate with a multitude of large and/or proprietary data sources that may require unique retrieval methods. The procedure must meet the following criteria:

- The procedure must return a name and value pair for each parameter value that will populate the list. The first value is the submission value which is passed to the control when you click the Submit button. The second value is the display value which is what you will see in the control. These two values can be the same or different.

- The procedure must return the two data values on a single data line in XML format (PCHOLD FORMAT XML).

**Note:** Different parameters in the same procedure can use both this option and the data source method.

For chained controls, there are two options based on whether caching is enabled:

- By default, caching is not enabled. Each parameter control must be mapped to its own procedure and the developer is responsible for writing filters or WHERE criteria to properly filter the hierarchy of controls.
If caching is enabled for the parameter values, a single procedure can be used to populate the controls of the chained variables. In this case, the HTML canvas writes the WHERE criteria.

Limit values returned, will not be applied. When using chaining, HTML canvas does not generate filters because it does not produce the request to create the population.

**Example:** Retrieving Dynamic Parameter Values With One Value

The following example shows the same value being used for the submission value and display value.

```plaintext
TABLE FILE GGSales
PRINT DST.PRODUCT
BY PRODUCT
ON TABLE SET HOLDLIST PRINTONLY
ON TABLE PCHOLD FORMAT XML
END
```
The XML output is:

```xml
<?xml version="1.0" encoding="ISO-8859-1" ?>
- <fxf version="1.0" data="hold">
  - <report records="4317" lines="10" columns="2" rows="10">
    <target format="" version="" type="" destination="HOLD" />
    - <column_desc>
      <col colnum="c0" fieldname="PRODUCT" alias="E01" datatype="char"
           width="16" focus_format="A16" description="Product name"
           accept="" help_message="" title="Product" within="" property=""
           reference="" valign="left" />
      <col colnum="c1" fieldname="PRODUCT" alias="E02" datatype="char"
           width="16" focus_format="A16" description="Product name"
           accept="" help_message="" title="Product" within="" property=""
           reference="" valign="left" />
    </column_desc>
    - <table>
      - <tr linetype="data" linenum="1">
        <td colnum="c0">Biscotti</td>
        <td colnum="c1">Biscotti</td>
      </tr>
      - <tr linetype="data" linenum="2">
        <td colnum="c0">Capuccino</td>
        <td colnum="c1">Capuccino</td>
      </tr>
      - <tr linetype="data" linenum="3">
        <td colnum="c0">Coffee Grinder</td>
        <td colnum="c1">Coffee Grinder</td>
      </tr>
      - <tr linetype="data" linenum="4">
        <td colnum="c0">Coffee Pot</td>
        <td colnum="c1">Coffee Pot</td>
      </tr>
    </table>
  - </report>
</fxf>
```

**Example:** Retrieving Dynamic Parameter Values With Two Values

The following example shows two different field values being used for the submission value and display value. In this case, PRODUCT (Product Description) is used for the display value and PCD (Product Code) is used as the submission value.

```plaintext
TABLE FILE GGSALES
PRINT DST.PRODUCT
BY PCD
ON TABLE SET HOLDLIST PRINTONLY
ON TABLE PCHOLD FORMAT XML
END
```
The XML output is:

```xml
<?xml version="1.0" encoding="ISO-8859-1" ?>
<report records="4317" lines="10" columns="2" rows="10">
  <target format="" version="" type="" destination="HOLD" />
  <column_desc>
    <col colnum="c0" fieldname="PCD" alias="E01" datatype="char" width="4" focus_format="A04"
       description="Product Identification code (for sale)" accept=""
       help_message="" title="Product ID" within=""
       property="" reference="" valign="left" />
    <col colnum="c1" fieldname="PRODUCT" alias="E02" datatype="char" width="16" focus_format="A16"
       description="Product name" accept="" help_message=""
       title="Product" within="" property="" reference="" valign="left" />
  </column_desc>
  <table>
    <tr linetype="data" linenum="1">
      <td colnum="c0">C141</td>
      <td colnum="c1">Espresso</td>
    </tr>
    <tr linetype="data" linenum="2">
      <td colnum="c0">C142</td>
      <td colnum="c1">Latte</td>
    </tr>
    <tr linetype="data" linenum="3">
      <td colnum="c0">C144</td>
      <td colnum="c1">Capuccino</td>
    </tr>
  </table>
</report>
```

**Note:** The procedure does not have to follow this WebFOCUS syntax exactly, but the end result must be two values per data line in XML format.

**Example:** **Retrieving Values for Chained Variables With Caching Disabled**

In the following procedures, there are three parameters (REGION, ST, CITY). Caching is disabled, so each parameter control must be mapped to its own procedures.

**Procedure 1 (REGION)**

```sql
TABLE FILE GGSALES
PRINT DST.REGION
BY REGION
ON TABLE SET HOLDLIST PRINTONLY
ON TABLE PCHOLD FORMAT XML
END
```
Procedure 2 (ST)

TABLE FILE GGSALES
PRINT DST.ST
BY ST WHERE REGION EQ '&REGION';
ON TABLE SET HoldLIST PRINTONLY
ON TABLE PCHOLD FORMAT XML
END

Procedure 3 (CITY)

TABLE FILE GGSALES
PRINT DST.CITY
BY CITY WHERE REGION EQ '&REGION'; WHERE ST EQ '&ST';
ON TABLE SET HoldLIST PRINTONLY
ON TABLE PCHOLD FORMAT XML
END

Example: Retrieving Chained Variable Values With Caching Enabled

In the following example, caching is enabled, so a single procedure is used to populate the controls.

TABLE FILE GGSALES
PRINT DST.REGION DST.ST DST.CITY
BY REGION
BY ST
BY CITY
ON TABLE SET HoldLIST PRINTONLY
ON TABLE PCHOLD FORMAT XML
END

The XML output is:

```xml
- <table>
  - <tr linetype="data" linenum="1">
    <td colnum="c0">Midwest</td>
    <td colnum="c1">IL</td>
    <td colnum="c2">Chicago</td>
  </tr>
  <tr linetype="data" linenum="2">
    <td colnum="c0">Midwest</td>
    <td colnum="c1">IL</td>
    <td colnum="c2">Chicago</td>
  </tr>
</table>
```

Automatically Populating Fields With Dynamic Values

When the name of a dynamic parameter matches a corresponding field name in a data source, the HTML canvas automatically populates the field name values for the parameter.
The data source is populated by a default based on the first data source specified by a TABLE FILE or GRAPH FILE command. The data source field is populated for the Value and Display fields in the Settings panel of the Parameters tab (when Dynamic is selected as the Data type). This generates a layout report that is ready to run as long as the parameter names match the field names.

**Example:**  
**Automatically Populating Fields With Dynamic Parameter Values**

When the following report request is called from the HTML canvas with a push button control, the Settings panel for the PRODUCT parameter on the Parameters tab is automatically populated to dynamically retrieve the values of the PRODUCT field.

```
TABLE FILE GGSALES
SUM UNITS
BY PRODUCT WHERE ( PRODUCT EQ '&PRODUCT.Product:' );
END
```

**Creating a Static or Dynamic Parameter Value List**

When creating a static or dynamic list of values, you may add an ALL value to the list of values and/or send the display value in a parameter.

The ALL feature allows developers to automatically add an ALL value to a list of values. An ALL value does the following:

- For dynamic parameters, the ALL feature sends a value of FOC_NONE to the Reporting Server alerting the server to bypass or ignore the parameter altogether. Ignoring the parameter would return all values in the data source.

- With static parameters, the ALL value typically uses JavaScript to return all of the values displayed in the list. This prevents you from having to select every value in the list manually. When using the ALL feature with static parameters, you can select from the following options:
  - Add ignore value. This option sends FOC_NONE to the server at run time, alerting the server to bypass or ignore the parameter altogether. It is intended for complex applications.
  - Add everything value. This option uses JavaScript to send every value present in the control list to the server at run time. The Add everything value option is only available with a Multiselect OR variable type.

When using a Dynamic or Analytic Document Data type, you may enter the value(s) to be selected as the default value whenever the procedure is run.
**Note**: You may also enter the selected value when adding a new unbound parameter on the Parameters tab.

**Procedure**: How to Send the Display Value for Static and Dynamic Controls

From the HTML canvas, you may send the display value, rather than the actual data, to the parameter. The display value can also be used for headings and footings in the report output.

1. From the HTML canvas, import or create a report that contains a parameter.

   When importing a report with parameters, the New Parameters dialog box appears prompting you to create the control type.

   The report and control is added to the HTML canvas.

2. To send the display value for the parameter selection, select the control object (for example, select listbox) in the Design view and click the **Parameters** tab.

3. Navigate to the Settings panel.

   **Note**: The options available in the Settings panel vary, depending on the type of values (static or dynamic) you are creating.

4. For a static list of values, the Value, Display, and Selected columns appear on the Settings panel.

   - In the Value column, enter the value to be passed to the control.
   - In the Display column, enter the text that represents the static parameter value in the control the user views.
   - In the Selected column, check the box for the value you want to be selected by default. More than one value can be selected.

   Repeat these steps until the list contains all of the values you want to include.

   Select **Send display value**.

   **Tip**: You may also update the display values from the Variable Editor dialog box in the Report canvas.

   Optionally, you may select values and click the **Delete** button to eliminate any values, and use the up and down arrows to rearrange the order of the values.

   Click the **Design** tab to view the display values in the control object of the HTML canvas.
5. For a dynamic list of values, the Value from field and the Display from field appear on the Settings panel.

- Add the request to the Requests & Data sources panel.
- Select *Explicit (Requests Panel).*
- Select the procedure from the Requests drop-down list.
- Click the ellipsis button from the Value field.

The Object Inspector opens with the field names from the selected Master File.

- Double-click a field name to add it to the Value field.

  The selected field is automatically added to the Display field and the source code for the default procedure appears.

- Optionally, you may click the Display field ellipsis button to select a different field name for the Display field.

- Optionally, select *Add "All" option* to automatically add an all value to a list of parameter values.

- Optionally, select *Add 'No selection' option* to optimize performance by populating a chain one control at a time instead of all the controls when the page initially loads.

- Select *Send display value.*

  When Send display value is selected, the &Variable gets the display value, instead of the actual value.

6. Optionally, you may add a heading to the report to show the display value. Double-click the report from the HTML canvas to open and edit the report.

   The report opens in the Report canvas.

7. Add *&Variable_TEXT* to the report heading or footing.

   **Note:** If the report procedure uses it, *&Variable_TEXT* will always be passed, regardless of if Send display value is selected.

   The heading as Display Value: &STCD_TEXT, where Store Code (STCD) is the variable name.

   **Tip:** This is different from adding the actual value from the data source, where clicking the variable name would add <STCD to the report heading.

8. Save and close the report to return the HTML canvas.
When you create the Text variable (&Variable_TEXT), you are not prompted to set a control type for this variable when returning to the HTML canvas, as no control type is needed.

9. Run the HTML page.

10. Select the parameter for the report and run the report.

   The display value is shown in the report heading.

   **Note:** The HTML canvas passes &Variable_TEXT if the report procedure uses it, regardless of whether the send display value check box is checked or unchecked.

**Procedure: How to Use Procedure Names as Values**

The *Values are procedures* names option lets you populate a control with procedure names or HTML file names. When that procedure name is clicked, the procedure executes.

1. Create an HTML page that contains a listbox, a push button, and a report.

   **Note:** In this procedure a listbox is used, however, the following controls are also able to use the Values are procedures names option: double list, drop-down, radio button, and check box.

2. Select the listbox to bring up the Settings panel.

   **Note:** If the Settings panel does not open, select View and click Settings.

3. Select Static as the Data type.

4. At the bottom of the Settings panel, select *Values are procedures/html names*.

5. Click the New button and select procedures from your directory.

   **Note:** You can add multiple procedure names to the Settings panel by multi-selecting procedures while in the Open File dialog box.

6. Once the procedures have been added to the Settings panel, edit the display names of the procedures by double-clicking the display contents if they are not already highlighted.

7. Right-click the button you created and click Create Hyperlink.

   The Hyperlink Properties dialog box opens.

8. Create a hyperlink that opens a selected procedure from a control in the report frame created earlier.

   a. For the Action, select *Procedures from control* from the drop-down list.

      This option coincides with the Values are procedures names option found in the Settings panel. This option will point to an entire procedure for the hyperlink, rather than a simple value. This option is only available when a control on the HTML page is using the Values are procedures names option.
b. Select *listbox1* as the Source.
   The source can be different if you use a different control. For example, combobox1, customselect1, radio1, or checkbox1.

c. Select *Frame* as the Target Type.
   You could also select *New Window* as the target if you wanted the procedure to open in a new window.

d. Select *report1* as the Target/Template Name.

9. Run the page.

10. Select the procedure from the listbox and click the button.

   The report is run.

**Procedure:**  How to Use Selected Values as the Default Value

When using a Dynamic or Analytic Document Data type, you may enter the values to be selected as the default value whenever the procedure is run.

If you import a procedure (.fex) that has a dynamic prompt value then the input box is populated with values retrieved from the data source. If the selected value is available in the data source, the values are selected by default. If the selected value is not available in the data source, then the value(s) that you entered are ignored and the first value retrieved from the data source is selected.

1. Create or import a report that contains a parameter value.

   The report and control is added to the HTML canvas.

2. To enter the selected value to be used as the default value, select the control object (for example, select listbox) in the Design view and click the *Parameters* view tab.

   The Settings panel opens.

   **Note:** The options available in the Settings panel vary, depending on the type of values (static or dynamic) you are creating.

3. For a dynamic list of values, the Value from field and the Display from field appear on the Settings panel.

   a. If using a default procedure to supply dynamic values, follow the steps below.

      - Select *Default*.

      - Click the ellipsis button adjacent to the Data Source field.

      The Open File dialog box appears.
Select the Master File name and click OK.

Click the ellipsis button adjacent to the Value from field.

The Object Inspector opens with the field names from the selected Master File.

Double-click a field name to add it to the Value from field.

The selected field is automatically added to the Display from field and the source code for the default procedure appears.

Optionally, you may click the Display from field ellipsis button to select a different field name for the Display from field.

Optionally, select Add "All" option to automatically add an all value to a list of parameter values.

Optionally, select Add 'No selection' option to optimize performance by populating a chain one control at a time instead of all the controls when the page initially loads.

Enter the exact parameter value in the Selected Value input field, as it appears in the data source.

Parameter values are case sensitive.

Optionally, you may enter more than one value by using a semicolon (;) between the values. For example, CA;GA.

You may enter selected values with a semicolon or a comma. Additionally, you may also have embedded commas or semicolons in the data values. If you have these embedded characters, you must enclose all of the values in the input area in double quotation marks ("). For example:

ENGLAND;ITALY

ENGLAND,ITALY

“ENGLAND”, “ITALY”

Note that even though one value in the last set has the embedded comma, both values need to be enclosed in double quotation marks (").

b. If using an explicit procedure to supply dynamic values, follow the steps below.

Select Explicit (Requests Panel).

Select the procedure from the Requests drop-down list.
The parameter names from the procedure are automatically added to the Value from field and Display from field, and the source code for the explicit procedure appears.

- Optionally, you may click the Value from field and Display from field ellipsis button to select a different field name or to type the field name manually.

  **Note:** Only the parameter names from the explicit procedure will be available for selection.

- Optionally, select *Add "All" option* to automatically add an all value to a list of parameter values.

- Enter the exact parameter value in the Selected Value input field, as it appears in the data source.

  Parameter values are case-sensitive.

- Optionally, you may enter more than one value by using a semicolon (;) between the values. For example, CA;GA.

  You may enter selected values with a semicolon (;) or a comma (,). Additionally, you may also have embedded commas or semicolons in the data values. If you have these embedded characters, you must enclose all of the values in the input area in double quotation marks ("). For example:

  ENGLAND;ITALY

  ENGLAND,ITALY

  “ENGLAND”, “IT,ALY”

  Note that even though one value in the last set has the embedded comma, both values need to be enclosed in double quotation marks (").

4. For an Analytic Document list of values, the Available Analytic Documents, Menu Option Types, and Common Columns appear on the Settings panel.

- Select one or more Analytic Documents from the list of Available Analytic Documents. The selected report will be bound to the Analytic Document control in the layout.

  When an Analytic Document is selected, the Refresh for Analytic Documents option, in the Settings panel, is enabled, by default.

- Select the Menu Options Types for the Analytic Document control to sort, filter, list or select columns, and/or change presentation styles of the bound Analytic Document and the associated report and graph objects synchronized to the Analytic Document.
Optionally, select Add "All" option to automatically add an all value to a list of parameter values.

Enter the exact parameter value in the Selected Value input field, as it appears in the data source.

Parameter values are case-sensitive.

Optionally, you may enter more than one value by using a semicolon between the values. For example, CA;GA.

You may enter selected values with a semicolon or a comma. Additionally, you may also have embedded commas (,) or semicolons (;) in the data values. If you have these embedded characters, you must enclose all of the values in the input area in double quotation marks ("). For example:

ENGLAND;ITALY
ENGLAND,ITALY
“ENGLAND”,”IT,ALY”

Note that even though one value in the last set has the embedded comma, both values need to be enclosed in double quotation marks ("").

5. For a single-select unbound parameter, the Selected Value input field appears on the Settings panel.

Enter the exact parameter value in the Selected Value input field, as it appears in the data source.

Parameter values are case sensitive.

Optionally, you may enter more than one value by using a semicolon between the values. For example, CA;GA.

You may enter selected values with a semicolon or a comma. Additionally, you may also have embedded commas or semicolons in the data values. If you have these embedded characters, you must enclose all of the values in the input area in double quotation marks ("). For example:

ENGLAND;ITALY
ENGLAND,ITALY
“ENGLAND”,”IT,ALY”

Note that even though one value in the last set has the embedded comma, both values need to be enclosed in double quotation marks (").
Even though it is a Single select parameter, multiple values are specified and selected.

6. Click the Run button to run the report with the selected value parameters.

   The report output appears.

   The selected value, if available from the data source, is automatically selected (highlighted) in the parameter list.

   If the selected value is not available in the report results, then the value that you entered is ignored and the first value retrieved from the data source is shown.

**Parameterizing Properties in the Properties Panel**

You can parameterize properties in the Properties panel for all objects in an HTML page. This enables you to add values to ampers variables and pass these variables to the corresponding property settings in App Studio so the HTML page behaves a specific way.

You can pass values using the `!IBI.AMP.VarName` variable or a URL call.

**Procedure: How to Parameterize Properties in the Properties Panel**

The following procedure shows how to parameterize properties in the Properties panel, using the `!IBI.AMP.VarName` variable and a procedure call to the HTML page.

1. From the Environments tree, right-click a folder, point to New, and click HTML/Document to create a new HTML page.

2. On the Components tab, in the Generic Elements group, click Button and draw a button on the canvas.

3. On the Controls tab, click the Tree drop-down arrow, and select Multi source Tree to draw the control on the canvas.

4. On the Requests & Data Sources panel, click the New drop-down arrow, and then click Add Data Source.

5. Navigate to the ibisamp folder and select a Master File. For example, movies.mas.

6. Select the button component on the HTML canvas.

7. On the Properties panel:

   - Next to the Color property, type `!IBI.AMP.MYCOLOR;`.
   - Next to the Background-color property, type `!IBI.AMP.BCOLOR;`. 
The Properties panel with Color and Background-color values are shown in the following image.

![Properties panel with Color and Background-color values](image)

8. Select the Multi source Tree control on the HTML canvas. On the Properties panel, next to the Direction of text property, type `!IBI.AMP.DIRECTION;`.

The Properties panel with the Direction of text value is shown in the following image.

![Miscellaneous panel with Autosize settings](image)
9. On the Settings panel, click the ellipsis for Value from and double-click Movie, as shown in the following image.

10. Save and close the HTML page.

11. From the Environments tree, right-click an application folder (for example, baseapp), point to New, and then click Procedure.

12. Type the following code:

   -DEFAULT &DIRECTION=’rtl’;
   -DEFAULT &MYCOLOR=’RED’;
   -DEFAULT &BCOLOR=’BLUE’;
13. From the Procedure View panel, right-click Comment, point to New, point to HtmlForm, and then click Referenced.


15. Close the procedure and save the file.

16. From the Environments tree, right-click the procedure, and click Run.

The following screen displays with the specified default values.

17. Click the Run icon.

Notice that the background color is blue, the button text is red, and the movie titles are right-justified.

18. Click the Show filter panel icon, as shown in the following image.
19. Change the direction to ltr (left to right) and the background color to yellow, as shown in the following image.

1. Specify values for all parameters.
2. Select the run button to submit the request.
20. Click the Run icon. Notice that the background color for the button is yellow and the movie titles are left-justified, as shown in the following image.

Note: You can also parameterize properties in the Properties panel using a URL in a browser. For example:

http://host:port/app_directory/htmfilename.htm?bcolor=red

In this example:

- &Varname (for example, &bcolor) must be added to the Properties panel for the parameter value.
- bcolor refers to the background color.
Viewing Object Attributes

The Properties panel shows the attributes of the object or objects selected on the canvas. For example, if you select a hyperlink object, the Properties panel shows the different attributes associated with a hyperlink, such as Enable Dragging. General attributes for the entire HTML page or Document are shown when no object is selected. The Properties panel is available when you are using the HTML canvas or Document canvas. The attributes can be sorted by category or alphabetically.

You can also select Events. When Events is selected, a list of all available JavaScript events that can be used in conjunction with an object appears. The events that are available change depending on what type of object is selected. For example, a report object has different events available than a button object. When no object is selected, events for the HTML page are displayed. Double-clicking on an event will create a function block for the selected object, using that event. You can view the created functions in the Embedded JavaScript and Embedded CSS tabs, where you can type the JavaScript code to execute when the selected event occurs.

For more information on customizing the Properties panel, see Customizing the Properties Panel for HTML Objects Using the Properties Toolbar on page 599.

Color Selection

For properties that affect color, such as Background-color, Border-color, and Color, you can enter the hexadecimal value of the color you want to use directly into the property, rather than opening the Color Picker dialog box. If you use the Color Picker dialog box to select a color, the hexadecimal value of that selected color will be entered into the selected property. For more information on the Color Picker dialog box, see Color Picker Dialog Box on page 604.

Sizing

Size property fields for a selected object can be set using the Left, Top, Width, and Height fields. The default setting is in pixels (px), and the settings are also displayed in the Locations field. You can also select <Not set>, auto, or inherit in the Left, Top, Width, and Height fields but only pixels are displayed in the Location field.

The Position field also contributes to the location of an object in the HTML canvas. The default value is absolute, but you can change it to one of the values in the list below:

- **<Not Set>**. The element is positioned relative to its first positioned (not static) ancestor element.

- **inherit**. Inherits this property from its parent element.

- **absolute**. The element is positioned relative to its first positioned (not static) ancestor element. This is the default value.
- **fixed.** The element is positioned relative to the browser window.
- **relative.** The element is positioned relative to its normal position, so setting the Left field to 20px adds 20 pixels to the elements left position.
- **static.** Elements render in order, as they appear in the document flow.
- **initial.** Sets this property to its default value.

**Controls**

The Name or Unique Identifier attribute settings for controls appear automatically in the Parameters tab of the HTML canvas.

- When you change the Name attribute for a control, the new name automatically appears in the Parameters tab.
- Some controls do not have a Name attribute. For these controls, the Unique Identifier setting automatically appears in the Properties panel instead.

**Customizing the Properties Panel for HTML Objects Using the Properties Toolbar**

The Properties toolbar contains the buttons and menus that you need to navigate and customize the contents of the Properties panel.

- **Categorized**
  - Groups the attributes by category.

- **Alphabetical**
  - Sorts the attributes alphabetically, without categories.

- **Properties**
  - Shows the property names and values. This is the default setting. Properties and Events cannot be selected at the same time.

- **Events**
  - Shows the JavaScript events that can be associated with the selected object on the canvas. Properties and Events cannot be selected at the same time.

**Resizing HTML Components Using the Autosize Children Option**

The Autosize Children option can resize all child components on an HTML page to automatically fit the maximum available screen space on any monitor or device where it might be viewed. For example, a single component will take up one hundred percent of the available space, while two components will take up fifty percent each.
This option is used so that when your HTML page is run on different devices, components and controls do not appear off the screen and have to be scrolled to in order to use them. To accommodate this, the orientation of components may be different on different devices. For example, a report and chart that appear side-by-side when run on a desktop monitor, may appear stacked one above the other when run on a tablet. Similarly, this difference could occur when run on a 24-inch desktop monitor and a 26-inch desktop monitor.

There are autosize Enable properties that work at both the document and component levels:

- **Autosize Children Enable.** This property is set at the document level. When set to Yes, it enables some or all of the child components in the document to resize automatically.
  
The Autosize Children Enable property is also available at the component level for the form, group box, and panel container objects.

- **Autosize settings Enable.** This property is set for each component in the document. The setting for this option may be:
  
  - Yes. Enables the component to resize automatically.
    
    You can prevent the component from becoming too small using the Min-width and Min-height options. Type the minimum number of pixels for the width, height, or both, in the appropriate fields. When a component reaches the minimum width or height that you specified, a scroll bar appears and the size of the component does not decrease further.
    
  - No. Prevents the individual component from resizing automatically, even when the document and other components resize. Components tagged in this way are rendered first, when the HTML page runs.
The following image shows a report component and a chart component on the HTML canvas where Autosize Children is enabled. Both components share the available space equally.

You can enable Autosize Children for an existing HTML file or create a new file with the option enabled.

**Procedure:**  How to Enable Autosize Children for an Existing HTML File

1. Open the HTML file.
   The HTML canvas opens.

2. In the Properties panel for the document, set the Autosize Children Enable property to Yes.

3. For each component on the page that you want to resize automatically, set the Autosize settings Enable property to Yes.

4. Right-click the HTML canvas and click *Update Layout*.
   The components are resized to occupy all of the space on the canvas.

**Procedure:**  How to Create a New HTML File with Autosize Children Enabled

1. On the *Home* tab, in the *Content* group, click *HTML/Document*.
You can also create a new HTML file from the Application menu or by using the shortcut menu in the Environments Tree panel, for a folder that supports content creation.

The HTML/Document Wizard opens.

2. Navigate to where you want to create your HTML page and click *Next*.

   The Themes and Settings window of the HTML/Document Wizard opens.

3. In the Other settings area, select the *Autosize reports/charts* check box.

   Selecting this option sets the Autosize Children Enable property for the document to *Yes*.

4. Click *Finish*.

   The HTML canvas opens.

5. For each component on the page that you want to resize automatically, set the Autosize settings Enable property to *Yes*.

**Working With Autosize Children**

Working with Autosize Children entails some practices and conditions beyond those found in the native HTML canvas. This is because, when Autosize Children is enabled, components automatically move and resize themselves on the canvas.

**Adding Components to the HTML Canvas**

When you add a component to the canvas with the Autosize Children option enabled, the existing components will temporarily move out of the way so that you can draw the new one. The components will then reposition and resize automatically.

If the screen does not refresh, you can right-click the canvas and click *Update Layout*. There is a small amount of canvas space shown to the bottom and right of the screen, which allows you to access the shortcut menu. This extra canvas space is not shown at run time.

**Note**: If Update Layout does not resize the component automatically, check the properties. The Autosize Children Enabled property for the document must be set to *Yes*, and the Autosize settings Enable property for the component must be set to *Yes*. Components with an Autosize settings Enable property set to *No* will not resize automatically on the canvas or at run time.

To change the order of the components, drag a component to the front or to the left of another component.

The following items apply to form, group box, and panel containers:

- Forms, group boxes, and panels that contains components and controls must have the Autosize Children Enable property set to *Yes*, and the Autosize settings Enable property set to *Yes*.\d
The components that are children of a form, group box, and panel have their Autosize settings Enable property automatically set to Yes. For controls that are children of a form, group box, or panel, you must manually set the Autosize settings Enable property to Yes.

The form, group box, or panel should have the Number of Columns property set to the value you want. For example, if you want three reports or charts to be next to each other, set the value for the Number of Columns property to 3.

If an object has the Autosize settings Enable property set to No, and you want that object to occupy the entire width of the available space, you must set the Width property to 100%.

**Note:** Reports and charts do not automatically re-execute once the page loads and the screen size changes. You must re-execute reports and charts to ensure that the content refreshes. If the output format of a chart is HTML5, the chart content refreshes automatically and you will not have to re-execute.

### Procedure: How to Add Content Inside a Container

You can easily add content inside a container, such as a panel, in the native HTML canvas. However, if the Autosize Children property is enabled, the container moves when you try to add content to it. To prevent this movement, use the following steps:

1. Click to select and freeze the container to which you want to add content.
2. On the **Components** tab, in the **Generic Elements** group, choose an object, such as a text box, that you want to add to the container.
3. Click in the container again to add the element. For example, draw the text box and type the text.
4. Click the element to select it.
   
   In the Properties panel, set the Autosize settings Enable property to Yes, if you want the element to resize automatically.
   
   Click No, if you want the element to remain fixed in the container.
5. Right-click the canvas and click **Update Layout**.
   
   The content now appears inside the container.

### Working With Containers

If you place an object that has Autosize settings Enable property set to No inside a container that has Autosize Children Enable property set to Yes, the object will move to the upper-left corner of the container.
When a container has Autosize Children Enable property set to Yes, and a report or chart is added to that container, the Autosize Children settings property for the report or chart is automatically set to Yes.

When a Tab, Accordion, or Window container has Autosize Children Enable property set to Yes, and multiple reports or charts are added to it, use the Number of columns property. Select the number of columns you want from the drop-down list and arrange the contents in the container, as desired. This ensures the contents will be arranged the same for all browsers. If you do not use the Number of columns property, different browsers may arrange the contents in different ways.

Reference: Color Picker Dialog Box

The Color Picker dialog box contains the Web Palette tab, Named Colors tab, System Colors tab, and Custom Color tab. From these tabs, you can pick different colors.

- **Web Palette.** You can choose a color from common web colors.
- **Named Colors.** You can choose a color from common named colors.
- **System Colors.** You can choose a color based on the colors of App Studio.
- **Custom Color.** You can drag red, green, and blue sliders to create custom colors.

The hexadecimal value for any color you select or create is displayed at the bottom of the dialog box. If you want to enter a specific hexadecimal value, you must enter using the Properties panel or the Style Composer dialog box, in the appropriate area. For example, you can enter a hexadecimal value on the Background-color property line.

Modifying Object Population Settings

In App Studio, you use the Settings panel to modify the population settings of components, controls, and parameters. The Settings panel has context-sensitive sections that are displayed or hidden, depending on the object selected on the canvas. When you select an object, the settings for that object are displayed in the Settings panel.
Settings are grouped under the following sections, and the sections and settings change, depending on which component, control, or parameter is selected.

- **Manage CSS and Scripts Section**
  
  When no object is selected on the canvas, you can manage your cascading style sheet files and JavaScript files using the Manage CSS and Scripts section. The Settings panel displays this section by default.

  Using the CSS button and JavaScript button, you can search for cascading style sheet files and JavaScript files, located in your WebFOCUS environment. You can reference web-accessible Cascading Style Sheet files and JavaScript files by typing the URL, of those files, in the URL/Find File area.

- **Parameter Created In Current Page Section**
  
  To create a parameter in the current page, right click in the Parameters tab and click Add Parameter. The Settings panel displays the Parameter Created in Current Page section. Type the parameter name and format. Click the radio button to specify Single select, Multiselect OR, or Multiselect AND. Type a value in the Selected Value field.

- **The Dynamic Parameter Data Section**
  
  When a dynamic parameter is selected on the Parameters tab, the Settings panel displays the data source file, Value field, and Display field. If the value is multiselect, you can click the drop-down list in the Multiselect field and choose OR, AND, BY, ACROSS, or NONE. Next, type the Selected Value and the Preview Value.

- **Input Control Population Section**
  
  When a control is selected on the canvas and the Data type is set to Dynamic, you can drag fields and parameters from the Requests & Data sources panel to the Settings panel.

**Working With the Selection To Area in the Settings Panel**

The Selection to area in the Settings panel, assists in directing where control and grid selections are sent. For example, you can choose to send any selections made from a drop-down control to a specific parameter.

You can click the Use ‘Requests_Data sources’ panel button to open the Requests & Data sources panel next to the Selection to area. This allows you to drag any parameter from the Requests & Data sources panel, to the Selection to area.
Using Tasks & Animations

Using the Tasks & Animations panel, you can submit requests for parsing, execute tasks when specific criteria are met, and add jQuery animations to your HTML page. The Tasks & Animations panel is shown in the following image.
For more information on customizing the Tasks & Animations panel, see *Executing jQuery Animations Using the jQuery Animations Section* on page 612.

**Executing a Task Using the Tasks Section**

The Tasks section of the Tasks & Animations panel allows you to execute a request when specific criteria are met. For example, you can create a task that runs an embedded report when a button is clicked.

For more information, see *How to Automatically Execute a Request When a Page is Loaded* on page 619.

**Tasks**

**Toggle details**

Opens the Tasks dialog box which displays the Tasks section of the Tasks & Animations panel horizontally rather than vertically. Tasks are displayed in a list. This list shows the Task Name, Trigger Type, Trigger Identifier, Requests/Actions, Target Type, and Target Name, of each task, next to each other. When the Tasks dialog box is opened, the Tasks section of the Tasks & Animations panel is collapsed.

**List of**

A list of tasks defined in the HTML page.

**New task**

Creates a new task. A task is an actionable item.

**Delete**

Deletes a selected task. You can use the drop-down list to delete a selected task or to delete all untriggered tasks.

**Trigger Type**

Determines when a task should start. You can choose:

- Click
- Click link
- Double click
- Mouse down
- Mouse enter
- Mouse leave
- Mouse move
- Mouse over
- Mouse out
- Mouse up
- Blur
- Selection Changed
- Checkbox: Check
- Checkbox: Uncheck
- TBD
- Maps: Selected marker drill down
- Maps: anywhere click
- Grids: Cell Modified
- Grids: Cell Selection Changed
- Grids: Cell Edit Start
- Grids: Cell Edit Finish
- Grids: Column Sized
- Grids: Column Selection Changed

**Note:** The TBD trigger type can be used when a task is executed by an API call.

**Trigger Identifier list**

A list of all possible triggers based on what option you have selected from the Trigger filters list.

**Clear Triggers Selection**

Deselects any object you have selected in the Trigger Identifier list.

**Buttons, Images, Hyperlinks/Selected Only**

You can select whether to display buttons, images, hyperlinks, or other objects as possible Trigger Identifiers. The options are:

- Buttons, Images, Hyperlinks
❖ Buttons
❖ Images
❖ Hyperlinks
❖ Menu Items
❖ All
❖ Selected Only

When All is selected, objects that are not buttons, images, or hyperlinks become available for use as Trigger Identifiers. For example, with All selected, a text object can be a Trigger Identifier.

Selected only will make objects you have selected on the canvas appear in the Trigger Identifier list.

**Conditions**

Allows you to conditionalize the task based on the value selected in a control object. For more information, see *How to Apply a Condition to a Task* on page 619.

**Requests/Actions list**

A list that displays the order in which the requests, for the selected tasks, will execute any Wait for completion requests and any refresh requests. You can use Wait for completion requests to have certain requests execute before others. For example, if request1 is above the Wait for completion action and request2 is below that, then request1 will run first and when that is completed, request2 will then run.

**Requests selections**

Allows you to select which request(s) to add to the Requests/Actions list. Each request selected populates the Target type field with the available targets in which that request can be executed.

❖ **Run Request.** Allows you to execute a procedure. To make a procedure available for selection, reference it in the Requests & Data Sources panel.

❖ **Schedule Request.** Allows you to schedule a procedure. To make a procedure available for selection, reference it in the Requests & Data Sources panel. From the Target/Template Name menu, you can specify the scheduling method, or select *Email Library FTP* to allow users to select one of those three options.
Run Procedures/Html From Control. Executes a procedure or HTML page selected from a specified control object on the page. To provide a list of procedures and HTML pages that can be executed, select the Values are procedures/html files check box in the Settings panel for the control.

Schedule Procedures From Control. Schedules a procedure selected from a specified control object on the HTML page. From the Target/Template Name menu, you can specify the scheduling method, or select Email Library FTP to allow users to select one of those three options. To provide a list of procedures and HTML pages that can be executed, select the Values are procedures/html files check box in the Settings panel for the control.

Run Animation. Displays the available jQuery animations.

Execute Task. Displays the available tasks, to enable you to execute one task from within another.

Refresh. Creates an action to refresh the selected target.

Wait for completion. Allows you to specify that one request must complete before the next one begins.

JavaScript call. Creates a JavaScript call action. When using the JavaScript call, different results occur depending on what is returned. If the JavaScript call returns 0, then all actions after it run. If the JavaScript call returns 1, then one action after the call is skipped, and all actions after that are then run. If the JavaScript call returns 2, all actions after it are skipped.

Delete
Deletes a request from the Requests/Actions list.

Move Up
Moves an item on the Requests/Actions list up one place.

Move Down
Moves an item on the Requests/Actions list down one place.

Target type
The Target type option contains a list of targets in which the request can be executed. These targets can be controls, frames, windows, or distribution methods when the Request is set to Schedule. These options can be different for specific actions.

The Window Target type will execute the request in a window.
The InfoWindow Target type will execute the request in the WebFOCUS generated InfoWindow.

The Ajax call Target type will execute the request as an asynchronous call in JavaScript.

The Frame Target type will execute the request in a selected frame.

The Deferred Target type will run the report deferred.

The Input Control Target Type is only available when you have a refresh request selected in the Requests/Actions list. This Target Type specifies that an input control will be refreshed. You specify which control should be refreshed by selecting one from the Target/Template Name list.

The Analytic Document Target Type is only available when you have a refresh request selected in the Requests/Actions list. This Target Type specifies that an Analytic Document will be refreshed. You specify the Analytic Document that will be refreshed by selecting one from the Target/Template Name list.

The Refresh BI Portal Target Type is only available when you have a refresh request selected in the Requests/Actions list. This Target Type specifies that a WebFOCUS BI Portal page will be refreshed. If you select All pages of the portal, all BI Portal pages will be refreshed. If you select Current page only, only the current BI Portal page will be refreshed.

The JavaScript function Target Type is only available when you have selected JavaScript call in the Requests/Actions field. This Target Type specifies that the selected task will call a JavaScript function that you type in the Function name field.

**Target/Template Name**

Contains options that are associated with the Target type option.

**Note:** When you type a frame name in the Target/Template Name field, if the frame does not exist, a dialog box displays, asking if you want to create a new frame.

This field title changes to Function name under the following conditions:

- The Trigger Type TBD was selected.
- The Requests/Actions JavaScript call was selected.
- The Target type JavaScript function was selected.
In the Function name field, you can type the function that you want to call. You can also include any parameters that are required. Parameters must be included in parentheses and multiple parameters separated by commas. If you had previously typed a function in this field, you can select it from the drop-down menu.

**Size (Width / Height)**

Sets the Width and Height of an InfoWindow. Only available for the InfoWindow Target Type.

**Current pages only**

Refresh the current WebFOCUS BI Portal page. Only available when there is a request to refresh the WebFOCUS BI portal.

**All pages of portal**

Refresh all WebFOCUS BI Portal pages. Only available when there is a request to refresh the WebFOCUS BI Portal.

### Executing jQuery Animations Using the jQuery Animations Section

The jQuery Animations section, in the Tasks & Animations panel, allows you to execute jQuery animations on your HTML page. The animation effects in the jQuery Animations section can be used individually or in conjunction with each other to create more complex animations.

For more information, see *How to Animate an Object Using the Tasks & Animations Panel* on page 615.

**List of**

A list of all animations present in the HTML page. This list will change when animations are added or deleted.

**New**

Adds a new animation to the HTML page. The newly added animation appears in the List of area.

**Delete**

Removes an animation from the HTML page. The deleted animation is removed from the List of area.

**All Targets**

A list of all possible targets that can be used in the current animation being defined.

**Selected Targets**

A list of all targets that will be used in the current animation.
Add canvas selection

Adds the currently selected object on the canvas to the Selected Targets list. Multiple objects can be selected and added at the same time.

Add from list

Adds a selected object from the All Targets list to the Selected Targets list. Multiple objects can be selected and added at the same time.

Remove

Removes an object from the Select Targets list when that object is selected. Multiple objects can be selected and removed at the same time.

Visibility

You can select whether or not to animate the target so that it is hidden or displayed. You can also select not to animate the target for visibility. The options are No Change, Hide, and Show.

Effect

The Effect group contains animation effects and the options you can use to customize those animations. Animation effects can make the target bounce, shake, pulsate, and much more. You can also customize the options associated with that animation effect. The options correlate to the effect used. Such options can be how many times the target bounces after you specify that you want the bounce effect.

Type

A drop-down list where you can select the animation effect you want to use.

Option

You can select which option value you would like to edit, if available. For example, selecting the Bounce animation type allows you to select Distance and Times in the Option drop-down list. When you select Distance or Times, you can then edit the value of either of those options in the Value area. If you select Times and then enter 3 into the Value area, your object will bounce 3 times. The options available are different depending on the effect type you choose.

Value

You can enter a number that pertains to the currently selected option and that affects the animation. For example, if you select the Slide type and the Distance option, the number you enter in the Value area will be the distance the object will slide when it is animated. The value options available are different depending on the effect type you choose.
Effect text area

As the options for the effect are set, the syntax for that effect are displayed here. You can manually adjust this syntax to affect the animation.

Additional Properties

The Additional Properties group contains animations that change the location and size of the target and the components of that target (text size, text width, border size).

Name

A drop-down list where you can select different properties that can be animated. Such properties include height, opacity, font size, and others.

End value

The value for the property you choose from the Name field. For example, if you choose Left and enter 10, the object you are animating would move 10 pixels to the left. The reason you do not need to specify a start value is because the current location of the object is the start value.

Location setting

You can animate the target so that the location and size of that target is changed once the animation is activated.

Use location of selected target

This will use the location of the currently selected target. Coordinates, height, and width of the object are entered automatically into the Location setting box. This is used when the developer plans to move the selected target object and the animation will move it back.

Start location setting

Inserts an adjustable placeholder object into the canvas, at the location of the selected target. You can move and resize this placeholder object. This object represents where the animation will move and what size it will be when the animation is complete.

Set location settings

Sets the adjustable object location and size. This will be where the animated object moves and what size it will be. It is the ending location of the selected target.

Cancel setting

Cancels the setting of the location for the animation.
Additional Properties text area

Once the location has been determined using the Location setting commands, the syntax for that location is displayed here. You can manually adjust this syntax to affect the animation.

**Duration**

How quickly the animation will execute. You can choose either Slow or Fast.

**Toggle animation**

Allows you to revert to the pre-animation state. For example, if the target moves from right to left, the next invocation of the trigger will move the target back to the original position at the right.

**Procedure:** How to Animate an Object Using the Tasks & Animations Panel

The following are examples for how to create and animate an HTML page with jQuery animations.

**Note:** Any of the jQuery animations in the jQuery Animations section can be used individually or together. Using different jQuery animations together will create a more complex animation.

1. Create an HTML page.
2. Insert an image object and a button object onto the HTML page.
3. On the Tasks & Animations panel, in the jQuery Animations section, click **New**.
   
   A new animation is added to the animation list.
4. To make the image object, image1, the target, do one of the following:
   
   - Select the image object on the canvas and click the **Add canvas selection** command.
   - Select image1 from the All Targets area and click the **Add from list** command.
   - Double-click on image1 in the All Targets area to move it to the Selected Targets area.
   
   The image object, image1, is added to the Selected Targets area.
5. Select Hide for the Visibility option.
   
   This animation option will cause the image to be hidden when the button is clicked.
6. On the Tasks & Animations panel, in the Tasks section, click **New**.
   
   A new task is added to the tasks list.
7. Select **Click** from the Trigger Type drop-down list.
8. From the Trigger Identifier list, select the button object, button1.
The button will be used to activate the animation.

9. Select Animation1 from the Requests/Actions option.

When the animation is activated using the button, the image will hide.

**Procedure: How to Select an Effect and Customize the Options for an Animation**

The following is an example for how to select an effect for an animation and customize the options for the effect.

**Note:** Any of the jQuery animations in the jQuery Animations section can be used individually or together. Using different jQuery animations together will create a more complex animation.

1. Create an HTML page.
2. Insert an image object and a button object onto the HTML page.
3. On the Tasks & Animations panel, in the jQuery Animations section, click **New**.
   A new animation is added to the animation list.
4. To make the image object, image1, the target, do one of the following:
   - Select the image object on the canvas and click the **Add canvas selection** command.
   - Select the image1 from the All Targets area and click the **Add from list** command.
   - Double-click on image1 in the All Targets area to move it to the Selected Targets area.
   The image object, image1, is added to the Selected Targets area.
5. Select an Effect and customize the options for that effect.
   a. Select **Blind** from the Type drop-down list.
       This will cause the image to appear as if window blinds have been pulled over it.
   b. Select **Direction** from the Option drop-down list.
      **Note:** Each Effect has different options available to customize. Blind has the Direction option to customize where Bounce has the Distance and Times options.
   c. Select Horizontal from the Value field.
       This will cause the image to be animated with a horizontal blind effect.
       **Note:** The Value field will either be a drop-down list or a text entry box depending on what you selected for the Option drop-down list. For example, Direction will use this as a drop-down list while Times will use this as a text entry box.
6. On the Tasks & Animations panel, in the Tasks section, click **New**.
   A new task is added to the tasks list.
7. Select **Click** from the Trigger Type drop-down list.

8. From the Trigger Identifier list, select the button object, *button1*.
   
   The button will be used to activate the animation.

9. Select *Animation1* from the Requests/Actions option.

   When the animation is activated using the button, the image will animate with a blind effect.

**Procedure:** How to Create a Move or Resize Animation

The following is an example for how to create a move or resize animation.

**Note:** Any of the jQuery animations in the jQuery Animations section can be used individually or together. Using different jQuery animations together will create a more complex animation.

1. Create an HTML page.

2. Insert an image object and a button object onto the HTML page.

3. On the Tasks & Animations panel, in the jQuery Animations section, click **New**.

   A new animation is added to the animation list.

4. To make the image object, *image1*, the target, do one of the following:

   - Select the image object on the canvas and click the **Add canvas selection** command.
   - Select *image1* from the All Targets area and click the **Add from list** command.
   - Double-click on *image1* in the All Targets area to move it to the Selected Targets area.

   The image object, *image1*, is added to the Selected Targets area.

5. Use the Location setting options, found in the Additional Properties area, to animate the object so that it moves when activated.

   a. Click the **Start location setting** command.
      
      A placeholder object is shown overlapping your image.

   b. Move the placeholder object to a different location on the HTML page.

   c. Click the **Set location setting** command.
      
      This removes the placeholder object and adds syntax to the Additional properties text area. When your animation is activated, it will move to a different location that you specified using the placeholder object.

6. Select **Fast** from the Duration drop-down list.

   This will make the animation run at a faster speed.
7. Check the *Toggle Animation* check box.

Checking the *Toggle Animation* check box will allow you to click the button after the animation has run and restore the image to its original state (in its original location and unhidden).

8. On the Tasks & Animations panel, in the Tasks section, click *New*.

A new task is added to the tasks list.

9. Select *Click* from the Trigger Type drop-down list.

10. From the Trigger Identifier list, select the button object, *button1*.

    The button will be used to activate the animation.

11. Select *Animation1* from the Requests/Actions option.

    When the animation is activated using the button, the image will move to the location that you set. If you click the button a second time, it will move back to the original location.

**Procedure:** How to Create a Hyperlink in App Studio to Drill to a WebFOCUS Procedure

You use the Hyperlink component and the Tasks & Animations panel to create hyperlinks. The following is an example of creating a hyperlink to drill to a WebFOCUS procedure.

1. In the *Components* tab, in the *Generic Elements* group, click *Hyperlink*.

    A task is added to the Tasks section of the Tasks & Animations panel with a trigger type and trigger identifier already chosen.

2. In the Requests & Data sources panel, create a new external request for a WebFOCUS Procedure.

3. Drag the request on to the canvas to create a frame.

4. In the Tasks section of the Tasks & Animations panel, in the Requests/Actions list, click the Requests selection command and select the request you created in step 2.

5. In the Trigger Type drop-down list, select *Frame*.

6. In the Target/Template Name drop-down, select the frame you created in step 3.

    When the HTML page is run and you click on the hyperlink, the WebFOCUS Procedure you chose will run in the frame.

**Procedure:** How to Create a Hyperlink in App Studio to Execute a URL

1. In the *Components* tab, in the *Generic Elements* group, click *Hyperlink*.

    A task is added to the Tasks section of the Tasks & Animations panel, with a trigger type and trigger identifier already chosen.
2. In the Requests & Data Sources panel, click the New drop-down arrow and select Url Request.
3. Type the URL in the Enter Url dialog box.
4. Navigate to the Tasks & Animations panel, select the task for the hyperlink, and verify that the trigger identifier displays the unique ID of the hyperlink object.
5. Click the arrow in the Requests/Actions section, select Run Request, and then select the URL request.
6. Select the Target type from the drop-down list (for example, Window or Frame).
7. Select the appropriate Target/Template name from the drop-down list.

**Procedure:** How to Automatically Execute a Request When a Page is Loaded

You can use the Requests and Tasks sections to create a request that executes when your HTML page is loaded. To do this, you must use the load task, in the Task Section. The load task is automatically added to every page and runs all selected requests when the page initially loads.

1. Select the load task.
2. Select the Load trigger type in the Trigger Type drop-down list. This option is selected by default, for a load task.
3. Select a request from the Requests/Actions list.
4. Select the destination of the procedure by using the Target type drop-down list. For example, you can have the procedure run in a new window or in a report frame on the HTML page.
5. Select the frame in which the procedure will run. This option is only needed if you want to run the procedure, in a frame, on the HTML page, and not a new window.

**Procedure:** How to Apply a Condition to a Task

You can apply a condition to a task so that it will only execute when certain values are selected from a control on the page. This allows you to modify run-time behavior based on user selection.

If you apply multiple conditions to a task, they must all be satisfied in order to execute the request or action associated with the task. If only one of the conditions is satisfied, the task will not execute. When the task is triggered for execution but the conditions are not all satisfied, an alert message appears indicating that the conditions are not met.

1. Create an HTML page that contains a control, a button to use as the Trigger Identifier, and a chart or report. The Trigger Identifier can be the control object.
2. Select the control and open the Settings panel.

3. Populate the control. You can use the Static data type and add new values manually, or use the Dynamic data type to take values from a data source.

4. Open the Tasks & Animations panel.

5. In the Tasks section, click the New button to create a new task.

6. Select a Trigger Type. This is the action that you want to use to initiate the task, for example Click.

7. Specify the Trigger Identifier. This is the object on the page upon which you perform the action set as the Trigger Type in order to initiate the task, such as a button that you can click.

8. Click the New condition button to create a condition for the task.

   The task will only execute if the condition is satisfied.

9. Click the Edit button to define the condition.

   The Task condition dialog box opens.

10. In the Task condition dialog box, select the following options.

   a. From the Input controls menu, select the control on the page whose values will be used in the condition.

   b. From the Values compare operator menu, select the test to use for the condition. You can set the condition to be satisfied when the selected value is equal to, not equal to, greater than, greater than or equal to, less than, or less than or equal to the compare value or values that you will specify.

   c. From the Multiselect operator menu, specify how multiple compare values should be treated. Select All of to specify that all compare values must be selected to satisfy the condition, or select One of to specify that just one of the compare values must be selected.

   d. In the Compare to values text area, supply the compare values that can be selected to satisfy the condition. You can type them manually, with one on each line, or click the ellipsis button and select values from the control.

11. Click OK to apply your changes and close the Task condition dialog box.

12. Optionally, click New condition again, select it from the list of conditions, and repeat steps 9 through 11 to add a second condition that must also be satisfied in order for the task to execute.

   You can also click the Delete button to delete the selected condition.

13. Add a request or action to execute when the condition or conditions are satisfied. For example, if you have a report on the page that you want to execute, click the down arrow next to the Requests selections button, point to Run Request, and select the report procedure.
14. Select an option from the Target type menu. Different target types are available for different kinds of requests and actions. The target type determines where or how the task executes.

15. Run the page. When you select values from the control object and execute the task, the condition is tested. If all conditions are satisfied by the values that you selected, the task executes as specified. If the conditions are not all satisfied, an alert appears.

**Working with Requests & Data Sources**

A request is a definition of something that can be executed. For example, you can execute a default procedure, explicit procedure, HTML page, URL, and more. If a request has parameters, those parameters will be indented and listed under the request name. By default, all parameters are sent to the Reporting Server. However, you can choose to not send a parameter in the request section by using the shortcut menu of the parameter, and clicking *Don’t Send*. If you choose to not send a parameter, you must verify that your procedure can work without that value. For example, it contains a -DEFAULT value for the parameter.

When creating an external request that uses an existing file, the request inherits the name of that external file. For example, if you create an external request that uses an existing WebFOCUS procedure called Parameter_Report, then your external request will inherit the name Parameter_Report.

Each request displays two folders beneath it, the Columns and Parameters folders. The Columns folder contains the fields used in the request. The Parameters folder contains the parameters used in the request. The Parameters folder is expanded by default, while the Columns folder is collapsed by default.

The Data Sources folder contains all data sources, used for default procedures and default control population requests, in the HTML page. Referenced data sources are not displayed in the Requests & Data sources panel. You can add additional data sources to the HTML page by embedding additional requests. You can also add additional data sources by right-clicking on the Data Sources folder, and using the shortcut menu to click *Add Data Source*.

You can refresh all requests, except empty requests, using the shortcut menu. Right-click a request and click *Refresh*.

You can also duplicate a request by using the shortcut menu, on the request you want to duplicate, and clicking *Clone*. When you clone an embedded request, you create a copy of the default request with the name, *name_1*. Name is the name of the original default request. For example, if you clone a request named SalesReport, the cloned request would be called SalesReport_1. Cloning an explicit request does not make a second copy of the referenced procedure.
You can also make edits to a selected procedure using the shortcut menu and clicking *Open in text editor*, as shown in the rightmost image below. For a default procedure, the new procedure tab opens with an extension of .vrt to show it is virtual. With a referenced procedure, the procedure tab opens with an extension of .fex.

In the Requests & Data sources panel, each icon next to an item indicates the type of request or parameter. For example, a parameter that was created in the current HTML page has the parameter symbol and an addition sign on it. Another example is how an external URL request has the word *URL* on it.

Two sample Requests & Data sources panels are shown in the following images.

You can drag parameters and fields to the Settings panel to configure the selected component or control. You can drag requests from the Tasks & Animations panel to the HTML canvas, to create objects and controls for the request.

**New request**

Creates a new request. A request is an item that can be executed.

**Delete**

Deletes a selected request.

**Refresh parameters**

Refreshes the parameters used in the request.

**Create Input Controls**

Opens the New Parameter dialog box where you can select which input controls to create for parameters that are checked off in the Parameters list box, and if you want those controls chained to the parameter.
Save Selection

Saves the parameters you currently have checked off in the Parameters list box. You can choose to send more or less parameters than the procedure in the request requires. If you send less parameters, then you need to make sure the remaining parameters are handled by a -DEFAULT, -SET, or some other construct in the request.

Clear Selection

Clears all selected items in the Requests & Data sources panel.

Procedure: How to Create a Default Procedure Request in App Studio

1. Add an embedded procedure to the Requests & Data source panel. Click the New dropdown arrow, point to Embedded Request, and then click New Report, New Chart, or New Document to create and embed a new procedure. Point to Import Existing to embed an existing procedure file.

A new request is created in the Requests & Data sources panel. If you are creating a new procedure, the Open File dialog box appears, prompting you to select a Master File. If you are embedding an existing file, the Open File dialog box appears, prompting you to select a procedure file.

2. Select a Master File or procedure file and click OK.

If you are creating a new procedure, the canvas for that type of procedure opens. Once you are done creating the procedure, save and close the canvas.

3. In the Requests & Data sources panel, you may drag the request that you created on to the canvas.

A procedure object is created on the canvas. If the procedure contains parameters, a form control is also added to the canvas. A task is created in the Tasks section of the Tasks & Animations panel.

Displaying Applications in Different Languages

You can translate HTML pages within App Studio to display applications in different languages in the portal. A translation XML file can be an embedded file or a referenced file.

When creating an HTML page in the HTML canvas, you can use the Dynamic Language Sets group on the Properties panel for the DOCUMENT object to:

- Select a language, to allow for development.
- Select a default language for run time, if the selected language is not yet defined.
- Use an embedded or external file for translation.
See a visual representation of the selected language. The open tab for the HTML file displays the language in parentheses next to the file name. This is for display purposes only. The file will not be saved with the additional language information.

The Dynamic Language Sets group on the Properties panel for the DOCUMENT object is shown in the following image.

![Properties panel showing Dynamic Language Sets](image)

The Dynamic Language Sets properties are as follows:

- **Selected.** Is a drop-down list, which contains a list of WebFOCUS languages, as selected in the WebFOCUS Administration Console. This is based on the selected code page. The default value is the language that is set in the General section of the App Studio Options dialog box.

- **Default.** Is a drop-down list of the languages that will be available in the embedded or referenced file (XML). When you select a language in the Selected drop-down list, the language is added to the Default drop-down list and a section in the XML file is added for the language. If you run the page from the Web Console (BIP tree), and if the selected WebFOCUS language is not available for the HTML file, then the page runs in the language selected in the Default drop-down list. When a new value is selected in the Selected drop-down list, the Default will automatically be set for the Language drop-down list in the General section of the App Studio Options dialog box.
Locale file. Indicates whether the translation XML file is an embedded file or a referenced file, as shown in the following image.

Possible values are:

- **Embedded.** Indicates that all the XML language strings are written in the HTML file. This is the default value.

- **Referenced.** Prompts you to select an existing XML file from the Open File dialog box. You can type a name in the Filename field in order to create a new XML file. Selecting Yes in the App Studio dialog box creates a new file.
Note:

- When creating a locale file for the first time, the referenced file must be created as a new file.

Yes populates the page with the localized strings in the file. No writes the information in the page to the file at the time when the HTML file is saved.

- A referenced file allows one file to be used for multiple pages. Make sure the objects have the same unique identifier, so they access the correct translation entry in the file.
You can also set Locale options by right-clicking the document and selecting Locale Sections from the right-click menu, as shown in the following image.

The following options are available:

- **Create All.** Creates sections in the XML file for all languages listed in the Selected drop-down list in the Properties panel. All the languages will also be populated in the Default drop-down list. Once the Create All option is selected, it will be grayed out until a section is removed from the XML file.

- **Update.** Updates sections in the XML file when you develop the HTML page and when saving the page.

  **Note:** If the XML file is not written for any sections in the HTML page, selecting Update will update the XML file sections for those missing sections.

- **Remove Selected.** Removes the section in the XML file for the language in the Selected drop-down list. The value in the Selected drop-down list will be the default language. The language will also be removed from the Default drop-down list.

**Procedure:** How to Display Applications in Different Languages

1. Right-click a folder, point to New, and then click HTML/Document to create a new HTML page.
Notice that the open tab for the HTML file displays the default language in parentheses, as shown in the following image.

2. Add a report and a heading control to the HTML page, as shown in the following image. Type the text for the heading in English.

3. Save the HTML page.

4. In the Properties panel, click the Selected drop-down list and select a different language, for example, French, as shown in the following image.

Notice that the open tab for the HTML file changes to the selected language, as shown in the following image.

5. Type the text for the heading in French, as shown in the following image.
6. Save the HTML page.
8. Run the HTML page. The report heading is in English, as shown in the following image.

### Margin Report for Product Categories

<table>
<thead>
<tr>
<th>Product Category</th>
<th>AVE Margin</th>
<th>Revenue</th>
<th>Cost of Goods</th>
</tr>
</thead>
<tbody>
<tr>
<td>Camcorder</td>
<td>40.41%</td>
<td>$154,465,702.24</td>
<td>$104,866,857.00</td>
</tr>
<tr>
<td>Accessories</td>
<td>36.51%</td>
<td>$129,608,338.53</td>
<td>$89,753,898.00</td>
</tr>
<tr>
<td>Computers</td>
<td>35.63%</td>
<td>$103,316,482.12</td>
<td>$69,807,654.00</td>
</tr>
<tr>
<td>Video Production</td>
<td>33.04%</td>
<td>$58,053,276.62</td>
<td>$40,105,657.00</td>
</tr>
</tbody>
</table>

10. Run the HTML page. The report heading is in French, as shown in the following image.

### Rapport de marge pour les catégories de produits

<table>
<thead>
<tr>
<th>Product Category</th>
<th>AVE Margin</th>
<th>Revenue</th>
<th>Cost of Goods</th>
</tr>
</thead>
<tbody>
<tr>
<td>Camcorder</td>
<td>40.41%</td>
<td>$154,465,702.24</td>
<td>$104,866,857.00</td>
</tr>
<tr>
<td>Accessories</td>
<td>36.51%</td>
<td>$129,608,338.53</td>
<td>$89,753,898.00</td>
</tr>
<tr>
<td>Computers</td>
<td>35.63%</td>
<td>$103,316,482.12</td>
<td>$69,807,654.00</td>
</tr>
<tr>
<td>Video Production</td>
<td>33.04%</td>
<td>$58,053,276.62</td>
<td>$40,105,657.00</td>
</tr>
</tbody>
</table>

### Specifying Browser Defaults

You can use the Style Composer to control default settings for font, background properties, position mode, flow control, margins, list styles, and visual effects.

To access the Style Composer, right-click an object on your HTML page and select Style from the shortcut menu.

**Reference:** Specifying Font Styles Using the Style Composer

To specify the font styles that will be used in the browser for your HTML page, make your selections in the Font window of the Style Composer.
The Font window of the Style Composer is comprised of the following elements:

**Font name**

Determines the font displayed in a browser.

You can specify: *Family* (launches the Font Picker dialog box) or *System Font*.

**Font attributes**

Determines the attributes of the font displayed in a browser.

The options include: *Color, Italics, Small Caps*.

**Size**

Determines the size of the font displayed in a browser.

The options include: *Specific, Absolute, Relative*.

**Bold**

Determines whether the font is displayed as bold in a browser.

The options include: *Absolute, Relative*.

**Effects**

Determines whether the font effects are displayed in a browser.

The options include: *None, Underline, Strikethrough, Overline, Capitalization*.

**Reference:** Specifying Background Properties Using the Style Composer

To specify the background styles that will be used in the browser for your HTML page, make your selections in the Background window of the Style Composer.

The Background window of the Style Composer is comprised of the following elements:

**Background color**

Determines the background color of the HTML page.

You can specify: *Color, Transparent*.

**Background image**

Determines the properties of the background image displayed in a browser.

The options include: *Image, Tiling, Scrolling, Position (Horizontal and Vertical), Do not use background image*. 
**Note:** When using a background image with scrolling enabled, you must specify the horizontal and vertical positions. If you do not specify these positions, your background image will not show. The horizontal and vertical positions are relative to the window and not the individual element.

**Reference:** Specifying Text Styles Using the Style Composer

To specify the text styles that will be used in the browser for your HTML page, make your selections in the Text window of the Style Composer.

The Text window of the Style Composer is comprised of the following elements:

**Alignment**

Determines the alignment of text.

You can specify: **Horizontal, Vertical, Justification**.

**Spacing between**

Determines the spacing between text.

You can specify spacing between the following text elements: **Letters, Lines**.

**Text flow**

Determines the flow of the text.

You can specify: **Indentation, Text direction**.

**Reference:** Specifying Position Mode Using the Style Composer

To specify the position mode that will be used in the browser for your HTML page, make your selections in the Position window of the Style Composer.

The Position window of the Style Composer is comprised of the following elements:

**Position Mode**

From which you can specify: **Position in normal flow, Offset from normal flow, Absolutely position**.

**Height/Width**

When Absolutely Position is selected, you can specify position indicators in the measurements.

You may specify: **Top, Left, Z-Index**.

**Note:** Z-Index is optional. It sets or retrieves the stacking order for absolute or relatively positioned objects.
**Reference:** Specifying Layout Styles Using the Style Composer

To specify the layout styles that will be used in the browser for your HTML page, make your selections in the Layout window of the Style Composer.

The Layout window of the Style Composer is comprised of the following elements:

**Flow control**
- From which you can specify: Visibility, Allow text to flow, Display, Allow floating objects.

**Content**
- From which you can specify: Overflow.

**Clipping**
- From which you can specify whether or not to clip the layout from the following positions: Top, Bottom, Left, Right.

**Printing page breaks**
- From which you can specify: Before, After.

---

**Reference:** Specifying Edge Styles Using the Style Composer

To specify the margins, padding, and border styles that will be used in the browser for your HTML page, make your selections in the Edges window of the Style Composer.

The Edges window of the Style Composer is comprised of the following elements:

**Margins**
- From which you can specify: Top, Bottom, Left, Right.

**Padding**
- From which you can specify: Top, Bottom, Left, Right.

---

**Reference:** Specifying List Styles Using the Style Composer

To specify the list styles that will be used in the browser for your HTML page, make your selections in the Lists window of the Style Composer.

The Lists window of the Style Composer is comprised of the following elements:

**Lists**
- From which you can specify: Bulleted, Unbulleted.

**Bullets**
- From which you can specify: Style, Position, Custom bullet.
Reference: Specifying User Interface Effects Using the Style Composer

To specify the interface styles and visual effects that will be used in the browser for your HTML page, make your selections in the Other window of the Style Composer.

The Other window of the Style Composer is comprised of the following elements:

**User interface**

From which you can specify: *Cursor*.

**Tables**

From which you can specify: *Borders, Layout*.

Reference: Specifying Border Settings Using the Style Composer

To specify the Border settings that will be used in the browser for your HTML page, make your selections in the Border window of the Style Composer.

The Borders window of the Style Composer is comprised of the following elements:

**Borders**

Determines which border should be styled, what type of style should be applied, the width of the border, and the color of the border.

**Rounded Border**

Determines the whether your border corners will be rounded. You can style each individual corner to be rounded. You can also specify by how much they are rounded and whether all corners should be equally rounded.

Chaining in the HTML Canvas

You may chain controls to one another on the Parameters tab and apply conditions to links in the chain. Chaining will populate controls based on the selected value from the prior control in the chain. You can chain static and dynamic controls, link or unlink parts of a chain, and create conditions on links in a chain. Chains are represented by lines connecting control objects on the Design or Parameters tab. Note that chaining is applicable only for controls, not parameters.

**Note:**

- Although you may chain controls from the Design tab, you may only create conditions to links in the chain through the Parameters tab.

  By clicking the arrow head in a link of a chain, the Settings panel enables you to modify and set the properties and conditions of the chain.
If using static controls, you must apply conditions for each link in the chain. Conditions need to be created for each value of the control chained from, and those values must be mapped to the correct value(s) that will be displayed in the control that it is being chained to.

Automatically Chaining Parameters From the New Parameters Dialog Box

The auto chain option enables you to automatically chain selected controls from the New Parameters dialog box. Chaining populates controls based on the selected value from the prior control in the chain. The auto chain option is useful since it creates the chain, or links of a chain, automatically.

Note: Automatic chaining creates a basic chain with default functionality that does not include any conditions. You may create conditions for a chain through the Parameters tab.

When importing or referencing a report with parameters to an HTML page, the controls are not chained by default. You may choose to include or exclude individual controls in a chain with the Chain control column from the New Parameters dialog box. Additionally, when the auto chain option is selected, a separator is added to the parameters list on the New Parameters dialog box. A separator is used to separate controls into multiple chains and can be moved up or down in the chain sequence.

Procedure: How to Auto Chain Controls From the New Parameters Dialog Box

The auto chain option creates the chain, or links of a chain, automatically. When the auto chain option is selected, a separator is added to the parameters list. A separator is used to separate controls into multiple chains and can be moved up or down in the chain sequence.

1. In the HTML canvas, import or reference a report with parameters.
   The New Parameters dialog box opens.

2. Select Auto chain controls in above specified order.
   Tip: You may use the up or down arrows to change the order of the selected control before selecting this option.
   The Chain control option is selected for all controls and a separator is added as the last object to the list of parameters.

3. To create multiple chains, click the separator row and use the up or down arrows to change the location of the separator in the chain.
   Note: If the default separator is moved up, another separator is added to the end of the list.
4. Click OK to close the New Parameters dialog box and add the control to the HTML page.

On the Design tab, when creating multiple chains from the New Parameters dialog box, each set of chained parameters appears on a new line, regardless of the grouping option selected from the New Parameters dialog box. This behavior is set through the Start each chain on a new line option, located on the Form Settings dialog box in the HTML Page tab of the App Studio Options dialog box. This enables you to see the relationship of the chains within the form. Start each chain on a new line is selected by default.

On the Parameters tab, chains are represented by lines connecting control objects.

5. You can remove a chain by clicking Break binding from the shortcut menu when a chain link is selected.

**Procedure: How to Chain Controls From the New Parameters Dialog Box**

The Chain control column enables you to include or exclude individual controls in a chain, from the New Parameters dialog box.

1. In the HTML canvas, import or reference a report with parameters.

   The New Parameters dialog box opens.

2. Select the Chain control check box for the controls to be included in the chain.

   The controls are chained in the order that they appear on the New Parameters dialog box. You may use the up or down arrows to change the order of the selected control before chaining controls.

   **Note:** If a control is excluded from a chain, the chain automatically links only the selected controls.

3. Click OK to close the New Parameters dialog box and add the control to the HTML page.

   On the Design tab, when creating multiple chains from the New Parameters dialog box, each set of chained parameters appears on a new line, regardless of the grouping option selected from the New Parameters dialog box. This behavior is set through the Start each chain on a new line option, located on the Form Settings dialog box in the HTML Page tab of the App Studio Options dialog box. This enables you to see the relationship of the chains within the form. Start each chain on a new line is selected by default.

   On the Parameters tab, chains are represented by lines connecting control objects.

4. You can remove a chain by clicking Break binding from the shortcut menu when a chain link is selected.
Creating Pop-Up Controls

For a DOCUMENT object, you can use pop-up controls to:

- Create modern looking controls that will run seamlessly on any device.
- Create controls that look the same, but offer different functionality based on single or multiple value selection.

To create pop-up controls, you can:

- Set the Create popup controls property on the Properties panel for the DOCUMENT object.
- Use the Popup style right-click shortcut option, which allows a control to be an original or a pop-up style control. (Disabled for Edit Box, Text Area, Calendar, and Slider).
- In the New Parameters dialog box, set the value in the Create control column to Popup.
The Create popup controls property on the Properties panel is shown in the following image. Possible values are Yes and No. No is the default value.
The Popup style right-click shortcut option for a drop-down control is shown in the following image. (Disabled for Edit Box, Text Area, Calendar, and Slider).
The New Parameters dialog box is shown in the following image. The Popup option is available in the drop-down menu in the Create control column.
The following image shows an example of a pop-up control.

![Pop-up Control Example](image)

**Procedure:** How to Add a Title to Pop-Up Controls

You can add a title bar and specify a customized title for pop-up controls in an HTML page.

To add a title bar, in the Properties panel, set Display Title Bar to Yes. When Display Title Bar is set to Yes, the Title Text property becomes available. Type a value in this field to display in the pop-up control title bar at run time.

1. Create an HTML page that includes a control object.
2. Change the control to a pop-up control.
   
   You can do this in one of the following ways:
   
   - Before adding controls to the page, open the Properties panel. For the DOCUMENT object, set the Create popup controls property to Yes.
     
     Any controls added to the page are created as pop-up controls.
   
   - In the New Parameters dialog box, when creating the control, select *Popup* from the Create control column.
   
   - Right-click the control and click *Popup style*.

**Note:**

- Edit boxes, text areas, calendars, and sliders cannot use pop-up styling.
- Multiselect drop-down controls use pop-up styling, by default.

3. Select the control, and open the Properties panel. When the control is set to use pop-up styling, the Display Title Bar property becomes available.
4. Set the Display Title Bar property to Yes.

5. When the Display Title Bar property is set to Yes, the Title Text property appears. Type the text for the control title into this field, as shown in the following image.

![Image of miscellaneous properties](image_url)

If you leave the Title Text field blank, the unique identifier of the control or the label assigned to the control, if there is one, is used as the title text.

6. Run the HTML page and click the control.
The text specified by the Title Text property appears on the control title bar, as shown in the following image.

![Image of a dropdown menu with a list of regions]

Using the Chain Separator and Line Separator

The chain separator and line separator options allow for chains and parameters to be grouped or split depending on which settings are turned on. When used, the two separators do the following:

**Chain separator.** When *Start each chain on a new line* is on, this separator creates new chain groups on new lines. When *Start each chain on a new line* is off, this separator starts a new chain wherever it is placed in the New Parameters dialog box. The controls are positioned in one row and wrap at the end of the form.
**Note:** Start each chain on a new line is turned on, by default. This option can be found in the Form Settings dialog box, in the HTML Page section of the App Studio Options dialog box, as shown in the following image.

![Image of Form Settings dialog box](image)

### Line separator
This separator creates a line break wherever it is placed.

**Procedure:** How to Use the Chain Separator and Line Separator

1. Create a new procedure that uses the GGSALES Master File and prints REGION, CATEGORY, PRODUCT, and BUDDOLLARS.
2. Create a WHERE statement with the same fields detailed in step 1, using a dynamic parameter.
3. Save the procedure, naming it separator_example.fex.
5. Insert a report component.
6. Right-click the report and select *Reference existing procedure*, as shown in the following image.

7. Select the previously created procedure, *separator_example.fex*, and click **OK**.
The New Parameters dialog box opens, as shown in the following image.

8. Select the *Auto chain controls in above specified order* option.

9. Move Line Separator above BUDDOLLARS, using the up arrow key.
   A copy of the line separator is moved up while the original stays in the starting position. This is so you can add multiple line separators.

10. Move Chain Separator above PRODUCT, using the up arrow key.
    A copy of the chain separator is moved up while the original stays in the starting position. This is so you can add multiple chain separators.
The New Parameters dialog box will look like the following image.

![New Parameters dialog box](image)

11. Click OK.

The report is added to the HTML page. REGION and CATEGORY are on the first line and make up one chain. PRODUCT is on the second line, while BUDDOLLARS is on a separate, third line.
The parameters are shown in the following image.

![Image of chained parameters]

**Chaining Controls on the Parameters Tab**

Chaining enables you to associate two or more related values. When you chain controls together, chained values are filtered as selections are made to each parameter control. For example, if you chain the PLANT parameter to the STATE parameter, only PLANT values for the currently selected STATE value will be available instead of all the plants in the data source. Each time a selection is made, all chained controls that come after will be dynamically updated. Chaining also enables you to add, remove, and reverse the order of controls in the chain.

Values are processed with a caching mechanism that gathers all of the necessary values prior to loading the page. This method automatically combines all of the necessary requests into a single HTTP request and maps the result sets to the appropriate controls, greatly reducing the load time involved with sending multiple requests for data.

If a parameter has two or more incoming bindings, the value selected last will be displayed as the parameter.

**Note:** When a parameter is populated by two or more controls, the value of the last control used will be assigned to the parameter.

**Procedure:** How to Chain Controls on the Parameters Tab

1. Create an HTML page using input controls to supply parameter values.
2. Click the Parameters tab.
3. Select the center of the control object and drag the control to the center of the next control object in the chain.
Repeat this step for each link in the chain.

4. Optionally, apply condition settings to the chain to determine how parameters are populated.

If using static controls, you must apply conditions for each link in the chain. Conditions need to be created for each value of the control chained from, and those values must be mapped to the correct value(s) that will be displayed in the control that it is being changed to.

**Procedure: How to Remove a Link in the Chain**

1. While on the Parameters tab, select the arrow head on the line so that the line is bold.
2. Right-click and select *Break binding*.
3. Repeat this step for each link in the chain that you want to break.

**Procedure: How to Reverse the Order of Chained Controls**

1. While on the Parameters tab, select the arrow head on the line so that the line is bold, right-click and select *Break binding*.
2. Select the center of the control object and drag the control to the center of the next control object in the chain.

Notice the direction of the arrow between the control objects. You may reverse the direction of the link in the chain or reverse the order of the chain by changing the direction of each link.

- If reversing the direction of a link in the chain, drag the control object in the desired order.

- If reversing the order of a chain, drag the control objects in the desired order.

**Tip:** In some scenarios, when reversing the order of chained values, you may want to move the controls from the default location on the Parameters tab so that you can better see the direction of the chain. Moving objects on the Parameters tab will not affect the Design view of your layout.

- Press the Shift key and select the control object and bound parameter to move the objects as a set.

- Chain the control objects together.

3. Optionally, apply condition settings to the chain to determine how parameters are populated.
Arranging Controls

You can choose the arrangement of controls in the New Parameters dialog box, without any additional steps, after the parameter controls are generated. This gives you the flexibility to design your HTML page, without the need for moving the controls after creation.

The Controls arrangement option, as shown in the following image, indicates the placement of controls.

![New Parameters dialog box]

The following are possible values for the Controls arrangement option:

- **Auto.** This value depends on the value in the Number of columns property in the Form settings dialog box. This dialog box is in the HTML Page section in the App Studio Options dialog box. Based on this value, the controls will fold to the next line. The valid values for Number of columns are 1 to 99. Auto is the default value.
Row. Places the controls horizontally within the form.

Column. Places the controls vertically within the form.

Applying Conditions to a Chain

A chain contains conditions for each link in the chain. The conditions are linked to the values being selected in the control object. You may apply multiple conditions to one link. The settings for the condition describe how the link should behave. The following options are available:

- Apply Actions for the links on the chain.
- Apply the Values compare operator for the condition.
- Apply Selected values with a Multiselect operator for the condition.
- Apply the Resolves parameter values for the condition.
- Apply the Compare operator for the condition.

If using static controls, you must apply conditions for each link in the chain. Conditions need to be created for each value of the control chained from, and those values must be mapped to the correct values that will be displayed in the control that it is being changed to.

Reference: Settings Panel (Conditions)

The Settings panel appears when creating a condition for a chain link on the Parameters tab. A chain contains conditions for each link in the chain.

The conditions are linked to the values being selected in the control object. The settings for the condition inherit the values of the prior bound control and provide additional condition settings. This section describes the additional condition settings.

The Settings panel contains the following fields and options when creating a condition:

Conditions

The conditions list enables you to create multiple conditions for the link. Default is the only initial condition.

- To create a new condition, click the New icon. Condition(n) is created, where (n) is the number, and added to the Conditions drop-down list. You may type in a unique condition name, choose Selected values, and set the condition settings.

- Click the Delete icon to remove the selected condition from the list. Note that the Default condition name cannot be deleted.
Actions

Select an action for the chain link to control. The options offer variations to populate, show, hide, execute, and select the values. The list of available options are:

- **Populate, show.** Populates the control and displays it at run time. This is the default action for all conditions.

- **Populate, hide.** Populates the control and does not display it at run time.

- **Populate with alternate, show.** Populates the control with alternate values derived from a procedure, or value list, that is not the default and displays the control at run time.

- **Populate with alternate, hide.** Populates the control with alternate values derived from a procedure, or value list, that is not the default and does not display the control at run time.

- **Show.** Shows the control, but does not populate it.

- **Hide.** Hides the control, but does not populate it.

- **Execute.** Executes the bound object. For example, if you bind a control to a Submit button and change the value in the control at run time, the report/chart automatically executes when you change the value, without having to click the Submit button.

- **Select.** Selects the bound object. For example, if you bind a control to a tab item and select a value in the control at run time, the bound object (the tab item) is automatically selected as the active tab on the page.

- **Use As Target.** This action is used in conjunction with a control whose values are procedure names or HTML file names. Selecting this option, binds the control to a frame for the output.

Values compare operator

Values compare operator provides chaining logic scenarios to include such options as Equal, Not Equal, Greater Than, Less Than, and so on. This option sets the condition for how to populate the control being linked to.

*Equal* is the default Values compare operator.

Selected values

Selected values enable you to provide the values used in the condition. When creating a new condition, the Selected values section is activated. You may type selected values in the input box or click the ellipsis button to select values from the list.
The list of values that appears is based on the values of the prior bound control in the chain.

When selected values are entered, the Multiselect operator field is activated.

**Multiselect operator**

The Multiselect operator options are activated when selected values are entered for the condition. Options are *One of* or *All of*. *One of* is based on one of the values shown in the Selected values, being selected in the prior control, in the chain. *All of* is based on the value of all of the Selected values, being selected in the prior control, in the chain.

*One of* is the default multiselect operator.

**Resolves parameter ("To:" field is required)**

*From.* The From field specifies where to get the value used in the To field, if the control being chained from is a map or activeX control.

*To.* The To field is used to dynamically generate the selection list used to populate the control being chained to. This field displays the parameter whose value will drive the condition evaluation. The parameter name linked to the prior control in the chain is displayed by default. The ellipsis button provides a pop-up dialog of the other parameter values (from the report) to be resolved.

**Compare operator**

The compare operator provides parameter chaining logic scenarios to include such options as Equal, Not Equal, Greater Than, Less Than, and so on. This sets the compare operator to populate the control.

*Equal* is the default Compare operator.

**Procedure:** How to Create a New Condition

1. Insert a report with parameters in the HTML canvas.
2. Drag control objects on the Parameters tab to create a chain.
   
   Chains are represented by lines connecting control objects on the Parameters tab.

   Chaining controls will populate parameters with values at run time, based on values selected in prior controls on the chain.

3. Click a link in the chain.

   The Settings panel shows the bound control values and the Default condition settings for the link in the chain.

4. Click the New icon to create a multiple condition for the chain.
Condition \( (n) \) is created, where \( (n) \) is the number, and added to the Conditions drop-down list, and the Selected values section is activated. You may type in a unique condition name.

5. You may type in a unique condition name, choose Selected values, and set the condition settings for the new condition.

6. Optionally, you may click the Delete button to remove the selected condition from the list.

   **Note:** Default, the initial condition, cannot be deleted.

**Procedure:** How to Select the Action for a Condition

1. Insert a report with parameters in the HTML canvas.

2. Drag control objects on the Parameters tab to create a chain.

   Chains are represented by lines connecting control objects on the Parameters tab.

   Chaining controls will populate parameters with values at run time, based on values selected in prior controls on the chain.

3. Click a link in the chain.

4. In the Setting panel, select the action for the condition from the Actions drop-down list. For example, to hide the control being chained to, select Hide.

   *Populate, show* is the default option.

When running the HTML page, the action for the chained control is applied.

**Procedure:** How to Select the Values Compare Operator for a Condition

1. Insert a report with parameters in the HTML canvas.

2. Drag control objects on the Parameters tab to create a chain.

   Chains are represented by lines connecting control objects on the Parameters tab.

   Chaining controls will populate parameters with values at run time, based on values selected in prior controls on the chain.

3. Click a link in the chain.

4. In the Setting panel, select the chaining logic for the parameter being chained to, in the condition, from the Values compare operator drop-down list.

   *Equal* is the default option.

The compare operator is applied to the value selected.
Procedure: How to Apply Selected Values With a Multiselect Operator to a Condition

1. Insert a report with parameters in the HTML canvas.

2. Drag control objects on the Parameters tab to create a chain.
   
   Chains are represented by lines connecting control objects on the Parameters tab.
   
   Chaining controls will populate parameters with values at run time, based on values selected in prior controls of the chain.

3. Click a link in the chain.

4. In the Settings panel, click the New icon to create a multiple condition for the chain.
   
   Condition(n) is created, where (n) is the number, and added to the Conditions drop-down list, and the Selected values section is activated. You may type in a unique condition name.

5. You may type selected values in the input box or click the ellipsis button to select values from the list.
   
   The list of values that appears is based on the values of the prior bound control in the chain.

   **Tip:** You may also use the pop-up icons to select a field and close the pop-up dialog box. The green icon is OK, the red icon is Cancel, double-clicking a value will select the value and close the dialog box without using any button, and pressing the Esc key will cancel the dialog box without using any button.

   When selected values are entered, the Multiselect operator field is activated.

6. Select the chaining logic for the selected values from the Multiselect operator drop-down list.

   - **One of** is based on one of the values shown in the Selected values, being selected in the prior control, in the chain. This is the default selection.

   - **All of** is based on the value of all of the Selected values, being selected in the prior control, of the chain.

   The selected values and multiselect operator are applied to the condition.
**Procedure:** How to Resolve Parameters for a Condition

It is recommended that you populate the controls first, before chaining. When you populate first, certain information is obtained that allows the determination of the best choice for *Resolves parameter*. If you chain first and then populate, the information cannot be obtained because the chaining is already established. If you chain first, you must manually set *Resolves parameter*.

1. Insert a report with parameters in the HTML canvas.
2. Drag control objects on the Parameters tab to create a chain.
   
   Chains are represented by lines connecting control objects on the Parameters tab.
   
   Chaining controls will populate parameters with values at run time, based on values selected in prior controls on the chain.
3. Click a link in the chain.
4. In the Setting panel, click the *Resolves parameter* ellipsis button to select a parameter name to resolve. If a custom procedure that has a filter (or filters) populates the control, the values list shows the parameters from the filters. If a data source populates the control, the values list shows all of the fields from the data source shown in the Object Inspector.

The value in the Resolves parameter field should be either:

- The field name that limits the values for the next control in the chain, if a data source populates the control.
- The parameter name from the procedure, if a procedure populates the control.

In most cases, this value will be populated by default and will not need to be changed.

**Tip:** You may also use the pop-up icons to select a field and close the pop-up dialog box. The green icon is OK, the red icon is Cancel, double-clicking a value will select the value and close the dialog box without using any button, and pressing the Esc key will cancel the dialog box without using any button.

The parameter value is resolved in the chain if no filter is specified.
Procedure: How to Select the Compare Operator for the Parameter

An example of when to apply chaining logic is when a form offers two lists of dates so that you can select a FROM/TO date range. By chaining these parameters together and applying the Greater than parameter compare operator, this ensures that when a date is selected for the FROM parameter, only dates that follow the FROM date display in the TO date control, eliminating the possibility of selecting an invalid date range.

1. Insert a report with parameters in the HTML canvas.
2. Drag control objects on the Parameters tab to create a chain.
   
   Chains are represented by lines connecting control objects on the Parameters tab.
   
   Chaining controls will populate parameters with values at run time, based on values selected in prior controls on the chain.
3. Click a link in the chain.
4. In the Setting panel, select the chaining logic option from the Compare operator drop-down list. This sets the compare operator to populate the control.

   Equal is the default option.

The compare operator is applied to the parameter selected.

Procedure: How to Enable Cache Processing for Chained Values

You may enable cache processing for chained values in two ways:

- Enable the caching option for the HTML page and all objects on the page.
- Enable cache run time data for a dynamic control or a condition.

A chain contains conditions for each link in the chain. The conditions are linked to the values being bound to the control object. If you change the options for the condition, it will also be applied to the control, and vice versa.

Caching options are turned off by default.

1. To enable caching options for all objects on the HTML page, in the App Studio Options dialog box:
   
   - Select the HTML Page tab.
   - Select Default caching option.
   - Click OK to close the App Studio Options dialog box.
2. To enable caching options for a dynamic control or condition:
A chain contains conditions for each link in the chain. The conditions are linked to the values being chained to the control object. If you change the options for the condition, it will also be applied to the control, and vice versa.

**For a dynamic control:**

1. Create a dynamic input control to supply parameter values.
2. Select the dynamic control object from the Parameters tab.
   The Settings panel opens, showing the dynamic control options.
3. Select *Cache run time data* to cache the run time data for the selected input control.
   **Note:** This setting overrides the *Default caching option* from the HTML Page tab, in the App Studio Options dialog box.
4. Select the center of the control object and drag the control to the center of the next control object.
   When binding controls, the conditions inherit the values set in the dynamic control settings.

**For a dynamic condition:**

1. Click a link on the chain to open the Settings panel for the condition.
2. Select *Cache run time data* to cache the run time data for the selected input control.
   This option is only available for dynamic controls.
   **Note:** This setting overrides the *Default caching option* from the HTML Page tab, in the App Studio Options dialog box.
   When running the HTML page, data for the chained value is cached to improve performance.

**Using JavaScript Code with HTML Canvas Pages**

Although the HTML canvas is fully integrated with JavaScript, it is suggested that you do not create custom JavaScript that manipulates the HTML canvas generated controls, as WebFOCUS cannot support such custom JavaScript code. Additionally, there is no guarantee that the JavaScript code will work correctly in future releases.

**Note:**

- The HTML canvas run time is a set of JavaScript files. You should not be calling the functions within them directly. Should you call these functions directly, your code may not function in future releases and Information Builders cannot be held responsible.
If you want JavaScript to run after a page loads completely, but before any reports are executed, you need to create a function called onInitialUpdate (this function was called onInitialUpdate() in previous releases). If you have another function, in that function, you can call IbComposer_onInitialUpdate(). Your code should be added inline in the HTML file after the line:

```javascript
//End function window_onload
```

The HTML canvas run time will call onInitialUpdate() if it exists.

**Function: IbComposer_removeSelectOption**

IbComposer_removeSelectOption removes values from a listbox, drop down, or the 'from' listbox of a double list control.

**Syntax:** How to Remove Listbox or Drop Down Values

```javascript
IbComposer_removeSelectOption(controlID, arr[]);
```

- **controlID**
  - Alphanumeric
  - Is the unique identifier of the control from which values are obtained.

- **arr[]**
  - Alphanumeric Array
  - Is the array that contains single or multiple values.

**Note:** When the IbComposer_removeSelectOption method is called, the values specified by the second parameter (arr[]) will be removed.

**Example:** Removing Values From a Listbox

```javascript
function button1_onclick(event) {
    var eventObject = event ? event : window.event;
    var ctrl = eventObject.target ? eventObject.target : eventObject.srcElement;
    // TODO: Add your event handler code here
    var readVals = [];
    readVals = IbComposer_getCurrentSelection('listbox1');
    IbComposer_removeSelectOption('combobox1',readVals);
}
```
Function: IbComposer_runAnimation

IbComposer_runAnimation runs the animation defined by the user in the Tasks and Animations panel.

Syntax: How to Run an Animation

IbComposer_runAnimation(name);

name
Alphanumeric

Is the name of the animation specified by the user in the Tasks and Animations panel.

Example: Running an Animation

function submit1_onclick(event) {
  IbComposer_runAnimation('animation1');
}

Function: IbComposer_triggerExecution

IbComposer_triggerExecution allows the user to execute a specific task defined in the Tasks section of the Tasks and Animations panel.

Syntax: How to Execute a Specific Task

IbComposer_triggerExecution(taskName, index [, paramName, paramValue]);

where:

taskName
Alphanumeric

Is the name of the task specified by the user in the Tasks section of the Tasks and Animations panel in the HTML canvas.

index
Numeric

Is the index value of the action assigned to the task that you want to execute. The first action has an index value of 1, the second an index value of 2, and so on.

paramName, paramValue
Alphanumeric
Optionally, are the name and value of a parameter to be applied when the task is executed. You can specify multiple parameters by using multiple name-value pairs.

**Example:** Executing a Task

The following example executes the first task, called task1, when a button called submit1 is clicked.

```javascript
function submit1_onclick(event) {
    IbComposer_triggerExecution('task1',1);
}
```

**Example:** Executing a Task From a Procedure

The following syntax appears in the StyleSheet section of a report procedure. It creates a JavaScript drilldown, launched from a menu item labeled Drill to InfoWindow, that uses the IbComposer_triggerExecution function to execute a task called task2, which has an index value of 1. It sets the value of the parameter &BUSINESS_SUB_REGION to the value selected from the first column in the report (N1). The report is loaded in a frame on the page, as identified by ib_frameName, that has the unique identifier report1.

```plaintext
TYPE=DATA,
COLUMN=N1,
DRILLMENUITEM='Drill to InfoWindow',
    JAVASCRIPT=parent.IbComposer_triggerExecution( 'task2' \
        '1' \
        'BUSINESS_SUB_REGION' \
        N1 \
        'ib_frameName' \
        'report1' \
    ),
    TARGET=_parent,
$
```

The report can then be added to an HTML page in a report component called report1. You can then create a task called task2, which is the first task after the load task, in the Tasks & Animations panel. Use a Trigger Type of TBD to set the task to execute when a drill-down link in the report is clicked. You can then specify a request in the Requests/Actions section to be executed using the selected parameter value when a drill-down link is clicked.

**Function: IbComposer_getRequestRefProcedure**

IbComposer_getRequestRefProcedure returns the name of the procedure, given the unique identifier of the request referencing the procedure. This was formerly available in the myXmlRoot document.
Syntax: How to Return the Procedure Name

```javascript
IbComposer_getRequestRefProcedure(Drilldown);
```

where:

- **Drilldown**
  - Alphanumeric
  - Is the name of the request provided.

Example: Returning a Procedure Name

```javascript
function button1_onclick(event) {
    IbComposer_getRequestRefProcedure('Drilldown');
}
```

Function: IbComposer_getRequestTarget

IbComposer_getRequestTarget returns the name of all the target frames used by the request. This was formerly available in the myXmlRoot document.

Syntax: How to Return the Target Frame Names

```javascript
IbComposer_getRequestTarget(Drilldown,bShow);
```

where:

- **Drilldown**
  - Alphanumeric
  - Is the name of the request provided.

- **bShow**
  - Boolean
  - Is an operator that can be set to true to show the names, or set to false to hide them.

Example: Returning Target Frame Names

```javascript
function button1_onclick(event) {
    IbComposer_getRequestTarget('Drilldown','true');
}
```
Function: IbComposer_getMapObject

IbComposer_getMapObject returns the map object for the map container that is passed as the parameter. This object can then be used as a parameter in other API functions.

Syntax: How to Return a Map Object

IbComposer_getMapObject(mapId);

where:

mapId
Alphanumeric
Is the unique identifier of the map container.

Example: Returning the Map Object for a Map

function onInitialUpdate() {
  var map = IbComposer_getMapObject('mapcontrol1');
}

Function: IbComposer_getMarkers

IbComposer_getMarkers returns an array of markers for a specific layer of a map.

Syntax: How to Return an Array of Markers for a Map

IbComposer_getMarkers(mapId, layerName);

where:

mapId
Alphanumeric
Is the unique identifier of the map container.

layerName
Alphanumeric
Is the name of the layer for which the markers are returned.
Example: Returning an Array of Markers for a Map

```javascript
function onInitialUpdate() {
    var map = IbComposer_getMapObject('mapcontrol1');
    var markers = IbComposer_getMarkers('mapcontrol1','Customers');
}
```

Function: IbComposer_populateDynamicCtrl

IbComposer_populateDynamicCtrl allows you to determine from which control data is drawn from to populate a destination control.

Syntax: How to Populate a Control Dynamically

```javascript
IbComposer_populateDynamicCtrl(controlID, fromControlId);
```

where:

- `controlID`
  - Alphanumeric
  - Is the unique identifier of the control from which values are obtained.

- `fromControlId`
  - Alphanumeric
  - Is the unique identifier of the control from which values are obtained, when two or more controls are chained to a destination control. For example, if listbox1 and listbox2 are both chained to listbox3, by default, the values of listbox3 will be determined by listbox1. You can use IbComposer_populateDynamicCtrl('listbox3','listbox2') to make listbox2 determine the values of listbox3. This identifier is optional.

Example: Populating a Control Dynamically

```javascript
function button3_onclick(event) {
    var acc = IbComposer_populateDynamicCtrl('listbox3','listbox2');
    acc.selectNextPage();
}
```

Function: IbComposer_getComponentById

IbComposer_getComponentById obtains a component by using its ID.

Syntax: How to Obtain a Component by Using Its ID

```javascript
IbComposer_getComponentById(controlID);
```
where:

c\textit{controlID}

Alphanumeric

Is the unique identifier of the control from which values are obtained.

\textbf{Example:} Obtaining the Accordion Report By Using Its ID

\begin{verbatim}
function button3_onclick(event) {
    var acc = IbComposer_getComponentById('accordion1');
    acc.selectNextPage();
}
\end{verbatim}

Function: \textit{IbComposer\_getCurrentSelection}

\textit{IbComposer\_getCurrentSelection} retrieves the current selected values from a control.

\textbf{Syntax:} How to Retrieve the Current Selected Value From a Control

\begin{verbatim}
IbComposer_getCurrentSelection(controlID,[layer],[bDateObj]);
\end{verbatim}

where:

\textit{controlID}

Alphanumeric

Is the unique identifier of the control from which values are obtained.

\textit{layer}

Integer

Is an optional parameter used to specify the layer number in a Multi source Tree control if a Multi source Tree control is being used. The layer number starts with 1 for the first layer.

\textit{bDateObj}

Boolean

Is an optional operator that can be set to true to return a date object or to false to return a string. If you do not specify a value for this operator, it returns a string.
Example: Retrieving the Current Selected Value for a Drop Down List

function button1_onclick(event) {
    var values = IbComposer_getCurrentSelection('combobox1');
    for(var i = 0; i < values.length; i++)
        alert(values[i]);
}

Function: IbComposer_getCurrentSelectionEx

IbComposer_getCurrentSelectionEx retrieves the current selected actual or display values from a control. The function can also be used to get the index values for List Boxes, Drop Down Lists, and Double Lists.

Syntax: How to Retrieve the Current Selected Value, Actual Value, or Display Value From a Control

IbComposer_getCurrentSelectionEx(controlID,[layer]);

where:

controlID

Alphanumeric

Is the unique identifier of the control from which values are obtained.

dLayer

Integer

Is an optional parameter used to specify the layer number in a Multi source Tree control if a Multi source Tree control is being used. The layer number starts with 0 for the first layer.

Example: Retrieving the Current Selected Index Value, Actual Value, and Display Value for a Multi-Select List

function button1_onclick(event) {
    var values = IbComposer_getCurrentSelectionEx('combobox1');
    for(var i = 0; i < values.length; i++)
        {alert("Index Value: " + values[i].getIndex() + "\n" +
            "Actual Value: " + values[i].getValue() + "\n" +
            "Display Value: " + values[i].getDisplayValue());
    }

Function: IbComposer_getClickedRow

IbComposer_getClickedRow retrieves the current clicked row of an HTML table.
Syntax: How to Retrieve the Current Clicked Row of an HTML Table

IbComposer_getClickedRow(clickEventTarget);

where:

clickEventTarget

Alphanumeric

Is the name of the event for the clicked row.

Example: Retrieving the Current Clicked Row of an HTML Table

function IbComposer_getClickedRow(clickEventTarget) {
    return getCurrentClickedRow(clickEventTarget);
}

Function: IbComposer_getClickedColumn

IbComposer_getClickedColumn retrieves the current clicked column of an HTML table.

Syntax: How to Retrieve the Current Clicked Column of an HTML Table

IbComposer_getClickedColumn(clickEventTarget);

where:

clickEventTarget

Alphanumeric

Is the name of the event for the clicked column.

Example: Retrieving the Current Clicked Column of an HTML Table

function IbComposer_getClickedColumn(clickEventTarget) {
    return getCurrentClickedColumn(clickEventTarget);
}

Function: IbComposer_getClickedCellValue

IbComposer_getClickedCellValue retrieves the current clicked cell value of an HTML table.

Syntax: How to Retrieve the Current Clicked Cell Value of an HTML Table

IbComposer_getClickedCellValue(clickEventTarget);
where:

`clickEventTarget`

Alphanumeric

Is the name of the event for the clicked cell.

**Example:** Retrieving the Current Clicked Cell Value of an HTML Table

```javascript
function IbComposer_getClickedCellValue(clickEventTarget) {
    return getClickedCellValue(clickEventTarget);
}
```

**Function: IbComposer_setCurrentSelection**

`IbComposer_setCurrentSelection` sets the current selected values for control parameters.

**Syntax:** How to Set the Current Selected Value for a Control

```javascript
IbComposer_setCurrentSelection(controlID, arrValues, bUpdateDependencies);
```

where:

`controlID`

Alphanumeric

Is the unique identifier of the control for which to set the values.

`arrValues`

Array

Is the array of values to be set.

`bUpdateDependencies`

Boolean

Is an operator that can be set to true to update chained controls and triggered events. The default is false.

**Example:** Setting the Current Selected Value for a List Box

The following example selects the values ITALY and JAPAN from a multiselect list box called `listbox1`.
function button1_onclick(event) {
    var arr = [];
    arr.push('ITALY');
    arr.push('JAPAN');
    IbComposer_setCurrentSelection('listbox1', arr, 'false');
}

Function: IbComposer_setCurrentSelection2

IbComposer_setCurrentSelection2 sets the current selected values for radio button and check box controls using an index value.

Syntax: How to Set the Current Selected Value for a Radio Button or Check Box Control

IbComposer_setCurrentSelection2(controlID, index, bUpdateDependencies);

where:

controlID

    Alphanumeric

    Is the unique identifier of the control for which to set the values.

index

    Numeric

    The index value of the item to select. The first item in the control object has an index value of 0.

bUpdateDependencies

    Boolean

    Is an operator that can be set to true to update chained controls and triggered events. The default is false.

Example: Setting the Current Selected Value for a List Box

The following example uses a button called button1 to select the third value, indicated by the index value of 2, in a radio button control called radio1.

function button1_onclick(event) {
    var eventObject = event ? event : window.event;
    var ctrl = eventObject.target ? eventObject.target : eventObject.srcElement;
    // TODO: Add your event handler code here
    IbComposer_setCurrentSelection2("radio1",2,false);
}
Function: IbComposer_execute

IbComposer_execute executes a report or chart.

Syntax: How to Execute a Report or Chart

IbComposer_execute(reportID, [outputTarget]);

where:

reportID

Alphanumeric

Is the unique identifier of the report or chart to execute.

outputTarget

Alphanumeric

Is the optional parameter to set the target of the output. Is one of the following:

- The name of a frame.
- `_blank`.
- `_target`.
- The name of a new window.

Example: Executing a Report in a New Window

function button3_onclick(event) {
    IbComposer_execute('report1','newwin');
}

Function: IbComposer_isSelected

IbComposer_isSelected determines if a control or value is selected.

Syntax: How to Determine If a Control or Value Is Selected

IbComposer_isSelected(controlID, [testValue]);

where:

controlID

Alphanumeric

Is the unique identifier of the control being tested.
testValue

Alphanumeric

Is the optional parameter the control is being checked against.

**Example:**  Determining If a Check Box Is Selected

```javascript
function checkbox1_onclick(event) {
    var curValue = IbComposer_isSelected('checkbox1');
    IbComposer_showHtmlElement('form1', curValue);
}
```

**Function: IbComposer_showHtmlElement**

IbComposer_showHtmlElement shows or hides an HTML element.

**Syntax:**  How to Show or Hide an HTML Element

```javascript
IbComposer_showHtmlElement(elementID, bShow);
```

where:

- **elementID**
  - Alphanumeric
  - Is the unique identifier of the element which is shown or hidden.

- **bShow**
  - Boolean
  - Is an operator that can be set to true to show the element and false to hide it.

**Example:**  Showing or Hiding a Check Box

```javascript
function checkbox1_onclick(event) {
    var curValue = IbComposer_isSelected('checkbox1');
    IbComposer_showHtmlElement('form1', curValue);
}
```

**Function: IbComposer_enableHtmlElement**

IbComposer_enableHtmlElement enables or disables an HTML element.

**Syntax:**  How to Enable or Disable an HTML Element

```javascript
IbComposer_enableHtmlElement(elementID, bEnable);
```
where:

\textit{elementID}

Alphanumeric

Is the unique identifier of the element which is enabled or disabled.

\textit{bEnable}

Boolean

Is an operator that can be set to true to enable the element and false to disable it.

\textbf{Example: Enabling or Disabling Elements}

\begin{verbatim}
function checkbox2_onclick(event) {
    IbComposer_enableHtmlElement('listbox1',
    IbComposer_isSelected('checkbox2', 'country'));
    IbComposer_enableHtmlElement('combobox1',
    IbComposer_isSelected('checkbox2', 'car'));
    IbComposer_enableHtmlElement('listbox2',
    IbComposer_isSelected('checkbox2', 'model'));
    IbComposer_enableHtmlElement('combobox2',
    IbComposer_isSelected('checkbox2', 'dcost'));
}
\end{verbatim}

\textbf{Function: IbComposer_ResetDownChainControls}

\texttt{IbComposer_ResetDownChainControls} resets the controls down the chain from the current control to have correct corresponding values.

\textbf{Syntax: How to Reset Chain Controls}

\begin{verbatim}
IbComposer_ResetDownChainControls(\textit{ctrl});
\end{verbatim}

where:

\textit{ctrl}

Alphanumeric

Is the unique identifier of the first control.

\textbf{Example: Resetting the Chain Started by a List Box}

\begin{verbatim}
function button4_onclick(event) {
    var arr = []; arr.push('ENGLAND');
    IbComposer_setCurrentSelection('listbox1', arr, 'false');
    IbComposer_ResetDownChainControls('listbox1');
}
\end{verbatim}
**Function: IbComposer_selectTab**

IbComposer_selectTab selects the tab specified by the tabNumberToSelect and makes it the active tab.

**Syntax:** How to Select a Tab and Make It Active

IbComposer_selectTab(tabControlID,tabNumberToSelect);

where:

*tabControlID*

Alphanumeric

Is the unique identifier of the tab control being made active.

*tabNumberToSelect*

Integer

Is the number of the tab to make active.

**Example:** Making a Tab Active

```html
<FORM id=form1 onsubmit="OnExecute(this);
     IbComposer_selectTab('tab1',1) name="form1">
</FORM>
```

**Function: IbComposer_selectTemplateTab**

IbComposer_selectTemplateTab selects a tab on a template page and makes it the active tab.

**Syntax:** How to Select a Template Tab and Make It Active

IbComposer_selectTemplateTab(tabId);

where:

*tabId*

Alphanumeric

Is the unique identifier of the tab control being made active.

**Example:** Making a Template Tab Active

```javascript
function submit1_onclick(event) {
    IbComposer_selectTemplateTab('tab5');
}
```
Function: IbComposer_goToPageOfMultiPageControl

IbComposer_goToPageOfMultiPageControl selects a page in a multipage control, such as a tab, accordion, or window.

Syntax: How to Select a Page in a Multipage Control

IbComposer_goToPageOfMultiPageControl(controlID, page)

where:

controlID
Alphanumeric
Is the unique identifier of the control from which values are obtained.

page
Alphanumeric
Specifies a page number (for example 1, 2, and so on), or true for the previous page and false for the next page.

Example: Selecting a Page for a Multipage Control

The following example shows how to select a page in a window multipage control. In this example, the control will start on page 3.

```javascript
function button2_onclick(event) {
    var eventObject = event ? event : window.event;
    var ctrl = eventObject.target ? eventObject.target : eventObject.srcElement;
    // TODO: Add your event handler code here
    IbComposer_goToPageOfMultiPageControl('windowPanel1', '3');
}
```

The following example shows how to select the previous page in a window multipage control.

```javascript
function button2_onclick(event) {
    var eventObject = event ? event : window.event;
    var ctrl = eventObject.target ? eventObject.target : eventObject.srcElement;
    // TODO: Add your event handler code here
    IbComposer_goToPageOfMultiPageControl('windowPanel1', 'true');
}
```

The following example shows how to select the next page in a window multipage control.
function button2_onclick(event) {
    var eventObject = event ? event : window.event;
    var ctrl = eventObject.target ? eventObject.target : eventObject.srcElement;
    // TODO: Add your event handler code here
    IbComposer_goToPageOfMultiPageControl('windowPanel1', 'false');
}

Function: IbComposer_getAllAmpersValues

IbComposer_getAllAmpersValues is used to retrieve the current selected values from all the
controls on your page layout. It then takes those values and assembles them as a string that
can be added to the end of a URL call. An example of this would be having a REGION control
and multiselecting MidEast, NorthEast, and NorthWest. It will assemble these selections as
shown below:

&REGION='%27MidEast%27%20OR%20%27NorthEast%27%20OR%20%27NorthWest%27

This function can be used in conjunction with the Business Intelligence Portal, where the
generated string is appended to all Business Intelligence Portal calls that run reports or charts.
This allows the parameter values to affect all portal components, even if new ones are added
or existing ones are removed at run time.

Syntax: How to Retrieve all Parameter Values

IbComposer_getAllAmpersValues([verifySelection]);

where:

verifySelection

Boolean

Is an optional parameter. When true and when the Selection required property for the
control is set to Yes, this returns an empty string for the parameter controls that do not
have a selection made.

Note: All controls have the Selection required property. This property is set to Yes by
default. If a control has no valid selection made at run time, a red box appears around it
and the following status bar message displays:

Please make required selections
**Example:** Retrieving a List of All Parameters Selected in a Report

```javascript
function button1_onclick(event) {
    var val = IbComposer_getAllAmpersValues();
    alert(val);
    OnExecute(event);
}
```

**Function:** IbComposer_showLayer

IbComposer_showLayer shows or hides the specified layer.

**Syntax:** How to Show or Hide a Layer

```javascript
IbComposer_showLayer(layerName, bShow);
```

where:

- **layerName**
  - Alphanumeric
  - Is the name of the layer, which will be shown or hidden.

- **bShow**
  - Is an operator that can be set to true to show the layer or false to hide it.

**Example:** Showing or Hiding a Layer

```javascript
function button1_onclick(event) {
    var eventObject = event ? event : window.event;
    var ctrl = eventObject.target ? eventObject.target : eventObject.srcElement;
    // TODO: Add your event handler code here
    IbComposer_showLayer('Customers','true');
}
```

**Function:** IbComposer_toggleMapLayer

IbComposer_toggleMapLayer toggles the visibility of the specified layer.

**Syntax:** How to Toggle Map Layer Visibility

```javascript
IbComposer_toggleMapLayer(mapId, layerName);
```

where:

- **mapId**
  - Alphanumeric
Is the unique identifier of the map control.

*layerName*

Alphanumeric

Is the unique identifier of a layer within the map.

**Example:** Toggling Map Layer Visibility

```javascript
function button1_onclick(event) {
    var eventObject = event ? event : window.event;
    var ctrl = eventObject.target ? eventObject.target :
                     eventObject.srcElement;
     // TODO: Add your event handler code here
    IbComposer_toggleMapLayer('mapcontrol1','Customers');
}
```

**Function: IbComposer_toggleMapMarker**

IbComposer_toggleMapMarker toggles the visibility of the specified marker.

**Syntax:** How to Toggle Map Marker Visibility

```javascript
IbComposer_toggleMapMarker(mapId,layerName,markerName);
```

where:

*mapId*

Alphanumeric

Is the unique identifier of the map control.

*layerName*

Alphanumeric

Is the unique identifier of a layer within the map.

*markerName*

Alphanumeric

Is the unique identifier of a marker within the map.
**Example:** Toggling Map Marker

```javascript
function button1_onclick(event) {
    var eventObject = event ? event : window.event;
    var ctrl = eventObject.target ? eventObject.target :
        eventObject.srcElement;
    // TODO: Add your event handler code here
    IbComposer_toggleMapMarker('mapcontrol1','Stores','EMart');
}
```

**Function: IbComposer_refreshMapLayer**

IbComposer_refreshMapLayer refreshes the specified layer from the database.

**Syntax:** How to Refresh a Map Layer

```
IbComposer_refreshMapLayer(mapId,layerName);
```

where:

- **mapId**
  - Alphanumeric
  - Is the unique identifier of the map control.

- **layerName**
  - Alphanumeric
  - Is the unique identifier of a layer within the map.

**Example:** Refreshing the Layer

```javascript
function button1_onclick(event) {
    var eventObject = event ? event : window.event;
    var ctrl = eventObject.target ? eventObject.target :
        eventObject.srcElement;
    // TODO: Add your event handler code here
    IbComposer_refreshMapLayer('mapcontrol1','Customers');
}
```

**Function: IbComposer_panToAddress**

IbComposer_panToAddress allows the user to pan to the point on a map for the specified address and zoom level.

**Syntax:** How to Pan to an Address

```
IbComposer_panToAddress(address,mapId,zoom);
```
where:

**address**

Alphanumeric

Is the address you want to pan to.

**mapId**

Alphanumeric

Is the unique identifier of the map control.

**zoom**

Integer

Is how much you wish to zoom.

**Example:** Panning to an Address

```javascript
function button1_onclick(event) {
  var eventObject = event ? event : window.event;
  var ctrl = eventObject.target ? eventObject.target :
    eventObject.srcElement;
  // TODO: Add your event handler code here
  IbComposer_panToAddress('2 Penn Plaza, NY, NY', 'mapcontrol1', 10);
}
```

**Function:** `ibComposer_panToPoint`

`ibComposer_panToPoint` allows the user to pan to the point on a map for the specified coordinates and zoom level.

**Syntax:** How to Pan to a Point

```javascript
IbComposer_panToPoint(lat, long, mapId, zoom);
```

where:

**lat**

Integer

Is the latitude coordinate of the point you want to pan to.

**long**

Integer

Is the longitude coordinate of the point you want to pan to.
mapId

Alphanumeric

Is the unique identifier of the map control.

zoom

Integer

Is how much you wish to zoom.

**Example:** Panning to a Point

```javascript
function button1_onclick(event) {
    var eventObject = event ? event : window.event;
    var ctrl = eventObject.target ? eventObject.target :
        eventObject.srcElement;
    // TODO: Add your event handler code here
    IbComposer_panToPoint(37.0625,-95.677068,'mapcontrol1',5);
}
```

**Function: IbComposer_preventModifyIFrameDocument**

IbComposer_preventModifyIFrameDocument can prevent CSS modification of any iframe within a document, by calling it from onInitialUpdate.

**Syntax:** How to Prevent Modification of a Document within an IFrame

```javascript
function onInitialUpdate() {
    IbComposer_preventIFrameUpdates();
}
```

**Function: IbComposer_showAllMapMarkers**

IbComposer_showAllMapMarkers displays all markers for the specified layer.

**Syntax:** How to Show All Map Markers

```javascript
IbComposer_showAllMapMarkers(mapId,layerName);
```

where:

mapId

Alphanumeric

Is the unique identifier of the map control.

layerName

Alphanumeric
Is the unique identifier of a layer within the map.

**Example:** Showing All Map Markers

```javascript
function button1_onclick(event) {
  var eventObject = event ? event : window.event;
  var ctrl = eventObject.target ? eventObject.target : eventObject.srcElement;
  // TODO: Add your event handler code here
  IbComposer_showAllMapMarkers('mapcontrol1', 'Customers');
}
```

**Function:** IbComposer_drawBullseye

IbComposer_drawBullseye draws a bullseye at a point on the map. This function has optional parameters to select whether to display markers, the units of measure used for the bullseye, the number of rings, the size of the rings, and the color of the rings.

**Syntax:** How to Draw a Bullseye

```javascript
IbComposer_drawBullseye(mapId, lat, long, selectmarkers, units, rings, [list-of-sizes], [list-of-colors]);
```

where:

- **mapId**
  - Alphanumeric
  - Is the unique identifier of the map control.

- **lat**
  - Integer
  - Is the latitude coordinate of the point you want to pan to.

- **long**
  - Integer
  - Is the longitude coordinate of the point you want to pan to.

- **selectmarkers**
  - Boolean
  - Is an operator that, when set to true, selects all markers within the Bullseye.

- **units**
  - Alphanumeric
The unit of measure for the Bullseye rings.

*rings*

Integer

The number of rings the bullseye uses.

*list-of-sizes*

Integer

Is an optional parameter, as a comma (,) separated list of sizes for the bullseye rings. For example, 1, 3, 5.

*list-of-colors*

Alphanumeric

Is an optional parameter, as a comma (,) separated list of colors for the bullseye rings. The colors can be RGB values or hexadecimal values. For example, Blue or #FFFF.

**Example:** Drawing a Bullseye

```javascript
function button1_onclick(event) {
  var eventObject = event ? event : window.event;
  var ctrl = eventObject.target ? eventObject.target : eventObject.srcElement;
  // TODO: Add your event handler code here
  IbComposer_drawBullseye('mapcontrol1', 37.0625, -95.677068, true, 'mi', 3);
}
```

**Function:** IbComposer_setCalendarDatesRange

IbComposer_setCalendarDatesRange sets the range for the target calendar, given the date on the source calendar and a range in days.

**Syntax:** How to Set a Date Range for a Target Calendar

```javascript
IbComposer_setCalendarDatesRange(elementId, fromDate, toDate)
```

where:

*elementID*

Alphanumeric

Is the unique identifier of the target calendar control for which you want to set the date range.
**fromDate**

Date object

Is the value of the date from the source calendar.

**Note:** This can be obtained by using the `IbComposer_getCurrentSelection` function. This function should have the third parameter set to True to return a Date object.

**toDate**

Date object

This value must be calculated using `fromDate` and the number of days needed to show the range.

**Example:**  
**Setting the Date Range for a Target Calendar**

```javascript
function button1_onclick(event) {
    var eventObject = event ? event : window.event;
    var ctrl = eventObject.target ? eventObject.target : eventObject.srcElement;
    // TODO: Add your event handler code here
    var curDate = IbComposer_getCurrentSelection('calendar1', 0, true);
    var fromDate = new Date(curDate);
    var toDate = new Date();
    var nOfDays = IbComposer_getCurrentSelection('slider1');
    if (!isNaN (nOfDays - 0) && nOfDays != null) {
        alert("Please enter a numeric value!!");
    } else {
        var time = fromDate.getTime() + (nOfDays * 3600000 * 24);
        toDate.setTime(time);
        IbComposer_setCalendarDatesRange("calendar2", fromDate, toDate);
    }
}
```

**Function: IbComposer_goToPortalPage**

You can use the `IbComposer_goToPortalPage` function to navigate to a specified page within the same a collaborative portal. Create an HTML page with a trigger for the `IbComposer_goToPortalPage` function, configure the `IbComposer_goToPortalPage` function to target a portal page, and add the HTML page to a portal page in the same collaborative portal as the targeted portal page.

**Reference:**  
How to Navigate to a Page in a Collaborative Portal

```javascript
IbComposer_goToPortalPage("Page_Name");
```
where:

*Page_Name*

Alphanumeric

Is the name of another portal page within the same collaborative portal as the HTML page containing the `IbComposer_goToPortalPage` function, in double quotation marks.

Make sure to type the portal page name instead of the title. You can see the name of a portal page in the Name field of the File/Folder Properties panel in App Studio. Do not include the .page extension in the `IbComposer_goToPortalPage` function.

**Example:** Navigating to a Page in a Collaborative Portal

In the following example, clicking a button with the unique identifier button1, which is available on a portal page, opens the page named `Page_1`, contained in the same collaborative portal.

```javascript
function button1_onclick(event) {
  var eventObject = event ? event : window.event;
  var ctrl = eventObject.target ? eventObject.target : eventObject.srcElement;
  // TODO: Add your event handler code here

  IbComposer_goToPortalPage("Page_1");
}
```

**Function:** IbComposer_isSelectionRequired

The `IbComposer_isSelectionRequired` function allows you to determine whether a selection is required for a specified control. If selection is required from the control, the HTML element is returned. If selection is optional, null is returned.

**Reference:** How to Determine if Selection Is Required

```javascript
IbComposer_isSelectionRequired("controlId");
```

where:

*controlId*

Alphanumeric

Is the unique identifier of the control whose status you are checking.
**Example:** Determining if Selection Is Required

In the following example, clicking a button with the unique identifier button1 displays a message that says whether a selection is required in combobox1, based on the value returned by `IbComposer_isSelectionRequired`. Since the item being checked is an HTML select element, the message is different depending on whether the returned value is `[object HTMLSelectElement]` or null.

```javascript
function button1_onclick(event) {
  var eventObject = event ? event : window.event;
  var ctrl = eventObject.target ? eventObject.target : eventObject.srcElement;
  // TODO: Add your event handler code here
  var required = IbComposer_isSelectionRequired("combobox1")
  if (required == "[object HTMLSelectElement]") {
    alert("Selection is required")
  }
  else if (required == null) {
    alert("No selection required")
  }
}
```

**Function: IbComposer_getNumberOfRecordsReturned**

The `IbComposer_getNumberOfRecordsReturned` function produces the number of records returned by a request executed by an Ajax call. To use the `IbComposer_getNumberOfRecordsReturned` function, create a task that executes a request using an Ajax call. The value in the Function name field for the task, in the Tasks & Animations panel, should be the name of the callback function. This function and the `IbComposer_getNumberOfRecordsReturned` function should have the same result object as an argument.

**Reference:** How to Return the Number of Records in a Request

```javascript
IbComposer_getNumberOfRecordsReturned(resultObject);
```

where:

- `resultObject`
  - Alphanumeric
    - Is a result object that matches the argument of the callback function for the Ajax call.
Example: Returning the Number of Records in a Request

For the following example, a task has been created in the Tasks & Animations panel to execute an external procedure request, with Ajax call set as the Target type. The Ajax call is specified to use a callback function named showResult. The showResult function then passes the value, called result, to the IbComposer_getNumberOfRecordsReturned function, the resulting value of which is shown in a message. This value is the number of records in the request.

```javascript
function showResult(result)
{
    alert(IbComposer_getNumberOfRecordsReturned(result));
}
```

Function: IbComposer_doSelectionByTableRow

The IbComposer_doSelectionByTableRow function returns the values of specified fields in the selected row of a table. You can use another JavaScript function, such as IbComposer_setCurrentSelection, to enable selection values in the table.

Reference: How to Retrieve Values From a Selected Row in a Table

```javascript
IbComposer_doSelectionByTableRow("tableId", fieldnames, setSelection, displayOnly);
```

where:

- **tableId**
  - Alphanumeric
  - Is the unique identifier of the table to return values from.

- **fieldnames**
  - Is an array of field names, for example:
    ```javascript
    ["field1", "field2", "field3"]
    ```

- **dontSetSelection**
  - Boolean
  - Determines whether to select values so that you can pass them to chained controls. When true, values are not selected. When false, the values are selected.

- **displayOnly**
  - Boolean
When true, selections are display values. When false, selections are values from the data source.

**Example:**  **Retrieving Values From a Selected Row in a Table**

In the following example, clicking a button with the unique identifier button1 displays a message containing the values of the Country and Model fields for the selected row in table1, if a row has been selected.

```javascript
function button3_onclick(event) {
  var eventObject = event ? event : window.event;
  var ctrl = eventObject.target ? eventObject.target : eventObject.srcElement;
  // TODO: Add your event handler code here

  var fields = ["CAR.ORIGIN.COUNTRY", "CAR.CARREC.MODEL"];  
  var values = IbComposer_doSelectionByTableRow("tablectrl1", fields, true, true);

  if(values && values.length)
  {
    for(var i = 0; i < values.length; i++)
      alert(values[i]);
  }
}
```

**Function: IbComposer_loadNextGroup**

The IbComposer_loadNextGroup function allows you to load the next group in a table.

**Reference:**  **How to Load the Next Group in a Table**

IbComposer_loadNextGroup("tableId", groupObject, updateDependencies);

where:

- **tableId**
  - Alphanumeric
  - Is the unique identifier of the table from which to load the next group.

- **groupObject**
  - Object
  - Is an object representing the group displayed in the table.

- **updateDependencies**
  - Boolean
  - If true, controls chained to the table are updated when IbComposer_loadNextGroup is executed. If false, they are not updated.
Example: Loading the Next Group in a Table

In the following example, clicking a button with the unique identifier next loads the next group of the table, called tablectrl1, using the IbComposer_loadNextGroup function. A button called prev, which executes the IbComposer_loadPrevGroup function, is not enabled until you have executed IbComposer_loadNextGroup for the first time, so that it is only available if there is a previous group to display. The next button is not available if the last group in the table is displayed.

In order to execute properly, a variable called numOfRows has been used to set the length of the displayed group to 3 rows.

```javascript
var numOfRows=3;

function tablectrl1_onbeforeload(ctrl, arrValuesToLoad) {
    if(IbComposer_isCompleteReloading("tablectrl1") &&
      arrValuesToLoad.length>numOfRows)
    {
        IbComposer_enableHtmlElement("prev",false);
        IbComposer_enableHtmlElement("next",true);
        return numOfRows;
    }
    return false;
}

function next_onclick(event) {
    var eventObject = event ? event : window.event;
    var ctrl = eventObject.target ? eventObject.target : eventObject.srcElement;
    // TODO: Add your event handler code here
    var groupObj = {};
    IbComposer_loadNextGroup("tablectrl1", groupObj, false);
    IbComposer_enableHtmlElement("prev",true);
    if(groupObj.end== groupObj.total)
        IbComposer_enableHtmlElement("next",false);
}
```

Function: IbComposer_loadPrevGroup

The IbComposer_loadPrevGroup function allows you to load the previous group in a table.

Reference: How to Load the Previous Group in a Table

```javascript
IbComposer_loadPrevGroup("tableId", groupObject, updateDependencies);
```

where:

- **tableId**
  - Alphanumeric
  - Is the unique identifier of the table from which to load the next group.
**groupObject**
Object
Is an object representing the group displayed in the table.

**updateDependencies**
Boolean
If true, controls chained to the table are updated when `IbComposer_loadPrevGroup` is executed. If false, they are not updated.

**Example: Loading the Previous Group in a Table**

In the following example, clicking a button with the unique identifier `prev` loads the previous group of the table, called `tablectrl1`, using the `IbComposer_loadPrevGroup` function. The `prev` button is not available if you are viewing the first group in the table, so that it is only available if there is a previous group to display. You must click the button called `next`, which executes the `IbComposer_loadNextGroup` function, in order to enable it.

In order to execute properly, a variable called `numOfRows` has been used to set the length of the displayed group to 3 rows.

```javascript
var numOfRows = 3;

function tablectrl1_onbeforeload(ctrl, arrValuesToLoad) {
if(IbComposer_isCompleteReloading("tablectrl1") &&
arrValuesToLoad.length>numOfRows)
{
    IbComposer_enableHtmlElement("prev",false);
    IbComposer_enableHtmlElement("next",true);
    return numOfRows;
}
return false;
}

function prev_onclick(event) {
var eventObject = event ? event : window.event;
var ctrl = eventObject.target ? eventObject.target : eventObject.srcElement;
// TODO: Add your event handler code here
var groupObj = {};
IbComposer_loadPrevGroup("tablectrl1", groupObj, false);
IbComposer_enableHtmlElement("next",true);
if(groupObj.begin== 1)
    IbComposer_enableHtmlElement("prev",false);
}
```
**Function: IbComposer_isCompleteReloading**

The IbComposer_isCompleteReloading can be used to check if an element has finished reloading. It returns true if the element has reloaded, and false if it has not.

**Reference:** How to Check if an Element Has Finished Reloading

IbComposer_isCompleteReloading("elementId");

where:

**elementId**
Alphanumeric

Is the unique identifier of the element whose reloading status you are checking.

**Example:** Checking if an Element Has Finished Reloading

In the following example, clicking a button with the unique identifier button1 displays a message indicating whether or not a table called tablectrl1 has finished reloading.

```javascript
function button1_onclick(event) {
  var eventObject = event ? event : window.event;
  var ctrl = eventObject.target ? eventObject.target : eventObject.srcElement;
  // TODO: Add your event handler code here
  alert(IbComposer_isCompleteReloading("tablectrl1"))
}
```

**Function: IbComposer_setCalendarDate**

The IbComposer_setCalendarDate function allows you to input a date for a target calendar.

**Reference:** How to Set the Date of a Target Calendar

IbComposer_setCalendarDate("controlId", dateObject);

where:

**controlId**
Alphanumeric

Is the unique identifier of the calendar whose date you are setting.

**dateObject**
Is a JavaScript date object.
**Example:** Setting the Date of a Target Calendar

In the following example, clicking a button with the unique identifier button1 sends the current date to a calendar control called calendar1.

```javascript
function button1_onclick(event) {
  var eventObject = event ? event : window.event;
  var ctrl = eventObject.target ? eventObject.target : eventObject.srcElement;
  // TODO: Add your event handler code here
  IbComposer_setCalendarDate("calendar1",new Date());
}
```

In the following example, clicking a button with the unique identifier button1 sends the specified date, June 25, 2015, to the calendar control called calendar1.

**Note:** In JavaScript, months start at 0 (January), so month 5 in the example below represents June.

```javascript
function button1_onclick(event) {
  var eventObject = event ? event : window.event;
  var ctrl = eventObject.target ? eventObject.target : eventObject.srcElement;
  // TODO: Add your event handler code here
  var today= new Date();
today.setDate(25);
today.setMonth(5);
today.setYear(2015);
  IbComposer_setCalendarDate("calendar1",today);
}
```

**Function:** IbComposer_saveSelectedFile

The IbComposer_saveSelectedFile function allows you to upload a file, selected in an edit box with the Type property set to *File*, to a specified application folder in the Data Servers area. This location is specified using the Copy file to property for the edit box.

**Reference:** How to Upload a File Selected in an Edit Box

```javascript
IbComposer_saveSelectedFile("controlId");
```

where:

- `controlId`  
  Alphanumeric  
  Is the unique identifier of the edit box where you selected the file to upload.
Example: Uploading a File Selected in an Edit Box

In the following example, clicking a button with the unique identifier button1 uploads the file selected in the edit box edit1 to a location set using the Copy file to property. The Type property for edit1 has been set to File.

```javascript
function button1_onclick(event) {
    var eventObject = event ? event : window.event;
    var ctrl = eventObject.target ? eventObject.target : eventObject.srcElement;
    // TODO: Add your event handler code here
    IbComposer_saveSelectedFile("edit1")
}
```

Function: IbComposer_loadFromSelectedFile

The IbComposer_loadFromSelectedFile function allows you to display a file, selected in an edit box with the Type property set to File, in a container in an HTML page.

Reference: How to Display a File Selected in an Edit Box

IbComposer_loadFromSelectedFile(controlId, containerId, callBack);

where:

- `controlId`
  - Alphanumeric
  - Is the unique identifier of the edit box where you selected the file to upload.

- `containerId`
  - Alphanumeric
  - Is the unique identifier of the container in which to display the file selected using `controlId`, or _blank to display the file in a new browser window.

- `callBack`
  - Alphanumeric
  - Is a function to call when the selected item loads.

Example: Displaying and Uploading a File Selected in an Edit Box

In the following example, clicking a button with the unique identifier button1 displays a preview of the file selected in the edit box edit1 in an image component called image1 and calls the IbComposer_saveSelectedFile function to save it to a specified location.
function button1_onclick(event) {
    var eventObject = event ? event : window.event;
    var ctrl = eventObject.target ? eventObject.target : eventObject.srcElement;
    // TODO: Add your event handler code here
    var saveFn = IbComposer_saveSelectedFile("edit1");
    IbComposer_loadFromFileSelectedFile("edit1", "image1", saveFn)
}

Creating Responsive Web Pages

Responsive web design is an approach to webpage creation where content automatically realigns to fit a variety of different window sizes and screen sizes. This allows the content from one HTML file to automatically adapt to multiple footprints such as a desktop, laptop, tablet, or smartphone.

Unlike a generic HTML page, the containers in a responsive page reorder automatically as the screen size changes. Where a generic page shows partial content with a horizontal scroll bar, the responsive page shows full content, re-ordered, with no horizontal scroll bar.
How Responsive Containers Fold

The behavior that makes a page responsive is called “folding.” This section details the way responsive containers fold, or re-arrange, as screen size changes. The order in which responsive containers fold is illustrated in the following image.

**Figure A** illustrates a responsive layout with a row-based 4-2 format, meaning there are four containers on row one and two containers on row two.

Figure A also illustrates the filter row, containing four controls. At run time, the filter row can either be hidden or displayed.

**Figure B** illustrates the way containers fold responsively when the screen width decreases. The content in each container resizes accordingly, as the screen width changes.

![Figure A and Figure B](image.png)

**Note:** Objects within a responsive container are positioned absolutely. That is, they do not fold. Responsive containers fold in relation to one another, but the objects inside the containers remain fixed.

Objects inside responsive containers can scale to defined limits, as detailed in *How to Set Minimum and Maximum Panel Sizes* on page 706. However, the objects within a container will not fold.
**Procedure:** How to Control Folding with the Flow Direction Property

You can control the column/row orientation by which responsive containers re-arrange themselves.

1. Select a container in a responsive HTML page.
2. Click the drop-down arrow in the *Flow Direction* field, in the Responsive design section of the Properties panel and select one of the following:
   - **Not Set.** - Allows you to fold objects based on the available space (default).
   - **Row.** - Allows you to fold objects horizontally by row.
   - **Column.** - Allows you to fold objects vertically by column.

   **Note:** The Flow Direction property does not display for a responsive container that contains an element that is not responsive. For example, a button contained in a responsive panel will disable (hide) the Flow Direction property for the panel. To prevent this, right-click the button and click *Add selected to new container* from the context menu. Then, when you click the original panel, the Flow Direction property is available again.

3. Run the page. Resize the browser to observe the folding.
Selecting a Responsive Method

There are two ways to create responsive pages in App Studio: using a Responsive Template, and using the HTML Canvas in Responsive Mode. The following diagram shows the high-level decision tree that lets you quickly find the best way to create your responsive page:

1. **Using a Responsive Template.** This method lets you create a page by populating responsive Output Widget containers in a pre-defined template or a layout that you create at design time. You use the HTML/Document wizard to specify a layout that is either row-based or column-based.

See "Creating a Page with a Responsive Template"

See "Creating a Page with the HTML Canvas in Responsive Mode"

See "How to Convert an HTML File to Responsive"
**Key Characteristics**

The Output Widget container, shown in the following image, is the key characteristic of a Responsive Template.

The Output Widget container has the following features:

- **Title Bar.** Including an editable text title.
- **Image.** Such as a company logo, that can be inserted on the left side of the title bar.
- **Arrow Toggle.** On the right side of the title bar, to display or hide widget-level controls.
- **Expand Toggle.** On the right side of the title bar, to make the widget contents display full screen or original size.

If you want to create a responsive page with one or more Output Widget containers, the Responsive Template method is the most efficient approach. This method is used only for creating new responsive HTML files. For more information, see *Creating a Page With a Responsive Template* on page 697.

2. **Using the HTML Canvas Responsive Mode.** This “free form” method lets you create a responsive page with no pre-defined layout. This manual approach is perhaps not as fast as using a template, but may be preferable if you want to create a responsive page with containers of many different types.
This method can also be used to convert an existing HTML file to responsive. For more information, see *Creating a Page With the HTML Canvas in Responsive Mode* on page 709.

**Creating a Page With a Responsive Template**

There are six pre-defined responsive templates available through the HTML/Document Wizard. These represent the most commonly used page layouts. You can use the layout from a template as-is, or modify the layout further after initiating it with a template.

As an alternative to using a pre-defined template, the HTML/Document Wizard allows you to create a custom page layout at design time. You can specify the number of rows and columns, and whether the page has a row- or column-based orientation. These and other page options are detailed in the following sections.

**Understanding Responsive Templates**

When you select a responsive template from the HTML/Document Wizard, it generates a responsive layout with the specified number of rows (or columns) and widget containers. The parts of the responsive layout are highlighted in the following image, which was generated using the 2-2 responsive template. The image is annotated numerically with corresponding properties and explanations appearing below.
**Document.** Although not enumerated in the previous image, a responsive template generates an HTML document that includes the following responsive properties, editable in the Properties panel.

The following properties are available in the Responsive design section of the Properties panel when the DOCUMENT object is selected:

- **Flow Direction.** Allows you to control how responsive containers rearrange themselves. You can leave this property as Not Set, or specify to fold into rows or columns.

- **Create responsive containers.** When set to Yes, objects added to the document automatically have responsive behavior enabled. This is enabled by default in a responsive template.

- **Global responsive margin.** Defines the margin, in pixels, around all four edges of all responsive containers on the page. Templates have no margins set, by default.

- **Responsive: min width.** Sets the minimum width (in pixels or percentage) beyond which the page size cannot be decreased. The default minimum width is 320 pixels.

- **Responsive: max width.** Sets the maximum width (in pixels or percentage) beyond which the page will not rescale larger. This also defines the width of the canvas at design time. This limit is indicated by a black vertical line on the right side of the canvas, as shown in item 3 in the previous image. The default maximum width is Full screen.

At run time, the layout populates the full browser.

The following properties are available in the Miscellaneous section of the Properties panel when the DOCUMENT object is selected:

- **Load in iFrame object.** To load the entire page as a widget (a single DIV item) for use in a BI Portal. The default value for this property is Yes.

1. **Main Widget.** Defined as windowPanel1 <DIV> in the Properties panel, the default title is *Output widgets container.*

The following properties are available in the Responsive design section of the Properties panel when the main widget object is selected:

- **Flex grow.** Uses a numeric value to specify how quickly the item to expands relative to other items on the HTML page when the window size changes.

The following properties are available in the Output Widget section of the Properties panel when the main widget object is selected:

- **Template orientation.** Determines if the content folds by row or by column. The default orientation is *Row-based.* To change this, you can select *Column-based.*
- **Widget Title.** You can delete the default and type the desired title for the widget that encompasses the entire page contents.

- **Display image.** Enables you to display an image in the upper left corner of the widget. The default setting is Yes.

- **Image source.** Used to select the image to be displayed. Once selected, the path to the image is provided.

- **Auto-hide inputs panel.** The row of controls used to filter the content for the page is hidden by default. To always display the row of controls, select No.

- **Select animation.** Enables you to select any animations that have been set for this window panel.

2. **Widget display buttons.** The page, and each widget within it, has two buttons in the upper-right corner: an arrow and a box. Toggle the arrow to display or hide the row of controls. Toggle the box to expand a widget to full screen or return it to original size.

3. **Vertical design boundary.** This is a visual indicator on the far right side of the canvas that shows the responsive maximum width set in the Properties panel for the document. The default is 1500 pixels.

4. **Widget Title.** Defined as windowPanel2 <DIV> in the Properties panel (for the first widget), the default widget title is *Output Widget Title*. You can delete the default and type the desired widget title in the Properties panel. At design time, a red box appears around the widget title and contents to indicate a responsive container.

5. **Widget contents.** Defined as iframe1 <IFRAME> in the Properties panel (for the first widget), you can right-click to add content to the widget through the following shortcut menu:

   - **New Report.** To create a new report in the widget.
   - **New Chart.** To create a new chart in the widget.
   - **New Document.** To create a new document in the widget.
   - **Import existing.** To import an existing procedure into the widget.
   - **Reference existing procedure.** To reference an existing procedure in the widget.
   - **Map.** To create a new map control in the widget.
   - **ESRI.** To create a new emf object in the widget.
   - **Use as Toolbox.** A general option to use the widget as needed. For example, you may decide to create a button to execute an action.
The content in pages derived from a responsive template loads in the following order at runtime: left to right - top to bottom.

To add a header to your responsive page, right-click in the title bar and select Add page header from the shortcut menu. Alternatively, you could use the Add page header option in the HTML/Document Wizard, as detailed in the following procedure.

Procedure: How to Select a Responsive Template

Select a responsive template from the HTML/Document Wizard as follows:

1. Open the HTML/Document Wizard using one of the following methods:
   a. On the Home tab, in the Content group, click HTML/Document; or
   b. In the Environments Tree panel, right-click an application folder, click New, and click HTML/Document.

   The HTML/Document Wizard opens. If you used option a. above, the HTML/Document Wizard contains a navigation window that you can use to specify the folder where you want to save the new file.

   2. Click Next.

      The Templates, Settings, and Themes page opens, containing the Responsive Templates section, as shown in the following image.

3. Click on a desired responsive template.

   - Selecting None results in a generic HTML canvas that is not responsive.
   - Selecting Custom lets you design a layout that differs from those offered by the responsive templates. For more information, see How to Create a Custom Layout on page 708.

For purposes of this procedure, do not select None or Custom.
4. Use the Input Controls section at the bottom of the page as follows:

- Select *Auto-hidden* to hide the controls input panel. This is the default. At run time, users display the panel by clicking the down arrow in the title bar.

- Select *Always show* to display the controls input panel. At run time, users hide the panel by clicking the up arrow in the title bar.

- Clear the check box for *Use a single input control panel* if you want to use widget-level controls instead of, or in addition to, page-level.

5. Select *Run requests on load* to load the contents of all the widgets when the page first opens.

6. Select *Add page header* if you want to add space above the title bar, within the responsive panel `<DIV>`. You could use this area to add a graphic and/or company logo, for example.

7. Click *Finish* to close the HTML/Document Wizard.

The HTML canvas opens with the automatically generated responsive layout corresponding to the selected template.

**Note:** It is a best practice to expand App Studio to full screen when working with a responsive layout. This lets you access the greatest number of widgets without having to scroll.

**Reference:** Populating Widgets in a Responsive Template

A layout generated by a responsive template contains blank widgets in responsive containers. This section contains guidelines for editing and adding objects to widgets.

- To add content to a header, click the desired element from the Components tab and drag and drop it on the header area to define it.

  To increase the height of a page header, click the *Title Bar* and drag it down to expose more room above it. Click the header area to highlight the responsive red box. Drag the lower border of the red box down to increase the height of the header.

- To change a widget title, click the default title, *Output Widget Title*, and open the Properties panel. In the Widget Title field, type the new widget title.

- To display an image in the top left corner of a widget title bar, set the Display image value to *Yes*. Use the Image source field to lookup the desired image file.

- To add objects to a widget, right-click in the widget to display the shortcut menu. Click the desired object type, for example, Report, Chart, Document, Map, and so on. You can create new content in the widget, import existing content, or reference existing content.
**Note:** When using a layout generated by a responsive template, you cannot add objects to the canvas outside the layout.

- To add multiple objects to a widget, drag the additional object from the ribbon to the widget. For example, on the *Home* tab, in the *Content* group, click the *Report* button and drag it to a widget that already contains an object, and drop it. A box is automatically drawn within the widget to contain the new report object.

**Note:** All of the objects in a responsive container must be responsive. You cannot include responsive and non-responsive objects in the same responsive container.

- To set an equal margin around all four sides of a widget, enter a number of pixels in the Margin property for the widget `<iframe>`.

- To move contents from one widget to another, click the Positioning tab and, in the Responsive Design group, click *Toggle Selection*. Drag contents between widgets as needed and click *Preview Runtime*, on the Utilities tab.

**Procedure:** How to Add or Remove a Widget

You can change the layout of your responsive page at design time by adding or removing a widget, as detailed below.

1. Open a responsive HTML page.

2. To add a widget, use one of the following methods:
   
   a. Select a widget next to the location where you want to add a new one. Right-click on the title bar of that widget and select *Insert new widget before* or *Insert new widget after* from the shortcut menu.

      The new widget is added.

   b. Alternatively, you can right-click on the title bar of the HTML page and select *Template configuration*... from the shortcut menu. The Template Configuration dialog box shows the row (or column) numeric configuration. For example, 3-2.

      Change the numeric configuration to include the new widget. For example, to add a new widget to the second row, change the value to 3-3.

      The new widget is added.

3. To remove a widget, use one of the following methods:
   
   a. Select a widget that you want to remove. Right-click on the title bar of that widget and select *Delete* from the shortcut menu.

      The widget is removed.
b. Alternatively, you can right-click on the title bar of the HTML page and select *Template configuration...* from the shortcut menu. The Template Configuration dialog box shows the row (or column) numeric configuration. For example, 3-2.

Change the numeric configuration to reduce the number of widgets. For example, to remove a widget from the first row, change the value to 2-2.

The widget is removed.

**Procedure: How to Add an Additional Object to a Widget**

You can put more than one object (such as a report or chart) in an output widget, as detailed in this procedure.

**Note:** A widget that contains a map will not accept an additional object.

1. Click an object that has already been added to a widget.

   - If the widget contains a report or chart, you can add another report or chart, but not any other type of object.
   
   - If the widget contains a toolbox, you can add an additional report or chart, but it will not have the Autosize option set by default. You must set this option manually.

   Open the Properties panel to verify that the IFRAME is selected.

2. On the *Components* tab, click the object that you want to add. For example, *Report* or *Chart*.

   The widget can be divided vertically (with the two objects, side by side) or horizontally (with the two objects one above the other). Move your cursor to the right or left side, or the top or bottom of the widget.

   The existing content automatically moves to the opposite side of your cursor.

3. Click on the side where you want to insert the new object.

   The widget is automatically divided into two equal columns or rows. The side you selected contains the report or chart icon in an iframe.

   **Note:** If you change your mind after you add the new iframe, you may right-click and delete it. However, the original iframe will not automatically expand to fill the original space in the widget. At run time, the content of the original iframe does fill the original space. But at design time it remains partial. You can click the original iframe and manually drag its border to fill the widget space, if you want the appearance of the page at design time to more closely reflect the appearance at run time.

4. Right-click the icon and select the desired option from the shortcut menu to create the new object. For example, Reference existing procedure.
5. Click the widget title bar and open the Properties panel. The Number of columns property defaults to Auto. Use the drop-down menu to select the number of columns you want in the widget. Select 2 if you have two objects side by side. Select 1 if you have two objects, one above the other.

Run the page to preview widgets that have multiple objects to be sure the content remains legible.

*Procedure: How to Apply Page-Level Controls in a Responsive Page*

You may often have a responsive page that contains multiple reports that use the same controls. For example, if users can select region and month, they may want to show the same region and month selection for multiple reports in the page. In this case, you can apply common controls at the page level.

Your page can also include one or more reports that use controls that differ from the common ones. In this case you can apply additional controls at the widget level, as defined in *How to Apply Widget-Level Controls in a Responsive Page* on page 705.

This procedure details how you apply controls at the page level.

1. Create multiple reports or charts that use the same controls and add them to widgets in a responsive layout as detailed in *How to Select a Responsive Template* on page 700.

When you add a report with controls to a widget, the New Parameters dialog box opens. You can use this dialog to chain controls together. Chaining lets you filter control values based on the selected value from the prior control in the chain. For example, if State and City controls are chained, the City values will be filtered to show only cities in the selected state.

For more information see *Chaining in the HTML Canvas* on page 633.

2. Run the page. Note that:

- The control names and values are appended to the page title in the title bar.
- The controls input panel does not display. This is the default.

3. Click the down arrow in the right corner of the title bar to display the controls input panel.

   Close the HTML output and return to the HTML canvas.

4. If you want the controls input panel to display when the page opens:
   a. Click the title bar and open the Properties panel.

      The properties for windowPanel1 <DIV> are displayed.

   b. Change the Auto-hide inputs panel value to No.
c. Run the page. Note that the controls input panel now does display.

5. To display the controls on the left side of the input panel:
   a. Click the controls input panel and open the Properties panel.
   b. Change the Control panel value to Yes.
   c. Run the page and expand it to full screen. Note that the controls in the input panel display together on the left side of the panel, where the user expects them to be.

   If you do not set the Control panel value to Yes, the controls will automatically expand to the right to use the full width as the page size increases.

The selections that the user makes in the controls input panel are automatically applied to all the reports on the page that share the controls.

**Procedure:** How to Apply Widget-Level Controls in a Responsive Page

You may often have a responsive page that contains multiple reports that use the same controls. For example, if users can select region and month, they may want to show the same region and month selection for multiple reports in the page. In this case you can apply common controls at the page level, as defined in *How to Apply Page-Level Controls in a Responsive Page* on page 704.

Your page can also include one or more reports that use controls that differ from the common ones. In this case you can apply additional controls at the widget level.

This procedure details how you apply controls at the widget level when different controls are used at the page level.

1. Open a responsive HTML file that uses page-level controls, such as the one created in *How to Apply Page-Level Controls in a Responsive Page* on page 704.

   Add a new widget to a row as detailed in *How to Add or Remove a Widget* on page 702.

2. Create a report or chart that uses controls and add it to the new widget. For purposes of this procedure, use different controls than the ones used in the other reports in this page.

   When you add a report with controls to a widget, the New Parameters dialog box opens. By default, this dialog is set to create a control. Click OK.

3. Run the page. Note that the controls input panel displays in the new widget by default.

4. To hide the controls input panel in a new widget:
   a. Add a new widget to a row as detailed in *How to Add or Remove a Widget* on page 702. Add the report you created in Step 2 to the new widget.

   The New Parameters dialog box opens.
b. In the Parameter grouping options field select New single layer form and click OK.

The New Parameters dialog box closes. The input panel is hidden.

The selections that the user makes in the controls input panel at the page level are automatically applied to all the widgets on the page that share controls. Additionally, the user can make a selection in the independent widget that does not share controls.

**Procedure: How to Animate the Controls Input Panel**

Creating a page with a responsive template enables you to add animation that appears when a user opens or closes a controls input panel at run time. This consists of creating and naming an animation, then applying it to the window panel that corresponds with the input controls, as detailed below.

1. Open an HTML page that was a) created with a responsive template; and b) contains input controls.

2. Open the Tasks & Animations panel. In the JQuery Animations section, click the New button.

   The system gives the new animation a default name. For example, Animation1. If you wish to rename the animation, click the default name and type the new name.

   **Note:** It is not necessary to specify a selected target for the animation. Leave this field blank.

3. In the Effect section, use the drop-down menu in the Type field to select an animation. If you wish, you may select an Option and Value to apply to the selected animation.

4. At the bottom of the panel, click **Toggle animation**.

   The animation is ready to be applied to the window panel.

5. In the responsive layout, click the title bar under which the control input panel appears.

6. Open the Properties panel. In the Output Widget section, click the Select animation field.

   Use the drop down menu to highlight the desired animation name. For example, Animation1.

7. Run the HTML page. Use the up/down arrow button on the title bar to see the animation when you hide/reveal the controls input panel.

**Procedure: How to Set Minimum and Maximum Panel Sizes**

Responsive panels automatically resize as the viewing window changes, but panels do not have a default minimum or maximum size. You can set minimum or maximum size, in pixels or percentages, to best suit the panel contents, as follows.
**Note:** Panels in a responsive page resize within the context of the minimum and maximum page width. To view or edit these values, open the Properties panel and select **DOCUMENT** from the drop-down menu at the top of the panel. For Responsive: min width, the default is 320px. For Responsive: max width, the default is Full screen.

1. Click a responsive panel that contains controls, or click the title bar of a widget, and open the **Properties** panel.

   The Properties panel for the panel `<DIV>` includes the following properties: Min-width, Max-width, Min-height, and Max-height. These values are blank by default.

2. You can manually type a number of pixels or a percentage. For example, `50px` or `50%`.

   Alternatively, you can use the shortcut menu as follows:

3. Right-click a responsive panel that contains controls, or right-click the title bar of a widget.

   From the shortcut menu, select **Update Sizes**.

   The Update Sizes shortcut menu displays.

   Select Update minimum size to populate the Min-width and Min-height properties with the number of pixels or percentages used by the selected container. In other words, the container will not scale smaller than the size shown in the responsive layout.

   **Note:** Update minimum size does not change the object size in design time, but it does change the size in run time.

   Select **Use Current** to use sizes from the selected container as follows:

   - **Size as min size.** To populate the Min-width and Min-height properties with the number of pixels used by the selected container.

   - **Size as max size.** To populate the Max-width and Max-height properties with the number of pixels used by the selected container.

   - **Height as min height.** To populate the Min-height property with the number of pixels used by the selected container.

   - **Width as min width.** To populate the Min-width property with the number of pixels used by the selected container.

   - **Height as max height.** To populate the Max-height property with the number of pixels used by the selected container.

   - **Width as max width.** To populate the Max-width property with the number of pixels used by the selected container.
**Procedure:** How to Load a Widget at Run Time

In some cases, the content you add to a widget might not load at run time, leaving the widget blank. This could occur if you did not select the *Run requests on load* option from the HTML/Document wizard, or if you added a new widget to a layout.

To cause widget content to load at run time:

1. Open the *Tasks & Animations* panel, select the *Load Task*, and then select *Load Trigger Type*.
2. In the Requests/Actions section, click the down arrow next to the Add Request button. The shortcut menu is displayed.
3. Select *Run Request* and then select an iframe, for example *iframe2*.
   The iframe is added to the Requests/Actions field and is highlighted.
4. In the Target Type field, select *Frame*. In the Target/Template field, select the iframe that corresponds to the one that is highlighted, for example *iframe2*. Run the page.
   The content loads at run time.
5. Repeat these steps for all the iframes in your page that do not load at run time.

**Procedure:** How to Create a Custom Layout

In the HTML/Documents Wizard, the Templates, Settings, and Themes page includes six responsive templates that represent the most commonly used layouts. You can use these layouts as-is, or use them as a point of departure for a modified layout that contains more or fewer widgets. For more information, see *How to Add or Remove a Widget* on page 702.

Instead of using a template, you can create a custom layout, as detailed in this procedure.

1. Open the HTML/Document Wizard using one of the following methods:
   a. On the *Home* tab, in the *Content* group, click *HTML/Document*.
      or
   b. In the Environments Tree panel, right-click an application folder, click *New*, and click *HTML/Document*.

   The HTML/Document Wizard opens. If you used option **a.** above, the HTML/Document Wizard contains a navigation window that you can use to specify the folder where you want to save the new file.

2. Click *Next*.

   The Templates, Settings, and Themes page opens, containing the Responsive Templates section.
3. In the Responsive Templates section, click Custom. Click Finish. The layout opens and the Template configuration dialog is activated.

4. In the Orientation field, select Row-based or Column-based.

5. Use the Select row number and Number of containers in a row field as follows:
   a. With number 1 showing in the Select row number field, use the drop down list in the Number of widgets in a row field to specify the number of widgets you want in row 1.
      **Note:** Use the drop down list. Do not type in the field.
   b. Select 2 in the drop down list in the Select row number field.
   c. Use the drop down list in the Number of widgets in a row field to specify the number of widgets you want in row 2.
   d. Repeat this sequence as needed to define your custom layout.
      Close the Template configuration dialog.

6. Define the page-level behavior of input controls as follows:
   - In the Properties panel for windowPanel1 <DIV>, set Auto-hide inputs panel to Yes. At run time, users reveal the panel by clicking the down arrow in the title bar. This controls page-level behavior.
   - In the Properties panel for windowPanel2 <DIV>, set Auto-hide inputs panel to Yes. At run time, users reveal the panel by clicking the down arrow in the title bar. This controls widget-level behavior. Repeat this for each widget for which you want to use widget-level controls.
   - Select No to display the controls input panel. At run time, users hide the panel by clicking the up arrow in the title bar.

7. To add a page header, right-click in the title bar of the page and select Add page header from the shortcut menu. You could use this area to add a graphic and/or company logo, for example.

**Creating a Page With the HTML Canvas in Responsive Mode**

This “free form” method lets you create a responsive page with no pre-defined layout. This manual approach is perhaps not as fast as using a template, but may be preferable if you want to create a responsive page with containers of many different types. You can also use this method to convert an existing HTML file to responsive.

The following containers are responsive, by default:

- Report
Procedure: How to Create New Content in Responsive Mode

You can create new responsive content using the HTML canvas in responsive mode, as defined in this procedure.

1. Open the HTML/Document Wizard using one of the following methods:
   a. On the Home tab, in the Content group, click HTML/Document; or
   b. In the Environments Tree panel, right-click an application folder, click New, and click HTML/Document.

   The HTML/Document Wizard opens.

2. Click Next.

   The Templates, Settings, and Themes page opens, containing the Page Settings section, as shown in the following image.
3. In the Page Settings section, select **Responsive design**.

   **Note:**
   - The Create default responsive containers option is selected, by default. When you create a control using the New Parameters dialog box, the forms and the controls will be created with responsive containers.
   - If you clear the Create default responsive containers check box, no responsive containers will be drawn for the form object.
   - Controls are not responsive, by default. If you draw a control, right-click the control and select **Add Selected to a new container** to draw a responsive container around the object.
   - You can make a non-responsive container responsive by selecting the container and, in the Properties panel, selecting Yes for the Enable Responsive property.

4. Click **Finish**.

   The HTML canvas opens. In the Properties panel, in the DOCUMENT properties, the Responsive design value is set to **Yes**.

   As an alternative to using the HTML/Document Wizard, you can open a file in the HTML canvas and manually change the Responsive design property value to **Yes**.

   You can add content to the HTML canvas before turning Responsive Design on. However, there are advantages to turning Responsive Design on before adding content. Design time benefits include:
   - Having the responsive minimum and maximum widths established
   - Having the maximum width visually indicated by the horizontal line on the right side of the canvas
   - Having the Preview Runtime capability to preview the run-time appearance

**Procedure:** **How to Convert an HTML File to Responsive**

1. To enable responsive behavior in an existing HTML file, double-click the file in the Environments Tree panel, or right-click it and click **Open**.

   The HTML file is open in the HTML canvas.

2. In the Properties panel, select **DOCUMENT** from the drop-down menu.

   The Document properties are displayed.
3. In the Responsive design property, select Yes from the drop-down menu.
   A message appears asking if you want to group control elements into responsive containers.

4. Indicate your preference for responsive containers as follows:
   a. Click Yes to add multiple containers in the control area as shown in the following image.

   ![Image showing responsive containers]

   Note there are three containers within the fourth, larger container. The containers are red, indicating that they are responsive.

   b. Click No to add no containers. This may be preferable if your page contains many nested objects, otherwise each object will get its own container.

   You can add additional containers at a later time:
   1. Multi-click the control objects you want to group in a container.
   2. Right-click one of the highlighted objects and select HTML object manipulation from the shortcut menu.
   3. Select Merge containers.
   4. To make a frame responsive, select it and open the Properties panel. Set the Enable responsive property value to Yes.

The HTML canvas is now in responsive mode. The frames and controls on your HTML canvas are each enclosed in a responsive container, indicated by a red box.

**Note:** if the HTML file had the Autosize Children option enabled, it will be superseded by the new responsive behavior, which automatically controls sizing.

The following properties appear in the Responsive design section of the Properties panel for the DOCUMENT object, whose values you may edit:

- **Enable responsive.** Enabled responsive behavior in the HTML page. When set to Yes, additional responsive design properties become available.

- **Flow Direction.** Allows you to control how responsive containers rearrange themselves. You can leave this property as Not Set, or specify to fold into rows or columns.
Create responsive containers. When set to Yes, objects added to the document automatically have responsive behavior enabled.

Global responsive margin. Defines the margin, in pixels, around all four edges of all responsive containers on the page. Templates have no margins set, by default.

Responsive: min width. Elements will not be repositioned or resized if the width of the container is less than this minimum, specified in pixels or percentage.

Responsive: max width. Elements will not be repositioned or resized if the width of the container is greater than this maximum, specified in pixels or percentage.

If you select a responsive container, the following properties appear in the Responsive design section of the Properties panel:

Enable responsive. Set to Yes, by default, indicating that the panel exhibits responsive behavior.

Flex grow. Uses a numeric value to specify how quickly the item expands relative to other items on the HTML page when the size of its container changes.

Content alignment. Controls how objects in a responsive container are aligned at run time. You can select one of the following options:

Blank <Not Set>. The objects are aligned toward the left side of the container by default.

Start. The objects are aligned on the left side of the container.

End. The objects are aligned on the right side of the container.

Center. The objects are centered within the container.

Space between. The objects are evenly distributed by width. The first object is close to the left side, the last object is close to the right side, and the objects in between are spaced equally.

Space around. The objects are evenly distributed by width and height.

Flow Direction. Allows you to control how responsive containers rearrange themselves. You can leave this property as Not Set, or specify to fold into rows or columns.

Responsive width. Determines whether the width of an object adjusts responsively at run time. Select No to keep the width set at design time in the canvas.

Responsive height. Determines whether the height of an object adjusts responsively at run time. Select No keep the height set at design time in the canvas.
If you select an iframe object, such as a report or chart component, in the canvas, the following properties appear in the Responsive design section of the Properties panel:

- **Enable responsive.** Determines whether the object exhibits responsive behavior.

- **Flex grow.** Uses a numeric value to specify how quickly the item expands relative to other items on the HTML page when the size of its container changes.

- **Responsive width.** Determines whether the width of an object adjusts responsively at run time. Select No to keep the width set at design time in the canvas.

- **Responsive height.** Determines whether the height of an object adjusts responsively at run time. Select No keep the height set at design time in the canvas.

A black vertical line appears on the right side of the HTML canvas in responsive mode, as a visual indicator of the responsive maximum width. You may need to scroll right to see this line.

5. To move contents from one container to another, click the **Positioning** tab and, in the Responsive Design group, click **Toggle Selection**. Drag contents between containers as needed and click **Preview Runtime**, on the Utilities tab.

6. Click the **Run** button on the Application menu and view the HTML output full screen. Gradually decrease the width to observe the responsive folding.

**Procedure: How to Restrict the First Row to Controls Only**

When you create a page with a responsive template, the first row of the page is automatically restricted to input controls (when applicable). Content such as reports or charts will not fold up to populate the first row, regardless of how wide the browser may stretch at run time.

When you create a page using the HTML canvas in responsive mode, this restriction is not automatic. Therefore a report or chart could fold up to populate the first row, if the browser width is increased. This behavior may be considered undesirable.

Ensure that the first row contains controls only, as follows:

1. Open an HTML page that was:

   - Created with the HTML canvas in Responsive mode
   and

   - Contains input controls.

2. Verify that the input controls are all grouped within a single container. If not:
   a. Hold down the Ctrl key and multi-select all the controls.
b. Right-click on one of the controls and select HTML object manipulation.

c. From the shortcut menu, select Add selected to new container.

Note that a box appears that contains all the selected controls. The box is red, indicating it is responsive.

3. To display the controls on the left side of the input panel:

   a. Click the controls input panel and open the Properties panel.

   b. Change the Control panel value to Yes.

   c. Run the page and expand it to full screen. Note that the first row contains controls only. Also note that the controls in the input panel display together on the left side of the panel, where the user expects them to be.

If you do not set the Control panel value to Yes, the controls will automatically expand to the right to use the full width as the page size increases.

**Procedure: How to Create a Responsive Page for Use in a BI Portal**

The WebFOCUS BI Portal gives users access to BI content, including dashboards, visualizations, reports, charts, graphs, maps, and interactive InfoApps. The BI Portal allows users to analyze vital information quickly, link content and reports together, and easily tailor information to their needs.

This procedure is comprised of two parts: creating a report for use in the responsive portal and creating a responsive HTML page using the HTML canvas.

1. Select or create a report with the following criteria:

   - Has dynamic parameters specified in a WHERE clause.
   - Has _FOC_NULL as the default.
   - Has a parameter that is a Multiselect OR.
   - Has a value of No in the File/Folder Properties panel - Prompt for Parameters property.

2. Create a responsive HTML page as follows:

   a. Open the HTML/Document Wizard from the Home tab, in the Content group, or from the shortcut menu in the Environments Tree panel. Click Next.

      The Templates, Settings, and Themes page opens.

   b. In the Page Settings area, click Responsive design and click Finish.

      The HTML canvas opens. In the Properties panel, in the DOCUMENT properties, verify that the Responsive design object property is set to Yes and the Load in iFrame object property is set to No.
The Load in iFrame object property is used to enable objects in a BI Portal to overlap the edges of a container. For example, when you have a pop-up calendar that populates a date field, the calendar can overlap the control container to allow the user to select a date.

**Note:** The Load in iFrame object property creates a `<DIV>` for the page instead of an `<iframe>` tag. A BI Portal is limited to only one HTML Canvas page that is enclosed in a `<DIV>` tag.

Note that the Responsive: min width is set to 320px and the Responsive: max width is set to Full screen. These default values can be edited in pixels or percentages.

c. In the Requests and Data sources panel, click the drop down arrow next to the New icon, and select the option Requests-Parameters-Filter Panel.

The Open File dialog box opens.

d. Select the procedure you designated in Step 1 and click OK.

The New Parameters dialog opens.

e. Click *Autochain controls in above specified order*, and click OK.

The New Parameters dialog closes and the HTML canvas is opened, showing the controls in containers. The red boxes indicate that responsive design is activated.

f. Open the Tasks & Animations panel and verify that the Submit button (task 2) Requests/Actions value is Refresh1 and the Target Type is Refresh BI Portal.

g. Right-click the canvas and select *Preview Runtime* or click the *Preview Runtime* button on the Utilities tab. Note that the content expands to the maximum width. The black vertical line on the right side of the canvas is a visual indicator of the specified Full screen max width.

h. Save the HTML page.

**Reference:** **Tips for Using Responsive Design**

The following are some best practices in working with Responsive Design to create responsive HTML pages:

- **When creating a new responsive HTML page:**
  - Use a Responsive template to generate a layout with widgets. The HTML/Document Wizard lets you control the number of rows and the number of widgets per row, lets you determine how input controls will appear, lets you add a page header, and lets you run requests automatically when the page loads at run time.
Use Responsive Design in the HTML canvas to generate a layout without widgets. This method lets you design a page for a BI Portal.

On the Positioning tab, the Positioning group contains the Same Width, Same Height, and Same Size commands that behave as follows in responsive design mode:

- **Same Width.** Sets the minimum and maximum width to that of the control object (the previously selected object).
- **Same Height.** Sets the minimum and maximum height to that of the control object (the previously selected object).
- **Same Size.** Sets the minimum and maximum width and height to that of the control object (the previously selected object).

To use these commands:

1. Click the object whose size you want to duplicate.
2. User the Control key and click the secondary objects that you want to resize.
3. Click the desired command button from the Positioning group.

On the Positioning tab, the Responsive Design group contains the Toggle Selection and Update Layout commands. These commands are enabled in responsive design mode.

- **Toggle Selection.** Toggle on to allow responsive containers that include content to be dragged to a new position. Toggle off to prevent those containers from being repositioned.

- **Update Layout.** This command is activated in a responsive page when the Autosize children property is set to Yes. Click to refresh the HTML canvas after you reposition containers, to show how the containers will stack when folded.

You can control the run-time alignment of contents within a responsive container using the *Content alignment* property. This property appears for a parent responsive container that contains multiple responsive objects.

Click the down arrow to display the following property values:

- **Blank <Not Set>.** The objects are aligned toward the left side of the container by default.
- **Start.** The objects are aligned on the left side of the container.
- **End.** The objects are aligned on the right side of the container.
- **Center.** The objects are centered within the container.
Space between. The objects are evenly distributed by width. The first object is close to the left side, the last object is close to the right side, and the objects in between are spaced equally.

Space around. The objects are evenly distributed by width and height.

The alignment in the HTML canvas does not change after you specify a content alignment property value. Click Run on the Quick Access Toolbar to see the specified alignment in the browser.

A black vertical line appears on the right side of the HTML canvas in responsive mode, as a visual indicator of the breakpoint width for desktop display. In order to control the behavior of your responsive containers, position them to the left of this line on the HTML canvas. Content appearing to the right of this line will fold arbitrarily.

If you have both Mobile Design and Responsive Design enabled, Mobile Design takes precedence when you view content on the smartphone. Mobile Design uses jQuery mobile controls. Responsive Design uses browser-generated controls.

**Designing Content for Smartphones**

You can design content specifically to be used on smartphones. Content designed in this way is automatically sized, and takes full advantage of the page-swipe navigation and touch-screen capabilities of smartphones.

**Note:** Tablets can display native App Studio HTML content without modification. This section pertains to designing HTML content for smartphones only.

The following steps outline how you can design HTML content for smartphones:

1. Create and save your content in an HTML file that is built in the native App Studio HTML canvas.

2. Enable Mobile Layout for the HTML file by using the Enable mobile property.
   
   For more information, see *Enabling Mobile Layout in an HTML File* on page 723.

3. Select either the Basic or Advanced Mobile Layout.
   
   For more information, see *Working With the Basic and Advanced Mobile Layouts* on page 724.

4. Populate the smartphone pages with your HTML content.

5. View the results on your smartphone.
   
   For more information, see *Viewing Mobile Output on a Smartphone* on page 730.
Designing Output for Smartphones With the Mobile Layout Functionality

Before you use the Mobile Layout functionality, you must create and save your content on the native HTML canvas. The example shown in the following image contains four objects: a text box containing a title, a drop-down control, a frame containing a report, and a frame containing a chart.

Frames

Frames in your HTML content automatically appear in the Mobile Layout. In the Basic Mobile Layout, individual frames appear separately on individual pages. In the Advanced Mobile Layout, all frames appear together on a single page. You can change either layout to display frames on pages as you like.

The page order, when viewed on a smartphone, is determined by the frame order in the Tasks area of the Tasks & Animations panel. You can change the page order in the Mobile Layout, as needed.

Animations that you have targeted to a frame included in the Mobile Layout will run on your smartphone.
Controls

To maximize the capabilities of a touch screen, single-select and multi-select controls both become listbox jQuery mobile controls, with one allowing single-select and the other multiselect.

**Note:** jQuery mobile controls do not display when you design your HTML page using the Mobile Layout, but will display when the page is viewed on a smartphone.

Other Objects

Some objects that you add to the HTML canvas are not automatically promoted to pages in the Mobile Layout. This is true for text boxes and images.

Objects that are not automatically promoted to pages appear below a horizontal line that underlines the page preview. You can drag objects above the line onto pages, as needed. Objects that remain below the line, and any animations targeted to them, will not appear when you view the pages on your smartphone.

**Note:** The size of an object that you drag into a page is accurately previewed in the page, so you can determine if the object needs to be resized. If so, you must resize it in the HTML canvas.

When you drag an object from below the horizontal line onto a page, the system recognizes this as a manual modification to the Mobile Layout. This triggers a message: Manual modification of mobile layout will stop default generation of the pages. It will be your responsibility to maintain it.

Accepting this means that changes to the underlying data will not flow automatically to the mobile pages. You must open the HTML file, right-click the canvas, and select *Update Layout*.

To take advantage of the default generation of the mobile pages, it is recommended that you avoid making manual modifications.

**Note:** You can undo manual modification of the Mobile Layout by right-clicking the canvas and clicking *Reset mobile to default*. This restores automatic update of the HTML pages, and removes any manual modifications.

A page in Mobile Layout appears as shown in the following image. In this example, the page content displays in a frame, which is scrollable when you view it on a smartphone. Below the frame is the navigation area.
Styling for the components of the Mobile Layout is controlled by the cascading style sheet. For more information, see *Cascading Style Sheet Class Mapping List for Mobile Components* on page 731.

**The Navigation Area**

The following image displays the navigation area that appears below the page content.
The icons in our example indicate that there is a home page, which is represented by the house icon, and two additional pages, which are represented by two square icons. In addition, there is a page combination tool, which is represented by a tile icon.

The default home page appears first in the page order. You can change the home page as needed.

You can use the square icons and the house icon to navigate between the pages.

You can use the tile icon to vertically combine objects in a page, in cases where there is more than one object on a page. Toggle the tile icon to change vertical combinations.

Adding/Removing Pages

The following list describes the shortcut menu options on the Mobile Layout canvas, which you can use to add and remove pages.

- **Show all pages.** Displays all pages on the Mobile Layout canvas. Both the Basic and Advanced Mobile Layouts show one page, by default.

- **Add empty page.** Adds an empty page to the Mobile Layout canvas. You can then drag content into the page.

- **Remove empty page.** Deletes any empty pages on the Mobile Layout canvas.

- **Remove selected page.** Deletes a page that has content. The system recognizes this as a manual modification to the Mobile Layout. This triggers a message: Manual modification of mobile layout will stop default generation of the pages. It will be your responsibility to maintain it.

  Accepting this means that changes to the underlying data will not flow automatically to the mobile pages. You must open the HTML file, right-click the HTML canvas, and select Update Layout.

- **Reset mobile to default.** Restores automatic update of the HTML pages, and removes any manual modifications.

**Note:** When you delete content from the HTML canvas, you must also manually delete it from the Mobile Layout. Deleting content from the Mobile Layout that was previously deleted from the HTML canvas is not interpreted as a manual modification, and will preserve the default generation of the pages.

Moving Content Between Pages

You can change the order of the pages or display more than one object on a page.
To display more than one object on a page horizontally, click the object in one screen and drag it to another.

To display more than one object on a page vertically, use the tile icon . Toggle the tile icon to remove vertical combinations.

To move a control or an object that appears below the horizontal line, drag the object to the desired page. The system recognizes this as a manual modification to the Mobile Layout. This triggers a message: Manual modification of mobile layout will stop default generation of the pages. It will be your responsibility to maintain it.

Accepting this means that changes to the underlying data will not flow automatically to the mobile pages. You must open the HTML file, right-click the HTML canvas, and select Update Layout.

**Note:** You can undo manual modification of the Mobile Layout by right-clicking the canvas and clicking Reset mobile to default. This restores automatic update of the HTML pages, and removes any manual modifications.

To take advantage of the default generation of the pages, it is recommended that you avoid making manual modifications.

### Enabling Mobile Layout in an HTML File

An HTML file is designated for mobile output when the Enable mobile property is set to Yes. This designation enables a Mobile Layout option, where you can edit and preview your mobile output.

**Note:** An HTML file that has Mobile Layout enabled can additionally be viewed on a desktop or tablet. In these cases, page design is derived from the HTML canvas and the page design on the Mobile Layout is ignored. This eliminates the need to maintain different copies of the same pages for different output.

You can enable mobile output for an existing HTML file, or create a new file with mobile output enabled.

**Procedure:** How to Enable Mobile Output for an Existing HTML File

1. Open the HTML file.
   
   The HTML canvas opens.

2. Open the Properties panel.

3. Change the Mobile property from No to Yes.
The HTML canvas shortcut menu now includes mobile output options.

**Procedure: How to Create a New File With Mobile Output Enabled**

1. On the Home tab, in the Content group, click **HTML/Document**. You can also create a new HTML file from the Application menu or by using the shortcut menu in the Environments tree panel, for a folder that supports content creation.

   The HTML/Document Wizard opens.

2. Navigate to where you want to create your HTML page and click **Next**.

   The Themes and Settings window of the HTML/Document Wizard opens.

3. Select the **Mobile design** check box.

   Selecting this option automatically sets the **Mobile** property to Yes in the Properties panel.

4. Click **Finish**.

   The HTML canvas opens. The canvas shortcut menu now includes mobile output options.

**Working With the Basic and Advanced Mobile Layouts**

There are two different layouts for designing HTML output for smartphones, Basic and Advanced.

- **Basic Mobile Layout**. Enables you to build simple smartphone pages that you can navigate using graphical icons and page-swipe. The Basic Mobile Layout displays individual frames from your HTML canvas on individual mobile pages, by default. You can change this as needed.

- **Advanced Mobile Layout**. Offers the same features as the Basic, but also gives you the additional ability to add a table of contents with or without a logo, and add a logo on each page.

In the Advanced Mobile Layout, all frames from your HTML canvas appear together on a single mobile page, by default. You can change this as needed.

Having selected one layout, you may choose to switch to the other, if needed. For more information, see *How to Change Between Basic and Advanced Mobile Layouts* on page 726.

**Procedure: How to Use the Basic Mobile Layout**

You can work with the Basic Mobile Layout when you have saved content in the HTML canvas and when you have set the Enable mobile property to Yes.

1. Right-click the HTML canvas and click **Show Mobile Layout (basic)**.

   The Basic Mobile Layout is displayed.
Styling for the components of the Mobile Layout is controlled by the cascading style sheet. For more information, see Cascading Style Sheet Class Mapping List for Mobile Components on page 731.

2. Edit the mobile content in the following ways:

- To preview all pages, right-click the Mobile Layout canvas and click Show all pages. This displays all pages side-by-side.

- A horizontal line appears below the navigation area. Any objects that appear below the line come from the HTML canvas, but were not automatically added to the Mobile Layout.

To add objects to the Mobile Layout, drag them from the area below the line to the desired place in the layout.

The system recognizes this as a manual modification to the Mobile Layout. This triggers a message: Manual modification of mobile layout will stop default generation of the pages. It will be your responsibility to maintain it.

Accepting this means that changes to the underlying data will not flow automatically to the mobile pages. You must open the HTML file, right-click the HTML canvas, and select Update Layout.

**Note:** You can undo manual modification of the Mobile Layout by right-clicking the canvas and clicking Reset mobile to default. This restores automatic update of the HTML pages, and removes any manual modifications.

To take advantage of the default generation of the pages, it is recommended that you avoid making manual modifications.

- To combine pages horizontally, drag one page to another.

- To change the home page, select the desired page, right-click the Mobile Layout canvas, and click Set current page as home page.

  Additionally, you can drag a page to the home page screen. If necessary, drag the old page to a different screen.

  **Note:** When you change the page order by manually dragging in the Mobile Layout, it overrides the page order specified in the Tasks & Animations panel.

- If there are any empty pages in your preview, right-click the canvas and click Remove empty pages.

3. Save the HTML file.
You can now view the HTML file on a smartphone. The layout is derived from the Mobile Layout. For more information, see Viewing Mobile Output on a Smartphone on page 730.

Additionally, you can view the HTML file on a desktop or tablet. The layout is derived from the HTML canvas.

**Procedure: How to Change Between Basic and Advanced Mobile Layouts**

To change between Basic and Advanced Mobile Layouts:

1. Right-click the existing Mobile Layout canvas and click Reset mobile to default.
   This restores the Mobile Layout to its original state.
2. Right-click the existing Mobile Layout canvas and click Back to desktop.
   The HTML canvas opens.
3. Right-click the HTML canvas and click the new layout, Show Mobile Layout (basic) or Show Mobile Layout (advanced).

**Procedure: How to Create a Table of Contents for Mobile Output**

With the Advanced Mobile Layout, you can include a table of contents page to help users navigate quickly. This may be useful when your mobile output contains a large number of pages.

To design output for smartphones that includes a table of contents:

1. Create an HTML page.
2. Right-click the HTML canvas and click Show mobile layout (advanced).
   The Mobile Layout opens and displays the table of contents preview, as shown in the following image.
The Mobile Layout default display shows a single page, which previews the appearance of the table of contents in a smartphone format.

In our example, this rectangle contains the title *HtmlPage*.

Styling for the components of the Mobile Layout is controlled by the cascading style sheet. For more information, see *Cascading Style Sheet Class Mapping List for Mobile Components* on page 731.

3. Edit your layout in the following ways:

- To change the title, use the drop-down at the top of the Properties panel and select *table_of_contents*. In the *Title* field, type the new title.

The new title now appears in the table of contents preview.
You can choose to show or to hide the table of contents on a smartphone. The default is to show it.

To hide the table of contents on a smartphone, select No from the Show at run time property field.

In the preview, the rectangles for each page represent hyperlinks in the table of contents, which open the selected page. In our example, there are hyperlinks for the task2 and load page titles.

To change page titles, select the Title property field for a specified page and type the desired title.

The new titles appear at the top of the page and on the table of contents.

4. Save the HTML file.

You can now view the HTML file with a table of contents on a smartphone. For more information, see Viewing Mobile Output on a Smartphone on page 730.

Procedure: How to Add a Logo to a Mobile Table of Contents

You can add a logo to the table of contents page of your mobile layout.

1. Open the Advanced Mobile Layout of an HTML file that has a table of contents.

   The logo placeholder is indicated by the cursor in the following image.

2. In the drop-down at the top of the Properties panel, click table_of_contents.

   The table of contents properties display.

3. In the Logo field, click the ellipsis button.

   The Open File dialog box appears.

4. Select the desired logo file and click OK.

   The logo now appears in the table of contents preview.
**Note:** The logo placeholder box provides an accurate preview of the way the logo will appear on a smartphone. It will indicate if the graphic file you selected needs to be resized.

5. **Save the HTML file.**

You can now view the HTML file with a table of contents on a smartphone. For more information, see *Viewing Mobile Output on a Smartphone* on page 730.

**Procedure:**  
**How to Add a Logo to Each Page of the Contents**

You can add a logo to each page of the table of the contents in your mobile layout.

1. **Open the Advanced Mobile Layout of an HTML file that has a table of contents.**

2. **Open a page, other than the table of contents page.**

   The small square near the top left of the page, indicated by the cursor in the following image, is a placeholder for a logo.

3. **In the drop-down at the top of the Properties panel, click `table_of_contents`.**

   The table of contents properties fields display.

4. **In the All swipes logo field, click the ellipsis button.**

   The Open File dialog box appears.

5. **Select the desired logo file and click `OK`.**

   The logo now appears on each page of the preview.

   **Note:** The logo placeholder for the individual pages is a small box. It provides an accurate preview of the way the logo will appear on a smartphone, and indicates whether the graphic file that you selected needs to be resized.

6. **Save the HTML file.**

   You can now view the HTML file with a table of contents on a smartphone. For more information, see *Viewing Mobile Output on a Smartphone* on page 730.
Viewing Mobile Output on a Smartphone

There are multiple ways that mobile output from App Studio can be viewed on a smartphone, depending upon the configuration of your environment. These include:

- Data Servers
- The Mobile Faves App

These ways are outlined in the following section.

**Note:** Check with your system administrator for your best practice in viewing mobile output.

**Data Servers - APPROOT**

During installation, App Studio and WebFOCUS set certain variables that affect the implementation. Your system administrator has the option of changing the values for these variables to meet site-specific needs. Most sites use the default values supplied during installation.

You can optionally specify the path in which files will reside on the web server and the WebFOCUS Reporting Server. The path is defined by the APPROOT variable, which you can set in two different files, one for the web server and one for the Reporting Server.

In App Studio, the Applications/baseapp folder typically resides on the APPROOT server. To view mobile output through Data Services:

1. Copy the mobile-enabled HTML file to the baseapp folder.
2. Open the baseapp copy of the file and run it.
   - A browser window opens showing the HTML content.
3. Copy the resulting URL from the browser, and email it to an account that is available on your smartphone.
4. Click the URL in your email.
   - The output opens in a browser, as designed in the Mobile Layout that you selected.

**Note:** Check with your system administrator if you need assistance viewing mobile output on your smartphone through Data Servers - APPROOT.
Mobile Faves App

The Mobile Faves app is automatically set up to obtain content from a server on the Internet, where you can view sample business content. You can add your own WebFOCUS servers to the list, including those that contain the HTML files that are enabled for mobile output. You will see a list of available folders saved to the selected server connection. These folders contain all of the content previously selected as Mobile Favorites from your WebFOCUS portal. To make an item appear in the Mobile Faves app, apply the FAVES tag to it. For more information, see the Using the WebFOCUS Home Page technical content.

iPhone or Android users can download the free Mobile Faves app from the App Store or the Google Play Store. For more information, refer to the Mobile Faves for Android User’s Manual or the Mobile Faves for iOS User’s Manual.

Cascading Style Sheet Class Mapping List for Mobile Components

This section contains a list of IBI classes that are used to style various components and controls for Mobile design.

<table>
<thead>
<tr>
<th>Components/Controls</th>
<th>Classes Used</th>
</tr>
</thead>
<tbody>
<tr>
<td>Smartphone container border color</td>
<td>.IBI_SmartPhoneContainer { border-color: #4C5E76; }</td>
</tr>
<tr>
<td>Control panel border color</td>
<td>.IBI_MobileControlPanel { border-top-color: #4C5E76; }</td>
</tr>
<tr>
<td>Control panel font</td>
<td>.IBI_MobileControlPanel { font-size: small; color: green; }</td>
</tr>
<tr>
<td>Page content font</td>
<td>.IBI_MobilepageContent { font-size: large; color: Red; }</td>
</tr>
<tr>
<td>TOC content font</td>
<td>.IBI_MobileTocContent { font-size: large; color: Blue; }</td>
</tr>
</tbody>
</table>
Cascading Style Sheet Support Matrix for Internet Explorer

The following table is a list of all Cascading Style Sheet (CSS) properties and whether they are supported in Internet Explorer 9 and Internet Explorer 10.

<table>
<thead>
<tr>
<th>CSS Property</th>
<th>Internet Explorer 9</th>
<th>Internet Explorer 10</th>
</tr>
</thead>
<tbody>
<tr>
<td>Borders</td>
<td></td>
<td></td>
</tr>
<tr>
<td>border-radius</td>
<td>Supported</td>
<td>Supported</td>
</tr>
<tr>
<td>box-shadow</td>
<td>Supported</td>
<td>Supported</td>
</tr>
<tr>
<td>border-image</td>
<td>Not Supported</td>
<td>Not Supported</td>
</tr>
<tr>
<td>Background</td>
<td></td>
<td></td>
</tr>
<tr>
<td>background-size</td>
<td>Supported</td>
<td>Supported</td>
</tr>
<tr>
<td>background-origin</td>
<td>Supported</td>
<td>Supported</td>
</tr>
<tr>
<td>Animations</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CSS Property</td>
<td>Internet Explorer 9</td>
<td>Internet Explorer 10</td>
</tr>
<tr>
<td>----------------------------</td>
<td>---------------------</td>
<td>----------------------</td>
</tr>
<tr>
<td>keyframes</td>
<td>Not Supported</td>
<td>Supported</td>
</tr>
<tr>
<td>animation</td>
<td>Not Supported</td>
<td>Supported</td>
</tr>
<tr>
<td>animation-name</td>
<td>Not Supported</td>
<td>Supported</td>
</tr>
<tr>
<td>animation-duration</td>
<td>Not Supported</td>
<td>Supported</td>
</tr>
<tr>
<td>animation-timing-function</td>
<td>Not Supported</td>
<td>Supported</td>
</tr>
<tr>
<td>animation-delay</td>
<td>Not Supported</td>
<td>Supported</td>
</tr>
<tr>
<td>animation-iteration-count</td>
<td>Not Supported</td>
<td>Supported</td>
</tr>
<tr>
<td>animation-direction</td>
<td>Not Supported</td>
<td>Supported</td>
</tr>
<tr>
<td>animation-play-state</td>
<td>Not Supported</td>
<td>Supported</td>
</tr>
<tr>
<td>Text</td>
<td></td>
<td></td>
</tr>
<tr>
<td>text-shadow</td>
<td>Not Supported</td>
<td>Supported</td>
</tr>
<tr>
<td>word-wrap</td>
<td>Supported</td>
<td>Supported</td>
</tr>
<tr>
<td>text-overflow</td>
<td>Supported</td>
<td>Supported</td>
</tr>
<tr>
<td>word-break</td>
<td>Supported</td>
<td>Supported</td>
</tr>
<tr>
<td>text-justify</td>
<td>Not Supported</td>
<td>Supported</td>
</tr>
<tr>
<td>2D and 3D Transforms</td>
<td></td>
<td></td>
</tr>
<tr>
<td>transform</td>
<td>ms-transform - only 2D</td>
<td>Supported - 2D and 3D</td>
</tr>
<tr>
<td>transform-origin</td>
<td>ms-transform - only 2D</td>
<td>Supported - 2D and 3D</td>
</tr>
<tr>
<td>transform-style</td>
<td>Not Supported</td>
<td>Supported</td>
</tr>
<tr>
<td>perspective</td>
<td>Not Supported</td>
<td>Supported</td>
</tr>
<tr>
<td>perspective-origin</td>
<td>Not Supported</td>
<td>Supported</td>
</tr>
<tr>
<td>backface-visibility</td>
<td>Not Supported</td>
<td>Supported</td>
</tr>
</tbody>
</table>
### Cascading Style Sheet Support Matrix for Internet Explorer

<table>
<thead>
<tr>
<th>CSS Property</th>
<th>Internet Explorer 9</th>
<th>Internet Explorer 10</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Fonts</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>font-feature-settings</td>
<td>Not Supported</td>
<td>Supported</td>
</tr>
<tr>
<td>hyphens</td>
<td>Not Supported</td>
<td>ms-hyphens</td>
</tr>
<tr>
<td>hyphenate-limit-zone</td>
<td>Not Supported</td>
<td>ms-hyphenate-limit-zone</td>
</tr>
<tr>
<td>hyphenate-limit-chars</td>
<td>Not Supported</td>
<td>ms-hyphenate-limit-chars</td>
</tr>
<tr>
<td>hyphenate-limit-lines</td>
<td>Not Supported</td>
<td>ms-hyphenate-limit-lines</td>
</tr>
<tr>
<td><strong>Multi Column Layout</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>columns</td>
<td>Not Supported</td>
<td>Supported</td>
</tr>
<tr>
<td>column-count</td>
<td>Not Supported</td>
<td>Supported</td>
</tr>
<tr>
<td>column-gap</td>
<td>Not Supported</td>
<td>Supported</td>
</tr>
<tr>
<td>column-rule</td>
<td>Not Supported</td>
<td>Supported</td>
</tr>
<tr>
<td>column-rule-color</td>
<td>Not Supported</td>
<td>Supported</td>
</tr>
<tr>
<td>column-rule-style</td>
<td>Not Supported</td>
<td>Supported</td>
</tr>
<tr>
<td>column-rule-width</td>
<td>Not Supported</td>
<td>Supported</td>
</tr>
<tr>
<td>column-span</td>
<td>Not Supported</td>
<td>Supported</td>
</tr>
<tr>
<td>column-width</td>
<td>Not Supported</td>
<td>Supported</td>
</tr>
<tr>
<td>column-fill</td>
<td>Not Supported</td>
<td>Supported</td>
</tr>
<tr>
<td>break-after</td>
<td>Not Supported</td>
<td>Supported</td>
</tr>
<tr>
<td>break-before</td>
<td>Not Supported</td>
<td>Supported</td>
</tr>
<tr>
<td>break-inside</td>
<td>Not Supported</td>
<td>Supported</td>
</tr>
<tr>
<td><strong>Transitions</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>transition</td>
<td>Not Supported</td>
<td>Supported</td>
</tr>
<tr>
<td><strong>CSS Property</strong></td>
<td><strong>Internet Explorer 9</strong></td>
<td><strong>Internet Explorer 10</strong></td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-------------------------</td>
<td>--------------------------</td>
</tr>
<tr>
<td>transition-property</td>
<td>Not Supported</td>
<td>Supported</td>
</tr>
<tr>
<td>transition-duration</td>
<td>Not Supported</td>
<td>Supported</td>
</tr>
<tr>
<td>transition-timing-function</td>
<td>Not Supported</td>
<td>Supported</td>
</tr>
<tr>
<td>transition-delay</td>
<td>Not Supported</td>
<td>Supported</td>
</tr>
</tbody>
</table>

**User Interface**

<table>
<thead>
<tr>
<th><strong>Property</strong></th>
<th><strong>Internet Explorer 9</strong></th>
<th><strong>Internet Explorer 10</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>resize</td>
<td>Not Supported</td>
<td>Not Supported</td>
</tr>
<tr>
<td>border-box</td>
<td>Not Supported</td>
<td>Not Supported</td>
</tr>
<tr>
<td>outline-offset</td>
<td>Not Supported</td>
<td>Not Supported</td>
</tr>
<tr>
<td>appearance</td>
<td>Not Supported</td>
<td>Not Supported</td>
</tr>
</tbody>
</table>

**Gradients**

<table>
<thead>
<tr>
<th><strong>Property</strong></th>
<th><strong>Internet Explorer 9</strong></th>
<th><strong>Internet Explorer 10</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>linear-gradient</td>
<td>Not Supported</td>
<td>Supported - ms-linear-gradient</td>
</tr>
<tr>
<td>radial-gradient</td>
<td>Not Supported</td>
<td>Supported - ms-radial-gradient</td>
</tr>
<tr>
<td>repeating-linear-gradient</td>
<td>Not Supported</td>
<td>Supported - ms-repeating-linear-gradient</td>
</tr>
<tr>
<td>repeating-radial-gradient</td>
<td>Not Supported</td>
<td>Supported - ms-repeating-radial-gradient</td>
</tr>
</tbody>
</table>

**Cascading Style Sheet Class Mapping List**

This section contains a list of IBI classes that are used to style various components and controls.
<table>
<thead>
<tr>
<th>Components/Controls</th>
<th>Classes Used</th>
</tr>
</thead>
<tbody>
<tr>
<td>Body</td>
<td>IBI_PageBg</td>
</tr>
<tr>
<td>Report</td>
<td>IBI_Report-iFrame; IBI_rounded_m</td>
</tr>
<tr>
<td>Chart</td>
<td>IBI_Report-iFrame; IBI_rounded_m</td>
</tr>
<tr>
<td>Hyperlink</td>
<td>IBI_LinkItem</td>
</tr>
<tr>
<td>Button</td>
<td>IBI_button</td>
</tr>
<tr>
<td>Reset</td>
<td>IBI_button</td>
</tr>
<tr>
<td>Label</td>
<td>IBI_ReportControlLabel</td>
</tr>
<tr>
<td>Form</td>
<td>IBI_ReportControlPanel; IBI_rounded_m</td>
</tr>
<tr>
<td>Submit Button</td>
<td>IBI_button; IBI_btn-run</td>
</tr>
<tr>
<td>Reset Button</td>
<td>IBI_button; IBI_btn-reset</td>
</tr>
<tr>
<td>Save Selection Button</td>
<td>IBI_btn-saveselection</td>
</tr>
<tr>
<td>Defer Button</td>
<td>IBI_btn-defer</td>
</tr>
<tr>
<td>Schedule Button</td>
<td>IBI_btn-schedule</td>
</tr>
<tr>
<td>Panel</td>
<td>IBI_Panel; IBI_rounded_m</td>
</tr>
<tr>
<td>Map</td>
<td>IBI_ReportControlTarget</td>
</tr>
<tr>
<td>Frame</td>
<td>IBI_rounded_m</td>
</tr>
<tr>
<td>Edit box</td>
<td>IBI_ReportControlTarget; IBI_rounded_s</td>
</tr>
<tr>
<td>Drop down</td>
<td>IBI_ReportControlTarget; IBI_rounded_s</td>
</tr>
<tr>
<td>List Box</td>
<td>IBI_ReportControlTarget; IBI_rounded_s</td>
</tr>
<tr>
<td>Double List</td>
<td>IBI_ReportControlTarget, IBI_btn-up, IBI_btn-down, IBI_btn-left, IBI_btn-right</td>
</tr>
<tr>
<td>Radio Button</td>
<td>IBI_ReportControlTarget; IBI_Radio</td>
</tr>
<tr>
<td>Check Box</td>
<td>IBI_ReportControlTarget; IBI_CheckBox</td>
</tr>
<tr>
<td>Components/Controls</td>
<td>Classes Used</td>
</tr>
<tr>
<td>----------------------------------------</td>
<td>------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Text Area</td>
<td>IBI_rounded_m</td>
</tr>
<tr>
<td>Single Source Tree</td>
<td>IBI_ReportControlTarget</td>
</tr>
<tr>
<td>Multi Source Tree</td>
<td>IBI_ReportControlTarget</td>
</tr>
<tr>
<td>Horizontal Slider</td>
<td>IBI_ReportControlTarget; IBI_rounded_s; IBI_SliderInput; IBI_buttonSliderNav; IBI_btn-left; IBI_btn-right; IBI_SliderTrack; IBI_SliderHandle</td>
</tr>
<tr>
<td>Vertical Slider</td>
<td>IBI_ReportControlTarget; IBI_rounded_s; IBI_SliderInput; IBI_buttonSliderNav; IBI_buttonSliderNavVert; IBI_btn-up; IBI_btn-down; IBI_SliderTrack; IBI_SliderTrackVert; IBI_SliderHandle; IBI_SliderHandleVert</td>
</tr>
<tr>
<td>Info Window</td>
<td>IBI_InfoWnd; IBI_InfoWndTitleBar; IBI_InfoWndFrame</td>
</tr>
<tr>
<td>Tab</td>
<td>IBI_MultiContentPlugin</td>
</tr>
<tr>
<td>Tab Header</td>
<td>IBI_pageHeader</td>
</tr>
<tr>
<td>TabHeader - Top Tab</td>
<td>IBI_pageHeaderTab_TopBottom</td>
</tr>
<tr>
<td>TabHeader - Bottom Tab</td>
<td>IBI_pageHeaderTab_Bottom</td>
</tr>
<tr>
<td>TabHeader - Left Tab</td>
<td>IBI_pageHeaderTab_Left</td>
</tr>
<tr>
<td>TabHeader - Right Tab</td>
<td>IBI_pageHeaderTab_Right</td>
</tr>
<tr>
<td>Tab Selected</td>
<td>IBI_pageHeader_Selected</td>
</tr>
<tr>
<td>Vertical Tab/Accordion/Window</td>
<td>IBI_pageHeader_Vertical</td>
</tr>
<tr>
<td>Vertical Tab/Accordion/Window Selected</td>
<td>IBI_pageHeaderVertical_Selected</td>
</tr>
<tr>
<td>Tab Heading Text</td>
<td>IBI_pageHeaderText</td>
</tr>
<tr>
<td>Tab Heading Text - Left Tab</td>
<td>IBI_textVerticalTopToBottom</td>
</tr>
<tr>
<td>Components/Controls</td>
<td>Classes Used</td>
</tr>
<tr>
<td>------------------------------------------------</td>
<td>--------------------------------------------------</td>
</tr>
<tr>
<td>Tab Heading Text - Right Tab</td>
<td>IBI_textVerticalBottomToTop</td>
</tr>
<tr>
<td>Tab/Window/Accordion Content</td>
<td>IBI_pageContent</td>
</tr>
<tr>
<td>Tab/Window/Accordion Content - Top</td>
<td>IBI_pageContentTab_Top</td>
</tr>
<tr>
<td>Tab/Window/Accordion Content - Bottom</td>
<td>IBI_pageContentTab_Bottom</td>
</tr>
<tr>
<td>Tab/Window/Accordion Content - Left</td>
<td>IBI_pageContentTab_Left</td>
</tr>
<tr>
<td>Tab/Window/Accordion Content - Right</td>
<td>IBI_pageContentTab_Right</td>
</tr>
<tr>
<td>Tab/Accordion/Window Min/Max box</td>
<td>IBI_windowNavBox</td>
</tr>
<tr>
<td>Tab/Accordion/Window images</td>
<td>IBI_windowMaxRestore; IBI_windowMaximize; IBI_windowMinimize; IBI_windowTiles; IBI_windowFlipRight; IBI_windowFlipLeft</td>
</tr>
</tbody>
</table>

**Mobile components**

<table>
<thead>
<tr>
<th>Component</th>
<th>Classes Used</th>
</tr>
</thead>
<tbody>
<tr>
<td>Smartphone container border color</td>
<td>IBI_SmartPhoneContainer</td>
</tr>
<tr>
<td>Control panel</td>
<td>IBI_MobileControlPanel</td>
</tr>
<tr>
<td>Page content</td>
<td>IBI_MobilepageContent</td>
</tr>
<tr>
<td>TOC content</td>
<td>IBI_MobileTocContent</td>
</tr>
<tr>
<td>Label</td>
<td>IBI_MobileLabel</td>
</tr>
<tr>
<td>TOC title</td>
<td>IBI_MobileTocTitle</td>
</tr>
<tr>
<td>TOC task name</td>
<td>IBI_MobileTocItem</td>
</tr>
<tr>
<td>Control panel text</td>
<td>IBI_MobileSwipeHeaderText</td>
</tr>
</tbody>
</table>
Creating Documents

A document is a series of pages that can contain reports, images, charts, and other information. A document is typically output as a PDF, or a Microsoft Excel or PowerPoint file.


This topic describes how to launch the HTML/Document Wizard to create documents. It also identifies and explains the tabs and panels that are available when you are developing documents in the Document canvas.

In this chapter:

- Launching the HTML/Document Wizard
- Accessing Document and In-Document Analytic Dashboard Components
- Previewing the Document Canvas
- Editing Document Canvas Properties
- Supporting Template Masters and Slide Layouts in App Studio-Generated Presentations

Launching the HTML/Document Wizard

The HTML/Document Wizard allows you to create a new HTML Page, Guided Report Page, or Document, and open a recent procedure. This section details how to create an HTML page using the HTML/Document Wizard.

To open the HTML/Document Wizard:

- On the Home tab, in the Content group, click HTML/Document.

- In the Environments Tree panel, right-click an application folder, point to New, and click HTML/Document.

**Note:** If you choose to create a new HTML page or Document using the shortcut menu in the Environments Tree panel, your wizard will not include a Navigator panel since the location of your HTML page or Document is already selected.
The HTML/Document Wizard opens, as shown in the following image.

![HTML/Document Wizard Image]

From the HTML/Document Wizard, you can open a recent procedure or create a new one.

**Procedure:** How to Create a Document Using the HTML/Document Wizard

Use the HTML/Document Wizard to create a FOCUS executable (.fex) document, as detailed below. After you have launched the HTML/Document Wizard:

1. In the File Type area, select *Document*.
2. Navigate to where you want to create the new procedure or select a recent procedure.
   
   **Note:** If you used the shortcut menu in the Environments Tree panel to create your document, a location is already selected.
4. Click Finish.
   
   **Note:** The Finish button is unavailable until you select a valid path.

   The Document canvas and Properties panel open. You can now add data to your document and format the data using the tabs in the ribbon.
5. Click the page layout to add objects to the page.
6. To save your document, click the Save button on the Quick Access Toolbar, or select Save from the Application menu.
The document is saved with a .fex extension.

7. To run your document, click Run on the Quick Access Toolbar, or click Run from the Application menu.

**Procedure: How to Select Document Output Format Using the HTML/Document Wizard**

Use the HTML/Document Wizard to create a document that you can output in various formats.

After you choose an output format, the program associated with that format opens when you click the Run button on the Quick Access Toolbar. For example, if you select one of the PowerPoint options (PPTX or PPT), PowerPoint opens to preview your document when you click Run.

In the HTML/Document Wizard:

1. In the File Type area, select Document.

2. Navigate to where you want to create the new procedure or select a recent procedure.

   **Note:** If you used the shortcut menu in the Environments Tree panel to create your document, a location is already selected.

3. Click Next.

   The Document Properties dialog box opens.

4. Use the Output Format list to choose one of the following output formats:
   - PDF
   - DHTML
   - PowerPoint (PPTX or PPT)
   - Analytic Document (HTML)
   - Excel (XLXS or XLS)
   - Excel Formula (XLXS or XLS)
   - Analytic Document (PDF)
   - User (to display a run time prompt for selecting the output format)

5. In the Coordinate Report list, select On if you want all reports and graphs that contain a common sort field to be burst into separate page layouts. Each value for the first sort field displays on a separate page.

   Additionally, in this area, you can specify page size, page orientation, and units of measure.
To add additional pages, select *Add Table of Contents* and/or *Add Master Page*.

6. Click *Finish*.

   The Document canvas opens.


8. To view it in the selected output format, click *Run* on the Quick Access Toolbar, or click *Run* from the Application menu.

## Accessing Document and In-Document Analytic Dashboard Components

The following topics describe the tabs and panels that are available when you create a document or In-Document Analytic dashboard in the Document canvas.

### Inserting Components and Controls in a Document or In-Document Analytic Dashboard Using the Insert Tab

You can insert components and controls in a document or In-Document Analytic dashboard. The Insert tab contains the Components, Controls, and Pages groups, as shown in the following image.

![Insert Tab](image)

### Inserting Components in a Document or In-Document Analytic Dashboard Using the Components Group

You can insert a report, chart, image, text, or line component in a document or In-Document Analytic dashboard. The Components group is shown in the following image.

![Components Group](image)
The components are:

**Report**

Inserts a report object. You can add reports to the Document canvas that appear when you run the layout. You can either embed or reference reports. Double-clicking a blank report object opens the Report canvas, where you can create and style a report to be used on the Document canvas.

You can also include parameters in a report. The values of the parameters can be assigned with controls that are added on the Document canvas.

**Chart**

Inserts a chart object. You can add charts to the Document canvas that appear when you run the layout. You can either embed or reference charts. Double-clicking a blank chart object opens the Chart canvas, where you can create and style a chart to be used on the Document canvas.

**Note:**

- HTML5 charts contain syntax that is currently not supported on the Document canvas, unless the output format is PDF Analytic Document or HTML Analytic Document.

- In the Domains area, when you reference or import an existing chart procedure, the Open File dialog box will only show charts that contain an output format of PDF Analytic Document or HTML Analytic Document.

- In the Data Servers area, when you reference or import an existing chart procedure, selecting an output format other than PDF Analytic Document or HTML Analytic Document may result in a *not enough data to draw chart* message.

**Image**

Inserts an image. You can add an image, such as a company logo, to the layout.

You can insert an image into your document and add a hyperlink to it. After you run your document, and click the image, you can launch a URL, or run a report.

**Note:** An inserted image must be referenced from a specific directory location.

**Text**

Inserts a text box. You can add text, such as headings, to your webpage. You can add directions or explanations for your reports and charts.
**Line**

Inserts a line. You can add a horizontal or vertical line to distinguish between sections of your launch or display page.

**Procedure: How to Format Text in a Document**

You may apply various formatting and style options to words and individual text characters within the text object.

*Note:* Any formatting and styling that you may have applied to individual text strings within the text object will remain unchanged.

1. On the **Insert** tab, in the **Components** group, click **Text**.
   
   The pointer changes to a crosshair.

2. Drag your pointer across the canvas to create a text object.
   
   A text object with the default text, *Enter text*, is created.

3. Highlight the text that you wish to format.

4. Right-click the text, point to **Style**, and then click **Font**.
   
   The Font dialog box opens.

   *Note:* You can also access font formatting options in the Properties panel. The Properties panel also allows you to specify whether or not to wrap text that exceeds the width of the text object.

5. Select from the formatting options available. You can change the type, style, color, size, and effect of the font.

6. Click **OK** to close the Font dialog box.

   The formatting options that you selected applied to the text.

**Procedure: How to Insert a Bulleted List or Numbered List Into a Text Element**

To insert a bulleted list or numbered list into a text object:

1. On the **Insert** tab, in the **Components** group, click **Text**.
   
   The pointer changes to a crosshair.

2. Drag your pointer across the canvas to create a text object.
   
   A text object with the default text, *Enter text*, is created.

3. Add multiple lines of text to the text object.

4. Highlight and right-click the text that you want to include in the list.
5. In the shortcut menu, select one of the following list options:

- **Bullets**
  - Disc
  - Circle
  - Square

- **Numbering**
  - Numbers
  - Lowercase Letters
  - Uppercase Letters
  - Small Roman numerals
  - Large Roman numerals

**Note:**

- Alternatively, you can select a bullet type before typing text to begin the list. Pressing enter will begin the next item in the list on a separate line.

- To change the bullet or number list type of an existing list, place your pointer on the list level you want to change and reselect a bullet or number list type. Selecting None will remove the bullets or numbers for that level and move any nested lists up one level. In order to switch between bullets and numbers, you must first remove the current list option by selecting None and then applying the list option you want.

- Bullets and numbering are not applied to documents using the DHTML output format.

**Procedure:** **How to Insert Nested Lists Into a Text Element**

To insert a nested list into the text object:

1. On the Insert tab, in the Components group, click Text.

   The pointer changes to a crosshair.

2. Drag your pointer across the canvas to create a text object.

   A text object with the default text, Enter text, is created.

3. Add a list to the text object. For more information, see How to Insert a Bulleted List or Numbered List Into a Text Element on page 744.
4. Place your pointer after a list item.

5. Right-click, point to Nested List and then select a bulleted or numbered list option.
   A list is started within the current list, allowing you to enter text on that list level.
   
   **Note:** Pressing tab while your pointer is on the same line as a list item will move that item one level down, resulting in a nested list. The bullet or number type selected is the next list type in the right-click shortcut menu. For example, if you have a bulleted list that uses the disc bullet type, pressing tab to move an item down one level will cause that nested list to have the circle bullet type.

   You can continue to nest lists within other lists by using the same steps shown above.
   
   **Note:** You cannot skip a list level. For example, in order to insert a nested bulleted list or nested numbered list on a lower level, there must be a list one level up from it.

### Inserting Controls in an In-Document Analytic Dashboard Using the Controls Group

You can insert an edit box, drop-down list, list box, radio button, or check box control in an In-Document Analytic dashboard. The Controls group is shown in the following image.

![Controls Group Image]

The controls are:

**Edit Box**

Inserts a text box. You can enter a value in the text box.

**Drop Down**

Inserts a drop-down list. A drop-down list enables you to select single or multiple values from a list of supplied values. In order to provide multiple values, the procedure must be set up to accept multiple values.

- From a single-select list, you can select only one value each time a request is run.

- From a multi-select list, you can select multiple values at once using the check boxes adjacent to the values.

You can use a dynamic or static list of values for the drop-down list.
**List Box**

Inserts a list. You can select single or multiple values at one time from a list box:

- From a single-select list, you can select only one value for each time a request is run.
- From a multiselect list, you can select multiple values all at once by holding down the Ctrl key as you select values.

In order to provide multiple values, the procedure must be set up to accept multiple values.

List box values can be dynamic or static.

**Radio Button**

Inserts a radio button. Using a radio button, you can only select a single value from a list of supplied values. Radio button values can be static or dynamic.

**Check Box**

Inserts a check box into an HTML Analytic Document or PDF Analytic Document file. You can select multiple values from multiple check boxes.

---

**Procedure: How to Change the Font Styling of In-Document Analytic Dashboard Controls**

You can use the Styling: Font property in the Document canvas Properties panel to change the font used in an In-Document Analytic dashboard control.

1. Create a new document, or open an existing document, using the HTML Analytic Document or PDF Analytic Document output format.
2. Add content, such as a chart or report, to the document.
3. On the Insert tab, in the Controls group, select a control type and add it to the page.
4. Select the control and configure it using the Settings panel.
   - In the Settings panel, select a report and column from which to display values, then configure the filter properties and specify the target reports.
5. Select the control and open the Properties panel.
6. Click the ellipsis button next to the Styling: Font property.
   - The Font dialog box opens.
7. Select the font styling properties that you wish to use in the control. You can change the font, font style, size, and color, and add an underline.
8. Click OK to accept your changes.
9. Click Run to load your document.
Adding Pages to a Document or In-Document Analytic Dashboard Using the Pages Group

You can add a new or existing page, or a Table of Contents, Page Master, or size and overflow page in a document or In-Document Analytic dashboard. The Pages group is shown in the following image.

The commands are:

**New**

Inserts a new page to the Page Layout canvas. The new page appears below the current page and is named Page layout \( n \), where \( n \) is a number that increments by 1.

**Note:**

- You can also right-click the Page Layout canvas and select *Insert new page after* or *Insert new page before* to indicate where to include the new page.
- To delete a page, select the page in the Page Layout canvas and press the *Delete key* on the keyboard.

**Existing**

Inserts an existing page. This page can contain images, drawing objects, text, page settings, reports, and charts.

To insert an existing page into your document, it must be saved as a procedure and exist somewhere in the WebFOCUS environment.

**Note:**

- You can also right-click the Page Layout canvas and select *Insert existing page after* or *Insert existing page before* to indicate where to include the existing page.
- To delete a page, select the page in the Page Layout canvas and press the *Delete key* on the keyboard.
Table of Contents

You can generate a Table of Contents page that shows a summary of the contents of the document, along with page numbers, and that can be printed with the document.

The entries can link to any component of the compound output (page, report, or graph) and vertical sort field values (BY field values) within each component report. The entries in the Table of Contents enable you to easily navigate to a particular section while viewing the document online.

When creating a compound layout report or a coordinated compound report, you can enable bookmarks available in Adobe® Acrobat® for PDF formatted reports. Bookmarking uses the Table of Contents descriptions, and the Table of Contents page and levels, to show specific reference points in the compound document.

**Note:** You cannot add a report, chart, image, text, or line object to the Table of Contents page. These commands are disabled when the Table of Contents is selected.

Master

Inserts a Page Master. A Page Master is a page that can be added in the Design View where you can add and edit repeating elements, such as the company logo, or page numbers. Any element placed on the Page Master repeats on every page in the resulting report.

**Note:** You cannot add a report or chart to the Page Master. These options are disabled when the Page Master is selected.

Overflow

Sets the size and overflow of a report object at run time.

You can control the overflow and relative (vertical) positioning of reports and graphs in coordinated compound documents so that reports fill the entire page, as well as maintain their relative position in the document.

Overflow is defined as the area of a report that exceeds its defined space in the page layout. For example, a multi-page report and a graph can both be added to a single page layout with the graph positioned beneath the report.

The report can flow or fill the page and the graph can be relatively positioned to the report, so it is placed at the end of the document following the complete rendering of the report.

Overflow and positioning options are available from the Properties window and from the Positioning toolbar.
Add Dashboard Bar

Inserts a Dashboard Bar into an In-Document Analytic dashboard. A Dashboard Bar is an additional page layout where you can insert controls, reports, and charts that display above the dashboard tabs.

The Dashboard Bar is only available for the HTML Analytic Document formatted documents. A Dashboard Bar can be a maximum of one page.

You can insert a Dashboard Bar into PDF Analytic Document formatted documents. However, if you run these documents, an empty page is returned.

Procedure: How to Create a Table of Contents Page

1. Create a new document, or open an existing document.
2. From the Insert tab, in the Pages group, click Table of Contents.

The Table of Contents page appears in the document.

Table of Contents is the default title for the page. To edit the title, select the current title and type your new title.

To style the title, select the text, right-click it, and in the shortcut menu that opens, point to Style, and select from among the following options: Bold, Italic, Underline, or Superscript.

In addition, you can select Font to open the Font dialog box, where you can set the font, font style, font size, font color, and font effects.

Note: The text does not wrap and must fit within the width of the overall text element.

3. Click Run to load your document.

The Table of Contents appears as the first page in your output.

4. Click a hypertext link on the Table of Contents page to jump to that section within the document.

Procedure: How to Control Which Objects Appear in the Table of Contents

Note: The objects that appear in the Table of Contents depend on whether the document is coordinated or uncoordinated. By default, all report, chart, and page layout objects appear in the Table of Contents for uncoordinated documents.

To control which objects appear in the Table of Contents:

1. Select a report, chart, or page layout object.

Each object has a TOC description, TOC level option, and TOC Number of sort levels in the Properties panel.
2. To change the name of the description for the object, type over the **TOC description** in the Properties panel.  
This description appears in the Table of Contents at run time.

3. To change the hierarchical order of how the object appears in the Table of Contents, type a TOC level.

   For example:
   
   0 = the object is not shown in the Table of Contents.
   1 = the object is shown as a first level item in the Table of Contents.
   2 = the object is shown as a second level item in the Table of Contents.

   Follow this sequence for additional levels.

   These levels appear in the Table of Contents at run time.

4. To change the number of vertical sort fields (TOC levels) that appear in the Table of Contents for the component, use the up or down arrow to adjust **TOC Number of sort levels** in the Properties panel. If the value designated is greater than the count of BY fields in the component report, then the value defaults to the total count of available BY fields.

   **Note:** Coordinated reports do not support TOC Number of sort levels within a compound TOC. Those entries are ignored for coordinated reports.

5. Run the procedure to see the updated TOC description and TOC levels.

**Procedure:** How to Use Bookmarks

1. Create a compound layout that is made up of multiple reports and/or charts.

2. Use the Properties panel to select each report/chart, and enter a bookmark (Table of Contents) description, or use the default selections.

   **Note:** The Table of Contents page might or might not be included in the compound document, however, the descriptions and levels that appear as bookmarks are set through these options.

3. In the Properties panel, from the Properties list, select **Compound document**.

4. From the Bookmarking drop-down list, select **On**.

   **Note:** Bookmarking is off by default.

5. Click **Run** to load your document.

   The bookmark tab is expanded in the PDF output.

6. Click a bookmark link to jump to that section within the document.
Procedure: How to Create a Page Master
1. Create a new document, or open an existing document.
   The document opens on the Document canvas.
2. From the Insert tab, in the Pages group, click Master.
   The Page Master is added to the document.
3. Add components (text, images, lines) and set their properties on the Page Master.
   Note: Only text, images, and lines can be added to the Page Master.
4. Click Save to save your new Page Master or to save your changes to an existing Page Master.

Procedure: How to Use an Existing Page Master in Another Document
1. Create a new document, or open an existing document.
2. From the Insert menu, in the Pages group, click Existing.
   The Open dialog box opens.
3. Select the procedure file (.fex) that contains the Page Master.
4. Click OK.
   If a Page Master has already been added to the document, a message appears stating that a Page Master already exists in the current layout. You can respond in one of the following ways:
   - Click Yes to replace the existing Page Master with the new one.
   - Click No to merge the two Page Masters.
   - Click Cancel to use the existing Page Master, instead of the Page Master from the Page Layout template.
5. Save the document.

Procedure: How to Customize the Overflow for a Fixed Report
1. Select an object from the Design View.
   The Properties panel shows the available properties for the selected object.
2. Select Fixed from the Size and Overflow drop-down list.
Note: Fixed is the default selection. If Not Set is selected, Fixed is used as the default.

3. Right-click the fixed report in the Design View and select Customize Fixed Overflow.

The overflow page is added after the page layout in the Design View, displaying a copy of the fixed component (with the original size and position) from the page layout. Scroll down in the Design View until you see the overflow page.

4. Resize the report to fill the page. You can also reposition the report overflow.

5. Run the report.

Note: If the document contains multiple fixed reports, the report output maintains the same size and position as the report objects on the Document canvas.

Procedure: How to Set the Flowing Report Property

1. Select an object from the Design View.

The Properties panel shows the available properties for the selected object.

2. Click Flowing from the Size and Overflow drop-down list.

Note: Repeat this step for any surrounding report objects to prevent the overlapping of reports and charts at run time.

Tip: When set to Flowing, flow margins are available for the page layout. These margins further enable you to adjust the page so that the report fills each page between the flow margins.

3. Run the document.

Note:

- If the document contains multiple flowing reports, the reports might overlap at run time. If you want one report to run until completion before the next report begins, you must set the relationship between the reports.

- If the document contains a flowing report and a chart, the chart might overlap the report at run time. If you want the report to run until completion before the chart begins, you must set the relationship between the chart and the report.

Procedure: How to Set Flow Margins for the Page Layout

When using Flowing overflow, each page layout has flow margins. Flow margins are set through the top and bottom margins. Flowing reports utilize flow margins to ensure that all reports fill the page, or the selected portion of the page, and that the header and footer information is preserved in the output.
**Note:** Flow margins are not available for Fixed overflow.

To set flow margins for the page layout:


   **Note:** Ensure that the report object is set to Flowing overflow.

2. From the Properties panel, type a value for the *flow margin: bottom* property.

   The flow margin bottom value sets the ending vertical coordinate where a flowing report ends on each page.

3. From the Properties panel, type a value for the *flow margin: top* property.

   The flow margin top value sets the beginning vertical coordinate where a flowing report starts on each new page.

   **Note:** When flow margins are changed from the default value, you can see the flow margins in the Design View of the Document canvas.

4. Adjust the objects in the Design View between the flow margins and run the report.

   The report fills each page between the flow margins until it reaches the end.

**Procedure:** *How to Add a New Overflow Page to a Page Layout*

Each page layout works independent of any other page layout in the coordinated compound document. This enables you to add a new header and footer for each individual page layout and associated overflow pages. The following procedure describes how to add a new overflow page from the page layout.

You can use any of the following methods to create an overflow page.

- From a fixed report component in a coordinated compound document.

  Select the report component on the page and from the shortcut menu, right-click and select *Customize Fixed Overflow*.

  The overflow page, displaying a copy of the fixed component (with the original size and position) from the page layout, is added after the page layout in Design View. This enables you to move and resize the overflow object and add reports and charts (as header and footer information) around the overflowing object.

- On a page layout with a fixed or flowing report.

  From the New Page Layout drop-down list, select *Add New Overflow Page*.

- Click anywhere on the page layout, right-click and, from the shortcut menu, select *Add New Overflow Page*.
The overflow page is added after the page layout in the Design View. You can add reports and charts to the overflow page.

**Note:** If there is a flowing report component, any flow margins defined on the page layout will also appear on the overflow page. This enables you to move and resize the flow margins and add reports and charts (as header and footer information) around the flow margins.

The overflow page is identified as Page layout \( n \), overflow object, where \( n \) is the number of the corresponding page layout.

**Procedure:** How to Add Header and Footer Information to the Overflow Page

You can add report and chart components on the overflow page as header and footer information for the overflow data, and position and size the components. You can copy existing components from the page layout, or add new report and chart components. All components added to the overflow page are automatically assigned as fixed components on the overflow page.

**Note:** The report and chart components added as headers and footers should not generate additional overflow.

1. To copy an existing report or chart component from the page layout:
   a. Select the component from the original page layout, right-click, and select *Copy*.
   b. Select Page layout \( n \), overflow object from the Properties panel list, or scroll down in the Design View until you see the overflow page.

   The overflow page appears in the layout.
   c. Right-click the current page and click *Paste*.

   The component is copied to the overflow page, maintaining the size and position from the page layout.

   **Note:** If the component was flowing on the original page layout, it is automatically changed to a fixed object on the overflow page.

2. To add a new report or chart component to the overflow page:
   a. From the Properties panel list, select Page layout \( n \) overflow object.

   The overflow page appears in the layout.
   b. Right-click the current page and select *New Report* or *New Graph*.

   **Note:** You can also add these components through the *Insert* tab.

   The pointer changes into a crosshair.
   c. Drag the crosshair to create a report object or a chart object, and adjust it to the size you want.
d. Open, import, or reference report or chart information as usual. This behavior is identical to adding a report or chart on the page layout.

**Note:** Keep in mind that these objects are acting as header and footer information, so they should not generate additional overflow.

3. To edit the report or chart component on the overflow page, double-click the object to open the associated tool and apply any styling or data changes.

**Procedure: How to Insert a Dashboard Bar Into the Layout**

1. Create a new In-Document Analytic dashboard, or open an existing In-Document Analytic dashboard.

   The In-Document Analytic dashboard opens in Document canvas.

2. From the Insert tab, in the Pages group, click **Add Dashboard Bar**.

   The Dashboard Bar is inserted at the top of the document.

   You can insert controls, reports, and charts to appear in the Dashboard Bar above the dashboard tabs.

   **Note:** Though the Dashboard Bar can be a full page, it is not recommended that you insert large reports and charts, as this would make the Dashboard Bar appear to be the same size, or larger, than the dashboard.

**Positioning Multi-Selected Objects in a Document or In-Document Analytic Dashboard Using the Positioning Tab**

Positioning options enable you to multi-select objects and position them relative to one another. The Positioning tab contains the Positioning, Relationships, and Text Alignment groups, as shown in the following image.
Positioning Objects in a Document or In-Document Analytic Dashboard Using the Positioning Group

The Positioning group contains the Left, Right, Top, Bottom, Center, Middle, Same Width, Same Height, Same Size, and Toggles Grid commands, as shown in the following image.

![Positioning Group](image)

**Left**
- Aligns the objects to the left. This works in relationship positioning.
- Relates an object to the left of another object.

**Right**
- Aligns the objects to the right. This works in relationship positioning.
- Relates an object to the right of another object.

**Top**
- Aligns the objects to the top of the highest selected object. This works in relationship positioning.

**Bottom**
- Aligns the objects to the bottom of the lowest selected object. This works in relationship positioning.

**Center**
- Aligns the objects to the center of the page. This works in relationship positioning.
- Aligns objects at the horizontal center point of the object.

**Middle**
- Aligns the objects to the middle of the page. This works in relationship positioning.
- Aligns objects at the vertical center point of the object.

**Same Width**
- Makes two or more objects the same width.

**Same Height**
- Makes two or more objects the same height.
**Same Size**

Makes two or more objects the same size.

**Toggles Grid**

Turns the grid on and off.

**Relating Objects on a Page in a Document Using the Relationships Group**

The Relationships group contains the Bottom Left, Break, and Show commands. Top Left, Top Right, and Bottom Right commands are available for HTML pages and Guided Report pages. The Relationships group is shown in the following image.

![Relationships](image)

**Bottom Left**

Relates two or more objects on a page. Two objects must be selected. Relates an object to the bottom left of another object.

**Break**

Breaks the relationship between the objects selected.

**Show**

Shows or hides the relationship between objects.

**Aligning Text in a Document Using the Text Alignment Group**

The Text Alignment group contains the Left, Center, Right, and Full Justification commands. These commands align text within the text box. The Text Alignment group is shown in the following image.

![Text Alignment](image)

**Left**

Aligns selected text to the left.
Center
Aligns selected text to the center.

Right
Aligns selected text to the right.

Full Justification
Fully justifies the selected text, meaning that the text fills the width of the text box.

Changing Properties of a Document or In-Document Analytic Dashboard Using the Utilities Tab
You can add or remove chaining in an In-Document Analytic report, add pre-process or post-process code to a document or In-Document Analytic dashboard, or display or hide the panels associated with a document or In-Document Analytic dashboard.

Adding or Chaining Objects in a Document or In-Document Analytic Dashboard Using the Chaining Group
You can add or remove chaining options. The Chaining group is shown in the following image.

The commands are:

Add
Chains two or more objects that are selected in the Parameters tab.

Remove
Unchains two or more selected, chained objects in the Parameters tab.

Show Chain order
Shows the order of the chained objects.
Working With the Files Utility Group

You can import and export a page, save a page, and add pre-processing or post-processing code to a document. The Files Utility group is shown in the following image.

![Files Utility Group](image)

The commands are:

**Save Document As**

Saves the document. This command is available only for a document or In-Document Analytic dashboard.

**Save Page As**

Saves the page you are currently on. This command is available only for a document or In-Document Analytic dashboard.

**Pre-process code**

Creates code that is used before the document is processed. This command is available only for a document or In-Document Analytic dashboard.

**Post-process code**

Creates code that is used after the document is processed. This command is available only for a document or In-Document Analytic dashboard.

**Refresh All**

Refreshes the document.

**Procedure:** How to Add the Pre-Process Component to a Document

You can create pre-process code that applies to all components added to a document. For example, if the components in your document all require the joining of two tables, you can create pre-process code before adding the components. This feature eliminates the need to create a Join before each component is added to the document.

In addition, you can create post-process code that runs after all of the components have been added to a document.

2. On the Utilities tab, in the Files Utility group, click **Pre-process code**.

   A new canvas and the Procedure View panel open. The new canvas will show the document name, an underscore, and the words, **Pre-process**. For example, if you are applying a pre-process code to Document1, the canvas is titled, *Document1_Pre-Process*.

3. In the Procedure View panel, right-click the procedure folder, point to New, and click the name of a procedure component.

4. Create your component, save, and close it.

5. When you are prompted to save the pre-process code changes, click Yes.

   Now, you can add components to the document that will use the pre-process code.

**Procedure: How to Add the Post-Process Component to a Document**

After you have added components to your Document, you can apply post-process code that removes the pre-process code when the procedure is run. For example, if you apply a Join pre-process code, add a report, add a chart, and format the Document, you can apply post-process code that removes the Join when the procedure is run.

1. On the Utilities tab, in the Files Utility group, click **Post-process code**.

   A new canvas and the Procedure View panel open. The new canvas will show the document name, an underscore, and the words, **Post-process**. For example, if you are applying a post-process code to Document1 the canvas will be, *Document1_Post-Process*.

2. In the Procedure View panel, right-click the procedure folder, point to New, and click the name of a procedure component.

3. Click **OK**.

4. When you are prompted to save the post-process code changes, click Yes.

**Viewing Panels Associated With a Document or In-Document Analytic Dashboard Using the View Group**

The View group allows you to display or hide the panels associated with a document or In-Document Analytic dashboard. The View group is shown in the following image.
The commands are:

**Properties**

Toggles the visibility of the Properties panel.

**Settings**

Toggles the visibility of the Settings panel.

**Thumbnails**

Toggles the visibility of the Thumbnails panel.

### Previewing the Document Canvas

The Thumbnails panel contains a preview of what is currently on the canvas. This can be a faster way of seeing your layout, instead of using the Run command.

The Thumbnails panel is available when you are using the HTML or Document canvas. The Thumbnails panel is hidden by default. You can display it using the View group, on the Utilities tab.

For more information on customizing panels, see *Customizing the Panels* on page 128.

### Editing Document Canvas Properties

You can edit the properties of your document in the Properties panel. When the Document canvas is active, the Properties panel displays a list of properties that you can modify.

For example, you change the output format from the type that you may have selected in the HTML/Document Wizard. You can also modify the size of a page, the page orientation, you can add bookmarks, and give each page, including the table of contents page, a title and description.

**Procedure:** How to Add a Template to a Document

1. On the Home tab, in the Content group, click **HTML/Document**.

   The HTML/Document Wizard opens

2. For File Type, select **Document**.

3. Click Next.

4. In the Output Format list, choose either **PowerPoint PPT** or **PowerPoint PPTX**.

   The Document canvas opens.

5. In the Properties panel, click the drop-down list at the top, and then click **Compound document**.
Note: When using a PPT or PPTX template in a document, the template must be specified at the document level, and not just the component level.

6. Click the ellipsis button next to the Template Name property.

The Open File dialog box opens.

7. Navigate to the template, and click OK.

Procedure: How to Create an Adaptive Dashboard

When you create a document using the active report or active PDF output formats, you can enable the Adaptive Dashboard feature for mobile users. This provides a more mobile-friendly layout that is easily navigable on smaller screens while providing access to multiple content items, filters, and in-document analytic features. Charts and reports are shown one at a time, and filter controls are available from a collapsible panel.


The HTML/Document Wizard opens.

2. For File Type, select Document.

3. Click Next.

4. In the Output Format list, choose either active report or active PDF.

The Document canvas opens.

5. In the Properties panel, click the drop-down list at the top, and then click Compound document.

6. From the Adaptive Dashboard drop-down menu, select Enable.

7. Add content to the document, such as charts, reports, and filter controls.

When you run the document on a mobile device, you can swipe to navigate between charts and reports, and tap the hamburger control at the top of the screen to access filter controls.

Supporting Template Masters and Slide Layouts in App Studio-Generated Presentations

A Slide Layout is the style applied to a slide in a Microsoft PowerPoint template or presentation created in Microsoft PowerPoint 2007 and higher. The style may consist of images, background color, text, tables, or other objects. Slide Layouts are available in the Slide Masters of PowerPoint templates. You can also create custom layouts.
By default, the first Slide Layout in the first Slide Master is applied to slides on which WebFOCUS data is displayed. With this new feature, WebFOCUS enables you to select any Slide Layout in any Slide Master in a PowerPoint template (POTX/POTM) or Presentation file (PPTX/PPTM). One Slide Layout may be applied to slides displaying the output of a standard report, while one or different Slide Layouts may be applied to each Page Layout in a PPTX formatted Compound Document. The selected Slide Layout is applied to the slide displaying WebFOCUS output.

This feature enhances the output of WebFOCUS-generated presentations, as well as the integration of WebFOCUS with Microsoft PowerPoint features.

**Procedure: How to Apply a Slide Layout to an Entire Document**

1. Create a PowerPoint PPTX format document.
2. Import a report to the Document canvas (for example, rep_ggsales.fex).
3. On the Properties panel, select *Compound Document*, as shown in the following image.

4. On the Properties panel:
   - From the Page size drop-down list, select *Power Point Slide*.
   - From the Page orientation drop-down list, select *Landscape*.
Click the ellipsis button next to Template name.
The Open File dialog box opens.

5. Navigate to the template file (for example, Title_layout.potx).
The Title_layout.potx template is added to the Properties panel.

6. Click the down arrow next to the Slide number property and select 2.

7. Click the down arrow next to the Slide master property, and select TURQUOISE.

8. Click the down arrow next to the Slide layout property, and select TITLE AND CONTENT.

**Note:** You must specify both a Slide Master and a Slide Layout.

9. Run the document and click **Open** to confirm that the slide layout is applied to the WebFOCUS output on slide #2, as shown in the following image.

10. Close the output and return to the Document canvas.

11. Click **Save** from the Quick Access Toolbar.

12. In the Save As dialog box, type *slides_entire_doc* for the file name.

13. Close the document.

14. If you want to see the syntax, in the Environments tree, right-click *slides_entire_doc* and select **Open in Text Editor**.

The syntax for the slide applied at the document level is as follows:

```plaintext
SECTION=section1:
COMPOUNT LAYOUT PCHOLD FORMAT PPTX
UNITS=IN
SECTION=section1, LAYOUT=ON, SLIDE-MASTER='TURQUOISE', SLIDE-
LAYOUT='TITLE AND CONTENT',
```
**Note:** In a Compound Document, if different Slide Layouts are applied to each Page Layout in a PPTX formatted Compound Document, the syntax is as follows:

\[ \text{PAGELAYOUT}=n, \text{NAME}='Page \ layout \ (n)', \text{SLIDE-MASTER}='slidemaster\_name', \text{SLIDE-\-LAYOUT}='layout\_name' \]

For more information on the syntax for Template Masters and Slide Layouts, see the *Creating Reports With WebFOCUS Language* manual.

15. Close the Text Editor.

16. Run the document.

The TITLE AND CONTENT Slide Layout is applied to the output on slide #2, as shown in the following image.

![Image](image.png)

**Learn More**

For more information, see the *Supporting Template Masters and Slide Layouts in App Studio-Generated Presentations* in the *App Studio* technical content.
Creating Maintain Data Applications

In App Studio, you can create Maintain Data files using the Maintain Data Editor and create Maintain Data applications through the HTML canvas. You can use the Components and Controls tabs, along with the Requests & Data Sources, Settings, and Tasks & Animations panels to take full advantage of the HTML canvas and create robust Maintain Data applications.

In this chapter:

- Using the Maintain Data App
- Using the Tasks & Animations Panel
- Using the Maintain Data Editor
- Using Functions in Procedures
- Using Variables in Procedures
- Using Data Source Stacks in Procedures
- Using Import Modules
- Executing Other Procedures
- Persistent and Non-Persistent Maintain Data Applications
- Asynchronous Maintain Data Applications
- Migrating Legacy Maintain Procedures to Maintain Data
Using the Maintain Data App

The Maintain Data product has been fully integrated into App Studio. The Maintain Data App icon, available in the Containers group of the Components tab, enables you to draw a Maintain Data container on the HTML canvas. The Containers group of the Components tab is shown in the following image.
When a Maintain Data file is added to an HTML page, it displays as a request in the Requests & Data Sources panel. Maintain Data requests display all functions, data sources, forms, variables, stacks, and parameters that are used in the Maintain Data file. If the Maintain Data request does not contain one of these components, it is not displayed beneath the request. A Maintain Data request in the Requests & Data Sources panel is shown in the following image.
You can create new functions, variables, and stacks, as well as add additional data sources and parameters by using the shortcut menu on the nodes. To edit a Maintain Data component, right-click the item and select Edit Source or Edit. The Edit Source option allows you to edit the entire Maintain Data file. The Edit option opens the Edit Function dialog box, where you can edit the signature and description of that function.

Many of the Maintain Data request components can be dragged to the canvas, or other panels, to automatically create the components and tasks needed to run the Maintain Data component. The following are examples of how you can drag Maintain Data components to a canvas.

☐ Drag a request to the canvas to create the objects necessary for running the Maintain Data file. Tasks are automatically created in the Requests/Actions section of the Tasks & Animations panel.

☐ Drag forms, variables, and stacks from the Requests & Data Sources panel to the canvas to create objects.

☐ Drag functions onto components or controls on the canvas to create tasks that execute the function when they are clicked.

☐ Drag variables and stacks to the Selection to area in the Settings panel. This assists in directing where control and grid selections are sent.

**Automatically Running Converted Maintain Data Files**

When adding an existing Maintain Data file to your HTML page, you are prompted to run that Maintain Data file after the page is loaded. Clicking Yes (recommended) creates an action for the load task in the Tasks & Animations panel. This means that the Maintain Data file will connect once the HTML page is loaded. If you click No, no action is created for the load task.

**Procedure: How to Use the Maintain Data App Container**

The Maintain Data App container is created in the HTML canvas. This container enables you to construct the application front-end (or user interface). Then, you develop the code that extracts data from your data sources and updates the data sources with new data.

1. In your Domain, create an HTML page.
2. Click the Maintain Data App icon in the Containers group of the Components tab.
   Your cursor turns into a crosshair.
3. Draw a box on the HTML canvas to create your Maintain Data App container. This is the container in which you will create your form.
Note:

- You can also drag an existing form onto the HTML canvas. This prompts you to create a multipage control.
- When you place a Maintain form on the canvas, you can choose to use a multi-form container. If you choose not to use a multi-form container, you can add it later.
- If you have a Maintain form on the canvas, you can right-click the form name, the form, or the Forms folder, and select Add form to container. All of the forms are added to the object on the form.
- If you decide to use the Maintain form container, after already having forms on the canvas, the container must be big enough to contain the largest form.

Procedure: How to Create a Maintain Data Application That Can Be Used Offline

You can create a Maintain Data application that can be used offline on a mobile device. When you create the Maintain Data application, use the Export for offline option to create an offline version of the file. The offline application can be accessed by a web browser on a mobile device, and saved to the device using the browser option to save to the Home screen. Users can then use the saved Maintain Data application offline. When they reconnect to the network and invoke the secured application, saved Maintain transactions are automatically submitted.

1. Create a Maintain Data application in an HTML page.
2. Create a button or other object to allow users to save using a Maintain case.
   a. On the Components tab, in the Generic Elements group, click Button, and draw a button on the page.
   a. Open the Tasks & Animations panel.
   b. Create a new task using Click as the Trigger Type and the button you created as the Trigger Identifier.
   c. Click the drop-down arrow next to the Requests selections button, point to Run request, point to the name of your procedure, and select the case in the procedure that updates records.
3. Right-click the HTML canvas and click Export for offline.
   The Specify Name dialog box opens.
4. Select a name and location for the offline file, and click OK.
5. If you are creating a new offline file, an alert appears prompting you to confirm the creation of a new file. Click Yes to continue.
In the Properties panel for the DOCUMENT object, the new offline file is listed for the Offline: File property. Notice also that the Offline: Save on reconnect property is automatically enabled by default.

As an alternative to enabling the Offline: Save on reconnect property, you can use a JavaScript function to save updates offline and submit them upon reconnecting. Create a JavaScript event using the Events section of the Properties panel, or create a task in the Tasks & Animations panel that executes a JavaScript call, and set it execute the following function:

```
IbComposer_runOfflineRequests()
```

6. Run the offline page on a mobile device. From the mobile device web browser, save the page to the Home screen.

7. Disconnect the mobile device from the network.

8. While offline, open the page from the Home screen and interact with the Maintain Data app.

If the Offline: Save on reconnect property was set to Yes, any transactions saved will be submitted once an online connection is reestablished. If the Offline: Save on reconnect property was not set to Yes, then when you reconnect to the network, you must invoke the trigger to call the IbComposer_runOfflineRequests() function in order to submit your saved transactions.

**Note:** Offline applications must be non-persistent.

---

**Procedure:** How to Create a Maintain Data Application That Uploads Images

You can create a Maintain Data Application that uploads images to a BLOB field in a database. The application uses an edit box with a Type property of *File* to browse for images, which can then be saved to an application folder and then uploaded by executing a MODIFY procedure.

1. Create a Maintain Data application in an HTML page.

   It should be configured to write to a BLOB field in your database using the file path of an image in an application folder. You can also use variables in a stack to assign an incremental ID number to each image for indexing.

2. Add an edit box that allows you to select an image from your system.

   a. On the Controls tab, click *Edit Box* and draw an edit box onto the HTML canvas.

   b. In the Properties panel, change the Type property for the edit box to *File*.

      A Browse button is added to the edit box.

   c. In the Properties panel, type *image/* into the text box for the Accept property.
d. In the Properties panel, for the Copy file to property, select the application folder in which to initially upload the selected images.

3. On the Components tab, in the Generic Elements group, click Button, and draw a button on the page.

4. Create a task to save the image selected using the edit box to the selected application folder when the button is clicked.
   a. Open the Tasks & Animations panel and click New to create a new task.
   b. Set the Trigger Type to Click and the Trigger Identifier to the button that you created, so that the task will execute when the button is clicked.
   c. Click the down arrow next to the Requests selections button and click JavaScript call.
   d. In the Function name field, type `IbComposer_saveSelectedFile("edit1")`. Replace `edit1` with the unique identifier of the edit box.

5. Create a MODIFY procedure to upload the image from the application folder to the database.
   An example of the syntax for this MODIFY procedure is shown below:

   ```
   -SET &ECHO="ALL";
   APP MAP PATHVAR C:/ibi/apps/APPNAME
   MODIFY FILE MASTER
   FREEFORM field1 field2
   MATCH field1
   ON MATCH REJECT
   ON NOMATCH INCLUDE
   DATA
   field1='&1', field2='&2', $
   END
   -RUN
   ```

   where:

   **PATHVAR**
   Is a variable name that is also appended to the file name in the Maintain form as part of the image variable compute.

   The APP MAP declaration sets PATHVAR as the path to the application folder containing the images.

   **APPNAME**
   Is the application folder to which the images are initially uploaded. This is the same location specified in the Copy file to property of the edit box on the HTML page.

   **MASTER**
   The Master File associated with the database table to which the images are uploaded.
field1
An index field used to identify the images in the table. For example, this could be an incremental ID number set using a compute in the Maintain form.

field2
The BLOB field to which the images are added.

&1, &2
Are positional variables that pass the values of field1 and field2 to be written to the server. Values for field1 and field2 are passed together from the Maintain form to the MODIFY procedure.

6. In the Requests & Data Sources panel, click the down arrow next to the New button, point to External Request, and click WebFOCUS Procedure.

The Open File dialog box opens.

7. Select the MODIFY procedure that you created and click OK.

8. Create another button to execute the MODIFY procedure.
   a. On the Components tab, in the Generic Elements group, click Button and draw a button onto the page.
   b. In the Tasks & Animation panel, create a new task.
   c. Set the Trigger Type to Click and set the Trigger Identifier to the new button.
   d. Click the down arrow next to the Requests selections button, point to Run Request, and select the MODIFY procedure.

9. Save and run the page. Select an image from the edit box and click the button to save it to an application folder. If you refresh the application folder in the Environments Tree, the image appears. Next, click the button to execute the MODIFY procedure. The MODIFY procedure loads the image to the database, with values formatted by the Maintain form.

Creating Maintain Data Requests

Maintain Data requests are submitted from the Request & Data Sources panel. There are two basic types of requests to create new applications: Embedded and External. Both Embedded and External requests allow you to create applications manually, or using Update Assist. When you create a request manually, you design the forms, write the navigation and validation, and update the procedures using the Maintain Data Editor. Update Assist enables you to create simple applications and add, update, or delete records against any data source for which you have read/write access.

- **Embedded Request.** Creates a new procedure within the HTML file.
- **External Request.** Creates a new Maintain Data file or edits an external procedure, not embedded in Maintain Data.
Procedure: How to Create an Embedded or External Request

The following steps walk you through the process of creating an Embedded request or External request manually. Also used to migrate existing Maintain procedures.

1. In a Domain folder, create a new HTML page, using the HTML/Document wizard.
2. On the Requests & Data Sources panel, select the down arrow next to the New icon, select Embedded Request or External Request, and then click New Maintain Data.
   By default, for an Embedded request, Request1 is created.
   For an External request, provide a name for your request in the Save As dialog box and click OK.
3. Right-click the Request1 parameter and select Use data sources.
4. From the Data Sources in Procedure dialog box, select New.
5. Browse to the location of your Maintain Data data sources, select the one to use, click OK, and then click OK again.
6. Click HtmlPage1 to display the canvas.
7. On the Requests & Data Sources panel, expand the Forms folder and then expand Request1.
   By default, Form1 has been created.

Procedure: How to Create a Request Using Update Assist

You can create an application using Update Assist that adds records, updates records, or deletes records against any data source for which you have read/write access. Data navigation and input validation are automatic. This means you get an update application with no need to design forms, or to write navigation, validation, or update procedures.

1. In a Domain folder, create a new HTML page, using the HTML/Document wizard.
2. On the Requests & Data Sources panel, select the down arrow next to the New icon, select Embedded Request, and then select New Maintain Data with Update Assist or select External Request and then select Maintain Data: New with Update Assist.
3. Select the Master File from the Open File dialog box. The Update Assist dialog boxes correspond to the steps needed to generate Update Assist applications.
Using the Tasks & Animations Panel

Once you create a request, you want it to generate tasks that a user performs, such as clicking a button or moving from one field to another. These tasks are created using Ajax calls, which execute them as asynchronous calls in JavaScript. With Ajax, the JavaScript does not have to wait for the server response, but instead can:

- Execute other scripts while waiting for server response.
- Deal with the response when the response is ready.

Requests/Actions

The Requests/Actions drop-down menu is used to select the type of request or action to be taken. As a request is selected, it is displayed in the Requests/Actions list. You can use the adjacent arrows to move actions into the desired execution order. Each request also populates the Target type field with the available targets in which that request can be executed.

The Request selection types are described in the following list.

**Run Request**

Lists the requests you have created in the Requests & Data Sources panel. Each request selected populates the Target type field with the available targets in which that request can be executed.

**Note:** You must include a Connect task or the load does not work. The format is: `<request type>;/<procedure name>;<function>`

For example,

*Embedded procedure/Request1.Connect*

**Schedule Request**

Lists the available requests created in the Requests & Data Sources panel.
Run Animation
Lists the available jQuery animations from the jQuery animation section.

Toggle Visibility
Toggles the selected Maintain Data form on and off.

Execute Task
Lists the available tasks to enable you to execute one task from within another.

Refresh
Creates an action to refresh the selected target.

Wait for completion
Allows you to specify that one request must complete before the next one begins. For example, if request1 is listed above the Wait for completion action and request2 is below it, request1 runs first and when completed, request2 runs.

JavaScript call
Creates a JavaScript call action. When using the JavaScript call, different results occur depending on what is returned. If the JavaScript call returns 0, then all actions after it run. If the JavaScript call returns 1, then one action after the call is skipped, and all actions after that are then run. If the JavaScript call returns 2, all actions after it are skipped.

Target Types
The Target type option contains a list of targets in which the request can be executed. These targets can be controls, frames, windows, or distribution methods when the Request is set to Schedule. These options can be different for specific actions.

Window
Executes the request in a window.

InfoWindow
Executes the request in the WebFOCUS-generated InfoWindow.

Frame
Executes the request in a selected frame.

Ajax call
Executes the request as an asynchronous call in JavaScript.
**Note:** The Ajax call is the only Target Type used by Maintain Data.

**Schedule**

Schedules the report request for distribution.

**Deferred**

Defers the running of the report.

**Input Control**

Specifies that an input control will be refreshed. This option is only available when you have a refresh request selected in the Requests/Actions list. You specify which control should be refreshed by selecting one from the Target/Template Name list.

**Analytic Document**

Specifies that an Analytic Document will be refreshed. This option is only available when you have a refresh request selected in the Requests/Actions list. You specify the Analytic Document that will be refreshed by selecting one from the Target/Template Name list.

**Refresh BI Portal**

Specifies that a WebFOCUS BI Portal page is refreshed. This option is only available when you have a refresh request selected in the Requests/Actions list. If you select *All pages of the portal*, all BI Portal pages are refreshed. If you select *Current page only*, only the current BI Portal page is refreshed.

**JavaScript**

Specifies that the selected task calls a JavaScript function that you type in the Function name field. This option is only available when you have selected *JavaScript call* in the Requests/Actions field.

**Using the Maintain Data Editor**

Underlying many of the graphical elements of App Studio Maintain Data is Maintain Data language source code. The Maintain Data Text Editor enables you to create, view, and edit the source code for procedures, procedure components, and other types of files required by your Maintain Data applications. The Maintain Data Text Editor tab opens when you create a new function or edit an existing one. It contains two groups, Find and Position. The Maintain Data Text Editor tab is shown in the following image.
All App Studio Maintain Data procedures start with the keyword MAINTAIN (which must be in uppercase) and end with the keyword END (also in uppercase), as shown in the following image. When you create a procedure, App Studio Maintain Data includes these two keywords automatically.

FILE fannames tells App Studio Maintain Data the data sources this procedure is going to access. In the list of components, there is a Data Sources folder with a fannames data source below it.

Data source names (up to 15) follow the MAINTAIN FILE command and are separated by the word AND.

Following this line is a comment line beginning with $$. You can tell that this is a comment since green (the default) is the color for comments. This comment line is automatically generated when you create a procedure.

This particular comment, $$Declarations, is generated automatically by App Studio Maintain Data when you created the procedure. If you create any new variables using the Request & Data Sources panel, App Studio Maintain Data places the source code after this comment.

Case Top begins the definition of the Top function. This definition takes up several lines and ends with the keyword EndCase. The first statement, which begins with Infer, defines the AddFanStack data source stack.

The next line of the Top function, Winform Show Form1; is the code that displays Form1 at run time. This code was generated automatically when you created the procedure.

The text in your window may wrap differently.

Note: The text in your window may wrap differently.

FILE fannames tells App Studio Maintain Data the data sources this procedure is going to access. In the list of components, there is a Data Sources folder with a fannames data source below it.

Data source names (up to 15) follow the MAINTAIN FILE command and are separated by the word AND.

Following this line is a comment line beginning with $$$. You can tell that this is a comment since green (the default) is the color for comments. This comment line is automatically generated when you create a procedure.

This particular comment, $$Declarations, is generated automatically by App Studio Maintain Data when you created the procedure. If you create any new variables using the Request & Data Sources panel, App Studio Maintain Data places the source code after this comment.

Case Top begins the definition of the Top function. This definition takes up several lines and ends with the keyword EndCase. The first statement, which begins with Infer, defines the AddFanStack data source stack.

The next line of the Top function, Winform Show Form1; is the code that displays Form1 at run time. This code was generated automatically when you created the procedure.

Finally, the Case AddFan and EndCase define an additional function in this procedure.
Finding or Replacing Text Using the Find Group

The Find group contains options that enable you to find or replace text. For information on the Find group options, see the WebFOCUS App Studio Maintain Data Getting Started content.

Reference: Find Dialog Box

You can use the options on the Find dialog box to indicate how to search for information. For information on the Find dialog box options, see the WebFOCUS App Studio Maintain Data Getting Started content.

Reference: Replace Dialog Box

You use the options on the Replace dialog box to indicate how to use the find feature to find and replace information. For information on the Replace dialog box options, see the WebFOCUS App Studio Maintain Data Getting Started content.

Placing the Cursor Using the Position Group

The Position group allows you to place your cursor at the desired line and allows you to turn off line numbers. For information on the Position group options, see the WebFOCUS App Studio Maintain Data Getting Started content.

Using the Shortcut Menu in the Maintain Data Editor

The shortcut menu is available by right-clicking anywhere within the body of the Editor and provides access to the Language Wizard, as well as New Variable, New Function, and New Class dialog boxes.

Note: The New Variable, New Function, and New Class options are also available from the Requests & Data Sources panel by right-clicking your Maintain Data request and selecting them from the shortcut menu.

Language Wizard

Opens the Maintain Language Wizard which helps you build Maintain Data language source code without typing the syntax yourself.

New variable

Opens the New Variable dialog box.

New function

Opens the New Function dialog box.

New class

Opens the New Class dialog box.
**Line Numbers**
Provides line numbers to the left of the source code.

**Outlining**
Indents code by one position.

**Auto Complete**
Not enabled for the Maintain Data Editor.

**Auto parse**
Parses as you type. Recommendation is to not select this option for Maintain Data.

**Parse**
Enables you to parse on demand.

**Procedure: How to Use the Language Wizard**
Maintain Data provides a Language Wizard to help you construct Maintain Data language source code.

1. Place the cursor where you want your source code to go.
2. Right-click at the insertion point and select Language Wizard from the shortcut menu.
   The first screen of the Language Wizard opens.
3. Select the type of code you wish to create and follow the online instructions.

The Language Wizard can generate Maintain Data commands to perform the following tasks:

- Retrieve records from a data source (NEXT).
- Update records in a data source (INCLUDE/UPDATE).
- Operate on a form (Winform).
- Run another procedure (CALL or EXEC).
- Operate on a stack (STACK).

**Procedure: How to Create a New Variable**
1. In the Requests & Data Sources panel, right-click the procedure name, and from the shortcut menu, select New variable.
   The Maintain Data Editor for the procedure opens and the New Variable dialog box displays.
2. Type a name for the variable and click *OK*.

   The new variable is added to the end of the existing variables.

**Note:** You can also access the New Variable dialog box from within the Maintain Data Editor. Place your cursor where you want the new variable added, right-click, and from the shortcut menu, select *New variable*.

**Procedure:** How to Create a New Function

1. In the Requests & Data Sources panel, right-click the procedure name, and from the shortcut menu, select *New function (case)*.

   The Maintain Data Editor for the procedure opens and the New Function dialog box displays.

2. Type a name for the function and click *OK*.

   The new function is added to the end of the existing functions.

**Note:** You can also access the New Function dialog box from within the Maintain Data Editor. Place your cursor where you want the new function added, right-click, and from the shortcut menu, select *New function*.

**Procedure:** How to Edit an Existing Function

In the Requests & Data Sources panel, right-click a function and from the shortcut menu, select *Edit* or *Edit source*. The Maintain Data Editor opens, highlighting the code or text of the selected function.

**Procedure:** How to Create a New Class

1. In the Requests & Data Sources panel, right-click the procedure name, and from the shortcut menu, select *New class*.

   The Maintain Data Editor for the procedure opens and the New Class dialog box displays.

2. Type a name for the class and click *OK*.

   The new class is added to the end of the existing classes.

**Note:** You can also access the New Class dialog box from within the Maintain Data Editor. Place your cursor where you want the new class added, right-click, and from the shortcut menu, select *New class*. 
Using Functions in Procedures

A function, also known as a case, is a series of commands in a procedure grouped together as a unit of control. A function accomplishes a task, such as calculating values, extracting data from a data source to place in a data source stack, or writing information to a data source. You can also call one function from within another function.

- All executable code must be in a function. The only types of logic allowed outside of a function are variable declarations, object declarations, and class definitions (CASE, DECLARE, DESCRIBE, END, MAINTAIN, and MODULE statements).

- Some functions have arguments, meaning when you invoke the function, you must supply information that the function needs to complete its task.

- Some functions also have a return value, meaning they calculate a value and return this value to whatever called the function. Functions that are event handlers (that is, that are invoked by some action in a form) cannot have return values.

- The combination of the arguments and return value of a function is known as its signature.

- Local variables (defined in a function using the DECLARE command) are available only within that function. As soon as the function completes processing, these values are no longer available.

- Global variables (defined using the DECLARE command outside of a function or using the COMPUTE command anywhere) are available for the entire procedure.

**Note:** For more information on local and global variables, see the WebFOCUS App Studio Maintain Data Language Reference content.

**Procedure:** How to Create a Function

1. Select the procedure you would like the new function to be part of.
2. Right-click the procedure and click *New function* in the shortcut menu.
3. In the New Function dialog box, type a name for your function in the Name field (up to 66 characters with no spaces).
4. Use the New button to open the Function Parameter dialog box to add any arguments (not all functions require arguments).
5. Use the Returns field to enter the name and format of a return value (not all functions require return values). You can also click the ellipsis button to open the Function Return dialog box. This is where you can define the function.
6. Click the Description tab, type a description, and click *OK*. (Optional)
7. Right-click the function and select *Edit Source* from the shortcut menu. The Maintain Data Editor opens the procedure containing your function in the code for the function.

8. Locate your cursor just before the ENDCASE keyword and enter the Maintain Data language commands that determine what this function does.

**Note:** The following Maintain Data language commands are not valid within the context of a function: CASE, ENDCASE, MAINTAIN, END, MODULE, and DESCRIBE.

**Tip:** You can add Maintain Data language code to your function using the Language Wizard. Place your insertion point where you want your code to go, right-click in the Maintain Data Editor window and select *Language Wizard* in the shortcut menu.

**Procedure:** How to Edit a Function

1. Right-click the function in the Requests & Data Sources panel.
2. Click *Edit Source* in the shortcut menu.
3. Make your desired changes between the *CASE functionname* and *ENDCASE* keywords.

   **Tip:** You can add Maintain Data language code to your function using the Language Wizard. Place your insertion point where you want your code to go, right-click in the Maintain Data Editor window and select *Language Wizard* in the shortcut menu.

**Procedure:** How to Edit the Name, Arguments, Return Value, and Description of a Function

1. Right-click the function in the Requests & Data Sources panel.
2. Click *Edit* in the shortcut menu.
3. Make your changes in the Edit Function dialog box and click *OK*. 

784  Information Builders
Reference: Function Editor: Signature Tab

When you create or edit a function, App Studio Maintain Data opens the New Function, Edit Function, or Member Function dialog box, as shown in the following image.

This dialog box contains the following options:

**Name**

The name you assign to your function (or case). This name can be up to 66 characters long. It must begin with a letter and can include any combination of letters, digits, and underscores (_).

**Takes: (Name/Type)**

Lists the arguments that the function requires. When you invoke the function, you pass to it variable names or values to substitute for these arguments.

- To create a new argument, double-click the gray rectangle or click the plus sign to the right of the field.
- To edit an existing argument, double-click its name.
- To change the order of the arguments, select the argument to be moved and use the arrows to move it up or down.
To delete an argument, select it and click the red X to the right of the field.

**Note:** Not all functions require arguments. You cannot use a function with arguments as an event handler.

**Returns: (Name/Type)**

Contains the name and data type of the return value that the function calculates. This information can be entered directly in the field, or you can use the ellipsis button to open the Function Return dialog box to enter it.

**Using Variables in Procedures**

A variable is a named storage location capable of containing a certain type of data that can be modified during program execution. You also create variables as part of a class definition or function.

Maintain Data variables have four attributes:

- A name
- A data type (for example: integer, alphanumeric, or a user-defined class)
- A value (optional)
- A description (optional)

**Procedure: How to Create a New Variable**

1. In the Requests & Data Sources panel, or within the Maintain Data Editor, right-click the procedure that you want the variable to be part of and select **New variable**.

   The New Variable dialog box is displayed.

2. Type a name for the variable.

3. Specify a data type for the variable. You can do this in one of two ways:
   - Select a **Type** using the drop-down list of recently-applied data types.
   - Click the ellipsis button to open the Type Wizard.

4. Specify an initial value for your variable by clicking the x=? **Initialize** tab and typing a value in the box (Optional).

5. Click the **Description** tab and enter a description (Optional).

6. Click **OK**.
This variable is global, meaning it is available to any code written in this procedure. To use it in another procedure, you must pass it to the other procedure.

**Procedure: How to Edit a Variable**

1. Right-click the variable in the Resources & Data panel, and from the shortcut menu, click *Edit*.
2. Make any changes in the Edit Variable dialog box and click *OK*.

**Procedure: How to Edit Source Code in a Variable**

1. The App Studio Maintain Data application generates Maintain Data language code for variables. You can edit this code directly in the Maintain Data Editor.
2. Right-click the variable in the Resources & Data panel, and from the shortcut menu, click *Edit Source*.
3. Make your changes to the code after the DECLARE variable name keyword and before the semicolon (;).

   For more information, see the *WebFOCUS App Studio Maintain Data Language Reference* content.

**Reference: Variable Editor: Declaration Tab**

When you create or edit a variable, App Studio Maintain Data opens the New Variable or Edit Variable dialog box. The Edit Variable dialog box is shown in the following image.

![Edit Variable Dialog Box](image)

This dialog box includes the following options:

**Name**

Contains the name of the variable, argument, or return value you are specifying.
**Type**

Contains the data type of the variable or argument or return value you are specifying. This information can be entered directly in the field, you can select a recently used data type from the drop-down list, or you can use the ellipsis button to open the Type Wizard. For more information on the Type Wizard, see *Using the Type Wizard* on page 792.

**Note:** The Type Wizard does not create specifications for the following data types: date-time, packed-decimal, and text. For more information on specifying packed-decimal or text, see the *Describing Data With WebFOCUS Language* content.

**Reference:** Variable Editor: x=? Initialize Tab

When you are creating or editing a variable in an existing Maintain Data request, use the x=? Initialize tab in the New Variable or Edit Variable dialog box to enter a value for your variable, as shown in the following image. This value can be any expression. For more information, see *Expressions Reference* in the App Studio Maintain Data Language Reference content.

**Using Data Source Stacks in Procedures**

A data source stack is a non-persistent (or in-memory) array where you can store and manipulate data from one or more data sources. In the Maintain Data language, you use data source stacks to hold values you read from the data source and manipulate data before writing it back to the data source. You can think of a data source stack as a staging area in memory in which you can manipulate data before committing it to the data source or displaying it to the user.

To use a data source stack, first create one using the Stack Editor, or by editing the procedure as text and typing the appropriate syntax. The columns of a stack are usually based on actual data source fields, but you can also add your own columns.

Fill the data source stack with data from one or more data sources. You can then use a form to display the stack data to the user. The user has the option of changing this data. App Studio Maintain Data stores the changes in the data source stack until the application issues an UPDATE command to update the data source.

There are two ways to create a data source stack:

- **Explicitly**, by declaring the data source stack using an INFER statement in your procedure (use the Stack Editor to create the INFER statement or edit the procedure as text and type the INFER statement directly). For more information on using the Stack Editor, see *How to Create a Data Source Stack Explicitly Using the Stack Editor* on page 789.

- **Implicitly**, by loading data into the data source stack using the NEXT or MATCH commands.
For more information, see the WebFOCUS App Studio Maintain Data Language Reference content.

**Note:** When you use a data source field as a column in a data source stack, App Studio Maintain Data defines columns based on the rest of the fields in that data source or, if your data source is hierarchical, the rest of the fields in the segment and the key fields in any parent segment. These columns are called implied columns. Maintain Data includes all of these fields in your data source stack so that when you update your data source from the data source stack, it knows the path to these fields.

**Procedure:** How to Create a Data Source Stack Explicitly Using the Stack Editor

1. Ensure that all the data sources you want to reference in this stack are being used by the procedure.
2. Select the procedure that you want the data source stack to be part of.
3. Right-click Stacks under the procedure and click New data source stack.
4. In the Stack Editor dialog box, type a name for your data source stack.
5. Define the columns that make up the data source stack. There are two ways to do this (you can use one or both):
   - **Base the columns on actual fields in your data source.** Select a field under the list of data sources in the Available fields list and click the right arrow button.
   - **Create custom (user-defined) columns.** You can use custom columns as temporary work areas or to create calculated fields, such as Name = First || Last. Under the Variables folder, click New Variable. In the Computed Stack Columns dialog box under the Declaration tab, type a name and type for the new column and then click OK. Repeat these steps, until all of your columns have been defined.
6. Click the Description tab and type a description (Optional).
7. Click OK.
App Studio Maintain Data creates an entry for your new data source stack in the Project Explorer under the procedure. When you open it, you see the columns that define the data source stack.

**Tip.** You can create a data source stack based on the fields in a data source segment by dragging the data source segment to the procedure in which you want to create the data source stack. App Studio Maintain Data prompts you for the name of the data source stack in the Create New Stack dialog box. Creating a data source stack this way also uses the data source in the procedure, if you have not specified it already.

**Reference:** Stack Editor: Definition Tab

When you create or edit a data source stack, App Studio Maintain Data opens the Stack Editor dialog box, as shown in the following image.
This dialog box includes the following options:

**Stack name**

Is the name of the stack.

**Available Fields**

Lists the data sources that you have specified for use in this procedure. To define columns for the data source stack, either use existing fields from the data sources or create new ones by clicking *New variable*.

**Arrow buttons**

The forward arrow buttons copy a selected parameter or field into the list of data source stack columns.

The back arrow buttons remove a selected column from the list of data source stack columns.

**Stack columns**

Contains the columns that you have defined for your data source stack.

When you use a data source field to define a stack, App Studio Maintain Data defines columns for all of the rest of the fields in the data source. If your data source is hierarchical, App Studio Maintain Data defines columns for the rest of the fields in the segment, and the key fields from parent segments. These are the implied columns.

**Generated code**

Contains the Maintain Data language code generated by the Stack Editor dialog box for your data source stack. This can take the form of *Infer datasource.segment.field* into *stack* and/or *Compute stack.column/format*. 


**Reference:** Using the Type Wizard

When you create a variable or define an argument or return variable, you must assign a data type to it. A data type is either a format or a class and can be assigned using the Type Wizard. There are two kinds of data types: Built-in Type (or format) and User-defined Class.

![Type Wizard](image)

If you choose Built-in Type, you have three basic formats:

- **Alphanumeric.** For values composed of alphabetic, numeric, or special characters.
- **Date.** For dates or components.
- **Numeric.** For values composed of the digits zero (0) through nine (9) and, optionally, a minus sign (-). You have the following choices:
  - **Double Precision.** For whole numbers or fractions, using eight (8) bytes of storage and a maximum number of 15 positions. This type of field automatically inserts a comma (,) after every third significant digit.
  - **Floating Point.** For whole numbers or fractions using four (4) bytes of storage and maximum number of nine (9) positions.
  - **Integer.** For whole numbers using four (4) bytes of storage and maximum number of nine (9) positions. Numbers after the decimal are truncated.
If you choose Class, you must already have defined a class. For more information, see the *WebFOCUS App Studio Maintain Data Language Reference* content.

**Note:** The Type Wizard does not create specifications for the following data types: date-time, packed-decimal, and text. You must manually enter the specification in the data type field. For more information on specifying packed-decimal or text, see the *Describing Data With WebFOCUS Language* content.

**Using Import Modules**

An import module is a non-executable procedure that contains Maintain Data language code. You do not execute an import module as part of your application. Instead, you use it as a library of functions or classes. Using the MODULE IMPORT command, you can bring an import module into any procedure and use its functions and classes. An import module cannot be used for data source access.

If you edit an import module, you will notice that, just as with a procedure, it starts with the keyword MAINTAIN and ends with the keyword END. However, it does not contain a Top function.

You can use the following in an import module:

- Functions
- Classes
- Variables

You cannot use the following in an import module:

- Forms
- Data sources (the syntax MAINTAIN FILE *filename* is not supported)
- Commands that read or write data to a data source (NEXT, MATCH, and so on)
- Stacks that contain columns from a data source (defined with the INFER or NEXT commands). You can, however, define stacks using Stack Of, DECLARE, or COMPUTE.

**Note:** When you move an import module into a procedure, the variables, functions, and classes in an import module become part of the name space of the procedure. For example, if you have a variable named COUNT in an import module and import it into a procedure, that procedure cannot define its own variable named COUNT.
Executing Other Procedures

Separating your application code into more than one procedure (called modularizing or partitioning) can significantly speed up your development time and application performance.

The Maintain Data language contains two commands for executing procedures:

- **CALL.** Executes Maintain procedures.
- **EXEC.** Executes WebFOCUS procedures.

These two commands work more or less in the same way. Each command has some options that enable you to do the following:

- Determine the WebFOCUS Server where the called procedure is located.
- Determine whether to keep or close the server session when the procedure finishes executing (the server session is a process on the WebFOCUS Server that executes the procedure).
- Pass parameters to and receive parameters from the called procedure.

Advantages of Modularizing Source Code

Separating your application code into more than one procedure has many advantages:

- You can use multiple procedures to share common source code among many developers, thus speeding up development and maintenance.

  For example, a generalized error message display procedure could be used by all App Studio Maintain Data developers. After passing a message to the generalized procedure, the procedure handles message display. The developers do not need to be concerned about how to display the message and error messages always look consistent to end users.

- You can remove infrequently-executed source code from a procedure and move it into its own procedure. This reduces the size of the original procedure, simplifying its logic, making maintenance easier, and using less memory if the new procedure is not called.

- You can split your application into presentation logic and database logic, and then run each type of logic on a server optimized to support that type of logic.
Using the CALL and EXEC Commands

To use the CALL or EXEC command, you must open the calling procedure in the Maintain Data Editor and enter the command inside of a function (CASE/ENDCASE command). You can type the command directly or use the Language Wizard. For more information on the CALL and EXEC commands and syntax, see the WebFOCUS App Studio Maintain Data Language Reference content.

Persistent and Non-Persistent Maintain Data Applications

App Studio Maintain Data applications can be persistent or non-persistent.

- A persistent application has an agent waiting on the Reporting Server as long as the application is open.
- A non-persistent application disconnects from the Reporting Server as soon as the form is displayed.

Overview of Persistent Maintain Applications

The benefits of a persistent application are the following:

- Faster response time.
- Easier to pass stacks and data back to the Reporting Server.
- Maintain Data commands are available on form events.

The disadvantages of a persistent application are the following:

- Connection must be maintained.
  - More Reporting Server agents are needed.
  - May be problematic for mobile devices.
- Back button or back arrow may cause the application to disconnect.
- May be problems with Reporting Server agents timing out.

Overview of Non-Persistent Maintain Applications

The benefits of a non-persistent application are the following:

- Connection is only needed at launch and Reporting Server update.
- Fewer agents are needed on the Reporting Server.
The disadvantages of a non-persistent application are the following:

- Application is restarted every time you return to the Reporting Server.
- All database keys must be retained on the form.
- Maintain Data commands are not available for events.

**Note:**

In a non-persistent application:

- Interaction between forms and Maintain Data code must be done using JavaScript events.
- A connect task is needed to perform the Maintain Data code.
- An action field is needed to determine how to branch inside the Maintain Data code.

**Procedure: How to Create the Application**

1. From the Environments Tree panel, right-click an application folder, point to New, and click *HTML/Document*, as shown in the following image. If needed, create the domain first.

   ![Application Creation Procedure](image)

   The HTML/Document Wizard opens.

2. Click Next.
The Templates, Settings, and Themes dialog box opens.

3. Click Finish.

**Procedure: How to Add the Maintain Data**

1. From the Requests & Data Sources panel, click the down arrow next to the New icon, select Embedded Request, and then select New Maintain data, as shown in the following image.

![Image of Requests & Data Sources panel](image)

By default, for an Embedded Request, Request1 is created.

2. Right-click the Request1 parameter and select Use data sources, as shown in the following image.
3. From the Data Sources in Procedure dialog box, select New.

4. Browse to the location of your Maintain Data data sources and select the one to use, in this case, the movies file, as shown in the following image.

5. Click OK.
**Procedure:**  **How to Create the Stack**

In the .mnt tab, add a loaddata case in the Maintain Data code to load the stack, as shown in the following image.

```
MAINTAIN FILE movies

$Declarations

Case Top
perform loaddata
Winform Show_and_exit Form1;
EndCase

case loaddata
compute action/a1;
compute selval/a6;
stack clear allstk
reposition moviecode
for all next moviecode into allstk
endcase

END
```

**Note:** The Winform Show_and_exit Form1 command makes the application non-persistent.

**Procedure:**  **How to Create the Form**

1.  Click the htmlpage1 tab.

2.  From the Requests & Data Sources panel, expand Request1 and the Forms folder.
3. Drag Form1 onto the canvas, as shown in the following image.

4. When prompted to create a multipage control, click No.

**Procedure: How to Display the Stack**

1. From the Requests & Data Sources panel, expand the Stacks folder.
2. Right-click allstk and drag it onto the form, as shown in the following image.

3. Select Create controls.

   **Note:** If you accidentally left-click allstk and fields are created, click the undo icon, and make sure to right-click the stack before you drag it onto the form.
4. On the Parameters dialog box, select the first four fields, as shown in the following image.

5. Right-click the Edit box value in the Control Type column on row 1 and select *Html Table*.

6. Click *OK*.

7. Highlight the Allstk label, as shown in the following image, and delete the label.
**Procedure:** How to Add the Connect Task

1. Open the Tasks & Animations panel.
2. Add the load task.
3. In the Requests/Actions section, click the arrow for Requests selections, select Run Request, then select Request1, and then select Request1.Connect, as shown in the following image.

4. Run the application.
**Procedure:** How to Add a Hyperlink

1. Click the HTML table and open the Settings panel.
2. Select *Moviecode* and change the Body hyperlink property to *True*, as shown in the following image.

![Image of settings interface](image_url)

**Procedure:** How to Add the Variables

1. From the Requests & Data Sources panel, expand the *Variables* folder.
2. Drag *selval* and then *action* onto the form. By default, they are named edit1 and edit2.
3. Rename edit1 and edit2 to `selval` and `action`, as shown in the following image.

To do so:

a. Open the Properties panel.

b. Click `selval` and change the Unique Identifier from edit1 to `selval`.

c. Click `action` and change the Unique Identifier from edit2 to `action`.

These are used to store and pass back values to Maintain Data. You can make them not visible (visible No) later.

**Procedure: How to Add the Event**

When you click the link, you want to return to the Maintain Data code, retrieve the record, and display it.

1. Click the HTML table and open the Properties panel.
2. Click the lightning bolt and double-click *Click link*, as shown in the following image.

![Click link properties](image)

3. Since there are no Maintain Data tasks in a non-persistent Maintain Data application, you need to use JavaScript.

- Store the selected value in selval.

- Set action to 'G', as shown in the following code, to branch in the Maintain Data code.

```javascript
selval.value=IbComposer_getClickedCellValue(ctrl);
action.value= 'G';
```
Open the Tasks & Animations panel and drag the load task into the event, as shown in the following image.

Note: This requires a reconnect to Maintain Data every time.

Procedure: How to Update the Code

1. Click the .mnt tab to type more code.
2. Add an IF statement for when action equals 'G' and a Getdata case, as shown in the following image.

```
MAINTAIN FILE movies

$$Declarations

Case Top
if action eq 'G' then perform Getdata
perform loaddata
Winform Show_and_exit Form1;
EndCase

case loaddata
compute action/a1;
compute selval/a6;
stack clear allstk
reposition moviecode
for all next moviecode into allstk
endcase

Case Getdata
stack clear recstk
reposition moviecode
Next moviecode into recstk
   where moviecode eq selval;
endcase

END
```

3. Save the code.

**Procedure:** How to Add Fields to the Form

1. Display the HTML form.
2. From the Request & Data Sources panel, expand the Stacks folder and drag `recstk` onto the form. Left-click and drag for default fields, as shown in the following image.

![Image showing the Request & Data Sources panel with `recstk` dragged onto the form]

3. Save the code and run the application.

4. Select a row in the HTML table.

   The output is:

   ![Image showing the HTML table with selected row]
5. Open the Maintain Data code and add an UpdateData case with a test for action equal to 'U', as shown in the following image. The edit boxes and stacks get sent back to the code.

```
MAINTAIN FILE movies

$$Declarations

Case Top
    if action eq 'G' then perform Getdata
    if action eq 'U' then perform Updatedata
    perform loaddata
    Winform Show_and_exit Form1;
EndCase

    case loaddata
    compute action/a1;
    compute selval/a6;
    stack clear allstk
    reposition moviecode
    for all next moviecode into allstk
    endcase

    Case Getdata
    stack clear recstk
    reposition moviecode
    Next moviecode into recstk
    where moviecode eq selval;
    endcase

    Case UpdateData
    Update movies.MOVINFO.TITLE movies.MOVINFO.CATEGORY
    movies.MOVINFO.DIRECTOR movies.MOVINFO.RATING
    movies.MOVINFO.RELDATE movies.MOVINFO.WHOLESALEPR
    movies.MOVINFO.LISTPR movies.MOVINFO.COPIES from recstk;
Endcase

END
```

6. Save the code.

7. Draw a button on the form and change the text to *Update*.

8. Open the Properties panel.
9. Click the lightning bolt and double-click the Click event, as shown in the following image.

![Click Event Image]

10. In the JavaScript, update the action field, as shown in the following image.

```javascript
//Begin function button1_onclick

function button1_onclick(event) {
  var eventObject = event ? event : window.event;
  var ctrl = eventObject.target ? eventObject.target : eventObject.srcElement;
  // TODO: Add your event handler code here
  action.value = 'U';
  IbComposer_triggerExecution("load", 1);
}

//End function button1_onclick
```

11. Reconnect to the Maintain Data code.
12. Save the code and run the application.

**Note:** Add and Delete are handled the same way.

**Procedure:** How to Add Other Objects

You can use other objects to display and collect data.

1. Add the loadratestk case to display all valid ratings.
2. Perform the load from both loaddata and Getdata.
3. Add code into Getdata to autoscroll to the selected value, as shown in the following image.

```plaintext
   case loaddata
   compute action/a1;
   compute selval/a6;
   stack clear allstk
   reposition moviecode
   for all next moviecode into allstk
   perform loadratestk
   endcase

   case loadratestk
   compute selrate/a4;
   Compute ratestk.rating/a4;
   Compute ratestk(2).rating = 'G';
   Compute ratestk(3).rating = 'PG';
   Compute ratestk(4).rating = 'PG13';
   Compute ratestk(5).rating = 'R';
   Compute ratestk(6).rating = 'NR';
   endcase

   Case Getdata
   perform loadratestk
   stack clear recstk
   reposition moviecode
   Next moviecode into recstk
       where moviecode eq selval;
   Compute i/i2=1;
   repeat ratestk.focount
       if ratestk(i).rating = recstk.rating then begin
           Compute ratestk.focindex = i;
           Goto exitrepeat
       endbegin
   compute i=i+1;
   endrepeat
   endcase
```
4. From the Requests & Data Sources panel, right-click `ratestk/rating`, drag it onto the form next to the rating field, and select *Create controls*, as shown in the following image.
5. Right-click the Edit box value in the Control Type column, select *New control*, and then select *Drop down list*, as shown in the following image.

6. Click *OK*.

7. Delete the rating field and header.

8. Drag the new drop box into that space.

9. Select the new drop box.

10. Open the Request & Data Sources panel and the Settings panel.
11. Drag selrate from the Variables folder into the Selection to area, as shown in the following image.

Procedure: How to Retrieve the Values

1. Using the selrate or stack().field, edit the Maintain Data code to collect the value from the drop box, as shown in the following image. This works for drop boxes, list boxes, and radio buttons.

   ```
   Case UpdateData
   Compute recstk.rating = selrate;
   Compute recstk.rating = ratestk().rating;
   Update movies.MOVINFO.TITLE movies.MOVINFO.CATEGORY
   movies.MOVINFO.DIRECTOR movies.MOVINFO.RATING
   movies.MOVINFO.RELDATE movies.MOVINFO.WHOLESALEPR
   movies.MOVINFO.LISTPR movies.MOVINFO.COPIES from recstk ;
   Endcase
   ```

2. Save the code and run the application.
The output is:

![Image of grid and request form]

**Procedure:** How to Add a Grid

Using the `IWC.updateGridData("stk");` command, non-persistent Maintain Data applications can use the grid to update multiple rows and columns.

1. Create a new HTML page.
2. Create a new embedded Maintain Data request, using the movies data source.
3. Add the code, as shown in the following image.

```
MAINTAIN FILE movies

$$Declarations

Case Top
  if action = 'U' then perform updater
  perform loader
  Winform Show_and_exit Form1;
EndCase

case loader
  stack clear stk1
  reposition moviecode
  for 10 next moviecode into stk1
  compute action/a10;
endcase

case updater
  stack clear stk1
  reposition moviecode
  for 10 next moviecode into stk1
  IWC.updateGridData("stk1");
  For all update rating from stk1
endcase

END
```

4. Drag the form onto the canvas.

5. Right-click stk1, drag it onto the form, and select Create controls.
6. Leave the first five fields selected and change the Control Type to Grid, as shown in the following image.

7. Click OK.

8. Open the Tasks & Animations panel.
9. Click the arrow in the Requests/Actions section, select *Run Request*, then select *Request1*, and then select *Request1.Connect*, as shown in the following image.

10. Expand the *Variables* folder.

11. Drag action onto the form.

12. Open the Properties panel.
13. Rename edit1 to *action* by clicking *action* and changing the Unique Identifier from edit1 to *action*, as shown in the following image.

14. Draw a button on the form and change the text to *Update*.

15. Open the Properties panel, click the lightning bolt, and double-click *Click*, as shown in the following image.
16. Set the action.value to 'U', as shown in the following image.

```javascript
function button3_onclick(event) {
    var eventObject = event ? event : window.event;
    var ctrl = eventObject.target ? eventObject.target : eventObject.srcElement;
    // TODO: Add your event handler code here
    action.value='U';
    ibComposer_triggerExecution("load", 1);
}
```

17. Save the code and run the application.

The output is:

![Image of a table showing movie data with a button labeled 'Update' and an input field set to 'U']

**Asynchronous Maintain Data Applications**

If you are running a Maintain Data application from a mobile device and you lose the wireless connection or connection to the Reporting Server, you can still save your data to the mobile device.

Maintain Data applications that can be asynchronous, must:

- Be non-persistent. See *Persistent and Non-Persistent Maintain Data Applications* on page 795.
- Not need to receive information from the Reporting Server after the initial load.
- Use JavaScript code for all selections and validations on the form.
Creating the Data Sources

For the example in this topic, a movie critic must rate movies. There may or may not be a connection to the Reporting Server when saving the review. The example uses the movies sample data source, as well as a second data source, called critic. Notice that the critic data source uses the same Moviecode and Title fields as the movies data source. While movies and critic are FOCUS files (SUFFIX=FOC), they could be SQL or any of the other supported data sources.

Procedure: How to Create the Application

The components of this application reside in the repository.

1. In App Studio, from the Environments Tree panel, right-click Domains and select New Folder, as shown in the following image.
2. Name the folder *asynch*.

3. Right-click *asynch*, point to *New*, and click *HTML/Document*, as shown in the following image.
The HTML/Document Wizard opens.

4. Click Next.

   The Templates, Settings, and Themes dialog box opens.

5. Click Finish.

6. Open the Requests & Data Sources panel.
7. From the Requests & Data Sources panel, click the down arrow next to the *New* icon, select *Embedded Request*, and then select *New Maintain Data*, as shown in the following image.

![Requests & Data Sources panel](image)

By default, for an Embedded Request, Request1 is created.

**Procedure: How to Add the Data Sources**

This application uses the movies and critic data sources. A Maintain Data application can manipulate up to 15 data sources in a single application.

1. From the Requests & Data Sources panel, right-click the *Request1* parameter and select *Use data sources*, as shown in the following image.
2. From the Data Sources in Procedure dialog box, select **New**.

3. Browse to the location of your Maintain Data data sources and select the ones to use (movies and critic).

4. Locate the movies data source and click **OK**.

5. Locate the critic data source and click **OK**.

The Data Sources in Procedure dialog box should look similar to the following image.
Procedure:  How to Create the Maintain Data Code

The HTML canvas contains two tabs, as shown in the following image.

- The htmlpage1 tab displays the form and all the elements.
- The htmlpage1_Request1.mnt tab contains the Maintain Data code.

You can switch back and forth between the tabs.

1. Before editing the code, turn off Auto parse. Right-click the code and uncheck Auto parse from the menu as shown in the following image.

When creating a non-persistent Maintain Data application, every time you return to the code, you have to start with Top case. This is because the agent on the Reporting Server goes away once the form is displayed. You need to create a variable, in this case, Action, to branch to the proper case every time.
The code has three cases: Top, Loadrecs, and Include, as shown in the following image.

```
MAINTAIN FILE movies AND critic
$Declarations
Case Top
If Action = 'I' then perform Include;
Perform Loadrecs
Infer Critic.Moviecode into Detailstk
Winfom Show_and_exit Form1;
EndCase

Case Loadrecs
compute action/A1;
For All Next Movies.Moviecode into Movstk
compute I/I2=1;
Repeat Movstk.FocCount
   Reposition critic.moviecode
   Stack Clear CheckStk
   Next Critic.Moviecode into checkstk
      Where critic.moviecode = movstk(i).moviecode;
      If checkstk.foccount eq 0 then
         Compute Movstk(I).Reviewed/A1 = 'N';
      Else Compute Movstk(I).Reviewed = 'Y';
      Compute I=I+1;
Endrepeat
Endcase

case Include
include critic.moviecode from detailstk
commit
Perform loadrecs
Endcase
END
```

- **Top case.** Checks if the Action field is set to 'I'. If it is, the code branches to the Include case to save a record to the data source. It also creates the Detailstk stack and performs the Loadrecs case. Finally, it displays the form. By using the Winform_show_and_Exit Form1 command, the form is displayed and the agent goes away. This is what makes the application non-persistent.
Loadrecs case. Creates Movstk. This is the list of movies that the critic needs to review. Once the records are loaded, the records in Movstk are compared against the critic data source. If the movie has already been reviewed, the Reviewed Flag is set to Y. Otherwise, it is set to N.

Includer case. Saves the record to the data source and reloads Movstk.

2. Once you type the code, save your application.

Procedure: How to Create the Form

1. From the Requests & Data Sources panel, expand all of the folders (Stacks, Data Sources, Functions, Forms, and Variables), as shown in the following image.
2. Drag Form1 from the Forms folder to the top-left corner of the canvas, as shown in the following image.

3. When prompted to create a multipage control, click No.
4. Expand the form, so it fills the canvas.

Procedure: How to Display the Stack

Movstk contains the list of movies that the critic needs to review. An HTML table is used to display and select the next movie to review.

1. From the Requests & Data Sources panel, right-click Movstk and drag it onto the top-left corner of the form.
2. Select Create controls, as shown in the following image.

Note: If you accidentally left-click Movstk and fields are created, click the undo icon, and make sure to right-click the stack before you drag it onto the form.
3. To display only Moviecode, Title, and Reviewed in the HTML table:
   a. In the Parameters dialog box, change the values in the Create control column to *Don’t create* for all the other fields.
   b. In the Control Type column for Moviecode, right-click the Control Type column and select *Html Table*, as shown in the following image.

![Control Type Selection](image)

4. Click *OK* to create the control.
The HTML table is shown in the following image.

![HTML Table Image]

5. Click the HTML table and open the Settings panel.

6. Click `<Row Numbers>` and change the Body hyperlink property to True, as shown in the following image.

![Settings Panel Image]
7. From the Requests & Data Sources panel, left-click and drag Detailstk to the form under the Html table, as shown in the following image. The default controls (edit boxes) are created.

![Form with Html table and edit boxes](image)

**Note:** By default, the edit box for Moviecode is named edit1 and the edit box for Title is named edit2.

a. Open the Properties panel.

b. Click the Moviecode edit box and change the Unique Identifier from edit1 to moviocode.

c. Click the Title edit box and change the Unique Identifier from edit2 to title.

8. If the Comment field is too long for the form, select the Comment field and the Comment label. Open the Properties panel, if not already open, and change Width to 1000px, as shown in the following image.

![Properties panel with Width set to 1000px](image)
9. From the Requests & Data Sources panel, drag the action field from the Variables folder onto the form, as shown in the following image.

The Action field determines where to branch when returning to your Maintain Data code. The Action field must be on the form, but does not need to be visible. You can select the field and the label and in the Properties panel make the objects not visible (Visible No).

10. In the Properties panel, click the action edit box and change the Unique Identifier to action.

11. Draw a button on the form and change the text to Submit, as shown in the following image.

**Procedure: How to Add Tasks**

All Maintain Data applications must have a Load task. The Load task launches the Maintain Data code and displays the forms. A persistent Maintain Data application can have multiple tasks that perform multiple cases. A non-persistent application only needs the Load task. This is because the Maintain Data code is always initiated from the Top case and why the Action field needs to be set in the JavaScript code.

1. Open the Tasks & Animations panel.

2. Add the load task.
3. In the Requests/Actions section, click the arrow for **Requests selections**, select **Run Request**, then select **Request1**, and then select **Request1.Connect**, as shown in the following image.

**Procedure**: **How to Add Events**

While tasks can connect directly to the Maintain Data code, you use events to perform JavaScript.

1. Click the HTML table and open the Properties panel.
2. Click the lightning bolt and double-click **Click link**, as shown in the following image.
3. Click the ellipse (…) to open the Embedded JavaScript tab.

4. Locate the event for tablectrl1_onclicklink. If your tablectrl is not named tablectrl1, locate the specific clicklink event.

5. Type the JavaScript code, as shown in the following image. Remember, case matters. If your tablectrl is not named tablectrl1, make sure the indicated row contains the name of your tablectrl.

```javascript
//Begin function tablectrl1_onclicklink
function tablectrl1_onclicklink(event) {
  var eventObject = event ? event : window.event;
  var ctrl = eventObject.target ? eventObject.target : eventObject.srcElement;
  // TODO: Add your event handler code here

  var TableDiv = document.getElementById("tablectrl1");
  var TableObj;
  for (i=0; iTableDiv.children.length; i++) {
    if (TableDiv.children[i].tagName == "TABLE") {
      TableObj = TableDiv.children[i];
      break;
    }
  }

  CurRow = IboComposer_getClickedRow(ctrl);
  var selcode = TableObj.rows[CurRow].cells[1].innerHTML;
  var seltitle = TableObj.rows[CurRow].cells[2].innerHTML;
  moviecode.value = selcode;
  title.value = seltitle;
}
//End function tablectrl1_onclicklink
```

6. Redisplay the form by clicking the Design tab on the bottom left of the page.

**Note:** At runtime, when you select a row from the HTML table, the JavaScript has Moviecode populate the moviecode field and Title populate the title field.

7. Select the Submit button.

8. Open the Properties panel.
9. Click the lightning bolt and double-click the *Click* event, as shown in the following image.

10. Type the JavaScript code, as shown in the following image. Remember, case matters. If your `tablectrl` is not named `tablectrl1`, make sure the indicated row contains the name of your `tablectrl`.

```javascript
//Begin function button1_onclick
function button1_onclick(event) {
    var eventObject = event ? event : window.event;
    var ctrl = eventObject.target ? eventObject.target : eventObject.srcElement;
    // TODO: Add your event handler code here
    action.value = 'I';
    Composer_triggerExecution("load", 1);
    var TableDiv = document.getElementById("tablectrl1");
    var TableObj;
    for(i=0; i<TableDiv.children.length, i++) {
        if(TableDiv.children[i].tagName == "TABLE") {
            TableObj = TableDiv.children[i];
            break;
        }
    }
    TableObj.rows[CurRow].cells[3].innerHTML = "Y";
}
//End function button1_onclick
```

11. At runtime, when you click the button to set the action field to 'I' and perform the Load task. The Maintain Data code is performed and the code branches to the Includer case to save the record. When you return to the form, the Reviewed flag is changed from Y to N so the critic knows this review is done.

12. Save the code and run the application.
You can select and review a movie, as shown in the following image.

Now that you have created the non-persistent application, you can make it so that it can work in an asynchronous environment.
13. Click the canvas, not the form. When you open the Properties panel, you should see Document, not Form, as shown in the following image.

There are two Offline parameters:

- **Offline: File.** Is the name of the file run from the mobile device.

- **Offline: Save on reconnect.** Any records saved to your mobile device automatically get sent to the Reporting Server the next time the application connects.
14. Click the Offline: File ellipse (…) to select a file, as shown in the following image.

15. Place the file in the asynch folder and name it *asynch1*.

16. Click *OK*.

   If prompted to create the file, select *Yes*.

17. Right-click the canvas, not the form.
18. Select *Export for offline*, as shown in the following image.

Two files are created:

- **asynch1.htm.** Contains all of the forms and code.
- **asynch1.appcache.** Contains all of the resources that the application needs to run offline.

**Procedure: How to Run the Application on a Mobile Device**

The first time you run the application, you must be connected to the Reporting Server. All of the components and data is loaded onto your mobile device.

1. Click the browser upload button and select *Add to Home Screen*, as shown in the following image.
2. Change the name to *asynch1* and click *Add*.

3. *Asynch1* now appears on the home screen on your mobile device.

   You can run *Asynch1* from your mobile device. If you are connected to the Reporting Server, the updates take place in real time. If you are not connected to the Reporting Server, the updates are saved to your mobile device. The next time you run the application while connected to the Reporting Server, all your changes are saved.

**Migrating Legacy Maintain Procedures to Maintain Data**

You can run Maintain applications that were created in Developer Studio in App Studio, without any changes or migration. However, if you wish to make changes to your application, you must migrate it to App Studio.

You can migrate existing Maintain procedures to the App Studio Maintain Data application, using the External Request option in the Requests & Data Sources panel.

*Note:*

- When migrating legacy Maintain procedures to Maintain Data, back up your application folder before starting this process.

- The environment defined for the original application still needs to be defined at the time of migration. For example, if you used localhost when the Maintain application was initially created, localhost must still be defined when migrating. Otherwise, files may not be found.

**Procedure: How to Migrate Legacy Maintain Procedures**

1. If you do not see your application on the Configured Environments tree, create a new one by right-clicking *Applications* and clicking *New Application Directory*.

   *Note:* Assign the application the name of the directory containing all of the files, including Master and Access Files, needed for the Maintain application.

2. Create a new HTML page by right-clicking the application name, selecting *New*, and then selecting *HTML/Document*.

   *Note:* The Maintain application code is no longer a stand-alone application. It resides as part of an HTML page.

3. In the HTML/Document Wizard, leave *HTML Page* selected and click *Next*.

4. On the Templates, Settings, and Themes pane, click *Finish* to continue.

5. Open the *Requests & Data Sources* panel and pin it to the canvas.

6. From the New drop-down menu, select *External Request* and then select *Maintain data: Existing* from the shortcut menu.
7. From the Open File dialog box, select the Maintain file to be migrated, and the migration process begins.

**Note:** If there is more than one Maintain file, select the parent or main Maintain that CALLs the others. If you do not see the name of your Maintain file, select the *Show All Files in Associated Paths* radio button.

The following App Studio dialog box opens, asking you whether you want to start the Maintain Data procedure after the page is loaded.

8. Click *Yes*.

**Note:** All Maintain applications must have a Load task that performs a Connect to the code. Without this, when you run the application, the Maintain code will not be processed. Clicking *Yes* to start the Maintain right after the page is loaded creates this task. All new Maintain applications must also contain this task.

As the migration runs, you may receive a message that the Maintain procedure contains multiple Winforms and that recommends that you use a multipage control for better layout and presentation, as shown in the following image. The multipage control puts one Winform on a page and the appropriate Winform is displayed automatically when needed.

9. Click *Yes*. 
The migration process continues.

If the conversion is successful, the following App Studio dialog box opens, indicating that the conversion process is complete and asking if you want to see the log file.

10. Click Yes if you want to review the log file. Otherwise, click No.

11. Click OK if you receive a message stating that code in the Maintain procedure was found that could not be migrated automatically and that you need to revise it.

The Maintain procedure opens in the App Studio Maintain Editor, as shown in the following image. In addition, the Maintain request can be expanded in the Requests & Data Sources panel to see its components.

12. In the App Studio Maintain Editor, search for the following line of code:

   ```
   --* The following line of code is not consistent with the new design of Maintain. Please revise.
   ```
This line appears for constructs, such as when the Maintain code wants to directly manipulate a control, or there is a Winform Set statement to make an object visible.

**Maintain Data Migration Considerations**

The following are migration considerations when migrating legacy Maintain applications to Maintain Data.

**Maintain Data Licensing**

Maintain Data has a license code on the Reporting Server. If Maintain Data is not licensed, each Maintain Data page contains a diagonal watermark background image that says "Maintain Data Trial" to indicate that the product is not licensed.

**Naming Changes**

An object in Maintain Data or JavaScript code is no longer referenced using Form.Objectname. All migrated variables are changed to Form_Objectname.

**Events**

All Maintain code in the application event section is migrated into the application. A case is created for each event, and a task is assigned to that case. Display the Tasks & Animations panel. When you click on a control, you can see the task assigned to each case.

If the event contains JavaScript, you can view the JavaScript by clicking the Embedded JavaScript tab at the bottom of the form. To see if an object is associated with a JavaScript event, click the object and display the Properties panel. Click the lightning bolt to display the events. Clicking on an event name brings you to the code in the Embedded JavaScript view.

**Winform Set Commands**

There are no longer Winform Set commands in Maintain Data. All of these commands are replaced by computed variables. Assign these variables to an object property and when the variable is evaluated, the property is set. Instead of the following Maintain command to make something invisible:

```
Winform Set Form.Object.Visible to No;
```

In Maintain Data, you use a Compute command, and assign that to the visible property of the object. For example:

```
Compute Var/a10 = 'Hidden';
```
You can assign variables by dragging them from the Requests & Data Sources panel directly onto the Properties panel of the object.

**Winform Get Command**

The Winform Get command is no longer supported. You can test the associated variable to get the current value.

**showLayer Command**

The SetLayer command in Maintain has been replaced by the IbComposer_showLayer command in Maintain Data. The IbComposer_showLayer command allows layers to be set as visible or invisible at run time. It is used in a JavaScript event.

**IWCTrigger Code**

IWCTrigger code is no longer used for a JavaScript event to perform a Maintain case. Instead, a new task is created to perform the Maintain case and assigned to a Trigger Type of TBD. You can then drag that task into the JavaScript code and create:

```javascript
IbComposer_triggerExecution("taskn",1);
```

This conversion is done for you at migration. If the IWCTrigger code was in a linked or embedded JavaScript file, you will have to perform this code conversion yourself.

**HTMLTable GetHTMLField**

When embedding HTML objects in HTMLTables, GetHTMLField was used to retrieve the selected or entered value at run time. You can now assign a Selection To field when creating the HTMLTable, making this unnecessary.

**HTMLTable ClickRow, ClickColumn, and Value**

Retrieving the clicked row, column, or value from an HTMLTable has changed for using both Maintain Data and JavaScript code.

The Developer Studio functions ClickColumn, ClickRow, and Value(cell value) are now IbComposer_getClickedColumn, IbComposer_getClickedRow, and IbComposer_getClickedCellValue.

The following Developer Studio Maintain code is removed.

```javascript
compute X/13 = Form1.HTMLTable1.Clickrow;
compute Y/13 = Form1.HTMLTable1.Clickcolumn;
compute Z/13 = Form1.HTMLTable1.value;
```
X and Y are still created, but are assigned in the HTMLTable Settings panel to the ClickRow and ClickColumn parameters.

The statement: Form1.HTMLTable1.value; is no longer supported and will have to be replaced. You can use the code:

```javascript
compute \( \frac{Z}{A10} = \text{Stack}(x).field; \)
```

where:

- **Stack**
  - Is the name of the stack populating the HTMLTable.

- **x**
  - Is the variable containing the ClickRow value.

- **field**
  - Is the name of the field on which you are clicking.

This Developer Studio JavaScript code:

```javascript
var col = Form1.HTMLTable1_ClickColumn.value;
var row = Form1.HTMLTable1_ClickRow.value;
var val = Form1.HTMLTable1_Value.value;
```

is replaced by:

```javascript
var col = IbComposer_getClickedColumn(ctrl);
var row = IbComposer_getClickedRow(ctrl);
var val = IbComposer_getClickedCellValue(ctrl);
```

### HTMLTable Dynamic Sizing

In Maintain, the command: `Form1.HTMLTable1.RealBodyRowHeight = n` was used to change the height of a row in an HTMLTable. In Maintain Data, this is done in the HTMLTable Properties panel.

### Freezing Grid Columns Using the FixedColumns Property

In Maintain Data, the FixedColumns property, which was used to freeze columns in a grid in legacy Maintain, is no longer supported. Legacy Maintain applications that use this property will no longer have frozen columns when migrated to Maintain Data.

### Closing and Exiting a Form

Since the Maintain Data application is now part of an HTMLPage, the command `self.Winexit` or `formname.Winexit` is no longer supported.
JavaScript `onclick window.close` Function

The JavaScript `onclick window.close` function only works with Internet Explorer 11.

Embedded or Linked JavaScript Files or CSS Files

To see the JavaScript or CSS files that are associated with your migrated application, click the form and display the Settings panel. The names of your resource files can be found there.

Displaying Forms and Databases

When you expand the Forms folder on the tree, all application forms are displayed. You can display one or multiple forms by checking the box next to their names.

Databases are displayed once for all the requests. They are not displayed for each request.

Property Functions in JSGrid

- Two additional values for `contentTypes` were added to the `ColumnSetContentType` function. The two values are 3 - CheckBox and 4 - Select.

- The `CellSetFont` function has been enhanced to include additional styling information, as follows:
  ```javascript
  grid1.CellSetFont(3,2,"italic bold 12px antique, serif");
  ```

- The syntax for the `SetTopRow` function is now:
  ```javascript
  $('#Form1_Grid1_table').setTopRow
  ```

- The syntax of the functions no longer includes the form name.

- The Grid and JSGrid `OnRowSized` and `OnRowSizing` events are not available in App Studio.

Migrating JavaScript Functions to App Studio Maintain Data

You can execute JavaScript functions to get and temporarily set values in a grid. Since these changes are made at run time using JavaScript functions, any changes are lost when the form refreshes. For identification purposes, when using these functions, the first cell in the grid is row 0, column 0. Grid column and row headers are ignored for numbering purposes.

If you used JavaScript functions with an ActiveX grid in legacy Maintain, you can update them to the corresponding functions listed below.
Function: SetCellFocus

Use the function SetCellFocus to place the cursor on a specific cell of the grid. This replaces the legacy Maintain function GotoCell.

Syntax: How to Set the Cursor on a Row and Column of a Grid

```
form.SetCellFocus(col, row);
```

where:

- `form`
  - Alphanumeric
  - Is the unique identifier of the grid.

- `col`
  - Numeric
  - Is the column of the cell.

- `row`
  - Numeric
  - Is the row of the cell.

Example: Setting the Cursor on a Row and Column of a Grid

The following example moves the cursor to the third column of the first row.

```
grid1.SetCellFocus(2, 0);
```

Function: GetNumberRows and GetNumberColumns

Use the function GetNumberRows to determine the total number of rows in a grid, and use GetNumberColumns to determine the total number of columns.

Syntax: How to Get the Number of Rows and Columns in a Grid

```
var var1 = form.GetNumberRows();
var var2 = form.GetNumberColumns();
```

where:

- `var1, var2`
  - Alphanumeric
  - Are the names of the variables to set.
**Function: GetCurrentRow and GetCurrentColumn**

Use the function GetCurrentRow to determine the row where the cursor is currently located in the grid, and use GetCurrentColumn to determine the column where the cursor is currently located. These replace the legacy Maintain functions GetCurrentRow and GetCurrentColumn.

**Syntax: How to Get the Current Row and Column in a Grid**

```javascript
var var1 = form.GetCurrentRow();
var var2 = form.GetCurrentColumn();
```

where:

- **var1, var2**
  - Alphanumeric
  - Are the names of the variables to set.

**Function: CellSetBackColor**

Use the function CellSetBackColor to change the background color of a grid cell. This replaces the legacy Maintain function QuickSetBackColor.

**Syntax: How to Change the Background Color of a Grid Cell**

```javascript
form.CellSetBackColor(col, row, color);
```

where:

- **form**
  - Alphanumeric
  - Is the unique identifier of the grid.

- **col**
  - Numeric
  - Is the column of the cell.
row
    Numeric
    Is the row of the cell.

color
    Alphanumeric
    Is a color name, RGB value, or hexadecimal color value, in double quotation marks.

Example:  Changing the Background Color of a Grid Cell
The following example changes the background color of the cell in the third row and third column to blue.

grid1.CellSetBackColor(2,2,"blue");

Function: CellGetBackColor
Use the function CellGetBackColor retrieve the background color of a cell into a variable.

Syntax:  How to Retrieve the Color of a Cell

var var1 = form.CellGetBackColor(col, row);

where:

var1
    Alphanumeric
    Is the name of the variable to set.

form
    Alphanumeric
    Is the unique identifier of the grid.

col
    Numeric
    Is the column of the cell.

row
    Numeric
    Is the row of the cell.
Migrating Legacy Maintain Procedures to Maintain Data

Example:

Retrieving the Color of a Cell
The following example retrieves the background color of the cell in the third row and third
column as celcolor.
var celcolor = grid1.CellGetBackColor(2,2);

Function: CellSetTextColor
Use the function CellSetTextColor to change the color of the text in a grid cell. This replaces
the legacy Maintain function QuickSetBackColor.

Syntax:

How to Change the Color of Text in a Grid Cell
form.CellSetTextColor(col,row,color);

where:
form
Alphanumeric

Is the unique identifier of the grid.
col

Numeric
Is the column of the cell.
row

Numeric
Is the row of the cell.
color
Alphanumeric

Is a color name, RGB value, or hexadecimal color value, in quotation marks (").

Example:

Changing the Color of Text in a Grid Cell
The following example changes the text color of the cell in the third row and third column to
blue.
grid1.CellSetTextColor(2,2,"rgb(0,0,255)");

852

Information Builders


Function: CellGetTextColor
Use the function CellGetTextColor retrieve the color of text in a cell into a variable. This replaces the legacy Maintain function CellGetTextColor.

Syntax: How to Retrieve the Color of Text in a Cell

```
var var1 = form.CellGetTextColor(col, row);
```

where:

- **var1**
  - Alphanumeric
  - Is the name of the variable to set.

- **form**
  - Alphanumeric
  - Is the unique identifier of the grid.

- **col**
  - Numeric
  - Is the column of the cell.

- **row**
  - Numeric
  - Is the row of the cell.

Example: Retrieving the Color of Text in a Cell
The following example retrieves the color of the text in the cell in the third row and third column as celcolor.

```
var celcolor = grid1.CellGetTextColor(2,2);
```

Function: CellSetText
Use the function CellSetText to change the text in a grid cell. This replaces the legacy Maintain function CellSetText.

Syntax: How to Change the Text in a Grid Cell

```
form.CellSetText(col, row, text);
```
where:

*form*  
Alphanumeric  
Is the unique identifier of the grid.

*col*  
Numeric  
Is the column of the cell.

*row*  
Numeric  
Is the row of the cell.

*text*  
Alphanumeric  
Is the text to enter into the cell, in quotation marks (").

**Example:** Changing the Text in a Grid Cell

The following example changes the text of the cell in the second row and second column to the words New Text.

```javascript
grid1.CellSetText(1, 1, "New Text");
```

**Function:** CellGetText

Use the function CellGetText to retrieve the text from a cell into a variable. This replaces the legacy Maintain function CellGetText.

**Syntax:** How to Retrieve the Text From a Cell

```javascript
var var1 = form.CellGetText(col, row);
```

where:

*var1*  
Alphanumeric  
Is the name of the variable to set.

*form*  
Alphanumeric  
Is the unique identifier of the grid.
Example: Retrieving the Text From a Cell

The following example retrieves the text from the cell in the second row and second column as textvalue.

```javascript
var textvalue = grid1.CellGetText(1,1);
```

Function: CellSetFontSize

Use the function CellSetFontSize to change the size of the text in a grid cell.

Size changes appear in navigation mode. When you edit the cell, the original size is displayed.

Syntax: How to Change the Size of Text in a Grid Cell

```javascript
form.CellSetFontSize(col, row, size);
```

where:

**form**

Alphanumeric

Is the unique identifier of the grid.

**col**

Numeric

Is the column of the cell.

**row**

Numeric

Is the row of the cell.

**size**

Numeric
Is the font size.

**Example:** Changing the Size of Text in a Grid Cell

The following example changes the size of the text in the second column and fourth row to size 25.

```javascript
grid1.CellSetFontSize(1, 3, 25);
```

**Function: CellSetFontStyle**

Use the function `CellSetFontStyle` to change the style of the text in a grid cell.

Style changes appear in navigation mode. When you edit the cell, the original size is displayed.

**Syntax:** How to Change the Style of Text in a Grid Cell

```javascript
form.CellSetFontStyle(col, row, style);
```

where:

- **form**
  - Alphanumeric
  - Is the unique identifier of the grid.

- **col**
  - Numeric
  - Is the column of the cell.

- **row**
  - Numeric
  - Is the row of the cell.

- **style**
  - Alphanumeric
  - Is the font style, in double quotation marks. Available options are Normal, Italic, Oblique, Inherit, and Initial.

**Example:** Changing the Style of Text in a Grid Cell

The following example changes the style of the text in the second column and fourth row to italic.

```javascript
grid1.CellSetFontStyle(1, 3, "Italic");
```
Function: CellSetFont

Use the function CellSetFont to change the font of the text in a grid cell. This replaces the legacy Maintain function QuickSetFont.

Font changes appear in navigation mode. When you edit the cell, the original font is displayed.

Syntax: How to Change the Font of Text in a Grid Cell

```
form.CellSetFont(col, row, "Font");
```

where:

```
form
   Alphanumeric
   Is the unique identifier of the grid.

col
   Numeric
   Is the column of the cell.

row
   Numeric
   Is the row of the cell.

Font
   Alphanumeric
   Is the font definition, which can include a font size. The entire string is in double quotation marks, while the font name is in single quotation marks ('').
```

Example: Changing the Font of Text in a Grid Cell

The following example changes the font of the text in the second column and second row to 20 pixel Times New Roman.

```
grid1.CellSetFont(1, 1, "20px 'Times New Roman'" newX);
```

You can specify additional parameters with this syntax. For example, the following function changes the style, size, and font of text in the cell to italic, bold, 30 pixel Georgia, serif.

```
grid1.CellSetFont(1,1, "italic bold 30px 'Georgia, serif'");
```
**Function: CellSetReadOnly**

Use the function CellSetReadOnly to make a cell read only. This replaces the legacy Maintain function CellSetReadOnly.

**Syntax:** How to Change the Protection Value of a Cell

```javascript
form.CellSetReadOnly(col, row, {true|false});
```

where:

- `form` Alphanumeric
  - Is the unique identifier of the grid.

- `col` Numeric
  - Is the column of the cell.

- `row` Numeric
  - Is the row of the cell.

- `{true|false}` Alphanumeric
  - Type 1 or true to make the cell read only, or type 0 or false to make it editable.

After migrating an application that contained the old grid, the following syntax may be seen:

```javascript
form.GetCell(col, row);
form.SetCell (col, row) ;
form.CellSetReadOnly ((true|false));
form.RedrawAll();
```

This syntax accomplishes the same result as the CellSetReadOnly function with the grid name, column, and row specified.

**Example:** Changing the Protection Value of a Cell

The following example makes the cell in the second row and second column read only.

```javascript
grid1.CellSetReadOnly (1,1,true);
```
Function: CellGetReadOnly

Use the function CellGetReadOnly to retrieve the protection value of a cell. This replaces the legacy Maintain function CellGetReadOnly.

Syntax: How to Retrieve the Protection Value of a Cell

```javascript
var var1 = form.CellGetReadOnly (col, row);
```

where:

- `var1` Alphanumeric
  
  Is the name of the variable to set.

- `form` Alphanumeric
  
  Is the unique identifier of the grid.

- `col` Numeric
  
  Is the column of the cell.

- `row` Numeric
  
  Is the row of the cell.

Example: Retrieving the Protection Value of a Cell

The following example retrieves the protection value of the cell in the second column and second row as cellread.

```javascript
var cellread = grid1.CellGetReadOnly (1, 1);
```

Function: ColumnSetContentType

Use the function ColumnSetContentType to change the content of a column in a grid. The content is text, by default, but can be changed to other input types.

Syntax: How to Change the Content Type of a Column in a Grid

```javascript
form.ColumnSetContentType(col, contentType);
```
where:

form
   Alphanumeric
   Is the unique identifier of the grid.

col
   Numeric
   Is the column of the cell.

contentType
   Numeric
   Is a number specifying a content type. This can be one of the following values:
   - 0. Text. This is the default values.
   - 1. HTML.
   - 2. Image.
   - 3. Check boxes.
   - 4. Select.

**Example:** Retrieving the Protection Value of a Cell

The following example replaces the text in the second column with check boxes, which are specified by the contentType value of 3.

```plaintext
grid1.ColumnSetContentType(1, 3);
```

**Check Box Property**

During the migration process, the TextOnLeft property does not migrate. If you require this property in App Studio, set the Direction of text property in the Properties panel.
Creating Esri Maps

Geographic Information Systems (GIS) enable you to integrate reports with maps and leverage location-based information.

In this chapter:

- Illustrating Trends
- Using the WebFOCUS Esri HTML5 Viewer
- Creating an Esri Component on an HTML Page
- Using Unified Geographic Roles
- Configuring a Map Data Layer
- Adding a Demographic Layer to a Map
- Adding an RSS Feed to an Esri Map
- Using Map Widgets
- Configuring the Map Menu
- Using IbComposer Functions to Invoke Map Menu Options
- Configuring Layer Visualizations
- Configuring Symbology for a Data Layer
- Configuring Symbology for a Point Data Layer
- Configuring Symbology for a Polygon Data Layer
- Configuring Symbology for a Line Data Layer
- Summary of Symbology and Visualizations by Layer Type
- Refreshing Markers on an ESRI Map Without Refreshing the Entire Map
- Retrieving the Esri Map Viewer Current Extent Coordinates as Variables
- Configuring Maps to Interact With Other Components
- Adding Before Load and After Load Events
- Configuring Geographic Information
- Adding an Esri Proxy URL
- Installing and Configuring Esri on Premise
Illustrating Trends

Using App Studio, you can create maps to identify patterns or trends in your data. By converting data into values that can be displayed on a map, you are able to visualize scenarios, illustrate hot spots, and identify potential problem areas. For example, a law enforcement agency may use mapping functionality to identify areas of higher crime within the locations they cover. You can also use maps to determine how places are related, understand where things are located, and identify the best actions to take. By illustrating trends on a map, a decision maker can identify patterns easily, and reach conclusions sooner.

An early example of how maps can be used to illustrate trends is the case of Dr. John Snow, an epidemiologist who was one of the first to use data to map occurrences of cholera to find the cause of infection. By plotting the cholera data on a map of a town, Dr. Snow was able to visualize a trend that showed higher incidences of cholera closest to water pumps. This example is shown in the following image.
Maps also allow you to measure size, shape, and distribution to detect and quantify patterns, and even perform predictive analytics. An example of how maps can help detect and quantify patterns is the scenario in which a state agency used a WebFOCUS mapping application to solve a problem with their food stamp system. Using this application, odd food stamp redemptions, such as rounded numbers transactions, were discovered. By plotting those transactions on a map, the agency discovered that the redemptions appeared in the same geographic location. Upon further investigation, the agency identified that individuals were selling their food stamps at reduced prices, $50 worth of food stamps for $40 in cash, to others instead using them as intended. This map example is shown in the following image.

When working with maps, the concepts of location intelligence and business intelligence are important to understand. A Geographic Information System (GIS) captures, stores, analyzes, manages, and presents data linked to a location, while Business Intelligence (BI) relies on the conversion of raw data into meaningful information. Location intelligence is the process of analyzing data to make better business decisions. It combines GIS and BI/Analytics to allow the recognition of patterns in your data, including the visualization and discovery of geospatial outliers, which would not be easily discovered if you use the technology independently and separately.

More specifically, maps use non-intrusive GIS workflows with existing data. You can view symbol layers for data bound to a geo-location, such as state, country, and ZIP code, in an integrated map viewer. Using metrics from your data, you can also visualize geographic roles or dimensions. Geographic roles, or dimensions, can be built directly into your Metadata or assigned to a data field when you create a map.
Using the WebFOCUS Esri HTML5 Viewer

The Esri HTML5 Viewer for WebFOCUS is based on the Esri ArcGIS JavaScript API. The ArcGIS JavaScript API is a robust API for creating maps with a variety of symbology options, enabling you to embed maps and tasks in web applications. It is supported on all modern browsers on any device.

The App Studio Esri map component allows you to use online content published on ArcGIS Online. ArcGIS Online publishes demographic and feature data that is location related. On the App Studio Esri map component, you can place any number of these data layers on top of a base map (background map image) of your choosing, and configure symbols and colors to highlight any relevant information.

You provide the location dimension for drawing map layers from a standard WebFOCUS report with XML output.

At run time, the map displays with a set of controls that let you show or hide individual layers, change the basemap, access layer tools, and change the map viewing area. In addition, you can add interactive widgets and other WebFOCUS content, including drilldowns to reports and charts, to create complete applications that leverage Esri content.

WebFOCUS automatically gives you access to public content from ArcGIS Online. If you have ArcGIS credentials, you can access any additional content for which you are licensed by signing into your ArcGIS Portal.

ArcGIS Portal is software from Esri that you can deploy either on premises or in the cloud. ArcGIS Online is the Esri Software as a Service offering that represents GIS as a Service and is implemented using the same technology as ArcGIS Portal. Portals allow you to publish and share content over the web.

A portal can have users who are unaffiliated with an organization or users who are part of an organization. A portal has users, groups, and content. Users sign in to the portal and create and share content. The system supports different types of items including the following:

- **Maps.** Web maps can be displayed on all supported platforms (web, mobile, and desktop).
- **Layers.** Layer types that are supported include feature, map, and image services that can be added as layers in web maps.
- **Applications.** You can create web and mobile applications whose content is provided by web maps.
- **Tools.** Your applications can include geocoding, routing, and other task-based services.
- **Data files.** You can upload, store, download, and, in some cases, activate files to create services (map layers).
In order to run a map in the Business Intelligence Portal, you must configure the properties panel of the HTML page as shown in the following image.

Note that you must set the property *Load in iframe object* to *No*. The default value is *Yes*.

**Note:** When building HTML pages for mobile devices, please use the Responsive Design Templates available in App Studio.

**Creating an Esri Component on an HTML Page**

You insert an Esri map component in an HTML page by clicking the Esri Map button on the right end of the Objects group on the Components tab, as shown in the following image.
After clicking the button, use your mouse to draw an area on the HTML canvas for the map component.

**Configuring the Esri Map Component**

Once you insert the Esri map component into the HTML page, you can configure the following properties and objects.

- The basemap on top of which the feature layers will display.
- Layers (Esri feature layers).
- The map view.
- Geographic role or longitude and latitude for each layer.
- Symbology using colors, shapes, sizes, and images.

The Esri viewer has widgets available at runtime that provide a table of contents (layer list) and a set of tools for making selections and changing the viewing area on the map.

You have the following options for configuring the map component contents.

- A map published on your own portal or on ArcGIS.com.
- The initial spatial extent of the map component (the bounding box for the initial display of the map).

**Note:** On the Properties panel, the Map type property defaults to *Google map*. This property is not relevant to an Esri component and can be ignored in this context.

**Reference:** Choosing a Basemap

The Miscellaneous options on the Properties panel let you select one of the following default basemaps:

- **Dark Gray Canvas Map.** Provides a dark background that allows the focus to be on other layers.
- **Dark Gray Vector.** Provides a detailed basemap for the world, with a dark neutral background using minimal colors, labels, and features.
- **Light Gray Canvas Map.** Provides a light gray neutral background. This is the default basemap.
- **Gray Vector.** Provides a detailed basemap for the world, with a light neutral background using minimal colors, labels, and features.
World Imagery with Labels. Provides a detailed World Imagery map layer with labels.

National Geographic World Map. Provides a general reference map from National Geographic.

Oceans Map. Provides a background designed to be used as a reference map for ocean data.

Open Street Map. Provides the OpenStreetMap community map layer.

World Imagery. Provides a detailed World Imagery map layer.

World Street Map. Provides a multiscale street map for the world.

Streets Navigation Vector. Provides a detailed basemap for the world, with a custom navigation map style.

Streets Night Vector. Provides a detailed vector basemap for the world, using a custom night time street map style that is designed for use at night or in other low-light environments.

Streets Relief Vector. Provides a detailed vector basemap for the world, using a classic Esri street map style including a relief map.

Streets Vector. Provides a detailed vector basemap for the world with a classic Esri street map style.

Terrain with labels. Provides a terrain base map with labels.

World Topographic Map. Provides a topographic map.

Topographic Vector. Provides a detailed basemap for the world, symbolized with a classic Esri topographic map style.

You can also add a custom basemap, as described in Configuring Geographic Information on page 1091.

Reference: Configuring Whether Selections on a Map Are Required to Run a Request

When selections on a map trigger a request to run, you can configure whether clearing the selections reruns the request. To specify whether to rerun the request, use the Selection Required property on the Properties panel for the map object.

"Selection Required" = yes runs the request only when features have been selected on the map. When you click Clear Selection in the Selection Widget, the request is not run again.
"Selection Required" = no always runs the request. When you click Clear Selection in the Selection Widget, the request is run again.

**Reference:** Defining the Esri Component Layers

To define the layers that will display on your map component, you use the ESRI Object Settings panel, shown in the following image:

On this panel, you configure:

- The layers that will display on your map component.
Add a layer by clicking the New Layer icon at the top of the panel, and remove a selected layer by clicking the X at the top of the panel. You can change the default layer name by selecting the default name, clicking it, and typing over it when the edit box displays.

- The visualizations for each layer.
- The symbology used for each layer.

Using the arrow keys at the top of the panel, you can control the order of layers on the resulting map.

**Using Unified Geographic Roles**

In addition to configuring standard Esri map services, the Reporting Server hosts and configures geographic boundaries for 58 World Administrative regions, out of the box. With a second level map license, you have access to additional detailed postal codes.

You can use these files to generate Esri maps in App Studio. To support using these administrative boundaries in maps that can show geographic locations down to the postal code level, the list of geographic roles has been simplified and unified.

The server provides a Geographic Configuration Editor tool for uploading and configuring additional shapefiles and geographic roles, basemaps, and demographic layers. For information, see *Configuring Geographic Information* on page 1091.

The list of geographic roles has been simplified and unified by adding hierarchical levels of keys in the server geographic configuration file. Your request that provides the geography dimension must provide the hierarchical keys needed to identify each target geography. For example, if your geographic role is City, you must also provide values for State and Country.

The following is the list of unified geographic roles is available for generating maps:

- Point of Interest.
- City.
- Continent.
- Country.
- County.
- Geometry line.
- Postal code.
- State.
**Note:** App Studio does not support aliasing or name variations in geographic roles. Users have to cleanse the data and provide the right values for all the georoles. Only Names are supported.

**Example:** Creating a Map of World Cities

The following request, city1.fex, retrieves world city names, state names, and country names.

```
TABLE FILE wf_retail_lite
SUM COGS_US REVENUE_US
FST.CITY_NAME
BY COUNTRY_NAME
BY STATE_PROV_NAME
ON TABLE PCHOLD FORMAT XML
END
```

The following Settings panel for the HTML page that will generate the map is shown in the following image. CITY_NAME is the field that matches the geographic role. The keys needed to correctly identify each city are State (STATE_PROV_NAME field) and Country (COUNTRY_NAME field).
Running the HTML page generates the following map.

![Map Image]

**Procedure:** How to Access Second Level Licensed Geographies for Esri Maps

1. Click **Workspace** on the Reporting Server Web Console sidebar.
2. Click **License** on the ribbon.
   
   The License Management pane opens, as shown in the following image.

   ![License Management Image]

3. Enter your Esri second level license code in the *license_2nd_level_maps* field.
4. Click **Save and Restart Server**.

   Once the second level license is enabled, you can use the standard administrative and postal geographic roles to access these additional geographic boundaries.
Note: The server must be configured for Unicode if Unicode characters exist in the data.

Reference: First and Second Level Licensed Geographies

The Reporting Server Web Console provides a list of first and second level map administrative regions. You can open the list by clicking Geo Services on the Workspace page ribbon and selecting General maps info. This opens the list of administrative regions and postal levels, as shown in the following image.

The regions that say Paid in the Maps license column are the additional regions you can access with a second level license.

- The source for the country administrative level is provided by the Esri World map. Country is administrative level 0.
- The source for the State georole can be provided by the Esri World map or by shape files. When there is a second level license, the state administrative level can be level 1 or level 2.
- The source for the County georole can be provided by the Esri World map or by shape files. When there is a second level license, the county administrative level can be level 3 or level 4.
- The source for the City georole can be provided by the Esri World map or by shape files. When there is a second level license, the city administrative level is level 5.
The source for the Postal Code georole can be provided by the Esri World map or by shape files. When there is a second level license, the postal code administrative level can be 3, 4, or 5.

Some georoles may not be applicable to specific countries. You can see the details of each country and its administrative levels by right-clicking the country name and clicking *Drill to administrative levels* or *Drill to postal levels*, as shown in the following image.
Clicking *Drill to administrative levels* opens the list of States for the country, as shown in the following image.

Clicking any link opens information about the next level georole.
Clicking Drill to postal levels opens the list of postal levels for the country, as shown in the following image.

<table>
<thead>
<tr>
<th>Data Services Agents</th>
<th>General maps info</th>
<th>Result</th>
</tr>
</thead>
</table>

List of postal codes for country 'Albania'
(Source: MB postal layer 3 Extended)

<table>
<thead>
<tr>
<th>POSTAL-CODE (POSTCODE3)</th>
</tr>
</thead>
<tbody>
<tr>
<td>10</td>
</tr>
<tr>
<td>15</td>
</tr>
<tr>
<td>20</td>
</tr>
<tr>
<td>25</td>
</tr>
<tr>
<td>30</td>
</tr>
<tr>
<td>33</td>
</tr>
<tr>
<td>34</td>
</tr>
<tr>
<td>35</td>
</tr>
<tr>
<td>40</td>
</tr>
<tr>
<td>43</td>
</tr>
</tbody>
</table>

Right-clicking a link in any georole column other than the Country column opens a summary of the values for that georole, as shown in the following image.

Statistics of states for country 'Albania'
(Source: MB admin layer 1 Extended)

<table>
<thead>
<tr>
<th>Number of names</th>
<th>First name</th>
<th>Last name</th>
</tr>
</thead>
<tbody>
<tr>
<td>12</td>
<td>Berat</td>
<td>Vlorë</td>
</tr>
</tbody>
</table>
**Administrative Boundaries for Level 1 Countries**

Administrative boundaries for the United States are automatically included by Esri.

The following table lists the Level 1 countries and their Level 1 and Level 2 administrative levels. For some countries, no additional administrative levels are added with a second level license.

<table>
<thead>
<tr>
<th>Country</th>
<th>Postal Code</th>
<th>Level 1 Administrative Level</th>
<th>Level 2 Administrative Level</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>(Number of Values)</td>
<td>(Number of Values)</td>
</tr>
<tr>
<td>Albania</td>
<td>2 - digit</td>
<td>Qarke (12)</td>
<td>Bashkia (61)</td>
</tr>
<tr>
<td>Andorra</td>
<td>5 - digit</td>
<td>Parroquies (7)</td>
<td></td>
</tr>
<tr>
<td>Argentina</td>
<td>5 - digit</td>
<td>Departamentos (525)</td>
<td></td>
</tr>
<tr>
<td>Australia</td>
<td>4 - digit</td>
<td>Local Government Areas (569)</td>
<td></td>
</tr>
<tr>
<td>Austria</td>
<td>4 - digit</td>
<td>Gemeinden (2120)</td>
<td></td>
</tr>
<tr>
<td>Belarus</td>
<td>6 - digit</td>
<td>Woblaszi (7)</td>
<td>Raioni (129)</td>
</tr>
<tr>
<td>Belgium</td>
<td>4 - digit</td>
<td>Communes (589)</td>
<td></td>
</tr>
<tr>
<td>Bosnia and Herzegovina</td>
<td>5 - digit</td>
<td>Kantone (18)</td>
<td>Opstine (142)</td>
</tr>
<tr>
<td>Brazil</td>
<td>5 - digit</td>
<td>Municipios (5565)</td>
<td></td>
</tr>
<tr>
<td>Canada</td>
<td>3 - digit</td>
<td>Census Divisions (293)</td>
<td>Census Subdivisions (5243)</td>
</tr>
<tr>
<td>Chile</td>
<td>2 - digit</td>
<td>Provincias (54)</td>
<td></td>
</tr>
<tr>
<td>China</td>
<td>2 - digit</td>
<td>Counties City Districts (2855)</td>
<td></td>
</tr>
<tr>
<td>Costa Rica</td>
<td>2 - digit</td>
<td>Cantones (81)</td>
<td>Distritos (473)</td>
</tr>
<tr>
<td>Country</td>
<td>Postal Code</td>
<td>Level 1 Administrative Level (Number of Values)</td>
<td>Level 2 Administrative Level (Number of Values)</td>
</tr>
<tr>
<td>-------------------------</td>
<td>-------------</td>
<td>-------------------------------------------------</td>
<td>-------------------------------------------------</td>
</tr>
<tr>
<td>Croatia</td>
<td>2-digit</td>
<td>Zupanije (21)</td>
<td>Općine (556)</td>
</tr>
<tr>
<td></td>
<td>5-digit for 2nd level license</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Cyprus</td>
<td>2-digit</td>
<td>Eparchia (6)</td>
<td>Dimoi (615)</td>
</tr>
<tr>
<td></td>
<td>4-digit for 2nd level license</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Czech Republic</td>
<td>2-digit</td>
<td>Orp (206)</td>
<td>Obce (6253)</td>
</tr>
<tr>
<td></td>
<td>6-digit for 2nd level license</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Denmark</td>
<td>4-digit</td>
<td>Kommuner (99)</td>
<td></td>
</tr>
<tr>
<td>Estonia</td>
<td>5-digit</td>
<td>Maakonnad (15)</td>
<td>Vallad (213)</td>
</tr>
<tr>
<td>Finland</td>
<td>5-digit</td>
<td>Seutukunnat (70)</td>
<td>Kunnat (317)</td>
</tr>
<tr>
<td>France</td>
<td>5-digit</td>
<td>Cantons (1972)</td>
<td>Communnes (36571)</td>
</tr>
<tr>
<td>Germany</td>
<td>5-digit</td>
<td>Municipalités</td>
<td></td>
</tr>
<tr>
<td>Gibraltar</td>
<td>3/4/5-digit</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Greece</td>
<td>5-digit</td>
<td>Nomoi (75)</td>
<td>Dimoi (326)</td>
</tr>
<tr>
<td>Holy See (Vatican City State)</td>
<td>5-digit</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Hong Kong</td>
<td>6-digit</td>
<td>Shih Zizhiqu (18)</td>
<td></td>
</tr>
<tr>
<td>Hungary</td>
<td>2-digit</td>
<td>Kistersegek (175)</td>
<td>Telepulesek (3177)</td>
</tr>
<tr>
<td></td>
<td>4-digit for 2nd level license</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Country</td>
<td>Postal Code</td>
<td>Level 1 Administrative Level</td>
<td>Level 2 Administrative Level</td>
</tr>
<tr>
<td>--------------------------------------</td>
<td>-------------</td>
<td>------------------------------</td>
<td>------------------------------</td>
</tr>
<tr>
<td>Iceland</td>
<td>2 - digit</td>
<td>Landsvaedi (8)</td>
<td>Sveitarfelog (74)</td>
</tr>
<tr>
<td></td>
<td>3-digit for 2nd level license</td>
<td></td>
<td></td>
</tr>
<tr>
<td>India</td>
<td>6 - digit</td>
<td>Districts (640)</td>
<td>Subdistricts (5783)</td>
</tr>
<tr>
<td>Italy</td>
<td>5 - digit</td>
<td>Provincias (110)</td>
<td>Comuni (8047)</td>
</tr>
<tr>
<td>Japan</td>
<td>3 - digit</td>
<td>Prefectures (47)</td>
<td>Municipalities (1901)</td>
</tr>
<tr>
<td>Kenya</td>
<td>1 - digit</td>
<td>Wilaya (47)</td>
<td>Districts (158)</td>
</tr>
<tr>
<td>Korea, Republic of</td>
<td>3 - digit</td>
<td>Si Gun (230)</td>
<td></td>
</tr>
<tr>
<td>Latvia</td>
<td>2 - digit</td>
<td>Rajons (33)</td>
<td>Novadi (119)</td>
</tr>
<tr>
<td></td>
<td>4-digit for 2nd level license</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Liechtenstein</td>
<td>4 - digit</td>
<td>Landschaften (2)</td>
<td>Gemeinden (11)</td>
</tr>
<tr>
<td>Lithuania</td>
<td>2 - digit</td>
<td>Apskritys (10)</td>
<td>Savivaldybes (60)</td>
</tr>
<tr>
<td></td>
<td>5-digit for 2nd level license</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Luxembourg</td>
<td>4 - digit</td>
<td>Cantons (12)</td>
<td>Communes (105)</td>
</tr>
<tr>
<td>Macedonia, the former Yugoslav Republic of</td>
<td>2 - digit</td>
<td>Statisticki Regioni (8)</td>
<td>Opstini (80)</td>
</tr>
<tr>
<td></td>
<td>4-digit for 2nd level license</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Malta</td>
<td>3 - digit</td>
<td>Districts (6)</td>
<td>Local Councils (68)</td>
</tr>
<tr>
<td>Mexico</td>
<td>3 - digit</td>
<td>Estados (32)</td>
<td></td>
</tr>
<tr>
<td>Monaco</td>
<td>5 - digit</td>
<td>Quartiers (9)</td>
<td></td>
</tr>
<tr>
<td>Country</td>
<td>Postal Code</td>
<td>Level 1 Administrative Level (Number of Values)</td>
<td>Level 2 Administrative Level (Number of Values)</td>
</tr>
<tr>
<td>--------------</td>
<td>-------------</td>
<td>-------------------------------------------------</td>
<td>-----------------------------------------------</td>
</tr>
<tr>
<td>Montenegro</td>
<td>2 - digit</td>
<td>Opstina (21)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>5-digit for 2nd level license</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Netherlands</td>
<td>4 - digit</td>
<td>Gemeenten (380)</td>
<td></td>
</tr>
<tr>
<td>New Zealand</td>
<td>4 - digit</td>
<td>Territorial Authorities (68)</td>
<td>Area Units (1911)</td>
</tr>
<tr>
<td>Norway</td>
<td>4 - digit</td>
<td>Okonomisk regioner (89)</td>
<td>Kommuner (428)</td>
</tr>
<tr>
<td>Poland</td>
<td>5 - digit</td>
<td>Gminy (2479)</td>
<td>Gminy Miasta (3119)</td>
</tr>
<tr>
<td>Portugal</td>
<td>4 - digit</td>
<td>Concelhos (308)</td>
<td>Freguesias (3092)</td>
</tr>
<tr>
<td>San Marino</td>
<td>5 - digit</td>
<td>Castelli (9)</td>
<td></td>
</tr>
<tr>
<td>Serbia</td>
<td>5 - digit</td>
<td>National (1)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>5-digit (1156) for 2nd level license</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Singapore</td>
<td>2 - digit</td>
<td>Regions (5)</td>
<td>Planning Areas (55)</td>
</tr>
<tr>
<td>Slovakia</td>
<td>2 - digit</td>
<td>Okresy (79)</td>
<td>Obce (2927)</td>
</tr>
<tr>
<td></td>
<td>6-digit for 2nd level license</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Slovenia</td>
<td>2 - digit</td>
<td>Statisticne Regije (12)</td>
<td>Obcina (212)</td>
</tr>
<tr>
<td></td>
<td>4-digit for 2nd level license</td>
<td></td>
<td></td>
</tr>
<tr>
<td>South Africa</td>
<td>2-digit</td>
<td>Municipalities (234)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>4-digit for 2nd level license</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Country</td>
<td>Postal Code</td>
<td>Level 1 Administrative Level</td>
<td>Level 2 Administrative Level</td>
</tr>
<tr>
<td>--------------------</td>
<td>-------------</td>
<td>--------------------------------</td>
<td>--------------------------------</td>
</tr>
<tr>
<td></td>
<td></td>
<td>(Number of Values)</td>
<td>(Number of Values)</td>
</tr>
<tr>
<td>Spain</td>
<td>5 - digit</td>
<td>Provincias (52)</td>
<td>Municipios (8122)</td>
</tr>
<tr>
<td>Sweden</td>
<td>5 - digit</td>
<td>Kommuner (290)</td>
<td></td>
</tr>
<tr>
<td>Switzerland</td>
<td>4 - digit</td>
<td>Gemeinden (2225)</td>
<td></td>
</tr>
<tr>
<td>Taiwan</td>
<td>3 - digit</td>
<td>Township Districts (368)</td>
<td></td>
</tr>
<tr>
<td>Turkey</td>
<td>5 - digit</td>
<td>Iller (81)</td>
<td>Ilceler (970)</td>
</tr>
<tr>
<td>United Kingdom</td>
<td>4 - digit</td>
<td>Districts (391)</td>
<td></td>
</tr>
</tbody>
</table>

### Administrative Boundaries for Level 2 Countries

The following table lists countries that are accessible only with a second level license.

<table>
<thead>
<tr>
<th>Country</th>
<th>Postal Code</th>
<th>Highest Administrative Level</th>
<th>Lowest Administrative Level</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>(Number of Values)</td>
<td>(Number of Values)</td>
</tr>
<tr>
<td>Afghanistan</td>
<td>4-digit</td>
<td>Velayat (34)</td>
<td>Woluswali (398)</td>
</tr>
<tr>
<td>Algeria</td>
<td>2-digit</td>
<td>Wilayat (48)</td>
<td></td>
</tr>
<tr>
<td>American Samoa</td>
<td>5-digit</td>
<td>Counties (77)</td>
<td></td>
</tr>
<tr>
<td>Angola</td>
<td></td>
<td>Provincias (18)</td>
<td>Municipios (161)</td>
</tr>
<tr>
<td>Anguilla</td>
<td>7-digit</td>
<td>Districts (14)</td>
<td></td>
</tr>
<tr>
<td>Antigua and Barbuda</td>
<td></td>
<td>Parishes (8)</td>
<td></td>
</tr>
<tr>
<td>Armenia</td>
<td>2-digit</td>
<td>Marzer (11)</td>
<td></td>
</tr>
<tr>
<td>Aruba</td>
<td></td>
<td>Districts (8)</td>
<td></td>
</tr>
<tr>
<td>Azerbaijan</td>
<td>2-digit</td>
<td>Regions (10)</td>
<td>Rayonlar (74)</td>
</tr>
<tr>
<td>Country</td>
<td>Postal Code</td>
<td>Highest Administrative Level (Number of Values)</td>
<td>Lowest Administrative Level (Number of Values)</td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>-------------</td>
<td>-------------------------------------------------</td>
<td>-----------------------------------------------</td>
</tr>
<tr>
<td>Bahamas Islands (19)</td>
<td></td>
<td>Islands (19)</td>
<td>Districts (32)</td>
</tr>
<tr>
<td>Bahrain</td>
<td>2-digit</td>
<td>Muhafazat (5)</td>
<td></td>
</tr>
<tr>
<td>Bangladesh</td>
<td>2-digit</td>
<td>Zila (64)</td>
<td>Upazila (553)</td>
</tr>
<tr>
<td>Barbados</td>
<td></td>
<td>Parishes (11)</td>
<td></td>
</tr>
<tr>
<td>Belize</td>
<td></td>
<td>Districts (6)</td>
<td>Constituencies (31)</td>
</tr>
<tr>
<td>Benin</td>
<td></td>
<td>Departements (12)</td>
<td>Communes (77)</td>
</tr>
<tr>
<td>Bermuda</td>
<td>4-digit</td>
<td>Parishes (11)</td>
<td></td>
</tr>
<tr>
<td>Bhutan</td>
<td>2-digit</td>
<td>Dzongkhags (20)</td>
<td></td>
</tr>
<tr>
<td>Bolivia, Plurinational State of</td>
<td></td>
<td>Departamentos (9)</td>
<td>Provincias (112)</td>
</tr>
<tr>
<td>Botswana</td>
<td></td>
<td>Districts (9)</td>
<td>Sub-Districts (28)</td>
</tr>
<tr>
<td>British Virgin Islands</td>
<td></td>
<td>National (1)</td>
<td>Electoral Districts (9)</td>
</tr>
<tr>
<td>Brunei Darussalam</td>
<td>2-digit</td>
<td>Daerah (4)</td>
<td>Mukim (38)</td>
</tr>
<tr>
<td>Burkina Faso</td>
<td></td>
<td>Regions (13)</td>
<td>Provinces (45)</td>
</tr>
<tr>
<td>Burundi</td>
<td></td>
<td>Provinces (17)</td>
<td>Communes (129)</td>
</tr>
<tr>
<td>Cambodia</td>
<td></td>
<td>Khaet (25)</td>
<td></td>
</tr>
<tr>
<td>Cameroon</td>
<td></td>
<td>Regions (10)</td>
<td>Departements (58)</td>
</tr>
<tr>
<td>Cape Verde</td>
<td>2-digit</td>
<td>Concelhos (22)</td>
<td>Freguesias (32)</td>
</tr>
<tr>
<td>Cayman Islands</td>
<td>8-digit</td>
<td>Districts (6)</td>
<td></td>
</tr>
<tr>
<td>Central African Republic</td>
<td></td>
<td>Prefectures (17)</td>
<td>Sous-Prefectures (51)</td>
</tr>
<tr>
<td>Country</td>
<td>Postal Code</td>
<td>Highest Administrative Level (Number of Values)</td>
<td>Lowest Administrative Level (Number of Values)</td>
</tr>
<tr>
<td>---------------------------------</td>
<td>-------------</td>
<td>-------------------------------------------------</td>
<td>-----------------------------------------------</td>
</tr>
<tr>
<td>Chad</td>
<td></td>
<td>National (1)</td>
<td></td>
</tr>
<tr>
<td>Colombia</td>
<td>2-digit</td>
<td>Departamentos (33)</td>
<td>Municipios (1122)</td>
</tr>
<tr>
<td>Comoros</td>
<td></td>
<td>Islands (3)</td>
<td></td>
</tr>
<tr>
<td>Congo</td>
<td></td>
<td>Departements (12)</td>
<td></td>
</tr>
<tr>
<td>Congo, the Democratic Republic of the</td>
<td></td>
<td>Districts (48)</td>
<td>Territoires (188)</td>
</tr>
<tr>
<td>Côte d'Ivoire</td>
<td></td>
<td>Regions (32)</td>
<td>Departements (95)</td>
</tr>
<tr>
<td>Cuba</td>
<td></td>
<td>Provincias (16)</td>
<td>Municipios (168)</td>
</tr>
<tr>
<td>Djibouti</td>
<td></td>
<td>Regions (6)</td>
<td></td>
</tr>
<tr>
<td>Dominica</td>
<td></td>
<td>Parishes (10)</td>
<td></td>
</tr>
<tr>
<td>Dominican Republic</td>
<td>5-digit</td>
<td>Provincias (32)</td>
<td>Municipios (155)</td>
</tr>
<tr>
<td>Ecuador</td>
<td>6 - digit</td>
<td>Cantones (224)</td>
<td>Parroquias (1040)</td>
</tr>
<tr>
<td>Egypt</td>
<td>2-digit</td>
<td>States (27)</td>
<td></td>
</tr>
<tr>
<td>El Salvador</td>
<td>7-digit</td>
<td>Departamentos (14)</td>
<td>Municipios (262)</td>
</tr>
<tr>
<td>Equatorial Guinea</td>
<td></td>
<td>Regions (2)</td>
<td>Provinces (7)</td>
</tr>
<tr>
<td>Eritrea</td>
<td></td>
<td>Zobas (6)</td>
<td>Subzobas (52)</td>
</tr>
<tr>
<td>Ethiopia</td>
<td></td>
<td>Kililoch (11)</td>
<td>Awrajja (85)</td>
</tr>
<tr>
<td>Faroe Islands</td>
<td>3 - digit</td>
<td>Syslur (6)</td>
<td>Kommunur (30)</td>
</tr>
<tr>
<td>Fiji</td>
<td></td>
<td>Provinces (15)</td>
<td></td>
</tr>
<tr>
<td>French Guiana</td>
<td>5-digit</td>
<td>Cantons (14)</td>
<td>Communes (22)</td>
</tr>
<tr>
<td>Country</td>
<td>Postal Code</td>
<td>Highest Administrative Level (Number of Values)</td>
<td>Lowest Administrative Level (Number of Values)</td>
</tr>
<tr>
<td>---------------------</td>
<td>-------------</td>
<td>-----------------------------------------------</td>
<td>-----------------------------------------------</td>
</tr>
<tr>
<td>French Polynesia</td>
<td>5-digit</td>
<td>Iles (5)</td>
<td>Communes (48)</td>
</tr>
<tr>
<td>French Southern</td>
<td></td>
<td>Districts (4)</td>
<td></td>
</tr>
<tr>
<td>Territories</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Gabon</td>
<td></td>
<td>Provinces (9)</td>
<td></td>
</tr>
<tr>
<td>Gambia</td>
<td></td>
<td>Local Government Areas (8)</td>
<td></td>
</tr>
<tr>
<td>Georgia</td>
<td></td>
<td>Regions (12)</td>
<td>Rajone (77)</td>
</tr>
<tr>
<td>Ghana</td>
<td></td>
<td>Regions (10)</td>
<td>Districts (216)</td>
</tr>
<tr>
<td>Greenland</td>
<td>4-digit</td>
<td>Kommuner (6)</td>
<td></td>
</tr>
<tr>
<td>Grenada</td>
<td></td>
<td>Parishes (7)</td>
<td></td>
</tr>
<tr>
<td>Guadeloupe</td>
<td>5-digit</td>
<td>Cantons (28)</td>
<td>Communes (32)</td>
</tr>
<tr>
<td>Guam</td>
<td>5-digit</td>
<td>County Subdivisions (19)</td>
<td></td>
</tr>
<tr>
<td>Guatemala</td>
<td>5-digit</td>
<td>Departamentos (22)</td>
<td>Municipios (334)</td>
</tr>
<tr>
<td>Guernsey</td>
<td>5-digit</td>
<td>Parishes (15)</td>
<td></td>
</tr>
<tr>
<td>Guinea</td>
<td></td>
<td>Regions (8)</td>
<td>Prefectures (34)</td>
</tr>
<tr>
<td>Guinea-Bissau</td>
<td>4-digit</td>
<td>Regioes (9)</td>
<td>Sectores (38)</td>
</tr>
<tr>
<td>Guyana</td>
<td></td>
<td>Regions (10)</td>
<td></td>
</tr>
<tr>
<td>Haiti</td>
<td></td>
<td>Arrondissements (42)</td>
<td>Communes (140)</td>
</tr>
<tr>
<td>Honduras</td>
<td>2-digit</td>
<td>Departamentos (18)</td>
<td>Municipios (298)</td>
</tr>
<tr>
<td>Indonesia</td>
<td>3-digit</td>
<td>States (34)</td>
<td></td>
</tr>
<tr>
<td>Country</td>
<td>Postal Code</td>
<td>Highest Administrative Level (Number of Values)</td>
<td>Lowest Administrative Level (Number of Values)</td>
</tr>
<tr>
<td>---------------------------------------------</td>
<td>-------------</td>
<td>-------------------------------------------------</td>
<td>-----------------------------------------------</td>
</tr>
<tr>
<td>Iran, Islamic Republic of</td>
<td>1-digit</td>
<td>Provinces (31)</td>
<td>Subprovinces (397)</td>
</tr>
<tr>
<td>Iraq</td>
<td></td>
<td>Muhafazat (18)</td>
<td>Kaza (109)</td>
</tr>
<tr>
<td>Ireland</td>
<td></td>
<td>Counties (34)</td>
<td>Electoral Divisions (3441)</td>
</tr>
<tr>
<td>Isle of Man</td>
<td>5-digit</td>
<td>Sheadings (6)</td>
<td>Districts (24)</td>
</tr>
<tr>
<td>Israel</td>
<td>2-digit</td>
<td>States (6)</td>
<td></td>
</tr>
<tr>
<td>Jamaica</td>
<td></td>
<td>Parishes (14)</td>
<td>Constituencies (62)</td>
</tr>
<tr>
<td>Jersey</td>
<td>5-digit</td>
<td>Parishes (12)</td>
<td></td>
</tr>
<tr>
<td>Jordan</td>
<td>5-digit</td>
<td>Muhafazat (12)</td>
<td>Nahia (51)</td>
</tr>
<tr>
<td>Kazakhstan</td>
<td>4-digit</td>
<td>Oblystar (16)</td>
<td>Audandar (209)</td>
</tr>
<tr>
<td>Korea, Democratic People's Republic of</td>
<td></td>
<td>Do (14)</td>
<td></td>
</tr>
<tr>
<td>Kosovo</td>
<td>2-digit</td>
<td>Obstina (38)</td>
<td></td>
</tr>
<tr>
<td>Kuwait</td>
<td>2-digit</td>
<td>Muhafazat (6)</td>
<td>Localities (137)</td>
</tr>
<tr>
<td>Kyrgyzstan</td>
<td>4-digit</td>
<td>Oblasttar (9)</td>
<td>Rajondor (46)</td>
</tr>
<tr>
<td>Lao People's Democratic Republic</td>
<td></td>
<td>Khoueng (17)</td>
<td>Muang (142)</td>
</tr>
<tr>
<td>Lebanon</td>
<td></td>
<td>Muhafazat (6)</td>
<td>Caza (26)</td>
</tr>
<tr>
<td>Lesotho</td>
<td></td>
<td>Districts (10)</td>
<td></td>
</tr>
<tr>
<td>Liberia</td>
<td></td>
<td>Counties (15)</td>
<td></td>
</tr>
<tr>
<td>Libyan Arab Jamahiriya</td>
<td></td>
<td>Schabiyat (22)</td>
<td></td>
</tr>
<tr>
<td>Country</td>
<td>Postal Code</td>
<td>Highest Administrative Level</td>
<td>Lowest Administrative Level</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-------------</td>
<td>-----------------------------</td>
<td>-----------------------------</td>
</tr>
<tr>
<td>Macao</td>
<td>6-digit</td>
<td>Parishes (8)</td>
<td></td>
</tr>
<tr>
<td>Madagascar</td>
<td>3-digit</td>
<td>Regions (22)</td>
<td>Districts (114)</td>
</tr>
<tr>
<td>Malawi</td>
<td></td>
<td>Regions (3)</td>
<td>Districts (30)</td>
</tr>
<tr>
<td>Malaysia</td>
<td>2-digit</td>
<td>Negeri (16)</td>
<td>Daerah (144)</td>
</tr>
<tr>
<td>Maldives</td>
<td>2-digit</td>
<td>Atolls (20)</td>
<td></td>
</tr>
<tr>
<td>Mali</td>
<td></td>
<td>Regions (9)</td>
<td>Cercles (50)</td>
</tr>
<tr>
<td>Marshall Islands</td>
<td>3-digit</td>
<td>Municipalities (34)</td>
<td></td>
</tr>
<tr>
<td>Martinique</td>
<td>5-digit</td>
<td>Arrondissements (4)</td>
<td>Communes (34)</td>
</tr>
<tr>
<td>Mauritania</td>
<td></td>
<td>Wilayas (13)</td>
<td>Moughataas (53)</td>
</tr>
<tr>
<td>Mauritius</td>
<td></td>
<td>Districts (10)</td>
<td></td>
</tr>
<tr>
<td>Mayotte</td>
<td></td>
<td>Communes (17)</td>
<td></td>
</tr>
<tr>
<td>Micronesia, Federated States of</td>
<td>5-digit</td>
<td>States (4)</td>
<td></td>
</tr>
<tr>
<td>Moldova, Republic of</td>
<td>4-digit</td>
<td>Raioane (37)</td>
<td></td>
</tr>
<tr>
<td>Mongolia</td>
<td>4-digit</td>
<td>Aimags (22)</td>
<td>Sums (338)</td>
</tr>
<tr>
<td>Montserrat</td>
<td></td>
<td>Parishes (3)</td>
<td></td>
</tr>
<tr>
<td>Morocco</td>
<td>2-digit</td>
<td>Regions (16)</td>
<td>Provinces (75)</td>
</tr>
<tr>
<td>Mozambique</td>
<td>2-digit</td>
<td>Provincias (11)</td>
<td>Distritos (142)</td>
</tr>
<tr>
<td>Myanmar</td>
<td></td>
<td>States and Divisions (15)</td>
<td></td>
</tr>
<tr>
<td>Country</td>
<td>Postal Code</td>
<td>Highest Administrative Level (Number of Values)</td>
<td>Lowest Administrative Level (Number of Values)</td>
</tr>
<tr>
<td>---------------------------------</td>
<td>-------------</td>
<td>------------------------------------------------</td>
<td>-----------------------------------------------</td>
</tr>
<tr>
<td>Namibia</td>
<td></td>
<td>Regions (13)</td>
<td>Constituencies (119)</td>
</tr>
<tr>
<td>Nauru</td>
<td></td>
<td>Districts (14)</td>
<td></td>
</tr>
<tr>
<td>Nepal</td>
<td></td>
<td>Zones (14)</td>
<td>Districts (75)</td>
</tr>
<tr>
<td>New Caledonia</td>
<td>5-digit</td>
<td>Provinces (3)</td>
<td>Communes (34)</td>
</tr>
<tr>
<td>Nicaragua</td>
<td></td>
<td>Departamentos (17)</td>
<td>Municipios (153)</td>
</tr>
<tr>
<td>Niger</td>
<td></td>
<td>Regions (8)</td>
<td></td>
</tr>
<tr>
<td>Nigeria</td>
<td></td>
<td>States (37)</td>
<td>Local Government Areas (774)</td>
</tr>
<tr>
<td>Northern Mariana Islands</td>
<td>5-digit</td>
<td>Municipalities (4)</td>
<td></td>
</tr>
<tr>
<td>Oman</td>
<td>1-digit</td>
<td>Muhafazat (11)</td>
<td>Wilayat (61)</td>
</tr>
<tr>
<td>Pakistan</td>
<td>2-digit</td>
<td>Provinces (8)</td>
<td>Districts (146)</td>
</tr>
<tr>
<td>Palau</td>
<td>5-digit</td>
<td>States (16)</td>
<td></td>
</tr>
<tr>
<td>Palestinian Territory, Occupied</td>
<td></td>
<td>Territories (2)</td>
<td>Muhafazat (16)</td>
</tr>
<tr>
<td>Panama</td>
<td></td>
<td>Provincias (12)</td>
<td>Distritos (76)</td>
</tr>
<tr>
<td>Papua New Guinea</td>
<td></td>
<td>Provinces (22)</td>
<td>Districts (87)</td>
</tr>
<tr>
<td>Paraguay</td>
<td></td>
<td>Departamentos (18)</td>
<td>Distritos (251)</td>
</tr>
<tr>
<td>Peru</td>
<td>2-digit</td>
<td>Provincias (195)</td>
<td>Distritos (1834)</td>
</tr>
<tr>
<td>Philippines</td>
<td>4-digit</td>
<td>Provinces (87)</td>
<td>Municipalities and Cities (1634)</td>
</tr>
<tr>
<td>Pitcairn</td>
<td>8-digit</td>
<td>Islands (4)</td>
<td></td>
</tr>
<tr>
<td>Country</td>
<td>Postal Code</td>
<td>Highest Administrative Level (Number of Values)</td>
<td>Lowest Administrative Level (Number of Values)</td>
</tr>
<tr>
<td>---------------------------------</td>
<td>-------------</td>
<td>-------------------------------------------------</td>
<td>-----------------------------------------------</td>
</tr>
<tr>
<td>Puerto Rico</td>
<td>5-digit</td>
<td>Municipios (78)</td>
<td>County Subdivisions (902)</td>
</tr>
<tr>
<td>Qatar</td>
<td></td>
<td>Municipalities (7)</td>
<td>Zones (90)</td>
</tr>
<tr>
<td>Republic of South Sudan</td>
<td></td>
<td>States (10)</td>
<td></td>
</tr>
<tr>
<td>Réunion</td>
<td>5-digit</td>
<td>Arrondissements (4)</td>
<td>Communes (24)</td>
</tr>
<tr>
<td>Romania</td>
<td>6-digit</td>
<td>Judete (42)</td>
<td>Comune (3181)</td>
</tr>
<tr>
<td>Russian Federation</td>
<td>4-digit</td>
<td>Federal Subjects (80)</td>
<td>Raioni (2345)</td>
</tr>
<tr>
<td>Rwanda</td>
<td></td>
<td>Provinces (5)</td>
<td>Districts (30)</td>
</tr>
<tr>
<td>Saint Kitts and Nevis</td>
<td></td>
<td>States (2)</td>
<td>Parishes (14)</td>
</tr>
<tr>
<td>Saint Lucia</td>
<td></td>
<td>Quarters (10)</td>
<td></td>
</tr>
<tr>
<td>Saint Vincent and the Grenadines</td>
<td>4-digit</td>
<td>Parishes (6)</td>
<td></td>
</tr>
<tr>
<td>Samoa</td>
<td>3-digit</td>
<td>Regions (4)</td>
<td>Districts (43)</td>
</tr>
<tr>
<td>Sao Tome and Principe</td>
<td></td>
<td>Province (2)</td>
<td>Distritos (7)</td>
</tr>
<tr>
<td>Saudi Arabia</td>
<td>2-digit</td>
<td>States (13)</td>
<td></td>
</tr>
<tr>
<td>Senegal</td>
<td></td>
<td>Regions (14)</td>
<td></td>
</tr>
<tr>
<td>Seychelles</td>
<td></td>
<td>Districts (25)</td>
<td></td>
</tr>
<tr>
<td>Sierra Leone</td>
<td></td>
<td>Provinces (4)</td>
<td>Districts (14)</td>
</tr>
<tr>
<td>Solomon Islands</td>
<td></td>
<td>Provinces (10)</td>
<td></td>
</tr>
<tr>
<td>Country</td>
<td>Postal Code</td>
<td>Highest Administrative Level (Number of Values)</td>
<td>Lowest Administrative Level (Number of Values)</td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>-------------</td>
<td>-------------------------------------------------</td>
<td>-----------------------------------------------</td>
</tr>
<tr>
<td>South Sudan</td>
<td>2-digit</td>
<td>States (10)</td>
<td></td>
</tr>
<tr>
<td>Sri Lanka</td>
<td>2-digit</td>
<td>Districts (25)</td>
<td>DS-Divisions (331)</td>
</tr>
<tr>
<td>Sudan</td>
<td>2-digit</td>
<td>States (15)</td>
<td></td>
</tr>
<tr>
<td>Suriname</td>
<td></td>
<td>Districten (10)</td>
<td>Ressorten (62)</td>
</tr>
<tr>
<td>Svalbard and Jan Mayen (IE)</td>
<td></td>
<td>Counties (34)</td>
<td>Electoral Divisions (3441)</td>
</tr>
<tr>
<td>Svalbard and Jan Mayen (SJ)</td>
<td>4-digit</td>
<td>National (1)</td>
<td>Kommuner (4)</td>
</tr>
<tr>
<td>Swaziland</td>
<td>1-digit</td>
<td>Districts (4)</td>
<td></td>
</tr>
<tr>
<td>Syrian Arab Republic</td>
<td></td>
<td>Muhafazat (14)</td>
<td>Manatiq (61)</td>
</tr>
<tr>
<td>Tajikistan</td>
<td></td>
<td>Regions (5)</td>
<td>Raioni (64)</td>
</tr>
<tr>
<td>Tanzania, United Republic of</td>
<td></td>
<td>Mkoa (30)</td>
<td>Wilayah (169)</td>
</tr>
<tr>
<td>Thailand</td>
<td>2-digit</td>
<td>Changwate (77)</td>
<td>Amphoe (928)</td>
</tr>
<tr>
<td>Timor-Leste</td>
<td></td>
<td>Districts (13)</td>
<td>Subdistricts (65)</td>
</tr>
<tr>
<td>Togo</td>
<td></td>
<td>Regions (5)</td>
<td></td>
</tr>
<tr>
<td>Tokelau</td>
<td></td>
<td>Atolls (3)</td>
<td></td>
</tr>
<tr>
<td>Tonga</td>
<td></td>
<td>Island Divisions (5)</td>
<td></td>
</tr>
<tr>
<td>Trinidad and Tobago</td>
<td></td>
<td>Municipalities (15)</td>
<td></td>
</tr>
<tr>
<td>Tunisia</td>
<td>4-digit</td>
<td>Wilayat (24)</td>
<td></td>
</tr>
<tr>
<td>Turkmenistan</td>
<td>3-digit</td>
<td>Welayaty (6)</td>
<td>Etraplar (65)</td>
</tr>
<tr>
<td>Country</td>
<td>Postal Code</td>
<td>Highest Administrative Level (Number of Values)</td>
<td>Lowest Administrative Level (Number of Values)</td>
</tr>
<tr>
<td>---------------------------------</td>
<td>-------------</td>
<td>-------------------------------------------------</td>
<td>-----------------------------------------------</td>
</tr>
<tr>
<td>Turks and Caicos Islands</td>
<td>8-digit</td>
<td>Districts (6)</td>
<td>Localities (38)</td>
</tr>
<tr>
<td>Tuvalu</td>
<td></td>
<td>Islands (9)</td>
<td></td>
</tr>
<tr>
<td>Uganda</td>
<td></td>
<td>Consolidated Districts (75)</td>
<td>Counties (110)</td>
</tr>
<tr>
<td>Ukraine</td>
<td>3-digit</td>
<td>Obstina (38)</td>
<td></td>
</tr>
<tr>
<td>United Arab Emirates</td>
<td></td>
<td>States (7)</td>
<td></td>
</tr>
<tr>
<td>United States Minor Outlying Islands</td>
<td></td>
<td>Islands (5)</td>
<td></td>
</tr>
<tr>
<td>United States Virgin Islands</td>
<td>5-digit</td>
<td>National (1)</td>
<td>Islands (3)</td>
</tr>
<tr>
<td>Uruguay</td>
<td>5-digit</td>
<td>Secciones (232)</td>
<td>Segmentos (4301)</td>
</tr>
<tr>
<td>Uzbekistan</td>
<td>4-digit</td>
<td>Viloyati (14)</td>
<td>Tuman (171)</td>
</tr>
<tr>
<td>Vanuatu</td>
<td></td>
<td>Provinces (6)</td>
<td></td>
</tr>
<tr>
<td>Venezuela, Bolivarian Republic of</td>
<td>2-digit</td>
<td>Estados (25)</td>
<td>Municipios (367)</td>
</tr>
<tr>
<td>Viet Nam</td>
<td>2-digit</td>
<td>Provinces (63)</td>
<td>Districts (698)</td>
</tr>
<tr>
<td>Wallis and Futuna</td>
<td>5-digit</td>
<td>Kingdoms (3)</td>
<td></td>
</tr>
<tr>
<td>Yemen</td>
<td></td>
<td>Muhafazat (21)</td>
<td>Muderiah (333)</td>
</tr>
<tr>
<td>Zambia</td>
<td>5-digit</td>
<td>Provinces (10)</td>
<td>Districts (103)</td>
</tr>
<tr>
<td>Zimbabwe</td>
<td></td>
<td>Provinces (10)</td>
<td>Districts (91)</td>
</tr>
</tbody>
</table>
**Example:** Using a Second Level License to Map French Postal Codes

The request used in this example references data about French state names, city names, and postal codes. This data is readily available online. The data in this example was downloaded from [https://www.aggdata.com/free/france-postal-codes](https://www.aggdata.com/free/france-postal-codes) which is available for free using a Creative Commons Attribution 4.0 license detailed at [https://creativecommons.org/licenses/by/4.0/](https://creativecommons.org/licenses/by/4.0/). Once you download the data, you can upload it to the server to create the data file and synonym for use in requests. This example assumes that the data and synonym are in the ibisamp application on the server.

**Note:** Information Builders takes no responsibility for the accuracy or continued existence of this data on this site. It is being used only as an example of the detailed administrative boundaries available with a second level license.

The Master File for the uploaded data follows. The Master File generated by the upload procedure was edited to change the first field name to COUNTRY and to remove the folder declarations.

```
FILENAME=FR_POSTAL_CODES, SUFFIX=DFIX
DATASET=ibisamp/fr_postal_codes.ftm (LRECL 1140 RECFM V, BV_NAMESPACE=OFF,
$ SEGMENT=FR_POSTAL_CODES, SEGTYPE=S0, $
  FIELDNAME=COUNTRY, ALIAS=E01, USAGE=A50V, ACTUAL=A50V,
    TITLE='Country for State',
    GEOGRAPHIC_ROLE=COUNTRY, $
  FIELDNAME=STATE, ALIAS=E02, USAGE=A21V, ACTUAL=A21V,
    MISSING=ON,
    TITLE='State',
    GEOGRAPHIC_ROLE=STATE, $
  FIELDNAME=COUNTY, ALIAS=E03, USAGE=A25V, ACTUAL=A25V,
    MISSING=ON,
    TITLE='County',
    GEOGRAPHIC_ROLE=COUNTY, $
  FIELDNAME=CITY, ALIAS=E04, USAGE=A48V, ACTUAL=A48V,
    MISSING=ON,
    TITLE='City',
    GEOGRAPHIC_ROLE=CITY, $
  FIELDNAME=POSTAL_CODE, ALIAS=E05, USAGE=A16V, ACTUAL=A16V,
    MISSING=ON,
    TITLE='Postal Code',
    GEOGRAPHIC_ROLE=POSTAL-CODE, $
  FIELDNAME=PLACE_NAME, ALIAS=E06, USAGE=A56V, ACTUAL=A56V,
    MISSING=ON,
    TITLE='Place Name', $
  FIELDNAME=GEO_POINT, ALIAS=E07, USAGE=A150, ACTUAL=A150,
    TITLE='GIS Point',
    GEOGRAPHIC_ROLE=GEOMETRY_POINT, $
$)
```

The Access File for the uploaded data follows.

```
SEGNAME=FR_POSTAL_CODES,
DELIMITER='|',
CDN=COMMAS_DOT,
CONNECTION=<local>, $
```

The following request named frenchzip2.fex creates the xml file with the postal code data that is passed to the HTML page with the Esri component.

```
TABLE FILE ibisamp/fr_postal_codes
PRINT COUNTRY STATE CITY POSTAL_CODE
ON TABLE PCHOLD FORMAT XML
END
```
Configure the Server with a second level license. Create an HTML page, add an Esri component, and select the `frenchzip2` request in the Requests & Data Sources panel. Then configure the Settings panel to use the request and the Postal code geographic role, as shown in the following image.
Run the HTML page. The output is shown in the following image, with one of the postal codes clicked to display the popup.
You can zoom in to see the boundaries of individual postal codes and change to a basemap that shows more detail, such as the World Street Map, as shown in the following image (the layer transparency has also been changed to 30% using the Table of Contents widget, in order to see the background detail more clearly).

**Configuring a Map Data Layer**

For each data layer that you place on your map component, you create an external WebFOCUS request that generates location or point values and any other values you want to use on your layer. The request must provide these values to the browser in XML format. You add this request to the map component in the Requests & Data Sources panel.
The first layer is automatically defined. To add another data layer, you must click New above the Layers text box and click Data Layer, as shown in the following image.

In the top section of the ESRI Object Settings panel, you configure the geographic role, the external request to be used for the geographic values of interest, and attributes for the layer.

Descriptions of the layer settings in the ESRI Object Settings panel follow.

**Layers**

- **Description.** Is a unique name for the layer.
- **Type of field.** Textfield VARCHAR(20).
- **Required?** Yes.
- **Populated by.** User.
- **Limits.** Maximum length = 20 characters. Special characters (' " \ / * + ? $ ] ( ) { } < > | & ,) are not allowed.
- **Example.** Customer

**Request**

- **Description.** Name of the request that provides locations or points.
- **Type of Field.** Drop-down list.
- **Required?** Yes.
- **Populated by.** System defined.
- **Limits.** Defined earlier in the Requests & Data Sources panel to an external WebFOCUS Procedure that outputs the values to the browser in XML format.
- **Example.** customer_locations
Geographic Role

Description. Geography lookup column. By default, a unified list of geographic roles is available for 58 World Administrative boundaries down to the postal code level.

Type of Field. Drop-down list.

Required? Yes.

Populated by. System Defined.

Limits. Choices are:

- Point of Interest (Latitude/Longitude)

  Note: Latitude and Longitude fields must be assigned a numeric data type.

- City
- Continent
- Country
- County
- Geometry Line
- Postal Code
- State

You can also add customized geographic roles, basemaps, and context layers. Geographic roles can be defined for existing Esri maps or for shapefiles that you upload to the Reporting Server. For information, see Configuring Geographic Information on page 1091. Private custom geographies will only be available after authenticating against ArcGIS Online or Esri on Premise credentials.

Example. Latitude/Longitude

Column(s) that match the role

Description. Column or columns in the request that will provide values for the geographic role.

Type of Field. Drop-down list box.

Required? Yes.

Populated by. System Defined.

Limits. Must be fields that are available in the request.
**Example.** LATITUDE/LONGITUDE

**Unique ID**

**Description.** This is the field that will be used as a parameter for other requests.

**Type of Field.** List box.

**Required?** Yes, for Point of Interest layers, no otherwise.

**Populated by.** System defined.

**Limits.** Must be a field available in the request.

**Example.** ID_CUSTOMER

**Layer Attributes**

**Description.** These are fields in the request that will appear in popups when a point or location is clicked and the Enable Popups visualization is turned on. You can multi-select fields using the Shift key and Ctrl key. Click the green button at the bottom to apply your selections, or the red button to cancel your selections. The selection dialogue box is shown in the following image.

![Layer Attributes Selection Dialogue Box](image)

**Note:** In order to display customized names rather than field names in the popup, the custom names must be defined with the TITLE attribute in the Master File. The TITLE attribute cannot contain any commas. Using an AS name in the request to create a custom name is not supported in the infoWindow.

**Type of Field.** List box.

**Required?** No.

**Populated by.** System defined.

**Limits.** Must be fields available in the request.

**Example.** COGS_US
Example: Configuring a Point of Interest Map Layer

This example configures a map layer using longitude and latitude point values that come from an external WebFOCUS request named customer_locations.fex.

You can create a request using the Report Canvas or by entering request syntax in the Text Editor. For information about creating a WebFOCUS report request using the Report Canvas, see Creating Reports on page 227.

Following is the syntax for the customer_locations procedure. Note that the fields that return the longitude and latitude values must be named LONGITUDE and LATITUDE, and that a request that returns these values for the geographic points must also have a unique ID field, in this case ID_CUSTOMER. The values must be returned to the browser in XML format. Paste this procedure into the Text Editor and save it as customer_locations.fex:

```sql
TABLE FILE WF_RETAIL_LITE
PRINT ID_CUSTOMER
    COGS_US
    QUANTITY_SOLD
    COMPUTE LONGITUDE/D12.2 = CUSTOMER_LONGITUDE;
    COMPUTE LATITUDE/D12.2 = CUSTOMER_LATITUDE;
BY   STATE_PROV_NAME
BY   ID_CUSTOMER NOPRINT
WHERE COUNTRY_NAME EQ 'United States';
ON TABLE PCHOLD FORMAT XML
END

First, add the external WebFOCUS procedure customer_locations.fex to the HTML page using the Requests & Data Sources panel, as shown in the following image:
Next, use the Settings panel to configure the map layer. The layer uses the default visualizations and symbology, so only the top portion of the ESRI Object Settings panel needs to be configured.

Each layer has a default name. To change the layer name, select and type over the default name. The geographic role to use when you provide latitude and longitude values in your request is called Point of Interest. The following image shows the configured Customers layer with the layer name changed and the geographic role configured:

![Image of configured Customers layer]

**Note:** For any Spatial Coordinate System under Layer Settings other than 4326 for a point of interest layer, please use an internally hosted Geometry Service. This will require projection on the fly. For more details about Geometry Service please see [http://server.arcgis.com/en/server/latest/publish-services/linux/about-the-geometry-service.htm](http://server.arcgis.com/en/server/latest/publish-services/linux/about-the-geometry-service.htm).
Run the HTML page. The output is shown in the following image:

---

**Example:** Configuring a US State Map Layer

This example configures a map layer using U.S. state names.

You can create a request using the Report Canvas or by entering request syntax in the Text Editor. For information about creating a WebFOCUS report request using the Report Canvas, see Creating Reports on page 227.

Following is the syntax for a WebFOCUS procedure that returns the state name for U.S. states. Paste this procedure into the text editor and save it as customer_states.fex.

```sql
TABLE FILE WF_RETAIL_LITE
SUM QUANTITY_SOLD
BY STATE_PROV_NAME
WHERE COUNTRY_NAME EQ 'United States'
ON TABLE PCHOLD FORMAT XML
END
```
First, add the external WebFOCUS procedure customer_states.fex to the HTML page using the Requests & Data Sources panel.

Next, use the Settings panel to configure the map layer. The layer uses the default visualizations and symbology, so only the top portion of the ESRI Object Settings panel needs to be configured.

Each layer has a default name. To change the layer name, select and type over the default name. The geographic role to use when you provide state names in your request is called State. The field in the request that matches the geographic role is STATE_PROV_NAME. Since the request screens only states where COUNTRY_NAME is 'United States', you can select that as the user-defined value for Country in the Settings panel. The following image shows the configured CustState layer:
Run the HTML page. The output is shown in the following image:

**Example:** Configuring a Geometry Line Layer

In addition to drawing polygons and points on an Esri map, you can draw geography lines. Lines are used to represent the shape and location of geographic objects such as transmission lines, streets, pipelines, and routes. A line is built by joining two or more points. The geographic role used for lines is called Geometry line in the Esri map Settings panel.

The request used to create the geometry lines uses a .csv file named 201709_citibike_tripdata that contains information about bike trips between bike stations. The following image shows partial data from this file.
The Master File contains the following DEFINEs that generate the geometry points and geometry lines using the GIS_POINT and GIS_LINE functions.

```plaintext
DEFINE WKID/A10='4326';
    TITLE='WKID', $
DEFINE START_STATION_POINT/A200=GIS_POINT(WKID, START_STATION_LONGITUDE, START_STATION_LATITUDE); GEOGRAPHIC_ROLE=GEOMETRY_POINT, $
DEFINE END_STATION_POINT/A200=GIS_POINT(WKID, END_STATION_LONGITUDE, END_STATION_LATITUDE); GEOGRAPHIC_ROLE=GEOMETRY_POINT, $
DEFINE CONNECTION_LINE_A/A200=GIS_LINE(START_STATION_POINT, END_STATION_POINT); GEOGRAPHIC_ROLE=GEOMETRY_LINE, $
```

The following request is used with the map.

```plaintext
TABLE FILE 201709_citibike_tripdata
SUM TRIPDURATION
FST.GENDER
FST.BIKE_PATH_ID AS 'BIKE_PATH_ID'
FST.START_STATION_NAME AS 'start station name'
FST.END_STATION_NAME AS 'end station name'
BY CONNECTION_LINE_A
WHERE END_STATION_LATITUDE NE 0;
WHERE END_STATION_LONGITUDE NE 0;
WHERE START_STATION_NAME EQ 'Newport Pkwy'
ON TABLE PCHOLD FORMAT XML
END
```
The following image shows the Esri Settings panel that uses this request with the Geometry line georole, using the default layer visualizations and symbol settings.
Adding a Demographic Layer to a Map

Esri demographic data enables you to add info-layers to a map that provide global demographic, spending, lifestyle, and business data on your map application.

The output is shown in the following image.
Procedure: How to Configure a Demographic Layer on an Esri Map

Once you have added an Esri map component to your HTML page, you can add one or more preconfigured demographic layers.

1. In the Settings panel for the Esri map component, click the arrow next to the New Layer icon and select **Demographic Layer**, as shown in the following image.

![Image of Settings panel with Demographic Layer selected](image)

The layer is created with a default name. You can rename the layer by clicking in the default name and typing a new name.

2. Select a type of demographic layer from the Layer group pull-down list, as shown in the following image.

![Image of Settings panel with Layer group pull-down list](image)
3. Select a layer name from the Layer name pull-down list, as shown in the following image.

Note: If the layer is not freely available from Esri, you will be asked to provide your Esri credentials before the layer can be added to the map.

4. Configure the layer visualizations you require, such as the transparency of the layer and the default visibility.

5. Save the HTML page.
When you run the HTML page, the demographic layer is added to the map output, as shown in the following image.

**Note:** You may need to adjust the transparency values for each layer to make them all visible.
6. To open the demographic layer table of contents open the *Change Base Maps* widget and select the *Info Maps* tab, as shown in the following image.
The following options are available on the Info Map table of contents.

<table>
<thead>
<tr>
<th>Description</th>
<th>Icon</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Toggle Layer Legend</td>
<td>![Icon]</td>
<td><img src="image1.png" alt="Example" /></td>
</tr>
<tr>
<td>This icon toggles the legend on and off.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Show Description</td>
<td>![Icon]</td>
<td><img src="image2.png" alt="Example" /></td>
</tr>
<tr>
<td>This icon toggles a layer description on and off.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Visibility</td>
<td>![Icon]</td>
<td><img src="image3.png" alt="Example" /></td>
</tr>
<tr>
<td>This icon toggles the layer visibility on and off.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Adding an RSS Feed to an Esri Map**

You can add an RSS (Rich Site Summary) Feed to an Esri map to show real-time data that is regularly updated, such as weather or news headlines.
Procedure: How to Add an RSS Feed to an Esri Map

The RSS feed is added as an RSS layer on the map.

1. Add a new layer to the Esri map using the Settings panel, and select *RSS Layer*, as shown in the following image.

   ![RSS Layer Image]

   An RSS layer is added, as shown in the following image.

   ![Configured RSS Layer Image]

   The layer name cannot be changed by the user, the default name must be used.

2. Configure the following properties.

   - **RSS URL.** Enter the URL to the RSS feed that you want to display on the map.

   - **Transparency.** Enter a transparency percentage (where 0 is totally transparent, and 100 is totally opaque), or accept the default transparency, 50%.
Default Visibility. The default is On. To make the layer not visible, select Off.

Refresh Interval. Enter a number of seconds for the interval to refresh the RSS layer.
The default value is 5.

3. Run the map.

RSS feed symbols display on locations that have data for the RSS feed. Clicking an RSS feed symbol displays the feed data for that location.

Example: Adding an RSS Layer to an Esri Map

The following map has a data layer with the geographic role Country that uses the following WebFOCUS request, customer_countries1b.fex.

```
TABLE FILE WF_RETAIL_LITE
SUM
  COGS_US
  QUANTITY_SOLD
BY COUNTRY_NAME
ON TABLE NOTOTAL
ON TABLE PC O LD FORMAT XML
END
```
The Settings panel for the data layer is shown in the following image.
An RSS layer is added pointing to the following URL, which is a disaster RSS feed, and the remaining properties are set to the defaults.

https://disasterscharter.org/charter-portlets/cpi-mvc/activations/feed/rss/

The RSS Layer properties are shown in the following image.
The output is shown in the following image, with one of the RSS symbols clicked to show the disaster information for that location.

![Map Image]

### Using Map Widgets

When you generate a map, a set of map widgets is generated that let you interact with the map output. The following table describes each widget.

<table>
<thead>
<tr>
<th>Widget Name</th>
<th>Image</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default Extent</td>
<td>![Default Extent Icon]</td>
<td>Toggles between the default extent (entire layer) and the extent that includes the majority of points for the layer.</td>
</tr>
<tr>
<td>Table of Contents</td>
<td>![Table of Contents Icon]</td>
<td>Opens a list of layers, their properties, and an icon for opening a set of layer tools. The tools differ depending on the type of layer. In the layer list, this widget toggles between showing the list and hiding the list.</td>
</tr>
<tr>
<td>Selection Tools</td>
<td>![Selection Tools Icon]</td>
<td>Provides selection tools and options based on the layer type.</td>
</tr>
<tr>
<td>Widget Name</td>
<td>Image</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>-------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Change Base Map</td>
<td><img src="image.png" alt="Image" /></td>
<td>Opens thumbnails of the available map base layers and lets you select a new one, as shown in the following image.</td>
</tr>
<tr>
<td>Find my location (Geolocation widget)</td>
<td><img src="image.png" alt="Image" /></td>
<td>Zooms the map to your current location.</td>
</tr>
<tr>
<td>Note: The Geolocation widget is removed by the Esri API if this feature is not supported by the browser or is not used in a secure (https) environment. For example, Chrome 50 or higher no longer supports obtaining the location using the HTML5 Geolocation API from pages delivered by non-secure connections. The widget also does not work in the run-time Esri Viewer with Safari browsers on mobile devices.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Zoom in</td>
<td><img src="image.png" alt="Image" /></td>
<td>Increases the zoom level.</td>
</tr>
<tr>
<td>Zoom out</td>
<td><img src="image.png" alt="Image" /></td>
<td>Decreases the zoom level.</td>
</tr>
</tbody>
</table>
## Reference: Layer Tools and Options

The following shows the options for a polygon layer in the table of contents:

![States](image)

The following shows the options for a point layer in the table of contents:

![Locations](image)

The visible icons when you first open this widget are:

- A polygon or point, which identifies this layer as a layer with polygon or point geometry.
- A check box for showing or hiding the layer on the map.
- The layer name.
- The Show Tools icon. Clicking this icon toggles the tools widgets on and off.

The following image shows the table of contents widget with the tools widgets toggled on:

![States](image)

### Option Name | Image | Description
--- | --- | ---
Show tools | ![Show tools](image) | Toggles the layer tools widgets on and off.
<table>
<thead>
<tr>
<th>Option Name</th>
<th>Image</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Toggle layer legend</td>
<td><img src="image" alt="Layer Legend" /></td>
<td>Toggles the layer legend on and off. The layer legend shows the fields, markers, colors, and sizes represented on the map layer. For example:</td>
</tr>
<tr>
<td></td>
<td></td>
<td><img src="image" alt="Legend Example" /></td>
</tr>
<tr>
<td>Toggle options</td>
<td><img src="image" alt="Options" /></td>
<td>Shows or hides the layer visualization options.</td>
</tr>
<tr>
<td>Zoom to layer extent</td>
<td><img src="image" alt="Zoom" /></td>
<td>Zooms to the extent configured for the layer.</td>
</tr>
</tbody>
</table>

The following layer options are available.

<table>
<thead>
<tr>
<th>Option Name</th>
<th>Image</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Opacity slider</td>
<td><img src="image" alt="Opacity Slider" /></td>
<td>Enables you to adjust the layer transparency.</td>
</tr>
<tr>
<td>Option Name</td>
<td>Image</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------</td>
<td>-------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Cluster (points only)</td>
<td><img src="image" alt="Cluster" /></td>
<td>Click the button to invoke clustering (markers are combined into cluster markers, depending on the range of points they represent and the zoom). A green button on the right shows that this option is selected, and an icon displays on the layer table of contents.</td>
</tr>
<tr>
<td>Heat layer (points only)</td>
<td><img src="image" alt="Heat Layer" /></td>
<td>Click the button to draw a heat map depicting the concentration of points. The areas of highest concentration will be red, the next highest will be yellow. A green button on the right shows that this option is selected.</td>
</tr>
</tbody>
</table>
The following image shows cluster markers. The points are categorized into ranges and the cluster markers are colored according to the range of points they represent.
The following image shows a heat layer.

Reference: Selection Tools and Options

The selection widget has a drop-down list for selecting the layer on which to make a selection.

The following image shows the selection tools for a polygon layer.
The following image shows the selection tools for a point layer.

The following selection tools and options are available.

<table>
<thead>
<tr>
<th>Option Name</th>
<th>Image</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Zoom to layer extent</td>
<td><img src="image1.png" alt="Image" /></td>
<td>Zooms to the extent configured for the layer.</td>
</tr>
<tr>
<td>Select features within an extent</td>
<td><img src="image2.png" alt="Image" /></td>
<td>Selects map points or locations included in a rectangle. To draw a rectangle, drag from the starting position to the ending position on the map and release the mouse pointer.</td>
</tr>
<tr>
<td>Select features within a polygon</td>
<td><img src="image3.png" alt="Image" /></td>
<td>Selects map points or locations included in a polygon. To draw a polygon, click each position on the map where you want a vertex. Double-click to complete the polygon at the last vertex you want to add.</td>
</tr>
<tr>
<td>Option Name</td>
<td>Image</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------------------------------------------------------</td>
<td>-------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Select features within a distance (point geography only)                   | ![Image](attachment://image.png) | When this option is selected, a distance text box opens. You can select miles or kilometers from a drop-down list, and enter a distance. For information, see *Changing Default Distance Settings From Miles to Kilometers* on page 924.  
When you double-click a point, the map zooms to show the points at that distance around the selected point.  
**Note:** There is no validation of the characters you enter in the text box. Make sure you enter valid numbers. |
| Select features intersecting a line (polygon geography only)               | ![Image](attachment://image.png) | Selects polygons that intersect a line. To draw a line, click at the starting position, and double-click at the ending position.               |
| Select features to delete                                                  | ![Image](attachment://image.png) | Deletes previously selected points or locations within a rectangle that you draw over selected points or locations.                        |
| Pan                                                                        | ![Image](attachment://image.png) | Switches from making selections to panning when you click and drag on the map layer.                                                     |
| Clear selection                                                            | ![Image](attachment://image.png) | Clears all selections.                                                                                                                                 |
| **Note:** If making selections triggers a report to run, you can specify whether the report should be rerun when the selections are cleared. For details, see *Configuring Whether Selections on a Map Are Required to Run a Request* on page 867. |
### Option Name | Image | Description
--- | --- | ---
Zoom to Selection | ![27](image) | Identifies the number of points or locations selected. If you click this button, the map zooms in to the selection.

**Reference:** Changing Default Distance Settings From Miles to Kilometers

In the Esri Viewer Selection widget, you can select features within a distance of a point you select on the map, as shown in the following image.

Although you can select either the miles or kilometers distance unit from the drop-down list in the widget, the default unit in which the distance is shown is determined by your browser locale settings. For example, if your browser language is United States English, the distance will be shown as miles, but if your language is Australian English or United Kingdom English, the distance will be shown as kilometers.

For information about configuring locale settings in your browser, see the help content for your browser.

**Configuring the Map Menu**

You can change background and hover colors of icons in the map menu by editing the .css classes that represent the menu components. To edit the .css class definitions, you can use the Embedded CSS tab on the HTML page that contains the map component or reference an external .css file.
To embed .css classes in the HTML page, click the Embedded CSS tab at the bottom of the HTML page. The default embedded CSS tab is shown in the following image.

```css
.internal_default {
}
```

Add your customized classes outside of the .internal_default class (for example, starting on line 3).

To create a new .css file, right-click an application in a domain, point to New, point to Text Editor, and select Cascading Style Sheet from the context menu, as shown in the following image.
The new .css file opens, as shown in the following image.

```
body
{
}
```

Add your customized classes outside of the body tag (for example, starting on line 4).

After you save the .css file, you can reference it in the HTML page:

1. Click on the HTML page outside of any of its components.
2. Open the Settings panel and click the .css icon, as shown in the following image.

The Open File dialog box opens.

3. Navigate to the application that contains the .css file, select the .css file, and click OK.

The .css file is added to the CSS Files list in the Settings panel.
**Reference: Map Menu Classes**

This section describes the classes that color the map widgets. You can type them into the Embedded CSS tab of the HTML page that contains the map, or you can access an external .css file.

If you add them to an external .css file, place them outside of the body tag.

The following table lists the map menu classes with an image of the map menu component affected by that class. The affected areas are outlined in or colored red.

<table>
<thead>
<tr>
<th>Class Name</th>
<th>Class Description</th>
<th>Class Image (Outlined in or Colored Red)</th>
</tr>
</thead>
<tbody>
<tr>
<td>.mainMenuColor</td>
<td>Main menu container colors</td>
<td><img src="image1.png" alt="Outline" /></td>
</tr>
<tr>
<td>.HomeButton</td>
<td>Home button hover color</td>
<td><img src="image2.png" alt="Outline" /></td>
</tr>
<tr>
<td>.layersWidget</td>
<td>Layers (Table of Contents) button hover color</td>
<td><img src="image3.png" alt="Outline" /></td>
</tr>
<tr>
<td>.selectionWidget</td>
<td>Selection button hover color</td>
<td><img src="image4.png" alt="Outline" /></td>
</tr>
<tr>
<td>.basemapBtn</td>
<td>Basemap button hover color</td>
<td><img src="image5.png" alt="Outline" /></td>
</tr>
<tr>
<td>.LocateButton</td>
<td>Locate button hover color</td>
<td><img src="image6.png" alt="Outline" /></td>
</tr>
<tr>
<td>.zoomLocateButton</td>
<td></td>
<td><img src="image7.png" alt="Outline" /></td>
</tr>
<tr>
<td><strong>Class Name</strong></td>
<td><strong>Class Description</strong></td>
<td><strong>Class Image (Outlined in or Colored Red)</strong></td>
</tr>
<tr>
<td>-----------------------------</td>
<td>---------------------------------------------------------------------------------------</td>
<td>---------------------------------------------</td>
</tr>
<tr>
<td><code>.lyrCheckBoxColors</code></td>
<td>Check boxes to turn layers on and off in Table of Contents</td>
<td><img src="image1.png" alt="Image" /></td>
</tr>
<tr>
<td><code>.lyrContainerColors</code></td>
<td>Color of each layer container in the Table of Contents widget</td>
<td><img src="image2.png" alt="Image" /></td>
</tr>
<tr>
<td><code>.optionsListColors</code></td>
<td>Layer options box container background color</td>
<td><img src="image3.png" alt="Image" /></td>
</tr>
<tr>
<td><code>.stContentColor</code></td>
<td>Selection tools content background color</td>
<td><img src="image4.png" alt="Image" /></td>
</tr>
<tr>
<td><code>.selectionInfoColors</code></td>
<td>Number of selected features box</td>
<td><img src="image5.png" alt="Image" /></td>
</tr>
<tr>
<td><code>.tabsHeaderColors</code></td>
<td>Background color of Basemaps and Info Maps tabs</td>
<td><img src="image6.png" alt="Image" /></td>
</tr>
<tr>
<td>Class Name</td>
<td>Class Description</td>
<td>Class Image (Outlined in or Colored Red)</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-----------------------------------------------------------------------------------</td>
<td>------------------------------------------</td>
</tr>
<tr>
<td><code>.imTabsTitlesColors</code></td>
<td>Button color of Basemaps and Info Maps tabs</td>
<td><img src="image1.png" alt="Image" /></td>
</tr>
<tr>
<td><code>.imContentColor</code></td>
<td>Background color of the Basemaps and Info Maps content area.</td>
<td><img src="image2.png" alt="Image" /></td>
</tr>
<tr>
<td><code>.imActive</code></td>
<td>Color of the active button, either the Basemaps and Info Maps tab</td>
<td><img src="image3.png" alt="Image" /></td>
</tr>
<tr>
<td>Class Name</td>
<td>Class Description</td>
<td>Class Image (Outlined in or Colored Red)</td>
</tr>
<tr>
<td>------------------------------------</td>
<td>------------------------------------------------------------------------------------</td>
<td>------------------------------------------</td>
</tr>
<tr>
<td>.dojoxFloatingPaneTitle</td>
<td>Background and border colors of the title pane of all widgets</td>
<td><img src="image1.png" alt="Image" /></td>
</tr>
<tr>
<td>.esriPopup .titlePane</td>
<td>Background color of the title pane in the Esri pop-up window</td>
<td><img src="image2.png" alt="Image" /></td>
</tr>
<tr>
<td>.tocContentColor</td>
<td>Background color of the content area in the Table of Contents widget</td>
<td><img src="image3.png" alt="Image" /></td>
</tr>
<tr>
<td>.WidgetOn</td>
<td>Color of any button in the main menu when its corresponding widget is active</td>
<td><img src="image4.png" alt="Image" /></td>
</tr>
</tbody>
</table>
The following syntax shows the .css definitions for the colors of the components in the map menu. You can replace any color definition using a hexadecimal color value, an RGBA color value, or a color name. Some classes contain multiple background color properties in order to support browsers that may require color definitions in different formats (hexadecimal or RGBA). The default color definitions are the same in both formats.

/*MAIN MENU STYLES*/

/*main menu container colors*/
.mainMenuColor{
  border-color: #FFFFFF;
  border-left-color: #66b2ff;
  background: #66b2ff;
}

/*Color of the home button in the main menu when mouse hovers*/
.HomeButton .home:hover {
  background-color: #5390cf;
  background-color: rgba(83, 144, 207,1);
}

/*Color of the button in the main menu that invokes the table of contents widget when mouse hovers*/
.layersWidget:hover {
  background-color: #5390cf;
  background-color: rgba(83, 144, 207,1);
}

/*Color of the button in the main menu that invokes the selection widget when mouse hovers*/
.selectionWidget:hover {
  background-color: #5390cf;
  background-color: rgba(83, 144, 207,1);
}
/*Color of the button in the main menu that invokes the basemaps widget when mouse hovers*/
.basemapBtn:hover {
  background-color: #5390cf;
  background-color: rgba(83, 144, 207, 1);
}

/*Color of the locate button in the main menu when mouse hovers*/
.LocateButton .zoomLocateButton:hover {
  background-color: #5390cf;
  background-color: rgba(83, 144, 207, 1);
}

/*Color any button in the main menu when its corresponding widget is active*/
.WidgetOn {
  background-color: #023858;
  background-color: rgba(2, 56, 88, 1);
}

/*Color any button in the main menu when its corresponding widget is active and mouse hovers*/
.WidgetOn:hover {
  background-color: #023858;
  background-color: rgba(2, 56, 88, 1);
}

/*background color of the content area in the Table-Of-Contents widget*/
.tocContentColor{
  background-color: #c9dbdf;
}

/*style of each layer container in the Table-Of-Contents widget*/
.lyrContainerColors{
  background-color: white;
  border-color: #00b2f3;
  color: #66b2ff; /*text color. All child nodes will inherit this color*/
}

/*check boxes to turn On and Off layers in Table-Of-Contents widget*/
.lyrCheckBoxColors{
  border-color: #66b2ff;
  color: #66b2ff;
}

/* layer options box container background color*/
.optionsListColors{
  background-color: rgba(243, 10, 21, 0.19);
}
10. Creating Esri Maps

/*selection tools content background color*/
.stContentColor{
    background-color: #c9dbdf;
}

/*number of selected features box*/
.selectionInfoColors{
    color: #cd5c5c;
    border-color: #cd5c5c;
}

/*BASE MAPS WIDGET*/
/*basemaps and info-maps tabs background color */
.tabsHeaderColors{
    background-color: #66b2ff;
}

/*base-maps and info-maps tabs buttons colors*/
.imTabsTitlesColors{
    color: #ffffff;
    background-color: transparent;
}

/*base-maps and info-maps tabs buttons active colors*/
.imActive{
    background-color: #5390cf;
    border: 1px solid white;
}

/*base-maps and info-maps tabs buttons hover colors*/
.imTabsTitles:hover{
    background-color: #5390cf;
    background-color: rgba(83, 144, 207,1);
}

/*base-maps and info-maps content area background color*/
.imContentColor{
    background-color: #00ff00;
}

/*Title pane of all widgets*/
.dojoxFloatingPaneTitle { 
    background-color: #023858;
    border-color: #ffffff;
}

/*title pane in the esri pop-up window*/
.esriPopup .titlePane{
    background-color: #66b2ff; !important;
}
**Example:** Changing the Map Menu Background Color

Place the following CSS commands above the `.internal_default` CSS command on the Embedded CSS tab of the map object to make the background color of the map menu cyan.

```css
.mainMenuColor{
  border-color: #FFFFFF;
  border-left-color: #66b2ff;
  background: cyan;
}
```

The menu generated when you run the HTML page is shown in the following image.

![Map Menu Example](image)

**Example:** Changing the Hover Color of the Home (Default Extent) and Layers Buttons

The following `.HomeButton .home:hover` class changes the background hover color of the Home (Default Extent) button to orange and the `.layersWidget:hover` class changes the background hover color of the Layers (Table of Contents) widget to yellow.

```css
.HomeButton .home:hover {
  background-color: orange;
}
.layersWidget:hover {
  background-color: yellow;
}
```

The following image shows the background hover color of the Home button:

![Home Button Hover Example](image)

The following image shows the background hover color of the Table of Contents button:

![Layers Button Hover Example](image)
**Example:** Coloring a Button When its Widget is Active

The following `.WidgetOn` class makes any button green when its widget is active.

```css
.WidgetOn {
  background-color: green;
}
```

The following image shows that the Table of Contents widget is green when the Table of Contents is open.

![Table of Contents widget open](image)

**Example:** Changing the Background Color of the Table of Contents Content Area

The following `.tocContentColor` class makes the area directly around the layer container purple.

```css
.tocContentColor{
  background-color: purple;
}
```

The following image shows the Table of Contents widget with the background color purple.

![Table of Contents widget purple](image)

**Example:** Styling the Layer Containers

The following class definition makes the layer container background color yellow, the border orange, and the text red.

```css
.lyrContainerColors{
  background-color: yellow;
  border-color: orange;
  color: red;
}
```
The following image shows a layer container whose background color is yellow, border color is orange, and text color is red.

![Layer container example](image)

**Example:** Styling the Widget Title Panes

The following class definition makes the background color of the title pane burlywood and the border color navy.

```css
.dojoxFloatingPaneTitle {
    background-color: burlywood;
    border-color: navy;
}
```

The following image shows the selection widget. Its title pane has a navy border and burlywood background color.

![Selection widget example](image)

**Example:** Changing the Background Color of the Pop-up Window Title Panes

The following class definition makes the background color of the pop-up window title panes magenta.

```css
.esriPopup .titlePane{
    background-color: magenta;
    !important;
}
```
The following image shows a pop-up window with a magenta title pane.

![Pop-up window with attributes](image)

### Using IbComposer Functions to Invoke Map Menu Options

The following ibComposer functions invoke map menu options using API calls.

- **Toggle layer visibility.** `IbComposer_toggleLayer('mapId', 'layerId')`
- **Toggle heatmap visibility on a layer.** `IbComposer_toggleHeatLayer('mapId', 'layerId', 'options')`
- **Toggle visibility of clustering on a layer.** `IbComposer_toggleCluster('mapId', 'layerId', 'options')`
- **Make selections on a layer by shape.** `IbComposer_selectLayerByShape(mapId, layerId, shape)`
- **Make selections on a layer by distance.** `IbComposer_selectByDistance('mapId', 'layerId', 'distance', 'units')`
- **Clear a subset of selections.** `IbComposer_clearSelected('mapId', 'layerId')`
- **Clear all selections.** `IbComposer_clearAllSelection('mapId', 'layerId')`
- **Change basemap.** `IbComposer_changeBaseMap('mapId', 'baseMapName')`
- **Zoom to layer.** `IbComposer_zoomToLayer('mapId', 'layerId')`

**Procedure:** How to Enable Map Menu Functions

By default, the map menu widgets display on the map output. You can prevent them from automatically displaying so they can be controlled using the ibComposer functions.

1. With the Esri component selected on the HTML page, open the Properties panel.
2. Change Map: Show Map Widgets to No, as shown in the following image.

![Map settings screenshot]

**Procedure:** How to Invoke Map Menu Functions

The map menu functions must be invoked from a control on the HTML page that contains the Esri map component.

**Syntax:** How to Toggle Layer Visibility on a Map

```javascript
IbComposer_toggleLayer('mapid', 'layerid');
```

where:

- `mapid`
  Is the map unique identifier from the Properties panel of the Esri component, for example, emfobject1.

- `layerid`
  Is the layer ID from the Settings panel of the Esri component, for example, Layer1.
**Example: Toggling Layer Visibility**

The following request, `customer_locations`, is used to generate a data layer on an Esri map.

```sql
TABLE FILE WF_RETAIL_LITE
PRINT
   ID_CUSTOMER
   COGS_US
   QUANTITY_SOLD
   COMPUTE LONGITUDE/D12.2 = CUSTOMER_LONGITUDE;
   COMPUTE LATITUDE/D12.2 = CUSTOMER_LATITUDE;
BY STATE_PROV_NAME
BY ID_CUSTOMER NOPRINT
WHERE COUNTRY_NAME EQ 'United States';
ON TABLE NOTOTAL
ON TABLE PCHOLD FORMAT XML
END
```

Create a new HTML page, add an Esri map component, and add the external WebFOCUS request, `customer_locations`, in the Requests & Data Sources panel.

In the Settings panel, configure the layer (by default, named Layer1) to use this request, with the Point of Interest geographic role, and the unique ID field `ID_CUSTOMER`. 
On the Properties panel for the Esri map component, set Show Map Widgets to No, as shown in the following image.
Add a button to the HTML page, and add the Click event in the Properties panel for the button, as shown in the following image.

Click the *Embedded JavaScript* tab at the bottom of the window and add the `IbComposer_toggleLayer` function to the `button1_onclick` function, as shown in the following image.

```javascript
//Begin function button1_onclick
function button1_onclick(event) {
  var eventObject = event ? event : window.event;
  var ctrl = eventObject.target ? eventObject.target : eventObject.srcElement;
  // TODO: Add your event handler code here
  IbComposer_toggleLayer('emfobject1', 'Layer1');
}
//End function button1_onclick
```
Run the HTML page. The output is shown in the following image.
Click the button. The layer is no longer visible, as shown in the following image.

Clicking the button again will make the layer visible again.

**Syntax:** How to Toggle Heatmap Visibility on a Map

```javascript
IbComposer_toggleHeatLayer('mapid', 'layerid', options);
```

where:

- `'mapid'`
  - Is the map unique identifier from the Properties panel of the Esri component, for example, `emfobject1`.

- `'layerid'`
  - Is the layer ID from the Settings panel of the Esri component, for example, `Layer1`.
'options'
Is an object with the following two properties.

{field: 'fieldname', colors: colorStops }

where:

field: 'fieldname'
Is the name of a numeric attribute field used to weight the heatmap points.

colors: colorStops
Is an array of color Stops objects describing the color ramp for rendering the heatmap gradient. For example:

colors: ['#feebe2', '#f768a1', '#7a0177']

Example: Toggling Heatmap Visibility

The following request, customer_locations, is used to generate a data layer on an Esri map.

TABLE FILE WF_RETAIL_LITE
PRINT
       ID_CUSTOMER
       COGS_US
       QUANTITY_SOLD
       COMPUTE LONGITUDE/D12.2 = CUSTOMER_LONGITUDE;
       COMPUTE LATITUDE/D12.2 = CUSTOMER_LATITUDE;
   BY STATE_PROV_NAME
   BY ID_CUSTOMER NOPRINT
 WHERE COUNTRY_NAME EQ 'United States';
 ON TABLE NOTOTAL
 ON TABLE PCHOLD FORMAT XML
END

Create a new HTML page, add an Esri map component, and add the external WebFOCUS request, customer_locations, in the Requests & Data Sources panel.

In the Settings panel, configure the layer (by default, named Layer1) to use this request, with the Point of Interest geographic role, and the unique ID field ID_CUSTOMER.
On the Properties panel for the Esri map component, set Show Map Widgets to No, as shown in the following image.
Add a button to the HTML page, and add the Click event in the Properties panel for the button, as shown in the following image.

Click the Embedded JavaScript tab at the bottom of the window and add the `IbComposer_toggleHeatLayer` function to the `button1_onclick` function, as shown in the following image.

```javascript
//Begin function button1_onclick
function button1_onclick(event) {
    var eventObject = event || window.event;
    var ctrl = eventObject.target || eventObject.srcElement;
    // TODO: Add your event handler code here

    IbComposer_toggleHeatLayer('emfObject1', 'Layer1', {field: 'QUANTITY_SOLD', colors: ['#f3ebe2','#f76831','#f00177']});
}
//End function button1_onclick
```
Run the HTML page. The output is shown in the following image.
Click the button. The heatmap is now visible, as shown in the following image.

Clicking the button again will make the heatmap not visible again.

**Syntax:**

How to Toggle Cluster Visibility on a Map

```
IbComposer_toggleCluster('mapid', 'layerid', options);
```

where:

- `'mapid'`
  - Is the map unique identifier from the Properties panel of the Esri component, for example, `emfobject1`.

- `'layerid'`
  - Is the layer ID from the Settings panel of the Esri component, for example, `Layer1`.
**options**

Is an array of objects containing the properties of each cluster class. The following are the properties of each cluster class:

```
{min: n, max: n, size: n, color: [r, g, b],
 outline: {color: [r, g, b], thickness: n} }
```

where:

- **min: n**
  
  Are the minimum number of points to group in this class.

- **max: n**
  
  Are the maximum number of points to group in this class.

- **size: n**
  
  Is the size in pixels of the circle symbol in this class.

- **color: [r, g, b]**
  
  Is the rgb value for the color of the circle symbol in this class.

- **outline**
  
  Defines the properties of the circle border for each class.

  - **color: [r, g, b]**
    
    Is the rgb value for the color of the circle symbol border in this class.

  - **thickness: n**
    
    Is the width of the circle border in pixels.

For example:

```
[ ...
, {min: 10, max: 30, size: 35, color: [128, 255, 0],
   outline: {color: [255, 100, 200], thickness: 10} }
, {min: 30, max: 100, size: 45, color: [255, 51, 51],
   outline: {color: [128, 255, 0], thickness: 5} }
]  
```
**Example:**  **Toggling Cluster Visibility**

The following request, `customer_locations`, is used to generate a data layer on an Esri map.

```
TABLE FILE WF_RETAIL_LITE
PRINT
   ID_CUSTOMER
   COGS_US
   QUANTITY_SOLD
   COMPUTE LONGITUDE/D12.2 = CUSTOMER_LONGITUDE;
   COMPUTE LATITUDE/D12.2 = CUSTOMER_LATITUDE;
   BY   STATE_PROV_NAME
   BY   ID_CUSTOMER NOPRINT
   WHERE COUNTRY_NAME EQ 'United States';
ON TABLE NOTOTAL
ON TABLE PCHOLD FORMAT XML
END
```

Create a new HTML page, add an Esri map component, and add the external WebFOCUS request, `customer_locations`, in the Requests & Data Sources panel.

In the Settings panel, configure the layer (by default, named Layer1) to use this request, with the Point of Interest geographic role, and the unique ID field `ID_CUSTOMER`. 
On the Properties panel for the Esri map component, set Show Map Widgets to No, as shown in the following image.
Add a button to the HTML page, and add the Click event in the Properties panel for the button, as shown in the following image.

Click the *Embedded JavaScript* tab at the bottom of the window and add the following *IbComposer_toggleCluster* syntax to the `button1_onclick` function.

```javascript
IbComposer_toggleCluster('emfobject1', 'Layer1', [
  {min: 1, max: 30, size: 35, color: [0, 0, 255],
   outline: {color: [255, 100, 200], thickness: 10}},
  {min: 31, max: 50, size: 40, color: [128, 255, 0],
   outline: {color: [255, 100, 200], thickness: 10}},
  {min: 51, max: 1000, size: 45, color: [255, 51, 51],
   outline: {color: [128, 255, 0], thickness: 5}}
]);
```
Run the HTML page. The output is shown in the following image.
Click the button. The clusters are now visible, as shown in the following image.

[Map image with clusters]

Clicking the button again will make the clusters not visible again.

**Syntax:**

How to Make Selections on a Map Using a Shape

```ibcomposer_selectLayerByShape('mapid', 'layerid', 'shape');```

where:

- `'mapid'`  
  Is the map unique identifier from the Properties panel of the Esri component, for example, emfobject1.

- `'layerid'`  
  Is the layer ID from the Settings panel of the Esri component, for example, Layer1.

- `'shape'`  
  Is one of the following valid selection shapes.

  - 'POLYGON'
  - 'POLYLINE'
Example: Making Selections on a Map Using a Polygon

The following request, customer_locations, is used to generate a data layer on an Esri map.

```sql
TABLE FILE WF_RETAIL_LITE
PRINT
   ID_CUSTOMER
   COGS_US
   QUANTITY_SOLD
   COMPUTE LONGITUDE/D12.2 = CUSTOMER_LONGITUDE;
   COMPUTE LATITUDE/D12.2 = CUSTOMER_LATITUDE;
BY  STATE_PROV_NAME
BY  ID_CUSTOMER NOPRINT
WHERE COUNTRY_NAME EQ 'United States';
ON TABLE NOTOTAL
ON TABLE PCHOLD FORMAT XML
END
```

Create a new HTML page, add an Esri map component, and add the external WebFOCUS request named customer_locations in the Requests & Data Sources panel.

In the Settings panel, configure the layer (by default, named Layer1) to use this request, with the Point of Interest geographic role, and the unique ID field ID_CUSTOMER.
On the Properties panel for the Esri map component, set Show Map Widgets to No, as shown in the following image.
Add a button to the HTML page, and add the Click event in the Properties panel for the button, as shown in the following image.

Click the *Embedded JavaScript* tab at the bottom of the window and add the `IbComposer_selectLayerByShape` function to the `button1_onclick` function, as shown in the following image.

```
//Begin function button1_onclick
function button1_onclick(event) {
  var eventObject = event ? event : window.event;
  var ctrl = eventObject.target ? eventObject.target : eventObject.srcElement;
  // TODO: Add your event handler code here

  IbComposer_selectLayerByShape('cmfobject1', 'Layer1', 'POLYGON');
}
//End function button1_onclick
```
Run the HTML page and click the button. Then click on the map in each position that you want a vertex of the polygon, as shown in the following image.
Double-click to end the selection process. The points within the polygon are highlighted, as shown in the following image.

For information on clearing your selections, see How to Clear Selections on a Map on page 964.

**Syntax:** How to Make Selections on a Map By Distance

This function is used to select a distance when the selection shape is a circle.

```java
IbComposer_selectByDistance('mapid', 'layerid', distance, 'units');
```

where:

- `mapid`  
  Is the map unique identifier from the Properties panel of the Esri component, for example, emfobject1.

- `layerid`  
  Is the layer ID from the Settings panel of the Esri component, for example, Layer1.
**distance**
Is the distance expressed in the specified units (see below).

**'units'**
Is one of the following valid distance units.

- 'esriMeters'
- 'esriKilometers'
- 'esriInches'
- 'esriFeet'
- 'esriYards'
- 'esriMiles'
- 'esriNauticalMiles'
- 'esriMillimeters'
- 'esriCentimeters'
- 'esriDecimeters'

**Example:** Making Selections on a Map by Distance

The following request, customer_locations, is used to generate a data layer on an Esri map.

```sql
TABLE FILE WF_RETAIL_LITE
PRINT
   ID_CUSTOMER
   COGS_US
   QUANTITY_SOLD
   COMPUTE LONGITUDE/D12.2 = CUSTOMER_LONGITUDE;
   COMPUTE LATITUDE/D12.2 = CUSTOMER_LATITUDE;
BY  STATE_PROV_NAME
BY  ID_CUSTOMER NOPRINT
WHERE COUNTRY_NAME EQ 'United States';
ON TABLE NOTOTAL
ON TABLE PCHOLD FORMAT XML
END
```

Create a new HTML page, add an Esri map component, and add the external WebFOCUS request, customer_locations, in the Requests & Data Sources panel.

In the Settings panel, configure the layer (by default, named Layer1) to use this request, with the Point of Interest geographic role, and the unique ID field ID_CUSTOMER.
On the Properties panel for the Esri map component, set Show Map Widgets to No, as shown in the following image.
Add a button to the HTML page, and add the Click event in the Properties panel for the button, as shown in the following image.

Click the Embedded JavaScript tab at the bottom of the window and add the IbComposer_selectByDistance function to the button1_onclick function, as shown in the following image. The selection distance shown is 100 miles.

```javascript
//Begin function button1_onclick
function button1_onclick(event) {
  var eventObject = event ? event : window.event;
  var ctrl = eventObject.target ? eventObject.target : eventObject.srcElement;
  // TODO: Add your event handler code here

  IbComposer_selectByDistance('emFobject1', 'Layer1', 100, 'esriMiles');
}
//End function button1_onclick
```
Run the HTML page. The output is shown in the following image.
Click the button, then click on the map at the point that you want to be the center of the circle where the points will be selected. The map is zoomed, and the points within the circle are highlighted, as shown in the following image.

For information on clearing your selections, see *How to Clear Selections on a Map* on page 964.

**Syntax:**

**How to Clear Selections on a Map**

Once you have made selections on a map, you have two choices for clearing selections.

- You can clear all of the selections.
- You can select a subset of the previously selected features and deselect only that subset of features, leaving the other features still selected.
**Note:** When selections on a map trigger a request to run (chaining), you can configure whether clearing selections reruns the request. To specify whether to rerun the request, use the *Selection Required* property on the Properties panel for the map object. The value *yes* does not rerun the request when selections are cleared. The value *no* does rerun the request.

To clear all selections, use the `IbComposer_clearAllSelection` function.

```java
IbComposer_clearAllSelection('mapid', 'layerid');
```

To clear a subset of the selected features, use the `IbComposer_clearSelected` function. This enables you to select a subset of the previously selected features and clear only that subset.

```java
IbComposer_clearSelected('mapid', 'layerid');
```

where:

- `'mapid'`  
  Is the map unique identifier from the Properties panel of the Esri component, for example, `emfobject1`.

- `'layerid'`  
  Is the layer ID from the Settings panel of the Esri component, for example, `Layer1`.

**Example: Clearing Selections on a Map**

The following request, `customer_locations`, will be used to generate a data layer on an Esri map.

```sql
TABLE FILE WF_RETAIL_LITE
PRINT
  ID_CUSTOMER
  COGS_US
  QUANTITY_SOLD
  COMPUTE LONGITUDE/D12.2 = CUSTOMER_LONGITUDE;
  COMPUTE LATITUDE/D12.2 = CUSTOMER_LATITUDE;
BY  STATE_PROV_NAME
BY  ID_CUSTOMER NOPRINT
WHERE COUNTRY_NAME EQ 'United States';
ON TABLE NOTOTAL
ON TABLE PCHOLD FORMAT XML
END
```

Create a new HTML page, add an Esri map component, and add the external WebFOCUS request, `customer_locations`, in the Requests & Data Sources panel.

In the Settings panel, configure the layer (by default, named `Layer1`) to use this request, with the Point of Interest geographic role, and the unique ID field `ID_CUSTOMER`. 
On the Properties panel for the Esri map component, set Show Map Widgets to No, as shown in the following image.
Add three buttons to the HTML page. For each button, add the Click event in the Properties panel for the button, as shown in the following image.

The first button will create a selection based on the polygon shape. Name that button Select Polygon. Click the Embedded JavaScript tab at the bottom of the window and add the IbComposer_selectLayerByShape function to the button1_onclick function, as shown in the following image.

```javascript
//Begin function button1_onclick
function button1_onclick(event) {
    var eventObject = event ? event : window.event;
    var ctrl = eventObject.target ? eventObject.target : eventObject.srcElement;
    // TODO: Add your event handler code here

    IbComposer_selectLayerByShape('emfobject1', 'Layer1', 'POLYGON');
}
//End function button1_onclick
```

Name the second button Clear Selected. For the second button, add the IbComposer_clearSelected function to the button2_onclick function, using the following syntax.

```javascript
IbComposer_clearSelected('emfobject1', 'Layer1');
```
Name the third button *Clear All*. For the third button, add the `IbComposer_clearAllSelection` function to the `button3_onclick` function, using the following syntax.

```javascript
IbComposer_clearAllSelection('emfobject1', 'Layer1');
```

Run the HTML page. The output is shown in the following image.
Click the Select Polygon button and select points, as shown in the following image.
Click the *Clear Selected* button, and select some of the previously selected points, as shown in the following image.
Those points have been deselected, as shown in the following image.
To clear all remaining selections, click the **Clear All** button. All selections are cleared, as shown in the following image.

![Map Selections](image)

**Syntax:** How to Change the Basemap

```javascript
IbComposer_changeBaseMap('mapid', 'basemapname');
```

where:

'**mapid**'

Is the map unique identifier from the Properties panel of the Esri component, for example, `emfobject1`.

'**basemapname**'

Is the name of one of the standard basemaps supplied with App Studio or the name of a customized basemap configured by the user. Standard basemap names are:

- 'streets'
- 'satellite'
- 'hybrid'
- 'terrain'
Example: Changing the Basemap

The following request, customer_locations, will be used to generate a data layer on an Esri map.

```
TABLE FILE WF RETAIL LITE
PRINT
   ID_CUSTOMER
   COGS_US
   QUANTITY_SOLD
   COMPUTE LONGITUDE/D12.2 = CUSTOMER_LONGITUDE;
   COMPUTE LATITUDE/D12.2 = CUSTOMER_LATITUDE;
   BY   STATE_PROV_NAME
   BY   ID_CUSTOMER NOPRINT
   WHERE COUNTRY_NAME EQ 'United States';
   ON TABLE NOTOTAL
   ON TABLE PCHOLD FORMAT XML
END
```

Create a new HTML page, add an Esri map component, and add the external WebFOCUS request, customer_locations, in the Requests & Data Sources panel.

In the Settings panel, configure the layer (by default, named Layer1) to use this request, with the Point of Interest geographic role, and the unique ID field ID_CUSTOMER.
On the Properties panel for the Esri map component, set Show Map Widgets to No, as shown in the following image.
Add a button to the HTML page, and add the Click event in the Properties panel for the button, as shown in the following image.

Click the *Embedded JavaScript* tab at the bottom of the window and add the `IbComposer_changeBaseMap` function to the `button1_onclick` function, as shown in the following image.

```javascript
//Begin function button1_onclick

function button1_onclick(event) {
    var eventObject = event ? event : window.event;
    var ctrl = eventObject.target ? eventObject.target : eventObject.srcElement;
    // TODO: Add your event handler code here
    IbComposer_changeBaseMap('emfobject1', 'streets');
}

//End function button1_onclick
```
Run the HTML page. The output is shown in the following image.
Click the button. The basemap changes, as shown in the following image.

**Syntax:** How to Zoom to a Layer on a Map

```ibComposer_zoomToLayer('mapid', 'layerid');```

where:

- `'mapid'`
  - Is the map unique identifier from the Properties panel of the Esri component, for example, `emfobject1`.

- `'layerid'`
  - Is the layer ID from the Settings panel of the Esri component, for example, `Layer1`. 
**Example: Zooming to a Layer**

The following request, `customer_locations`, is used to generate one data layer on an Esri map.

```sql
TABLE FILE WF_RETAIL_LITE
PRINT
   ID_CUSTOMER
   COGS_US
   QUANTITY_SOLD
   COMPUTE LONGITUDE/D12.2 = CUSTOMER_LONGITUDE;
   COMPUTE LATITUDE/D12.2 = CUSTOMER_LATITUDE;
BY  STATE_PROV_NAME
BY  ID_CUSTOMER NOPRINT
WHERE COUNTRY_NAME EQ 'United States';
ON TABLE NOTOTAL
ON TABLE PCHOLD FORMAT XML
END
```

The following request named `customer_countries1b` will be used to generate a second data layer on an Esri map.

```sql
TABLE FILE WF_RETAIL_LITE
SUM
   COGS_US
   QUANTITY_SOLD
BY  COUNTRY_NAME
ON TABLE NOTOTAL
ON TABLE PCHOLD FORMAT XML
END
```

Create a new HTML page, add an Esri map component, and add the external WebFOCUS requests, `customer_locations` and `customer_countries1b`, in the Requests & Data Sources panel.

In the Settings panel, configure Layer1 to use the `customer_locations` request, with the Point of Interest geographic role, and the unique ID field `ID_CUSTOMER`. Configure Layer2 to use the `customer_countries1b` request, with the Country geographic role using the `COUNTRY_NAME` field as the field that matches the geographic role.
On the Properties panel for the Esri map component, set Show Map Widgets to No, as shown in the following image.

![Properties panel showing Show Map Widgets set to No](image-url)
Add a button to the HTML page, and add the Click event in the Properties panel for the button, as shown in the following image.

Click the *Embedded JavaScript* tab at the bottom of the window and add the `IbComposer_toggleLayer` function to the `button1_onclick` function, as shown in the following image.

```javascript
//Begin function button1_onclick
function button1_onclick(event) {
    var eventObject = event ? event : window.event;
    var ctrl = eventObject.target ? eventObject.target : eventObject.srcElement;
    // TODO: Add your event handler code here
    IbComposer_toggleLayer('emfobject1', 'Layer2');
}
//End function button1_onclick
```
Run the HTML page. The output is shown in the following image.
Configuring Layer Visualizations

Click the button. The map is zoomed to the country layer, as shown in the following image.

![Zoom to Countries Layer](image)

Configuring Layer Visualizations

The visualizations available in a map layer depend on the layer type.

The following image shows the Layer Visualizations section of the ESRI Object Settings panel.

![Layer Visualizations](image)

A list of layer visualizations you can configure in the Layer Visualizations section of the ESRI Object Settings dialog box follows.

**Clustering**

**Description.** Enables clustering (grouping of symbols) on the selected layer.
**Type of Field.** Boolean.

**Populated by.** User.

**Limits.** On/Off. Default is Off. If you click this property, a dialog box opens that lets you turn on clustering and style the clusters. For information, see *Enabling and Styling Clusters on Point Maps* on page 985.

**Example.** On

Create Labels

**Description.** Creates labels based on field values for point of interest layers.

**Type of Field.** Boolean.

**Populated by.** User.

**Limits.** On/Off. Default is Off. If you click this property, a dialog box opens that lets you configure labels. For information, see *Adding Labels to Point of Interest Layers* on page 994.

**Example.** On

Transparency

**Description.** Transparency of the layer.

**Type of Field.** Numeric.

**Populated by.** User.

**Limits.** Values 0 - 100. 100 is 100% opaque, and 0 is 100% transparent. Default is 50.

**Example.** 50

Add Heatmap

**Description.** Applies to Point of Interest and Cities geographic roles. Colors the areas around the points using a gradient in which the intensity of the color is based on the concentration of points.

**Type of Field.** Boolean.

**Populated by.** User.

**Limits.** On/Off. Default is Off.

**Example.** Off

Enable Popups

**Description.** Shows an InfoWindow with the values of the layer attribute fields when a polygon or point is clicked.
**Type of Field.** Boolean.

**Populated by.** User.

**Limits.** On/Off. Default is Off.

**Example.** Off

**Default Visibility**

**Description.** Makes the layer initially visible or not visible.

**Type of Field.** Boolean.

**Populated by.** User.

**Limits.** On/Off. Default is On.

**Example.** On

**Default Extent**

**Description.** If Default Extent is Off, the map view is the extent of the first layer loaded. If it is On, the map view is the full layer. The map extent is determined as follows:

- If there are no layers, the extent is the entire map.
- If any layer is configured with the default extent, the extent is determined by that layer data.
- If there are one or more layers and no layer is configured with the default extent, the extent is determined by the data for the first layer.

**Type of Field.** Boolean.

**Populated by.** User.

**Limits.** On/Off. Default is Off.

**Example.** Off

**Spatial Coordinate System**

**Description.** Is the id of coordinate system used by the WebFOCUS procedure to provide geographic data. For information about coordinate systems available with Esri, see [https://developers.arcgis.com/javascript/jshelp/ref_coordsystems.html](https://developers.arcgis.com/javascript/jshelp/ref_coordsystems.html).

**Note:** For any Spatial Coordinate System under Layer Settings other than 4326, please use an internally hosted Geometry Service. This will require projection on the fly. For more details about Geometry Service please see [http://server.arcgis.com/en/server/latest/publish-services/linux/about-the-geometry-service.htm](http://server.arcgis.com/en/server/latest/publish-services/linux/about-the-geometry-service.htm).

**Type of Field.** ID.
Example: Enabling and Styling Clusters on Point Maps

Turning the Clustering layer visualization on for a point map combines multiple points into one symbol, with default class breaks, colors, and sizes. You can style the clusters by changing the default colors, sizes, and class breaks. The only symbol shape supported for clustering is a circle.

The default clusters are broken into three classes.

1. Class 1 clusters 0 to 10 points using a 20px diameter symbol with blue fill.
2. Class 2 clusters 11 to 200 points using a 35px diameter symbol with green fill.
3. Class 3 clusters more than 200 points using a 60px diameter symbol with red fill.

The clusters change as you zoom the map.
When you turn the Clustering layer visualization on in the Settings panel for a map, a dialog box opens that enables you to customize the number of classes and the colors and sizes for each class, as shown in the following image.

To customize the symbols, enter the following information in the Cluster Settings dialog box.

1. Click On in the Clustering section.
2. Select a number of classes, between 2 and 5, from the Number of Classes drop-down list.
The class numbers are added to the list box on the left of the dialog box, as shown in the following image, where the number 3 was selected.

3. Click each class number. The following properties become active for each class.

- **Minimum.** Specifies the smallest number of features (records) at any given map scale. Enter the smallest number of points you want to include in this class.

- **Maximum.** Specifies the largest number of features (records) at any given map scale. Enter the largest number of points you want to include in this class.

  *Note:* The minimum value for each class must be less than its maximum value.

- **Size.** Represents the maximum symbol size (in pixels) that corresponds to this scale. Enter the maximum symbol size you want to use for this class.

- **Color.** Represents the color that will be used for coloring the inner circle. Click this box to open the color picker dialog box and select a color.

- **Outline Color.** Represents the color that will be used for coloring the outer circle. Click this box to open the color picker dialog box and select a color.
Outline Width. Represents the width of the outer circle in pixels. Enter a number of pixels in this text box.

4. Click OK.

Create an HTML page with an Esri component. Add the following request, named customer_locations.fex, in the folder with the HTML page, then add it to the HTML page using the Requests & Data Sources panel.

```
TABLE FILE WF_RETAIL_LITE
PRINT
   ID_CUSTOMER
   COGS_US
   QUANTITY_SOLD
   COMPUTE LONGITUDE/D12.2 = CUSTOMER_LONGITUDE;
   COMPUTE LATITUDE/D12.2 = CUSTOMER_LATITUDE;
BY STATE_PROV_NAME
BY ID_CUSTOMER NOPRINT
WHERE COUNTRY_NAME EQ 'United States';
ON TABLE NOTOTAL
ON TABLE PCHOLD FORMAT XML
END
```
In the Settings panel, select this request, select the Point of Interest Geographic Role, and select ID_CUSTOMER as the Unique Id field, as shown in the following image.

In the Layer Visualizations section of the Settings panel, click Clustering. Click the On radio button.
Click OK and run the HTML page. The clusters appear with the default properties, as shown in the following image.

In the Layer Visualizations section of the Settings panel, click Clustering.
In the Cluster Settings dialog box, turn clustering on and select three classes. Select the options shown in the following images for each class.

**Class 1**
Class 2

Cluster Settings

Clustering

- Off
- On

Number of Classes: 3

<table>
<thead>
<tr>
<th>Class</th>
<th>Minimum</th>
<th>Maximum</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>21</td>
<td>100</td>
</tr>
<tr>
<td>2</td>
<td>30</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>5</td>
<td></td>
</tr>
</tbody>
</table>

Color

Size

Outline Color

Outline Width: 5

OK  Cancel
Class 3

Cluster Settings

- Clustering:
  - Off
  - On

- Number of Classes: 3

Class 1:
- Minimum: 101
- Maximum: 1000
- Color: Purple
- Size: 40
- Outline Color: Red
- Outline Width: 5

Class 2:
- Minimum: 101
- Maximum: 1000
- Color: Purple
- Size: 40
- Outline Color: Red
- Outline Width: 5

Class 3:
- Minimum: 101
- Maximum: 1000
- Color: Pink
- Size: 40
- Outline Color: Red
- Outline Width: 5
Click OK and run the HTML page. The customized clusters are shown in the following image.

**Example:** Adding Labels to Point of Interest Layers

When you generate a point layer on an Esri map, you can add a Labels visualization to display a field value at each point location.

The Layer Visualizations section of the Settings panel for an Esri map component is shown in the following image.
By default, Create Labels is set to Off. Click the ellipsis (…) next to Off to open the Labels dialog box, as shown in the following image.

Click the On radio button and configure the following label properties.

- **Field.** Click the ellipsis (…) to select a field whose value will display for each point.
- **Font.** Select a font family from the Font drop-down list. The default font family is MS Serif.
- **Font Size.** Enter a point size for the font, or accept the default size (12 points).
- **Font Weight.** Select a font weight from the Font Weight drop-down list. Possible values are Bold, Bolder, Lighter, or Normal. The default value is Normal.
- **Font Color.** Click the Font Color field to open a color picker, or accept the default color (Red).
- **Font Style.** Select a font style from the Font Style drop-down list. Possible values are Italic, Normal, or Oblique. The default value is Normal.
- **Alignment.** Select an alignment for the labels relative to the point locations, from the Alignment drop-down list. Possible values are Above Center, Above Left, Above Right, Below Center, Below Left, Below Right, Center Center, Center Left, Center Right.
- **Angle.** Enter an angle in degrees for the orientation of the labels. The default value is 0 (zero).
Min Scale. Enter the minimum map scale for which the labels should display, or leave this field blank for no minimum.

Max Scale. Enter the maximum map scale for which the labels should display, or leave this field blank for no maximum.

Halo. These fields define the properties of a color line around the font.

Off/On. Click the On radio button to turn on halos.

Color. Click the color field to open a color picker for selecting the halo color.

Size. Enter a size in pixels for the thickness of the halo. The default value is 1.

The following request, bike_locations1.fex, provides point locations based on the start station latitudes and longitudes for bicycle trips.

```
DEFINE FILE ESRI_CITIBIKE
GENDER1/A10 = IF GENDER EQ 0 THEN 'None' ELSE IF GENDER EQ 1 THEN 'Male'
ELSE 'Female';
LATITUDE/D20.8 = START_STATION_LATITUDE;
LONGITUDE/D20.8 = START_STATION_LONGITUDE;
END
TABLE FILE ESRI_CITIBIKE
PRINT START_STATION_NAME GENDER1
LATITUDE LONGITUDE
BY BIKEID
ON TABLE PCHOLD FORMAT XML
END
```
The HTML page has an Esri component that uses this request to generate a point of interest layer, as shown in the following image.

![Settings](image1)

The symbol used for the point locations is a bicycle image (at URL http://ecl.informationbuilders.com/jschart/bicycle.png) angled at 15 degrees, as shown in the following image.

![Symbol Settings](image2)
The labels are turned on and set to use the value of the field `START STATION NAME` as the label text for each point. The labels are displayed at a 15-degree angle, above and to the right of the point symbols. The font is red 16-point Arial. The halo is turned on. Its color is yellow and its size is 5. The Labels dialog box with these properties set is shown in the following image.
Run the HTML page. The output is shown in the following image.

Example: Enabling Popups

When you enable popups in the Layer Visualizations section of the ESRI Object Settings panel, and you click a marker or polygon, an InfoWindow opens that shows additional information for the map layer drawn. This popup is dependent on the layer attributes enabled at design time.
The following image shows an InfoWindow for a marker on the map layer:

Note: In order to display customized names rather than field names in the popup, the custom names must be defined with the TITLE attribute in the Master File. Using an AS name in the request to create a custom name is not supported in the infowindow.

To close the InfoWindow, click the X in the header or click another marker.

Clicking Zoom to zooms in the map to the location of the clicked marker.

Example: Enabling the Default Extent

With the Default Extent visualization Off (the default), the initial view of the layer shows the map view of the data layer defined. If there are multiple data layers, only one layer can have the Default Extent turned on. In this case, the map view will be determined by the map layer that has the Default Extent turned on. If no layer has Default Extent turned on, the extent of the first data layer defined for the map will be used.
The following image shows a map that has two layers, one based on countries, and one based on US states, as shown in the following image.

Running the HTML page shows both layers, with the default extent set by the Countries layer, as shown in the following image.
The following image shows the States map layer with the Default Extent turned on.
The following image shows that the map now zooms to the default extent of the States map layer.

If you have zoomed the map using the zoom controls, you can return to the default extent using the Default Extent control, shown in the following image.

For any layer, you can zoom to the layer extent using the Table of Contents control, shown in the following image.
Configuring Symbology for a Data Layer

The symbology available for a layer depends on the type of layer, and on whether the geographic data provided to the layer consists of points (X/Y values in either decimal degrees or other units) or polygons (geographic areas).

When the geographic data consists of points, each point is represented by a marker on the map. Each marker can be drawn using a standard shape or an image file. Markers can be assigned a size and can be colored based on several classification schemes, using any metrics.

When the geographic data defines polygons, the areas on the map representing each polygon can be colored based on several classification schemes, using any metrics. It can have an outline that consists of a color, a thickness, and a line style. It can also have a fill style such as solid, diagonal lines (forward or backward) or crosshatch.

Configuring Symbology for a Point Data Layer

Geographical point data places markers on the map layer that can be configured with a wide range of shape, size, color, and image options.

The following image shows the Symbol Settings section of the ESRI Object Settings panel for a point-based data layer. Some selections may open additional options not shown in this image.
The following table summarizes the types of symbology available for a point layer. Each type of symbology is illustrated in one of the sections that follows.

<table>
<thead>
<tr>
<th>Type of Symbol (Subtype)</th>
<th>Description</th>
<th>Configuration Fields</th>
</tr>
</thead>
</table>
| Single (Shape)          | User selects from a list of marker shapes. | **Use.** Selects the type of symbols, **Single** for this option.  
**Color.** User selects a marker color. The default is red.  
**Size.** User specifies the marker size in pixels. The default is 12 and the maximum is 99.  
**Shape/Image.** Select **Shape** for this option.  
**Shape.** User selects one of the following marker shapes:  
- Circle (default)  
- Cross  
- Diamond  
- Square  
- X  
**Outline Color.** User selects a color for the marker border, when the marker is a standard shape. The default is gray85.  
**Outline Thickness.** Is the thickness of the outline in pixels. The default value is 1.  
**Outline Style.** User selects one of the following styles for the marker border. Solid (default), Dashes, Dash-dot, Dash-dot-dot, Dots, Long dashes, Long dash-dot, None, Short dashes, Short dash-dot, Short dash-dot-dot, Short dots. For more information, see *Configuring Point Symbology Using a Single Standard Shape* on page 1010. |
<table>
<thead>
<tr>
<th>Type of Symbol (Subtype)</th>
<th>Description</th>
<th>Configuration Fields</th>
</tr>
</thead>
</table>
| Single (Image)          | User provides an image source for the markers. | **Use.** Selects the type of symbols, *Single* for this option.  
**Color.** N/A. The image has its own colors.  
**Size.** User specifies the marker width and height in pixels. The default is 12 for each, and the maximum is 99.  
**Shape/Image.** Select *Image* for this option.  
**Image Source.** User must provide the path to the image.  
**Image Angle.** User can enter an angle, in degrees, to control the image orientation.  
For more information, see *Configuring Point Symbology Using a Single Image File* on page 1012. |
<table>
<thead>
<tr>
<th>Type of Symbol</th>
<th>Description</th>
<th>Configuration Fields</th>
</tr>
</thead>
</table>
| **Color**     | User specifies a field to be used to classify marker colors. | **Use.** Selects the type of symbols, *Color* for this option.  
**Using Field.** User selects a field in the request to be used to classify the markers by color.  
**By.** User selects from the following classification methods.  
- Natural Jenks (the default).  
- Quantile.  
- Equal Breaks.  
- Standard Deviation.  
- Geometrical Breaks.  
**Number of Classes.** User specifies the number of color breaks. The default is 5.  
**Color Scheme.** User selects the color palette for the markers. The default uses shades of green.  
For more information, see *Configuring Point Symbology Using Color* on page 1016. |
| **Size**      | User specifies a field to be used to size the markers. | **Use.** Selects the type of symbols, *Size* for this option.  
**Using Field.** User selects a field in the request to be used to classify the markers by size.  
**Color.** User selects a color for the markers.  
For more information, see *Configuring Point Symbology Using Size* on page 1019. |
<table>
<thead>
<tr>
<th>Type of Symbol (Subtype)</th>
<th>Description</th>
<th>Configuration Fields</th>
</tr>
</thead>
</table>
| Dynamic                 | The WebFOCUS request that provides the location dimension defines the marker properties. | **Use.** Selects the type of symbols, *Dynamic* for this option.  
**Label.** User specifies a field in the request that contains the label text for the legend. The default is the AS name, title, or field name.  
**Color.** User specifies a field in the request that defines the colors for the markers. Not supported when marker images are used, as each image has its own colors.  
**Size.** User specifies a field in the request that defines the size in pixels for the markers. The default is 12 and the maximum is 99.  
**Image Source.** User specifies a field in the request that contains the path to the marker images.  
For more information, see *Configuring Dynamic Point Symbology* on page 1021. |
<table>
<thead>
<tr>
<th>Type of Symbol</th>
<th>Description</th>
<th>Configuration Fields</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Unique</strong></td>
<td>User selects marker properties for each value of a dimension in the request.</td>
<td><strong>Use.</strong> Selects the type of symbols, <em>Unique</em> for this option.</td>
</tr>
</tbody>
</table>

**Using Field.** User selects an alphanumeric dimension in the request and assigns marker properties for each value.

**Size.** User specifies a size in pixels for the markers, for a standard shape. For an image, the user specifies the width and height in pixels. The default is 12 and the maximum is 99.

**Shape / Image.** User can select a standard shape or specify an image source for the markers.

**Dimension Values box.** A box is populated with the dimension values. The user can select values and move them to the right, then assign marker properties to those selected values.

**Label.** User specifies text to display in the legend for each selected dimension value.

**Color.** If Single is the selected marker type, the user selects a color for each selected dimension value.

**Shape.** If Shape is the selected marker type, the user selects a standard shape and standard shape properties for each selected dimension value.

**Image Source.** If Image is the selected marker type, the user specifies an image source for each selected dimension value.

For more information, see *Configuring Unique Symbology for Points* on page 1025.

**Note:** The symbol dynamically changes size with the zoom level of the map output for a single symbol, but not for a symbol that is unique, dynamic, based on size, or based on color.
Configuring Point Symbology Using a Single Standard Shape

The default symbol used for points is a 12-pixel red circle with a solid border, as shown in the following image.

![Symbol Settings](image)

You can open a color picker dialog box by clicking the Color field, enter a size in pixels, and select a different shape (square, diamond, cross, or X). The maximum size supported is 99. For the outline, you can open a color picker dialog box by clicking the Outline Color field, enter a thickness in pixels, and select an outline line style. The outline styles are:

- Solid (default).
- Dashes.
- Dash-dot.
- Dash-dot-dot.
- Dots.
- Long dashes.
- Long dash-dot.
- None.
- Short dashes.
- Short dash-dot.
- Short dash-dot-dot.
Example: Configuring Point Symbology Using a Standard Shape

This example uses a blue diamond symbol with a 3-pixel wide black solid outline as the marker. The following image shows the symbol settings. The external WebFOCUS request used to provide the point data is the customer_locations procedure created in Configuring a Map Data Layer on page 894. The geographic role is Point of Interest, and the fields that match the role are LATITUDE/LONGITUDE.
Run the HTML page. The output is shown in the following image.

Configuring Point Symbology Using a Single Image File

You can select a valid image file to use as the marker for point data and specify its size and orientation (image angle), as shown in the following image.

The default width and height are 12 pixels and the maximum number of pixels is 99.

Selecting a color has no effect on the output, as the image file is placed on the points with no manipulation, except for size.

The symbol can be located on your machine or at a URL reference.
Leaving the Image Angle field blank, or entering 0 (zero) or 360, displays the images at their default orientation.

**Example:** Configuring Point Symbology Using an Image File

The following example uses a US flag as the symbol for the Customer layer.

In the Symbol Settings section of the ESRI Object Settings panel, select Single in the Use drop-down list and Image in the Shape / Image drop-down list.

Enter the following URL in the Image Source box.

http://ecl.informationbuilders.com/jschart/us.gif

Run the HTML page. The output is shown in the following image.
Example: Changing the Orientation of a Point Image Using Single Image Symbology

The following request, bike_locations.fex, is used to generate a point of interest layer.

```fex
DEFINE FILE ESRI_CITIBIKE
  GENDER1/A10 = IF GENDER EQ 0 THEN 'None' ELSE IF GENDER EQ 1 THEN 'Male'
    ELSE 'Female';
  LATITUDE/D20.8 = START_STATION_LATITUDE;
  LONGITUDE/D20.8 = START_STATION_LONGITUDE;
END
TABLE FILE ESRI_CITIBIKE
  PRINT START_STATION_NAME  GENDER1
  LATITUDE LONGITUDE
  BY BIKEID
  ON TABLE PCHOLD FORMAT XML
END
```

The HTML page has an Esri component that uses this request, as shown in the following image.

The symbol used to identify the point locations will be a bicycle image displayed at a 45 degree angle. The URL to the image is:

http://ecl.informationbuilders.com/jschart/bicycle.png
The symbol settings are shown in the following image.

```
Symbol Settings
Use: Single
Color
Size: Width 30 Height 20
Shape/Image: Image
Image Source: http://ecl.informationbuilders.com,...
Image Angle: 45
```

Run the HTML page. The output is shown in the following image.
Configuring Symbology for a Point Data Layer

Configuring Point Symbology Using Color

When you select Color in the Symbol Settings Use drop-down list of the ESRI Object Settings panel, the markers are colored using a choice of color classification systems, as shown in the following image.

![Symbol Settings Image]

Using Field

**Description.** This is a numeric field in the request whose values will be used by the classification schema to define the class breaks.

**Type of field.** Combo box.

**Populated by.** User.

**User limitations.** User can only select one field. It should be a measure field or numeric.

Number of Classes

**Description.** This is the number of class breaks that will be rendered.

**Type of field.** Combo box.

**Populated by.** User.

**User limitations.** User can only select values 2 through 9. The default is 5.
Note: The map will not render if the data cannot be divided into the number of classes selected. For example, if the data can only be divided into four classes, but five is selected, the map will not render, and a message similar to the one shown in the following image will be displayed.

![Message from webpage]

By

Description. This is the classification scheme to be used for assigning the breaks and ranges.

Type of field. Drop-down list.

Populated by. User.

User limitations. Choices are:

- Natural Jenks, a classification scheme that uses breaks inherent in the data, grouping similar values and maximizing differences between groups. This is the default choice.
- Quantile, a classification scheme in which each class contains an equal number of points.
- Equal Breaks, a classification scheme that breaks the data into equal ranges of values.
- Standard Deviation, a classification scheme that defines the breaks based on the number of standard deviations from the mean.
- Geometrical Breaks, a classification scheme that bases class breaks on intervals that have a geometrical series.

Color Scheme

Description. This lets you select an array of color values, defining the color ramp. The first color will be used to render the minimum data class, and the last color will be used to render the maximum data class.

Type of field. Drop-down list.
Populated by. User.

User limitations. User can only select one color array. The default array uses shades of off-white and green.

Example: Symbolizing Points Using Color

This example symbolizes the points using color. The external WebFOCUS request used to provide the point data is the customer_locations procedure created in Configuring a Map Data Layer on page 894. The geographic role is Point of Interest, and the fields that match the role are LATITUDE/LONGITUDE. This example uses the Natural Jenks color classification scheme based on the COGS_US field, as shown in the following image.
Run the HTML page. The output is shown in the following image.

Configuring Point Symbology Using Size

When you choose Size in the Symbol Settings Use box in the ESRI Object Settings panel, each symbol is sized based on a numeric field in the request. You can also select a single color for the markers, as shown in the following image.
Configuring Symbology for a Point Data Layer

Example: Symbolizing Points Using Size

This example uses the COGS_US field to size the markers and blue to color the markers, as shown in the following image.

The WebFOCUS request that provides the values is customer_locations.fex, described in Configuring a Map Data Layer on page 894. Run the HTML page. The output is shown in the following image.
Configuring Dynamic Point Symbology

When the symbology for points is Dynamic, you can specify columns in the request that provide labels, colors, sizes, and image sources for the points, as shown in the following image.

![Symbol Settings](image)

Descriptions of the fields available when you select *Dynamic* in the Symbol Settings Use drop-down list follow.

**Label**

*Description.* This column will be used to provide the text in the Legend.

*Type of field.* Combo box.

*Populated by.* User.

*User limitations.* User can only select one column in the layer request.

**Color**

*Description.* This column will provide a value for the color of a marker. Any valid color value is accepted for example, RGB, hex, or named. The default is red.

*Type of field.* Combo box.

*Populated by.* User.

*User limitations.* User can only select one column in the layer request. Not supported when the markers are configured as images.

**Size**

*Description.* This column will provide a value for the size of a marker in pixels. The default is 12 and the maximum is 99.

*Type of field.* Combo box.

*Populated by.* User.
User limitations. User can only select one column in the layer request.

Image Source

Description. This column will provide a value for the image used as a marker. The value needs to be a qualified URL. If no image source is specified, the default marker is a circle.

Type of field. Combo box.

Populated by. User.

User limitations. User can only select one column in the layer request.

Once Image symbology is selected, color and size are disabled.

Note: You cannot type characters in the combo boxes for dynamic symbols. You can only select field names.

Example: Using Dynamic Symbols for Points

This example uses dynamic images, sizes, and labels for points.

You can create a request using the Report Canvas or by entering request syntax in the Text Editor. For information about creating a WebFOCUS report request using the Report Canvas, see Creating Reports on page 227.
The following WebFOCUS procedure dynamically defines fields that supply the labels, sizes, and images for the map points. Paste this procedure into the text editor and save it as customer_locations2.fex.

```
DEFINE FILE WF_RETAIL_LITE
SIZE1/I4 = IF COUNTRY_NAME EQ 'United States' THEN 25
ELSE IF COUNTRY_NAME EQ 'France' THEN 20
ELSE IF COUNTRY_NAME EQ 'Japan' THEN 12
ELSE IF COUNTRY_NAME EQ 'Italy' THEN 15
ELSE 10;
LABEL1/A20 = IF COUNTRY_NAME EQ 'United States' THEN 'US'
ELSE IF COUNTRY_NAME EQ 'France' THEN 'France'
ELSE IF COUNTRY_NAME EQ 'Japan' THEN 'Japan'
ELSE IF COUNTRY_NAME EQ 'Italy' THEN 'Italy'
ELSE 'UK';
IMAGE1/A80 = IF COUNTRY_NAME EQ 'United States'
THEN 'http://ecl.informationbuilders.com/jschart/us.gif'
ELSE IF COUNTRY_NAME EQ 'France'
THEN 'http://ecl.informationbuilders.com/jschart/france.gif'
ELSE IF COUNTRY_NAME EQ 'Japan'
THEN 'http://ecl.informationbuilders.com/jschart/japan.gif'
ELSE IF COUNTRY_NAME EQ 'Italy'
THEN 'http://ecl.informationbuilders.com/jschart/italy.gif'
ELSE 'http://ecl.informationbuilders.com/jschart/uk.gif';
END

TABLE FILE WF_RETAIL_LITE
SUM
WF_RETAIL_LITE.WF_RETAIL_CUSTOMER.ID_CUSTOMER
WF_RETAIL_LITE.WF_RETAIL_SALES.COGS_US
QUANTITY_SOLD
LABEL1 SIZE1 IMAGE1
COMPUTE LONGITUDE/D12.2 = CUSTOMER_LONGITUDE;
COMPUTE LATITUDE/D12.2 = CUSTOMER_LATITUDE;
BY COUNTRY_NAME
BY WF_RETAIL_LITE.WF_RETAIL_CUSTOMER.ID_CUSTOMER NOPRINT
WHERE COUNTRY_NAME EQ 'United States' OR 'France' OR 'Italy' OR 'Japan' OR 'United Kingdom';
ON TABLE NOTOTAL
ON TABLE PCHOLD FORMAT XML
END
```
Add this request to the HTML page using the Requests & Data Sources panel. Then configure the ESRI Object Settings panel to use this request for the Customer layer. Configure the symbol settings by selecting the appropriate fields from the request, as shown in the following image.

The output is shown in the following image, after zooming in to fill the frame. The Legend is toggled on to show the labels, sizes, and images used.
Configuring Unique Symbology for Points

When you configure Unique symbology, you can display a different shape or image for each value of an alphanumeric dimension field in the request.

The following image shows the Symbol Settings properties for Unique symbology in the ESRI Object Settings panel.

Descriptions of the fields for unique symbology for points follow.

**Using Field**

**Description.** Is an alphanumeric dimension field in the request whose values will determine the shape or image to use.

**Type of field.** Combo box.

**Populated by.** User.

**User limitations.** Must be an alphanumeric dimension field in the request.

**Size**

**Description.** Is the size of a marker in pixels for a standard shape. For an image, size consists of separate values for Width and Height. The default is 12 and the maximum is 99.
Type of field. Text box.

Populated by. User.

User limitations. Must be a measure field in the request.

Shape / Image

Description. Indicates which type of marker to use, a standard shape or an image file.

Type of field. Drop-down list.

Populated by. User.

User limitations. All values must use the same type of marker.

Values

Description. This is the list of values for the Using Field. You can select any value and click the arrow keys to move it between the original list box and the user-selected values list box. Any values not in the user-selected list will display with default markers.

Type of field. List box.

Populated by. System.

User limitations. The user can select values from the system-generated list.

Label

Description. For each value selected, you can enter a label to display in the legend.

Type of field. Text box.

Populated by. User.

User limitations. User can enter a single label for each value of the Using Field.

Color

Description. For each value selected, you can select a marker color. The default is red. Note that color is disabled if the type of marker is image.

Type of field. Color picker.

Populated by. User.

User limitations. User can select a single color for each value of the Using Field.

Shape

Description. For each value selected, you can select a standard shape and its properties (color, outline color, outline thickness, and outline style).

Type of field. Drop-down list.
Populated by. System defined.

User limitations. User can select a single shape and its properties for each value of the Using Field. Choices are:

Shape Values

☐ Circle. This is the default shape.

☐ Diamond.

☐ Cross.

☐ Square.

☐ X.

Color. The default marker color is red.

Outline Color. The default outline color is gray85.

Outline Thickness. Is the thickness of the outline in pixels. The default value is 1.

Outline Style. Select one of the following outline styles.

☐ Solid (default).

☐ Dashes.

☐ Dash-dot.

☐ Dash-dot-dot.

☐ Dots.

☐ Long dashes.

☐ Long dash-dot.

☐ None.

☐ Short dashes.

☐ Short dash-dot.

☐ Short dash-dot-dot.

☐ Short dots.
Image Source

Description. For each value selected, specify an image file. This file must have a valid image format.

Type of field. Text box with Browse to button.

Populated by. User.

User limitations. User can specify a single image file for each value of the Using Field. It can be a path to a file accessible by the user PC or a URL reference. This file must have a valid image format.

Example: Configuring Unique Image Symbology for Points

This example configures a unique image for the markers for each country name.

Configure the map to use the customer_locations2 procedure and the Point of Interest geographic role in the ESRI Object Settings panel. Configure the unique symbology to use the COUNTRY_NAME field, as shown in the following image.

Move the values of the COUNTRY_NAME field to the right using the > arrow and configure them as follows.

For France, enter France in the Label box and enter the following in the Image Source box:

http://ecl.informationbuilders.com/jschart/france.gif

For Italy, enter Italy in the Label box and enter the following in the Image Source box:

http://ecl.informationbuilders.com/jschart/italy.gif
For Japan, enter Japan in the Label box and enter the following in the Image Source box:
http://ecl.informationbuilders.com/jschart/japan.gif

For the United Kingdom, enter UK in the Label box and enter the following in the Image Source box:
http://ecl.informationbuilders.com/jschart/uk.gif

For the United States, enter US in the Label box and enter the following in the Image Source box:
http://ecl.informationbuilders.com/jschart/us.gif

The output is shown in the following image, after zooming in to fill the frame. The Legend is toggled on to show the labels, sizes, and images used.
Configuring Symbology for a Polygon Data Layer

When the geographic data defines polygons, the areas on the map representing each polygon can be colored based on several classification schemes and can have an outline that consists of a color, a thickness, and a line style and a fill style.

The following image shows the Symbol Settings section of the ESRI Object Settings panel for a polygon-based layer. Some selections may open additional options not shown in this image. 
The following table summarizes the types of symbology available for a polygon layer. Each type of symbology is illustrated in one of the sections that follows.

<table>
<thead>
<tr>
<th>Type of Symbol</th>
<th>Description</th>
<th>Configuration Fields</th>
</tr>
</thead>
</table>
| Single         | User selects a single color, outline color, outline thickness, and outline style for the polygons. | **Use.** Selects the type of symbols, Single for this option.  
**Color.** User selects a polygon fill color. The default is red.  
**Outline Color.** User selects a color for the borders around the polygons. The default is gray.  
**Outline Thickness.** User specifies a thickness in pixels for the polygon borders. The default is 1.  
**Outline Style.** User selects one of the following polygon border styles:  
- Solid (default)  
- None  
- Dot  
- Dash  

For more information, see Configuring Polygon Symbology Using a Single Color on page 1034.
<table>
<thead>
<tr>
<th>Type of Symbol</th>
<th>Description</th>
<th>Configuration Fields</th>
</tr>
</thead>
</table>
| Color         | User specifies a field to be used to classify polygon colors. | **Use.** Selects the type of symbols, *Color* for this option.  
**Using Field.** User selects a field in the request to be used to classify the polygons by color.  
**By.** User selects from the following classification methods.  
- Natural Jenks (the default).  
- Quantile.  
- Equal Breaks.  
- Standard Deviation.  
- Geometrical Breaks.  
**Number of Classes.** User specifies the number of color breaks. The default is 5.  
**Color Scheme.** User selects the color palette for the polygons. The default uses shades of green.  
For more information, see *Configuring Polygon Symbology Using Color* on page 1044. |
| Dynamic       | The WebFOCUS request that provides the location dimension defines the polygon properties. | **Use.** Selects the type of symbols, *Dynamic* for this option.  
**Label.** User specifies a field in the request that contains the label text to display in the legend. The default is the AS name, title, or field name.  
**Color.** User specifies a field in the request that defines the fill colors of the polygons.  
For more information, see *Configuring Dynamic Polygon Symbology* on page 1047. |
<table>
<thead>
<tr>
<th>Type of Symbol</th>
<th>Description</th>
<th>Configuration Fields</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unique</td>
<td>User selects polygon properties for each value of a dimension in the request.</td>
<td><strong>Use.</strong> Selects the type of symbols, <em>Unique</em> for this option.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Using Field.</strong> User selects an alphanumeric dimension in the request and assigns polygon properties for each value.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Dimension Values box.</strong> A box is populated with the dimension values. The user can select values and move them to the right, then assign polygon properties to those selected values.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Label.</strong> User specifies text to display in the legend for each selected dimension value.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Color.</strong> User selects a polygon fill color for each selected dimension value. The default value is red.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Outline Color.</strong> User selects a polygon border color for each selected dimension value. The default value is gray.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Outline Thickness.</strong> User specifies a polygon border thickness in pixels for each selected dimension value. The default value is 1.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Outline Style.</strong> User selects a polygon border style (Solid, None, Dot, Dash) for each selected dimension value. The default value is Solid.</td>
</tr>
</tbody>
</table>

For more information, see *Configuring Unique Symbology for Polygons* on page 1037.
Configuring Polygon Symbology Using a Single Color

The default symbology for a polygon data layer is to color the polygons red with a light gray, 1-pixel solid outline, as shown in the following image.

You can change the color for the polygon, the color for the outline, the thickness of the outline, the line style for the outline, and a fill style for the polygon.

The following fields are available when you use Single as the symbology setting.

**Color**

*Description.* Opens a color picker dialog box that lets you select a color for the polygons. You can select from a palette, select a named string, select a system color, or create a custom color, and set this color instance to that value.

*Type of field.* Color value.

*Populated by.* User.

*User limitations.* User can browse to a single color. The default is red.

**Outline Color**

*Description.* Opens a color picker dialog box that lets you select a color for to outline the polygons. You can select from a palette, select a named string, select a system color, or create a custom color, and set this color instance to that value.

*Type of field.* Color value.

*Populated by.* User.

*User limitations.* User can browse to a single color. The default is light gray.
Outline Thickness

**Description.** Is a thickness for the outline in pixels.

**Type of field.** Integer.

**Populated by.** User.

**User limitations.** User can enter a single number. The default is 1.

Outline Style

**Description.** Is the style of the polygon outline.

**Type of field.** Drop-down list.

**Populated by.** User.

**User limitations.** Choices are:

- Solid (this is the default value).
- None.
- Dot.
- Dash.

Fill Style

**Description.** Is the fill style of the polygon.

**Type of field.** Drop-down list.

**Populated by.** User.

**User limitations.** Choices are:

- Backward Diagonal.
- Cross.
- Diagonal Cross.
- Forward Diagonal.
- Horizontal.
- None.
- Solid (this is the default value).
Note: The hatch patterns are images from Esri whose color cannot be altered using the Settings panel.

**Example:** Using Single Symbology for Polygons

This example makes the polygons blue and the outline a dashed light blue line. The WebFOCUS request used is customer_states, as described in *Configuring a Map Data Layer* on page 894. Add this request to the HTML page in the Requests & Data Sources panel.

Configure the map layer to use the customer_states procedure described in *Configuring a Map Data Layer* on page 894. The geographic role is US state (Name), and the field that matches the role is STATE_PROV_NAME. Configure the Symbol Settings in the ESRI Object Settings panel as shown in the following image, by clicking the *Color* field and selecting a dark blue color, clicking the *Outline Color* field and selecting a light blue color, and selecting *Dash* from the *Outline Style* drop-down list.

![Symbol Settings](image-url)
Run the HTML page. The output is shown in the following image.

Configuring Unique Symbology for Polygons

When you configure Unique symbology, you can display a different color for each value of an alphanumeric dimension field in the request. This is a good technique for defining categories.
The following image shows the Symbol Settings properties for Unique symbology in the ESRI Object Settings pane.

![Symbol Settings](image)

Descriptions of the fields for unique symbology for polygons follow.

**Using Field**

**Description.** Is an alphanumeric dimension field in the request whose values will determine the shape or image to use.

**Type of field.** Combo box.

**Populated by.** User.

**User limitations.** Must be an alphanumeric dimension field in the request.

**Values**

**Description.** This is the list of values for the Using Field. You can select any value and click the arrow keys to move them between the original list box and the user-selected values list box. Any values not in the user-selected list will display with default colors.

**Type of field.** List box.

**Populated by.** System.
User limitations. The user can select values from the system-generated list.

Label
Description. For each value selected, you can enter a label to display in the legend.
Type of field. Text box.
Populated by. User.

User limitations. User can enter a single label for each value of the sing Field.

Color
Description. For each value selected, you can select a polygon color. The default is red.
Type of field. Color picker.
Populated by. User.

User limitations. User can select a single color for each value of the Using Field.

Outline Color
Description. For each value selected, you can select a color for the polygon outline. The default is light gray.
Type of field. Color picker.
Populated by. User.

User limitations. User can select a single color for each value of the Using Field.

Outline Thickness
Description. Is a thickness for the outline in pixels.
Type of field. Integer.
Populated by. User.

User limitations. User can enter a single number. The default is 1.

Outline Style
Description. Is the style of the polygon outline.
Type of field. Drop-down list.
Populated by. User.

User limitations. Choices are:
☐ Solid (this is the default value).
Fill Style

**Description.** Is the fill style of the polygon.

**Type of field.** Drop-down list.

**Populated by.** User.

**User limitations.** Choices are:

- None.
- Dot.
- Dash.
- Backward Diagonal.
- Cross.
- Diagonal Cross.
- Forward Diagonal.
- Horizontal.
- Solid (this is the default value).
- Vertical.

**Note:** The hatch patterns are images from Esri whose color cannot be altered using the Settings panel.

**Example:** Configuring Unique Color Symbology for Polygons

This example configures a unique color for the polygons for each US region.

You can create a request using the Report Canvas or by entering request syntax in the Text Editor. For information about creating a WebFOCUS report request using the Report Canvas, see *Creating Reports* on page 227.
Following is the syntax for a WebFOCUS request that defines regions based on state names. Paste this request into the text editor and save it as customer_states4.

```
DEFINE FILE WF_RETAIL_LITE
STATE/A20 = STATE_PROV_NAME;
REGION/A10 = IF STATE EQ 'Connecticut' OR 'Maine' OR 'Massachusetts' OR 'New Hampshire' OR 'Rhode Island' OR 'Vermont' OR 'New Jersey' OR 'New York' OR 'Pennsylvania' THEN 'Northeast'
ELSE IF STATE EQ 'Illinois' OR 'Indiana' OR 'Michigan' OR 'Ohio' OR 'Wisconsin' OR 'Iowa' OR 'Kansas' OR 'Minnesota' OR 'Missouri' OR 'Nebraska' OR 'North Dakota' OR 'South Dakota' THEN 'Midwest'
ELSE IF STATE EQ 'Delaware' OR 'Florida' OR 'Georgia' OR 'Maryland' OR 'North Carolina' OR 'South Carolina' OR 'Virginia' OR 'Washington D.C.' OR 'West Virginia' OR 'Alabama' OR 'Kentucky' OR 'Mississippi' OR 'Tennessee' OR 'Arkansas' OR 'Louisiana' OR 'Oklahoma' OR 'Texas' THEN 'South' ELSE 'West';
END
TABLE FILE WF_RETAIL_LITE
SUM QUANTITY_SOLD
BY REGION
BY STATE_PROV_NAME
WHERE COUNTRY_NAME EQ 'United States'
ON TABLE PCHOLD FORMAT XML
END
```
Configure the map layer to use this request in the ESRI Object Settings panel. The geographic role is US state (Name), and the field that matches the role is STATE_PROV_NAME. Configure the unique symbol settings using the REGION field, as shown in the following image.
Move each region value to the right using the > arrow, and configure the following entries and selections for each:

For Northeast, enter *Northeast* in the Label box and select a green polygon color from the color picker.

For West, enter *West* in the Label box and select a blue polygon color from the color picker.

For South, enter *South* in the Label box and leave the polygon color as red.

For Midwest, enter *Midwest* in the Label box and select and orange polygon color from the color picker.

Run the HTML page. The output is shown in the following image. The table of contents is open to show the labels and colors.
**Configuring Polygon Symbology Using Color**

When you select *Color* in the Symbol Settings Use drop-down list of the ESRI Object Settings panel, the polygons are colored using a choice of color classification systems, as shown in the following image.

![Symbol Settings Use drop-down list](image.png)

**Using Field**

- **Description.** This is a numeric field in the request whose values will be used by the classification schema to define the class breaks.
- **Type of field.** Combo box.
- **Populated by.** User.
- **User limitations.** User can only select one field. It should be a measure field or numeric.

**Number of Classes**

- **Description.** This is the number of class breaks that will be rendered.
- **Type of field.** Combo box.
- **Populated by.** User.
- **User limitations.** User can only select values 2 through 9. The default is 5.
**Note:** The map will not render if the data cannot be divided into the number of classes selected, and a message similar to the one shown in the following image will display.

![Message from webpage]

Class Break Renderer [error]: For the selected field, the number of classes must be less than 4

**By**

**Description.** This is the classification scheme to be used for assigning the breaks and ranges.

**Type of field.** Drop-down list.

**Populated by.** User.

**User limitations.** Choices are:

- **Natural Jenks**, a classification scheme that uses breaks inherent in the data, grouping similar values and maximizing differences between groups. This is the default choice.
- **Quantile**, a classification scheme in which each class contains an equal number of points.
- **Equal Breaks**, a classification scheme that breaks the data into equal ranges of values.
- **Standard Deviation**, a classification scheme that defines the breaks based on the number of standard deviations from the mean.
- **Geometrical Breaks**, a classification scheme that bases class breaks on intervals that have a geometrical series.

**Color Scheme**

**Description.** This lets you select an array of color values, defining the color ramp. The first color will be used to render the minimum data class, and the last color will be used to render the maximum data class.

**Type of field.** Drop-down list.

**Populated by.** User.
User limitations. User can only select one color array. The default array uses shades of off white and green.

Example: Symbolizing Polygons Using Color

This example uses the Natural Jenks color classification scheme based on the QUANTITY_SOLD field, as shown in the following image. The WebFOCUS request that provides the point data is the customer_states4 procedure. The geographic role is US state (Name), and the field that matches this role is STATE_PROV_NAME.

![Symbol Settings](image)

Run the HTML page. The output is shown in the following image.
Configuring Dynamic Polygon Symbology

When the symbology for polygons is Dynamic, you can specify columns in the request that provide labels and colors for the polygons, as shown in the following image.

![Symbol Settings](image)

Descriptions of the fields available when you select Dynamic in the Symbol Settings Use drop-down list follow.

**Label**

*Description.* This column will be used to depict values in the Legend.

*Type of field.* Combo box.

*Populated by.* User.

*User limitations.* User must select one column in the layer request.

**Color**

*Description.* This column will provide a value for the color of a polygon. The default is red.

*Type of field.* Combo box.

*Populated by.* User.

*User limitations.* User can only select one column in the layer request.

**Note:**

- Dynamic symbology automatically creates an *Other* category that is symbolized using a pink color. With the Edge browser, the *Other* category does not show the default pink color, but shows a white outline instead.

- You cannot type characters in the combo boxes for dynamic symbols, you can only select field names.
**Example: Using Dynamic Symbols for Polygons**

This example uses dynamic colors and labels for polygon.

You can create a request using the Report Canvas or by entering request syntax in the Text Editor. For information about creating a WebFOCUS report request using the Report Canvas, see *Creating Reports* on page 227.

The following WebFOCUS procedure defines fields that supply the color and label for each country. Paste this procedure into the text editor and save it as customer_countries.fex.

```webfocus
define file wf_retail_lite
  color/a10 = if country_name eq 'United States' then 'blue'
  else if country_name eq 'France' then 'red'
  else if country_name eq 'Italy' then 'green'
  else if country_name eq 'Japan' then 'black'
  else 'purple';
label/a20 = if country_name eq 'United States' then 'US'
  else if country_name eq 'France' then 'France'
  else if country_name eq 'Japan' then 'Japan'
  else if country_name eq 'Italy' then 'Italy'
  else 'UK';
end
table file wf_retail_lite
  sum
    cogs_us
    quantity_sold
  label
    color
  by country_name
where country_name eq 'United States' or 'France' or 'Italy' or 'Japan'
  or 'United Kingdom';
on table nototal
on table pchold format xml
end
```

Configuring Symbology for a Polygon Data Layer
Add this request to the Customer Layer using the Requests & Data Sources panel. Then configure the map layer to use this request. The geographic role is Country (Name), and the field that matches this role is COUNTRY_NAME. Configure the Symbol Settings section of the ESRI Object Settings panel by selecting the appropriate fields from the request, as shown in the following image. The Label is taken from the Label field in the request, and the Color is taken from the COLOR field in the request.

Run the HTML page. The output, zoomed in to fit the frame, is shown in the following image. The Legend is toggled on to show the labels, sizes, and colors used.

Configuring Symbology for a Line Data Layer

Geographical line data places lines on the map layer that can be configured with a wide range of size, color, and thickness options.
The following image shows the Symbol Settings section of the ESRI Object Settings panel for a point-based data layer. Some selections may open additional options not shown in this image.

The following table summarizes the types of symbology available for a line layer. Each type of symbology is illustrated in one of the sections that follows.

<table>
<thead>
<tr>
<th>Type of Symbol (Subtype)</th>
<th>Description</th>
<th>Configuration Fields</th>
</tr>
</thead>
</table>
| Single                  | Uses a single line | **Use.** Selects the type of symbols, *Single* for this option.  
**Color.** User selects a line color. The default is red.  
**Thickness.** User specifies the line thickness in pixels. The default is 12 and the maximum is 99.  
**Style.** User selects one of the following line styles:  
- Solid (default)  
- Dashes  
- Dash-dot  
- Dash-dot-dot  
- Dots  
- None  
For more information, see *Configuring Line Symbology Using a Single Line Symbol* on page 1054. |
<table>
<thead>
<tr>
<th>Type of Symbol (Subtype)</th>
<th>Description</th>
<th>Configuration Fields</th>
</tr>
</thead>
</table>
| Color                   | User specifies a field to be used to classify line colors. | **Use.** Selects the type of symbols, *Color* for this option.  
**Using Field.** User selects a field in the request to be used to classify the lines by color.  
**By.** User selects from the following classification methods.  
- Natural Jenks (the default).  
- Quantile.  
- Equal Breaks.  
- Standard Deviation.  
- Geometrical Breaks.  
**Number of Classes.** User specifies the number of color breaks. The default is 5.  
**Color Scheme.** User selects the color palette for the lines. The default uses shades of green.  
**Thickness.** User specifies the line thickness in pixels. The default is 1 and the maximum is 99.  
For more information, see [Configuring Line Symbology Using Color](#) on page 1055.
<table>
<thead>
<tr>
<th>Type of Symbol (Subtype)</th>
<th>Description</th>
<th>Configuration Fields</th>
</tr>
</thead>
</table>
| Thickness              | User specifies a field to be used to classify the thickness of the lines. | **Use.** Selects the type of symbols, *Thickness* for this option.  
**Using Field.** User selects a field in the request to be used to classify the lines by thickness.  
**Color.** User selects a color for the lines.  
**Minimum.** Specifies the minimum thickness. The default is 1.  
**Maximum.** Specifies the maximum thickness. The default is 10.  
For more information, see *Configuring Line Symbology Using Thickness* on page 1063. |
| Dynamic                | The WebFOCUS request that provides the location dimension defines the line properties. | **Use.** Selects the type of symbols, *Dynamic* for this option.  
**Label.** User specifies a field in the request that contains the label text for the legend. The default is the AS name, title, or field name.  
**Color.** User specifies a field in the request that defines the colors for the markers.  
**Size.** User specifies a field in the request that defines the thickness in pixels for the lines. The default is 12 and the maximum is 99.  
**Style.** User specifies a field in the request that contains styles for the lines.  
For more information, see *Configuring Dynamic Line Symbology* on page 1066. |
<table>
<thead>
<tr>
<th>Type of Symbol (Subtype)</th>
<th>Description</th>
<th>Configuration Fields</th>
</tr>
</thead>
</table>
| Unique                  | User selects line properties for each value of a dimension in the request. | **Use.** Selects the type of symbols, *Unique* for this option.  
**Using Field.** User selects an alphanumeric dimension in the request and assigns marker properties for each value.  
**Thickness.** User specifies a thickness in pixels for the lines. The default is 12 and the maximum is 99.  
**Dimension Values box.** A box is populated with the dimension values. The user can select values and move them to the right, then assign line properties to those selected values.  
**Label.** User specifies text to display in the legend for each selected dimension value.  
**Color.** The user selects a color for each selected dimension value.  
**Style.** The user selects a line style for each selected dimension value.  
For more information, see *Configuring Unique Symbology for Lines* on page 1059. |

**Note:** The symbol dynamically changes size with the zoom level of the map output for a single symbol, but not for a symbol that is unique, dynamic, based on thickness, or based on color.
Configuring Line Symbology Using a Single Line Symbol

The default symbol used for lines is a 12-pixel thick solid red line, as shown in the following image.

![Symbol Settings](image)

You can open a color picker dialog box by clicking the Color field, can enter a size in pixels, and select a different style (dashes, dash-dot, dash-dot-dot, or dots). The maximum size supported is 99.

**Example:** Configuring Line Symbology Using a Single Line Symbol

This example uses blue dashed line symbol that is three pixels thick. The following image shows the symbol settings.

The external WebFOCUS request used to provide the point data is the citibike_tripdata_line1 procedure created in *Configuring a Geometry Line Layer* on page 902. The geographic role is Geometry line, and the field that matches the role is CONNECTION_LINE_A.
Run the HTML page. The output is shown in the following image.

Configuring Line Symbology Using Color

When you select Color in the Symbol Settings Use drop-down list of the ESRI Object Settings panel, the lines are colored using a choice of color classification systems, as shown in the following image.

Using Field

**Description.** This is a numeric field in the request whose values will be used by the classification schema to define the class breaks.
Type of field. Combo box.

Populated by. User.

User limitations. User can only select one field. It should be a measure field or numeric.

Number of Classes

Description. This is the number of class breaks that will be rendered.

Type of field. Combo box.

Populated by. User.

User limitations. User can only select values 2 through 9. The default is 5.

Note: The map will not render if the data cannot be divided into the number of classes selected. For example, if the data can only be divided into four classes, but five is selected, the map will not render and a message similar to the one shown in the following image will display.

![Message from webpage](image)

Class Break Renderer [error]: For the selected field, the number of classes must be less than 4

By

Description. This is the classification scheme to be used for assigning the breaks and ranges.

Type of field. Drop-down list.

Populated by. User.

User limitations. Choices are:

- **Natural Jenks**, a classification scheme that uses breaks inherent in the data, grouping similar values and maximizing differences between groups. This is the default choice.

- **Quantile**, a classification scheme in which each class contains an equal number of points.

- **Equal Breaks**, a classification scheme that breaks the data into equal ranges of values.
- **Standard Deviation**, a classification scheme that defines the breaks based on the number of standard deviations from the mean.

- **Geometrical Breaks**, a classification scheme that bases class breaks on intervals that have a geometrical series.

### Color Scheme

**Description.** This lets you select an array of color values, defining the color ramp. The first color will be used to render the minimum data class, and the last color will be used to render the maximum data class.

**Type of field.** Drop-down list.

**Populated by.** User.

**User limitations.** User can only select one color array. The default array uses shades of off-white and green.

### Thickness

**Description.** This lets you enter a thickness in pixels for the lines. The default value is 1 and the maximum is 99.

**Type of field.** Text Box.

**Populated by.** User.

**User limitations.** User enter only an integer value from 1 to 99.
**Example:** Symbolizing Lines Using Color

This example symbolizes the lines using color. The external WebFOCUS request used to provide the point data is the citibike_tripdata_line1 procedure created in *Configuring a Geometry Line Layer* on page 902. The geographic role is Geometry line, and the field that matches the role is CONNECTION_LINE_A. This example uses the Natural Jenks color classification scheme based on the GENDER field, as shown in the following image. Note that the Number of classes is 3, as that is the number of values for gender in the data. Using the default number, 5, would generate an error.
Run the HTML page. The output is shown in the following image.

Configuring Unique Symbology for Lines

When you configure Unique symbology, you can display a different line style for each value of an alphanumeric dimension field in the request.
The following image shows the Symbol Settings properties for Unique symbology in the ESRI Object Settings pane.

![Symbol Settings properties for Unique symbology](image)

Descriptions of the fields for unique symbology for lines follow.

**Using Field**

- **Description.** Is an alphanumeric dimension field in the request whose values will determine the line style to use.
- **Type of field.** Combo box.
- **Populated by.** User.
- **User limitations.** Must be an alphanumeric dimension field in the request.

**Thickness**

- **Description.** Is the thickness of a line in pixels. The default is 12 and the maximum is 99.
- **Type of field.** Text box.
- **Populated by.** User.
- **User limitations.** Must be a measure field in the request.

**Values**

- **Description.** This is the list of values for the Using Field. You can select any value and click the arrow keys to move it between the original list box and the user-selected values list box. Any values not in the user-selected list will display with default line styles.
Type of field. List box.

Populated by. System.

User limitations. The user can select values from the system-generated list.

Label

Description. For each value selected, you can enter a label to display in the legend.

Type of field. Text box.

Populated by. User.

User limitations. User can enter a single label for each value of the Using Field.

Color

Description. For each value selected, you can select a line color. The default is red.

Type of field. Color picker.

Populated by. User.

User limitations. User can select a single color for each value of the Using Field.

Style

Description. For each value selected, you can select a standard line style.

Type of field. Drop-down list.

Populated by. System defined.

User limitations. User can select a single shape for each value of the Using Field. Choices are:

- Solid. This is the default style.
- Dashes.
- Dash-dot.
- Dash-dot-dot.
- Dots.

Example: Configuring Unique Symbology for Lines

This example configures a unique style for the lines for each gender value.
Configure the map to use the citibike_tripdata_line1 procedure and the Geometry line geographic role in the ESRI Object Settings panel. Configure the unique symbology to use the GENDER field, as shown in the following image.
Move the values of the GENDER field to the right using the > arrow, enter a label and select a color and line style for each.

The output is shown in the following image. The Legend is toggled on to show the labels, and line styles used.

**Configuring Line Symbology Using Thickness**

When you choose *Thickness* in the Symbol Settings Use box in the ESRI Object Settings panel, each line has a thickness based on a numeric field in the request. You can also select a single color for the lines, as shown in the following image.
Descriptions of the fields for unique symbology for lines follow.

**Using Field**

*Description.* Is a numeric field in the request whose values will determine the line thickness to use.

*Type of field.* Combo box.

*Populated by.* User.

*User limitations.* Must be a numeric field in the request.

**Color**

*Description.* Is a line color. The default is red.

*Type of field.* Color picker.

*Populated by.* User.

*User limitations.* User can select a single color.

**Minimum**

*Description.* Is the minimum thickness to be used

*Type of field.* Text box.

*Populated by.* User.

*User limitations.* The user can enter a value from 1 to 99. The default value is 1.

**Maximum**

*Description.* Is the maximum thickness to be used

*Type of field.* Text box.

*Populated by.* User.

*User limitations.* The user can enter a value from 1 to 99. The default value is 10.
Example: Symbolizing Lines Using Thickness

This example uses the GENDER field to thicken the lines and green to color the lines, as shown in the following image.

The WebFOCUS request that provides the values is citibike_tripdata_line1.fex, described in Configuring a Geometry Line Layer on page 902. Run the HTML page. The output is shown in the following image.
Configuring Dynamic Line Symbology

When the symbology for lines is Dynamic, you can specify columns in the request that provide labels, colors, sizes, and line styles for the lines, as shown in the following image.

![Symbol Settings](image)

Descriptions of the fields available when you select Dynamic in the Symbol Settings Use dropdown list follow.

**Label**

*Description.* This column will be used to provide the text in the Legend.

*Type of field.* Combo box.

*Populated by.* User.

*User limitations.* User can only select one column in the layer request.

**Color**

*Description.* This column will provide a value for the color of a marker. Any valid color value is accepted for example, RGB, hex, or named. The default is red.

*Type of field.* Combo box.

*Populated by.* User.

*User limitations.* User can only select one alphanumeric column in the layer request.

**Size**

*Description.* This column will provide a value for the thickness of a line in pixels. The default is 12 and the maximum is 99.

*Type of field.* Combo box.

*Populated by.* User.

*User limitations.* User can only select one numeric column in the layer request.
**Style**

**Description.** This column will provide a value for the style of the line. The default style is Solid.

**Type of field.** Combo box.

**Populated by.** User.

**User limitations.** User can only select one alphanumeric column in the layer request.

Valid values in the field have the prefix `STYLE_` followed by the combination of line styles you want with no separators. For example, `STYLE_LONGDASHDOT` for long dashes followed by dots.

**Note:** You cannot type characters in the combo boxes for dynamic symbols. You can only select field names.

**Example: Using Dynamic Symbols for Lines**

This example uses dynamic colors, sizes, labels, and styles for lines.

You can create a request using the Report Canvas or by entering request syntax in the Text Editor. For information about creating a WebFOCUS report request using the Report Canvas, see *Creating Reports* on page 227.
The following WebFOCUS procedure dynamically defines fields that supply the colors, styles, and sizes for the map lines. Paste this procedure into the text editor and save it as citibike_tripdata_line2.fex.

```cobol
DEFINE FILE esri8203/201709_citibike_tripdata
COLOR/A10 = IF GENDER EQ 0 THEN ©blue©
ELSE IF GENDER EQ 1 THEN ©red©
ELSE ©green©;
SIZE/I2 = IF GENDER EQ 0 THEN 2
ELSE IF GENDER EQ 1 THEN 4
ELSE 6;
STYLE/A20=DECODE GENDER(0 ©STYLE_DOT© 1 ©STYLE_SHORTDASHDOT© 2 ©STYLE_LONGDASH© ELSE ©STYLE_SOLID©);
END

TABLE FILE esri8203/201709_citibike_tripdata
PRINT  BIKE_PATH_ID
BY TRIPDURATION
BY GENDER
BY START_STATION_NAME AS 'start station name'
BY END_STATION_NAME AS 'end station name'
BY CONNECTION_LINE_A
BY COLOR
BY SIZE
BY STYLE
WHERE END_STATION_LATITUDE NE 0;
WHERE END_STATION_LONGITUDE NE 0;
WHERE START_STATION_NAME EQ 'Newport Pkwy'
ON TABLE PCHOLD FORMAT XML
END
```

Add this request to the HTML page using the Requests & Data Sources panel. Then configure the ESRI Object Settings panel to use this request for the Customer layer. Configure the symbol settings by selecting the appropriate fields from the request, as shown in the following image.
The output is shown in the following image.

![Image of a map with various geo-spatial data visualizations]

**Summary of Symbology and Visualizations by Layer Type**

The following table lists the visualizations available by layer type.

<table>
<thead>
<tr>
<th>Feature Type</th>
<th>Geographic Roles</th>
<th>Available Symbology</th>
<th>Available Visualizations</th>
</tr>
</thead>
<tbody>
<tr>
<td>Point</td>
<td>Latitude/Longitude City</td>
<td>Shape/Image, Color, Size</td>
<td>Popups, Clustering, Heatmap, Popups, Default Visibility, Transparency</td>
</tr>
<tr>
<td>Polygon</td>
<td>State Country Continent Postal Code</td>
<td>Color</td>
<td>Popups, Default Visibility, Transparency</td>
</tr>
</tbody>
</table>
### Feature Type

<table>
<thead>
<tr>
<th>Feature Type</th>
<th>Geographic Roles</th>
<th>Available Symbology</th>
<th>Available Visualizations</th>
</tr>
</thead>
<tbody>
<tr>
<td>Line</td>
<td>Geometry Line</td>
<td>Color, Size, Style</td>
<td>Popups, Default Visibility, Transparency</td>
</tr>
</tbody>
</table>

**Note:** The symbology and visualizations available for custom geographic roles depend on whether they define points or polygons.

### Refreshing Markers on an ESRI Map Without Refreshing the Entire Map

Markers on a Point of Interest layer may be used to represent the positions of objects (such as vehicles or incidents) whose location changes over time. You can update these markers without updating the entire map using the `IbComposer_refreshEsriMapLayer` JavaScript function in a control.

The refresh will do the following:

- Update the locations of the markers without refreshing the map layer or other map layers.
- Maintain the extent (zoom level) of the map layer.
- Maintain the symbols with which the map layer was configured.
- Maintain the visibility of the map layer.
- Allow infoWindows to be opened on click.

### Syntax: How to Refresh Map Markers Without Refreshing the Map

Add the following JavaScript function call to the onclick event of the control created to refresh the markers.

```
IbComposer_refreshEsriMapLayer("mapid", "layerid") ;
```

where:

- **"mapid"**
  - Is a map ID (for example, "emfobject1").

- **"layerid"**
  - Is a layer ID (for example, "Layer1").
Example: Refreshing Markers on an ESRI Map Without Refreshing the Entire Map

The following image shows a map layer that contains a map object and three buttons. The map ID is emfobject1, and the layer ID is Layer1, which are the default IDs.

The WebFOCUS request associated with the map is fed the coordinates of the cars and prints each car ID and its latitude and longitude as the car positions change.

The button labeled Start, whose name is button1, has the IbComposer_refreshEsriMapLayer function call in its onclick event, as shown on the Embedded JavaScript tab.

```javascript
//Begin function button1_onclick
function button1_onclick(event) {
  var eventObject = event ? event : window.event;
  var ctrl = eventObject.target ? eventObject.target : eventObject.srcElement;
  // TODO: Add your event handler code here
  IbComposer_refreshEsriMapLayer("emfobject1", "Layer1")
  //End function button1_onclick
```
The following image shows the map output before the Start button is clicked. The circles that represent the map markers are in their starting positions within the large X’s on the map.

After the Start button is clicked, the markers move on the map, but the map is not refreshed and its zoom and position remain unchanged, as shown in the following image.
Clicking a marker opens its InfoWindow. The values displayed in the InfoWindow update as the marker moves. The following images show an open InfoWindow for the same marker in two different locations.

Retrieving the Esri Map Viewer Current Extent Coordinates as Variables

The current extent of an Esri map can be retrieved as map parameters and used for subsequent filtering of map layers and reports. The extent can be in any coordinate system and must be a simple polygon.

The names of the map extent variables are:

- &MINX, which defines the minimum longitude of the extent.
- &MINY, which defines the minimum latitude of the extent.
- &MAXX, which defines the maximum longitude of the extent.
- &MAXY, which defines the maximum latitude of the extent.
**Example:** Using the Current Extent Parameters in a Map

The following steps create a map with a procedure that shows the markers within the current extent when the map is refreshed.

1. Create a domain named RetailExtent.
2. Right-click the domain, point to New, and click Procedure.
3. Copy the following procedure, paste it into the text editor, and save it as retail_map.fex.

```plaintext
-DEFAULT &MINX=_FOC_NULL
-DEFAULT &MAXX=_FOC_NULL
-DEFAULT &MINY=_FOC_NULL
-DEFAULT &MAXY=_FOC_NULL

DEFINE FILE WF_RETAIL_LITE
LATITUDE = STATE_PROV_CAPITAL_LATITUDE;
LONGITUDE = STATE_PROV_CAPITAL_LONGITUDE;
END

TABLE FILE WF_RETAIL_LITE
PRINT
   ID_CUSTOMER
   QUANTITY_SOLD
   MSRP_US
   FST.LATITUDE
   FST.LONGITUDE

WHERE RECORDLIMIT EQ 250
WHERE COUNTRY_NAME EQ 'United States'
WHERE LATITUDE GE &MINY
WHERE LATITUDE LE &MAXY
WHERE LONGITUDE GE &MINX
WHERE LONGITUDE LE &MAXX
ON TABLE SET PAGE-NUM NOLEAD
ON TABLE SET ASNAMES ON
ON TABLE NOTOTAL
ON TABLE PCHOLD FORMAT XML
ON TABLE SET HTMLEMBEDIMG ON
ON TABLE SET HTMLCSS ON

END
```

This procedure uses WHERE selection tests to show the markers only for the extent that is displayed.
4. Create a new HTML page and add a map object and a button, as shown in the following image.

5. In the Requests & Data Sources panel, open the drop-down menu next to the New icon, point to External Request, and click WebFOCUS Procedure. Select retail_map.fex.

6. Select the map and configure the Settings panel as shown in the following image.
7. In the Requests & Data Sources panel, right-click the retail_map request and select Create Controls for Parameters.

The New Parameters dialog box opens.

8. Right-click the value in the first row of the Control Type column, point to Existing Control, and click emfobject1, as shown in the following image.

9. Click OK.
10. Select the button and in the Tasks & Animations panel create a task that will refresh the map when the button is clicked, as shown in the following image.

11. Save the HTML page.
When you run the page, all of the markers are displayed on the map, as shown in the following image.

Zoom in and click the button. The map will be refreshed and only markers for that extent are displayed, as shown in the following image.

Configuring Maps to Interact With Other Components

Variables in requests and maps can be used as parameters that are passed from one component to other components on an HTML page. When selections are made on one component, other components on the HTML page can be automatically updated to show those same selected values.
A point layer on a map has a unique ID field that App Studio automatically turns into a parameter. When you use that same parameter in a filter in a report or chart component, any selection on the map layer will change the output of the report or chart.

For a polygon layer, you must create the variables to be passed between the map and other components.

A WebFOCUS report or chart request can have drill-down links that select and zoom to points or polygons on a map layer.

**Procedure: How to Update a Request Based on Map Selections**

In order to cause map selections to update a report or chart, you need a parameter in the request that supplies the location dimension for the map, and a matching parameter in the request that will be updated when a selection is made on the map.

**Note:** You can specify whether to rerun the request when the map selections are cleared. For information, see Configuring Whether Selections on a Map Are Required to Run a Request on page 867.

For a point layer using the map unique ID field, the report or chart must have a parameter matching the unique ID parameter automatically generated for the map. For a polygon layer, you can define a parameter in the request that supplies the location dimension for the map.

Once you have the parameter in the request to be updated and the parameter in the map defined, you must bind it to the map object on the Parameters tab by dragging the mouse from the map object to the request parameter, as shown in the following image.

![Diagram showing binding between map object and request parameter](image)

The example used in this section to provide the point data is the customer_locations procedure created in Configuring a Map Data Layer on page 894. The unique ID field is ID_CUSTOMER.
The following version of the request populates a report and contains a parameter named &ID_CUSTOMER. Paste the syntax into the Text Editor and save it as customer_locations2b.fex.

```
-DEFAULT ID_CUSTOMER=FOC_NONE
TABLE FILE WF_RETAIL_LITE
SUM
  ID_CUSTOMER
  COGS_US
  REVENUE_US
  QUANTITY_SOLD
BY COUNTRY_NAME
BY STATE_PROV_NAME
BY ID_CUSTOMER NOPRINT
WHERE ID_CUSTOMER EQ &ID_CUSTOMER
ON TABLE NOTOTAL
ON TABLE SET PAGE NOLEAD
ON TABLE SET STYLE *
INCLUDE=IBFS:/FILE/IBI_HTML_DIR/javaassist/intl/EN/combine_templates/ENWarm.sty,$
ENDSTYLE
END
```

Note that the WHERE condition selects ID_CUSTOMER values that are equal to the &ID_CUSTOMER parameter values. When selections are made on the map, the map component will automatically pass the ID_CUSTOMER values selected to the report component, and the report will update to display those selections only. The -DEFAULT command causes the WHERE test to be ignored when no selection has been made.

The following steps set up the report and the task for updating it.

1. Add an Esri component to the HTML page.
2. Add the customer_locations.fex and customer_locations2b.fex external WebFOCUS requests to the HTML page using the Requests & Data Sources panel.
3. Configure the Esri component to use the Point of Interest geographic role and the customer_locations procedure, as described in Configuring a Map Data Layer on page 894.
4. Add a Frame component next to the map component on the HTML page.
5. With the map component selected, create a new task in the Tasks & Animations panel. Set the following properties for the task.

   - Set the Trigger Type to Selection Changed.
   - For the Trigger, check the map layer whose selections should trigger the task.
   - For Requests/Actions, select Run Request and then customer_locations2b.

   **Note:** The Load task should also run this request so that it is populated as soon as the HTML page is run.
For Target Type, select Frame.

For Target/Template Name, select the name of the frame where customer_locations2b will be run.

The Tasks & Animations panel should look similar to the following:

6. Bind the parameter to the map object on the Parameters tab by dragging the mouse from the map object to the request parameter, as shown in the following image.
Run the HTML page. The output will be similar to the following:

Make a selection on the map using the selection widget. The report updates to show the selected points on the map, as shown in the following image.

**Procedure:** How to Update a Request Based on Map Selections for a Polygon Layer

In order to cause map selections to update a report or chart, the report or chart must have a parameter matching a parameter on the map.

The request used in this example to provide the polygon data is the customer_states3 procedure. It is similar to the customer_states procedure created in Configuring a Map Data Layer on page 894, but it has a variable added to select regions.
The customer_states3 procedure follows:

-DEFAULT REGION = FOC_NONE
DEFINE FILE WF_RETAIL_LITE
STATE/A20 = WF_RETAIL_LITE.WF_RETAIL_GEOGRAPHY_CUSTOMER.STATE_PROV_NAME;
REGION/A10 = IF STATE EQ 'Connecticut' OR 'Maine' OR 'Massachusetts' OR 'New Hampshire' OR 'Rhode Island' OR 'Vermont' OR 'New Jersey' OR 'New York' OR 'Pennsylvania' THEN 'Northeast'
ELSE IF STATE EQ 'Illinois' OR 'Indiana' OR 'Michigan' OR 'Ohio' OR 'Wisconsin' OR 'Iowa' OR 'Kansas' OR 'Minnesota' OR 'Missouri' OR 'Nebraska' OR 'North Dakota' OR 'South Dakota' THEN 'Midwest'
ELSE IF STATE EQ 'Delaware' OR 'Florida' OR 'Georgia' OR 'Maryland' OR 'North Carolina' OR 'South Carolina' OR 'Virginia' OR 'Washington D.C.' OR 'West Virginia' OR 'Alabama' OR 'Kentucky' OR 'Mississippi' OR 'Tennessee' OR 'Arkansas' OR 'Louisiana' OR 'Oklahoma' OR 'Texas' THEN 'South' ELSE 'West';
END
TABLE FILE WF_RETAIL_LITE
SUM QUANTITY_SOLD
BY REGION
BY STATE_PROV_NAME
WHERE REGION EQ &REGION
WHERE COUNTRY_NAME EQ 'United States'
ON TABLE PCHOLD FORMAT XML
END

The DEFINE FILE command defines which states are in which regions. The WHERE phrase for REGION sets the values of the REGION field to the values of the &REGION parameter. When a selection has been made on the map, the parameter values will be passed to a report request. The -DEFAULT command causes the WHERE test to be ignored when no selection has been made.

Paste this syntax into the Text Editor, and save it as customer_states3.fex.
The following version of the request, named customer_states3b, populates a report and also contains a parameter named &REGION. Paste the syntax into the Text Editor and save it as customer_states3b.fex.

```
-DDEFAULT &REGION = FOC_NONE
DEFINE FILE WF_RETAIL_LITE
STATE/A20 = STATE_PROV_NAME;
REGION/A10 = IF STATE EQ 'Connecticut' OR 'Maine' OR 'Massachusetts' OR 'New Hampshire' OR 'Rhode Island' OR 'Vermont' OR 'New Jersey' OR 'New York' OR 'Pennsylvania' THEN 'Northeast'
ELSE IF STATE EQ 'Illinois' OR 'Indiana' OR 'Michigan' OR 'Ohio' OR 'Wisconsin' OR 'Iowa' OR 'Kansas' OR 'Minnesota' OR 'Missouri' OR 'Nebraska' OR 'North Dakota' OR 'South Dakota' THEN 'Midwest'
ELSE IF STATE EQ 'Delaware' OR 'Florida' OR 'Georgia' OR 'Maryland' OR 'North Carolina' OR 'South Carolina' OR 'Virginia' OR 'Washington D.C.' OR 'West Virginia' OR 'Alabama' OR 'Kentucky' OR 'Mississippi' OR 'Tennessee' OR 'Arkansas' OR 'Louisiana' OR 'Oklahoma' OR 'Texas' THEN 'South' ELSE 'West';
END
TABLE FILE WF_RETAIL_LITE
SUM QUANTITY_SOLD
BY REGION AS Region
BY STATE_PROV_NAME
WHERE REGION EQ &REGION
WHERE COUNTRY_NAME EQ 'United States'
ON TABLE SET PAGE NOLEAD
ON TABLE SET STYLE *
INCLUDE=IBFS:/FILE/IBI_HTML_DIR/javaassist/int1/EN/combine_templates/ENWarm.sty,$
ENDSTYLE
END
```

Note that the WHERE condition selects REGION values that are equal to the &REGION parameter values. When selections are made on the map, the map component will pass the REGION values selected to the report component, and the report will update to display those selections only.

The following steps set up the report and the task for updating it.

1. Add an Esri component to the HTML page.
2. Add the customer_states3.fex and customer_states3b.fex external WebFOCUS requests to the HTML page using the Requests & Data Sources panel.
3. Configure the Esri component to use the State geographic role and the customer_states3 procedure. The field that matches the geographic role is STATE_PROV_NAME.
   
   For clarity, the map component has been configured with unique symbology using the REGION field, as described in Configuring Unique Symbology for Polygons on page 1037.
4. Add a Frame component next to the map component on the HTML page.
5. With the map component selected, create a new task in the Tasks & Animations panel.
Set the following properties for the task.

- Set the Trigger Type to *Selection Changed*.
- For the Trigger, check the map layer whose selections should trigger the task.
- For Requests/Actions, select *Run Request* and then *customer_states3b*.

*Note:* The Load task should also run this request so that it is populated as soon as the HTML page is run.

- For Target Type, select *Frame*.
- For Target/Template Name, select the name of the frame where customer_states3b will be run.

The Tasks & Animations panel should look similar to the following:
6. On the parameters tab, make the map parameter populate the report parameter (drag the REGION parameter onto the emfobject1 parameter and back down), as shown in the following image.

Run the HTML page. The output will be similar to the following:
Make a selection on the map using the selection widget. The report updates to show the selected points on the map, as shown in the following image, in which the South and West regions have been selected on the map.

**Syntax:** How to Drill Down From a WebFOCUS Request to Selections on a Map

The JavaScript function `IbComposer_selectEsriMap` can be used in a WebFOCUS StyleSheet to make a selection on a WebFOCUS request and zoom to that selection on a map. The syntax is.

\[
\text{TYPE=DATA,} \\
\text{COLUMN= requestcol,} \\
\text{JAVASCRIPT=} \text{parent.IbComposer_selectEsriMap(} \text{'mapobject'} \text{ 'maplayer'} \text{'mapfield'} \text{ [fieldvalue]})},
\]

where:

- `requestcol`
  - Is a designation for the drilldown column in the request.
- `'mapobject'`
  - Is the object name for the map component that is the target of the drilldown.
- `'maplayer'`
  - Is the name of the map layer that is the target of the drilldown.
'mapfield'

Is the name of the map field that is the target of the drilldown.

'fieldvalue'

Is the field value of the target field, passed from the request when a drill-down link is selected.

**Example:** Creating a Drilldown From a Report to a Map

This example has a report component named customer_states4 that has a drilldown from the REGION field to the map component. The syntax follows. Paste it into the Text Editor and save it as customer_states4.fex.

```
DEFINE FILE WF_RETAIL_LITE
STATE/A20 = WF_RETAIL_LITE.WF_RETAIL_GEOGRAPHY_CUSTOMER.STATE_PROV_NAME;
REGION/A10 = IF STATE EQ ©Connecticut© OR ©Maine© OR ©Massachusetts© OR 'New Hampshire' OR 'Rhode Island' OR 'Vermont' OR 'New Jersey' OR 'New York' OR 'Pennsylvania' THEN 'Northeast'
ELSE IF STATE EQ 'Illinois' OR 'Indiana' OR 'Michigan' OR 'Ohio'
OR 'Wisconsin' OR 'Iowa' OR 'Kansas' OR 'Minnesota' OR 'Missouri'
OR 'Nebraska' OR 'North Dakota' OR 'South Dakota' THEN 'Midwest'
ELSE IF STATE EQ 'Delaware' OR 'Florida' OR 'Georgia' OR 'Maryland'
OR 'North Carolina' OR 'South Carolina' OR 'Virginia' OR 'Washington D.C.' OR 'West Virginia' OR 'Alabama' OR 'Kentucky' OR 'Mississippi' OR 'Tennessee' OR 'Arkansas' OR 'Louisiana' OR 'Oklahoma' OR 'Texas' THEN 'South' ELSE 'West';
END
TABLE FILE WF_RETAIL_LITE
SUM QUANTITY_SOLD
BY REGION
BY STATE
WHERE COUNTRY_NAME EQ ©United States©
ON TABLE SET PAGE NOLEAD
ON TABLE SET STYLE *
INCLUDE=IBFS:/FILE/IBI_HTML_DIR/javaassist/intl/EN/combine_templates/ENWarm.sty,$
TYPE=DATA,

COLUMN=REGION, 
JAVASCRIPT=parent.IbComposer_selectEsriMap(  
'emplobject1' \
'State' \
'REGION' \
REGION \
),

$END
```

The drilldown in the StyleSheet is on the REGION column. It uses the IbComposer_selectEsriMap function to target the map object on the State layer using the REGION field and the REGION values passed from the selected drill-down link.
The map component will use the customer_states3 procedure, as described in the previous example.

Use the following steps to set up the report request and map component.

- Add the customer_states3 and customer_states4 requests to the HTML page in the Requests & Data Sources panel.
- Add a Frame component on the HTML page.
- Set the Load task to run the customer_states4 request in the Tasks & Animation panel, with the target being the frame you created.
- Add a map component next to the report frame on the HTML page. Configure it to use the customer_states3 request, the State geographic role, and the STATE_PROV_NAME field. Name the layer State, as shown in the following image.

The map component in this example has been configured for unique symbology based on the REGION field, as described in Configuring Unique Symbology for Polygons on page 1037.
Run the HTML page. The output should be similar to the following.

Click the Northeast link on the report. The map component zooms to that region with all of the states selected, as shown in the following image.

You can change the selection by clicking another drill-down link on the report. You can also change the extent or clear the selection using the map widgets.

Adding Before Load and After Load Events

You can add JavaScript events to occur before and after a map layer is loaded:

1. Draw an ESRI map component.
2. Add a map layer.
3. Open the Properties panel, click the Events icon to open the list of events, and either double-click Before Load or After Load or select Before Load or After Load and click the ellipsis.

The Embedded JavaScript tab opens with a template for your JavaScript function.

4. Add your JavaScript code.

Every time a layer is ready, meaning that the layer has all its graphics, the event `geometry-complete` is fired. The `afterload` event fires when `geometry-complete` has fired as many times as there are data layers in the application. The `load` event fires after base maps and the first layer (if it exists) have been added to the map (not drawn, just added).

There is a time gap between the time the `afterload` event fires and when you actually see the layer in the map. This time gap is related to the time the map takes to render the layer. So the layer is already in the map, but it has not rendered yet. There is no event that will fire after the layer is finished rendering in the map.

**Configuring Geographic Information**

Geographic roles have been unified to access 58 world administrative boundaries down to the postal code level, out of the box. You can access administrative boundaries for approximately 250 countries with a second level license, which is a paid service from Esri. Enter your second level license code by clicking the License button on the ribbon.

The server has a geographic configuration editor for customizing the list of geographic roles, basemaps, reference layers, and demographic layers. A customized geographic role can reference either an uploaded shapefile or an existing Esri Feature Layer.

**Note:**

- You must configure the Adapter for ESRI ArcGIS in order to use many of the geographic features. For more information on configuring the adapter, see the *Adapter Administration* manual.

- The server must be configured for Unicode.

- To view the list of first and second level administrative boundaries, click *General maps info* on the Geo Services menu. The rows that have the value Paid in the Maps license column describe administrative boundaries available with a second level license. Right-click a column to see information about the data for that geographic role.
Procedure: How to Edit Geographic Configuration Settings

By default, the server is configured for unified geographic roles. This configuration is controlled by the following settings.

1. Navigate to the Workspace page, click Settings, point to Geo Services, and click Edit settings.

The Change Settings for GEO services page opens, as shown in the following image.

2. The following setting controls whether geographic role assignments are automatically assigned using field name analysis.

GEOROLE-AUTO. The default value is On. For example, if an alphanumeric field has the name COUNTRY, it will be assigned the geographic role Country.

3. The following settings control unified geographic roles.

- GEO_UNIFIED_ROLE. This compatibility setting must be turned on (the default) to activate unified geographic roles. Turn it off to use geographic roles from prior releases. On indicates that the new shorter set of geographic roles that combines subsets of previously used roles will be used. Off will use geographic roles from previously shipped releases.

- GEO_MAP_PROVIDER. Assigns names of the providers of geographic maps. The list of names should be separated with slashes to be used by transformation code for mapping. Default is ALL. The currently supported set of providers includes WFRS (geographic boundaries distributed in the Reporting Server) and ESRI.
GEO_ALIASING. On enables aliasing to map administrative entities. Aliasing is a mechanism to support alternative names/spellings to the administrative names used as keys to find the corresponding geometry. Caution, incorrect results will be reported on a map in the case where the column data contains variations of names/spellings for the same administrative entity (resolved to the same key). Alias names are stored in .csv files. Shipped aliasing files are located in the geomaps sub-directory of the etc folder under EDAHOME. The naming convention is geo_srv_dbl_geo_role. Each data file has an associated synonym with the same name. Aliasing is currently supported for the four geo roles COUNTRY, STATE, COUNTY, and CITY. The STATE aliasing data file includes the valid country name for each state. COUNTY and CITY files include valid country and state names. Valid means the actual key value used to fetch a geometry. The default value is off.

GEO_ALIASING_APP. Sets an application name for user-added .csv files with aliases. DEFAULT means no user files. User-added alias data files are supported for the four geo roles COUNTRY, STATE, COUNTY, and CITY (see the description for the GEO_ALIASING setting). The default value is DEFAULT, which uses the server aliasing files.

The best practice is to copy the desired .csv file from the _edahome/etc/geomaps folder to the application folder named in this setting, and edit it, changing aliases or adding records with new ones. There are four focexecs named geo_srv_mapkey_<geo_role> that have mandatory parameter ISO2 country name. The following is a request example that reports city names for South Africa sorted by state/province name.

```
EX geo_srv_mapkey_city ISO2='ZA'
```

Following is an example of user-created records (based on the obtained report):

"South Africa", "Gauteng", "Johannesburg", "City of Johannesburg" "South Africa", "Western Cape", "Paarl", "Drakenstein"

GEO_ALIASING_FIPS. On enables FIPS aliasing to US map administrative entities. This setting requires GEO_ALIASING to be on. The data file with the United State FIPS aliases is processed as an extension to the main aliases data file. The default value is off.

GEO_COUNTRY. Assigns a default value for an automatically added DEFINE field with GEOGRAPHIC_ROLE 'Country'. This mechanism is in effect during the create metadata process when the setting GEOROLE-AUTO is ON and a column with geo role COUNTRY is not detected. The generated DEFINE field will be used to create geo hierarchies required in mapping. The default value is 'United States'.

WebFOCUS App Studio User’s Manual  1093
GEOROLE_2_MBRLEVEL. CUSTOM enables customized per country mapping of the geo roles (STATE, COUNTY, and CITY) to the MBR administrative levels. STANDARD sets uniform mapping of geo roles (STATE, COUNTY, and CITY) for all countries to the MBR administrative levels (1, 3, and 5 respectively). There is a geo_role2mbrlev focexec to list countries with customized admin levels. The report does not depend on this setting.

4. Click Save.

Editing the Geographic Configuration

The GEO configuration editor provides a tool for editing or adding properties for geographic roles, basemaps, reference layers, and demographic layers. In addition, it enables you to add maps and shapefiles to the configuration.

Click Workspace on the sidebar. Click Settings, point to Geo Services, then click Edit Configuration. The GEO configuration editor opens displaying the configured geographic roles, as shown in the following image.

You can select the following objects from the Object drop-down list.

- Role.
- Basemap.
- ContextLayer.

You can edit the properties for a basemap or context layer (reference layer or demographic layer), or add a new one. You cannot edit the properties of a standard geographic role. To add a customized geographic role, you first add an Esri map or a shapefile (WFRS map) and assign the geographic role to the map or shapefile.
Reference: Editing the List of Geographic Roles

The following standard unified geographic roles are configured by default and cannot be changed. These geographic roles create a hierarchy that can be used to drill down or up between levels of administration in maps, reports, or charts.

- CONTINENT.
- COUNTRY.
- STATE.
- COUNTY.
- CITY.
- POSTAL_CODE.

To add a geographic role to the configuration, you can add a new Esri map or a shapefile hosted by the Server and associate a geographic role with the new map. You can also implement NUTS geographic roles support.

Configuring Properties of Geographic Roles

The following describes columns for geographic roles in the configuration editor.

**name**

Is the unique name of the geographic role. It cannot have spaces, but it can have underscores (_).

Next to the name is an indicator of whether the role is a standard role or a customized role.

**title**

Is the description of the geographic role that is displayed in reports and in drop-down lists in the WebFOCUS tools.

**returned_geometry**

Is the type of geographic data returned from the map service for rendering on the map.

Valid values include:

- GEOMETRY_AREA
- GEOMETRY_POINT
- GEOMETRY_LINE
When you have configured the properties, click OK to return to the Geo Configuration Editor. The new role will display on the list of roles. Click Save to save it in the geographic configuration.

**Adding a New Role for an Esri Map**

To add an Esri geographic role, click *Add ESRI map* on the Geographic Configuration Editor. The *Create a new ESRI map role* dialog box opens, as shown in the following image.

![Create a new ESRI map role dialog box](image)

Configure the following map service properties.

**name**

Is a name for the geographic role.

**title**

Is a title to display in the WebFOCUS tools.
returned_geography

Select the type of geometry that is returned from the map service for this role. Valid values are:

- **GEOMETRY_AREA.** Returns JSON polygon definitions.
- **GEOMETRY_LINE.** Returns JSON line definitions.
- **GEOMETRY_POINT.** Returns a JSON point.

url

Is the URL to the map service that provides the geographic data.

Click **Verify** after entering the URL to verify that the map service is available by going to the specified URL.

Service Parameters

Add as parameters any additional geographic roles needed to identify the exact location of the new role. For example, a city name needs state and country parameters.

**Example:** Adding the WebFOCUS Regions Geographic Role

The following properties add the WebFOCUS Regions role to the configuration.

![Image of WebFOCUS Regions properties](image)

**Note:** The **parameter name** corresponds to the field name in the FeatureLayer referenced in the following URL:

http://services7.arcgis.com/L95Wwv90jRQ0tJAs/ArcGIS/rest/services/wfretail_sub_regions/FeatureServer/0

Click **OK** when you have finished configuring the properties.
The new role is added to the configuration as a customized role, as shown in the following image.

Click Save to save this role to the configuration.
The following request uses the WebFOCUS Regions geographic role in a map request.

```plaintext
DEFINE FILE WF_RETAIL_LITE

REGION/A50 (GEOGRAPHIC_ROLE=REGION) = BUSINESS_SUB_REGION;
END

GRAPH FILE WF_RETAIL_LITE
SUM COGS_US
BY REGION
WHERE COUNTRY_NAME EQ 'United States'
ON GRAPH PCHOLD FORMAT JSCHART
ON GRAPH SET LOOKGRAPH CHOROPLETH
ON GRAPH SET STYLE *
TYPE=REPORT, CHART-LOOK=com.esri.map, $
TYPE=DATA, COLUMN=N2, BUCKET=color, $
*GRAPH_JS_FINAL
"extensions": {
  "com.esri.map": {
    "overlayLayers": [
      {
        "ibiDataLayer": {
          "map-metadata": {
            "map_by_field": "REGION"
          }
        }
      }
    ],
    "baseMapInfo": {
      "customBaseMaps": [
        {
          "ibiBaseLayer": "gray"
        }
      ]
    }
  }
}
*END
ENDSTYLE
END
```
Adding a New Role for a Server-Hosted Map

A server-hosted map is based on a shapefile. You must upload the shapefile (.dbf) to an application folder accessible to the server. The server will transform it to ibijson format.

An ESRI shape file is actually a collection of at least four files:

- **.dbf file.** The .dbf file is a standard database file used to store attribute data and object IDs. A .dbf file is mandatory for shape files.

- **.shp file.** The .shp file is a mandatory Esri file that gives features their geometry. Every shapefile has its own .shp file that represents spatial vector data.

- **.shx file.** The .shx file is a mandatory Esri shape index position file. This type of file is used to search forward and backwards.

- **.prj file.** The .prj file is an optional file that contains the metadata associated with the shapefiles coordinate and projection system.

All files must have exactly the same name and to be located in the same directory. If they are not, the shapefile conversion will fail.

When there are several possible keys associated with a geometry, a drop down list of detected key names will be displayed. Select any one of these fields. No selection required when there is a single geometry key.

The shapefile should only be in the GCS_WGS_1984 - World Geodetic System 1984 (decimal degrees) coordinate system.
To add a geographic role for a Server-hosted map, click Add WFRS map on the Geographic Configuration Editor.

The Add WFRS hosted map dialog box opens, as shown in the following image.

![Add WFRS hosted map dialog box](image)

Configure the following properties.

**role name**

Is a name for the geographic role.

**Geometry type**

Select either POLYGON or POINT from the drop-down list.

**Esri shape**

Enter the name of the application directory where the shapefile resides, or click the ellipsis (...) to navigate to the application directory. Then select the .dbf file for the role.

**Load to app**

Enter the name of the application directory where you want to place the ibijson file, or click the ellipsis (...) to navigate to the application directory.

**Quantization type**

Quantization is the process of transforming a large set of input values to a smaller set of values. When transforming the shapefile, the server will quantize points that are too close together in order to optimize map rendering performance. Two methods are available for quantization, LINEAR or GRID. The default is LINEAR.

**Quantization_X**

Is the threshold value for the x-axis.
Quantization_Y

Is the threshold value for the y-axis.

If the map has multiple keys, a drop-down list displays so that you can select one.

Click OK when you have finished configuring the properties.

The new role is added to the configuration as a customized role, as shown in the following image.

Click Save to save this role to the configuration.

You can test the role by right-clicking the role in the configuration editor and clicking Test. A sample map will be generated, as shown in the following image.
Adding NUTS Support

Nomenclature of territorial units for statistics (NUTS) are geographic roles specific to the European Union.

To add NUTS geographic roles to the configuration, click Add NUTS support on the Geographic Configuration Editor.

The NUTS geographic roles are added, as shown in the following image.

Click Save to save these roles to the configuration.

Adding Support for Extended Postal Codes

Click Add extended postal codes to add support for Level 1 and Level 2 postal codes used in certain countries.

Customizing Vocabulary Rules

For each geographic role, a set of vocabulary rules define how to recognize when a field name should automatically be assigned to that role. If you right-click a role, you can click Customize vocabulary from the shortcut menu.

Elements in a rule are connected by the Boolean logic operation OR (only one needs to be satisfied). Each vocabulary element contains words enclosed with special characters. Words in the rule element are connected by the Boolean logic operation AND (all need to be satisfied).

A word may be prefixed and/or suffixed with the percent character (%), which is a placeholder for any sequence of characters. If an element contains more than one word, each word has to be prefixed by the character plus (+) or minus (-). Plus indicates that the word must be found in the column name. Minus indicates that word must not be found in the column name.
For example, the following are the vocabulary rules for the role COUNTRY.

To add another rule, click *Add optional*.

When you are finished, click *OK*.

Click *Save* to save these rules to the configuration.

**Reference:** Customizing the List of Basemaps

You can edit an existing basemap definition or add a custom basemap.

Basemaps that are not vector maps are pre-rendered image tiles. Vector basemaps are delivered from ArcGIS Online as vector tiles that are rendered on the client based on a style file that is delivered with the vector tiles. This provides customization options not available with pre-rendered image tiles.

A default set of vector basemaps is configured in the GEO configuration editor in the Server. However, you can configure additional vector basemaps as needed. You can find the basemap URLs and Style URLs at [http://www.arcgis.com](http://www.arcgis.com).
Using Standard Basemaps

To add a new basemap or customize an existing basemap, select Basemap from the Object drop-down list.

The following image shows the GEO configuration editor with the Basemap object selected, showing the list of standard basemaps.

GEO configuration editor

<table>
<thead>
<tr>
<th>name</th>
<th>icon</th>
<th>title</th>
<th>type</th>
<th>url</th>
</tr>
</thead>
<tbody>
<tr>
<td>streets</td>
<td>qib/streets_map_108x72.png</td>
<td>World Street Map</td>
<td>tiled</td>
<td></td>
</tr>
<tr>
<td>satellite</td>
<td>qib/imagery_map_108x72.png</td>
<td>World Imagery</td>
<td>tiled</td>
<td></td>
</tr>
<tr>
<td>terrain</td>
<td>qib/terrain_map_108x72.png</td>
<td>Terrain with Labels</td>
<td>tiled</td>
<td></td>
</tr>
<tr>
<td>gray</td>
<td>qib/gray_map_108x72.png</td>
<td>Light Gray Canvas Map</td>
<td>tiled</td>
<td></td>
</tr>
<tr>
<td>dark-gray</td>
<td>qib/darkgray_map_108x72.png</td>
<td>Dark Gray Canvas Map</td>
<td>tiled</td>
<td></td>
</tr>
<tr>
<td>oceans</td>
<td>qib/oceans_map_108x72.png</td>
<td>Oceans Map</td>
<td>tiled</td>
<td></td>
</tr>
<tr>
<td>national-geographic</td>
<td>qib/national_geographic_map_108x72.png</td>
<td>National Geographic World Map</td>
<td>tiled</td>
<td></td>
</tr>
<tr>
<td>osm</td>
<td>qib/open_streets_map_108x72.png</td>
<td>Open Street Map</td>
<td>tiled</td>
<td></td>
</tr>
<tr>
<td>hybrid</td>
<td>qib/hybrid_map_108x72.png</td>
<td>World Imagery with Labels</td>
<td>tiled</td>
<td></td>
</tr>
<tr>
<td>topo</td>
<td>qib/topo_map_108x72.png</td>
<td>World Topographic Map</td>
<td>tiled</td>
<td></td>
</tr>
<tr>
<td>gray-vector</td>
<td>qib/light_gray_vector.png</td>
<td>Gray Vector</td>
<td>vector</td>
<td></td>
</tr>
<tr>
<td>streets-night-vector</td>
<td>qib/streets_night_map.png</td>
<td>Streets Night Vector</td>
<td>vector</td>
<td></td>
</tr>
<tr>
<td>streets-navigation-vector</td>
<td>qib/navigation_day_map_vector.png</td>
<td>Streets Navigation Vector</td>
<td>vector</td>
<td></td>
</tr>
<tr>
<td>topo-vector</td>
<td>qib/topographic_relief_vector.png</td>
<td>Topographic Vector</td>
<td>vector</td>
<td></td>
</tr>
<tr>
<td>dark-gray-vector</td>
<td>qib/dark_gray_vector.png</td>
<td>Dark Gray Vector</td>
<td>vector</td>
<td></td>
</tr>
<tr>
<td>streets-vector</td>
<td>qib/streets_map_vector.png</td>
<td>Streets Vector</td>
<td>vector</td>
<td></td>
</tr>
<tr>
<td>streets-relief-vector</td>
<td>qib/street_relief_vector.png</td>
<td>Streets Relief Vector</td>
<td>vector</td>
<td></td>
</tr>
<tr>
<td>None</td>
<td>qib/non_map_108x72.png</td>
<td>BasemapNone</td>
<td>tiled</td>
<td></td>
</tr>
</tbody>
</table>

Configuring Basemap Properties

The following is a description of the properties used for basemap configuration.

name

Is the name of the basemap.

Next to the name is an indicator of whether the basemap is a standard basemap or a customized basemap.

icon

Is the name of the thumbnail for the basemap (for a standard basemap) or the URL to the thumbnail (for a customized basemap) that will appear on the Basemap drop-down list in the WebFOCUS tools or the Change Basemap map widget.

title

Is a title to display on the Basemap drop-down list in the WebFOCUS tools or the Change Basemap map widget.
url

Is the URL to the map service that provides the basemap, for a customized basemap. The
map service URL can be copied from the URL field on the page showing a custom
basemap. For a standard basemap, the URL is already stored in the server geographic
configuration file and is not displayed.

type

Valid values are tiled and vector.

addon_json

Specifies additional JSON properties for rendering the map. For a custom vector basemap,
enter the basemap map service URLs and Style URLs needed for rendering the map. The
map can consist of an array of layers, each with a URL and its style URL. The style URL for
each layer can be found by clicking View Style on the page showing the map layer. The map
service URL for each layer can be copied from the URL field on the page showing the map
layer. Enter the information in the following format.

{"baseMapLayers":
 [  
   {"url": "url_to_map_service", "styleUrl": "url_to_style"},
   {"url": "url_to_map_service", "styleUrl": "url_to_style"},
   ...
  ]
}

Note: If the vector basemap has multiple layers, its page on ArcGIS online will have links
to each layer.

Editing the Properties of a Standard Basemap

To customize the properties of an existing basemap, right-click the basemap line and click
Customize BASEMAP.
The Customize Basemap dialog box opens, as shown in the following image.

Edit the properties you want to change. If you change the URL, you can click *Verify* to make sure the map service is valid and accessible.

When you are finished, click *OK*, then click *Save* on the GEO configuration editor *Basemaps* page.

**Adding a Custom Basemap**

To add a new basemap to the configuration, click *Add*. 
The Create a BASEMAP dialog box opens, as shown in the following image.

Enter a name for the basemap, a URL to the thumbnail, a title to display, and the URL to the map service that provides the basemap, and click Verify.

When you have configured the properties, click OK, then click Save on the GEO configuration editor Basemap page.

**Example:** Configuring the Nova Vector Basemap

The following steps are needed to determine the properties associated with the Nova vector basemap.

1. Navigate to the following URL for the Nova basemap.

   https://www.arcgis.com/home/item.html?id=75f4dfdf19e445395653121a95a85db.
The Nova basemap page is shown in the following image.

In the addon_json syntax, you need the styleUrl for each basemap URL defined in the vector basemap.

2. Click the View Style button to retrieve the styleUrl. In this case, it is the following URL.

   https://www.arcgis.com/sharing/rest/content/items/75f4ddf19e445395653121a95a85db/resources/styles/root.json?f=pjson

3. Add the following URL for the Esri vector map service in both the url field in the GEO configuration editor and in the addon_json syntax for this basemap. You can copy this location from the URL field on the lower right of the Nova basemap page.

   https://basemaps.arcgis.com/arcgis/rest/services/World_Basemap_v2/VectorTileServer

4. The icon value must be a URL reference. This example uses the one referenced in the thumbnail of the webmap, which is the following URL (retrieved by right-clicking the thumbnail image at the top of the page and copying the image location).

   http://www.arcgis.com/sharing/rest/content/items/75f4ddf19e445395653121a95a85db/info/thumbnail/Nova.png

Add these properties in the GEO configuration editor to define the Nova vector basemap, which consists of a single layer. Add the name, type, and a title, as follows.

   name: Nova
   icon: http://www.arcgis.com/sharing/rest/content/items/75f4ddf19e445395653121a95a85db/info/thumbnail/Nova.png
   title: Nova
url: https://basemaps.arcgis.com/arcgis/rest/services/World_Basemap_v2/VectorTileServer

addon_json:

{"baseMapLayers":
[
{"url": "https://basemaps.arcgis.com/arcgis/rest/services/World_Basemap_v2/VectorTileServer",
"styleUrl": "http://www.arcgis.com/sharing/rest/content/items/75f4dfdf19e445395653121a95a85db/resources/styles/root.json"
}]
}

The following image shows the Create a BASEMAP page for configuring the Nova vector basemap in the Reporting Server GEO configuration editor.
After clicking OK, then Save, the custom vector basemap becomes available for selection in the App Studio Properties panel for the Esri map component, as shown in the following image.
The App Studio Esri component in this example uses the following request, named customer_locations.fex.

```
TABLE FILE WF_RETAIL_LITE
PRINT
  ID_CUSTOMER
  COGS_US
  QUANTITY_SOLD
  COMPUTE LONGITUDE/D12.2 = CUSTOMER_LONGITUDE;
  COMPUTE LATITUDE/D12.2 = CUSTOMER_LATITUDE;
BY  STATE_PROV_NAME
BY  ID_CUSTOMER NOPRINT
WHERE COUNTRY_NAME EQ 'United States';
ON TABLE NOTOTAL
ON TABLE PCHOLD FORMAT XML
END
```

Configure the Settings panel for the Esri map to use this request for a Point of Interest layer.

Running the HTML page generates the following map, with the Nova vector basemap as the base layer.
The Nova vector basemap is also available in the Change Basemap widget, as shown in the following image.

**Reference:** Customizing the List of Context Layers

To add a new context layer or customize an existing context layer, select ContextLayer from the Object drop-down list.
The following image shows the GEO configuration editor with the ContextLayer object selected.

<table>
<thead>
<tr>
<th>name</th>
<th>authorization</th>
<th>layerType</th>
<th>title</th>
<th>url</th>
</tr>
</thead>
<tbody>
<tr>
<td>USA_Population_Older_Than_Age_64</td>
<td>standard</td>
<td>file</td>
<td>USA Population Older than Age 64</td>
<td><a href="http://server.arcgis.com/arcgis/rest/services/Demographics/USA_Population_OlderThanAge64/MapServer">http://server.arcgis.com/arcgis/rest/services/Demographics/USA_Population_OlderThanAge64/MapServer</a></td>
</tr>
<tr>
<td>USA_Insurance_Rate_2012</td>
<td>standard</td>
<td>file</td>
<td>USA Unemployment Rate 2012</td>
<td><a href="http://server.arcgis.com/arcgis/rest/services/Demographics/USA_Insurance_Rate/MapServer">http://server.arcgis.com/arcgis/rest/services/Demographics/USA_Insurance_Rate/MapServer</a></td>
</tr>
<tr>
<td>USA_Average_Household_Size_2012</td>
<td>standard</td>
<td>file</td>
<td>USA Average Household Size 2012</td>
<td><a href="http://server.arcgis.com/arcgis/rest/services/Demographics/USA_Average_Household_Size/MapServer">http://server.arcgis.com/arcgis/rest/services/Demographics/USA_Average_Household_Size/MapServer</a></td>
</tr>
<tr>
<td>USA_Median_House_Value_2012</td>
<td>standard</td>
<td>file</td>
<td>USA Median Home Value 2012</td>
<td><a href="http://server.arcgis.com/arcgis/rest/services/Demographics/USA_Median_House_Value/MapServer">http://server.arcgis.com/arcgis/rest/services/Demographics/USA_Median_House_Value/MapServer</a></td>
</tr>
<tr>
<td>USA_Population_Younger_Than_Age_18</td>
<td>standard</td>
<td>file</td>
<td>USA Population Younger than Age 18</td>
<td><a href="http://server.arcgis.com/arcgis/rest/services/Demographics/USA_Population_YoungerThanAge18/MapServer">http://server.arcgis.com/arcgis/rest/services/Demographics/USA_Population_YoungerThanAge18/MapServer</a></td>
</tr>
<tr>
<td>USA_Population_Occupied_Housing_2012</td>
<td>standard</td>
<td>file</td>
<td>USA Average Household Size 2012</td>
<td><a href="http://server.arcgis.com/arcgis/rest/services/Demographics/USA_Average_Household_Size/MapServer">http://server.arcgis.com/arcgis/rest/services/Demographics/USA_Average_Household_Size/MapServer</a></td>
</tr>
<tr>
<td>USA_Median_House_Value_2012</td>
<td>standard</td>
<td>file</td>
<td>USA Median Net Worth 2012</td>
<td><a href="http://server.arcgis.com/arcgis/rest/services/Demographics/USA_Median_House_Value/MapServer">http://server.arcgis.com/arcgis/rest/services/Demographics/USA_Median_House_Value/MapServer</a></td>
</tr>
<tr>
<td>USA_Median_House_Value_2013</td>
<td>standard</td>
<td>file</td>
<td>USA Median Net Worth 2013</td>
<td><a href="http://server.arcgis.com/arcgis/rest/services/Demographics/USA_Median_House_Value/MapServer">http://server.arcgis.com/arcgis/rest/services/Demographics/USA_Median_House_Value/MapServer</a></td>
</tr>
<tr>
<td>USA_Labor_Force_Participation_Rate_2010</td>
<td>standard</td>
<td>file</td>
<td>USA Labor Force Participation Rate 2010</td>
<td><a href="http://server.arcgis.com/arcgis/rest/services/Demographics/USA_Labor_Force_Participation_Rate/MapServer">http://server.arcgis.com/arcgis/rest/services/Demographics/USA_Labor_Force_Participation_Rate/MapServer</a></td>
</tr>
<tr>
<td>USA_Median_House_Value_2012</td>
<td>standard</td>
<td>file</td>
<td>USA Median Age 2012</td>
<td><a href="http://server.arcgis.com/arcgis/rest/services/Demographics/USA_Median_Age/MapServer">http://server.arcgis.com/arcgis/rest/services/Demographics/USA_Median_Age/MapServer</a></td>
</tr>
<tr>
<td>USA_Median_House_Value_2013</td>
<td>standard</td>
<td>file</td>
<td>USA Median Age 2013</td>
<td><a href="http://server.arcgis.com/arcgis/rest/services/Demographics/USA_Median_Age/MapServer">http://server.arcgis.com/arcgis/rest/services/Demographics/USA_Median_Age/MapServer</a></td>
</tr>
<tr>
<td>USA_Median_House_Value_2014</td>
<td>standard</td>
<td>file</td>
<td>USA Median Age 2014</td>
<td><a href="http://server.arcgis.com/arcgis/rest/services/Demographics/USA_Median_Age/MapServer">http://server.arcgis.com/arcgis/rest/services/Demographics/USA_Median_Age/MapServer</a></td>
</tr>
</tbody>
</table>

### Configuring Context Layer Properties

Following is a description of the properties used for context layer configuration.

**name**

Is the name of the context layer.

Next to the name is an indicator of whether the context layer is a standard context layer or a customized context layer.

**authorization**

Is the type of authentication needed to access this context layer. Valid values are:

- **silent.** Credentials for your ArcGIS application are provided in the connection string of the Adapter for Esri ArcGIS.

  **Note:** For instructions for configuring the Adapter for Esri ArcGIS, see the Adapter Administration manual.

- **none.** No authorization is needed.

- **named.** User credentials are provided in the connection string of the Adapter for Esri.

- **on premises.** User credentials for a locally hosted ArcGIS server are provided in the connection string of the Adapter for Esri.
layer type

Is the type of context layer. For a cached layer, the layer type is tile. For a layer that is rendered dynamically, the layer type is featurelayer.

title

Is a title to display on the demographic layer drop-down list in the WebFOCUS tools.

uri

Is the URL to the map service that provides the context layer.

addon_json

Specifies additional JSON properties needed for rendering the context layer. For example, smartMapping properties define the border styles within the context layer.

Customizing the Properties of an Existing Context Layer

To customize the properties of an existing context layer, click the down arrow next to a context layer name or right-click the context layer line and click Customize context layer.

The Customize CONTEXTLAYER dialog box opens, as shown in the following image.
Edit the properties you want to change. If you change the URI, you can click Verify to make sure the map service is valid and accessible.

When you are finished, click OK, then click Save on the GEO configuration editor Context Layers page.

**Adding a New Context Layer**

To add a new context layer to the configuration, click Add.

The **Create a Customized CONTEXTLAYER** dialog box opens, as shown in the following image.

![Create a Customized CONTEXTLAYER dialog box](image)

Enter a name for the context layer, the authorization type, a layer type, a title to display, any additional JSON needed for rendering the context layer, and the URI to the map service that provides the context layer, and click Verify.

When you have configured the properties, click OK, then click Save on the GEO configuration editor Context Layer page.
Adding an Esri Proxy URL

All of the configured proxy URLs for retrieving data from Esri are stored in the file esri-arcgis-rest.xml, which is located under your WebFOCUS configuration directory. For example, the default configuration directory on Windows is, C:\ibi\WebFOCUSxx\config, where xx is your release of WebFOCUS (for example, 82). The file contains configuration properties followed by a list of Esri proxy URLs, which start with the characters <ESRI_URL.

To add a new proxy URL, add a new <ESRI URL line to the <WF_ESRI_ARCGIS_PROXY> list in the esri-arcgis-rest.xml file. We recommend that you add the proxy URL prior to using the URL to define a new geographic role.

The syntax for a public proxy URL is:

<ESRI_URL URL="public_proxy_url" DESCRIPTION="Public access data" />

where:

public_proxy_url
    Is your public proxy URL.

The syntax for a restricted proxy URL is:

<ESRI_URL PROFILE_ID="default" URL="restricted_proxy_url" DESCRIPTION="Restricted access data" />

where:

restricted_proxy_url
    Is your restricted proxy URL.

Following are sample public Esri proxy URLs from the esri-arcgis-rest.xml file.

<ESRI_URL URL="http://services.arcgisonline.com/ArcGIS" DESCRIPTION="Public access data" />
    <ESRI_URL URL="http://services.arcgisonline.com/arcgis" DESCRIPTION="Public access data" />
    <ESRI_URL URL="http://static.arcgis.com/attribution" DESCRIPTION="Public access data" />

Following is a sample restricted Esri proxy URL from the esri-arcgis-rest.xml file.

<ESRI_URL PROFILE_ID="default" URL="http://www.arcgis.com/sharing/rest" DESCRIPTION="Restricted access data" />
Installing and Configuring Esri on Premise

Installing and Configuring Esri on Premise

The Esri on Premise feature enables customers to generate Esri maps using a locally hosted Esri server, making it unnecessary to go to ArcGIS Online or another outside site for basemaps, geographic roles, and the geometry task (the service that performs operations on input geometries such as projecting geometries into a different spatial reference). This feature enables the App Studio Esri Viewer feature to leverage all GIS Enterprise Data developed by a customer with intranet connectivity.

When a site uses Esri on Premise, the following geographic elements must be customized to be retrieved from the local Esri server.

- Geographic roles. For information on configuring custom geographic roles, see #unique_1084.
- Basemaps. For information, see #unique_1085.
- Geometry task.
- Demographic layers.

**Note:** All on-premise published feature layers should be published on a CORS-enabled ArcGIS Server and avoid proxy on client.

**Procedure:** How to Install and Configure Esri on Premise

1. Download the ArcGIS Online API for JavaScript.
   a. Go to [https://developers.arcgis.com/downloads/](https://developers.arcgis.com/downloads/) > ArcGIS API for Javascript > Version 3.24, as shown in the following image.

   ![ArcGIS API for JavaScript Download](image)

   **Note:**
   - You may be prompted to sign in with your Esri credentials.
   - Even if a newer version of the API is available, it is critical that you download and use the 3.24 version.
b. Click API to download the API.

2. Unzip the API.
   a. Create a folder called arcgis_api under:
      
      `webfocusdir\config\web_resource\`
      
      where:
      
      `webfocusdir`
      
      Is the directory where WebFOCUS is installed.
   b. Navigate to the following subfolder in the zip file you downloaded:
      
      `arcgis_js_v322_api\arcgis_js_api\library\3.24\3.24`
      
      Extract its contents to the folder you created in step 2:
      
      `webfocusdir\config\web_resource\arcgis_api`
3. Configure the WebFOCUS Administration Console for Esri on Premise.
   a. In the WebFOCUS Administration Console, click ESRI, and in the Esri on Premise text box add the path to the folder in which you unzipped the API, as shown in the following image.

   ![Configuration and ESRI Path Image]

   This identifies the path to the internal ArcGIS Javascript API Source that develops Esri-based maps. This setting is blank, by default, meaning that the use of the internal API Source to develop Esri maps is not activated. The API referenced by default is https://js.arcgis.com/3.24/. To direct WebFOCUS to use the internal ArcGIS Javascript API to develop Esri maps, type the path to it in this text box.

   This path should be a relative path accessible to the local WebFOCUS installation.

   b. Click Save.

4. Clear your browser cache.
Once you have installed and configured the API, you must configure the locally hosted geometry task when creating a map.

The geometry task is the service that performs operations on input geometries, such as projecting geometries into a different spatial reference. You configure the geometry task in the Esri Viewer Properties panel when creating a map. Add the URL to the locally hosted geometry task in the Map: Geometry Service text box of the Esri Viewer Properties panel, as shown in the following image.

Using the Reporting Server Geographic Configuration tool, configure locally hosted, roles, basemaps, and demographic layers.
Working With Source Control

When you have multiple users working on the same files, you can prevent conflicting updates by using a source code management (SCM) system, such as Team Foundation Server. An SCM system allows a user to check out a file for editing and prevents other users from checking it out until the first user checks it back in.

This topic describes how to implement Source Control in App Studio.

In this chapter:

- Using Source Control in App Studio
- Microsoft Team Foundation Server Requirements and Configuration

Using Source Control in App Studio

Through the Source Control feature, you can use App Studio to manage files and add them to the Source Control system repository. Your Source Control provider must first be configured in the WebFOCUS Administration Console. For more information, see the WebFOCUS Security and Administration manual.

Within an App Studio domain, you can add a published folder to Source Control. Within a designated folder, you can add individual files to Source Control.

Source Control Benefits

Source Control is a feature that provides many benefits to developers, including the following:

- A valuable feature for companies that need to audit changes made to their applications.
- A repository to store your source code, providing backup in a central location.
- A historical record of changes over time.
- Ability to review and compare changes.
- Ability to retrieve a specific version of a file.
- Ability to compare files between WebFOCUS and Source Control.
Source Control Requirements and Usage Notes

The following are requirements and usage notes when using Source Control:

- WebFOCUS must be configured for Source Control.
- You must be signed in to WebFOCUS and to Source Control.
- Source Control operations are available while working in the Domains area.
- Folders and files in the Domains area need to be Published.
- Source Control operations are not available if an item is not Published.
- Source Control is not available when accessing WebFOCUS from a browser. Development against a WebFOCUS environment from a browser client should be avoided to ensure that there are no conflicts in files, as files may be modified and changes may be overwritten. When using Source Control, all development must be performed through App Studio.

- Source Control operations are supported with the following file types:
  - .fex
  - .htm
  - .html
  - .css
  - .js
  - .pdf
  - .sql
  - .sty
  - .txt
  - .url
  - .xls
  - .xlsx
Source Control operations are supported with the following image files:

- .bmp
- .gif
- .jpg
- .png

Currently, Source Control operations are not supported with the following:

**ReportCaster related files**

- Distribution List: .adr
- Access List: .acl
- Schedules: .sch
- Library content: .lib

**Business Intelligence Portal related files**

- Portal files .page and .prtl
- Blog files .blog

Source Control operations are not available for My Content files, including Shared files.

Single-file check out configuration needs to be implemented and enforced by the version control system, meaning that the same file cannot be checked out by multiple users.

**How Source Control Works**

When you start App Studio, it checks the WebFOCUS instance to determine if it is configured for Source Control.

If WebFOCUS is configured for Source Control and the App Studio user provides Source Control credentials, App Studio enables options to perform Source Control operations against the connected WebFOCUS environment.
Procedure: How to Test Source Control From App Studio

1. When configuring a new WebFOCUS environment for App Studio, the product prompts you to connect to WebFOCUS to validate the connection and, if App Studio detects that the environment is configured for Source Control, it prompts you to connect to Source Control, as shown in the following image.

   ![Source Control Connection Prompt](image)

   - If you select Yes, a prompt to provide Source Control credentials is presented. Source Control credentials are validated and saved for the current and future sessions of App Studio. The Environment Properties dialog box closes, you can proceed, use the new environment, and perform Source Control operations without getting prompted to sign in to WebFOCUS or Source Control. Source Control credentials are cleared when you select the Disconnect from Source Control operation.

     **Note:** If you type invalid credentials, you will receive an error message.

   - If you select No, the environment is saved and Source Control operations are disabled. You can proceed and perform development against the new environment without getting prompted to sign in to WebFOCUS or Source Control. Signing out of the environment and attempting to work with the same environments properly prompts the user to sign in to WebFOCUS and optionally to Source Control. The same applies when restarting App Studio.

     **Note:** If a WebFOCUS environment is configured for Source Control and you are not connected to Source Control, App Studio starts and you are prompted to connect to both WebFOCUS and Source Control when attempting to use the Source Control configured environment.

2. You can also connect to or disconnect from Source Control, on demand.
To connect to Source Control on demand, right-click the environment in the Configured Environments Tree panel and select Connect to Source Control, as shown in the following image.

To disconnect from Source Control on demand, right-click the environment in the Configured Environments Tree panel and select Disconnect to Source Control, as shown in the following image.

**Procedure:** How to Add Folders and Files to Source Control

As a first step, you must first add a published domain folder to Source Control or select specific files to be added to Source Control.

**Note:** If files and folders are not published, Source Control options are not available. The same applies if you are not connected to Source Control.

1. To publish a folder, right-click the folder and select Publish from the shortcut menu. Content in this folder may now be accessed by other users.
2. To add a published folder to Source Control, right-click the folder and select Source Control from the shortcut menu.

The Source Control shortcut menu displays.

If the Source Control shortcut menu does not display, the WebFOCUS environment is not configured for Source Control. For more information on configuring a WebFOCUS environment for Source Control, see the WebFOCUS Security and Administration manual.

3. Select Add to Source Control from the shortcut menu, as shown in the following image.
The Add to Source Control dialog box opens, as shown in the following image.

4. Select the **Include Subfolders** check box to add all items, including subfolders and files in these folders, to the Source Control database.

   This operation binds your selected folder to a folder with the same name in the Source Control database, and adds all folders and files, based on your selection.

   To verify this, select the folder and open the File/Folders Properties panel. The Source Control Status property value is **Added to Source Control**.

   A folder that has been added to Source Control may contain files that are added to Source Control, and also files that are not.

   **Note:** Files in a published folder are accessible to all developers.

**Procedure:** **How to Remove a Folder From Source Control**

1. To remove the association of a WebFOCUS folder from Source Control, right-click the folder and select **Source Control** from the shortcut menu.

   The Source Control shortcut menu displays.
2. Select **Unbind from Source Control** from the shortcut menu, as shown in the following image.

![Source Control menu](image)

**Reference:** **Source Control Icons**

The following table describes how App Studio uses the icons in the Configured Environments tree to indicate the status of a file in Source Control.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="folder icon" /></td>
<td>The folder has been added to Source Control.</td>
</tr>
<tr>
<td><img src="image" alt="file icon" /></td>
<td>The file has been added to Source Control.</td>
</tr>
<tr>
<td><img src="image" alt="file check icon" /></td>
<td>The file has been checked out by the current user.</td>
</tr>
<tr>
<td><img src="image" alt="file exclusive icon" /></td>
<td>The file has been exclusively checked out by another user.</td>
</tr>
</tbody>
</table>

**Note:** Files not added to Source Control do not have overlay icons.
**Example: Source Control Icons in the Configured Environments Tree**

The following image shows an example of Source Control icons for added and checked out folders and files in the Configured Environments tree.

![Source Control Icons](image)

**Procedure: How to Check Files In and Out of Source Control**

1. To check out a file for editing, right-click the file and select *Source Control* from the shortcut menu.

   The Source Control shortcut menu displays.
2. Select Check Out from the shortcut menu, as shown in the following image.
The Check Out dialog box opens, as shown in the following image.

3. Select *Do not update the file in the WebFOCUS repository* to only mark the file as checked out and not update the file currently in the WebFOCUS repository with the version of the file that is in the Source Control database. This allows you to preserve changes that are made to the WebFOCUS version of the file. A later check in operation will update the Source Control file with the one from WebFOCUS. Optionally, you may type a comment describing your edits and click *OK.*
The Check Out dialog box closes, and the file is marked as checked out in App Studio and in the Source Control repository. The Source Control Status property value in the File/Folder Properties panel is *Checked out by <user name>*. as shown in the following image.

![File/Folder Properties panel showing the file is checked out by <user name>](image)

**Note:** If the *Check Out* option is not available from the shortcut menu, it means that another user has checked out the file. To verify this, open the File/Folders Properties panel. The Source Control Status property value is *Checked out by <user name>*.
4. To check the file in after making edits, save the file, right-click the file, and then select Source Control from the shortcut menu.

The Source Control shortcut menu displays.

5. Select Check In from the shortcut menu.

The Check In dialog box opens, as shown in the following image.

![Check In dialog box](image)

6. Select Keep checked out to update the file in Source Control and keep the file as checked out. Optionally, you may type a comment describing your edits and click OK.

The Check In dialog box closes.

7. Close the file.

To verify, open the File/Folders Properties panel. The Source Control Status property value is Added to Source Control.

**Reference:** Source Control Status

The following are the Source Control status values that display in the App Studio File/Folder Properties panel:

- Connection to Source Control is not available
- Added to Source Control/Bound to a Source Control project (folder level)
- Source Control status was not retrieved for the selected item/Not bound to a Source Control project (folder level). This occurs when a folder has not been added to Source Control or has been unbound.
- Added to Source Control (file level)
Procedure: How to Undo a Check Out From Source Control

If you decide that you do not want to make changes to a file, you can undo its check out from Source Control.

1. To undo a check out, right-click the file and select Source Control from the shortcut menu.

   The Source Control shortcut menu displays.
2. Select *Undo Check Out* from the shortcut menu, as shown in the following image.
The Undo Check Out dialog box opens, as shown in the following image.

![Undo Check Out: Regional_Analysis.fex](image)

- If you select *Update the WebFOCUS file*, if the WebFOCUS file is different than the one in Source Control, the WebFOCUS copy gets replaced with the latest version of the file from the Source Control database. This is ignored if the WebFOCUS file has not changed.

- If you select *Discard All Changes (Force Undo)*, it forces an undo check out if the file in the WebFOCUS repository is different than the latest version of the file in the Source Control database.

**Note:** Keeping the default options ensures that all changes will be discarded.

**Procedure:** **How to Retrieve the Latest Version of a Folder or File**

You can retrieve the latest version of a folder or file from the Source Control database and update the file in the WebFOCUS repository.

1. To retrieve the latest version of a folder, right-click the folder and select *Source Control* from the shortcut menu.

   The Source Control shortcut menu displays.
2. Select *Get Latest Version* from the shortcut menu, as shown in the following image.

The Get Latest Version dialog box opens, as shown in the following image.
3. Select one of the following options:

- **Update WebFOCUS Folder Properties Only** to update WebFOCUS folders only.

- **Update WebFOCUS Folder Properties and Files** to update WebFOCUS folders and children (files under the selected folder), using the latest version from Source Control.

- **Update WebFOCUS Folder Properties, Subfolders, and Files** to update WebFOCUS folders, children (files under the selected folder), and subfolders, using the latest version from Source Control.

**Note:** If you select this option, the Add New Projects check box is activated. Use this option if you have a folder or file that is in Source Control that you want to add back to WebFOCUS.

You can also use this option to get an entire new project from Source Control to WebFOCUS (the folder does not exist in WebFOCUS). To do this, create an empty folder in WebFOCUS that exactly matches the name and case of the folder name in Source Control. On the Get Latest Version dialog box, select the **Update WebFOCUS Folder Properties, Subfolder, and Files** and **Add New Projects** options.

**Procedure:** How to View the History for a Specific File

Using the History feature, you can view information about a file, such as version history, date of creation or modification, and other details. You can also compare two versions of a file.

1. To view information about a file, right-click the file and select **Source Control** from the shortcut menu.

   The Source Control shortcut menu displays.
2. Select *Show History* from the shortcut menu, as shown in the following image.
This History dialog box opens, as shown in the following image.

The following table describes the options that are available on the History dialog box.

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Close</td>
<td>Closes the History dialog box. This option is always enabled.</td>
</tr>
<tr>
<td>View</td>
<td>Opens the selected version of the file in an editor. This option is disabled for multi-select. The viewer program can be set by a user, and is defaulted to notepad.exe.</td>
</tr>
<tr>
<td>Details</td>
<td>Displays the summary of a selected revision in a viewer. The same viewer is used for the View option. This option is disabled for multi-select.</td>
</tr>
<tr>
<td>Get</td>
<td>Updates the WebFOCUS version with the selected revision. This option is disabled for multi-select.</td>
</tr>
<tr>
<td>Check Out</td>
<td>Checks out the selected revision. This option is disabled for multi-select.</td>
</tr>
<tr>
<td>Button</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Diff                 | Enables you to compare two versions of a file from Source Control:  
  - If a single row is selected, the selected revision and current WebFOCUS version will be compared.  
  - If two rows are selected, the two selected revisions will be compared.  
  The diff program can be set by a user, and is defaulted to fc.exe.  
  Batch program RunFC.bat, located in the bin folder, is used to perform the file comparison. |
| Report               | Displays a summary for all of the revisions. The same viewer is used for the View option. This option is always enabled.                  |
| Diff and View Setup  | Opens the History Viewer and Diff Setup dialog box, which enables you to configure the editor and application used as a Compare tool. This dialog box includes edit input controls for specifying the following:  
  - Text Viewer Command Line for viewing text content.  
  - Binary Viewer Command Line for viewing binary content.  
  - Text Diff Command Line for viewing the difference between text content.  
  - Binary Diff Command Line for viewing the difference between binary content.  
  For more information, see *Diff and View Setup Dialog Box* on page 1144. |
Reference:  **Diff and View Setup Dialog Box**

The Diff and View Setup dialog box is shown in the following image.

You can type, copy-and-paste, or click the browse buttons located next to the edit controls to update the configuration and specify other programs. The browse buttons open the standard Windows Files Open dialog boxes.

By default, the product is configured to use the Windows built in editor notepad.exe. For compare, file RunFC.bat is configured to use the Windows fc.exe Compare tool and passes as arguments the two selected versions of the file, in addition to setting arguments /A and /N.

where:

/A

Abbreviates the output of an ASCII comparison. Instead of displaying all of the lines that are different, fc displays only the first and last line for each set of differences.

/N

Displays the line numbers during an ASCII comparison.
Performing a diff with these options displays the output in a command window, as shown in the following image.

Optionally, you can customize the Compare tool and editor. The Compare application you select needs to support the running from a command window and allow a user to pass, as input, the file names to be compared, for example, as done in RunFC.bat and the new sample Compare.bat.
The following example uses Notepad++ as the editor and Compare.bat as a new batch file that is configured to use the Compare tool KDiff3, as shown in the following image.

![History Viewer and Diff Setup](image)

The following is in the compare.bat file:

```batch
ECHO OFF
cmd /K "C:\Program Files (x86)\KDiff3\kdiff3.exe" %1 %2
```
The following image shows an example of a diff request using the above configuration.

Note: This process opens a command window that needs to be closed manually.

Procedure: How to Show Differences Between WebFOCUS and Source Control Files

You can show the difference between a file in WebFOCUS and the file in the Source Control database.

1. To show differences between files, right-click the file and select Source Control from the shortcut menu.

The Source Control shortcut menu displays.
2. Select *Show Differences* from the shortcut menu, as shown in the following image.

- If there are no differences between the files, you will receive a *no difference encountered* message.
- If there are differences between the files, the differences display in the Compare tool that is configured on your machine.

**Note:** Files for comparison get downloaded to the local temp folder on the user machine. For example, `%LOCALAPPDATA%\Temp`, which is mapped to `C:\Users\<username>\AppData\Local\Temp`. 
Reference: Supported Source Control Operations

Folder Level Operations

- **Get Latest Version.** Select this option to retrieve the latest version of the folder from the Source Control database and update the folder properties in the WebFOCUS repository. This also contains options to update folders and files and to retrieve new files.

- **Add to Source Control.** This is the first operation to add folders or files to Source Control.
  
  - The Include Subfolders option adds all items, including subfolders and files in these folders, to the Source Control database.

- **Bind to Source Control.** Associates the WebFOCUS item with a copy in the Source Control database.
  
  - This is needed to perform further commands, such as Check In, Check Out, and Get.
  
  - The Bind to Source Control option is enabled only when a folder is added to Source Control and it is later unbound.

- **Unbind from Source Control.** Select this option to disassociate the connection of the WebFOCUS item with the copy in the Source Control database and disable all Source Control commands.
  
  **Note:** Unbind does not remove the item from the Source Control database.

File Level Operations

- **Get Latest Version.** Select this option to retrieve the latest version of the file from the Source Control database and update the file in the WebFOCUS repository.

- **Check Out.** To make changes to a file in Source Control, you must first check it out of the Source Control database.
  
  The Check Out option retrieves the latest version of the selected file and allows you to edit it.

  You can control the replacement of the local WebFOCUS file copy by selecting *Do not update the file in the WebFOCUS repository*. When this option is selected, the file is only marked as checked out and it does not update the file currently in the WebFOCUS repository with the version of the file that is in the Source Control database. This allows you to preserve changes that are made to the WebFOCUS version of the file. A later check in operation will update the Source Control file with the one from WebFOCUS.
Check In. Select this option to return a checked out file to the Source Control database. Source Control stores any changes made to the file in the database.

The Keep checked out option updates the file in Source Control and keeps the file as checked out.

Undo Check Out. Select this option to reverse a check out and cancel any changes made to a file in your working area.

If you select the Update the WebFOCUS file option, if the WebFOCUS file is different than the one in Source Control, the WebFOCUS copy gets replaced with the latest version of the file from the Source Control database. This is ignored if the WebFOCUS file has not changed.

If you select the Discard All Changes (Force Undo) option, it forces an undo check out if the file in the WebFOCUS repository is different than the latest version of the file in the Source Control database.

Note: Keeping the default options ensures that all changes will be discarded.

Add to Source Control. This is the first operation to add folders or files to Source Control.

The Include Subfolders option adds all items, including subfolders and files in these folders, to the Source Control database.

The Add to Source Control option will not be available if a file with the same name is already in the Source Control repository. You can either merge the file in App Studio with the file in Source Control or change the name of the file in App Studio and then add it to Source Control.

Show History. Select this option to view information about a file, such as version history, date of creation or modification, and other details. This also enables the comparison of two versions of the file.

Show Differences. Allows a comparison between the file in WebFOCUS and the file in the Source Control database.

Microsoft Team Foundation Server Requirements and Configuration

WebFOCUS App Studio supports Team Foundation Server (TFS) as a Source Control provider. Information Builders has tested and certified Team Foundation Server version 2013 and 2015.

The following section describes the requirements and configuration for Team Foundation Server.
Procedure: How to Configure Team Foundation Server

A Team Project must exist on the Team Foundation Server. This project holds the files associated with the WebFOCUS Repository.

1. In order to properly work with the WebFOCUS Source Control feature, configure the project to allow only single check outs, as shown in the following image.
2. The workspace type for the Team Project Collection needs to be configured by selecting Server and clearing the Enable file merging and multiple check-out check box, as shown in the following image.

3. Select the File Types tab and then click Edit.
The Edit File type dialog box opens, as shown in the following image.

**Note:** WebFOCUS uses the Team Foundation Server API to automatically create a workspace for each of the users that have access to the Team Project Collection. These workspaces are created on the machine where WebFOCUS is installed.
Working With Team Foundation Server in WebFOCUS

When WebFOCUS domains or folders are initially added to the configured Team Foundation Project, a structure that matches the internal WebFOCUS Repository structure is created. For example, if the project is called $/Test1, adding a WebFOCUS folder named Retail_Samples creates the default top-level folder WFC/Repository. Under this location, WebFOCUS creates the Retail_Samples folder, in addition to any other folders or files added to Source Control. An example of this is shown in the following image.

- For every folder, there is an additional file created, called .dmeta. The .dmeta file contains the properties of the folder.
- For every file added, there is a file item with the contents of the file, and an additional file created, called .fmeta. The .fmeta file contains the properties of the file.

When performing operations, such as checking out a file, updating, and so on, both the file and folder content and the properties files are retrieved and updated, based on the selected Source Control operation.

**Reference:** Usage Notes

The following are usage notes for Team Foundation Server when using WebFOCUS.

- WebFOCUS folders match to a folder with the same name in the Source Control repository.
- Due to the Team Foundation Server single file check out feature, files can only be checked out by a single user at a time.
The option to check out a file is not enabled if a file is exclusively checked out by another user. In this case, the Source Control status displays the user account that has the file checked out, and the overlay icon shows that the file is exclusively checked out.
In App Studio, you can create, view, and edit the source syntax for procedures, procedure components, and other types of files required by your applications.

This topic describes the Text Editor that is available when you are developing the source syntax for procedures, procedure components, and other types of files.

In this appendix:

- Accessing the Text Editor

Accessing the Text Editor

App Studio provides a fully integrated Text Editor that you can use to create, view, and edit the source syntax for procedures, procedure components, and other types of files required by your applications.

You can access the Text Editor tab by right-clicking a procedure in the Environments Tree panel and clicking Open in Text Editor, or by right-clicking a file or folder, pointing to New, pointing to Text Editor, and clicking JavaScript File, Cascading Style Sheet, WebFOCUS StyleSheet, or Text Document. You can also access the Text Editor tab by selecting the Embedded JavaScript or Embedded CSS view tabs in the HTML canvas. Some commands are unavailable while in the Text Editor tab for JavaScript or CSS.

The Text Editor tab is shown in the following image.

![Text Editor tab](image)

Note: The Text Editor tab shares groups with the Command Console tab. However, in addition to these groups, the Command Console contains the Execution Path and Edit groups. For more information, see Sending Commands to the Server Using the Command Console Tab.

In addition, you can:

- Take advantage of color-coded syntax designed to make writing, editing, and debugging procedures easier.
- Bookmark lines of a file for quick editing and easy reference.
- Find and replace text.
Run procedures or procedure components directly from the Editor.

Finding or Replacing Text Using the Find Group

The Find group contains options that enable you to find or replace text. The Find group is shown in the following image.

The commands in this group are:

Find
Finds the specified text. You can also press Ctrl+F to activate the Find dialog box.

Next
Finds the next instance of the specified text.

Previous
Finds the previous instance of the specified text.

Replace
Replaces specific text with different text.

Select All
Selects all of the text in the procedure.

Reference: Find Dialog Box
You can use the options on the Find dialog box to indicate how to search for information.

The options on the Find dialog box are:

Find what
Provides a text box where you can specify the text that you want to find. Optionally, you can click the arrow to select a search term or phrase that was previously specified.

Match whole word only
Select this option to match the whole word only.
**Match case**

Select this option to match the uppercase or lowercase value, as specified in the Find what field.

**Direction**

Select up or down to indicate the direction in which the Text Editor should search.

**Find Next**

Allows you to find the next instance of your search term.

**Mark All**

Marks all instances of your search term in the Text Editor.

**Cancel**

Cancels the current search and closes the Find dialog box.

**Reference:**

**Replace Dialog Box**

You use the options on the Replace dialog box to indicate how to use the find feature to find and replace information.

The options on the Replace dialog box are:

**Find what**

Provides a text box where you can specify the text that you want to find. Optionally, you can click the arrow to select a search term or phrase that was previously specified.

**Replace with**

Provides a text box where you can specify the text that is going to replace the text for which you are searching. Optionally, you can click the arrow to select a replacement term or phrase that was previously specified.

**Match whole word only**

Select this option to match the whole word only.

**Match case**

Select this option to match the uppercase or lowercase value, as specified in the Find what and Replace with fields.

**Replace In**

Enables you to specify where you would like the replacement to occur. Options include Selection or Whole file.
Find Next
Allows you to find the next instance of your search term.

Replace
Replaces the search information that you specified in the Find next field with the text or other information that you indicated in the Replace with field.

Replace All
Allows you to automatically replace all instances of the search term you indicated in the Find next field with the information you specified in the Replace with field.

Cancel
Cancels the current search and replaces and closes the Replace dialog box.

Working With Bookmarks Using the Bookmarks Group
The Bookmarks group enables you to turn bookmarks on or off, find the next bookmark, find the previous bookmark, and delete all bookmarks. The Bookmarks group is unavailable when you access the Text Editor tab through the Embedded JavaScript or Embedded CSS view tabs, in the HTML canvas. The Bookmarks group is shown in the following image.

The commands are:

Toggle
Turns bookmarks on or off.

Next
Goes to the next bookmark.

Previous
Goes to the previous bookmark.

Delete All
Deletes all bookmarks.
Placing the Cursor Using the Position Group

The Position group allows you to place your cursor at the desired line and allows you to turn off line numbers. The Position group is shown in the following image.

The commands are:

**Goto Line**

Displays the current line your cursor is on. You can type a different line number into the text box to place your cursor on that line.

**Show Line Numbers**

When selected, displays line numbers. This option is selected, by default.

Changing the Case of Text Using the Case/Comment Group

The Case/Comment group contains options for changing selected text to uppercase or lowercase. The Case/Comment group is unavailable when you access the Text Editor tab through the Embedded JavaScript or Embedded CSS view tabs, in the HTML canvas. The Case/Comment group is shown in the following image.

The commands are:

**Upper**

Changes the selected text to uppercase (all capital letters).

**Lower**

Changes the selected text to lowercase (all lowercase letters).

**Change Case**

Changes the case of the selected text to lowercase or uppercase depending on how the selected text appeared first. You can also change the case of selected text by using the shortcut menu on the canvas, while text is selected.
**Add Comment**

Inserts a new comment line if your pointer appears on a new line or changes an active line of text to a comment. You can also use the shortcut menu on the canvas to add a comment.

**Remove Comment**

Deletes the previous comment change. This option is similar to the Undo command on the Quick Access Toolbar. You can also use the shortcut menu on the canvas to remove a comment.

**Formatting Text Using the Options Group**

The Options group contains commands that you can use to format the text in a procedure. The Options group is unavailable when you access the Text Editor tab through the Embedded JavaScript or Embedded CSS view tabs, in the HTML canvas. The Options group is shown in the following image.

![Options](image)

**Note:** When you access the Text Editor through the Embedded JavaScript or Embedded CSS view tabs, the only option in the Options group is Font Style.

The commands are:

**Font Style**

Opens the Font and Color Settings dialog box from which you can modify the appearance of the syntax in a procedure.

**Show Whitespace**

Replaces spaces between characters with a visual indicator.

**Tab Size**

Controls the number of spaces a tab character uses.

**Tab Options**

Provides the options to control tab characters. You can substitute spaces for tab characters or keep tab characters in the syntax.
**Auto Indent**

Automatically indents the syntax within a procedure.

**Reset All**

Restores all options back to the default settings.

**Using the Text Editor Status Bar to View Contextual Information**

The Status bar in the Text Editor displays contextual information, such as cursor location, the number of lines in the file, and keyboard input modes.

To show the Status bar, on the Home tab, in the View group, select Status Bar. Clicking Status Bar when it is already selected hides the Status bar.

The following values display in the Status bar:

- **Col.** Provides the cursor position on the current line, from left to right.
- **Line.** Provides the line that the cursor is on. Each line is labeled with a number to its left.
- **Total Lines.** Shows the total number of lines in the current file.
- **CAPS.** Indicates whether Caps Lock is set on or off. This setting is controlled by the Caps Lock key on your keyboard.
- **INS.** Indicates whether insert or overtype mode is active. When the value for INS is On, your keyboard is in insert mode. Typing when your cursor is placed before existing text shifts subsequent text forward. When the value for INS is Off, your keyboard is in overtype mode. Typing when your cursor is placed before existing text overwrites that text, instead of pushing it forward. This setting is controlled by the Insert key on your keyboard.

The following image shows an example of the values displayed in the Status bar.
Selenium Browser Support

App Studio uses Selenium WebDriver 3.0 and the corresponding stand-alone driver executables for Mozilla Firefox, Google Chrome, and Microsoft Edge in order to support multiple browsers.

In this appendix:

- Selenium Browser Tiers
- Updating the Selenium Software and Driver Executables

Selenium Browser Tiers

The following three-tier architecture explains how multi-browser support is implemented in App Studio. It also provides steps for updating browser drivers for automatic browser updates for Firefox, Chrome, and Microsoft Edge.

The first tier is an Information Builders browser dll (IBIWebBrowserDrivers_dotnet_35.dll). This acts a bridge between App Studio and the second tier Selenium Web drivers (WebDriver.dll and Webdriver.Support.dll). The Selenium drivers communicate with the browsers through the third tier.

The third tier consists of stand-alone executables provided by the browser vendors: geckodriver.exe for Firefox, chromedriver.exe for Chrome and MicrosoftWebDriver.exe for Microsoft Edge.

The executables are located in the bin folder of the App Studio installation. For example, C:\ibi\AppStudio82\bin.
The following image shows the Selenium browser support tier setup.

Note:

- Information Builders browser dll updates are available in new or maintenance releases of App Studio.
- The Selenium WebDriver and the corresponding stand-alone driver executables are available as free downloads.
- When new updates or versions of the browsers are installed, you may need to update the other three tiers. Otherwise, the browser automation may yield unexpected results or may not function at all.
- Selenium browsers only retain the language selection for the request being run. For example, if the result of a request is a drill-down report, clicking the drill-down link will produce the report in the default language. Only HTML reports will be able to retain the IBIWF_language cookie.

Updating the Selenium Software and Driver Executables

These topics describe how to update the Selenium software and the corresponding stand-alone driver executables.
The most frequently updated tier is the second tier (Selenium WebDriver.dll and WebDriver.Support.dll modules). The updates to these two modules can be found at [http://www.seleniumhq.org/download/](http://www.seleniumhq.org/download/). Since App Studio uses C# and .Net version 4.0 to communicate with Selenium, you need to download the .Net 4.0 version of the Selenium modules.

**Procedure: How to Download the Selenium Modules**

1. Navigate to the following URL:
   

2. Locate the Selenium Client & WebDriver Language Bindings section.

3. Select the download link for the zip file that corresponds to C# language, as shown in the following image.

   ![Download Options](image)

   **Note:** Back up the existing .dll files prior to copying the files.

4. Once the zip file is downloaded, extract the content to a folder and navigate to the net40 subfolder, as shown in the following image.

   ![Extracted Files](image)

5. Copy the WebDriver.dll and WebDriver.Support.dll files to the bin folder of the App Studio installation. For example, C:\ibi\AppStudio82\bin.

7. Copy the .Net 4.0 content of the NuGet package into the bin folder of the App Studio installation. For example, C:\ibi\AppStudio82\bin.

**Procedure: How to Update the geckodriver.exe for Mozilla Firefox Automation**

Updates to the geckodriver.exe executable can be found at https://github.com/mozilla/geckodriver/releases, which is a website used to track changes to the software. A typical entry on the page will indicate what was done in a particular version of geckodriver.exe, followed by a series of download links.

1. Select the download link relevant to the version of Windows you are running, as shown in the following image.

   **Downloads**

   - geckodriver-v0.14.0-armhf.tar.gz
   - geckodriver-v0.14.0-linux32.tar.gz
   - geckodriver-v0.14.0-linux64.tar.gz
   - geckodriver-v0.14.0-macos.tar.gz
   - geckodriver-v0.14.0-win32.zip
   - geckodriver-v0.14.0-win64.zip

2. Download the zip file to a folder and extract the content.

   **Note:** Back up the existing geckodriver.exe file prior to the copy.

3. Copy the geckodriver.exe executable to the bin directory of the App Studio installation. For example, C:\ibi\AppStudio82\bin.
**Procedure:** How to Update chromedriver.exe for Google Chrome Automation

Updates to the chromedriver.exe executable can be found at [https://sites.google.com/a/chromium.org/chromedriver](https://sites.google.com/a/chromium.org/chromedriver).

1. Navigate to the Latest Release section of the page and follow a series of download links, locating a chromedriver_win32.zip file, as shown in the following image.

2. Download the zip file to a folder and extract the content.

   **Note:** Back up the existing chromedriver.exe file prior to the copy.

3. Copy the chromedriver.exe executable to the bin folder of the App Studio installation. For example, C:\ibi\AppStudio82\bin.

**Procedure:** How to Update MicrosoftWebDriver.exe Needed for Microsoft Edge Automation

Updates to the MicrosoftWebDriver.exe executable can be found at:

Make sure to follow instructions in the Installation and usage section to correctly detect the build number of your Windows OS.

1. Once you have detected the build number, select a download link to a version of MicrosoftWebDriver.exe that matches the build number. For example, if the build number is 10586, then click the Release 10586 download link, as shown in the following image.

2. Download the provided MicrosoftWebDriver.exe file.
   
   **Note:** Prior to downloading the file, back up the MicrosoftWebDriver.exe file in the bin folder of the App Studio installation.

3. Save MicrosoftWebDriver.exe in the bin directory of your App Studio installation, for example drive:\ibi\AppStudio82\bin.

4. In the Output Viewer Settings section of the App Studio Options dialog box, select **Edge** from the Browser Setup area and click **Test browser setup**.

   If MicrosoftWebDriver.exe is properly configured, the test URL opens in Microsoft Edge, and an alert appears informing you that the test was successful.
Troubleshooting

The following topics explain how to troubleshoot App Studio.

In this appendix:

- Troubleshooting Tips
- Troubleshooting Tools

Troubleshooting Tips

Review the following tips when troubleshooting App Studio.

Updated Browser Issues

Newer browser versions may not immediately work with App Studio. In this case, the Selenium support modules included with App Studio can be updated manually and may resolve the issue. Selenium is a suite of tools specifically for automating web browsers.

2. Under the Selenium Client & WebDriver Language Bindings section, look for the C# line and click the Download link to the ZIP file.
3. Unzip the file on the desktop machine.
5. From the net40 folder in the unzipped file location, copy the WebDriver.dll and WebDriver.Support.dll files into the AppStudio\bin folder.
6. Restart App Studio and test the installed browser version.

   If there is still a problem, open a support case.

Note: If you are using Microsoft Edge, you may need to get an updated driver from Microsoft which is usually available on the Microsoft web site.

Tomcat Configuration Options

Since Tomcat runs as a service, Tomcat Java settings and other parameters are written into the registry. They can be configured through the Apache Tomcat Properties window. You can launch this from the Start menu by selecting All Programs, Information Builders, Tomcat, and Tomcat Configuration Utility.
If you need to adjust the Java release, click the Java tab to change where Tomcat looks for Java components. Be aware that Tomcat 8.0 requires Java 7 or later.

**Note:** Tomcat 8.0 requires Java 7 or later. If Tomcat 8.0 is configured to use Java 6, JSP page compilations will fail. To fix this, update the paths to point to the jvm.dll file of a supported Java version.

### Java Memory Issues

If the App Studio installation configured Tomcat for you, the Tomcat Java VM memory settings are automatically increased. This is done because default application server Java VM memory options may not be sufficient for some WebFOCUS features. If you need to troubleshoot further or if you manually install Tomcat or another application server, you may need to manually increase the Java VM memory options.

The most common Java VM options you need to set involve the size of the Java heap and stack, which determine memory availability for Java programs and the Java VM. Errors can occur if not enough memory is available, and the heap size impacts performance, since it determines how often garbage collection occurs.

The following are the most common Java VM options related to memory settings. Replace the `###` with the size you wish to set:

- `Xmx###M`
  
  Sets the maximum Java heap size. It is common to make this 1/4 of the system RAM.

- `Xms###M`
  
  Sets the initial Java heap size. It is common to make this 1/8 of the system RAM.

- `Xss###M`
  
  Sets the Java thread stack size. You do not need to set this unless you are fine tuning your environment.

The size is normally set in megabytes, for example:

- `Xms256M`
- `Xmx512M`

Optimum sizes vary depending on your total memory, the needs of your application, how many other processes require memory, the type of Java VM, and other considerations. A good starting place is to set the minimum to 1/8 of the total RAM and set the maximum to 1/4 of total RAM.
Where to set these and other Java VM options depend on your application server.

- For Tomcat on Windows, you can set these options using the Apache Tomcat Properties window.

  1. From the Start menu, select All Programs, Information Builders, Tomcat, and Tomcat Configuration Utility.
  2. Click the Java tab.
  3. In the Initial memory pool (-Xms) field, specify the initial Java heap size in megabytes. For example: 256
  4. In the Maximum memory pool (-Xmx) field, specify the maximum Java heap size in megabytes. For example: 512
  5. Click OK.
  6. Restart Tomcat.

- For other application servers, refer to your application server documentation.

Starting App Studio

On rare occasions, App Studio may fail to initialize correctly. If this happens, you can start the product in safe mode, or close the product manually.

Starting in Safe Mode

App Studio may fail to initialize correctly if a problem occurred during the previous close. In rare cases, a file in the Configured Environments tree can remain persistent when it should have closed. A file in this state will attempt to transact with the server before the application is fully initialized.

Starting App Studio in safe mode initializes the product with its environments only.

1. In your windows start menu, navigate to the Information Builders section. Immediately below WebFOCUS App Studio is WebFOCUS App Studio (Safe Mode). Click the Safe Mode option.

   Alternatively, you can navigate to the folder where App Studio is installed. Open a command prompt and type appstudio-s.

   App Studio opens with the environments displaying in the Configured Environments tree.

2. Double-click to expand the environment. Navigate to your content as needed.
A file that remained persistent after the previous close will be able to transact with the server without conflict. A file in this state will close normally the next time you close App Studio.

After starting in Safe Mode, you may work normally in App Studio. The next time you start App Studio, you can use the normal WebFOCUS App Studio option.

**Closing Manually**

If starting App Studio in safe mode fails to initialize the product, it may be that the underlying AppStudio.exe process did not terminate correctly during the previous close. In this case, you can manually end the AppStudio.exe process.

1. Press Ctrl + Alt + Delete and choose Task Manager.
2. Click the Processes tab.
3. Find and select an AppStudio.exe Image Name if it appears.
   
   **Note:** You can click the Image Name column to sort by name.
4. Click End Process.
5. Start App Studio normally.

**Manual Registration to Enable Multiple Browser Support in App Studio**

Developers can use Chrome™, Firefox®, Internet Explorer®, Edge®, or the internal viewer when running reports. To use Chrome or Firefox, the product requires registration of the IBIWebBrowserDrivers_dotnet_35.dll .NET module that is included with the product.

To register this file, .NET version 4.0 is required. This version of .NET is preinstalled on most machines. If your machine does not have this .NET version, it will be installed during the App Studio installation process and the module needed to support multiple browsers will get registered.

In a few cases, on Windows 8.1 machines where the registration of the module fails, the developer will not be able to switch browsers. To address this issue, the developer must register the required module manually. To do this, open a Command Window, with the option Run as administrator, and run the following commands:

```bash
%SystemRoot%\Microsoft.NET\Framework64\v4.0.30319\RegAsm
C:\ibi\AppStudio82\bin\ibiwebbrowserdrivers_dotnet_35.dll /u
```

A message should display that the file unregistered successfully.

Then run:
%SystemRoot%\Microsoft.NET\Framework64\v4.0.30319\RegAsm
C:\ibi\AppStudio82\bin\ibiwebbrowserdrivers_dotnet_35.dll

A message should display that the file registered successfully.

where:

%SystemRoot%

Is the location of the Windows folder on your machine. This includes the drive and path. It is usually the C drive. For example, C:\Windows.

Note:

- Adjust the above commands based on location of the App Studio installation location.
- The commands in the documentation are shown in two separate lines, but they should be issued as one command.

Troubleshooting Tools

Tools to troubleshoot App Studio are available in the WebFOCUS Administration Console, App Studio program folder, and Reporting Server Console.

Accessing the Verification Tools in the WebFOCUS Administration Console

To run the verification tools installed with the WebFOCUS Administration Console, access the console.

Procedure: How to Access the WebFOCUS Administration Console

1. Ensure that Apache Tomcat and/or IIS are started.

2. From the Windows Start menu, select All Programs, Information Builders, WebFOCUS 82 App Studio, WebFOCUS App Studio Utilities, and then click WebFOCUS Administration Console.

If you are using Apache Tomcat standalone, you can also go to:

http://localhost:8080/ibi_apps/console/webfocusconsole.jsp

For IIS with Tomcat, you can go to:

http://localhost/ibi_apps/console/webfocusconsole.jsp
The WebFOCUS Sign In page opens, as shown in the following image.

If the WebFOCUS Sign In page does not appear, ensure that your web server is started. If the web server is started and this page does not appear, you may need to manually configure the web server.

3. Sign in using an administrator user ID. The initial default user name and password is admin.

The WebFOCUS Administration Console opens, as shown in the following image.

Using this console, you can edit various configuration settings. Information about the various settings in this console can be found by clicking Help. The WebFOCUS Administration Console contains a verification tool to further test the configuration.
4. Click **Diagnostics**, as shown in the following image.

Several tests are available from the Diagnostics tab.

**Testing the WebFOCUS Client**

Click **Client Verification** to verify the client configuration settings.

A page similar to the following image appears on the right with a list of tests. The list varies depending on your license and configuration. For a Tomcat standalone configuration, the web/app server tests may not appear.

If a test fails, a Possibilities link appears providing information on what the problem might be and possible solutions. The verification tools are only supported with Internet Explorer, and you may receive errors if you use other browsers.
**Procedure:** How to Test the WebFOCUS Reporting Server

1. Click the **Configuration** tab and then expand the **Reporting Servers** and **Server Connections** nodes.

2. Right-click the desired Reporting Server and select **Test**.

The Test sub menu is displayed, as shown in the following image.

![Configuration menu](image)

You can test the following areas:

- **TABLE Request.** A new window opens, displaying the results of your test.

- **GRAPH Request.** Returns information about server-side graphics (SSG). The information that is displayed depends on whether SSG_EXTERNAL=YES (process-based) or SSG_EXTERNAL=NO (thread-based).

- **Stored Procedure.** The Remote Server Connection Test page opens, displaying the results of your test.

For more information, see the *WebFOCUS Security and Administration* guide.

**App Studio Trace Utility**

The App Studio trace utility (Communication Layer Trace) generates trace files for tasks performed by the App Studio development environment communication layer. It captures information for tasks performed by App Studio when a request is submitted or retrieved by the product.
You can use this utility to help troubleshoot issues, such as communication failures, connection problems, and transfer of files.

To generate traces for issues you might encounter at startup, you should start the trace utility prior to launching App Studio.

To generate traces for a failure to connect to a Data Server or to determine why applications are not listed, you should start and enable the trace at the point prior to performing the task that fails.

**Procedure:** How to Use the Communication Layer Trace

1. Launch the Communication Layer Trace from the Windows Start menu by selecting *All Programs, Information Builders, WebFOCUS 82 App Studio, WebFOCUS App Studio Utilities,* and *Communication Layer Trace.*

   The Communication Layer Trace tool opens, as shown in the following image.

2. Click the *On* radio button to enable tracing.

3. The Trace File field indicates the location and name of the trace file. The default trace file is created in the following location for Windows 7:
drive:\Users\user_id\AppData\Roaming\Information Builders\wfscom.xml

where:

user_id

Is your Windows user ID.

**Note:** The Application Data directory may not be visible by default. To see this directory, open Windows Explorer, click Tools, choose Folder Options, and select the View tab. Then select Show hidden files and folders and click OK.

4. In the Trace Levels area, keep the default All levels to capture all required information or specify a specify level.

### WebFOCUS Reporting Server Traces

You can turn WebFOCUS Reporting Server traces on when you start the server or dynamically after the server has started.

- To start the server with traces, you should start it before App Studio by selecting All Programs from the Start menu, then Information Builders, WebFOCUS 82 App Studio, WebFOCUS Server for App Studio, Diagnostic Functions, and Start Security OFF with Traces.

- To turn traces on dynamically, access the Server Console and select Workspace, Diagnostics, and Traces.

**Note:** Viewing traces is only available to a server administrator.

You can use the Reporting Server Console to view server traces, as well as turn them dynamically on or off for a running server.

If tracing is set to off and it was never turned on, the page shows that no traces are available and enables you to turn traces on. If tracing is on, the page displays the available traces in drop-down boxes. Which traces are available depends on what requests were made against the server.

To turn traces on dynamically, click Enable Traces. Be aware that a dynamic trace is not the same as turning traces on at server startup. A dynamic trace is usually not sufficient for following a problem through with Customer Support, but it may suffice for other purposes, such as seeing how something is parsed.

**Note:** The default for tracing is to trace all components when tracing is turned on. However, the trace settings file (ibitrace.fex) may have been altered. Therefore, components that you expect to be traced may not be traced.
Procedure: How to View a Trace File

1. Open the Web Console by selecting All Programs from the Start menu, then pointing to Information Builders, WebFOCUS 82 App Studio, WebFOCUS Server for App Studio, then clicking Web Console.

2. Click the Workspace tab.

3. In the left panel, expand the Logs and Traces folder.

4. Double-click Traces, or right-click Traces and click View.
   
   A list of traces displays in the right panel.

5. Right-click a specific trace file and then choose from the following options:

   - **View.** Displays the trace in the right-hand browser pane.

   - **Open or Save.** Enables you to open the trace in a local editor or to save it to a local disk.

   - **Delete.** Deletes the selected trace.

   The file opens, or is deleted, according to the option you choose.
Index

-\[string\] command 488
-\[variablename\] commands 488
-GOTO command 479, 480
-HTMLFORM command 476
-IF ... GOTO command 480–482
-IF command 479–481
-REPEAT command 482–484
-SET command 482
-TYPE command 479
-WINDOW command 485
//TODO 572, 576
$$Declarations comment 778

A

ACCESS attribute 219
access to data 220
restricting 220
Accordion Reports
creating 310
adapters 136
adding a computed field (COMPUTE) in virtual fields 183
adding existing field to group field 194
adding group fields 193
adding headers and footers to overflow pages 755
adding new field to group field 194
adding new overflow pages 754
Aerial view 141

all columns 173
amper variables 478, 485
Analytic Document options tab 350
Analytic Documents 350
applying data visualizations 356
columns 350
page navigation bar 355
Apache Tomcat
Java configuration 1171
troubleshooting 1171
App Studio canvas 64
App Studio interface
application button 40
canvas 41
Configured Environments panel 40
Quick Access Toolbar 40
ribbon 40
App Studio Options dialog box 45, 47, 57
Index

App Studio
   architecture 33
   development modes 35
   directory structure 34
   launching 37
   processing 35
   customizing 85
   interface components 39
   trace utility 1178
   troubleshooting 1171
Appearance tab
   Analytic Documents group 350
Application button 41
application root directory 34
APPROOT directory 34
ArcGIS
   locally hosted server 1118
Authoring Mode 47
auto chain controls 634
auto drill 437, 439
auto hide 129
Auto Linking 437
automatic verification 1177
autoprompt 244
   calendar 247
   chaining 245
   filters 244
Autosize Children 599
Autosize
   adding components 602
Autosize
   adding content in a container 603
B
basemaps for Esri HTML5 Viewer 866
Basic Sampling Concepts 370
   Margin of Error 371
bookmarks 1160
   using 751
branching 479
   conditional 480–482
   unconditional 480
BY phrase 310
C
calculating data 316
calculating trends 316
calendar
   autoprompt 247
canvas 64
canvases
   customizing 72, 129
Cascading Style Sheet Canvas 68
cascading style sheets (CSS) 262
CASE command 778
cell padding 323
chain controls 635
reversing the order 648
chained variable values
   retrieving 583
Chaining group 542, 759

chaining
  applying conditions 650

Chaining group 542, 759
controls 647
  tree controls 538
  autoprompt 245
  breaking chains 648
  new conditions 652
  removing links 648

Chart canvas 79, 445
chart procedures 445

Chart Wizard 79, 445
  creating charts 447
  launching 445

charts
  adding to HTML pages 495
  components of a procedure 468

closing panels 129
cluster joins 137
  creating 202

Color selection 598
column management 147
COMBINE command and data security 222
combining expressions 241
commands
  stacked 478
comments 778

Communication Layer Trace 1178

Components tab 494
  Containers group 502
  Generic Elements group 496
  Objects group 506
  Reports group 494
components
  inserting 742

Compute calculator 189
computed fields 183
computed fields in Synonym Editor 183
concatenate data sources 256
conditional branching 480, 481
  -IF ... GOTO command 480–482
conditional joins 412, 417
  creating 417

Conditional styling 257
conditions
  actions 653
  cache processing 656
  creating 652
  multiselect operator 654
  new 652
  parameter compare operators 656
  resolving parameters 655

Configured Environments tree 87, 89
  Content node 93
  Data Servers node 90
  opening files 104
  source code management 1123
  Web Applications node 97
Controls group 510, 746
Controls tab
  Controls group 510
controls
  chaining 635, 647
  settings 604
creating expressions 237
creating filters 185
creating joins 415
creating procedures 463
creating temporary fields 183
creating virtual fields 183
creating virtual measures with COMPUTES 207
CSS (cascading style sheets) 262
Cube data sources in Synonym Editor 204
custom procedures 579
customizing keyboard shortcuts 62
customizing the Quick Access Toolbar 60, 62

data access 220
  levels of 219, 220
data encryption 223
data profiling 172, 173
  statistics 173
data security 211, 216, 217
  encrypting segments 223
  JOIN command and 222
  passwords 219
Data Servers 90
data source 137
data source stacks
  writing to data sources 778
data sources 211
  joins 470
  access control 220
  joining 415
  joins 414
  security 217
Data tab 312
  Calculation group 313
  Forecast group 316
  Guided Reports group 319
data visualization 348
Data Visualization dialog box 348
DBA (database administration) 211
DBA Pane 214
DBAFILE attribute 222
debugging 1171
Declarations comment 778
decrypting Master Files 216
default report styling 265
default WebFOCUS StyleSheet
  applying 265
Deferred Report 83
DEFINE command
    joins 413
DEFINE field for OCCURS 196
deleting a field from group fields 194
deleting dimensions or parent/child hierarchies 206
deleting group field from segment 194
deleting measures 206
deleting passwords 215
Derby Security database 33
developing models 368
diagnostic tools 1177
    App Studio 1178
    WebFOCUS Reporting Server 1180
Dialogue Manager 462, 477
    messages 479
    processing 478
    looping procedures 482
    stacked commands 478
directories 34
display options 47
Document canvas 80, 598, 762
documents 491, 739–741
    adding pages 748
    creating 741
    creating .fex documents 740
    creating page masters 752
    creating table of contents pages 747, 750
    inserting components 742
    inserting controls 746
drill through compound reports in PDF format
    278–280, 283, 289
drill through PDF compound reports 278–280, 283, 289
drill through reports 278–280, 283, 289
drill-through procedures 274
    hyperlinks 350
drill-down reports compared 278
Drop Down List Properties window 531
drop-down lists
    multiple values 531
dynamic values 571, 578
    populating fields 583
    retrieving 580–582
    sorting 578
E
    editing existing environments 115
    editing field names and titles 205
    editing source code 1157
    editing titles for multiple languages 206
    embedded procedures 533
embedding style sheets 261, 263
ENCRIPT command 223
ENCRIPT parameter 223
encrypting Master Files 216
encrypting procedures
  in Master Files 223
END command 778
ENDCASE keyword 778
environment settings 106
Environments Detail panel 116
Environments tab 57
Environments Tree panel 86, 87
Environments Tree toolbar 87
  sorting information 87
environments
  adding 106
  Data Server properties 115
  editing 115
  Local Machine properties 111
  logging on 108
  Web Component properties 112
Esri HTML5 Viewer 864
  interactions 1078
  line symbology 1049
  map layers 868
  map widgets 915
  point of interest layer 898
  point symbology 1004
  polygon layer 900
  polygon symbology 1030
  single image point symbology 1012
  single line symbology 1054
  single polygon symbology 1034
  single shape point symbology 1010
  size point symbology 1019
  symbology 1004, 1069
  thickness line symbology 1063
  unique line symbology 1059
  unique point symbology 1025
  unique polygon symbology 1037
  visualizations 982, 1069
Esri
  on Premise 1118
Events 598
  everything value option 570
  exponential moving average 317
Expression Builder 236, 237
expressions
  combining 241
  creating 237
External Tools tab 45
F

FANNAMES data source
  using in procedures 778
field display options 47
Field tab 330, 340
  Break group 333
  Column Type group 331
  Filter group 332
  Format group 344
  Links group 350
  Sort group 332
  Specific group 346
  Style group 340
fields 224
  changing views 323, 327
  viewing 323, 327
File/Folder Properties panel 117
Files Utility group 760
Filter calculator 189
Filter group 235
filters 185
  autoprompt 244
finding text 1158
Folding
  responsive design 693
Forecast dialog box 317
Forecast group 316
Forecast
  conditional styling 318
  data visualization 318
  exponential moving average 317
  linear regression analysis 317
  simple moving average 317
Format tab 290
  Features group 304
  Navigation group 298
  Output Types group 291
formatting text 499, 744
  bulleted lists 500, 744
  nested lists 501, 745
  numbered lists 500, 744
full-screen data entry 485
functions
  editing 778
  viewing source code 778

G

General tab 45
  generating ad hoc reports 439
global variables 478, 485, 488
  naming 486
  querying 489
group field attributes 194
Guided Drill Down 276
Guided Report pages 319, 320, 491, 493, 739
  adding buttons 543
  adding controls 543
  adding text 543
  creating 493
Guided Reports 320
  parameters 320

H

handles 129
headings and footings 585
Help 86
Help Configuration tab 57
Help Wizard 38, 82
Home tab 75
  Configure group 75, 80
  Consoles group 75
  Content group 75, 78
  Data & Metadata group 75
  Modeling group 80
  View group 75, 82
HTML canvas 79, 598, 762
  adding tree controls 533, 534
  auto chain controls 634
  automatic chaining 634
  chaining controls 633, 635, 647
  controls 633
  double-head slider control 527
  embedded procedures 533
  Parameters tab 633
HTML pages 491, 492, 739
  adding buttons 543
  adding charts 495
  adding components 494, 495
  adding controls 543

HTML pages 491, 492, 739
  adding reports 495
  adding text 543
  adding tree controls 533, 534, 536
  animating jQuery animations 615–617
  components 494, 495
  creating 492
  creating jQuery animations 615–617
  embedded procedure 533
  existing procedures 534
  jQuery animations 606, 612

HTML
  advanced mobile layout 724
  basic mobile layout 724
  designing for smartphones 718
HTML/Document Wizard 491, 739
  79
  create Documents 79
  create Guided Report Pages 79
  create HTML Pages 79
  create In-Document Analytic dashboards 79
  creating 491, 739
  creating .fex documents 740
  creating documents 741
  creating Guided Report pages 493
  creating HTML pages 492

I

IbComposer_enableHtmlElement 670
IbComposer_execute 669
IbComposer_getCurrentSelection 659, 662–665, 675
IbComposer_isSelected 669
IbComposer_ResetDownChainControls 671
IbComposer_selectTab 672
IbComposer_setCurrentSelection 667, 668
IbComposer_showHtmlElement 670
identifying procedures in fields 224
identifying procedures in Master Files 224
ignore value option 569
Impact Analysis 224
Impact Analysis tool 224
implied prompting 485
In-Document Analytic dashboard 739
In-Document Analytic dashboards
adding pages 748
inserting components 742
inserting controls 746
In-Document Analytic reports 350
INFER command 778
Insert tab 742
Components group 742
Controls group 746
Pages group 748
interactive data entry 485
interface components 39
Application button 41
canvas 64
Quick Access Toolbar 60

J
Java
memory issues 1172
JavaScript code 657
JOIN command
data security 222
Join tab 414
Join group 414
joins 411
conditional 412, 417
creating 414, 415
customizing 418
DEFINE command and 413
tag name 421
jQuery animations 606, 612
animating 615–617
creating 615–617

K
keyboard shortcuts 62
customizing 62

L
launching the Report Wizard 229
Layout tab 321
Page Setup group 321
Report group 322
limiting number of records read 47
limiting number of records retrieved 47
line data layer 902
linear regression analysis 317
linking summary and detail data 278, 283
linking summary and detail data drill through reports 279, 280
Links group 274
local variables 478, 485, 487
    naming 486
looped procedures 482
    -REPEAT command 482–484
    -SET command 482
looping 482–484

M

Mailing Label Options dialog box 312
MAINTAIN command 778
Maintain Data procedures 778
    viewing source code 778
Managed Reporting 93
map layers for Esri HTML5 Viewer 868
map widgets for Esri HTML5 Viewer 915
maps 864
    introduction 862
mask text property 519
Master Files 211, 216, 224
    encrypting 223
    identifying procedures within 224
Match Wizard 462
Matrix tab 360
    Preview mode 360
    Report Properties group 367
    Row Properties group 367
    Row/Cell group 366
    View group 360
merging data sources 462
messages 479
    displaying 479
Metadata canvas 137
Metadata tab
    Clipboard group 139
    Editing group 140
    Insert group 142
    Reports group 143
    Tools group 144
    Undo/Redo group 139
    View group 141
metadata
    adapter 80
    password 76
    rebuild 76
Miscellaneous group 543
Mobile output
    viewing 730
Modeling group 80
Modeling tab 368
multilingual titles and descriptions in Synonym Editor 171
N
naming 486
navigating procedures 479
branching 479, 480
looping 482
new environments 106, 108
nodes
inserting 142
normal embedded styling 263
O
OCCURS repetitions in a DEFINE field 196
Open dialog box 43
outliers 173
output formatting 47
Output Viewer Settings tab 58, 59
outputs 294
setting 294
P
page layout
adding overflow pages 754
flow margins 753
inserting dashboards 756
page masters
creating 752
using in another document 752
Pages group 748
panels 128
customizing 129
docking 129, 130
floating 129
hide 129
pinning 129
unpinning 129
parameter values 488
querying settings 488
adding filters 577
creating 557
custom procedures 579
default 588
duplicate values 578
dynamic 571, 574, 577, 579, 588
everything value option 570
from a procedure 570
ignore value option 569
importing 571
list options 584
Parameters (Dynamic Values) tab 571
populating fields 583, 584
sending display values 585
sorting 578
static 562, 565, 567
parameters 560
generating 320
passwords 211, 215
pattern columns 173
PCHOLD formats 283
PDF OPEN/CLOSE and PCHOLD formats 283
point of interest layer for Esri HTML5 Viewer 898
polygon layer for Esri HTML5 Viewer 900
Positioning group 538, 757
positioning objects 538, 756
Positioning tab 538, 756
  Positioning group 538, 757
  Relationships group 540, 758
  Responsive Design group 541
  Text Alignment group 541, 758
Precision reports
  accessing 393
  Columns palette 403
  composition 410
  creating precision reports 406
  Data Matrix layer 407
  embedded fields 408
  Fields tab 404
  heading/footing objects 408
  Layers tab 401
  matching output to a preprinted form example 410
  Navigate tab 405
  page layout 407
  Positioning tab 397
  Properties tab 405
  Sort Groups tab 402
tabs 400
  Tools tab 395
  usage notes 394
preferences 45
Preview group 544
Procedure View panel 455
Procedure view
  order of components 463
procedures
  allocation 460
  branching 479
  charts 459
  components 456
  creating 463
  define 458
  define function 459
  editing source code 1157
  execute 460
  HTMLForm 461
  joins 459
  looping 482
  match 461
  navigating 479, 480
  prompting 485
  reports 457, 464
  running 478
  scheduling 97
  set 459
  use 460
  variables and 485
  branching 480
processing Dialogue Manager procedures 478
prompting for variable values 485
Properties and settings dialog box
  unbound parameters 564
  bound parameters 565, 574
  dynamic values 571
Properties panel 598
  Autosize Children 599
Properties toolbar 599

Q

Quick Access Toolbar 60
  adding commands 62
  customizing 62

R

read limits 47
read-only access 219
read/write access 219
records 47
  selecting 241
Relationships group 540, 758
remote development 36
replacing text 1158
Report canvas 78, 229, 230
  fields 330, 340
report display options 47
Report group 249
Report Painter
  formatting options 335
Report tab 235
  Filter group 235
Report tab 235
  Links group 274
  Report group 249
  Style group 258
  Traffic Lights group 257
Report Wizard 78
  creating SQL reports 447
  creating reports 229, 230
  creating SQL reports 231
ReportCaster 83
  reporting server 33
Reporting Server Console 83
Reporting tab 45, 47
reports 360, 361
  adding to HTML pages 495
  procedures 464
  adding borders 267
  creating 229, 230
  data visualization 348
  embedding style sheets 263
  filters 332
  formatting 335
  including StyleSheets 262, 433
  joining files 411
  joins 411
  layouts 321
  manipulating mathematical data 312
  mathematical data 312
  modifying 235
  output 291
Index

reports 360, 361
  setting width options 272
  sorting 332, 335
requests 621
  executing 607
Responsive Design group 541
Responsive
  add objects to widgets 703
  add/remove widgets 702
  animate controls 706
  BI portal 715
  containers folding 693
  controls, first row only 714
  convert to responsive 711
  custom layout 708
  flow direction 694
  folding 693
  folding diagram 693
  HTML canvas 696, 709
  load widget at run time 708
  methods 695
  new content 710
  output widget 695
  page-level controls 704
  panel sizes 706
  populating widgets 701
  selecting a template 700
  template 695, 697
  template diagram 697
  tips 716

Responsive
  web design 692
  widget 695
  widget-level controls 705
RESTRICT attribute 220
  SAME option 220
  SEGMENT option 220
  VALUE option 220
retrieval limits 47
ribbon 73
  organization 73
RStat 81, 368
  developing models 368
S
  sampling functionality 370
Save As dialog box 44
Save StyleSheet 265
scheduling 97
scheduling procedures 97
securing data 211, 216
  securing data in Master Files 211
security 216, 217
  ACCESS 217
  access levels 219, 220
  encrypting data segments 223
  encrypting Master Files 223
  identifying users 218, 219
  passwords 218, 219
  storing DBA information centrally 222
segments
  encrypting 223
Selection Required 867
Server Console
  troubleshooting 1180
server diagnostic trace files 1180
SET parameters 218
  PASS 218, 219
  USER 218, 219
setting output types 294
setting preferences 45
Settings panel 604
  conditions 650
SHOW keyword in Winform command 778
side-by-side development 73
simple moving average 317
single column 173
Smart phones
  advanced mobile layout 724
  basic mobile layout 724
Smartphones
  designing HTML output 718
Sort tab of Field Properties dialog box 335
Sorting Tab 335
sorting
  reports 335
source code for procedures 778
Source code management 1123
source code
  editing 1157
SQL reports 231, 447
  creating 447
  importing 450
  creating 231
  importing 233
stacked commands 482
stacks
  writing to data sources 778
Startup Options 45
static parameters 563
  importing 571
static values 562, 565, 567
  adding 565
  importing 567
  Report canvas 567
statistical variables 478, 485
  querying 489
Style Composer 629
  background properties 630
  edge styles 632
  font styles 629
  interface effects 633
  layout styles 632
  list styles 632
  position mode 631
  text styles 631
Style File Selector 266
Style group 258
style menu 85
Index

style sheets
   embedding 261
StyleSheet File Selector 261
symbology for Esri HTML5 Viewer 1004
symbology for lines 1049
   color 1055
   dynamic 1066
   single 1054
   thickness 1063
   unique 1059
symbology for points 1004
   color 1016
   dynamic 1021
   single image 1012
   single shape 1010
   size 1019
   unique 1025
symbology for polygons 1030
   color 1044
   dynamic 1047
   single 1034
   unique 1037
synonym 137
   adapter 137
   creating 137
   editing 137
   enhancing 137
   uses 136
synonyms
   virtual columns 181
syntax color 778
system variables 478, 485
T
table of contents pages
   creating 747, 750
   objects 750
Table of contents
   adding 299
   disabling 299
Tasks & Animations panel 606
   Animations section 612
   Tasks section 607
Template group 543
temporary fields 183
text alignment group 541, 758
text boxes
   masked text 519
text editor 1157
Text Editor 97
Text Editor tab 1157
   Bookmarks group 1160
   Case/Comment group 1161
   Find group 1158
   Options group 1162
Tomcat
   Java configuration 1171
   troubleshooting 1171
Top function 778
tracing 1175, 1178
  App Studio 1178
  WebFOCUS Reporting Server 1180
Traffic Lights group 257
tree controls
  multi source 535
troubleshooting
  App Studio 1171
  servers 1180
  tools 1175

U
unbound parameters 560, 563
  adding 560
unconditional branching 479, 480
  -GOTO command 479
  -GOTO command 480
update access 219
usage notes stylesheet 266
USER attribute 218, 219
user defined functions
  creating 466, 467
utilities in App Studio
  Communication Layer Trace 1178
Utilities tab 542, 759
  Preview group 544
  Template group 543
  View group 545, 761

V
value columns 173
values
  querying 488, 489
  supplying 485
variable types 478
  amper 485
  global 485, 488
  local 485, 487
  statistical 485
  system 485
  global 478
  local 478
  statistical 478
  system 478
variables 485
  procedures and 485
  querying 488, 489
  substitution 485
verification 1177
  automatic 1177
  WebFOCUS Reporting Server 1178
View group 82, 545, 761
View tab 323, 327
viewing items based on type 87, 117
Viewing mobile output on a smart phone 730
Virtual Column calculator 189
virtual columns
  creating 181
virtual field attributes 187
virtual field for OCCURS 196
virtual fields 183, 413
  defining 465
  joins 413
visualizations for Esri HTML5 Viewer 982

W
WebFOCUS Administration 83
WebFOCUS Administration Console
  accessing 1175
  verification tool 1177
WebFOCUS client 33, 115
  properties 115
  testing 1177
WebFOCUS environment
  properties 108
WebFOCUS environments 105
WebFOCUS Environments 89
WebFOCUS Home Page 83
WebFOCUS Reporting Server 1178
  connection 1178
  testing 1178
  tracing 1180
WebFOCUS RStat 81, 368
  developing models 368
WebFOCUS
  architecture 32
  components 32
  configuration 33
  network connections 32
  windows 45
    startup options 45, 57
Winform command 778
write-only access 219
Feedback

Customer success is our top priority. Connect with us today!

Information Builders Technical Content Management team is comprised of many talented individuals who work together to design and deliver quality technical documentation products. Your feedback supports our ongoing efforts!

You can also preview new innovations to get an early look at new content products and services. Your participation helps us create great experiences for every customer.

To send us feedback or make a connection, contact Sarah Buccellato, Technical Editor, Technical Content Management at Sarah_Buccellato@ibi.com.

To request permission to repurpose copyrighted material, please contact Frances Gambino, Vice President, Technical Content Management at Frances_Gambino@ibi.com.
WebFOCUS

Release 8205